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About This Guide

This preface describes the objectives, audience, organization, and conventions of the User Guide for the 
Cisco Mobile Wireless Transport Manager 6.0. It refers you to related publications and describes online 
sources of technical information.

The Cisco Mobile Wireless Transport Manager (MWTM) is a network management software product 
that enables network administrators to discover, manage, and troubleshoot networks that include 
Cisco IP Transfer Point (ITP) or Radio Access Network Optimization (RAN-O) networks. For a more 
detailed description of the MWTM, see Chapter 1, “Overview.”

For the latest MWTM information and software updates, go to http://www.cisco.com/go/mwtm.

This preface includes:

• Document Objectives, page xxxi

• Document Audience, page xxxii

• Document Organization, page xxxii

• Document Conventions, page xxxiii

• Related Documentation, page xxxiv

• Obtaining Documentation, Obtaining Support, and Security Guidelines, page xxxv

Document Objectives
This guide describes the architecture, supporting hardware and software, and management procedures 
for the MWTM. Using the information provided in this guide, you can complete the tasks that are 
necessary to use the MWTM in your ITP or RAN-O system environment.

http://www.cisco.com/go/mwtm
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Document Audience
This guide is for network administrators or operators who use the MWTM software to manage ITP or 
RAN-O installations. Network administrators or operators should have:

• Basic network management skills

• Basic Solaris system administrator skills

• Basic IP, SS7, and ITP knowledge and/or basic RAN-O knowledge

Document Organization
This guide is divided into the following chapters:

• “Overview” provides brief descriptions of ITP and RAN-O, the MWTM, the MWTM’s client-server 
architecture, and an overview of how to use the MWTM to manage your ITP or RAN-O installation.

• “Configuring Security” provides information about configuring MWTM security and limiting 
access to the MWTM.

• “Setting Up Your Server” provides procedures to setup your MWTM server, which includes 
enabling traps, configuring a backup server, setting up TFTP, configuring SNMP settings and 
credentials, and creating new troubleshooting commands.

• “Getting Started” provides basic information and procedures for using the MWTM.

• “Basic Operations” provides information about basic operations you can perform using the MWTM, 
including navigating windows, exporting data, and performing basic server operations.

• “Understanding Basic Object Functions” provides information about basic object functions found 
within the Summary Lists section of the navigation tree.

• “Managing Views” provides information about using the MWTM to create, change, and load views 
and subviews, and view basic and detailed information for views and subviews.

• “Understanding Detailed Object Functions” provides information about more detailed object 
functions you can perform on specific types of objects.

• “Managing Events” provides information about using the MWTM to view basic and detailed 
information for events, and change the way the MWTM processes events.

• “Viewing Network Topology” provides procedures for viewing the topology of your network, 
changing the way the MWTM shows the topology, and saving customized topology displays.

• “Accessing Data from the Web Interface” describes how to access MWTM data from the MWTM 
Web interface.

• “Managing ITP Reports” provides procedures for creating and viewing MWTM accounting and 
statistics reports for your ITP network.

• “Editing an ITP Route Table File” provides procedures for viewing and editing ITP route table files.

• “Editing an ITP Global Title Translation Table” provides procedures for viewing and editing ITP 
GTT files.

• “Editing ITP MLR Address Table Files” provides procedures for viewing and editing ITP MLR 
address table files. 

• “Object Map Reference” provides an overview of the tabs available for each MWTM object within 
a view.
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• “Command Reference” describes the commands used to set up and operate the MWTM.

• “FAQs” provides a list of frequently asked questions and troubleshooting tips for the MWTM.

• “Troubleshooting the MWTM and the Network” provides information for troubleshooting basic 
MWTM and network problems, including how to verify network discovery, clearing a locked-up 
MWTM display, and using the MWTM to diagnose typical network problems.

• “Status Definitions” defines the default status settings for all MWTM network objects.

• “MIB Reference” lists and describes the MIB variables that are polled by the MWTM.

• “Trap Reference” lists and describes the traps that the MWTM supports.

• “Configuring MWTM to Run with Various Networking Options” describes communication between 
the MWTM client and the MWTM server in different networking environments, including Virtual 
Private Network (VPN), Network Address Translation (NAT), firewall, port-forwarding, and Secure 
Sockets Layer (SSL).

• “Archived Reports File Formats” lists the formats for MWTM statistics export files. 

• “MWTM Ports” lists MWTM and CDM services ports, port type and descriptions.

Document Conventions
This guide uses basic conventions to represent text and table information.

Command descriptions use the following conventions:

• Commands and keywords are in boldface font.

• Arguments for which you supply values are in ialic font.

• Elements in square brackets ([ ]) are optional.

• Alternate but required keywords are grouped in braces ({ }) and separated by a vertical bar (|).

Examples use the following conventions:

• Terminal sessions and information that the system displays are printed in screen font.

• Information that you enter is in boldface screen font. Variables for which you enter actual data are 
printed in italic screen font.

• Nonprinting characters, such as passwords, are shown in angle brackets (< >).

• Information that the system displays is in screen font, with default responses in square brackets ([ ]).

This publication also uses the following conventions:

• Menu items and button names are in boldface font.

• Directories and filenames are in italic font.

• If items such as buttons or menu options are dimmed on application windows, it means that the items 
are not available either because you do not have the correct permissions or because the item is not 
applicable at this time.

Note Means reader take note. Notes contain helpful suggestions or references to materials not contained in 
the manual.
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Caution Means reader be careful. You are capable of doing something that might result in equipment damage or 
loss of data.

Tip Means the following are useful tips.

Related Documentation
Additional information can be found in the following publications of the MWTM documentation set:

• Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0

• Release Note for the Cisco Mobile Wireless Transport Manager 6.0

• Online Help System for Cisco Mobile Wireless Transport Manager 6.0

• OSS Integration Guide for the Cisco Mobile Wireless Transport Manager 6.0

Information about Cisco IOS software-related functions can be found in the following publication:

• Cisco Management Information Base (MIB) User Quick Reference

Information about Cisco IP Transfer Point (ITP) software, including procedures for configuring ITP 
objects, can be found in the following publication:

• Cisco IP Transfer Point (ITP) in IOS Software Release 12.2(25)SW8 

Information about the Cisco ITPs can be found in the documentation that shipped with the ITP.

Information about Cisco RAN-O nodes, including procedures for configuring RAN-O objects, can be 
found in the following publications:

• Cisco MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration Guide 

• Cisco ONS 15454 RAN Service Module Software Configuration Guide

Information about the CiscoWorks LAN Management Solution (LMS) 2.6 products, which can be 
integrated with the MWTM, can be found in the following publication:

• Cisco Quick Start Guide for LAN Management Solution 2.6

You can find answers to frequently asked questions about the MWTM in the MWTM online help or in 
the User Guide for the Cisco Mobile Wireless Transport Manager 6.0.

The MWTM includes a browser-based online help system that provides overviews, related information, 
procedures, and glossary terms for the MWTM. You can select underlined text to access additional help 
topics that provide related information.

When you access online help for the MWTM the first time there might be a slight pause while your client 
browser loads the online help.
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Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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1
Overview

This chapter describes the Cisco Mobile Wireless Transport Manager (MWTM) software that manages 
IP Transfer Point (ITP) and Radio Access Network Optimization (RAN-O) networks. It includes:

• What is the MWTM?, page 1-1

• What is ITP?, page 1-6

• What is RAN-O?, page 1-7

• How Do I Identify My Network Type?, page 1-8

• What is Client/Server Architecture?, page 1-8

What is the MWTM?
The MWTM is a network management software product that network administrators use to discover, 
manage, and troubleshoot networks that include Cisco ITP and Cisco RAN-O nodes. The MWTM 
provides:

• Server and Network Features, page 1-2

• Graphical User Interface and Web Features, page 1-2

• Event Monitoring Features, page 1-3

• Performance Features, page 1-3

• Provisioning Features (ITP Only), page 1-3

• Security Features, page 1-4

• Topology Features, page 1-4

• Troubleshooting Features, page 1-4

• Customization Features, page 1-4

• Integration Features, page 1-5
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Server and Network Features
The MWTM:

• Uses client/server architecture. See What is Client/Server Architecture?, page 1-8 for more details.

• Supports Windows and Solaris clients and Solaris and Linux servers, and provides data access 
through a Web browser.

• Supports large networks and is verified to work with a network containing more than 1,000 cell sites, 
or 150 Cisco ITP nodes and 20 clients connected to the server.

• Allows multiple MWTM servers to monitor the network simultaneously, providing data redundancy. 
Clients have server failure recognition and automatic failover capabilities. MWTM clients will 
automatically switch to a backup server when the primary server is not available (in network 
problems or hardware failures, for example).

• Discovers the entire Cisco ITP network and displays the ITP nodes, neighboring SS7 equipment, 
and linksets in tables and in a network topology drawing that you can customize. 

• Discovers the entire Cisco RAN-O network and displays each network element, neighboring 
equipment, and physical and logical connections in a network topology drawing that you can 
customize.

• Lets you create custom views and subviews for grouping similar nodes together, where the state of 
the subview is the aggregation of the states of the contained nodes.

• Provides a command-line interface (CLI) on the server.

• Allows clients to connect to a server through the IP network; clients work across a Virtual Private 
Network (VPN) connection through a firewall that supports port forwarding or Network Address 
Translation (NAT), and through a Secure Sockets Layer (SSL) connection.

• (ITP only) Supports concurrent network indicators and variants; ANSI, China, ITU, NTT, and TTC 
point code variants; three- and four-octet point code formats; multiple secondary point codes; SS7 
instance translation; and virtual linksets.

Graphical User Interface and Web Features
The MWTM:

• Provides a Java-based, easy-to-use GUI on the client with an easy-to-navigate tree display of all 
network objects as well as extensive web-based online help.

• Provides an extensive HTML-based web interface. Most of the primary GUI client features are also 
available on the web interface except the topology map, real-time data charts, and event management 
(and, for ITP networks, route table and GTT file configuration).
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Event Monitoring Features
The MWTM:

• Displays a real-time event list that supports acknowledgement, annotation, customized filtering, and 
field viewing that conform to ITU-T Q.733 standards.

• Receives native traps from nodes in the Cisco RAN-O and Cisco ITP solutions and uses SNMP 
polling to identify the status of each managed RAN-O node and the status of links, linksets, and ITP 
platforms. The MWTM uses easy-to-recognize, color-coded icons to report the status.

• Monitors Cisco ITP nodes running Message Transfer Part Level 3 (MTP3) User Adaptation (M3UA) 
or Signaling Connection Control Part (SCCP) User Adaptation (SUA) application servers, as well 
as servers with multiple signaling points or variants acting as gateways.

• Provides web-based status monitoring, alarm viewing, sorting, filtering, archiving, online 
documentation, and client download.

• Provides external script execution on the server and sound playing on the client; both are triggered 
by events or alarms, and you can also customize them.

Performance Features
The MWTM:

• Provides extensive web-based accounting and network statistics reports for:

– Cisco RAN-O nodes—Network utilization and detailed interface-level statistics

– Cisco ITP nodes—Network efficiency, detailed interface-level statistics, Q.752-based statistics 
reports, and point code inventory reports, including MTP3, GTT, M3UA/SUA, MSU, and 
multilayer routing reports

• Displays real-time data rate and usage line graphs

• Supports options to configure collection intervals, record aging and statistics export via 
comma-separated values (CSV) format files

Provisioning Features (ITP Only)
The MWTM:

• Assists in provisioning destination point code (DPC) route tables, global title translation (GTT) 
tables, multilayer routing (MLR) address tables, links and linksets by providing GUI-based editing; 
reduces errors by checking syntax and semantics before deploying the tables to the Cisco ITP node.

• Provides revision management and archiving of DPC route, GTT, and MLR address tables; can 
re-deploy a known good configuration in the event of a misconfiguration. Stores time of change, user 
ID, and comments for each change.

• Provides a deployment wizard that simplifies the process of transferring and activating GTT and 
DPC route-table configuration files onto Cisco ITP nodes. The wizard takes you through 
deployment step-by-step and learns along the way to speed up future deployments. 
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Security Features
The MWTM provides:

• Management of SSL certificates via the GUI

• Multi-level password-protected access for multiple users

• Multiple user authentication methods (OS-based and standalone)

• Passwords that users can change using the GUI

• Password enforcement policies (aging, minimum length, and lockouts)

• Audit trails of all user actions and all access via the web interface

• Security logs

• Optional access via VPN, Secure Shell (SSH), and SSL

Topology Features
The MWTM:

• Automatically discovers the network from any node, with links to unsupported nodes, and creates 
topological (graphical) and tabular (text) views of the network.

• Shows network objects as color-coded glyphs on a topology map, with right-click menus and layout, 
zoom, find, grid, hide, show, and save-as-JPEG functions. The topology map can be organized into 
one or more submaps, with a single object representing groups of network objects on the main 
topology map.

• Shows detailed data (including alarm and node data) in columns that can be resized, sorted, or 
hidden, depending on your preferences.

Troubleshooting Features
The MWTM provides:

• Troubleshooting tools that you can customize to help reduce the total time to resolution of network 
or node problems

• Integrated, online, context-sensitive help

Customization Features
The MWTM:

• Automatically saves your preferences, such as the size of specific windows or the order of columns 
in a window, and automatically applies those preferences whenever you launch the MWTM client.

• Polls the nodes on demand and at user-defined intervals, and reports the real-time status of all 
network objects and events, including the reason for any changes in status.

• Receives SNMP traps natively to drive alarms, and accurate and up-to-date status displays.
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You can:

• Customize the MWTM personality to show menus, options, and tools that are only for ITP networks 
or only for RAN-O networks, or, if required, for both network types. You customize the personality 
preference during installation. You can change the personality type later, if required, through the 
command line.

• Customize the GUI, topology, and tabular views to meet your specific needs. You can save 
customized views and subviews for future use and reference, and share them with other network 
users.

• Annotate network objects and events, attaching important information such as detailed descriptions, 
locations, service history, what triggered the event, and how often it has occurred.

• Customize the display category, severity, color, and message that you see with events. You can even 
have the MWTM play unique sounds for different types of events.

• Automate events, calling UNIX scripts to drive automatic paging, e-mail, and so on.

• Forward SNMP traps, and MWTM events in the form of SNMP traps, to other hosts, such as the 
Cisco Info Center (CIC) and the Micromuse Netcool suite of products.

• (ITP only) Load destination point code (DPC) route tables, GTT tables, and MLR address tables 
from files or from ITPs, configure the tables in the MWTM client, and deploy and activate the tables 
on ITPs. Supports GTT file format versions 3.1, 4.0, and 4.1. Supports cross-instance GTT files. 
Provides command-line verification of route tables and GTT tables.

Integration Features
The MWTM can integrate with:

• The entire suite of CiscoWorks LMS 2.6 products, including:

– Resource Manager Essentials, which provides network management for Cisco ITP and RAN-O 
nodes.

– CiscoView Element Manager, which provides dynamic status, monitoring, and configuration 
information for a broad range of Cisco internetworking products.

You can launch the CiscoView Element Manager and the CiscoWorks Device Center directly from 
the topology map for quick drill-down network analysis.

• The Cisco Transport Controller (CTC) on the Cisco Optical Networking System (ONS) 15454 for 
managing alarms and provisioning circuits on the SONET or SDH traffic cards. You can launch the 
CTC from a right-click menu in the MWTM client.

The MWTM:

• Receives SNMP traps and generates Cisco MWTM-specific traps for forwarding to external 
SNMP-based network management applications such as Cisco Info Center or IBM Tivoli/NetCool.

• Stores statistics in CSV format files for extracting performance and key performance indicators.

• Processes northbound Cisco ITP and RAN-O events, inventory, and provisioning XML/SOAP APIs, 
allowing 3rd-party OSSs to programmatically manage:
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What is ITP?
The Cisco hardware and software SS7-over-IP (SS7oIP) solution includes the ITP, which provides a 
reliable, cost-effective medium for migrating Signaling System 7 (SS7), the telecommunications 
network signaling technology, to the mobile wireless industry IP environment. The ITP off-loads SS7 
traffic onto the IP network, replacing the mobile service provider’s signaling network with a redundant 
IP cloud.

In the ITP, and in the MWTM, a node is a Cisco ITP or a legacy SS7 device (SSP, SCP, or STP).

A Cisco ITP node can have multiple signaling points. Signaling points are identified with unique 
addresses called point codes. Point codes are carried in signaling messages that are exchanged between 
signaling points to identify the source and destination of each message.

Signaling points and legacy SS7 nodes are connected by links, and multiple links are grouped in a linkset. 
Each link is assigned to a single linkset, but each linkset can have multiple links. Links within the same 
linkset must be parallel between the same signaling points or nodes. 

In the MWTM, a linkset is a representation of two linksets that are associated with two signaling points 
or nodes, one for each side of a logical connection.

An application server is a logical entity serving a specific routing key.

The application server implements a set of one or more unique application server processes, of which 
one or more is normally actively processing traffic. An application server process is an IP-based instance 
of an application server, such as Call Agents, HLRs, SMSCs, and so on. An application server process 
can implement more than one application server.

An application server process association is the ITP virtual view of an application server process. The 
application server process association resides and is defined on the ITP.

Events • Retrieving all or filtered list of events (based on time, event ID, severity, 
category, message text)

• Clearing event alarms

• Changing event severity 

• Acknowledging events

• Attaching text notes to events

Inventory • Retrieving all inventory objects 

• Retrieving a specific inventory object 

• Walking the MWTM inventory tree

• Attaching text notes to an inventory object

Provisioning 
(ITP only)

• Customizing the MWTM templates when necessary

• Configuring:

– linksets 

– links

– application servers

– application server processes
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A signaling gateway-mated pair is a pair of signaling gateways that exchange necessary state 
information by using the Signaling Gateway Mate Protocol (SGMP).

Collectively, nodes, signaling points, linksets, links, application servers, application server processes, 
application server process associations, and signaling gateway-mated pairs are known as managed 
objects.

For more information about ITP, including procedures for configuring ITP objects, see the IP Transfer 
Point (ITP) feature module for Cisco IOS software release 12.2(25)SW5 or later.

What is RAN-O?
Radio Access Network Optimization (RAN-O) delivers standard-based, end-to-end, IP connectivity for 
GSM and UMTS RAN transport. The solution Cisco offers frames RAN voice and data frames into IP 
packets at the cell-site, and transports them seamlessly over an optimized backhaul network. At the 
central site, the RAN frames are extracted from IP packets and the Abis or Iub data streams are rebuilt. 
The result is a transparent, radio vendor-agnostic, RAN IP transport and optimization solution that 
delivers nominal optimization efficiency of 50% without any impact on voice quality. 

In RAN-O, and in the MWTM, a node is a Cisco RAN-O device. A RAN node can be one of the 
following:

• Cisco MWR 1941-DC-A router

• Cisco ONS 15454 SONET multiplexer

• RAN Service Module (card in the Cisco ONS 15454 SONET multiplexer)

• Unmanaged RAN node (BSC, RNC, BTS, or Node B)

Note The MWTM does not manage BSC, BTS, RNC, or Node B objects but displays them in the topology 
window to help you visualize the network.

RAN interfaces that are available on the nodes interconnect nodes in a RAN-O network. A Cisco RAN-O 
node can have multiple RAN interfaces. 

Cards are the modules that reside in the Cisco ONS 15454 SONET multiplexer. 

IP backhauls are the trunks that transport optimized voice and data traffic between a remote cell-site 
RAN-O node and an aggregation RAN-O node at a central site.

RAN shorthauls are the interfaces that transport GSM or UMTS voice and data traffic between the Base 
Transceiver Station (BTS) or Node-B and the RAN-O node at the cell site. At the aggregation site, RAN 
shorthauls exist between the RAN-O node and the BSC or RNC.

RAN backhauls describe the end-to-end RAN connections between the BTS or Node-B at the cell site 
and the BSC or RNC. 

Collectively, nodes, interfaces, cards, and RAN backhauls and shorthauls are known as managed objects.

For more information about RAN-O objects, see: 

• Cisco MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration Guide:

http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_chapter0
9186a00804d45e1.html

• Cisco ONS 15454 RAN Service Module Software Configuration Guide: 
http://www.cisco.com/en/US/products/hw/optical/ps2006/products_configuration_guide_book091
86a0080787fc2.html

http://www.cisco.com/en/US/products/hw/optical/ps2006/products_configuration_guide_book09186a0080787fc2.html
http://www.cisco.com/en/US/products/hw/optical/ps2006/products_configuration_guide_book09186a0080787fc2.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_chapter09186a00804d45e1.html
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How Do I Identify My Network Type?
The MWTM typically manages ITP or RAN-O networks, but it can also manage both network types 
simultaneously. To determine the type of network that the MWTM is managing, launch the MWTM (by 
using either the MWTM client or web interface), and observe the network type in the title bar. For 
example, if the MWTM is managing both network types, the title bar displays (ITP RAN-O).

You can also click on a node in the left tree of the MWTM main window to view detailed information 
about the node in the right pane. The Node Type and other information provide enough details to 
determine the type of network you are managing. 

If you are using the MWTM to manage ITP and RAN-O networks, you can uniquely identify node types 
by the DNS hostnames that you assign to them. For example, you can incorporate the string itp into the 
hostname of an ITP node (as in itp-75). Similarly, RAN-O nodes can employ a unique host naming 
scheme (for example, rano-34). In addition, you can separate the ITP and RAN-O node types into 
different management subviews with, for example, one subview for ITP and another subview for RAN-O 
nodes. For more information about creating views and subviews, refer to Chapter 7, “Managing Views.”

What is Client/Server Architecture?
The MWTM provides central services and database functions on an MWTM server, which 
communicates through a messaging interface with multiple MWTM clients.

The MWTM supports a maximum of 20 clients per MWTM server.

The MWTM comprises server and client software components that can be installed on the same 
workstation or on different workstations. The MWTM server is currently available on Solaris or Linux. 
The MWTM client is available on Solaris and Windows XP Professional.

Figure 1-1 The MWTM Client/Server Architecture
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Note The MWTM client is also available on Linux, but is not a supported feature of the MWTM. Use it under 
advisement. 

The client/server architecture is cross-platform compatible, with which you can run the client and server 
software in mixed operating system environments. For example, you can run the MWTM server on a 
Solaris or Linux workstation, and access it from an MWTM client running on Windows XP Professional.

The MWTM server software comprises a group of functional services that manage the data among the 
network, client workstations, and the centralized database. The MWTM server manages the exchange of 
data between the MWTM database and the network nodes. The MWTM process manager launches and 
manages all of the MWTM server processes, providing a robust and reliable launching platform for the 
MWTM.

The MWTM client software communicates with the MWTM server. You can install the MWTM client 
software on the same workstation as the MWTM server software, or on a different workstation on the 
same network as the MWTM server. After you install the MWTM server, you can download the MWTM 
client software from the web, for easy distribution to users and easier access to important information.

Note For detailed information on installing the MWTM server and client software, refer to the Installation 
Guide for the Cisco Mobile Wireless Transport Manager 6.0.
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Configuring Security

Before you set up your server for discovering, monitoring, and configuring your Cisco network, you 
need to make some decisions about the level of security you desire in your network management. With 
the MWTM, you can determine how you want users to authenticate, whether you want encrypted data 
between the application client and the server, and if you want to limit client access to specific IP 
addresses.

This chapter provides information about configuring Cisco Mobile Wireless Transport Manager 
(MWTM) security and limiting access to the MWTM:

• Configuring User Access, page 2-1

• Implementing SSL Support in the MWTM, page 2-20

• Limiting MWTM Client Access to the MWTM Server (Server Only), page 2-31

• Backing Up or Restoring MWTM Files (Server Only), page 2-32

• Removing MWTM Data from the MWTM Server, page 2-33

Configuring User Access
You can use the MWTM to control who is allowed to do what in the MWTM, beyond simply specifying 
root and nonroot users. The MWTM calls this ability user-based access.

User-based access provides multilevel, password-protected access to MWTM features. Each user can 
have a unique user name and password. You can also assign each user to one of five levels of access, 
which control the list of MWTM features accessible by that user.

To configure MWTM user access, perform the tasks in the following sections. Required and optional 
tasks are indicated:

Required:

• Implementing Secure User Access (Server Only), page 2-2 

• Creating Secure Passwords, page 2-5

• Configuring MWTM User Account Levels (Server Only), page 2-5 

Optional:

• Automatically Disabling Users and Passwords (Server Only), page 2-8 

• Manually Disabling Users and Passwords (Server Only), page 2-11

• Enabling and Changing Users and Passwords (Server Only), page 2-12 
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• Displaying a Message of the Day (Server Only), page 2-13 

• Manually Synchronizing Local MWTM Passwords (Server Only), page 2-15 

• Listing All Currently Defined Users (Server Only), page 2-16 

• Displaying the Contents of the System Security Log (Server Only), page 2-16 

• Restoring Security-Related MWTM Data (Server Only), page 2-17 

• Disabling MWTM User-Based Access (Server Only), page 2-18 

• Specifying a Super User (Server Only), page 2-18 

Implementing Secure User Access (Server Only)
Before you can access the full suite of security commands in the MWTM, you must enable MWTM user 
access, configure the type of security authentication you want, and add users to your user lists.

After you implement user access for the MWTM, users must log in to the system to access the:

• MWTM client interface

• MWTM web interface

• Event Editor

• Global Title Translation (GTT) Editor (ITP only)

• Address Table Editor (ITP only)

Note After you implement MWTM user access, if a user logs in on one client, then logs in on a second client, 
the MWTM closes the first client and records the event in the system security log.

Security Authentication 

Two types of security authentication are possible:

• Local authentication: You can create user accounts and passwords that are local to the MWTM 
system. When using this method, you can use MWTM user access commands to manage user names, 
passwords, and access levels.

• Solaris/Linux authentication: Uses standard Solaris- or Linux-based user accounts and passwords, 
as specified in the /etc/nsswitch.conf file. The local /etc/passwd file or a distributed Network 
Information Services (NIS) system can provide authentication. You can use all MWTM user access 
commands except: 

– mwtm disablepass

– mwtm passwordage

– mwtm userpass

In addition, if you have enabled Solaris/Linux authentication, you must be logged in as the root user, 
not as a superuser, to use:

– mwtm adduser

– mwtm updateuser

– mwtm authtype
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User Levels

You can configure one of five account levels for each user. Valid levels are:

1. Basic User

2. Power User

3. Network Operator

4. Network Administrator

5. System Administrator

For more information about account levels, see Configuring MWTM User Account Levels (Server 
Only), page 2-5.

User Passwords

The method that you use for setting user passwords depends on the type of authentication that you 
configure on the MWTM system (local or solaris).

Local Authentication

If mwtm authtype is set to local, the MWTM prompts you to:

• Enter the user password. When setting the password, follow the rules and considerations in Creating 
Secure Passwords, page 2-5.

• Force the user to change the password at the next login. The default is to not force the user to change 
the password.

Whenever a user must change a password, the MWTM issues an appropriate message, and prompts for 
the user name and new password.

Solaris Authentication

If mwtm authtype is set to solaris or linux, users cannot change their passwords by using the MWTM 
client. Instead, they must manage their passwords on the external authentication servers by using Solaris 
or Linux commands, such as passwd. 

All new passwords take effect the next time the MWTM automatically synchronizes local MWTM 
passwords with Solaris or Linux. You can manually synchronize passwords at any time using the 
mwtm syncusers command. See mwtm syncusers, page B-63 for more information.
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Enabling Secure User Access

To enable secure user access for the MWTM:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Enter the following commands:

cd /opt/CSCOsgm/bin

./mwtm useraccess enable

~text elided~

The valid choices for authentication type are solaris and local

Please choose the type of authentication to use: [local]

Step 3 To choose solaris authentication, enter solaris.

Step 4 To choose local authentication (default), press Enter.

User Based Access Protection is Enabled.

~text elided~

Step 5 To add a user to your MWTM authentication list, use:

./mwtm adduser username

where username is the name of the user.

Note If mwtm authtype is set to solaris or linux, you must be logged in as the root user, not as a 
superuser, to enter this command.

Step 6 Enter a password for the user. (You are prompted to enter the password twice.)

Step 7 Repeat from Step 5 to add additional users.

Step 8 To activate your security changes on the MWTM client, restart the MWTM server:

./mwtm restart

The MWTM client restarts all server processes. (This might take several minutes to complete.)

Step 9 To activate your security changes on the MWTM web interface, clear the browser cache and restart the 
browser.

Step 10 Use the remaining procedures in this chapter to further customize your MWTM security system.
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Creating Secure Passwords
When setting passwords in the MWTM, the:

• Password must be at least 6 characters, up to 15 characters.

• Password cannot be identical to the user name.

• New password cannot be the same as the old password.

• MWTM does not allow users to switch back and forth between two passwords.

• Password cannot be a commonly used word. The MWTM server uses the system dictionary at 
/usr/share/lib/dict/words (Solaris) or /usr/share/dict/words (Linux) to determine whether a word is 
a commonly used word. 

To use your own dictionary, add a line to the System.properties file:

– To disable the MWTM dictionary and allow common words, add:

DICT_FILE=/dev/null

– To use a custom dictionary, add:

DICT_FILE=/new-dictionary

where new-dictionary is the path and filename of the custom dictionary file, such as 
/users/usr11/words. Each line in the custom dictionary must contain a single word, with no 
leading or trailing spaces.

Configuring MWTM User Account Levels (Server Only)
This section describes the user account levels, and the MWTM client and web interface actions that are 
available at each level:

• Basic User (Level 1) Access, page 2-6

• Power User (Level 2) Access, page 2-7

• Network Operator (Level 3) Access, page 2-7

• Network Administrator (Level 4) Access, page 2-8

• System Administrator (Level 5) Access, page 2-8

The account level that includes an action is the lowest level with access to that action. The action is also 
available to all higher account levels. For example, a System Administrator also has access to all 
Network Administrator actions.

Account levels are based on the action to be performed, not on the target network element. Therefore, if 
a user can perform an action on one MWTM network element (such as deleting a node), the user can 
perform the same action on all similar MWTM network elements (such as deleting an interface, signaling 
point, or linkset).

Note Access to MWTM information and downloads on Cisco.com is already protected by Cisco.com, and is 
not protected by the MWTM.
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To configure the account level for a user, use the mwtm adduser command, as described in 
Implementing Secure User Access (Server Only), page 2-2, or the mwtm updateuser or mwtm 
newlevel command, as described in Enabling and Changing Users and Passwords (Server Only), page 
2-12.

Basic User (Level 1) Access

Basic users can view MWTM data, load MWTM files, and use MWTM drill-down menus. 

The following MWTM actions in the client and web interfaces are available to basic users:

MWTM Client Interface Actions MWTM Web Interface Actions

• Connecting to a new server

• Applying changes to views

• Loading the DEFAULT View and
existing views, but not saving them

• Editing, loading, and applying
preferences files, but not saving them

• Viewing and manipulating the topology
map, and saving it as a JPEG, but not
saving icon locations

• Viewing network elements, events, 
details, and notes

• Viewing the MWTM web interface
Homepage

• Loading existing event filters, but not
saving them

• Printing MWTM windows

• Launching CiscoWorks

• Homepage

• Administrative page: System Information

• Administrative page: System Status

• Preferences
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Power User (Level 2) Access

The following MWTM actions in the client and web interfaces are available to power users:

Network Operator (Level 3) Access

The following MWTM actions in the client and web interfaces are available to network operators:

MWTM Client Interface Actions MWTM Web Interface Actions

• Accessing all basic user client actions

• Editing network elements, events, and
views

• Unignoring network elements and views

• Saving preferences files, event filters, and
views

• Acknowledging events

• Viewing real-time data and charts

• View, change and save event
configuration, but no deployment of
changes

• Homepage

• Administrative page: System Information

• Administrative page: System Status

• Preferences

MWTM Client Interface Actions MWTM Web Interface Actions

• Accessing all basic user and power user
client actions

• Accessing Troubleshooting features

• Ignoring network elements and views

• Polling nodes

• Accessing the node through Telnet

• (ITP only) Viewing route table files and
GTT files, but not editing them

• Accessing all basic user and power user web
actions

• Troubleshooting features

• Provisioning features

• Administrative page, all features
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Network Administrator (Level 4) Access

The following MWTM actions in the client and web interfaces are available to network administrators:

System Administrator (Level 5) Access

The following MWTM actions in the client and web interfaces are available to system administrators:

Automatically Disabling Users and Passwords (Server Only)
After you have implemented the basic MWTM security system, you can customize the system to 
automatically disable users and passwords when certain conditions are met (for example, a series of 
unsuccessful login attempts or a specified period of inactivity).

Tip To view a list of current users and the status of user accounts, use the mwtm listusers command (see 
mwtm listusers, page B-30).

To automatically disable users and passwords:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Becoming the Root User (Server Only), page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

MWTM Client Interface Actions MWTM Web Interface Actions

• Accessing all basic user, power user, and
network operator client actions

• SNMP configuration

• Network Discovery

• Deleting network elements

• Managing and unmanaging nodes

• (ITP only) Editing and saving route table
files, GTT files, and address table files 

• (ITP only) Using the Deployment Wizard 

• Accessing all basic user, power user, and
network operator web actions

• Reports (and File Archive reports)

MWTM Client Interface Actions MWTM Web Interface Actions

• Accessing all basic user, power user,
network operator, and network
administrator client actions

• Accessing Trap Settings

• Deploying saved event configuration
changes

• Accessing all basic user, power user,
network operator, and network administrator
web actions

• Trap settings features
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Step 2 Enter the following command:

cd /opt/CSCOsgm/bin

Step 3 (Optional) To configure the MWTM to generate an alarm after a specified number of unsuccessful login 
attempts by a user, enter:

./mwtm badloginalarm number-of-attempts

where number-of-attempts is the number of unsuccessful login attempts allowed before the MWTM 
generates an alarm.

The valid range is 1 unsuccessful attempt to an unlimited number of unsuccessful attempts. The default 
value is 5 unsuccessful attempts.

To disable this action (that is, to prevent the MWTM from automatically generating an alarm after 
unsuccessful login attempts), enter:

./mwtm badloginalarm clear

Step 4 (Optional) To configure the MWTM to disable a user’s account automatically after a specified number 
of unsuccessful login attempts, enter:

# ./mwtm badlogindisable number-of-attempts

where number-of-attempts is the number of unsuccessful login attempts allowed before the MWTM 
disables the user’s account. The MWTM does not delete the user from the user list, the MWTM only 
disables the user’s account.

The valid range is 1 unsuccessful attempt to an unlimited number of unsuccessful attempts. The default 
value is 10 unsuccessful attempts.

To re-enable the user’s account, use the mwtm enableuser command.

To disable this action (that is, to prevent the MWTM from automatically disabling a user’s account after 
unsuccessful login attempts), enter:

# ./mwtm badlogindisable clear

Step 5 (Optional) The MWTM keeps track of the date and time each user last logged in. To configure the 
MWTM to disable a user’s log in automatically after a specified number of days of inactivity, enter:

# ./mwtm inactiveuserdays number-of-days

where number-of-days is the number of days that a user can be inactive before the MWTM disables the 
user’s account. The MWTM does not delete the user from the user list, the MWTM only disables the 
user’s account.

The valid range is 1 day to an unlimited number of days. There is no default setting.

To re-enable the user’s account, use the mwtm enableuser command.

This action is disabled by default. If you do not specify the mwtm inactiveuserdays command, user 
accounts are never disabled as a result of inactivity.

If you have enabled this action and you want to disable it (that is, to prevent the MWTM from 
automatically disabling user accounts as a result of inactivity), enter:

# ./mwtm inactiveuserdays clear
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Step 6 (Optional) If mwtm authtype is set to local, you can configure the MWTM to force users to change their 
passwords after a specified number of days. 

To configure the MWTM to force users to change their passwords after a specified number of days, enter:

# ./mwtm passwordage number-of-days

where number-of-days is the number of days allowed before users must change their passwords.

Note You must have changed your password at least once for the mwtm passwordage command to 
properly age the password.

The valid range is 1 day to an unlimited number of days. There is no default setting.

Note The MWTM starts password aging at midnight on the day that you set the value. For example, 
if you use the mwtm passwordage command to set the password age to 1 day (24 hours), the 
password begins to age at midnight and expires 24 hours later.

This action is disabled by default. If you do not specify the mwtm passwordage command, users never 
need to change their passwords.

If you have enabled this action and you want to disable it (that is, prevent the MWTM from forcing users 
to change passwords), enter:

# ./mwtm passwordage clear

Note If mwtm authtype is set to solaris or linux, you cannot use the mwtm passwordage command. 
Instead, you must manage passwords on the external authentication servers.

Step 7 (Optional) To configure the MWTM to automatically disconnect a client (this includes the MWTM 
client, the GTT editor, and the address table editor) after a specified number of minutes of inactivity, 
enter:

# ./mwtm clitimeout number-of-minutes

where number-of-minutes is the number of minutes a client can be inactive before the MWTM 
disconnects the client.

The valid range is 1 minute to an unlimited number of minutes. There is no default value.

This action is disabled by default. If you do not specify the mwtm clitimeout command, clients are never 
disconnected as a result of inactivity.

If you have enabled this action and you want to disable it (that is, never disconnect a client as a result of 
inactivity), enter the following command:

# ./mwtm clitimeout clear
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Manually Disabling Users and Passwords (Server Only)
As described in the Automatically Disabling Users and Passwords (Server Only), page 2-8, you can 
customize the MWTM to automatically disable users and passwords when certain conditions are met. 
However, you can also manually disable MWTM users and passwords whenever you suspect a security 
breech has occurred. 

To disable MWTM users and passwords:

Step 1 Login to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Enter:

# cd /opt/CSCOsgm/bin

Step 3 (Optional) To delete a user entirely from the MWTM user access account list, enter:

# ./mwtm deluser username

where username is the name of the user.

If you later decide to add the user back to the account list, you must use the mwtm adduser command.

Step 4 (Optional) If mwtm authtype is set to local, you can disable a user’s password. To disable a user’s 
password, enter:

# ./mwtm disablepass username

where username is the name of the user. The MWTM does not delete the user from the account list, the 
MWTM only disables the user’s password.

Note If mwtm authtype is set to solaris or linux, you cannot use the mwtm disablepass command. 
Instead, you must manage passwords on the external authentication servers.

The user must change the password the next time he or she logs in.

You can also re-enable the user’s account with the same password, or with a new password:

• To re-enable the user’s account with the same password as before, use the mwtm enableuser 
command.

• To re-enable the user’s account with a new password, use the mwtm userpass command.

Step 5 (Optional) To disable a user’s account, but not the user’s password, enter:

# ./mwtm disableuser username

where username is the name of the user.

Note If mwtm authtype is set to solaris or linux, you must be logged in as the root user, not as a 
superuser, to enter this command.



 

2-12
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 2      Configuring Security
  Configuring User Access

The MWTM does not delete the user from the account list; the MWTM only disables the user’s account. 
The user cannot log in until you re-enable the user’s account:

• To re-enable the user’s account with the same password as before, use the mwtm enableuser 
command.

• To re-enable the user’s account with a new password, use the mwtm userpass command.

Enabling and Changing Users and Passwords (Server Only)
Of course, the MWTM also enables you to re-enable users and passwords, and change user accounts. To 
enable and change users and passwords, use the following procedures:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Enter the following command:

# cd /opt/CSCOsgm/bin

Step 3 (Optional) To re-enable a user’s account, which had been disabled either automatically by the MWTM 
or by a superuser, enter the following command:

# ./mwtm enableuser username

where username is the name of the user. The MWTM re-enables the user’s account with the same 
password as before.

Note If mwtm authtype is set to solaris or linux, you must be logged in as the root user, not as a 
superuser, to enter this command.

Step 4 (Optional) If mwtm authtype is set to local, you can change a user’s password, or re-enable the user’s 
account with a new password, if the user’s account had been disabled either automatically by the MWTM 
or by a superuser. To change a password or to re-enable a user’s account with a new password, enter:

# ./mwtm userpass username

where username is the name of the user.

The MWTM prompts you for the new password. When setting the password, follow the rules and 
considerations in the Creating Secure Passwords, page 2-5.

If the user’s account has also been disabled, the MWTM re-enables the user’s account with the new 
password.

Note If mwtm authtype is set to solaris or linux, you cannot use the mwtm userpass command. 
Instead, you must manage passwords on the external authentication servers.
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Step 5 (Optional) To change a user’s account level and password, enter the following command:

# ./mwtm updateuser username

where username is the name of the user.

Note If mwtm authtype is set to solaris or linux, you must be logged in as the root user, not as a 
superuser, to enter this command.

The MWTM prompts you for the new account level. Valid levels are described in User Levels, page 2-3:

If mwtm authtype is set to local, the MWTM also prompts you for the user’s new password. When 
setting the password, follow the rules and considerations in Creating Secure Passwords, page 2-5.

Step 6 (Optional) To change a user’s account level, but not the user’s password, enter the following command:

# ./mwtm newlevel username

where username is the name of the user.

The MWTM prompts you for the new account level. Valid levels are described in User Levels, page 2-3.

Displaying a Message of the Day (Server Only)
You can use the MWTM to display a user-specified MWTM system notice called the message of the day 
(Figure 2-1). You can use the message of the day to inform users of important changes or events in the 
MWTM system. The message of the day also gives users an opportunity to exit the MWTM client, Event 
Editor, GTT Editor (ITP only), or Address Table Editor (ITP only) before starting them.

If you enable the message of the day, it appears whenever a user attempts to launch a client. If the user 
accepts the message, the client launches. If the user declines the message, the client does not launch.

To display the Message of the Day dialog, use one of the following procedures:

• Launch a client. If there is a message of the day, the Message of the Day dialog appears.

• Choose View > Message of the Day from the MWTM main menu.

• Select the MWTM server name in the lower-right corner of the MWTM main window.
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Figure 2-1 Message of the Day Dialog

The Message of the Day dialog contains the following fields:

Field or Button Description

Message of the Day 
Last Updated

Date and time the message of the day was last updated. If there is no message 
of the day, the MWTM displays Unknown.

Message Field Text of the message of the day. If there is no message of the day, the MWTM 
displays There is no message of the day.

Accept Closes the Message of the Day dialog and launches the client.

If you do not click Accept, you cannot launch the client.

This button is available when there is a message of the day and you launch a 
client.

Decline Closes the Message of the Day dialog and exits the client.

This button is available when there is a message of the day and you launch a 
client.

OK Closes the Message of the Day dialog without exiting the client.

This button is available if you displayed the Message of the Day dialog by 
choosing View > Message of the Day from the MWTM main menu.
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To configure the MWTM to display a message of the day:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Enter the following commands:

cd /opt/CSCOsgm/bin

./mwtm motd enable

The MWTM displays:

Enter location of the message of the day file: [/opt/CSCOsgm/etc/motd]

Step 3 To accept the default value, press Enter; or type a different location and press Enter. 

The MWTM displays:

Setting Message of the Day File to: [/opt/CSCOsgm/etc/motd]
Message of the Day File set to: [/opt/CSCOsgm/etc/motd]
MWTM server must be restarted for changes to take effect.

Step 4 To create the message text (the first time) or edit the existing text, enter:

./mwtm motd edit

Step 5 To display the contents of the message of the day file, enter:

./mwtm motd cat

Step 6 To disable the message of the day file, enter:

./mwtm motd disable

Manually Synchronizing Local MWTM Passwords (Server Only)
If mwtm authtype is set to solaris or linux, the MWTM automatically synchronizes local MWTM 
passwords with the operating system at 1:30 AM each night (this setting can be changed using the root 
crontab). However, you can also manually synchronize passwords at any time. 

To manually synchronize local MWTM passwords:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 Synchronize the MWTM passwords:

./mwtm syncusers

The MWTM synchronizes the passwords with Solaris.
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Listing All Currently Defined Users (Server Only)
To list all currently defined users in the MWTM User-Based Access account list:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 List all users:

./mwtm listusers

The MWTM displays the following information for each user:

• User name

• Last time the user logged in

• User’s account access level

• User’s current account status, such as Account Enabled or Password Disabled

Step 4 To list information for a specific user, enter:

./mwtm listusers username

where username is the name of the user.

Note You can also view user account information on the MWTM User Accounts web page. For more 
information, see Viewing User Accounts, page 11-18.

Displaying the Contents of the System Security Log (Server Only)
To display the contents of the system security log with PAGER:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 Display the security log contents:

./mwtm seclog

The following security events are recorded in the log:

• All changes to system security, including adding users

• Login attempts, whether successful or unsuccessful, and logoffs
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• Attempts to switch to another user's account, whether successful or unsuccessful

• Attempts to access files or resources of higher account level

• Access to all privileged files and processes

• Operating system configuration changes and program changes, at the Solaris level

• MWTM restarts

• Failures of computers, programs, communications, and operations, at the Solaris level

Step 4 To clear the log, enter:

./mwtm seclog clear

The default path and filename for the system security log file is /opt/CSCOsgm/logs/sgmSecurityLog.txt. 
If you installed the MWTM in a directory other than /opt, then the system security log file is located in 
that directory.

Note You can also view the system security log on the MWTM System Security Log web page. For more 
information, see Viewing the Security Log, page 11-21.

Restoring Security-Related MWTM Data (Server Only)
If you inadvertently delete your user accounts, or make other unwanted changes to your MWTM security 
information, the MWTM can restore the security-related parts of the MWTM data files from the previous 
night’s backup.

To restore the security-related MWTM data files:

Step 1 Log in as the root user (for details see Starting the MWTM Client, page 4-2.

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 Restore the security-related data:

./mwtm restore security

The MWTM restores the data.
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Disabling MWTM User-Based Access (Server Only)
To completely disable MWTM User-Based Access:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Starting the MWTM Client, page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 Disable user-based access:

./mwtm useraccess disable

The MWTM user access is disabled the next time you restart the MWTM server (./mwtm restart).

Specifying a Super User (Server Only)
You can use the MWTM to specify a superuser. A superuser can perform most actions that otherwise 
require the user to be logged in as the root user. (The root user can still perform those actions, too.) If 
you specify a superuser, the server also runs as the superuser and not as the root user.

Caution As a superuser, you can adversely affect your operating environment if you are unaware of the effects of 
the commands that you use. If you are a relatively inexperienced UNIX user, limit your activities as a 
superuser to the tasks described in this document.

When you specify a superuser, remember that:

• The user must exist in the local /etc/passwd file. You cannot specify a user that is defined in a 
distributed Network Information Services (NIS) system.

• The superuser does not have access to all MWTM commands. You must still be logged in as the root 
user to enter the following commands:

– mwtm authtype

– mwtm backup

– mwtm backupdir

– mwtm browserpath

– mwtm certgui

– mwtm certtool

– mwtm clean

– mwtm cleanall

– mwtm cleandb

– mwtm cwsetup

– mwtm evilstop
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– mwtm jspport

– mwtm keytool

– mwtm killclients

– mwtm reboot

– mwtm restore

– mwtm restoreprops

– mwtm setpath, if you are specifying a username

– mwtm sounddir

– mwtm ssl

– mwtm stopclients

– mwtm superuser

– mwtm syncusers

– mwtm trapsetup

– mwtm uninstall

– mwtm webport

– mwtm xtermpath

• If mwtm authtype is set to solaris or linux, you must still be logged in as the root user to enter the 
following commands:

– mwtm adduser

– mwtm disablepass

– mwtm passwordage

– mwtm updateuser

– mwtm userpass

• If the SNMP trap port number on the MWTM server is less than 1024, you cannot use the mwtm 
superuser command. To correct this situation, you must specify a new SNMP trap port number that 
is greater than 1024:

– To change the SNMP trap port number in the nodes in your network, use the snmp-server host 
command. By default, the MWTM listens for traps from trap multiplexing nodes and NMS 
applications on port 44750, so that is a good port number to choose. The SNMP trap port 
number must be the same on all nodes in your network.

– For more information, see the description of the snmp-server host command in the “Node 
Requirements” section of the Installation Guide for the Cisco Mobile Wireless Transport 
Manager 6.0.

– Use the mwtm trapsetup command to change the SNMP trap port number in the MWTM server 
to match the port number in the nodes in your network. See mwtm trapsetup, page B-65 for more 
information.
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To specify a superuser on the MWTM server:

Step 1 Log in as the root user (see Becoming the Root User (Server Only), page 4-2).

Step 2 Change to the /bin directory:

cd /opt/CSCOsgm/bin

Step 3 Specify the superuser:

./mwtm superuser username

where username is the name of the user.

Implementing SSL Support in the MWTM
You can implement Secure Sockets Layer (SSL) support in your MWTM system. When you do, the 
MWTM uses secure sockets to encrypt all communication between the MWTM clients and server.

This section includes the following information:

• Enabling SSL Support on the MWTM Server, page 2-20

• Downloading the MWTM SSL Module for Windows Using the Web Interface, page 2-22

• Downloading the Self-Signed SSL Certificate from the MWTM Server, page 2-24

• Launching the MWTM Certificate Tool for SSL, page 2-24

• Exporting an SSL Certificate, page 2-27

• Viewing Detailed Information About a SSL Certificate, page 2-28

• Managing SSL Support in the MWTM, page 2-30

• Disabling SSL Support in the MWTM, page 2-30

Enabling SSL Support on the MWTM Server
To enable SSL support in the MWTM, perform the following:

Step 1 Install an SSL key/certificate pair in the MWTM by using one of the following procedures:

• To install a new SSL key and a self-signed certificate, generate the key and certificate by logging in 
as the root user on the MWTM server and entering the mwtm keytool genkey command.

The MWTM stops the MWTM server and these prompts appear:

Country Name (2 letter code) []:
State or Province Name (full name) []:
Locality Name (eg, city) []:
Organization Name (eg, company) []:
Organizational Unit Name (eg, section) []:
Common Name (your hostname) []:
Email Address []:

Enter the requested information.

The MWTM generates the following files:
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– /opt/CSCOsgm/etc/ssl/server.key is the MWTM server’s private key. Ensure that unauthorized 
personnel cannot access this key.

– /opt/CSCOsgm/etc/ssl/server.crt is the self-signed SSL certificate.

– /opt/CSCOsgm/etc/ssl/server.csr is a certificate signing request (CSR). It is not used if you are 
using a self-signed SSL certificate.

• To install a new SSL key and a certificate signed by a certificate authority (CA), generate the key 
and a CSR by logging in as the root user on the MWTM server and entering the 
mwtm keytool genkey command.

The MWTM stops the MWTM server and issues the following prompts:

Country Name (2 letter code) []:
State or Province Name (full name) []:
Locality Name (eg, city) []:
Organization Name (eg, company) []:
Organizational Unit Name (eg, section) []:
Common Name (your hostname) []:
Email Address []:

Enter the requested information.

The MWTM generates the following files:

– /opt/CSCOsgm/etc/ssl/server.key is the MWTM server’s private key. Ensure that unauthorized 
personnel cannot access this key.

– /opt/CSCOsgm/etc/ssl/server.csr is a CSR.

– /opt/CSCOsgm/etc/ssl/server.crt is the self-signed SSL certificate. It is not used if you are using 
a CA-signed SSL certificate; the CA-signed certificate overrides the self-signed certificate.

Print the CSR in X.509 format, by logging in as the root user on the MWTM server and entering the 
mwtm keytool print_csr command.

Send the CSR to a CA to be signed.

After the CA signs the certificate, log in as the root user on the MWTM server and enter the 
following command:

./mwtm keytool import_cert cert_filename

where cert_filename is the name of the signed certificate.

The MWTM stops the MWTM server and imports the certificate in X.509 format.

• To use an existing signed key/certificate pair, log in as the root user on the MWTM server and enter 
the following command:

./mwtm keytool import_key key_filename cert_filename

where key_filename is the name of the existing SSL key and cert_filename is the name of the existing 
signed certificate.

The MWTM stops the MWTM server and imports the SSL key in OpenSSL format and the signed 
SSL certificate in X.509 format.

Step 2 Enable SSL support in the MWTM, by logging in as the root user on the MWTM server and entering the 
mwtm ssl enable command.

Step 3 Restart the MWTM server. 
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Step 4 Set up the MWTM client-side SSL certificate trust relationship, by downloading and importing the 
self-signed or CA-signed certificate on every remote MWTM client, Windows as well as Solaris, that 
connects to the MWTM server.

a. (Self-signed certificate only) Download the self-signed certificate (server.crt) by using the 
procedure in Downloading the Self-Signed SSL Certificate from the MWTM Server, page 2-24.

b. Import the self-signed or CA-signed certificate by using the procedure in Launching the MWTM 
Certificate Tool for SSL, page 2-24.

Step 5 Restart the MWTM client.

The MWTM clients can now connect to the MWTM server by using SSL. All communication between 
the server and clients is encrypted.

If an MWTM client, GTT editor (ITP only), or Address Table editor (ITP only) that is not SSL-enabled 
attempts to connect to an SSL-enabled MWTM server, the MWTM displays an appropriate warning 
message and opens the MWTM Client for Windows page. You can then download and install a new 
MWTM SSL module for the client to use to connect to that MWTM server.

If the client is SSL-enabled but does not have the correct certificate, the MWTM displays an appropriate 
warning message and opens the MWTM Server SSL Certificate page. You can then download the signed 
SSL certificate in X.509 format to the client.

Downloading the MWTM SSL Module for Windows Using the Web Interface
To install the MWTM SSL module on a Windows system from the MWTM web interface:

Step 1 From your browser, go to the URL for the MWTM Homepage:

http://your_mwtm_server:1774

where your_mwtm_server is the name or IP address of the MWTM server and 1774 is the web port being 
used by the MWTM (1774 is the default port number.) If you do not know the name or web port of the 
MWTM server, contact the system administrator who installed the MWTM server software.

The MWTM web interface home page appears (Figure 2-2).
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Figure 2-2 The MWTM Web Interface Home Page

Step 2 Click Download Windows Client. Ensure that your browser is pointed to an MWTM, SSL-enabled 
server.

Step 3 Right-click Download SSL Module for MWTM Client on Windows XP. Choose the Save Link As or 
Save Target As option. 

Note If you are using Internet Explorer, change the .zip extension to .jar during the Save Target As 
option. 

Step 4 When queried, save the file under <Installed Drive>:\Program Files\Cisco Systems\MWTMClient\lib 
where <Installed Drive> is the disk on which the MWTM client is installed.

Step 5 You are prompted to launch the client, then download the self-signed SSL certificate (follow the 
subsequent procedures).
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Downloading the Self-Signed SSL Certificate from the MWTM Server
If you have implemented Secure Sockets Layer (SSL) support in your MWTM system, you can download 
the MWTM server’s signed SSL certificate to all remote MWTM clients that connect to the server using 
SSL.

To download the certificate from the MWTM Server SSL Certificate page, use the following procedure 
on each remote MWTM client:

Step 1 In a web browser, enter the following URL:

https://server_name:1774

where server_name is the name or IP address of the server on which the MWTM server is running 
and 1774 is the Web port being using by the MWTM (1774 is the default port number.) If you do 
not know the name or Web port of the MWTM server, contact the system administrator who installed 
the MWTM server software.

The Server SSL Certificate page appears.

Step 2 Right-click Download Server SSL Certificate.

Step 3 Select Save Link As (or Save Target As) from the right-click menu.

Step 4 Select a directory in which to save the certificate (server.crt), and click Save. The MWTM downloads 
the server.crt file into the specified directory.

Launching the MWTM Certificate Tool for SSL
If you have implemented Secure Sockets Layer (SSL) support in your MWTM system, you can launch 
the MWTM Certificate Tool for SSL. The MWTM Certificate Tool dialog box lists all SSL certificates 
that the MWTM client imported. In this dialog box, you specify whether to import, export, and display 
detailed information about SSL certificates.

To launch the MWTM SSL Certificate Tool, use one of the following procedures:

• In Solaris, log in as the root user and enter the following commands:

cd /opt/CSCOsgm/bin

./mwtm certgui

See mwtm certgui, page B-10 for more information.

• In Windows, choose Start > Programs > Cisco MWTM Client > MWTM SSL Certificate Tool.

The MWTM displays the MWTM Certificate Tool dialog box.
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Figure 2-3 The MWTM Certificate Tool Dialog

For each SSL certificate, the MWTM Certificate Tool dialog box displays:

Field or Button Description

Issued to Host name of the MWTM server to which the SSL certificate was issued.

Issued by Certificate authority (CA) that issued the SSL certificate.

Self-signed SSL certificates display the hostname of the MWTM server.

Expiration Date Date on which the SSL certificate expires.

Import Displays the Open dialog box for an SSL certificate, which you use to import 
SSL certificates (for details, see Importing an SSL Certificate to an MWTM 
Client, page 2-26).

Export Displays the Save dialog box for an SSL certificate, which you use to export 
the selected SSL certificate.

Remove Removes the selected SSL certificate from the table.

Details Displays the Certificate Information dialog box, which provides detailed 
information about the selected certificate.

Exit Closes the MWTM Certificate Tool dialog box.

Help Displays online help for the current window.
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Importing an SSL Certificate to an MWTM Client

If you have implemented Secure Sockets Layer (SSL) support in your MWTM system, you can import 
the MWTM server’s self-signed SSL certificate, or a CA-signed SSL certificate, to all remote MWTM 
clients that connect to the server using SSL.

Note If you are using a Solaris client, you can import by using the MWTM SSL Certificate Tool as described 
in this section, or the CLI command mwtm certtool (for details, see mwtm certtool, page B-10). If you 
are using a Windows client, you must use the MWTM SSL Certificate Tool. 

To import an SSL certificate, launch the MWTM SSL Certificate Tool, as described in Launching the 
MWTM Certificate Tool for SSL, page 2-24, then click Import. The MWTM displays the Open dialog 
box for SSL certificates.

Figure 2-4 Open Dialog for SSL Certificates

Use the Open dialog box to locate the SSL certificate that you want to import. The Open dialog box 
contains:

Field or Button Description

Look In Click to select the directory in which you want to find the SSL certificate. 
Accept the default directory, or select a new directory from the drop-down list 
box.

For a self-signed certificate, locate the directory in which you downloaded the 
certificate.

File Name Enter a name for the SSL certificate, or select a file from those listed in the 
Open field. The MWTM displays the name of the certificate in the File Name 
field.

Files of Type Specifies the type of file to display, and displays all files of that type in the 
selected directory. For SSL certificates, this field displays All files, which 
means files of all types appear in the table.
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Exporting an SSL Certificate
If you have implemented Secure Sockets Layer (SSL) support in your MWTM system, you can export 
SSL certificates that have been imported to the MWTM client.

To export a SSL certificate, launch the MWTM SSL Certificate Tool, as described in Launching the 
MWTM Certificate Tool for SSL, page 2-24, select a certificate from the list, then click Export. The 
MWTM displays the Save dialog for SSL certificates.

Figure 2-5 Save Dialog for SSL Certificates

Up One Level Displays the subfolders and files that are in the folder that is up one level from 
the currently visible folder.

Desktop Displays the subfolders and files that are on your workstation desktop.

Create New Folder Creates a new subfolder in the visible folder.

List Displays only icons for subfolders and files.

Details Displays detailed information for subfolders and files, including their size, 
type, date they were last modified, and so on.

Open Imports the file, closes the Open dialog box for an SSL certificate, and 
populates the MWTM Certificate Tool dialog box with the SSL certificate’s 
information.

Cancel Closes the Open dialog box for an SSL certificate without importing the file.

Field or Button Description



 

2-28
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 2      Configuring Security
  Implementing SSL Support in the MWTM

Use the Save dialog box to export the SSL certificate to another directory. The Save dialog box contains:

Related Topics:

Launching the MWTM Certificate Tool for SSL, page 2-24

Viewing Detailed Information About a SSL Certificate
If you implemented Secure Sockets Layer (SSL) support in your MWTM system, you can view detailed 
information about SSL certificates that were imported to the MWTM client.

To view detailed information about an SSL certificate, use one of the following procedures:

• Click the locked padlock icon in the lower-left corner of any MWTM window.

• Launch the MWTM SSL Certificate Tool, as described in Launching the MWTM Certificate Tool 
for SSL, page 2-24, select an SSL certificate from the list and click Details.

The MWTM displays the Certificate Information dialog.

Field or Button Description

Save In Click to select the directory in which you want to save the SSL certificate. 
Accept the default directory, or select a new directory from the drop-down list 
box.

For a self-signed certificate, locate the directory in which you downloaded the 
certificate.

File Name Enter a name for the SSL certificate, or select a file from those listed in the 
Save In field. The MWTM displays the name of the certificate in the File 
Name field.

Files of Type Specifies the type of file to save, and displays all files of that type in the 
selected directory. For SSL certificates, this field displays All files, which 
means files of all types.

Up One Level Displays the subfolders and files that are in the folder that is up one level from 
the currently visible folder.

Desktop Displays the subfolders and files that are on your workstation desktop.

Create New Folder Creates a new subfolder in the visible folder.

List Displays only icons for subfolders and files.

Details Displays detailed information for subfolders and files, including their size, 
type, date they were last modified, and so on.

Save Saves the file, closes the Save dialog box for an SSL certificate, and returns to 
the MWTM Certificate Tool dialog box. Click Exit to close the MWTM 
Certificate Tool dialog box and export the self-signed SSL certificate in X.509 
format.

Cancel Closes the Save dialog for an SSL certificate without saving the file.
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Figure 2-6 Certificate Information Dialog Box

For the selected SSL, the Certificate Information dialog box displays:

Field or Button Description

Subject Node to which the SSL certificate was issued.

The Subject field always includes the Common Name (CN) of the subject, 
which must match the fully qualified hostname of your MWTM server, such 
as xxxx.company.com.

The Subject field might also contain other information, such as the Country 
(C), Organizational Unit (OU), or Organization (O) of the subject.

Issuer CA that issued the SSL certificate.

The Issuer field might include the Common Name (CN) of the issuer, as well 
as the Country (C), Organizational Unit (OU), or Organization (O) of the 
issuer.

Version Version of the SSL certificate, such as V1.

Serial number Serial number associated with the SSL certificate.

Signature algorithm Asymmetric algorithm ensures that the digital signature is secure, such as 
MD5withRSA.

Valid from Date and time on which the SSL certificate was created or became valid.

Valid to Date and time on which the SSL certificate expires.
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Related Topics:

Launching the MWTM Certificate Tool for SSL, page 2-24

Managing SSL Support in the MWTM
You use the MWTM to manage SSL support. To:

• Display the current status of SSL support in the MWTM, including whether SSL support is enabled 
or disabled and which SSL keys and certificates exist, use either the mwtm ssl status or 
mwtm sslstatus command.

• Print the MWTM server’s SSL certificate in X.509 format, use the mwtm keytool print_crt 
command.

• List the SSL key/certificate pair on the MWTM server, use the mwtm keytool list command.

• List all SSL certificates on the MWTM client, launch the MWTM SSL Certificate Tool. The MWTM 
lists each imported certificate, including to whom the certificate was issued, who issued the 
certificate, and when the certificate expires.

See Appendix B, “Command Reference” for more information on the use of these commands.

See Exporting an SSL Certificate, page 2-27 for more information on launching the MWTM SSL 
Certificate Tool.

Disabling SSL Support in the MWTM
You use the MWTM to disable SSL support in the MWTM, and to remove SSL keys and certificates from 
the MWTM server and clients. To:

• Disable SSL support in the MWTM, use the mwtm ssl disable command.

See mwtm ssl, page B-59 for more information.

• Remove all SSL keys and certificates from the MWTM server, use the mwtm keytool clear 
command. The MWTM stops the MWTM server, if necessary, and removes the keys and certificates. 
Before restarting the server, you must generate new SSL keys by using the mwtm keytool genkey 
command, or you must completely disable SSL using the mwtm ssl disable command.

See Appendix B, “Command Reference” for more information on the use of these commands.

• Remove an SSL certificate from the MWTM client, launch the MWTM SSL Certificate Tool. The 
MWTM lists each imported certificate. Select the certificate that you want to remove, and click 
Remove. The MWTM deletes the certificate from the list.

See Exporting an SSL Certificate, page 2-27 for more information on launching the MWTM SSL 
Certificate Tool.

Public key Public key associated with the SSL certificate, used for encryption and for 
verifying signatures.

OK Closes the Certificate Information dialog box.

When you are ready to close the dialog box, click OK. The MWTM closes 
the Certificate Information dialog. If necessary, click Exit to close the 
MWTM Certificate Tool dialog.

Field or Button Description
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Limiting MWTM Client Access to the MWTM Server (Server 
Only)

By default, when you first install the MWTM, all MWTM client IP addresses can connect to the MWTM 
server. However, you use the MWTM to limit client access to the server by creating and maintaining the 
ipaccess.conf file.

You can create the ipaccess.conf file and populate it with a list of MWTM client IP addresses that can 
connect to the MWTM server. The MWTM allows connections from only those clients, plus the local 
host. If the file exists but is empty, the MWTM allows connections only from the local host. (The 
MWTM always allows connections from the local host.)

When you first install the MWTM, the ipaccess.conf file does not exist and the MWTM allows all client 
IP addresses to connect to the MWTM server. To create the ipaccess.conf file and work with the list of 
allowed client IP addresses:

Step 1 Log in to the MWTM server as the root or superuser:

• Root user—See Becoming the Root User (Server Only), page 4-2 

• Super user—See Specifying a Super User (Server Only), page 2-18

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Create the ipaccess.conf file:

• To create the ipaccess.conf file and add a client IP address to the list, enter:

./mwtm ipaccess add

• To create the ipaccess.conf file and open the file to edit it directly, enter:

./mwtm ipaccess edit

The default directory for the file is located in the MWTM installation directory:

• If you installed the MWTM in the default directory, /opt, then the default directory is 
/opt/CSCOsgm/etc.

• If you installed the MWTM in a different directory, then the default directory is located in that 
directory.

In the ipaccess.conf file, begin all comment lines with a pound sign (#).

All other lines in the file are MWTM client IP addresses, with one address per line.

Wildcards (*) are allowed, as are ranges (for example, 1-100). For example, if you input the address 
*.*.*.* then all clients can connect to the MWTM server.

After you create the ipaccess.conf file, you can use the full set of mwtm ipaccess keywords to work with 
the file:

• clear—Remove all client IP addresses from the ipaccess.conf file, and allow connections from any 
MWTM client IP address.

• list—List all client IP addresses currently in the ipaccess.conf file. If no client IP addresses are listed 
(that is, the list is empty), connections from any MWTM client IP address are allowed.
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• rem—Remove the specified client IP address from the ipaccess.conf file.

• sample—Print out a sample ipaccess.conf file.

See the mwtm ipaccess, page B-28 for more information.

Any changes you make to the ipaccess.conf file take effect when you restart the MWTM server.

You can also use the MWTM to limit the IP addresses that can send traps to the server by creating and 
maintaining the trapaccess.conf file. For more information, see the “Limiting Traps by IP Address” 
section on page 3-8.

Backing Up or Restoring MWTM Files (Server Only)
The MWTM automatically backs up all MWTM data files to the MWTM installation directory daily at 
1:30 AM.

To change the time at which the MWTM automatically backs up files, log in as the root user and change 
the root crontab file:

• crontab -l lists cron jobs.

• crontab -e opens up an editor so you can make changes and save them.

Backing Up MWTM Data Files

To manually back up the MWTM data files at any time on a Solaris or Linux server:

Step 1 Log in as the root user. See Becoming the Root User (Server Only), page 4-2.

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Back up the MWTM files:

./mwtm backup

The MWTM backs up the data files in the installation directory.

If you installed the MWTM in the default directory, /opt, then the default backup directory is also /opt. 
If you installed the MWTM in a different directory, then the default backup directory is that directory.

Changing the Backup Directory

To change the directory in which the MWTM stores its nightly backup files:

Step 1 Log in as the root user. See Becoming the Root User (Server Only), page 4-2.

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Change the backup directory location:

./mwtm backupdir directory

where directory is the new backup directory. 
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If the new directory does not exist, the MWTM does not change the directory, but issues an appropriate 
warning message.

Restoring the MWTM Data Files

You can restore data files on the same Solaris or Linux server, or on a different Solaris or Linux server 
running the MWTM 6.0. 

To restore the MWTM data files from the previous night’s backup:

Step 1 Log in as the root user. See Becoming the Root User (Server Only), page 4-2.

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Restore the MWTM data files:

./mwtm restore

The MWTM restores the data files.

Warning Do not interrupt this command. Doing so can corrupt your MWTM data files.

The mwtm restore command provides optional keywords that you use to restore only selected MWTM 
data files, such as GTT files (ITP only), route table files (ITP only), log files, report files, or security 
files. For more information, see mwtm restore, page B-45.

Removing MWTM Data from the MWTM Server
If you ever want to remove all MWTM data from the MWTM server without uninstalling the product, 
you can do so in one of two ways. Both ways restore the MWTM server to a state that would exist after 
a new installation of the MWTM.

Method 1

To remove all MWTM data from the MWTM server, excluding message log files, backup files, and 
report files:

Step 1 Log in as the root user (see Becoming the Root User (Server Only), page 4-2).

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Remove the MWTM data:

./mwtm clean

Data removed includes all MWTM data, notes, preferences, security settings, route files (ITP only), GTT 
files (ITP only), address table files (ITP only), seed files, event filters, report control files, and views, as 
well as any user-created files stored in the MWTM directories.
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Method 2

To remove all MWTM data from the MWTM server, including all view files, notes that are associated 
with network elements, and event filters and preferences, excluding message log files, backup files, 
report files, configuration settings, and security settings:

Step 1 Log in as the root user. See Becoming the Root User (Server Only), page 4-2.

Step 2 Change to the bin directory:

cd /opt/CSCOsgm/bin

Step 3 Enter:

# ./mwtm cleandb

This command restores the MWTM server to a state that would exist after a new installation of the 
MWTM, except for the presence of the retained files. Data removed includes all MWTM data, notes, 
preferences, route files (ITP only), GTT files (ITP only), address table files (ITP only) and views, as well 
as any user-created files stored in the MWTM directories.

To remove all MWTM data from the MWTM server, including message log files, backup files, and 
report files, log in as the root user, as described in the Becoming the Root User (Server Only), page 4-2, 
then enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm cleanall

Data removed includes all MWTM data, notes, preferences, security settings, route files (ITP only), GTT 
files (ITP only), address table files (ITP only), seed files, event filters, report control files, views, 
message log files, backup files, and report files, as well as any user-created files stored in the MWTM 
directories.
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This chapter contains:

• Importing SNMP Community Names from CiscoWorks (Solaris Only), page 3-2

• Changing MWTM Server Poller Settings, page 3-2

• Changing the Message Display, page 3-4

• Setting the ITP Point Code Format, page 3-5

• Connecting a Single-Instance ITP to a Multiple-Instance ITP, page 3-6

• Enabling SNMP Traps, page 3-7

• Limiting Traps by IP Address, page 3-8

• Configuring a Backup MWTM Server, page 3-9

• Configuring an MWTM Client Connection Timer, page 3-10

• Enabling the Telnet Server Proxy Service, page 3-11

• Setting Up TFTP on Your Server (ITP Only), page 3-11

• Configuring Nodes, page 3-13

• Creating New Troubleshooting Categories and Commands, page 3-22
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Importing SNMP Community Names from CiscoWorks (Solaris 
Only)

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to store all SNMP community 
names in a single database in CiscoWorks Common Services (CS), and to export those names for use by 
the MWTM.

To export the database from CiscoWorks CS to the MWTM:

Step 1 Log in to CiscoWorks. From the Common Services tab, choose Device and Credentials > Device 
Management.

Step 2 Click the Export button.

Step 3 In the tree in the left pane, select the device(s) for export. To choose all devices, click the box next to 
CS@<your_server_name>. To choose an individual device:

• Expand the hierarchy

• Drill-down to find an individual device

• Click the box next to the corresponding device

Step 4 In the fields in the right pane, enter:

File Name = mwtm
Format = CSV

CiscoWorks creates the mwtm file in the default export directory, /opt/CSCOpx/objects/dmgt. When you 
start the MWTM server, the MWTM looks for this file. If the file exists, the MWTM merges the file with 
its own community name database, and the exported SNMP community names will appear in the SNMP 
tab of the Node SNMP and Credentials dialog box (see Configuring Nodes, page 3-13.)

Tip For more information about SNMP, refer to “Configuring SNMP Support” in the Cisco IOS Release 12.2 
Configuration Fundamentals Configuration Guide, Part 3, System Management.

Changing MWTM Server Poller Settings

Note For details on changing poller settings using the MWTM client or MWTM web interface, see Changing 
Client and Web Preference Settings, page 5-1

The MWTM provides three pollers for use in the MWTM client GUI and web pages: a fast poller, a slow 
poller, and a status refresh poller. Each poller has default minimum, maximum, and default settings; but, 
with the MWTM you can change those settings. 
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To change server poller settings:

Step 1 Edit the Server.properties file:

• If you installed the MWTM in the default directory, /opt, then the location of the Server.properties 
file is /opt/CSCOsgm/properties/Server.properties.

• If you installed the MWTM in a different directory, then the Server.properties file is located in that 
directory.

Step 2 To change fast poller settings, change one or more of these lines in the file:

# Fast poller default polling interval in seconds
FAST_POLLER_DEFAULT = 15

# Fast poller minimum polling interval in seconds
FAST_POLLER_MIN = 5

# Fast poller maximum polling interval in seconds
FAST_POLLER_MAX = 60

For example, to change the fast poller default to 30 seconds, change the FAST_POLLER_ DEFAULT 
line to:

FAST_POLLER_DEFAULT = 30

Step 3 To change slow poller settings, change one or more of these lines in the file:

# Slow poller default polling interval in seconds
SLOW_POLLER_DEFAULT = 60

# Slow poller minimum polling interval in seconds
SLOW_POLLER_MIN = 60

# Slow poller maximum polling interval in seconds
SLOW_POLLER_MAX = 300

For example, to change the slow poller default to 180 seconds, change the SLOW_POLLER_DEFAULT 
line to:

SLOW_POLLER_DEFAULT = 180

Step 4 To change status refresh poller settings, change one or more of these lines in the file:

# Status refresh default interval in seconds
STATE_REFRESH_DEFAULT = 180

# Status refresh minimum interval in seconds
STATE_REFRESH_MIN = 180

# Status refresh maximum interval in seconds
STATE_REFRESH_MAX = 900

For example, to change the status refresh poller default to 300 seconds, change the 
STATE_REFRESH_DEFAULT line to:

STATE_REFRESH_DEFAULT = 300

Step 5 Save your changes and restart the MWTM server.

Any changes you make take effect when you restart the MWTM server, and are reflected throughout the 
MWTM client GUI and web pages at that time.
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For each of these pollers, remember that, if you set the:

• Minimum interval for a poller to less than 0 seconds, the MWTM overrides that setting and resets 
the minimum interval to 0 seconds.

• Maximum interval for a poller to less than the minimum interval, the MWTM overrides that setting 
and resets the maximum interval to be equal to the minimum interval.

• Default interval for a poller to less than the minimum interval, the MWTM overrides that setting and 
resets the default interval to be equal to the minimum interval.

• Default interval for a poller to more than the maximum interval, the MWTM overrides that setting 
and resets the default interval to be equal to the maximum interval.

Changing the Message Display
These sections contain information about changing the way the MWTM displays and stores messages:

• Changing the Location of MWTM Message Log Files, page 3-4

• Changing the Size of the MWTM Message Log Files, page 3-4

• Changing the Time Mode for Dates in Log Files, page 3-4

• Changing the Age of the MWTM Message Log Files, page 3-4

Changing the Location of MWTM Message Log Files
By default, all MWTM system message log files are located on the MWTM server at 
/opt/CSCOsgm/logs. To change the location of the system message log directory, use the mwtm 
msglogdir command. See mwtm msglogdir, page B-35 for more information.

Changing the Size of the MWTM Message Log Files
To change the size of the message log files, use the mwtm msglogsize command. See mwtm msglogsize, 
page B-36 for more information.

Changing the Time Mode for Dates in Log Files
To change the time mode for dates in log files, use the mwtm logtimemode command. See mwtm 
logtimemode, page B-31 for more information.

Changing the Age of the MWTM Message Log Files
To change the number of days the MWTM archives system message log files before deleting them from 
the MWTM server, use the mwtm msglogage command. See mwtm msglogage, page B-35 for more 
information.
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Setting the ITP Point Code Format
You can use the MWTM to set a new point code format for an MWTM server. The MWTM server and 
all associated MWTM clients use the new point code format. Normally, you need to do this only once, 
after installation.

The point code format configuration is contained in the PointCodeFormat.xml file.

To set the new point code format, log in as the root user, as described in Starting the MWTM Client, page 
4-2, or as a superuser, as described in Specifying a Super User (Server Only), page 2-18. Then enter:

# cd /opt/CSCOsgm/bin
# ./mwtm pcformat [edit | list | master | restore]

Where:

• edit—Opens the PointCodeFormat.xml file for editing, using $EDITOR environment variable if set, 
otherwise uses vi.

• list—Displays the current contents of the PointCodeFormat.xml file.

• master—Restores the PointCodeFormat.xml file to the default settings.

• restore—Restores the PointCodeFormat.xml file to the last saved copy.

The PointCodeFormat.xml file provides these default point code formats:

• <Variant value="ANSI" format="8.8.8"/>—Formats point codes using the 24-bit American 
National Standards Institute (ANSI) standard format, xxx.yyy.zzz, where:

– xxx is the 8-bit network identification

– yyy is the 8-bit network cluster

– zzz is the 8-bit network cluster member

• <Variant value="China" format="8.8.8"/>—Formats point codes using the 24-bit China 
standard format, xxx.yyy.zzz, where:

– xxx is the 8-bit network identification

– yyy is the 8-bit network cluster

– zzz is the 8-bit network cluster member

• <Variant value="ITU" format="3.8.3"/>—Formats point codes using the 14-bit International 
Telecommunication Union (ITU) standard format, x.yyy.z, where:

– x is the 3-bit zone identification

– yyy is the 8-bit region identification

– z is the 3-bit signal-point

• <Variant value="NTT" format="5.4.7" readBits=”rightToLeft”/>— Formats point codes using 
the 16-bit Nippon Telegraph and Telephone Corporation (NTT) standard format, xx.yy.zzz, where:

– xx is the 5-bit zone identification

– yy is the 4-bit area/network identification

– zzz is the 7-bit identifier

• <Variant value="TTC" format="5.4.7" readBits=”rightToLeft”/>— Formats point codes using 
the 16-bit Telecommunication Technology Committee (TTC) standard format, xx.yy.zzz, where:

– xx is the 5-bit zone identification
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– yy is the 4-bit area/network identification

– zzz is the 7-bit identifier

As shown previously, the standard point code format for each variant is three octets. (For example, 3.8.3 
for ITU.) However, you can also specify a four-octet format for any of the variants. (For example, 4.3.4.3 
for ITU.) The total number of bits must still equal 24 for ANSI and China, 14 for ITU, and 16 for NTT 
and TTC.

For information about customizing the point code formats, including setting a new three-octet or 
four-octet format, see the detailed instructions in the PointCodeFormat.xml file.

Any changes that you make take effect when you restart the MWTM server.

The MWTM preserves customized point code formats when you upgrade to a new version or release of 
the MWTM.

Connecting a Single-Instance ITP to a Multiple-Instance ITP
You can configure the MWTM to recognize a single-instance ITP connecting to multiple instances on a 
multiple-instance ITP. In effect, the MWTM views the multiple networks as a single all-encompassing 
network.

To connect single-instance ITPs to multiple-instance ITPs:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin
# ./mwtm pcformat edit

The mwtm pcformat edit command opens the PointCodeFormat.xml file for editing. For more 
information about using this command, see Setting the ITP Point Code Format, page 3-5.

Step 3 Add these lines to the PointCodeFormat.xml file:

<NetworkConfig>
    <Network value="Big-Network">
        <Include value="Network-1"/>
        <Include value="Network-2"/>
        <Include value="Network-3"/>
    </Network>
</NetworkConfig>

Where:

• Network-1, Network-2, and Network-3 are the names of your subnetworks. (This example assumes 
that you are combining three subnetworks into one.)

• Big-Network is the name of the combined network that includes Network-1, Network-2, and 
Network-3.

In the MWTM, the signaling point Instance Name field displays the subnetwork name (for example, 
Network-1), and the Point Code field displays the name of the combined network (for example, 
Big-Network).

During Discovery, the MWTM assigns a default name to each discovered signaling point. The 
assigned default name consists of the point code and the combined network name (for example, 
3.8.3:Big-Network).
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Step 4 Save your changes to the PointCodeFormat.xml file.

Step 5 Restart the MWTM server. Any changes you made to the PointCodeFormat.xml file take effect when you 
restart the MWTM server.

The MWTM preserves the customized network configuration when you upgrade to a new version or 
release of the MWTM.

Enabling SNMP Traps
By default, the MWTM cannot receive SNMP traps. To use SNMP traps with the MWTM, you must first 
configure the MWTM to receive traps.

Related Topics: 

Integrating the MWTM with Other Products, page 5-39

To view the current trap reception configuration for the MWTM:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin
# ./mwtm trapstatus

The MWTM displays the current trap reception configuration for the MWTM, including:

• Whether receiving traps is enabled or disabled

• Which UDP port the MWTM trap receiver is listening on

To configure the MWTM to receive traps:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin
# ./mwtm trapsetup

The MWTM displays:

The MWTM server must also be stopped to perform this operation.
Do you wish to continue? [n]

Step 3 Type y and press Enter. The MWTM stops the MWTM Process Manager and all managed processes and 
displays:

Would you like to configure MWTM to receive SNMP traps? [yes]

Step 4 Press Enter. The MWTM displays:

MWTM can receive traps natively on the standard UDP port number 162
or on any other UDP port chosen. If another application is already
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bound to the SNMP standard trap reception port of 162, an alternate
port number for MWTM to receive traps must be specified.

UDP port number 44750 is the default alternate port.

Enter trap port number? [ 162 ] 

Step 5 By default, nodes send traps to port 162. To accept the default value, press Enter.

Step 6 If your nodes have been configured to send traps to a different port, type that port number and press 
Enter.

Step 7 By default, the MWTM listens for traps from trap-multiplexing nodes and NMS applications on port 
44750. If you want the MWTM to monitor that port, and port 162 is not available on the MWTM server 
host, type 44750 and press Enter.

Step 8 If trap multiplexing nodes and NMS applications in your network have been configured to send traps to 
a different port, type that port number and press Enter.

Step 9 If you are a superuser, you must specify a port number that is greater than 1024, then press Enter.

Do not enter a non numeric port number. If you do, you are prompted to enter a numeric port number.

When you select an SNMP trap port number for the MWTM server, ensure your nodes use the same 
SNMP trap port number. See the description of the snmp-server host command in the “Preparing to 
Install the MWTM” chapter of the Installation Guide for the Cisco Mobile Wireless Transport Manager 
6.0 for more information.

Step 10 To accept the default value, press Enter; or, type a different location and press Enter.

The MWTM confirms your choices and restarts the MWTM Process Manager and all managed 
processes.

You can change all aspects of MWTM event processing, including the size of the MWTM event database, 
the maximum length of time the MWTM is to retain events, and the default severity and color associated 
with each type of event. If a new trap becomes available that is of interest to the MWTM, you can add it 
to the MWTM event database, enabling the MWTM to recognize and process the new trap. For more 
information about changing MWTM event processing, see Changing the Way the MWTM Processes 
Events, page 9-27.

Limiting Traps by IP Address
By default, when you first install the MWTM, all IP addresses are allowed to send traps to the MWTM 
server. However, you can use the MWTM to limit the IP addresses that can send traps to the server by 
creating and maintaining the trapaccess.conf file.

You can create the trapaccess.conf file and populate it with a list of IP addresses that can send traps to 
the MWTM server. The MWTM receives traps from only those IP addresses, plus the local host. If the 
file exists but is empty, the MWTM receives traps only from the local host. (The MWTM always receives 
traps from the local host.)

When you first install the MWTM, the trapaccess.conf file does not exist and the MWTM allows all IP 
addresses to send traps to the MWTM server.
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To create the trapaccess.conf file and work with the list of allowed IP addresses:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin

Step 3 Create the trapaccess.conf file:

• To create the trapaccess.conf file and add a client IP address to the list, enter:

# ./mwtm trapaccess add

Enter address to add: 1.2.3.4
IP Address 1.2.3.4 added.
MWTM server must be restarted for changes to take effect.
Use the following command to restart the server:
   mwtm restart

• To create the trapaccess.conf file and open the file to edit it directly, enter:

# ./mwtm trapaccess edit

The default directory for the file is located in the MWTM installation directory. If you installed the 
MWTM:

• In the default directory, /opt, then the default directory is /opt/CSCOsgm/etc.

• In a different directory, then the default directory resides in that directory.

In the trapaccess.conf file, begin all comment lines with a pound sign (#).

All other lines in the file are MWTM client IP addresses, with one address per line.

Wildcards (*) are allowed, as are ranges (for example, 1-100). For example, the address *.*.*.* allows 
all clients to send traps to the MWTM server.

After you create the trapaccess.conf file, you can use the full set of mwtm trapaccess keywords to work 
with the file. See mwtm trapaccess, page B-64 for more details.

Any changes that you make to the trapaccess.conf file take effect when you restart the MWTM server.

Configuring a Backup MWTM Server
You can use the MWTM to configure a second MWTM server as a backup for the primary MWTM 
server. For best results, Cisco recommends that you configure the primary server and the backup server 
as backups for each other.

To configure a backup MWTM server:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin
# ./mwtm secondaryserver hostname naming-port
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where:

• hostname is the optional name of the host on which the backup MWTM server is installed.

• naming-port is the optional MWTM Naming Server port number for the backup MWTM server. The 
default port number is 44742.

Note If you use the mwtm secondaryserver command to configure a backup MWTM server, but 
the primary MWTM server fails before you launch the MWTM client, then the MWTM client 
has no knowledge of the backup server.

Step 3 (Optional) To list the backup MWTM server that has been configured for this primary MWTM server, 
enter:

# cd /opt/CSCOsgm/bin
# ./mwtm secondaryserver list

Configuring an MWTM Client Connection Timer
You can use the MWTM to specify how long an MWTM client is to wait for the MWTM server before 
exiting.

To configure an MWTM client connection timer:

Step 1 Login as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin
# ./mwtm cliconntimer number-of-seconds

where number-of-seconds is the time the MWTM client is to wait for a message from the MWTM server 
before exiting. The valid range is 10 seconds to an unlimited number of seconds. The default value is 
60 seconds.

If the timer expires, the client pings the server and responds. If the server:

• Responds to the ping, the client reconnects to the server.

• Does not respond to the ping, but there is a backup server configured, the client connects to the 
backup server.

• Does not respond to the ping, and there is no backup server configured, the client stops.

The timer takes effect when you restart the MWTM server.

Step 3 (Optional) To restore the default timeout of 60 seconds, enter:

# ./mwtm cliconntimer clear

The timer is reset to 60 seconds when you restart the MWTM server.
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Enabling the Telnet Server Proxy Service
The MWTM provides the capability to function through firewalls, where the server is located behind the 
firewall and the client is outside the firewall. To use this feature, enable the Telnet proxy service by the 
mwtm tnproxy command (see Appendix B, “Command Reference.”)

Setting Up TFTP on Your Server (ITP Only)
Before deploying or loading route table, GTT, or MLR address table files, the TFTP daemon must be 
running on the Solaris or Linux server.

Tip For more information about questions regarding TFTP, see When I try to deploy routes, GTT files, or 
address table files from the MWTM, why does TFTP fail or time out?, page C-14.

This section contains:

• Setting Up TFTP on Solaris, page 3-11

• Setting Up TFTP on Linux, page 3-12

Setting Up TFTP on Solaris
To set up TFTP on your Solaris server:

Step 1 Verify that the tftp-server package is installed:

pkginfo -l | grep tftp

If the tftp-server package is not installed, install it from your Solaris CD or distribution.

Step 2 If you are not logged in, log in as the root user:

> login: root
> Password: root-password 

If you are already logged in, but not as the root user, use the su command to change your login to root:

# su
# Password: root-password

Caution As the root user, you can adversely affect your operating environment if you are unaware of the effects 
of the commands that you use. If you are a relatively inexperienced UNIX user, limit your activities as 
the root user to the tasks described in this manual.

Step 3 Using a UNIX editor, open the inetd.conf file:

/etc/inetd.conf

Step 4 In the inetd.conf file, ensure that this line appears:

tftp dgram udp6 wait root /usr/sbin/in.tftpd -s /tftpboot 

If the line begins with a # sign, delete it, and save the changes.
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Step 5 Ensure that this directory exists:

/tftpboot

If not, then create this directory. Also ensure the directory has write permissions (777).

Step 6 If you will be accessing more than one type of file (route, GTT, or MLR address table files,) you must 
create subdirectories, for example:

/tftpboot/route
/tftpboot/gtt
/tftpboot/atbl

Step 7 Restart the inetd process:

a. As the root user, enter:

# ps -ef | grep inetd

Output should be similar to:

root   157     1  0   Oct 21 ?        0:00 /usr/sbin/inetd -s

b. To find the process ID for inetd, enter:

# ps -e -o pid,comm | grep inetd

Output should be similar to:

157 /usr/sbin/inetd

c. To restart the inetd process, enter:

# kill -HUP 157

Where 157 corresponds to the output integer returned in Step b.

Step 8 Within the /opt/CSCOsgm/bin directory, set the staging directory with these commands. For:

• Route table files, use the mwtm routedir command (see mwtm routedir, page B-102).

• GTT files, use the mwtm gttdir command (see mwtm gttdir, page B-86).

• MLR address table files, use the mwtm atbldir command (see mwtm atbldir, page B-78).

Setting Up TFTP on Linux
To set up TFTP on your Linux server:

Step 1 Verify that the tftp-server package is installed:

rpm -q tftp-server

If the tftp-server package is not installed, install it from your RedHat Enterprise CD or distribution.

Step 2 If you are not logged in, log in as the root user:

> login: root
> Password: root-password 
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If you are already logged in, but not as the root user, use the su command to change your login to root:

# su
# Password: root-password

Caution As the root user, you can adversely affect your operating environment if you are unaware of the effects 
of the commands that you use. If you are a relatively inexperienced UNIX user, limit your activities as 
the root user to the tasks described in this manual.

Step 3 Using a UNIX editor, open the tftp file:

/etc/xinetd.d/tftp

Step 4 Edit the file:

a. Change the line:

user = nobody 

to 

user = root

b. Change the line:

disable = yes 

to 

disable = no

c. If you want to specify a different TFTP directory, replace /tftpboot in the line server_args = -s 
/tftpboot with the name of your directory.

Step 5 Save the changes.

Step 6 Enter:

/etc/init.d/xinetd restart 

Step 7 Set the staging directory:

• For route table files, use the mwtm routedir command (see mwtm routedir, page B-102).

• For GTT files, use the mwtm gttdir command (see mwtm gttdir, page B-86).

• For MLR address table files, use the mwtm atbldir command (see mwtm atbldir, page B-78).

Configuring Nodes
If MWTM User-Based Access is disabled, or if it is enabled and you are a Network Administrator or 
System Administrator, you can use the MWTM to view and change SNMP settings and configure login 
credentials. 

For more information about user authorization levels in the MWTM, see Configuring MWTM User 
Account Levels (Server Only), page 2-5.
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To access SNMP and credentials configuration, choose Network > Node SNMP and Credentials 
Editor from the MWTM main menu. The MWTM displays the Node SNMP and Credentials Editor 
dialog box.

Figure 3-1 Node SNMP and Credentials Editor Dialog (SNMP Tab)

The Node SNMP and Credentials Editor dialog box contains:

• Node SNMP and Credentials Menu, page 3-14

• Configuring SNMP Settings, page 3-15

• Configuring Login Credentials, page 3-19

Node SNMP and Credentials Menu
The menu on the Node SNMP and Credentials Editor dialog box contains:

Menu Command Description

File > Save
(Ctrl-S)

Saves any SNMP configuration changes.

When you are satisfied with all of your changes to the SNMP settings, choose 
the File > Save menu option. The MWTM saves the changes and updates the 
SNMP information on the MWTM server in real time.

Note If another user modifies and saves the SNMP configuration before 
you save your changes, the MWTM asks if you want to overwrite that 
user’s changes. If you choose to do so, the other user’s changes are 
overwritten and lost. If you choose not to do so, your changes are lost.

File > Close
(Ctrl-W)

Closes the current window.
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Configuring SNMP Settings

Note If you want to change SNMP settings, do so before running discovery.

For more information about SNMP, refer to “Configuring SNMP Support” in the Cisco IOS Release 12.2 
Configuration Fundamentals Configuration Guide, Part 3, System Management.

To change SNMP settings in the MWTM, start the MWTM client, as described in Starting the MWTM 
Client, page 4-2, then choose:

• From the MWTM main window—Network > Node SNMP and Credentials Editor from the 
MWTM main menu.

• From the Discovery Dialog—Edit > Node SNMP and Credentials Editor from the menu bar.

Note (If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Administrator [level 4] and higher.)

The MWTM displays the SNMP tab (see Figure 3-1).

The SNMP tab of the Node SNMP and Credentials Editor dialog box contains:

• SNMP Settings Table, page 3-15

• SNMP Configuration Table, page 3-16

• SNMP Configuration Buttons, page 3-17

The MWTM also provides a set of commands that you can use to configure SNMP settings (see SNMP 
Configuration Commands, page 3-18).

SNMP Settings Table

The SNMP settings table displays current SNMP information for nodes in the MWTM. You can edit 
these fields in the SNMP Configuration Table, page 3-16.

The SNMP configuration table contains:

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information about 
the MWTM application.

Menu Command Description
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SNMP Configuration Table

In the SNMP configuration table, you can change SNMP settings for a node.

The SNMP configuration table contains:

Column Description

IP Address Range or 
Hostname

IP address or DNS name of a node or range of nodes. An asterisk (*) indicates 
a wildcard value.

Read Community SNMP community name used by the node for read access to the information 
maintained by the SNMP agent on the node.

Timeout (secs) Time, in seconds, the MWTM waits for a response from the node.

Retries Number of times the MWTM attempts to connect to the node.

Poll Interval (mins) Time, in minutes, between polls for the node.

Field Description

IP Address 
Range or 
Hostname

IP address or DNS name of a node.

To change the IP address or DNS name of a node, select the node, enter the new 
address or name in the IP Address Range or Hostname field, then click Update.

IP addresses use the format x.x.x.x, where each x has one of these values:

• An integer in the range 0 through 255.

• A range of integers separated by a hyphen (-), such as 10-60.

• An asterisk (*), which is equivalent to specifying 0-255.

The default value for this field is the IP address *.*.*.*, which the MWTM uses for 
all nodes not covered by other IP address ranges or names.

When entering an IP address: 

• Use Class A, B, or C addressing:

– Class A—The first octet value is within the range of 1-126. A valid IP 
address is from 1.0.0.1 to 126.255.255.254. 

– Class B—The first octet value is within the range of 128-191. A valid IP 
address is from 128.1.0.1 to 191.254.255.254.

– Class C—The first octet value is within the range of 192-223. A valid IP 
address is from 192.0.1.1 to 223.255.254.254.

• Do not use 0 or 255 for the last octet (x.x.x.0 is reserved for subnet addresses 
or network addresses; x.x.x.255 is reserved for subnet broadcast addresses).

• Do not use IP addresses that fall within these ranges: 
127.0.0.1-127.255.255.254, 128.0.0.1-128.0.255.254, 
191.255.0.1-191.255.255.254, 223.255.255.1-223.255.255.254, and so on.

• Do not use 0 for the first octet.

Unlike IP addresses, you cannot specify a range of node names or use wildcards in 
node names. Each node name corresponds to a single node in the network.
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SNMP Configuration Buttons

The SNMP tab of the Node SNMP and Credentials Editor dialog box contains:

Read Community SNMP community name to be used by the node for read access to the information 
maintained by the SNMP agent on the node. 

To change the SNMP community name for a node, select the node and enter the new 
name in the Read Community field, then click Update.

This new SNMP community name must match the name used by the node. The 
default name is public.

For information about exporting SNMP community names from CiscoWorks 
Resource Manager Essentials (RME), see Importing SNMP Community Names 
from CiscoWorks (Solaris Only), page 3-2.

Timeout (secs) Time, in seconds, the MWTM waits for a response from the node.

If you determine that the MWTM waits too long for a response from a node, or does 
not wait long enough, you can change the timeout value. To change the time that 
the MWTM waits for a response from a node, select the node and enter the new 
timeout value in the Timeout (secs) field, then click Update.

The valid range is 1 to 60 seconds. The default value is 1 second.

Retries Number of times the MWTM attempts to connect to the node.

If you determine that the MWTM retries a node too many times, or not enough 
times, you can change the number of retries. To change the number of times the 
MWTM attempts to connect to a node, select the node and enter the new number in 
the Retries field, then click Update.

The valid range is 0 to 99. The default value is 2 retries.

Poll Interval 
(mins)

Time, in minutes, between polls for the node.

If you determine that the MWTM polls a node too often, or not often enough, you 
can change the poll interval. To change the time, in minutes, between polls for a 
node, select the node and enter the new interval in the Poll Interval (mins) field, 
then click Update.

The valid range is 5 to 1440. The default value is 15 minutes.

Field Description

Button Description

Add Adds the new SNMP settings to the MWTM database.

To add a new node or range of nodes, enter the SNMP information in the appropriate fields 
and click Add. The new SNMP settings are added to the MWTM database.

Update Applies the values in the SNMP configuration fields to the selected node or range of 
nodes.

Delete Deletes the selected node or range of nodes.

To delete a node, select it and click Delete. The MWTM deletes the node without asking 
for confirmation.
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SNMP Configuration Commands

This section contains:

• MWTM Commands for SNMP, page 3-18

• Required SNMP Configuration for RAN-O Nodes, page 3-18

MWTM Commands for SNMP

The MWTM provides these SNMP-related commands:

• To set a new default SNMP read community name, use the mwtm snmpcomm command.

• To change the file used for SNMP parameters, such as community names, timeouts, and retries, use 
the mwtm snmpconf command.

• To query a host using SNMP GetRequests, use the mwtm snmpget command.

• To query a host using SNMP GetNextRequests, use the mwtm snmpnext command.

• To query a host, using SNMP GetNextRequests to “walk” through the MIB, use the mwtm 
snmpwalk command.

Tip For more information on the use of these commands, see Appendix B, “Command Reference.”

Required SNMP Configuration for RAN-O Nodes

Configure these SNMP statements on the RAN-O nodes that you would like to manage by using the 
MWTM:

ipran-mib snmp-access <inBand | outOfBand>
ipran-mib location <cellSite | aggSite>
logging traps informational

snmp-server enable traps syslog
snmp-server community <SNMP_COMMUNITY_STRING> RO 1
snmp-server trap link ietf snmp-server queue-length 100
snmp-server enable traps snmp linkdown linkup coldstart warmstart
snmp-server enable traps ipran snmp-server enable traps cpu threshold
snmp-server host <SNMP_SERVER_HOST_IP_ADDRESS> version 2c v2c 

Tip For more information about these commands, refer to the Cisco MWR 1941-DC-A Mobile Wireless Edge 
Router Software Configuration Guide.
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Configuring Login Credentials
This section contains:

• Setting Up Login Credentials, page 3-19

• Credentials Fields, page 3-21

• Credentials Buttons, page 3-21

• Adding Nodes, page 3-22

• Credentials Commands, page 3-22

You can use the MWTM to set up log in credentials, which you may use for:

Setting Up Login Credentials

The MWTM enables a system administrator to configure the login credentials using the Node SNMP and 
Credentials Editor dialog box. Login credentials are stored in an encrypted file on the server, eliminating 
the need for users to login before running commands.

To set up login credentials in the MWTM, start the MWTM client, as described in Starting the MWTM 
Client, page 4-2, then choose Network > Node SNMP and Credentials Editor from the MWTM main 
menu, and select the Credentials tab. 

Action Description Related Content

Troubleshooting ITP and RAN-O networks Viewing Troubleshooting

Discovery ONS nodes only Discovery Overview

Deployment ITP only Deploying ITP Files

Provisioning ITP only Using ITP Provisioning

Launching a SSH 
terminal to a node

(ITP, RAN-O including ONS) In the 
MWTM client navigation tree, 
right-click on an object and choose 
Node > Connect To.

Viewing the Right-Click Menu for an 
Object

Establishing a 
low-level connection 
to a node

(ITP only) 

In the MWTM client, choose Network 
> Node File Management, then choose 
File > Connect

or

In the Route Table Editor, choose File > 
Deploy

or

In the Global Title Translator Editor or 
Address Table Editor, choose File > 
Load from Node or File > Deploy.

Node File Management

Deploying ITP Files

Loading a GTT File from a Node

Loading an Address Table File from 
a Node
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Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Administrator (level 4) and higher. 

For detailed information on the SNMP tab, see Configuring SNMP Settings, page 3-15.

Figure 3-2 Node SNMP and Credentials Editor—Credentials Tab

Note A check mark appears beside nodes or default ITP, ONS, RAN-O, or RAN SVC credentials that are 
configured.

A system administrator can set up credentials:

• Globally on all nodes of all types—Click Default and complete the fields in the right pane.

• All nodes of a specific node type only—Under Default, click the node type (ITP, ONS, RAN-O or 
RAN_SVC) and complete the fields in the right pane.

Note Configuring Default RAN-O credentials applies to Cisco MWR nodes only.

• On a specific node—Under Nodes, click the node name and complete the fields in the right pane. 
Configuring credentials on a specific node overrides any Default credentials for that particular node.

The Credentials tab of the Node SNMP and Credentials dialog box contains:

• Credentials Fields, page 3-21

• Credentials Buttons, page 3-21

The MWTM also provides a set of commands that you can use to configure SNMP settings (for details, 
see the Credentials Commands, page 3-22).
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Credentials Fields

Under the Credentials tab of the Node SNMP and Credentials dialog box, you can configure these login 
credentials for node(s):

Note Ensure that each user has sufficient privileges to run all commands.

Note User name and password requirements vary according to your security configuration. For more 
information, see the Cisco IOS Security Configuration Guide, Release 12.2, Part 1 and Part 5.

Credentials Buttons

The Credentials tab of the Node SNMP and Credentials dialog box contains:

Field Description

IP Address or 
DNS Hostname

See the Adding Nodes, page 3-22.

User name Enter the login username, if required.

Password Enter the login password, if required.

Enable User 
name

Enter the login enable username (not required for ONS nodes).

Enable Password Enter the login enable password (not required for ONS nodes).

Connection 
Protocol

Choose the protocol to use when connecting to the node, either SSH or Telnet.

Note The key size on the node must be configured to a minimum of 768 bits and 
a maximum of 2048 bits.

Button Description

Apply Applies specified usernames and passwords to the selected node or Default credentials. 

Clear Removes credentials. To clear usernames and passwords on a selected object, click Clear 
to remove the credentials, then click Apply.

Test You can test the credentials you have configured on the corresponding node or the default 
credentials against a selected node type (not available for all node types).

Add (Button only available when you click Nodes) Adds a specified node.
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Adding Nodes

In the Credentials tab, you can add a node. If you are working with ONS nodes, you must add the ONS 
node and set the credentials for the node before running discovery.

Step 1 Click Nodes in the navigation tree.

Step 2 Enter the IP address or DNS hostname.

Step 3 Add the username and password credentials.

Step 4 Specify the connection protocol (Telnet or SSH).

Step 5 Click Add.

Credentials Commands

The MWTM also provides credentials-related commands:

• To add credentials for a given IP address, or for the Default credentials, use the mwtm addcreds 
command.

• To show credentials for a given IP address, or for the Default credentials, use the mwtm showcreds 
command.

• To delete credentials for a given IP address, or for the Default credentials, use the mwtm 
deletecreds command.

Tip For more information on the use of these commands, see Appendix B, “Command Reference.”

Creating New Troubleshooting Categories and Commands
A system administrator can use the MWTM to create user-specific categories and commands:

Step 1 On the server machine, if you are not logged in, log in as the root user:

> login: root
> Password: root-password 

If you are already logged in, but not as the root user, use the su command to change your login to root:

# su
# Password: root-password

Caution As the root user, you can adversely affect your operating environment if you are unaware of the effects 
of the commands that you use. If you are a relatively inexperienced UNIX user, limit your activities as 
the root user to the tasks described in this manual.

Step 2 Using a UNIX editor, open the UserCommands.ts file:

/opt/CSCOsgm/etc/UserCommands.ts
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Step 3 Create new categories and commands, following the instructions in the UserCommands.ts file. Sample 
categories and commands are provided, which may be directly useful in your network.

Step 4 Save changes. The new categories and commands now appear in the Troubleshooting tabs.

Related Topics

• Viewing Troubleshooting, page 8-42

• mwtm tshootlog, page B-66
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4
Getting Started

This chapter provides information about starting and stopping the Cisco Mobile Wireless Transport 
Manager (MWTM), and an overview of how to use the MWTM to manage your Cisco IP Transfer Point 
(ITP) or Radio Access Network-Optimization (RAN-O) installation.

This chapter includes:

• Starting the MWTM Server, page 4-1

• Starting the MWTM Client, page 4-2

• Discovering Your Network, page 4-4

• Displaying the MWTM Main Window, page 4-22

• Using the MWTM Main Menu, page 4-33

• Accessing the MWTM through a Web Browser, page 4-39 

• Loading and Saving MWTM Files, page 4-41

• Using the Windows Start Menu, page 4-43

• Using the Windows Start Menu, page 4-43

• Exiting the MWTM Client, page 4-44

For detailed information about the MWTM-supported platforms, and hardware and software 
requirements, see the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0.

Note The default directory for installing the MWTM is /opt. In commands that call for the default directory, 
if you installed the MWTM in a different directory, you must specify that directory instead of /opt.

Starting the MWTM Server
Before starting an MWTM server, verify that:

• Each node uses a supported IOS image

• The MWTM server has IP connectivity to each node

• SNMP is enabled on each node

• (Optional, but recommended) Traps are enabled on each node

• (Optional, but recommended) A trap host is defined on each node
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Tip For a definition of MWTM nodes, see What is ITP?, page 1-6 and What is RAN-O?, page 1-7.

Because the MWTM application comprises a server component and a client component, you must start 
both components to run the application.

To start the MWTM server on a Solaris or Linux system:

Step 1 You must be logged in as the root user or as a superuser, or your login must have administrator privileges. 
To log in as the root user, see the Becoming the Root User (Server Only), page 4-2.

Note For details on setting up administrator privileges, see Specifying a Super User (Server Only), 
page 2-18). 

Step 2 Enter:

# cd /opt/CSCOsgm/bin

# ./mwtm start

Becoming the Root User (Server Only)
Some MWTM procedures require that you log in as the root user.

Caution As the root user, you can adversely affect your operating environment if you are unaware of the effects 
of the commands that you use. If you are a relatively inexperienced UNIX user, limit your activities as 
the root user to the tasks described in this manual.

If you are not logged in, log in as the root user:

> login: root
> Password: root-password 

If you are already logged in, but not as the root user, use the su command to change your login to root:

# su
# Password: root-password

Starting the MWTM Client
This section contains:

• Before Starting the MWTM Client, page 4-3

• Starting the MWTM Client on Solaris or Linux, page 4-3

• Access the Node, page 4-4

• Starting the MWTM Client on Windows, page 4-4
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Before Starting the MWTM Client
When you start an MWTM client, the version and release of the client must match that of the MWTM 
server.

If there is a client-server mismatch, the MWTM displays a warning message when you try to start the 
client. If you have a web browser installed, the MWTM optionally opens a web page from which you 
can download an allowed, matching client. See Downloading the MWTM Client from the Web, page 
11-7 for more information about downloading the MWTM client.

Setting the DISPLAY Variable for Solaris or Linux Clients

If you see the following message upon client startup, you must set the DISPLAY variable: 

Could not launch client: Can't connect to X11 window server using <x> as the value of the 
DISPLAY variable.

The DISPLAY variable is set as part of your login environment on Solaris or Linux. However, if you use 
Telnet or SSH to access a workstation, you must set the DISPLAY variable to local display by using this 
command:

# setenv DISPLAY local_ws:0.0

where local_ws is your local workstation.

If your shell does not support the setenv command, enter:

# export DISPLAY=local_ws:0.0

Starting the MWTM Client on Solaris or Linux
To start the MWTM client on a Solaris or Linux system on which the MWTM server is installed, ensure 
that the MWTM server is running, then enter:

# cd /opt/CSCOsgm/bin
# ./mwtm client

To start the MWTM client on a Solaris or Linux system other than the one on which the MWTM server 
is installed, ensure that the MWTM server is running, then enter:

# cd /opt/CSCOsgmClient/bin
# ./mwtm client

To start the MWTM client on a Solaris or Linux system other than the one on which the MWTM server 
is installed, and connect to an MWTM server other than the default server, enter:

# cd /opt/CSCOsgmClient/bin
# ./mwtm client server_name_or_ip_address

where server_name_or_ip_address is the name or IP address of the Solaris or Linux system on which 
the MWTM server is running.
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Access the Node
You use the MWTM to link to the node by using the connection protocol (Telnet or SSH) that you set in 
the Node SNMP and Credentials dialog box (see Credentials Fields, page 3-21).

To access the node, right-click a node in a window, then choose Node > Connect to from the right-click 
menu.

Note If your client workstation does not have network access to the IP address of the node (that is, if the node 
is behind a firewall or NAT device), you might be unable to access the node.

Starting the MWTM Client on Windows
To start the MWTM client on a Windows system, choose Start > Programs > Cisco MWTM Client > 
Launch MWTM Client, or double-click the MWTM Client icon on the Windows desktop.

Discovering Your Network
This section provides details on using the MWTM to discover your ITP or RAN-O networks. It includes:

• Discovery Overview, page 4-4

• Launching the Discovery Dialog, page 4-6

• Loading Seed Nodes and Seed Files, page 4-7

• Running Discovery, page 4-13

• Verifying Discovery, page 4-21

Discovery Overview
The MWTM uses a Discovery process to populate the MWTM database, discovering the objects in your 
network.

You can run Discovery if MWTM User-Based Access is disabled; or, if it is enabled, and you are a 
Network Administrator or System Administrator. (For more information about user authorization levels 
in the MWTM, see Configuring MWTM User Account Levels (Server Only), page 2-5.)

To discover your network:

Step 1 Start the MWTM client, as described in Starting the MWTM Client, page 4-2.

Step 2 If you want to change SNMP settings, do so before running Discovery. See Configuring SNMP Settings, 
page 3-15 for more information.

Step 3 If you want to discover ONS nodes and did not choose the option to discover your network during 
installation, you must add the ONS nodes and set the credentials before running discovery (see Adding 
Nodes, page 3-22 for more information.)

Step 4 Choose Network > Network Discovery from the MWTM main menu. The MWTM displays the 
Discovery dialog box. See Launching the Discovery Dialog, page 4-6 for more information.
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Step 5 Select the Seed Settings tab, if it is not already selected. You use the Seed Settings tab to create, save, 
load, and delete MWTM seed files. Load one or more seed nodes, or an existing seed file, by using the 
procedures in Loading Seed Nodes and Seed Files, page 4-7.

Step 6 Select the Discovery tab, or click Next. You use the Discovery tab to discover the objects in your 
network. See Running Discovery, page 4-13 for more information.

• To specify the extent of the network discovery, check the Entire Network check box. See the 
description of the Entire Network check box in Running Discovery, page 4-13 for more information.

• To specify whether the MWTM should keep or delete the existing database when discovering the 
network, check the Delete Existing Data check box. See the description of the Delete Existing Data 
check box in Running Discovery, page 4-13 for more information.

• To specify the maximum number of hops for discovering objects in your network, enter a value in 
the Max. Hops text box. For more information, see the description of the Max. Hops text box in the 
Running Discovery, page 4-13.

Step 7 When the “Discovery In Progress” message disappears, Discovery is running. The Discovered Nodes 
table within the Discovery tab (Figure 4-5) lists all nodes that were discovered by the MWTM (all nodes, 
including new and excluded nodes, not just the nodes in the current view). See Discovered Nodes, page 
4-17 for more information.

Step 8 Examine the Discovered Nodes table to verify that the MWTM discovered all of the nodes in the 
network. If you suspect that the MWTM did not discover all of the nodes, see Verifying Discovery, page 
4-21 for troubleshooting information. You might need to add more seed nodes and run Discovery again.

Step 9 When you are satisfied that the MWTM discovered all of the nodes in the network, save the list of seed 
nodes in a seed file. See Saving a Seed File, page 4-9 for more information.

Note (ITP only) You can run Discovery multiple times to attempt to discover additional nodes based on the IP 
addresses defined in the Stream Control Transmission Protocol (SCTP) links. If you are using a separate 
management VLAN to manage your nodes, but private or unreachable IP addresses for your SCTP 
connectivity, uncheck the Entire Network check box in the Discovery dialog box. Otherwise, Discovery 
attempts to reach those nodes continuously. Instead, enter all nodes to be discovered directly into the 
seed list and do a nonrecursive Discovery.

Related Topics:

• Configuring SNMP Settings, page 3-15

• Backing Up or Restoring MWTM Files (Server Only), page 2-32

• Investigating Data Problems, page D-1
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Launching the Discovery Dialog
To launch the Discovery dialog box and begin the Discovery process, choose Network > Network 
Discovery from the MWTM main menu. The MWTM displays the Discovery dialog box.

Figure 4-1 Discovery Dialog with Seed Settings Displayed

You use the Discovery dialog box to load and configure seed nodes, and use those seed nodes to discover 
the objects in your network.

If you start the MWTM client and the MWTM database is empty (including the very first time you start 
the MWTM client), the MWTM automatically opens the Discovery dialog box so you can run Discovery 
and populate the database.

The Discovery dialog box contains:

• Discovery Dialog Menu, page 4-6

• Discovery Dialog Tabs, page 4-7

Discovery Dialog Menu

The menu on the Discovery dialog box contains:

Menu Command Description

File > Load Seeds
(Ctrl-L)

Opens the Load File Dialog: Seed File List, enabling you to load a 
seed file into the MWTM:

• Enter the name of the seed file, and click OK to load it.

• Click Cancel to return to the Seed Settings tab without loading 
a seed file.

File > Save Seeds
(Ctrl-S)

Opens the Save File Dialog: Seed File List, which you use to save 
changes you have made to the selected seed file.

File > Save As Opens the Save File Dialog: Seed File List, which you use to save 
changes you have made to the selected seed file with a new name, 
or overwrite an existing seed file.
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Discovery Dialog Tabs

The Discovery dialog box contains these tabs:

Loading Seed Nodes and Seed Files
You use the MWTM to load one or more new seed nodes; or, to create, save, load, and delete existing 
MWTM seed files.

This section includes:

• Loading a Seed Node, page 4-8

• Loading a Seed File, page 4-8

• Saving a Seed File, page 4-9

• Creating a New Seed File, page 4-11

• Creating a New Seed File, page 4-11

• Creating and Changing Seed Files Using a Text Editor, page 4-13

File > Close
(Ctrl-W)

Closes the current window.

Edit > Node SNMP and 
Credentials Editor
(Alt-D)

Opens the Node SNMP and Credentials Editor dialog box.

If you have implemented MWTM User-Based Access, this option is 
available to users with authentication-level Network Administrator 
(level 4) and higher.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright 
information about the MWTM application.

Menu Command Description

Tab Description

Seed Settings Displays the Seed Settings tab in the Discovery dialog box.

Discovery Displays the Discovery tab in the Discovery dialog box.
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Loading a Seed Node

To load a seed node, enter the name or IP address of the seed node in the IP Address, Address range, 
Subnet, CIDR, or DNS Hostname field, and click Add Node (or press Enter). 

Note Follow the guidelines for IP addresses in SNMP Configuration Table, page 3-16.

The MWTM displays details of the SNMP settings for the seed nodes in the Seed Details pane. Continue 
adding seed nodes until you are certain that the MWTM will be able to discover the entire network.

Loading a Seed File

If you have already created and saved one or more seed files, you can load a seed file, change the list of 
seed files, and select one seed file to be loaded automatically when the MWTM client is started or the 
Discovery dialog box is opened.

To load an existing seed file, choose File > Load Seeds from the Discovery Dialog menu. The MWTM 
displays the Load File Dialog: Seed File List dialog box.

Figure 4-2 Load File Dialog: Seed File List Dialog

The Load File Dialog: Seed File List contains:

Field or Button Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the seed file or folder.

Last Modified Date and time the seed file or folder was last modified.

Size (bytes) Size of the seed file or folder, in bytes.
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Saving a Seed File

You use the MWTM to save a specific seed file, change the list of seed files, and select one seed file to 
be loaded automatically when the MWTM client is started or the Discovery dialog box is opened.

When you are satisfied that the MWTM has discovered all of the nodes in the network, save the list of 
seed nodes in a seed file by using one of these procedures:

• To save the changes you made to the seed file without changing the name of the file, choose File > 
Save from the Discovery Dialog menu.

• To save the changes you have made to the seed file with a new name, choose File > Save As from 
the Discovery Dialog menu. The MWTM displays the Save File Dialog: Seed File List dialog box 
(Figure 4-3).

The MWTM stores the seed file in the seed file directory on the MWTM server:

• If you installed the MWTM in the default directory, /opt, then the MWTM seed file directory is 
/opt/CSCOsgm/seeds.

• If you installed the MWTM in a different directory, then the MWTM seed file directory is located 
in that directory.

Make this my preferred start option Specifies whether the selected seed file should be loaded 
automatically whenever this MWTM client is started or the 
Discovery dialog box is opened.

By default, this check box is unchecked for all seed files. That is, 
no seed file is loaded automatically when the MWTM client is 
started or the Discovery dialog box is opened.

Number of Files
(appears in bottom-left corner)

Total number of seed files and folders.

OK Loads the selected seed file, saves any changes you made to the 
list of files, and closes the dialog box.

To load a seed file, double-click it in the list, select it in the list 
and click OK, or enter the name of the file and click OK.

The MWTM saves any changes you made to the list of files, 
closes the Load File Dialog: Seed File List dialog box, loads the 
seed file, and returns to the Discovery dialog box. The MWTM 
lists all of the seed nodes in the seed file in the Seed Nodes pane, 
and displays details of the SNMP settings for the seed nodes in the 
Seed Details pane.

Delete Deletes the selected file from the seed file list. The MWTM issues 
an informational message containing the name and location of the 
deleted file.

Cancel Closes the dialog box without loading a seed file or saving any 
changes to the seed file list.

Help Displays online help for the dialog box.

Field or Button Description
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Note If another user modifies and saves the seed file before you save your changes, the MWTM asks if you 
want to overwrite that user’s changes. If you choose to do so, the other user’s changes are overwritten 
and lost. If you choose not to do so, your changes are lost, unless you save the seed file to a different 
filename.

Figure 4-3 Save File Dialog: Seed File List Dialog

The Save File Dialog: Seed File List contains:

Field or Button Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the seed file or folder.

Last Modified Date and time the seed file or folder was last modified.

Size (bytes) Size of the seed file or folder, in bytes.

Filename Name by which you want to save the seed file.

If you create a new seed filename, you can use any letters, 
numbers, or characters in the name that are allowed by your 
operating system. However, if you include any spaces in the new 
name, the MWTM converts those spaces to hyphens. For 
example, the MWTM saves file a b c as a-b-c.

Make this my preferred start option Specifies whether the selected seed file should be loaded 
automatically whenever this MWTM client is started or the 
Discovery dialog box is opened.

By default, this check box is unchecked for all seed files. That is, 
no seed file is loaded automatically when the MWTM client is 
started or the Discovery dialog box is opened.
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Creating a New Seed File

To create a new seed file in the MWTM, launch the Discovery dialog box, as described in Launching the 
Discovery Dialog, page 4-6, then select the Seed Settings tab, if it is not already selected (Figure 4-1).

You use the Seed Settings tab within the Discovery dialog box to create, save, load, and delete MWTM 
seed files.

The Seed Settings tab on the Discovery dialog box contains:

Number of Files
(displayed in bottom left corner)

Total number of seed files and folders.

OK Saves the seed file and any changes you made to the seed file list 
and closes the dialog box.

To save the seed file with a new name, you can either save the file 
with:

• A completely new name. Enter the new name and click OK.

• An existing name, overwriting an old seed file. Select the 
name in the list and click OK.

The MWTM: 

• Saves the seed file with the new name

• Saves any changes you made to the list of files

• Closes the Save File Dialog: Seed File List dialog

• Returns to the Discovery dialog box

Delete Deletes the selected file from the seed file list. The MWTM issues 
an informational message containing the name and location of the 
deleted file.

Cancel Closes the dialog box without saving the seed file or saving any 
changes to the seed file list.

Help Displays online help for the dialog box.

Field or Button Description

Field or Button Description

Seed Nodes Lists the seed nodes currently defined in the MWTM.

IP Address Range 
or Hostname

IP address of the seed node. The default value is *.*.*.*.

Note Follow the guidelines for IP addresses in SNMP Configuration Table, 
page 3-16.

Retries Number of times the MWTM attempts to connect to the seed node. The valid 
range is 0 to 99. The default value is 2.

Timeout (sec) Time, in seconds, the MWTM waits for a response from the seed node. The valid 
range is 0 (no timeout) to 9999. The default value is 1 second.
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Changing an Existing Seed File

To modify an existing seed file in MWTM: 

Step 1 Load the seed file as described in Loading a Seed File, page 4-8.

Step 2 To add another seed node to the seed file, enter the name or IP address of the seed node in the IP Address, 
Address range, Subnet, CIDR, or DNS Hostname field, and click Add Node.

Step 3 To delete a seed node from the seed file, select the seed node and click Delete Node.

Step 4 To save the modified seed file, use the procedure described in Saving a Seed File, page 4-9.

Read Community SNMP community name for read access to the information maintained by the 
SNMP agent on the node. This value can be up to 32 characters in length. Do not 
include special characters such as the opening single quote ('), at symbol (@), 
dollar sign ($), caret (^), closing single quote ('), double quote ("), ampersand 
(&), or pipe (|). This value is usually set to public (the default).

Poll Interval (mins) Time, in minutes, between polls. The valid range is 0 to 9999. The default value 
is 15 minutes.

IP Address, 
Address range, 
Subnet, CIDR, or 
DNS Hostname

Address or name of the selected seed node.

To create a new seed file, enter the name or address of a seed node in this field. 
Examples of acceptable input include:

• IP Address: 1.2.3.4 (see the guidelines for IP addresses in SNMP 
Configuration Table, page 3-16).

• Address Range: 1.2.3.2-15

• Subnet, CIDR: 1.2.3.0/24, 1.2.3.0/255.255.255.0

• DNS Hostname: mwtm.cisco.com

The MWTM displays details of the SNMP settings for the seed node in the Seed 
Details pane. 

Continue to add as many seed nodes as necessary to discover your entire network.

When you are ready to save the list of seed nodes in a new seed file, choose File 
> Save As from the Discovery Dialog menu. The MWTM displays the Save File 
Dialog: Seed File List dialog box (Figure 4-3). See Saving a Seed File, page 4-9 
for more information about saving seed files.

Add Node Adds a new seed node to the MWTM.

Delete Deletes the selected seed node. The MWTM deletes the seed node without asking 
for confirmation.

Next Displays the Discovery tab in the Discovery dialog box.

If you enter a seed node IP address or name in the IP Address, Address range, 
Subnet, CIDR, or DNS Hostname field, then click Next, MWTM automatically 
adds the seed node before displaying the Discovery tab.

Field or Button Description
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Creating and Changing Seed Files Using a Text Editor

A seed file is simply an unformatted list of seed node names. To create a seed file by using a text editor, 
simply create a file and list the seed node names, one on each line, with no other formatting:

new-york-a
new-york-b
chicago-c

When you save and name the seed file, remember:

• You can use any letters, numbers, or characters in the name that your operating system allows, 
except blanks.

• The MWTM saves the seed file with a .see file extension.

• The MWTM saves the seed file in the MWTM server’s seed file directory, seeds:

– If you installed the MWTM in the default directory, /opt, then the seed file directory is 
/opt/CSCOsgm/seeds/.

– If you installed the MWTM in a different directory, then the seed file directory resides in that 
directory.

When the MWTM loads the seed file, it verifies the syntax of the file, deleting blank lines and extraneous 
leading and trailing spaces as needed. The MWTM also verifies that each seed node name resolves to a 
valid IP address. If a name does not resolve to a valid IP address, the MWTM logs the erroneous entry 
and ignores it.

For example, given this seed file:

new-york-a<space>
<space>new-york-b
zzzzzzzzzzzz
<blank line>
<tab>chicago-c<tab>

The MWTM loads these entries:

new-york-a
new-york-b
chicago-c

Running Discovery
Click the Discovery tab in the Discovery dialog box to discover the objects in your network.

To display the Discovery tab, launch the Discovery dialog box, as described in Launching the Discovery 
Dialog, page 4-6, then select the Discovery tab in the Discovery dialog box, or click Next in the Seed 
Settings tab. (If you enter a seed node IP address or name in the IP Address, Address range, Subnet, 
CIDR, or DNS Hostname field, then click Next, MWTM automatically adds the seed node before 
displaying the Discovery tab.) 
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Figure 4-4 Discovery Tab Before Discovery

The Discovery tab comprises:

• Discovery Settings, page 4-15

• Discovered Nodes, page 4-17

Related Topics:

• Discovery Overview, page 4-4

• Polling a Node, page 8-70
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Discovery Settings

The Discovery Settings pane of the Discovery tab contains:

Field or Button Description

Entire Network Check box used to specify the extent of the network discovery:

• To discover the entire network, check this check box. This is called recursive 
discovery, and it is the default setting.

With this check box checked, the MWTM discovers all seed nodes and 
attempts to manage them; then attempts to discover and manage all nodes that 
are adjacent to those seed nodes (unless the nodes are connected by serial links 
only); then attempts to discover and manage all nodes that are adjacent to those 
nodes; and so on, until the Max Hops limit is reached.

• To rediscover only seed nodes, uncheck this check box. This is called 
nonrecursive discovery.

With this check box unchecked, the MWTM discovers all seed nodes and 
attempts to manage them, then labels all nodes that are adjacent to those seed 
nodes as Unmanaged.

Delete Existing 
Data

Check box used to keep or delete the existing MWTM database when discovering 
the network:

• To keep all existing network data in the MWTM database before rediscovering 
the network, uncheck this check box. This is the default setting.

• To delete all existing network data from the MWTM database before 
rediscovering the network, check this check box. Choose this option if you 
know that network elements have been deleted from your network since the last 
Discovery.

If you discover the network with Delete Existing Data selected, the MWTM stops 
any real-time polls that are running and issues appropriate messages.

Max Hops The maximum number of hops from the seed node to search for other nodes to 
discover. Default is 3.
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If you run Discovery with the Entire Network check box unchecked, and then you run Discovery with 
the Entire Network check box checked, any Unmanaged nodes in the first Discovery are not rediscovered 
by the second Discovery.

Discover 
Network

Begins discovering the network.

Click Discover Network to begin Discovery.

If you have not defined at least one seed node in the Seed Settings tab, the MWTM 
prompts you to do so.

When Discovery begins:

• The Discover Network button changes to Stop Discovery.

• The Discovery In Progress message appears in the title bar of all MWTM 
client windows.

Discovery progresses in bursts. You might see a number of updates, followed by a 
pause, followed by more updates. The information that MWTM windows displays 
is not fully updated until Discovery is complete.

By default, Discovery times out after 600 seconds (10 minutes). To change the 
Discovery timeout, change the value of the DISCOVERY_TIMELIMIT entry in the 
Server.properties file:

• If you installed the MWTM in the default directory, /opt, then the location of 
the Server.properties file is /opt/CSCOsgm/properties/Server.properties.

• If you installed the MWTM in a different directory, then the Server.properties 
file resides in that directory.

Because the MWTM is an asynchronous system, with the MWTM server 
contacting clients one at a time, and because clients might run at different speeds, 
the information that MWTM clients display during Discovery might not always be 
synchronized.

All other MWTM windows (Node, topology, and so on) are also populated with the 
newly discovered network data.

Stop Discovery Stops the Discovery process. For example, if you click Discover Network, then you 
realize that you loaded a seed node that you did not intend to load, you can click 
Stop Discovery to stop the Discovery process.

Note If you stop the Discovery process, the information in the MWTM database 
is incomplete and unreliable. To generate a new, complete, and reliable 
MWTM database, check the Delete Existing Data check box and run 
Discovery again.

This button replaces the Discover Network button when the Discovery process 
begins, and changes back to the Discover Network button when the Discovery 
process ends.

Field or Button Description
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To recover from this situation and generate a new, complete, and reliable MWTM database, you must 
perform one of these procedures:

• Run Discovery again, with Entire Network and Delete Existing Data checked.

• Change the Unmanaged nodes to managed status. See Unmanaging and Managing Nodes or ITP 
Signaling Points, page 6-38 for more information.

• Poll the nodes that were Unmanaged in the first Discovery. See Polling a Node, page 8-70 for more 
information.

Discovered Nodes

The Discovered Nodes table in the Discovery tab (Figure 4-5) lists all nodes that the MWTM discovered 
(all nodes, including new and excluded nodes, not just the nodes in the current view). By default, this 
table is sorted by Status.

Figure 4-5 Discovery Tab After Discovery, with Discovered Nodes

To see a tooltip for each column in the table, place the cursor over a column heading.

If a cell is too small to show all of its data, place the cursor over the cell to see the full text in a tooltip.
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You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Discovered Nodes section except Internal ID, Uptime, 
Reboot Reason, Process Traps, and Last Status Change.

• To display hidden columns, right-click in the table heading and select the check boxes for the 
columns that you want to display.

• To hide columns, right-click in the table heading and uncheck the check boxes for the columns that 
you want to hide.

For detailed information on working within tables, see Navigating Table Columns, page 5-23 

The Discovered Nodes section contains:

Column or Button Description

Internal ID Internal ID of the event. The internal ID is a unique ID for every object that the 
MWTM assigns for its own internal use. It can also be useful when the TAC is 
debugging problems.

Name Name or IP address of the discovered node.

All discovered nodes are placed in a DEFAULT configuration view, which is 
stored on the MWTM server and all MWTM clients share. Initially, all clients use 
the DEFAULT view. Users can then create their own views, which are subsets of 
the DEFAULT view, to meet their individual needs. However, you cannot modify 
the DEFAULT view stored on the MWTM server. The DEFAULT view is always 
available for users who need to view the entire network.

Primary SNMP 
Address

IP address of the node that SNMP uses to poll the node. (There might be other 
IP addresses on the node that are not the primary SNMP address.)

CLLI Code (ITP 
only)

COMMON LANGUAGE Location Identification Code for the node. A CLLI 
code is a standardized 11-character identifier that uniquely identifies the 
geographic location of the node. If the node has no CLLI code configured, this 
field is blank.
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Node Type Type of node. Node types can be specific to ITP, RAN-O, or generic to both.

ITP specific nodes include:

• Cisco2650XM, Cisco2651XM

• Cisco2811

• Cisco7204VXR, Cisco7206VXR

• Cisco7301

• Cisco7507, Cisco7507mx, Cisco7507z, Cisco7513, Cisco7513mx, 
Cisco7513z

• Cisco7604, Cisco7606, Cisco7609, Cisco7613

RAN-O-specific nodes include:

• CiscoMWR-1941-DC-A—Cisco MWR-1941-DC-A series router

• CiscoONS15454—Cisco ONS 15454 SONET multiplexer

• Node B—The radio transmission and reception unit for communication 
between radio cells.

• RAN_SVC—RAN Service Module in the Cisco ONS 15454

Generic nodes include:

• IPDevice—IP device, other than those listed previously. You can assign this 
icon to an unknown node if you know that it is an IP device.

• Unknown—MWTM is unable to determine the node type.

Software Version Version of software (for example, IOS) that is installed on the node.

Uptime Time the node has been up, in days, hours, minutes, and seconds.

Reboot Reason Reason for the last reboot of the node.

Ignored Indicates whether the node should be included when aggregating and displaying 
MWTM status information:

• Uncheck the check box to include the node. This is the default setting.

• Select the check box to exclude the node.

Note Not applicable for unmanaged nodes.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Process Traps Indicates whether the MWTM should process traps from this node:

• Check the check box if you want the MWTM to process traps from this node. 
This is the default setting.

• Uncheck the check box if you do not want the MWTM to process traps from 
this node.

Users with authentication level Power User (level 4) and higher can edit this 
field.

Column or Button Description
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Trap Polling 
(RAN-O only)

Indicates whether trap polling is enabled. This field is read-only. If you want to:

• Enable trap polling for the RAN-O node, set ipran-mib snmp-access to 
outOfBand on the node.

• Disable trap polling for the RAN-O node, set ipran-mib snmp-access to 
inBand on the node.

Report Polling Indicates whether report polling is enabled on the web interface.

For ITP nodes, the default setting is enabled (check box is checked). To disable 
ITP report polling, uncheck the check box.

For RAN-O nodes, the check box is read only. If you want to: 

• Enable trap polling for the RAN-O node, set ipran-mib snmp-access to 
outOfBand on the node.

• Disable trap polling for the RAN-O node, set ipran-mib snmp-access to 
inBand on the node.

Notes Indicates whether a note is associated with the node.

Events Indicates whether a recent event is associated with the node. (Even if the server 
purges all of the events associated with the node, the MWTM continues to 
display the event icon in this field.)

During Discovery, the MWTM might flag most nodes with an event icon (orange 
triangle). If the event icons are too distracting, choose Edit > Clear All Events 
from the MWTM main menu to remove them.

Last Status Change Date and time that the status of the node last changed.

Status Current status of the node. Possible values are:

Active (green)

Discovering (cyan)

Polling (cyan)

Unknown (red)

Unmanaged (gray)

Waiting (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Column or Button Description
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Verifying Discovery
After you discover the network (see Discovery Overview, page 4-4), examine the Discovered Nodes 
table to verify that the MWTM discovered all of the nodes in the network. If you suspect that the MWTM 
did not discover all of the nodes, verify that:

• No nodes are excluded from your current view.

• The MWTM server can ping the nodes.

• The nodes are running images that are compatible with the MWTM server.

• SNMP is enabled on the nodes.

• The MWTM is configured with the correct SNMP community name. See Launching the Discovery 
Dialog, page 4-6 for details.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If you installed 
the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file reside in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing severity. If two or more 
reasons apply, the reason of greatest severity appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Back Displays the Seed Settings tab in the Discovery dialog box.

Delete Deletes the selected node or nodes from the Discovery database. The MWTM 
deletes the nodes without asking for confirmation.

Poll Node Begins a poll of all nodes selected within the Discovered Nodes table in the 
Discovery tab.

You cannot poll a node with a Primary SNMP Address of N/A. If you select:

• A node with a Primary SNMP Address of N/A, then the Poll button is 
dimmed and cannot be selected.

• More than one node, and even one of them has a Primary SNMP Address of 
N/A, then the Poll button is dimmed and cannot be selected.

Column or Button Description
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• (ITP only) The missing nodes are connected to the seed nodes by SCTP connections, not just serial 
connections. If they are not connected by SCTP connections, you must add the missing nodes to the 
seed file as seed nodes. See Changing an Existing Seed File, page 4-12 for more information.

• You selected Entire Network when you ran Discovery. If you suspect that you did not, run Discovery 
again with Entire Network selected.

Displaying the MWTM Main Window
The MWTM main window (Figure 4-7) is the primary MWTM client window. It is the first window to 
appear when you launch the MWTM client. It displays information about the events and objects that the 
MWTM discovers. The MWTM main window is divided into two areas: the navigation tree in the left 
pane and the content area in the right pane. When you select an item in the navigation tree, MWTM 
displays detailed information about the item in the content area in the right pane, such as configuration 
details and real-time data.

The MWTM main window contains:

When you start the MWTM for the first time, the MWTM displays the Discovery dialog box and the 
MWTM main window.

Element Description

Title Bar Displays: MWTM main window (ITP and/or RAN-O 
personality) - <server name>.

MWTM main menu For details, see Using the MWTM Main Menu, page 4-33.

Alarms Displays a summary of all currently active alarms in your 
network, including the current status of the associated 
network object. For details, see Displaying Alarms, page 
4-30.

Events Displays information about the events that the MWTM event 
logger and event processor deliver for all objects in the 
current network view. For details, see Chapter 9, “Managing 
Events.”

Summary Lists Displays basic summary information about all discovered 
network objects, including their status, the total number of 
objects with that status, and the number of nodes with that 
status. For details, see Displaying Summary Lists, page 4-26.

DEFAULT View (or named view) Displays the view name and all objects within that view. For 
details about views, see Chapter 7, “Managing Views.”
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Figure 4-6 Discovery Dialog

Figure 4-7 MWTM Main Window

The MWTM main window is the primary window of the MWTM client interface. It is the first window 
to appear when you launch the MWTM client. It displays basic information about the events and objects 
that the MWTM discovers.

When you start the MWTM for the first time, if you did not configure the MWTM server to automatically 
discover your network the first time the server starts after installation, the MWTM database contains no 
information, and the MWTM main window is blank. The database is populated, and reflected in the 
MWTM main window, when you run Discovery for the first time; the MWTM displays the Discovery 
dialog box to make it easier for you to do so. In fact, any time you start the MWTM client and the 
MWTM database is empty, the MWTM automatically opens the Discovery dialog box so you can run 
Discovery and populate the database. For more information about Discovery, see Discovering Your 
Network, page 4-4.

The events and objects that the MWTM discovers appear in the MWTM main window.
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Navigational Features
To help you keep track of which view you are currently using, as well as other important information, 
most MWTM windows display the name of the system on which the MWTM server is running in the title 
bar. This information appears across the bottom of the window:

• A “locked padlock” symbol if the MWTM server has a security certificate. To see the certificate, 
click the symbol. An “unlocked padlock” symbol if the MWTM server does not have a security 
certificate.

• The number of objects currently visible in the window, if any.

• The number of files currently visible in the load or save files dialog box, if any.

• Status messages, as appropriate:

– Informational messages are visible in black. For example:

Discovery running

– Messages that indicate successful actions are visible in green. For example:

View Saved

– Error messages are visible in red. For example:

Node does not have a note

– The MWTM contains many fields into which you can enter information, such as a new node 
name or IP address. If you enter an incorrect value in the field, such as an IP address that 
contains letters or is too long, the MWTM alerts you of the incorrect value and retains the 
current value of the field. Check the message bar at the bottom of the window for information 
and assistance.

• The text (Modified), if you have modified but not yet saved a view. You must save the view if you 
want to save your changes. For details, see Saving a View, page 7-7.

• A New icon, if there is at least one newly discovered node, signaling point, or application server 
process in the network that has not been added to your current view. To add or exclude the node to 
your current view, see New on the Network Pane, page 7-13.

Clicking the New icon in the topology window opens the New Objects pane in the left pane. Clicking 
the New icon in any other window opens the Edit View tab of the View Editor window.

• The name of the current view.

• The name of the current user, or the name of the node the user is using.

• If you have implemented MWTM user access security, the authentication level of the user.

If your personal default view has been deleted, then the next time you launch the client, the MWTM 
informs you that your default view has been deleted and that your view has been reset to the DEFAULT 
view. To choose another view as your default view, use the Load Dialog: View List. For details, see 
Loading a Client-Specific View, page 7-15.
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MWTM Client Navigation Tree
The MWTM Client navigation tree displays objects in a variety of formats and views. The DEFAULT 
view, and other views that you can create, display a hierarchy of the objects that the MWTM manages. 
The highest objects within a view are nodes, which contain the following subtending objects: 

• RAN-O nodes can contain:

– RAN SVC—A RAN SVC node can contain a list of backhauls, a management interface folder, 
and a physical folder.

– RAN Backhaul—The end-to-end RAN connection between the BTS or Node B at the cell site 
and the BSC or RNC at the aggregation site. The RAN backhaul contains one or more shorthaul 
objects and an IP backhaul object.

– IP Backhaul—The IP link that carries RAN-O traffic between the RAN-O nodes (for example, 
between an MWR at the cell site and a RAN Service card in an ONS at the aggregation site).

• RAN backhauls can contain:

– GSM Abis Shorthaul—In GSM technology, the interface between the BTS and the BSC.

– UMTS Iub Shorthaul—In UMTS technology, the interface between the Node B and the RNC.

Note The MWTM does not manage BSC, BTS, RNC, or Node B objects but displays them in the 
topology window to help you visualize the network.

• ITP nodes can contain:

– Signaling Points—A signaling point object contains a list of associated linksets, links, and 
other related objects.

– Application Server Processes—An application server process object can contain application 
server process associations.

• ITP and RAN-O nodes can contain: 

– Management Interfaces—A folder that contains a list of interfaces that the MWTM uses to 
manage the node.

– Physical—A folder that contains a list of the physical interfaces and cards that belong to the 
node. Slot numbers precede card objects (for example, 15 - RAN_SVC or 02 - E1-42).

Note All objects in the Physical folder are ignored unless they also appear outside of the Physical 
folder. The status of Physical folder-only objects does not contribute to the status of the parent 
node. These objects also do not appear in the Alarms view, but they do appear in the Events view. 
You can un-ignore the Physical folder, then re-ignore the objects you do not want to monitor. For 
more information, see Why are objects in the Physical folder ignored?, page C-8).

You can easily navigate the features of the MWTM client with the navigation tree. To view detailed 
information about an object in the navigation tree, click the object in the tree. The content area in the 
right pane displays the details about the selected object. An icon just to the left of the object name 
indicates whether the object has subtending objects under its domain. This icon is called a turner. To 
expand the tree of objects, click the turner. Click the turner again to collapse the objects.
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Note For additional features that appear only in the navigation tree of the web interface, see MWTM Web 
Interface Navigation Tree, page 11-3.

MWTM Client Content Area
The content area in the right pane displays detailed information about your network, such as 
configuration and historical data. To view detailed information for an object, click the object in the 
navigation tree. The content area in the right pane shows the details about the selected object. 

The content area formats the information in a way that is easy to interpret. Descriptive information is 
usually organized into subpanes. Tabs along the top of the content area organize more complex sets of 
information. Large amounts of information are organized into tables with labeled columns and multiple 
rows of data.

For additional features that appear only in the content area of the MWTM web interface, see MWTM 
Web Interface Content Area, page 11-4.

Displaying Summary Lists
You use the MWTM to view basic summary information about all discovered network objects, including 
their status and associated alarms and events.

• To see a summary of all network objects that the MWTM discovered, click Summary Lists in the 
navigation tree. The MWTM displays the Summary Statistics window in the content area. 

• Right-click Summary Lists in the navigation tree to display a menu for the summary lists. For more 
information, see Right-Click Menu for the Summary Lists, page 4-29.

• For details on the right-click menu for an object within a summary list, see Viewing the Right-Click 
Menu for an Object, page 8-3.

Note If an object of a given type has not been discovered, then the corresponding summary lists folder does 
not appear. 

To view the summary lists, select Summary Lists in the navigation tree within the MWTM main window. 
The MWTM displays the Summary Statistics window.
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Figure 4-8 Summary Statistics Window

The Summary Statistics window provides basic summary information about all discovered network 
objects that the MWTM discovered. For detailed information on objects within Summary Lists, see 
Displaying Object Windows, page 6-2.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, with failures (red statuses) at the top, and the MWTM displays all of the 
columns in the table except Signaling Points, Linksets, Links, Application Servers, Application Server 
Processes, Application Server Process Associations, and Signaling Gateway Mated Pairs.

Note If you are viewing Summary Lists through the MWTM Web interface, all columns appear, assuming you 
have discovered all types of objects. For example, if you have no Cards discovered, the Cards column is 
not visible.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The summary list table contains:
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Column Description

Status Current status of the network objects. Possible values are:

Unknown (red)

Unavailable (red)

Inactive (red)

Failed (red)

Down (red)

Blocked (red)

Pending (red)

Warning (yellow)

Shutdown (blue)

InhibitLoc (blue)

InhibitRem (blue)

Discovering (cyan)

Polling (cyan)

Waiting (gray)

Unmanaged (gray)

Active (green)

For detailed definitions of each status for each type of network object, see 
Appendix E, “Status Definitions.”

Total Total number of network objects with the indicated status.

Objects in hidden columns are not included in the totals. 

Nodes Total number of discovered nodes with the indicated status.

Signaling Points 
(ITP only)

Total number of discovered signaling points with the indicated status.

Linksets
(ITP only)

Total number of discovered linksets with the indicated status.

Linksets is a count of linkset pairs, not individual linksets; therefore, this 
count might differ from the number of linksets in the MWTM client 
navigation tree.

Links 
(ITP only)

Total number of discovered links with the indicated status.

Links is a count of link pairs, not individual linksets; therefore, this count 
might differ from the number of links in the MWTM client navigation tree.

Application Servers 
(ITP only)

Total number of discovered application servers with the indicated status.

Application Server 
Processes 
(ITP only)

Total number of discovered application server processes with the indicated 
status.

Application Server 
Process Associations 
(ITP only)

Total number of discovered application server process associations with the 
indicated status.
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Right-Click Menu for the Summary Lists

To see the right-click menu for the summary lists, select Summary Lists or any of the objects under 
Summary Lists in the navigation tree and press the right mouse button. The menu provides:

Signaling Gateway 
Mated Pairs 
(ITP only)

Total number of discovered signaling gateway-mated pairs with the indicated 
status.

Interfaces Total number of discovered interfaces with the indicated status.

RAN Backhauls Total number of discovered RAN backhauls with the indicated status.

RAN Shorthauls Total number of discovered RAN shorthauls with the indicated status.

Cards Total number of discovered cards with the indicated status.

Column Description

Menu Command Description

Show In New Window Opens the current window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.
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Displaying Alarms

Note For details about viewing alarms using the MWTM web interface, see Displaying Alarms, page 11-27.

You use the MWTM to view a summary of all currently active alarms in your network, including the 
current status of the associated network object. An active alarm is a network object with this status:

• A node or interface that is Warning (yellow) or worse and is not Ignored.

• A node or interface that is Pending (red) or worse and is not Ignored.

• An application server process, application server process association, link, or signaling 
gateway-mated pair that is Warning (yellow) or worse and is not Ignored.

• An application server, linkset, node, or signaling point that is Pending (red) or worse and is not 
Ignored.

To see a summary of all currently active alarms, click Alarms in the navigation tree. The MWTM 
displays the Active Alarms window in the content area (see Figure 4-9).

• Right-click Alarms in the navigation tree to display the right-click menu for all alarms. For more 
information, see Right-Click Menu for All Alarms, page 4-32.

• Right-click an alarm in the content area to display the right-click menu for a specific alarm. For 
more information, see Right-Click Menu for a Specific Alarm, page 4-32.

Figure 4-9 Active Alarms Window

The Active Alarms window provides basic information about all currently active alarms in your network 
that are not excluded from your current view. The MWTM updates the information in the window at least 
once every minute.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Age, with the most recent alarms at the top, and the MWTM displays all of the 
columns in the table except Last Status Change.

See Navigating Table Columns, page 5-23 for more information about resizing, sorting, displaying, or 
hiding columns.
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The active alarms table contains:

Column Description

Type Type of network object associated with the selected alarm.

To see all higher-level alarms associated with the network object, select the 
turner beside the object. The MWTM displays the higher-level alarms below 
the selected alarm. For example, if you select the turner beside a link, the 
MWTM displays the alarms for the linkset, signaling point, and node 
associated with that link.

Name Name of the network object associated with the selected alarm.

Status Current status of the network object associated with the selected alarm. 
Possible values are:

Unknown (red)

Unavailable (red)

Inactive (red)

Failed (red)

Down (red)

Blocked (red)

Pending (red)

Warning (yellow)

Shutdown (blue)

InhibitLoc (blue)

InhibitRem (blue)

Discovering (cyan)

Polling (cyan)

Waiting (gray)

Unmanaged (gray)

Active (green)

For detailed definitions of each status for each type of network object, see 
Appendix E, “Status Definitions.”
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Right-Click Menu for All Alarms

To see the right-click menu for all active alarms, select Alarms in the navigation tree and press the right 
mouse button. For details on the menu options, see Right-Click Menu for the Summary Lists, page 4-29.

Right-Click Menu for a Specific Alarm

The active alarms table provides a subset of the MWTM main menu as a right-click menu. To see this 
menu, select an alarm and press the right mouse button. The alarm right-click menu provides the same 
options as the right-click menu for the associated network object, plus these:

Caution The alarms that the active alarms table displays are the actual network objects in the MWTM. Options 
that you select in the right-click menu affect the object in the MWTM. For example, if you delete a node 
in the active alarms table, you delete that node from the MWTM database.

Status Reason Reason for the current status of the network object associated with the 
selected alarm.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing severity. If two or more 
reasons apply, the reason of greatest severity appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Last Status Change Date and time that the status of the network object associated with the 
selected alarm last changed.

Age Age of the selected alarm, in days, hours, and minutes.

Column Description

Menu Command Description

Expand All Displays all higher-level alarms associated with all network objects in the active 
alarms table.

Collapse All Does not display higher-level alarms in the active alarms table.
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Using the MWTM Main Menu
The MWTM main menu appears in the menu bar of most MWTM windows.

Some menu items do not appear on some windows. In addition, menu items that are dimmed are not 
available on that window.

For detailed information about the menu options provided by other windows, see the descriptions of 
those windows.

The MWTM main menu contains:

Menu Command Description

File > Load DEFAULT View
(Ctrl-D)

Loads the DEFAULT view, which is the view into 
which the MWTM places all discovered objects when 
discovering the network. The DEFAULT view is stored 
on the MWTM server and shared by all MWTM 
clients, but the clients cannot modify it.

File > Load View
(Ctrl-L)

Loads an already existing view. The MWTM prompts 
you for the name of the view you want to load:

• Select the name of the view, or accept the default 
view name, then click OK to load the view.

• Click Cancel to close the prompt window without 
loading a view.

File > Save View
(Ctrl-S)

Saves the current view:

• If you have not already saved the current view, 
opens the Save File dialog box: View List, in 
which you enter or select a filename under which 
to save the current view.

• If you have already saved the current view, saves 
the view to that filename.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Power User (level 2) and higher.

File > Save View As Opens the Save File Dialog: View List, which you use 
to enter or select a filename under which to save the 
current view.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Power User (level 2) and higher.

File > Connect to New Server
(Ctrl-O)

Connects to a new server. The MWTM prompts you for 
the new server’s name or IP address, and UDP port 
number.

The MWTM stops the MWTM client, then restarts the 
client connected to the new server.
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File > Print
(Ctrl-P)

Opens the Print window where you can:

• Specify options for printing

• Print the current window

• Save the current window to a file

The MWTM printing options require that you define a 
printer on your system. If you choose File > Print and 
the Print window does not appear, ensure you have 
defined a printer on your system.

File > Exit
(Ctrl-Q)

Exits the MWTM application, after prompting you for 
confirmation.

If you are working in a custom view (that is, not the 
DEFAULT view), the MWTM automatically saves any 
changes you made to the view.

Edit > Views
(Ctrl-M)

Opens the View Editor window to allow you to edit any 
views that you have created.

Edit > Clear All Events
(Ctrl-E)

Deletes the event icon (orange triangle) from MWTM 
displays for all known objects. The actual events are 
not deleted from the MWTM, only the event icon for 
all known objects.

Note During Discovery, the MWTM might flag most 
objects with an event icon. If the event icons 
are too distracting, use the Edit > Clear All 
Events menu option to remove them.

Edit > Find
(Ctrl-F)

Opens the Find dialog box, in which you find a specific 
object, event, or text in the window.

If you select an object in the navigation tree within the 
MWTM main window, this option is dimmed and 
cannot be selected.

Menu Command Description
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Edit > Delete
(Delete)

Deletes the currently selected element or elements 
from the MWTM database. The MWTM displays the 
Confirm Deletion dialog box. To:

• Delete the selected elements, click Yes. The items 
are deleted from the MWTM database and the 
Confirm Deletion dialog box is closed.

• Retain the selected elements, click No. The items 
are kept in the MWTM database and the Confirm 
Deletion dialog box closes.

• Prevent the MWTM from displaying the Confirm 
Deletion dialog box, select the Do not show this 
again check box.

Note If you select the Do not show this again check 
box, and you later decide you want the MWTM 
to begin displaying the Confirm Deletion 
dialog box again, you must select the Confirm 
Deletions check box in the General GUI 
settings in the Preferences window. For more 
information, see the description of the Confirm 
Deletions check box in Startup/Exit Settings, 
page 5-4.

To permanently delete all elements marked for deletion 
from the MWTM database, you can also run the mwtm 
purgedb command (see mwtm purgedb, page B-41).

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Edit > Preferences
(Ctrl-H)

Opens the Preferences window.

Network> Node SNMP and Credentials 
Editor
(Alt-S)

Opens the SNMP Configuration dialog box.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Network > Network Discovery
(Ctrl-Y)

Opens the Discovery dialog box.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Network > Poll Nodes > Normal Poll
(Alt-L)

Polls all selected nodes.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Operator (level 3) and higher.

Menu Command Description
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Network > Poll Nodes > Clean Poll
(Alt-C)

Polls all selected nodes and removes any Unknown 
objects after the completion of the poll.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Operator (level 3) and higher.

Network > Node Archive Management Opens the Node Archive Management dialog box, 
allowing you to view archived GTT files, route table 
files, or MLR address table files and perform various 
functions on the files.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Network > Node File Management Opens the Node File Management dialog box, 
allowing you to view GTT files, route table files, or 
MLR address table files and perform various functions 
on the files.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

View > Show Topology
(Ctrl-T)

Opens the topology window.

View > MWTM Server > Connect via Telnet
(Ctrl+Shift+T)

Opens a Telnet window to the server.

View > MWTM Server > Connect via SSH
(Ctrl+Shift+S)

Opens a Secure Shell (SSH) window to the server.

Note The key size on the SSH server must be a 
minimum of 512 bits and a maximum of 2048 
bits.

View > MWTM Server > Status Opens the Server Status Information window.

View > Web > Home Displays the MWTM web interface home page in a 
web browser.

View > Web > Administrative Displays the MWTM web administrative page in a web 
browser.

View > Web > Reports Displays the MWTM web reports main page in a web 
browser. 

View > Web > Archived Events > Status 
Changes

Displays the archived status changes in a web browser. 

View > Web > Archived Events > SNMP 
Traps 

Displays the archived SNMP traps in a web browser.

View > Web > Archived Events > Status 
Changes and SNMP Traps

Displays both the archived status changes and archived 
SNMP traps in a web browser.

View > Web > Software Versions Displays the MWTM software versions for the server 
you are connected to, and which is currently running 
the MWTM server, in a web browser.

View > Message of the Day Opens the Message of the Day dialog box.

Menu Command Description
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View > Cisco.com Displays the Cisco.com Home Page in a web browser.

Go > Back
(Alt-Left Arrow) 1

Navigates back to the last window viewed in this 
session.

Go > Forward
(Alt-Right Arrow) 1

Navigates forward to the last window viewed in this 
session.

Go > Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back 
windows.

Go > Forward > List of Windows Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward 
windows.

Tools > Route Table > From Archive
(Alt-J)

(ITP only)

Opens the Load Route Table from Archive wizard. 

If you select an Unmanaged node, this option is 
dimmed and cannot be selected.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Tools > Route Table > From Node
(Alt-O)

(ITP only)

Opens the Route Table dialog box by using a route 
table from an ITP node.

If you select an Unmanaged node, this option is 
dimmed and cannot be selected.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Tools > Route Table > From File
(Alt-I)

(ITP only)

Opens the Route Table dialog box by using a route 
table from a file.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Administrator (level 4) and higher.

Tools > Global Title Translator Editor
(Ctrl-G)

(ITP only)

Launches the GTT client.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Operator (level 3) and higher.

Tools > Address Table Editor 
(Alt-A)

(ITP only)

Launches the Address Table Editor, which you use to 
create new address table files, load existing address 
table files, perform semantic checks, save address 
table files, and deploy address table files to an ITP. 

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Operator (level 3) and higher.

Menu Command Description
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Tools > Event Editor
(Alt-B)

Launches the Event Editor, which you use to:

• Customize the visible category, severity, color, 
and message associated with events

• Configure sounds for the MWTM to play for 
different types of events

• Load, save, and deploy customized event 
configurations.

If you have implemented MWTM User-Based Access, 
this option is available to users with authentication 
level Network Operator (level 3) and higher.

Tools > Event Sounds
(Ctrl-U)

Opens the Event Sound Filters dialog box, which you 
use to define sounds that the MWTM client should 
play when specific events are logged.

Tools > Virtual RAN Backhaul Editor
(Ctrl-B)

Launches the Virtual RAN Backhaul Editor, which you 
use to create a virtual RAN backhaul by grouping real 
backhauls.

Tools > CiscoWorks > Device Center
(Ctrl-2)

Links to the CiscoWorks Device Center, which 
provides a number of web-based functions, including 
reachability trends, response time trends, interface 
status, Syslog browsing, and detailed inventory. The 
MWTM prompts you for a CiscoWorks user ID and 
password before linking to CiscoWorks.

The link to CiscoWorks has these prerequisites. 
CiscoWorks must:

• Be installed somewhere in the network.

• Monitor the specific device.

This option is dimmed if the selected node is not an 
ITP or RAN-O node, or in Unmanaged status or has a 
Device Type of Unknown. (CiscoWorks cannot 
monitor a non-ITP, Unmanaged, or Unknown node.)

This option is not visible if you did not specify a 
CiscoWorks server during installation. See the 
“Installing MWTM on Solaris” and “Installing 
MWTM on Windows” chapters of the Installation 
Guide for the Cisco Mobile Wireless Transport 
Manager 6.0 for more information.

Menu Command Description
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Accessing the MWTM through a Web Browser
You can manage network nodes through one of two graphical user interfaces:

• MWTM client interface—The standard interface for accessing MWTM data. (This interface is 
described in Displaying the MWTM Main Window, page 4-22.)

• MWTM web interface—A browser interface for accessing MWTM data. (This interface is 
introduced here and fully described in Chapter 11, “Accessing Data from the Web Interface.”)

A comparison of the GUI features supported in each interface is shown in this matrix:

Tools > CiscoWorks > CiscoView
(Ctrl-3)

Links to CiscoView, which provides a real-time, 
color-coded, graphical representation of Cisco objects. 
You can use CiscoView to quickly identify an incorrect 
status on a port or interface.

This option is dimmed if the selected node is not an 
ITP or RAN-O node, or in Unmanaged status or has a 
Device Type of Unknown. (CiscoWorks cannot 
monitor Unmanaged or Unknown nodes or nodes that 
are not ITP or RAN-O nodes.)

This option is not visible if you did not specify a 
CiscoWorks server during installation. See the 
“Installing MWTM on Solaris” and “Installing 
MWTM on Windows” chapters of the Installation 
Guide for the Cisco Mobile Wireless Transport 
Manager 6.0 for more information.

Help > Topics
(F1)

Displays the table of contents for the MWTM online 
help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and 
copyright information about the MWTM application.

1. In the UNIX environment (Solaris or Linux), this key combination can be mapped to a different function based on the 
Common Desktop Environment (CDE) that a user might have. For example, in Solaris CDE, Alt-Left Arrow and Alt-Right 
Arrow combinations are typically mapped to move back and forward through the different desktops. To remap the keys for 
use with the MWTM, see your UNIX Desktop Environment guide.

Menu Command Description

GUI Features Web Interface Client Interface Notes

Main window X X Slight differences exist between the 
interfaces (in the navigation tree and content 
area displays).

Discovery window X Client-only feature, but the nodes that appear 
in the web interface are refreshed after a 
discovery is performed in the client 
interface.
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You access the web interface using one of two methods:

• Open a browser and enter http://server_name:1774 in the Address field.

• From the MWTM client interface, choose View > MWTM Server > Home Page.

The web interface window opens in the browser window.

Historical Data X You enter a start and stop time for the data 
you are interested in, and the MWTM 
retrieves the data from its database. You can 
access the web interface display from the 
right-click menus in the client interface.

Real-time Data X The MWTM periodically polls the node for 
real-time data, and updates the charts and 
graphs as new data is received.

Topology X Client-only feature.

High-level editors X These editors appear under the Tools menu 
of the MWTM main window:

• Route Table Editor

• GTT Title Editor

• Address Table Editor

• Event Editor 

Provisioning X Web-only feature for ITP objects. 

To launch web provisioning from the 
MWTM client, select the ITP object in the 
navigation tree and choose the Provision 
option from the right-click menu.

GUI Features Web Interface Client Interface Notes
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Figure 4-10 MWTM Web Interface

For detailed information about the MWTM web interface, see Chapter 11, “Accessing Data from the 
Web Interface.”

Loading and Saving MWTM Files
You use the MWTM to quickly and easily load and save MWTM files. The files are on the MWTM server 
and you can load them on any connected MWTM client.

To display a Load File dialog box, use one of these procedures:

Launched From Choose Window Launched Notes

Address Table Editor 
(ITP only)

File > Load > Load 
from File

Load File Dialog: 
Address Table File List

See Loading an Existing 
Address Table File, 
page 15-8.

Discovery dialog box File > Load Seeds Load File Dialog: Seed 
File List

See Loading Seed 
Nodes and Seed Files, 
page 4-7.

Event Filter dialog box Load Load File Dialog: Load 
Filter

See Loading an Existing 
Event Filter, page 9-16.

GTT Editor (ITP only) File > Load Load File Dialog: GTT 
File List

See Loading an Existing 
GTT File, page 14-33.
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Note To load the DEFAULT network view, choose File > Load DEFAULT View from the MWTM main 
menu. The MWTM loads the DEFAULT view.

To display a Save File dialog box, use one of these procedures:

Preferences window File > Load System 
Default Prefs

None See Displaying the 
Preferences Menu, page 
5-3.

Route Table dialog box File > Load Load File Dialog: Route 
Table File List

See Loading an Existing 
Route Table File, page 
13-12.

View Editor window File > Load Load File Dialog: View 
List

See Loading a 
Client-Specific View, 
page 7-15.

Launched From Choose Window Launched Notes

Launched From Choose Window Launched Notes

Address Table Editor 
(ITP only)

File > Save As Save File Dialog: 
Address Table File List

See Saving an Address 
Table File, page 15-23.

Discovery dialog box File > Save As Save File Dialog: Seed 
File List

See Saving a Seed File, 
page 4-9.

Event Filter dialog box File > Save As Save File Dialog: Save 
Filter

See Saving an Event 
Filter File, page 9-17.

GTT Editor (ITP only) File > Save As Save File Dialog: GTT 
File List

See Saving a GTT File, 
page 14-46.

Route Table dialog box File > Save As Save File Dialog: Route 
Table File List

See Saving a Route 
Table File, page 13-14.

View Editor window File > Save As Save File Dialog: View 
List

See Closing the View 
Editor Window, page 
7-15.
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Using the Windows Start Menu
This section includes:

• Changing the Default MWTM Server Name, page 4-43

• Launching the MWTM Client, page 4-43

• Launching the MWTM DOS Prompt, page 4-44

• Launching the MWTM Event Editor, page 4-44

• Launching the MWTM SSL Certificate Tool, page 4-44

• Displaying the MWTM README File, page 4-44

• Uninstalling the MWTM, page 4-44

Changing the Default MWTM Server Name
If the IP address or hostname to which your MWTM client is bound fails, you can change the default 
MWTM server name from the Windows Start menu.

To change the default MWTM server name:

Step 1 Close all open MWTM windows.

Step 2 Choose Start > Programs > Cisco MWTM Client > Modify Default MWTM Server  Name. The 
MWTM opens a DOS window, and asks you to enter the name of the new default MWTM server.

Step 3 Type the name of the new default MWTM server, and press Enter. The MWTM sets the default server 
to the new name that you entered.

Tip See Connecting to a New Server, page 5-42 for more information about changing the default MWTM 
server name.

Launching the MWTM Client
To launch the MWTM Client, choose Start > Programs > Cisco MWTM Client > MWTM Client 
from the Windows Start menu, or double-click the MWTM icon on the desktop. The MWTM launches 
the MWTM Client.
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Launching the MWTM DOS Prompt
To launch a DOS prompt for the MWTM from the Windows Start menu, choose Start > Programs > 
Cisco MWTM Client > MWTM DOS Prompt. The MWTM opens a DOS window, starting in the \bin 
directory:

• If you installed the MWTM client in the default directory, C:\Program Files, then the DOS prompt 
starts at C:\Program Files\MWTMClient\bin.

• If you installed the MWTM client in a different directory, then the \bin directory is located in that 
directory.

Launching the MWTM Event Editor
To launch the MWTM Event Editor, choose Start > Programs > Cisco MWTM Client > 
Launch MWTM Event Editor from the Windows Start menu. The MWTM launches the MWTM Event 
Editor.

Launching the MWTM SSL Certificate Tool
To launch the MWTM SSL Certificate Tool from the Windows Start menu, choose Start > Programs > 
Cisco MWTM Client > MWTM SSL Certificate Tool.

Displaying the MWTM README File
The MWTM README file contains late-breaking information about the MWTM that might not be 
found in the other product documentation. To open the MWTM README file from the Windows Start 
menu, choose Start > Programs > Cisco MWTM Client > Readme.

Uninstalling the MWTM
You can uninstall the MWTM from the Windows Start menu. For details, see the “Uninstalling the 
MWTM Client” section of the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0.

Exiting the MWTM Client
When you are finished monitoring network performance statistics, you can exit the MWTM client:

Step 1 From the MWTM main menu, choose File > Exit. The Exit MWTM confirmation window appears.

Step 2 Click Yes to close the MWTM client application.



C H A P T E R
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Basic Operations

This chapter provides information about basic operations that you can perform in the Cisco Mobile 
Wireless Transport Manager (MWTM), and contains:

• Changing Client and Web Preference Settings, page 5-1

• Viewing Online Help, page 5-21

• Finding Information in a Window, page 5-22

• Navigating Table Columns, page 5-23

• Printing Windows, page 5-24

• Managing and Deploying ITP Files, page 5-25

• Exporting Data, page 5-38

• Integrating the MWTM with Other Products, page 5-39

• Running Simultaneous Client Sessions, page 5-41

• Performing Basic Server Operations, page 5-41

• Using the Command Line Interface, page 5-45

Note The default directory for installing the MWTM is /opt. In commands that call for the default directory, 
if you installed the MWTM in a different directory, you must specify that directory instead of /opt.

Changing Client and Web Preference Settings
This section contains this information:

• Changing Client Preference Settings, page 5-2

• Changing Web Preference Settings, page 5-19

• Changing Real-Time Poller and Counter Settings, page 5-20
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Changing Client Preference Settings
When a user changes some aspect of the MWTM client, such as the size of a window, or the order of 
columns in a window, the MWTM makes note of the user’s preferences on the MWTM client and server. 
The MWTM saves the user’s preferences to the MWTM server when the MWTM client exits.

Thereafter, whenever the user launches the MWTM client, the MWTM searches for the user’s 
preferences. If the MWTM finds the user’s preferences on the MWTM server, the MWTM launches the 
MWTM client with those preferences. Otherwise, the MWTM launches the MWTM client with the 
default preferences file.

In addition to the user preferences that the MWTM automatically saves, you use the MWTM to change 
many GUI, data, topology, and table settings that affect the way the MWTM presents its information.

Note Anyone who uses the MWTM client can change its preference settings, and the changes affect all views 
running on this client.

To change overall MWTM preference settings, choose Edit > Preferences from the MWTM main menu. 
The MWTM displays the Preferences window.

Figure 5-1 Preferences Window (Client)
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In the Preferences window, you can:

• Displaying the Preferences Menu, page 5-3

• Changing General GUI Settings, page 5-4

• Changing Topology Settings, page 5-8

• Changing Event Settings, page 5-9

• Changing Charts Settings, page 5-13

• Changing Status Settings, page 5-14

• Changing Deploy Settings, page 5-15

• Customizing Colors, page 5-17

• Restoring Default Preference Settings, page 5-19

Displaying the Preferences Menu

The menu on the Preferences window contains:

Option Description

File > Load System 
Default Prefs

Restores all preference settings to the original system default settings.

File > Save
(Ctrl-S)

Saves the preference changes.

File > Close
(Ctrl-W)

Closes the Preferences window.

To close the Preferences window at any time, choose File > Close. If you have 
changed any preferences, the MWTM asks if you want to apply the changes 
before leaving the window:

• Click Yes to apply the changes and close the prompt window and the 
Preferences window.

• Click No to close the prompt window and the Preferences window without 
applying or saving any changes.

• Click Cancel to close the prompt window without applying any changes. 
The Preferences window remains open.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information about the 
MWTM application.
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Changing General GUI Settings

You use the General GUI settings in the Preferences window to change general display settings for the 
MWTM, including which window to display first when starting the MWTM, and whether to display 
values in bits or bytes.

To display the General GUI settings, choose General GUI in the left pane of the Preferences window.

In the General GUI area you can change:

• Startup/Exit Settings, page 5-4

• General Display Settings, page 5-4

• Node Name Settings, page 5-5

• Poller Settings, page 5-6

• Troubleshooting, page 5-6

• Connection Settings, page 5-7

• Repaint Priority, page 5-7

Startup/Exit Settings

Use the Startup/Exit Settings pane of the General GUI settings to specify whether you want to display 
the topology window when you launch the MWTM client, and whether you want the MWTM to prompt 
you for confirmation when you exit the MWTM client.

The Startup/Exit Settings pane contains:

General Display Settings

Use the General Display pane of the General GUI settings to specify whether the MWTM should:

• Display node domain names.

• Show details in bits instead of bytes.

• Show receive and send utilizations as percentages.

• Show the point code mask in bits instead of dotted notation.

Check Box Description

MWTM: Topology Window If checked, causes the topology window to appear when you start the 
MWTM. The default setting for this check box is unchecked.

Confirm Exit If checked, the MWTM prompts you for confirmation when you exit 
the MWTM client. The default setting for this check box is checked.

Confirm Deletes If checked, the MWTM prompts you for confirmation when you 
delete an object. The default setting for this check box is checked.

Note If you check the Do not show this again check box in a 
Confirm Deletion dialog box, and you later decide that you do 
want the MWTM to display the Confirm Deletion dialog box, 
you must check the Confirm Deletions check box.

Confirm In Band Polls If checked, the MWTM prompts you for confirmation when you 
access a function that requires the MWTM to perform in-band polling 
of the object. 
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The General Display pane contains:

Node Name Settings

Use the Node Name pane of the General GUI settings to specify how the MWTM should display node 
names.

The Node Name pane contains these radio buttons:

Check Box Description

Show Node Domain Names If checked, the MWTM shows node domain names in its displays. 
The default setting for this check box is unchecked (do not show 
node domain names).

Show Details in Bits Instead of 
Bytes

If checked, the MWTM displays data and data rates in bits instead 
of bytes:

• Check if you want the MWTM to display data in bits, and data 
rates in bits per second. This is the default setting.

• Uncheck if you want the MWTM to display data in bytes, and 
data rates in bytes per second.

Show Utilization as Percentage If checked, the MWTM displays receive and send utilization for 
linksets and links as a percentage:

• Check if you want the MWTM to display utilization as a 
percentage. This is the default setting.

• Uncheck if you want the MWTM to display utilization in 
Erlangs.

Show Point Code Mask in Bits 
(ITP only)

If checked, the MWTM displays point code masks as a number of 
bits instead of dotted-decimal format. The MWTM applies this 
setting to all point code masks in the MWTM client, including 
those in the Route Table dialog box, in messages, and so on.

• Uncheck if you want the MWTM to display point code masks 
in dotted-decimal format (octets separated by periods). This is 
the default setting.

• Check if you want the MWTM to display point code masks as 
a number of bits.

For more information about point code masks, see Route Table, 
page 13-8.

Radio Buttons Description

Show DNS or User Defined 
Names

Indicates whether the MWTM should identify nodes by their DNS or 
user-defined names. The default setting for this radio button is 
clicked.

Show IP Address in Name 
Field

Radio button used to indicate whether the MWTM should identify 
nodes by their IP addresses. The default setting for this radio button is 
unclicked.
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Poller Settings

Use the Poller pane of the General GUI settings to change the MWTM poller and counter settings.

The Poller pane contains:

Troubleshooting

Use the Troubleshooting pane of the General GUI settings to specify whether the MWTM clears the 
display window upon command execution.

The Troubleshooting pane contains:

Field or Radio Button Description

Fast Poller Default (secs) Default interval, in seconds, for the fast poller. The valid range is 
5  to 60 seconds. The default setting is 15 seconds.

The fast poller appears in these MWTM client windows:

• MWTM Real-Time Statistics: CPU Statistics window

• (ITP only) Details window for an Application Server

• (ITP only) Details window for a Linkset

• (ITP only) Details window for a Signaling Gateway Mated 
Pair

You can change the valid range and default setting in the 
Server.properties file. For more information, see Changing 
MWTM Server Poller Settings, page 3-2.

Slow Poller Default (secs) Default interval, in seconds, for the slow poller. The valid range 
is 60 seconds to 300 seconds. The default setting is 60 seconds.

The slow poller is used in all the MWTM client windows except 
those listed previously that use the fast poller.

Note You can change the valid range and default setting in the 
Server.properties file. For more information, see 
Changing MWTM Server Poller Settings, page 3-2.

Show Counters Since Reboot Radio button used to configure the MWTM client to clear all 
counters in MWTM web pages whenever the node reboots. The 
default setting for this radio button is clicked.

Show Counters Since Last Poll Radio button used to configure the MWTM client to clear all 
counters whenever an MWTM web page is polled. The default 
setting for this radio button is unclicked.

Show Counters Since User Reset Radio button used to configure the MWTM client to clear all 
MWTM counters whenever the user resets the counters on an 
MWTM web page. The default setting for this radio button is 
unclicked.

Field Description

Clear Display upon Execution Clears the output display each time you execute a command.
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Connection Settings

Use the Connection Settings pane of the General GUI settings to set the Telnet or SSH path and 
arguments for accessing nodes using one of these methods.

Note To connect to a node using SSH, the key size on the node must be configured to a minimum of 768 bits 
and a maximum of 2048 bits.

The Connection Settings pane contains:

Repaint Priority

Use the Repaint Priority pane of the General GUI settings to balance the responsiveness versus efficiency 
of the MWTM client. This setting controls how quickly the MWTM client repaints its displays.

The Repaint Priority pane contains a sliding control:

Field Description

Telnet path Use to modify the default MWTM Telnet path. Click Find to choose a Telnet path 
on your local machine. For example, to launch Telnet from UNIX you may 
choose xterm, then in the Telnet arguments field, specify -e telnet.

Note Choosing a non-GUI file might not yield the expected results.

Telnet arguments Optional arguments that the MWTM passes to the Telnet executable when the 
MWTM invokes it.

SSH path Use to modify the default MWTM SSH path. Click Find to choose an SSH path 
on your local machine.

Note Choosing a non-GUI file may not yield the expected results.

SSH arguments Optional arguments that the MWTM passes to the SSH executable when the 
MWTM invokes it.

Field Description

Repaint Priority Balances the MWTM client’s responsiveness versus efficiency. The valid range is 
0 through 10, with 0 representing a high repaint priority (high responsiveness, low 
efficiency) and 10 representing a high communication priority (high efficiency, 
low responsiveness):

• To maximize repainting (responsiveness) over communication (efficiency), 
slide the selector toward High Repaint Priority.

• To maximize communication (efficiency) over repainting (responsiveness), 
slide the selector toward High Comm. Priority.

• The default setting is 2 (the third mark from the left).
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Changing Topology Settings

Use the Topology pane in the Preferences window to change default settings for the topology window. 

To display the topology settings, select Topology in the left pane of the Preferences window.

The Topology pane contains:

Check Box or Field Description

Spring Layout Spacing 
Factor (1-10)

Indicates how far to space nodes when the MWTM draws the Spring 
Layout topology map. Valid values are 1 through 10, with 1 being closer 
together and 10 being farther apart. The default spacing factor is 5.

Even if you apply preferences and close the Preferences window, the 
topology map does not show the new spacing factor until you choose 
Topology Tools > Layout > Spring, or click the Spring Layout button.

Show Mouse Overs Specifies whether tooltips are enabled in topology maps. Checked is the 
default.

Draw Connections When 
Dragging a Node

Specifies whether the MWTM draws connection lines in the topology 
map as you move nodes:

• Check if you want the MWTM to draw the associated connection 
lines dynamically as you move a node.

• Uncheck if you do not want the MWTM to draw the associated 
connection lines until after you have finished moving a node. 
Unchecked is the default.

Show Small SS7 Icons (ITP 
only)

Specifies the size of the SS7 icons in the topology map:

• Uncheck if you want the MWTM to display large SS7 icons. 
Unchecked is the default.

• Check if you want the MWTM to display small SS7 icons. This 
setting can save space in the topology map, making it easier to read.

Show Non-ITP Nodes (ITP 
only)

Specifies whether the MWTM should display non-ITP nodes and 
linksets in the topology map:

• Check if you want the MWTM to display non-ITP nodes and 
linksets in the topology map. Checked is the default.

• Uncheck if you want the MWTM to hide non-ITP nodes and linksets 
in the topology map. (The navigation tree still shows the hidden 
signaling points and linksets.)
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Changing Event Settings

Use the Event settings in the Preferences window to:

• Change the default background color for each type of event

• Specify whether to display acknowledged events

• Specify the types of event the MWTM should display in the Event tables, including the:

– Category and severity of event

– Whether the event is acknowledged

– Other properties

To display the Event settings, select Events in the left pane of the Preferences window.

In the Event area you can change:

• Event Colors, page 5-10

• Categories, page 5-11

• Severities, page 5-12

• Other, page 5-12

Show Point Code and Node 
Name (ITP only)

Specifies whether the MWTM should display point codes as well as 
node names in the topology map:

• Uncheck if you want the MWTM to display point codes but not node 
names. Unchecked is the default.

• Check if you want the MWTM to display both point codes and node 
names.

X Performance Enhancer 
(AntiAliasing Off)

Specifies whether antialiasing is turned on in the topology map. 
Antialiasing, which is on by default, improves the appearance of the 
icons and connections in the map.

However, antialiasing can impact the performance of the MWTM client 
on a remote workstation (that is, a Solaris or Linux workstation by using 
xhost, or a Windows workstation using an X-Window system emulator 
such as eXceed or Reflection X).

• Uncheck if you want to turn on antialiasing in the topology map. 
Unchecked is the default.

• Check if you want to turn off antialiasing.

Remember that performance is always better if you access the MWTM 
by installing the MWTM client on the remote workstation.

Check Box or Field Description
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Event Colors

The Event Colors pane:

Event Time Format

The Event Time Format pane contains:

Event Date Format

The Event Date Format pane contains:

Field Description

Change Color Opens the Select Event Color dialog box from which you select a color for an event 
type. For more details, see Customizing Colors, page 5-17.

Informational Indicates the background color for Informational events. The default is white.

Normal Indicates the background color for Normal events. The default is light green.

Indeterminate Indicates the background color for Indeterminate events. The default is cyan.

Warning Indicates the background color for Warning events. The default is blue.

Critical Indicates the background color for Critical events. The default is red.

Major Indicates the background color for Major events. The default is orange.

Minor Indicates the background color for Minor events. The default is yellow.

Button Description

12 Hour Click this radio button to configure event time stamps to use 12-hour format (for example, 
07:10:09).

24 Hour Click this radio button to configure event time stamps to use 24-hour format (for example, 
19:10:09).

Button Description

Month-First Click this radio button to configure event date stamps with the month appearing first 
(for example, 8/16/05).

Day-First Click this radio button to configure event date stamps with the day appearing first (for 
example, 16/8/05).
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Categories

In the Categories pane, you specify which event categories to display in the Event window.

The Categories pane contains:

Note The fields in the previous table are default categories; however, the MWTM system administrator might 
define additional categories. For information about custom categories, see Changing Event Categories, 
page 9-33.

Field or 
Button Description

Status Indicates whether Status events should appear in the Event window. The default is 
checked.

Trap Indicates whether Trap events should appear in the Event window. The default is 
checked.

Create Indicates whether Create events should appear in the Event window. The default is 
checked.

Delete Indicates whether Delete events should appear in the Event window. The default is 
checked.

Discover Indicates whether Discover events should appear in the Event window. The default is 
checked.

Edit Indicates whether Edit events should appear in the Event window. The default is 
checked.

Ignore Indicates whether Ignore events should appear in the Event window. The default is 
checked.

Login Indicates whether Login events should appear in the Event window. The default is 
checked.

LoginDisable Indicates whether LoginDisable events should appear in the Event window. The default 
is checked.

LoginFail Indicates whether LoginFail events should appear in the Event window. The default is 
checked.

Logout Indicates whether Logout events should appear in the Event window. The default is 
checked.

OverWrite Indicates whether OverWrite events should appear in the Event window. The default is 
checked.

Poll Indicates whether Poll events should appear in the Event window. The default is 
checked.

Purge Indicates whether Purge events should appear in the Event window. The default is 
checked.

Select All Checks all event category check boxes.

Deselect All Unchecks all event category check boxes.
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Severities

In the Severities pane, you specify which event severities to display in the Event window.

The Severities pane contains these default fields:

Note The fields in the previous table are default severities; however the MWTM system administrator might 
define additional severities. For information about custom severities, see Changing Event Severities and 
Colors, page 9-35.

Other

Use the Other pane to further define the event filter for the Event window. These settings apply to all 
event displays in the current view.

The Other pane contains:

Field Description

Informational Indicates whether events of severity Informational should appear in the Event 
window. The default is checked.

Normal Indicates whether events of severity Normal should appear in the Event window. The 
default is checked.

Indeterminate Indicates whether events of severity Indeterminate should appear in the Event 
window. The default is checked.

Warning Indicates whether events of severity Warning should appear in the Event window. The 
default is checked.

Critical Indicates whether events of severity Critical should appear in the Event window. The 
default is checked.

Major Indicates whether events of severity Major should appear in the Event window. The 
default is checked.

Minor Indicates whether events of severity Minor should appear in the Event window. The 
default is checked.

Check Box or Field Description

Acknowledged Indicates whether only acknowledged events should appear in the Event 
window. The default is checked.

Unacknowledged Indicates whether only unacknowledged events should appear in the Event 
window. The default is checked.

Time Before Indicates whether only events that the MWTM logs prior to a specified date and 
time should appear in the Event window. The default is checked.

Time Before Field Specifies the date and time prior to which events that the MWTM logs should 
appear in the Event window. This field is dimmed unless the Time Before check 
box is checked.

Time After Indicates whether only events that the MWTM logs after a specified date and 
time should appear in the Event window. The default is checked.
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Changing Charts Settings

Use the Charts pane in the Preferences window to change default settings for the elements in real-time 
data charts for application servers, application server process associations, links, and linksets.

To display the Charts pane, click Charts in the left pane of the Preferences window.

The Charts pane contains:

Time After Field Specifies the date and time after which events that the MWTM logs should 
appear in the Event window. This field is dimmed unless the Time After check 
box is checked.

Message Contains Indicates whether only events that contain the specified message text should 
appear in the Event window. The default is checked.

Match Case Indicates whether only events that match the case of the text in the Message 
Contains field should appear in the Event window. This field is dimmed unless 
the Message Contains check box is checked. If the Message Contains check box 
is checked, the default setting for this check box is checked.

Suppress Events for 
unmanaged nodes

Suppresses all events from nodes that are unmanaged. The default setting for 
this check box is unchecked.

Check Box or Field Description

Field or Button Description

Series Indicates the time series being defined. A time series is a set of data collected 
sequentially at a fixed interval of time.

The default values for series are:

• Series 0: Dot, Solid, Red

• Series 1: Box, Solid, Green

• Series 2: Triangle, Solid, Blue

• Series 3: Diamond, Solid, Black

• Series 4: Star, Solid, Pink

• Series 5: Cross, Solid, Orange

• Series 6: Circle, Solid, Gray

• Series 7: Square, Solid, Light Green

• Series 8: Vertical Line, Solid, Red

• Series 9: Horizontal Line, Solid, Green

• Series 10: Dot, Solid, Blue

• Series 11: Box, Solid, Black

• Series 12: Triangle, Solid, Pink

• Series 13: Diamond, Solid, Orange

• Series 14: Star, Solid, Gray

• Series 15: Cross, Solid, Light Green

• Series 16: Circle, Solid, Red
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Changing Status Settings

You use the MWTM to customize the sort order for status settings, as well as the color of each status 
setting.

When you change the sort order or the color of a status setting, most MWTM client windows reflect the 
new sort order or color immediately. All other windows reflect the new sort order or color at the next 
poll.

When you change the color of a status, most MWTM client windows reflect the new color immediately. 
All other windows reflect the new color at the next poll.

To display the Status settings, click Status in the left pane of the Preferences window.

The Status pane contains:

Symbol Style Drop-down list box used to define the symbol associated with a series. To change the 
symbol for a series, select a new value: Dot, Box, Triangle, Diamond, Star, Vertical 
Bar, Horizontal Line, Cross, or Circle.

Line Style Drop-down list box that you use to define the style of line that connects data points in 
the chart. To change the line style for a series, select a new value: Solid, Long Dash, 
Long-Short-Long (LSL) Dash, Short Dash, Dash Dot, or None.

Color Indicates the current color for the series.

Change Color Opens the Select Series Color dialog box in which you select a color for a series. For 
more details, see Customizing Colors, page 5-17.

Field or Button Description

Field or Button Description

Status Sort Order Indicates the status setting being defined. The default status sort order and colors 
are:

• None: Black

• Unknown: Red

• Unavailable: Red

• Inactive: Red

• Failed: Red

• Down: Red

• Blocked: Red

• Pending: Red

• Warning: Yellow

• Shutdown: Blue

• Inhibited: Blue

• InhibitLoc: Blue

• InhibitRem: Blue
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Changing Deploy Settings

Note Deploy settings are only for ITP networks. If you configure the MWTM to manage ITP networks, the 
deploy settings will appear in the Preferences window. If you configure the MWTM to manage only 
RAN-O networks, deploy settings will not appear. You customize the MWTM to manage ITP or RAN-O 
networks (or both) during installation. You can also do this later by command (see mwtm manage, page 
B-31).

Use the Deploy settings to change the way the Deployment Wizard works.

To display the Deploy settings, select Deploy in the left pane of the Preferences window.

The Deploy settings contain:

Status Sort Order

(continued)

• Discovering: Cyan

• Polling: Cyan

• Waiting: Gray

• Unmanaged: Gray

• Active: Green

Move Up Moves the selected status setting up in the Status Sort Order list.

Change Color Opens the Select Status Color dialog box in which you select a color for a status. 
For more details, see Customizing Colors, page 5-17.

Move Down Moves the selected status setting down in the Status Sort Order list.

Reset Order Restores the status settings to the default sort order.

Reset Colors Restores the status settings to the default colors.

Field or Button Description

Check Box or Field Description

Turn On Term 
Monitor During 
File Activation

Indicates whether the MWTM should turn on the terminal monitor before 
activating a route table file or GTT file on the ITP, and turn it off after activation 
(whether or not the activation was successful).

If you turn on the terminal monitor during activation, detailed activation error 
messages appear in the connection log. These messages can be useful if activation 
fails. However, all node console logging messages also appear in the connection 
log, so you might see many nonactivation messages, too.

The default is checked.

Turn Off All Debug 
Output Before 
Turning On Term 
Monitor

Indicates whether debug messages should appear in the connection log. The 
default is checked.

If you check the Turn On Term Monitor During File Activation check box, all 
node console logging messages appear, including all debug messages that are 
currently enabled on the node.
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Turn Off All Debug 
Output Before 
Turning On Term 
Monitor

(continued)

You can then check the Turn Off All Debug Output Before Turning On Term 
Monitor check box to turn off all debug messages. This setting can reduce the 
number of nonactivation messages in the connection log. The default is checked.

Note The MWTM does not turn the debug messages back on after activation. 
Ensure that other users are not debugging on the node before checking 
this check box.

This check box is dimmed unless you check the Turn On Term Monitor During 
File Activation check box.

Synchronize Active 
and Standby 
Storage If Node Is 
Configured as 
Redundancy Mode

Cisco 7507, 7513, and 7600 series routers support redundancy, which requires 
synchronization of the active and all standby storage devices.

If you want the MWTM to use a node’s configured redundancy mode to determine 
whether the MWTM should replicate storage operations (such as creating files, 
uploading, deleting, and so on) among the active and all standby storage devices, 
click this radio button.

Note This radio button is mutually exclusive with the Synchronize Active and 
Standby Storage If Node Is Operating in Redundancy Mode and Do Not 
Synchronize Active and Standby Storage radio buttons.

Synchronize Active 
and Standby 
Storage If Node Is 
Operating in 
Redundancy Mode

If you want the MWTM to use a node’s operating redundancy mode to determine 
whether the MWTM should replicate storage operations (such as creating files, 
uploading, deleting, and so on) among the active and all standby storage devices, 
in the right pane click this radio button. The default is clicked.

Note This radio button is mutually exclusive with the Synchronize Active and 
Standby Storage If Node Is Configured as Redundancy Mode and Do Not 
Synchronize Active and Standby Storage radio buttons.

Do Not 
Synchronize Active 
and Standby 
Storage

If you want the MWTM to perform storage operations only on the active storage 
device (that is, no automatic synchronization of active and standby storage 
devices), click this radio button.

Clicking this radio button requires you to manually synchronize the active and 
standby storage devices.

This radio button is mutually exclusive with these radio buttons:

• Synchronize Active and Standby Storage If ITP Is Configured as 
Redundancy Mode 

• Synchronize Active and Standby Storage If ITP Is Operating in Redundancy 
Mode

Check Box or Field Description
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Customizing Colors

You use the MWTM to customize the colors for these settings:

Enable Auto 
Refresh Node 
Storage In Node 
File Management 
Dialog

Indicates whether the Node File Management dialog box should refresh storage 
device content automatically at user-defined intervals. Clicking this check box 
enables the Node File Management dialog box to detect any updates made to the 
file system.

In addition, you can configure the node to disconnect idle connection sessions. If 
you check this check box, the MWTM automatically generates node operations 
at the user-defined interval, which prevents disconnection of the session by the 
node.

The default is unchecked.

To enable the automatic refresh, check this check box, then specify a Refresh 
Interval. The valid range is 1 seconds to an unlimited number of seconds. The 
default interval is 60 seconds.

Always Overwrite 
Existing File In 
Deployment 
Wizard

Indicates whether the Deployment Wizard should overwrite an existing file with 
the same filename automatically, without prompting the user. The default is 
unchecked.

Always Skip 
Archive Comments

Indicates whether the Deployment Wizard should skip archive comments. The 
default is unchecked.

This check box appears only if deploy comments are set to optional. For details, 
see mwtm deploycomments, page B-82. If deploy comments are set to required, 
this check box does not appear.

Always Activate 
Deployed File In 
Deployment 
Wizard

Indicates whether the Deployment Wizard should activate the deployed file 
automatically, without prompting the user. The default is unchecked.

Command Timeout 
in Seconds

Indicates how long, in seconds, an MWTM client with a session to a node should 
wait for a response from the node before closing the session.

The valid range is 1 second to an unlimited number of seconds. The default is 
90 seconds.

Check Box or Field Description

Setting Menu Selection Color Dialog 

Event severity Click Events in the left pane of the Preferences window 
(Figure 5-1), then click Change Color in the Event Colors 
section.

Select Event Color

Series in 
real-time charts

Click Charts in the left pane of the Preferences window 
(Figure 5-1), then click Change Color in the Series Colors 
section.

Select Series Color

Status Click Status in the left pane of the Preferences window 
(Figure 5-1), select a status setting, then click Change Color. 

Select Status Color 
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The Select Color dialog box contains:

• Swatches Tab (Recommended), page 5-18

• HSB Tab, page 5-18

• RGB Tab, page 5-18

• Select Color Field and Buttons, page 5-19

Related Topics:

• Changing Event Settings, page 5-9

• Changing Charts Settings, page 5-13

• Changing Status Settings, page 5-14

Swatches Tab (Recommended)

You use the Swatches tab of the Select Color dialog box to select a color from a set of color swatches. 
This is the recommended method for selecting a color.

To display the Swatches tab, click the Swatches tab in the Select Color dialog box.

To select a color, select a swatch. The selected color appears in the Preview field. When you are satisfied 
with the color, click OK.

HSB Tab

You must also choose hue, saturation, and brightness (HSB) variables to select a color.

To display the HSB tab, click the HSB tab in the Select Color dialog box.

To select a color, you can either:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the (hue), S (saturation), and B (brightness) fields.

The selected color appears in the Preview field. When you are satisfied with the color, click OK.

RGB Tab

You then select the red, green, and blue (RGB) content of the color. 

To display the RGB tab, click the RGB tab in the Select Color dialog box.

To select a color, select values for the Red, Green, and Blue fields. The selected color appears in the 
Preview field. When you are satisfied with the color, click OK.
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Select Color Field and Buttons

The Select Color dialog box contains:

Restoring Default Preference Settings

If you decide you do not like your modified preference settings, you can use the MWTM to restore all 
preference settings to the original system default settings. To do so:

Step 1 Display the Preferences window, as described in Changing Client Preference Settings, page 5-2.

Step 2 Choose the File > Load System Default Prefs menu option. 

The MWTM restores the default settings.

Changing Web Preference Settings
The web preference settings are accessible by clicking the Preferences link in the title bar of any web 
interface window. Web preferences include only a small subset of the General GUI preferences that are 
available in the client interface (see Changing General GUI Settings, page 5-4).

To change web preferences settings:

Step 1 Click Preferences in the title bar of any MWTM web page.

Step 2 Click the General GUI tab in the Preferences window to display the general GUI settings.

Step 3 Change the setting you want to modify. If you enter a new value in a text field, press Enter or Tab to 
activate the change.

Note For any user, common preferences between the web and client interfaces are shared. However, if the web 
and client interfaces are active at the same time, and you exit the client, any changes you made to the 
web preferences are overwritten by the client preferences.

You can now exit the web preferences window.

Field or Button Description

Preview Displays a preview of the current selected color.

Whichever method you choose to select a color, the selected color appears in the 
Preview field. When you are satisfied with the color, click OK.

OK Sets the color as shown in the Preview field, and closes the Color dialog box.

Cancel Closes the Color dialog box without selecting a color.

Reset Resets the color to its initial setting.
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The Web Preferences window contains:

Changing Real-Time Poller and Counter Settings
The MWTM provides three pollers for use in the MWTM client GUI and web pages: a fast, a slow, and 
a status refresh. You use the MWTM to change settings for those pollers, and also to specify how you 
want to aggregate the visible counter values.

To change the MWTM poller refresh and counter display settings, use one of these methods:

• The Server.properties file specifies minimum, maximum, and default settings for the fast, slow, and 
status refresh pollers. To change those settings, see Changing MWTM Server Poller Settings, page 
3-2.

• To change the MWTM poller refresh and counter display settings for the GUI in the MWTM 
Preferences window, see Poller Settings, page 5-6.

• To change the MWTM poller refresh and counter display settings for the MWTM web pages by 
using the MWTM Web Preferences web page, see Link Reports, page 12-21.

• To change the MWTM counter display settings for the GUI from any Real-Time Data and Charts 
window in the GUI, click Reset Counters in any of these MWTM windows:

– Poll Settings dialog box in any network object’s MWTM Details window

– Node Details: MTP3 Errors table

– Signaling Point Details: GTT MAP Status table

– Signaling Point Details: GTT Statistics table

– Signaling Point Details: MLR Details table

Check Box, Radio Button, or Field Description

Show DNS or User-Defined 
Names

Indicates whether the MWTM should identify nodes by their DNS 
or user-defined names. The default setting for this radio button is 
clicked.

Show IP Address in Name Field Indicates whether the MWTM should identify nodes by their IP 
addresses. The default setting for this radio button is unclicked.

Show Node Domain Names If checked, the MWTM shows node domain names in its displays. 
The default setting for this check box is unchecked (do not show 
node domain names).

Clear Display upon Execution Clears the output display each time you execute a command.

Slow Poller Interval (secs) Default interval, in seconds, for the slow poller. The valid range is 
60 seconds to 300 seconds. The default setting is 60 seconds.

Note You can change the valid range and default setting in the 
Server.properties file. For more information, see Changing 
MWTM Server Poller Settings, page 3-2.

Status Refresh Interval (secs) Specifies the default setting for how frequently the MWTM 
refreshes the web pages on the web interface.

The valid range is 180 seconds to 900 seconds. The default setting 
is 180 seconds. (You can change the valid range and default setting 
in the Server.properties file. For more information, see Changing 
MWTM Server Poller Settings, page 3-2.)
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The MWTM displays the MWTM Reset Counters dialog box.

Figure 5-2 MWTM Reset Counters Dialog

The MWTM Reset Counters dialog box contains:

Viewing Online Help
The MWTM provides these online help options in the MWTM main menu. To display:

• The table of contents for the MWTM online help in a web browser, choose Help > Topics.

• Online help for the current window in a web browser, choose Help > Window.

• Build date, version, SSL support, and copyright information about the MWTM application in a web 
browser, choose Help > About.

Related Topics:

Viewing the MWTM Technical Documentation, page 11-9

Field or Button Description

Show Counters 
Since Reboot

Click to configure the MWTM client to clear all counters in MWTM web pages 
whenever the node reboots. The default is clicked.

Show Counters 
Since Last Poll

Click to configure the MWTM client to clear all counters whenever an MWTM 
web page is polled. The default is unclicked.

Show Counters 
Since User Reset

Click to configure the MWTM client to clear all MWTM counters whenever the 
user resets the counters on an MWTM web page. The default setting for this radio 
button is cleared.

Apply Applies any changes you made to the counter settings, reflects the changes 
throughout the MWTM GUI, and closes the MWTM Reset Counters dialog box.

Cancel Closes the MWTM Reset Counters dialog box.

Help Displays online help for the current window.
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Finding Information in a Window
Sometimes, finding information, such as a node name or event text, in a long list can be difficult. You 
can use the MWTM client to search for a specific character string in windows that contain lots of 
information.

Note To find a specific object in the topology window, see Finding an Object, page 10-17.

To find a character string, choose Edit > Find from the MWTM main menu. This menu option is 
available when you select from the navigation tree:

• Alarms

• Events

• Any object under Summary Lists

The MWTM displays the Find dialog box.

Figure 5-3 Find Dialog Box

Note The Find dialog box also appears when you choose File > Find from the Route Table Editor dialog box 
(Chapter 13, “Editing an ITP Route Table File”).

The Find dialog box contains:

Field or Button Description

What Character string for which the MWTM should search in the window. This can be 
any character string: all or part of a node name, event text, status, and so on.

Match Case Check box used to indicate whether the MWTM should search for only character 
strings that match the case of the text in the What field. To search with:

• Case-matching on, select this check box.

• Case-matching off, clear this check box. This is the default setting.

Search Forward Indicates whether the MWTM should search forward (down and to the right) in 
the window. This radio button is mutually exclusive with the Search Backward 
button. The default is checked.

Search Backward Indicates whether the MWTM should search backward (up and to the left) in the 
window. This radio button is mutually exclusive with the Search Forward button. 
The default is unchecked.
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Navigating Table Columns
You can resize, sort, or hide the columns in some tables in the MWTM client interface to meet your 
specific needs. The MWTM client automatically saves your new settings and, thereafter, launches the 
client with the new settings. 

Note Resizing and hiding table columns is possible only in the client interface. In the web interface, you can 
search for specific information and page through long tables by using its search and paging features (see 
MWTM Web Interface Content Area, page 11-4).

• To view a tooltip for each column in the table, place the cursor over a column heading. If a cell is 
too small to show all of its text, place the cursor over the cell to see the full text of the tooltip.

• To make a column wider or narrower, click the column divider in the heading and move the divider 
to the right or left while holding down the left or right mouse button.

All Components or Recent Events tables in the MWTM main window reflect changes that you make 
to any object's Components or Recent events table. The Show in New window or Real-Time Data 
and Charts windows do not reflect the changes, however.

Depending on your system, as well as other factors, MWTM windows can sometimes appear so 
small that text is illegible, and columns and text entry fields too narrow to be usable. If this happens, 
resize the window and widen the individual columns until the information is again legible and the 
columns and text entry fields are usable.

• By default, the MWTM displays most of the columns in tables, but some columns may be hidden. 
To:

– Display hidden columns, right-click in the table heading and select the check boxes for the 
columns you want to display.

– Hide columns, right-click in the table heading and clear the check boxes for the columns you 
want to hide.

All Components or Recent Events tables in the MWTM main window reflect changes that you make 
to any object's Components or Recent events table. The Show in New window or Real-Time Data 
and Charts windows do not reflect the changes, however.

Find Launches the search. If:

• It finds a matching character string in the window, the MWTM highlights the 
first line that contains the string.

To find the next occurrence of the string, click Find again.

You can continue to click Find until you find no more matches in the window. 
At that time, the MWTM displays an appropriate message in the dialog box, 
such as:

Bottom of table reached.

• No matching character string is found, the MWTM displays an appropriate 
message in the dialog box.

Close Closes the Find dialog box when you finish searching.

Field or Button Description
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• To sort a table based on the data in a column, left-click in the column heading. The MWTM 
alphanumerically sorts the table from top to bottom, based on the data in the selected column. To 
sort the table in reverse order, left-click in the column heading a second time. If two entries in the 
selected column are identical, the MWTM sorts those rows based on the data in the remaining table 
columns, moving left to right.

• Many of the tables in the web interface display an icon in the column heading to indicate the column 
on which the table is sorted, and the direction of the sort. The icon displays a noninverted triangle 
if the sort order is ascending (1-9, A-Z), and an inverted triangle if the sort order is descending (Z-A, 
9-1).

• If you sort a table in the web interface based on the Nodes column, the MWTM sorts the table based 
on the DNS names of the nodes, as the MWTM discovers nodes. However, if you modified your 
preferences to identify nodes by their user-defined names, then the MWTM sorts the table based on 
the user-defined names of the nodes. For more information, see Node Name Settings, page 5-5.

• To customize the sort order for status settings in the Status column of tables, use the Status settings 
section of the Preferences window. For more information, see Changing Status Settings, page 5-14.

• (ITP only) To sort a route table, click Sort Table. The MWTM sorts the entries in the route table 
field-by-field, beginning with Dest. Point Code, then Mask, Cost, Dest.Linkset, and finally QoS.

Printing Windows
You can print most MWTM windows, as well as the topology map, for those times when you need 
hardcopy.

To print an MWTM window, choose File > Print from most MWTM windows (for example, the MWTM 
main window or topology window).

The MWTM displays the Print dialog box.

Figure 5-4 Print Dialog
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You use the Print dialog box to specify print settings, such as which printer to print to, whether to send 
output to a file (the default location for the print file is your home directory), and whether to print duplex.

Note You can send output to a file only in the file formats that your printer drivers support. Sending output to 
files can result in large file sizes that you will need to monitor and manage.

When you are satisfied with your print settings, click Print. The MWTM prints the window or map.

To exit the Print dialog box at any time without printing, click Cancel.

Managing and Deploying ITP Files
You use the MWTM to manage GTT files, route table files, and MLR address table files. The MWTM 
provides a Node File Management dialog box and a Node Archive Management dialog box:

• Node File Management, page 5-25

• Node Archive Management, page 5-32

• Deploying ITP Files, page 5-35

Node File Management
You use the Node File Management dialog box to:

• View:

– GTT files

– Route table files

– MLR address table files

• Check these files for semantics and syntax

• Delete, rename, and upload the files to a remote node

• Activate the files 

The Node File Management dialog box can handle GTT and route table files up to 512 KB in size (the 
maximum size supported by the MWTM and ITP) and up to 100,000 MLR address table entries.

To launch the Node File Management dialog box, choose Network > Node File Management from the 
MWTM main menu. The MWTM displays the Node File Management dialog box.

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Administrator (level 4) and higher.
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Figure 5-5 Node File Management Dialog

The Node File Management dialog box contains:

• Node File Management Menu, page 5-26

• Node File Management MWTM Pane, page 5-29

• Node File Management Node Pane, page 5-30

Node File Management Menu

The menu on the Node File Management dialog box contains:

Command Description

File > Connect
(Ctrl-N)

Opens the Pick Node dialog box in which you select a node and connect 
to that remote node.

Note The remote node might be configured to disconnect idle 
sessions. To prevent disconnection of sessions by the node, 
enable the MWTM to refresh storage device content 
automatically by selecting the Enable Auto Refresh Node 
Storage In Node File Management Dialog check box in the 
Deploy settings section of the Preferences window, then specify 
a Refresh Interval. For more information, see Changing Deploy 
Settings, page 5-15.

To avoid entering username and password information each 
time, you can set up credentials (see Configuring Login 
Credentials, page 3-19).

File > Disconnect
(Ctrl-D)

Disconnects from the node.

This option is dimmed if you are not connected to a remote node.

File > Close
(Ctrl-W)

Closes the Node File Management dialog box.
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Local > Open File Opens the selected route table file in the Route Table dialog box 
(Figure 13-4) or the GTT file in the GTT Editor window (Figure 14-1) 
or the MLR address table file in the Address Table Editor (Figure 15-1).

Local > Check File Checks the semantics and syntax of the selected file on the MWTM 
client.

Local > Cut Cuts the selected local file from the MWTM client.

Local > Copy Copies the selected local file from the MWTM client.

Local > Paste Pastes a cut or copied local file into the MWTM client.

Local > Delete Deletes the selected file from the MWTM client.

Note If you try to delete a file, and you do not have permission to 
delete the file, the MWTM issues an appropriate error message.

Local > Rename Renames the selected file on the MWTM client.

You can use any letters, numbers, or characters in the new name that 
your operating system allows. However, if you include any spaces in the 
new name, the MWTM converts those spaces to dashes. For example, 
the MWTM saves file a b c as a-b-c.

Local > Refresh Refreshes the list of files in the MWTM pane.

If you have added or modified route table files, GTT files, or MLR files 
on the MWTM client since you launched the Node File Management 
dialog box, the MWTM pane reflects those changes.

Local > Go Up Displays the subdirectories and files that are in the directory that is up 
one level from the currently displayed directory on the MWTM client.

This option is dimmed if this is the highest directory level.

Local > Create Directory Creates a new subdirectory in the directory that the MWTM client 
currently is displaying.

Remote > Activate Activates the selected route table file, GTT file, or MLR file on the 
remote node. That is, the MWTM replaces the currently running route 
table file, GTT file, or MLR file on the remote node with the selected 
file.

Note You cannot activate the MWTM-LAST-ACTIVE-filename.rou, 
MWTM-LAST-ACTIVE_filename.gtt, 
MWTM-LAST-ACTIVE-filename.mlr,
or MWTM-LAST-ACTIVE-filename.sms files. These are backup 
files. If you need to revert to one of these files, copy it, rename 
it, and upload and activate the renamed file on the remote node.

This option is dimmed if you are not connected to a remote node.

Remote > Cut Cuts the selected remote file from the remote node.

Remote > Copy Copies the selected remote file from the remote node.

Remote > Paste Pastes a cut or copied remote file into the remote node.

Command Description
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Remote > Delete Deletes the selected file from the remote node.

If you try to delete a file, and you do not have permission to delete the 
file, the MWTM issues an appropriate error message.

Some Cisco routers support redundancy, which requires 
synchronization of the active and all standby storage devices. If you 
delete a file in the node pane from an active storage device, and you then 
try to undelete the file before the standby storage devices have been 
synchronized, the file will have different IDs on the active and standby 
storage devices. If this occurs, the MWTM issues this error message 
and cancels the undelete: 

Invalid ID

You must then undelete the file on the standby storage devices.

This synchronization problem does not occur in the MWTM pane.

This option is dimmed if you are not connected to a remote node.

Remote > Rename Renames the selected file on the remote node.

Note You can rename files on the remote node for only Class C 
devices on the disk drives.

You can use any letters, numbers, or characters in the new name that 
your operating system allows. However, if you include any spaces in the 
new name, the MWTM converts those spaces to dashes. For example, 
the MWTM saves file a b c as a-b-c.

This option is dimmed if you are not connected to a remote node.

Remote > Undelete Recovers the selected file on the remote node.

This option is dimmed if you are not connected to a remote node.

Remote > Refresh Refreshes the list of files in the node pane.

If route table files, GTT files, or MLR files have been added or modified 
on the remote node since you launched the Node File Management 
dialog box, those changes appear in the node pane.

This option is dimmed if you are not connected to a remote node.

Remote > Go Up Displays the subdirectories and files that are in the directory that is up 
one level from the directory that is currently visible on the remote node.

This option is dimmed if this is the highest directory level or if you are 
not connected to a remote node.

Remote > Create Directory Creates a new subdirectory in the directory that the remote node 
currently is displaying.

Note You can create folders on the remote node for only Class C 
devices on the disk drives.

This option is dimmed if you are not connected to a remote node.

Command Description
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Node File Management MWTM Pane

The MWTM pane on the left side of the Node File Management dialog box displays all of the files that 
the MWTM currently defines on the MWTM client. To populate the MWTM pane with all of the:

• Route table files currently defined on the MWTM client, select Route Tables from the drop-down 
list box.

• GTT files currently defined on the MWTM client, select GTT Files from the drop-down list box.

• MLR address table files currently defined on the MWTM client, select MLR Address Tables from 
the drop-down list box. 

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM sorts this table by Name, and displays all of the columns in the MWTM pane.

See Navigating Table Columns, page 5-23 for more information about resizing, sorting, displaying, or 
hiding columns.

The MWTM pane contains:

Remote > Squeeze Node Optimizes Flash memory on the remote node so that the space used by 
the files marked as deleted or error can be reclaimed. For more 
information, see the description of the squeeze command in the Cisco 
IOS Release 12.2 Configuration Fundamentals Command Reference.

Note After performing the squeeze process you cannot recover 
deleted files using Undelete.

This option is dimmed if you are not connected to a remote node.

Remote > Format Node Formats the Flash memory file system on the remote node. For more 
information, see the description of the format command in the Cisco 
IOS Release 12.2 Configuration Fundamentals Command Reference.

This option is dimmed if you are not connected to a remote node.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information 
about the MWTM application.

Command Description

Column Description

Type Indicates whether the selected name is a directory or a file.

Name Name of the route table, GTT, or MLR file.

Size Size of the file in bytes.

Modified Date and time the file was last modified.
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The MWTM pane provides these right-click menu options for files:

Node File Management Node Pane

The node pane on the right side of the Node File Management dialog box displays all of the files that the 
MWTM currently defines on the remote node. To populate the node pane with all of the:

• Route table files currently defined on the remote node, select Route Tables from the drop-down list 
box.

• GTT files currently defined on the remote node, select GTT Files from the drop-down list box.

• MLR address table files currently defined on the remote node, select MLR Address Tables from 
the drop-down list box. 

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM sorts this table by Name, and displays all of the columns in the node pane.

Command Description

Open File Opens the selected route table file in the Route Table dialog box (Figure 13-4) or 
the selected GTT file in the GTT Editor window (Figure 14-1) or the selected 
MLR address table file in the Address Table Editor window (Figure 15-1).

Check File Checks the semantics and syntax of the selected file on the MWTM client.

Cut Cuts the selected file from the MWTM client.

Copy Copies the selected file from the MWTM client.

Paste Pastes a cut or copied file into the MWTM client.

Delete Deletes the selected file from the MWTM client.

Note If you try to delete a file, and you do not have permission to delete the file, 
the MWTM issues an appropriate error message.

Rename Renames the selected file on the MWTM client.

You can use any letters, numbers, or characters in the new name that your 
operating system allows. However, if you include any spaces in the new name, the 
MWTM converts those spaces to dashes. For example, the MWTM saves file 
a b c as a-b-c.

Refresh Refreshes the list of files in the MWTM pane.

If you have added or modified route table, GTT, or MLR files on the MWTM client 
since you launched the Node File Management dialog box, the MWTM pane 
reflects those changes.

Go Up Displays the subdirectories and files that are in the directory that is up one level 
from the currently displayed directory on the MWTM client.

This option is dimmed if this is the highest directory level.

Create Directory Creates a new subdirectory in the currently displayed directory on the MWTM 
client.

Upload Uploads the selected file from the MWTM client to the remote node.

You can also upload a file by selecting it in the MWTM pane and clicking the 
arrow pointing to the node pane.

This option, and the arrow, is dimmed if you are not connected to a remote node.
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See Navigating Table Columns, page 5-23 for more information about resizing, sorting, displaying, or 
hiding columns.

The node pane contains:

The node pane provides these right-click menu options for files:

Column Description

Type Indicates whether the selected name is a directory or a file.

Name Name of the route table, GTT, or MLR file.

Size Size of the file in bytes.

Modified Date and time the file was last modified.

Right-click Option Description

Activate Activates the selected route table file, GTT file, or MLR file on the remote node. 
That is, the MWTM replaces the currently running route table file, GTT file, or 
MLR file on the remote node with the selected file.

Note You cannot activate the MWTM-LAST-ACTIVE-filename.rou, 
MWTM-LAST-ACTIVE_filename.gtt, MWTM-LAST-ACTIVE-filename.mlr, 
or MWTM-LAST-ACTIVE-filename.sms files. These are backup files. If 
you need to revert to one of these files, copy it, rename it, and upload and 
activate the renamed file on the remote node.

This option is dimmed if you are not connected to a remote node.

Cut Cuts the selected file from the remote node.

Copy Copies the selected file from the remote node.

Paste Pastes a cut or copied file into the remote node.

Delete Deletes the selected file from the remote node.

If you try to delete a file, and you do not have permission to delete the file, the 
MWTM issues an appropriate error message.

Some Cisco routers support redundancy, which requires synchronization of the 
active and all standby storage devices. If you delete a file in the node pane from an 
active storage device, and you then try to undelete the file before the standby 
storage devices have been synchronized, the file will have different IDs on the 
active and standby storage devices. If this occurs, the MWTM issues the following 
error message and cancels the undelete:

Invalid ID

You must then undelete the file on the standby storage devices.

This synchronization problem does not occur in the MWTM pane.
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Node Archive Management
You use the Archive Management dialog box to view the contents of the archive, open a version with its 
corresponding editor, and delete all versions of a file.

To launch the Archive Management dialog box, choose Edit > Node Archive Management from the 
MWTM main menu. The MWTM displays the Archive Management dialog box.

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Administrator (level 4) and higher.

Rename  Renames the selected file on the remote node.

Note You can rename files on the remote node for only Class C devices on the 
disk drives.

You can use any letters, numbers, or characters in the new name that your 
operating system allows. However, if you include any spaces in the new name, the 
MWTM converts those spaces to dashes. For example, the MWTM saves file a b 
c as a-b-c.

Undelete Recovers the selected file on the remote node.

Refresh Refreshes the list of files in the node pane.

If route table files, GTT files, or MLR files have been added or modified on the 
remote node since you launched the Node File Management dialog box, those 
changes appear in the node pane.

This option is dimmed if you are not connected to a remote ITP.

Go Up Displays the subdirectories and files that are in the directory that is up one level 
from the currently displayed directory on the remote node.

This option is dimmed if this is the highest directory level.

Create Directory Creates a new subdirectory in the currently displayed directory on the remote 
node.

Note You can create folders on the remote node for only Class C devices on the 
disk drives.

Squeeze Node Optimizes Flash memory on the remote node so that the space used by the files 
marked as deleted or error can be reclaimed. For more information, see the 
description of the squeeze command in the Cisco IOS Release 12.2 Configuration 
Fundamentals Command Reference.

Note After performing the squeeze process you cannot recover deleted files 
using Undelete.

Format Node Formats the Flash memory file system on the remote node. For more information, 
see the description of the format command in the Cisco IOS Release 12.2 
Configuration Fundamentals Command Reference.

Download Downloads the selected file from the remote node to the MWTM client.

You can also download a file by selecting it in the node pane and clicking the arrow 
pointing to the MWTM pane.
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Figure 5-6 Archive Management Dialog

The Archive Management dialog box contains:

• Node Archive Management Menu, page 5-33

• Node Archive Management Selector Pane, page 5-34

• Node Archive Management Display Pane, page 5-35

Node Archive Management Menu

The menu on the Archive Management dialog box contains:

Command Description

File > Open File Opens the selected route table file in the Route Table dialog box (Figure 13-4) or 
the selected GTT file in the GTT Editor window (Figure 14-1) or the selected MLR 
address table file in the Address Table Editor window (Figure 15-1).

File > Delete Deletes all versions of the selected file from the MWTM client. 

Note If you try to delete a file, and you do not have permission to delete the file, 
the MWTM issues an appropriate error message.

File > Refresh Updates data for the currently displayed entries.

File > Close
(Ctrl-W)

Closes the Archive Management dialog box.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information about the 
MWTM application.
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Node Archive Management Selector Pane

The selector pane on the left side of the Archive Management dialog box displays all of the files that the 
MWTM currently defines on the MWTM client. To populate the selector pane with all of the:

• Route table files currently defined on the MWTM client, select Route Tables from the drop-down 
list box.

• GTT files currently defined on the MWTM client, select GTT Files from the drop-down list box.

• MLR address table files currently defined on the MWTM client, select MLR Address Tables from 
the drop-down list box. 

To see the tooltip for each button in the selector pane, place the cursor over the button.

The selector pane contains:

The selector pane provides these right-click menu options for files:

Button or Object Description

Open File Opens the selected route table file in the Route Table dialog box (Figure 13-4) or 
the selected GTT file in the GTT Editor window (Figure 14-1) or the selected MLR 
address table file in the Address Table Editor window (Figure 15-1).

Delete Deletes all versions of the selected file from the MWTM client.

Note If you try to delete a file, and you do not have permission to delete the file, 
the MWTM issues an appropriate error message.

Refresh Updates data for the currently visible files.

Nodes To see the nodes, signaling points, and archived files associated with a specific 
node, select the turner beside the node or signaling point. Clicking on an archived 
file displays the file in the right pane.

Signaling Points To see the signaling points and archived files associated with a specific signaling 
point, select the turner beside the signaling point. Clicking on an archived file 
displays the file in the right pane.

Command Description

Open File Opens the selected route table file in the Route Table dialog box (Figure 13-4) or 
the selected GTT file in the GTT Editor window (Figure 14-1) or the selected MLR 
address table file in the Address Table Editor window (Figure 15-1).

Delete Deletes all versions of the selected file from the MWTM client.

Note If you try to delete a file, and you do not have permission to delete the file, 
the MWTM issues an appropriate error message.
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Node Archive Management Display Pane

The Archive Management pane displays all of the versions that currently exist on the selected file in a 
table. To navigate to a selected file, select the turner beside Nodes or Signaling Points in the selector 
pane (in the left pane), and click on the file. All versions appear in the right pane.

If a cell is too small to show all of its comments, place the cursor over the cell to see the full text in a 
tooltip.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM sorts this table by Rev and displays all of the columns in the display pane. 

See Navigating Table Columns, page 5-23 for more information about resizing, sorting, displaying, or 
hiding columns.

The display pane contains:

The display pane provides this right-click menu option for files:

Deploying ITP Files

Tip Before you can use the Deployment Wizard, you must set up TFTP (for details, see Setting Up TFTP on 
Your Server (ITP Only), page 3-11).

You use the Deployment Wizard to validate a route table file, GTT file, or MLR address table file, upload 
it to an ITP, archive the file, and activate it on the ITP. The Deployment Wizard can handle route table 
and GTT files up to 512 KB in size (the maximum size the MWTM and ITP support) and up to 100,000 
MLR address table entries.

To launch the Deployment Wizard, choose File > Deploy from the route table menu, GTT menu, or 
Address Table Editor menu. The MWTM displays the Deployment Wizard for the currently visible file.

Column or Button Description

Rev Revision number.

Date Date of archival.

Comments Archival comments.

Author User or client hostname or IP address from which the deployment or archiving 
occurred.

Adjust row height You can adjust the row height to make comments readable.

Command Description

Open File Opens the selected route table file in the Route Table dialog box (Figure 13-4) or 
the selected GTT file in the GTT Editor window (Figure 14-1) or the selected MLR 
address table file in the Address Table Editor window (Figure 15-1).
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Figure 5-7 Deployment Wizard for a GTT File

The left pane of the Deployment Wizard contains:

Step Description

Select File Indicates that the file is selected for deployment. The name of the file to deploy 
appears in the Deployment Wizard title bar.

Select Node/SP If you are deploying a GTT file or address table file, you use this option to select the 
signaling point to deploy the file. You can optionally check the Filter by Node check 
box, which limits signaling point selection to a specific node.

Select a signaling point and node (optional) from the drop-down list boxes in the 
right pane, then click Next >.

If you are deploying a route table file, the MWTM proceeds directly to the Validate 
step.

Validate Validates the file for deployment. Validation messages and error messages, if any, 
appear in the right pane.

Login You can log in to the signaling point. If required, enter the:

• Login username, if required.

• Login password, if required.

• Enable username, if required.

• Enable password, if required.

Note To avoid entering username and password information each time, you can set 
up credentials (see Configuring Login Credentials, page 3-19).
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The bottom line of the Deployment Wizard contains:

Upload Uploads the file to the signaling point.

If the file uploads with no errors, the MWTM proceeds to the Activate step.

If the specified file already exists on the ITP, the MWTM displays the name of the 
duplicate file and the Overwrite and Always Overwrite check boxes. Check the:

• Overwrite check box to overwrite the file on the ITP with the file being 
deployed. This is the default setting.

• Always Overwrite check box if you want the MWTM to always overwrite the 
file on the ITP with the file being deployed, without prompting you for 
confirmation. The default setting for this check box is unchecked (prompt for 
confirmation).

If you have set your preferences so that the MWTM client identifies nodes by their 
DNS names (the default setting) instead of by their IP addresses, then the ITP must 
be able to resolve the DNS names. Otherwise, the MWTM issues an appropriate error 
message and does not deploy the file.

To enable the ITP to resolve DNS names, enter the ip domain-lookup command on 
the ITP. For more information about this command, see the Cisco IOS IP Command 
Reference, Volume 1 of 4: Addressing and Services, Release 12.3 or later.

For more information about the Show DNS or User-Defined Names and Show IP 
Address in Name Field preference settings, see Node Name Settings, page 5-5.

Archive You use to enter archive comments, if required. If archive comments are not required, 
the MWTM displays the Always Skip Archive Comments check box. 

For details on setting archive comments to required or optional, see mwtm 
deploycomments, page B-82.

Activate Activates the file on the signaling point (replaces the currently running route table 
file, GTT file, or address table file with the deployed file).

The MWTM displays the Activate File and Always Activate File check boxes. You 
can:

• Check the Activate File check box to activate the deployed file on the ITP. This 
is the default setting.

• Uncheck the Activate File check box if you do not want to activate the deployed 
file on the ITP yet.

• Check the Always Activate File check box if you want the MWTM to always 
activate the deployed file on the ITP, without prompting you for confirmation. 
The default setting for this check box is cleared (prompt for confirmation).

Done Displays any status messages, such as errors or successful completion.

Step Description

Field or Button Description

Progress Bar Indicates that the MWTM is validating or uploading the file.

Show Log/Hide Log Displays or hides the log file for the Deployment Wizard.

Next > Advances to the next step in the Deployment Wizard.
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Exporting Data
You use the MWTM to export its data for use by other products, such as CiscoWorks or Microsoft Excel. 
This section includes:

• Exporting Current Data for Network Objects, page 5-38

• Exporting Current Node Names and SNMP Community Names, page 5-39

Exporting Current Data for Network Objects
You can use the MWTM CLI to export all MWTM data, or to export only selected MWTM data.

To export all current MWTM data, with fields separated by vertical bars (|; this is the default setting), 
enter the mwtm export all command with the -d bar keywords:

mwtm export all -d bar

To export all MWTM data with fields separated by commas (,), specify the -d comma keywords:

mwtm export all -d comma

To export all MWTM data with fields separated by tabs, specify the -d tab keywords:

mwtm export all -d tab

To export only object-specific MWTM data, specify one of these keywords:

• as—(ITP only) Export only application server data.

• asp—(ITP only) Export only application server process data.

• aspa—(ITP only) Export only application server process association data.

• links—(ITP only) Export only link data.

• linksets—(ITP only) Export only linkset data.

• nodes—Export only node data.

• sgmp—(ITP only) Export only signaling gateway-mated pair data.

• sps—(ITP only) Export only signaling point data.

You can also specify the -d comma or -d tab keywords on any of these object-specific mwtm export 
commands.

Here is sample output for the mwtm export nodes command:

# ./mwtm export nodes
# v6.0.0.15
# t1168093931311|Sat Jan 06 09:32:11 EST 2007
#
# Total 2 nodes

Finish Closes the Deployment Wizard. The Finish button appears when deployment 
ends successfully, or when the MWTM encounters errors and cancels the 
process.

Cancel Closes the Deployment Wizard without deploying the file.

Help Displays online help for the Deployment Wizard.

Field or Button Description
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# name|displayname|sgmid|old_description|cllicode|ipaddress|old_pointcode|old_se
condary|old_capability|state|statetimestamp|ioslevel|devicetype|usericonname|sys
descr|lastpolltimestamp|lastpolltime|avgpolltime|old_lasterrormsg|old_lasterrort
ime|notesexist|old_variant|sysuptime|rebootreason|statereason|discoveredtime|eve
ntRcvd|connectTo|ignore|customName|processTraps|nsoconfig|mtp3offload|rfpeerstat
e|trapPollingEnabled|reportPollingEnabled|sysName|nodeType

ems1941ka.cisco.com|ems1941ka.cisco.com|1253|not_used|not_used|[172.18.156.20][2
0.1.1.105]|not_used|not_used|not_used|Warning|1168092733287|7|CiscoMWR-1941-DC|n
ull|sysDescr|1168093830179|328|634|not_used|not_used|false|not_used|248128063|re
load|62|1168092732082|false|null|false|null|true|not_used|not_used|not_used|true
|true|ems1941ka|RAN-O

sgm-26-91c-2.cisco.com|null|1350|not_used|clli_2691c|[172.18.17.132,172.18.17.4]
[]|not_used|not_used|not_used|Unmanaged|1168093760605|31|Cisco2651XM|null|sysDes
cr|1168092856198|12984|18729|not_used|not_used|false|not_used|731561022|reload|1
|1168092734928|false|null|false|null|true|1|1|2|false|false|sgm-26-91c.cisco.com
|ITP

For more information about the use of the mwtm export command, see mwtm export, page B-24.

Exporting Current Node Names and SNMP Community Names
To export current MWTM node names and read and write SNMP community names, in CiscoWorks 
import format, with fields separated by commas (,), specify the cw keyword:

mwtm export cw

You can export this data to a file, then use the file to import the nodes into the CiscoWorks database.

For more information about the use of the mwtm export cw command, see mwtm export cw, page B-25.

Integrating the MWTM with Other Products
The MWTM does not require CiscoWorks or the Cisco Info Center (CIC), but the MWTM does integrate 
with those products to provide added value. See these sections for more information:

• Integrating the MWTM with CiscoWorks, page 5-39

• Forwarding Traps to Other Hosts (Server Only), page 5-40

Integrating the MWTM with CiscoWorks
The MWTM can integrate with CiscoWorks during installation, registering with CiscoWorks as an 
installed application. See the “Installing the MWTM on Solaris” and “Installing the MWTM on 
Windows” chapters of the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 for 
more information.

You can also integrate the MWTM with CiscoWorks after installation, using the mwtm cwsetup 
command. See mwtm cwsetup, page B-17 for more information.

When you integrate the MWTM with CiscoWorks, you can launch the CiscoWorks Device Center and 
CiscoView from the MWTM main menu. See these sections for more information:

• Launching the CiscoWorks Device Center, page 5-40

• Launching CiscoView, page 5-40
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Launching the CiscoWorks Device Center

The CiscoWorks Device Center provides a number of useful web-based device-monitoring functions, 
including reachability trends, response time trends, interface status, Syslog browsing, and a detailed 
inventory.

To link the MWTM to the Device Center:

Step 1 Ensure that CiscoWorks is installed in the network.

Step 2 Select a node that you know CiscoWorks is monitoring, or an associated linkset, in a window. If you 
select a non-ITP node, or a node with a status of Unmanaged or a Device Type of Unknown, the 
CiscoWorks menu option is dimmed.

Step 3 Choose Tools > CiscoWorks > Device Center from the MWTM main menu.

Step 4 At the prompt, enter a CiscoWorks user ID and password. The MWTM links to the CiscoWorks Device 
Center dashboard.

Launching CiscoView

CiscoView provides a real-time, color-coded, graphical representation of Cisco devices. You can use 
CiscoView to quickly identify an incorrect status on a port or interface. If you are running CiscoWorks 
on UNIX or Windows, you can access CiscoView through the link to the web version of CiscoWorks.

To link the MWTM to CiscoView:

Step 1 Select a node that you know CiscoWorks is monitoring in a window. If you select a non-ITP or RAN-O 
node, or a node with a status of Unmanaged or a Device Type of Unknown, the CiscoWorks menu option 
is dimmed.

Step 2 Choose Tools > CiscoWorks >CiscoView from the MWTM main menu.

Step 3 At the prompt, enter a CiscoWorks user ID and password. The MWTM links to CiscoView.

Forwarding Traps to Other Hosts (Server Only)
You use the MWTM to forward SNMP traps to other SNMP servers, or hosts. The MWTM can then 
function as a trap multiplexer, integrating with high-level event- and alarm-monitoring systems such as 
the Cisco Info Center and Micromuse's Netcool suite of products. These systems can provide a single 
high-level view of all alarm monitoring in your network, making it easier to detect and resolve problems.

To enable the MWTM to forward SNMP traps to other hosts, specify the list of hosts in the 
TrapForwarder.properties file. The default file resides in the MWTM /properties directory. If you 
installed the MWTM in:

• The default directory, /opt, then the default file resides in 
/opt/CSCOsgm/properties/TrapForwarder.properties.

• A different directory, then the default file resides in that directory.

In the TrapForwarder.properties file, begin all comment lines with a pound sign (#).
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All other lines in the file are host definition lines using this format:

SERVERxx=dest-address[:portno]

where:

• xx is the user-defined server number.

• dest-address is the hostname, or the IP address in dotted-decimal format.

• portno is the optional port number. The default port number is 162.

For example, this host definition line:

SERVER02=64.102.86.104:162

enables the MWTM to forward traps to Server 02, with IP address 64.102.86.104, on port 162.

Any changes you make to the TrapForwarder.properties file take effect when you restart the MWTM 
server. Thereafter, the MWTM forwards all traps from the listed hosts except traps:

• That the MWTM cannot parse.

• From hosts listed in the trapaccess.conf file. For more information, see Limiting Traps by IP 
Address, page 3-8.

The MWTM modifies Version 2c traps that do not have the agent IP address already specified in the 
varbind list by including the agent IP address in the varbind list.

You can also forward MWTM events to other hosts, in the form of SNMP traps. For more information, 
see Forwarding Events as Traps to Other Hosts, page 9-40.

Running Simultaneous Client Sessions
You can run multiple sessions of the MWTM client simultaneously because the MWTM uses a 
client-server architecture. The MWTM server provides central services and database functions and 
communicates with multiple MWTM clients. You can install the MWTM client software on the same 
system as the MWTM server, or on a different system on the same network as the MWTM server.

Note Running more than one MWTM client on the same workstation can degrade the workstation 
performance.

The MWTM recommends a maximum of 20 clients per MWTM server. If you connect more than 20 
clients to a single server, the server requires additional memory and a more powerful CPU.

Performing Basic Server Operations
This section contains this information:

• Connecting to a New Server, page 5-42

• Viewing Server Status Information, page 5-43
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Connecting to a New Server
You use the MWTM to connect the client to a new MWTM server. For example, you can monitor two or 
more networks from the same MWTM client, simply by switching servers. Or, if you have two MWTM 
servers monitoring the same network, and one server fails, the MWTM client automatically switches to 
the secondary server.

If you want to determine the default hostname before you connect to the new server, it appears in the 
SERVER_NAME entry in the System.properties file. If you installed the MWTM in:

• The MWTM in the default directory, /opt, then the location of the System.properties file is 
/opt/CSCOsgm/properties/System.properties.

• A different directory, then the System.properties file resides in that directory.

To connect the client to a new server, choose File > Connect to New Server from the MWTM main 
menu. The MWTM displays the Connect to New Server dialog box.

Figure 5-8 Connect to New Server Dialog

The Connect to New Server dialog box contains:

Field or Button Description

Server Name or IP Address Name or IP address of the new server. Enter the name of the new server, 
or its IP address, in the Server Name or IP Address field.

Name Server Port UDP port number for the new server. Enter the MWTM Naming Server 
UDP port number for the new server in the Name Server Port field.

The default value is 44742.

OK Stops the MWTM client, then restarts the client connected to the 
specified server.

When you have entered the name of the new server, or its IP address, 
and its UDP port number, click OK. The MWTM stops the client, then 
restarts the client connected to the new server.

Cancel Closes the Connect to New Server dialog box without connecting to the 
new server.

Help Displays online help for the Connect to New Server dialog box.
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Viewing Server Status Information
You use the MWTM to view detailed information about the processes, pollers, tasks, and clients for the 
server to which you are connected.

To display server status information, choose View > MWTM Server > Status in the MWTM main 
menu. The MWTM displays the Server Status Information window.

Figure 5-9 Server Status Information Window

The Server Status Information window contains:

• Server Status Information: Fields and Buttons, page 5-43

• Server Status Information: Processes, page 5-44

• Server Status Information:Pollers, page 5-44

• Server Status Information:Tasks, page 5-44

• Server Status Information: Clients, page 5-45

Server Status Information: Fields and Buttons

The Server Status Information window contains:

Command Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays a message that the MWTM is polling the device. After 
the first polling cycle, the MWTM populates this field with the actual time of the 
last poll.

Update Forces an immediate poll, and refreshes the Server Status Information window with 
the latest data.

Close Closes the Server Status Information window.

Help Accesses the online help for this window.
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Server Status Information: Processes

The Server Status Information: Processes section lists the processes that make up the MWTM server, 
and contains:

Server Status Information:Pollers

The Server Status Information: Pollers table lists the detail and demand pollers that the MWTM server 
is currently processing, and contains:

Server Status Information:Tasks

The Server Status Information: Tasks table lists long-running services that the MWTM server performs, 
and contains:

Field Description

Name Name of the process, such as sgmNameServer.

Process ID Number to uniquely identify the process.

Is Running Indicates whether the process is running (true) or not (false).

Field Description

Poller ID Number to uniquely identify each MWTM detail poller that is currently active.

MWTM detail pollers collect detailed data (such as real-time data, statistics, route 
detail, and so on) that the regular MWTM poller did not collect.

Client Host Name of the MWTM client that started the detail poller.

Interval Poll interval for the detail poller, in hours, minutes, and seconds.

Iteration Number of times the detail poller should poll. If this field displays Forever, the detail 
poller will never stop polling, until the MWTM client requests that it stops.

Next Poll Time until the next poll, in hours, minutes, and seconds.

Time Limit Time remaining, in hours, minutes, and seconds, until the poller times out. When the 
poller times out, the MWTM automatically stops the poller to prevent unnecessary 
traffic on the network and sends an appropriate error message to the client.

By default, the MWTM allows pollers to run up to 8 hours. To change that setting, see 
the description of the mwtm pollertimeout command in mwtm pollertimeout, page 
B-39.

Description Description of the detail poller.

Field Description

Task ID Number to uniquely identify the task.

Interval Time between runs for the task, in hours, minutes, and seconds.

Iteration Number of times the task should run. If this field displays Forever, the task will 
never stop polling.

Next Execution Time until the next run for the task, in hours, minutes, and seconds.



 

5-45
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 5      Basic Operations
  Using the Command Line Interface

Server Status Information: Clients

The Server Status Information: Clients table contains:

Using the Command Line Interface
The MWTM provides a command line interface that you use to interact with the MWTM and with the 
Cisco IOS software operating system by entering commands and optional arguments. For more 
information, see Appendix B, “Command Reference.”

State Current state of the task. Valid values are:

• None—Task is stopped.

• Waiting—Task is waiting to transition to Ready or Running state.

• Ready—Task is ready to execute but is not yet in Running state.

• Running—Task is started and is currently executing.

• Pending—Task was in Ready state when a user canceled it. The task is pending 
final removal from the scheduler.

• Error—Task encountered an error.

• Dying—Task was in Running state when it was canceled by a user. The task 
continues to run in Dying state until it ends. The server then removes the task 
from the scheduler.

Description Description of the task.

Field Description

Field Description

Process Name Name of an MWTM client that is currently connected to the server.

User Name If you have implemented MWTM User-Based Access, this field displays the name of 
an MWTM client user who is currently logged in and connected to the server.

If you have not implemented MWTM User-Based Access, this field displays the 
name of the node that the user is using.

Message Mask Mask that indicates which messages can be sent to the client. 

Sleeping? Indicates whether the thread that is responsible for delivering messages is sleeping 
(yes) or not (no). The normal setting for this field is no.

Sleep Time Time in seconds the thread that is responsible for delivering messages has been 
sleeping. The normal setting for this field is 0.

Queue Size Number of messages waiting to be sent to the MWTM client. The normal setting for 
this field is 0, but it could be higher if the MWTM server or client is very busy, as 
during Discovery.
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6
Understanding Basic Object Functions

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to view basic information about 
any discovered MWTM object, including its associated objects, events, status, and other important 
information.

To view basic information for an object, click the turner beside Summary Lists in the navigation tree of 
the MWTM main window, then select one of these objects:

Note Objects only appear if your network contains that particular object type.

Object Applicable Network Type

Nodes ITP and RAN-O

Signaling Points

Note In a multi-instance network, the signaling 
point name has the format 
pointcode:instanceName.

In a multi-instance network, the MWTM 
does not display signaling points that are 
only partly configured (that is, the variant 
and network name are configured, but not 
the primary point code).

ITP only

Linksets

Links

Application Servers

Application Server Processes

Application Server Process Associations

Signaling Gateway Mated Pairs

Interfaces ITP and RAN-O

Cards RAN-O only

RAN Backhauls

RAN Shorthauls
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This chapter contains:

• Displaying Object Windows, page 6-2

• Editing Properties, page 6-29

• Attaching Notes, page 6-34

• Viewing Notes, page 6-35

• Deleting Objects, page 6-36

• Unmanaging and Managing Nodes or ITP Signaling Points, page 6-38

• Excluding Nodes or ITP Signaling Points from a View, page 6-39

• Ignoring and Unignoring Objects, page 6-39

Displaying Object Windows
To display an object window, in the MWTM main window, under Summary Lists in the navigation tree, 
select the object type. The object window appears in the right pane. 

Note The right pane lists all objects of the object type that you select in the navigation tree. To see the fully 
qualified domain name (FQDN) of any object in the right pane, hover over the object name with the 
mouse. A tooltip lists the FQDN for the object.

Example:

To display the nodes table, choose Summary Lists > Nodes. The nodes table appears.

Figure 6-1 Node Window
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Object windows provide information about all objects of a specific type that the MWTM has discovered.

Object windows can contain:

• Right-Click Menu for All Objects, page 6-3

• Nodes Table, page 6-4

• Signaling Points Table, page 6-6

• Linksets Table, page 6-8

• Links Table, page 6-11

• Application Servers Table, page 6-13

• Application Server Processes Table, page 6-15

• Application Server Process Associations Table, page 6-17

• Signaling Gateway Mated Pairs Table, page 6-19

• Interfaces Table, page 6-21

• Cards Table, page 6-23

• RAN Backhauls Table, page 6-25

• RAN Shorthauls Table, page 6-27

• Software Versions Table, page 6-29

Right-Click Menu for All Objects
To see the right-click menu for all objects, in the MWTM main window, under Summary Lists in the 
navigation tree, select the object type and right-click on it. The right-click menu contains:

Note The right-click menu, available by clicking on a specific object in the right pane, is described in Viewing 
the Right-Click Menu for an Object, page 8-3.

Menu Command Description

Show in New Window Opens the object window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.
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Nodes Table
The nodes table displays information about nodes that the MWTM has discovered. To display the nodes 
table, choose Summary Lists > Nodes.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the nodes table except 
Internal ID, CLLI Code, Uptime, Reboot Reason, Process Traps, and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The nodes table contains:

Column Description

Internal ID Internal ID of the node. The internal ID is a unique ID for every object, 
which the MWTM assigns for its own internal use. This ID can also be useful 
when the TAC is debugging problems.

Name Name of the node.

Primary SNMP Address IP address of the node, which SNMP uses to poll the node. (There might be 
other IP addresses on the node that are not the primary SNMP address.)

CLLI Code (ITP only) Common Language Location Identification code for the node. A CLLI code 
is a standardized 11-character identifier that uniquely identifies the 
geographic location of the node. If the node has no CLLI code configured, 
this field is blank.

Node Type Type of node. Node types can be specific to ITP, RAN-O, or generic to both.

ITP specific nodes include:

• Cisco2650XM, Cisco2651XM

• Cisco2811

• Cisco7204VXR, Cisco7206VXR

• Cisco7301

• Cisco7507, Cisco7507mx, Cisco7507z, Cisco7513, Cisco7513mx, 
Cisco7513z

• Cisco7604, Cisco7606, Cisco7609, Cisco7613

RAN-O specific nodes include:

• CiscoMWR-1941-DC-A—Cisco MWR-1941-DC-A series router

• CiscoONS15454—Cisco ONS 15454 SONET multiplexer

• Node B—The radio transmission and reception unit for communication 
between radio cells.

• RAN_SVC—RAN Service module in the Cisco ONS 15454

Generic nodes include:

• IPDevice—IP device, other than those listed above. You can assign this 
icon to an unknown node if you know that it is an IP device.

• Unknown—The MWTM is unable to determine the node type.

Software Version Version of node’s software.
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Uptime Time the node has been up, in days, hours, minutes, and seconds.

Reboot Reason Reason for the last reboot of the node.

Ignored Indicates whether to include the node when aggregating and displaying 
MWTM status information:

• Check the check box to include the node. This is the default setting.

• Uncheck the check box to exclude the node.

Note Not applicable for unmanaged nodes.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Process Traps Indicates whether the MWTM should process traps from this node. This field 
is read-only.

Trap Polling Indicates whether trap polling is enabled for this node. This field is 
read-only. 

• If you want to enable trap polling for this node, set ipran-mib 
snmp-access to inBand on the node.

• If you want to disable trap polling for this node, set ipran-mib 
snmp-access to outOfBand on the node.

Report Polling Indicates whether report polling is enabled for this node. This field is 
read-only. 

• If you want to enable report polling for this node, set ipran-mib location 
to aggSite on the node.

• If you want to disable report polling for this node, set ipran-mib location 
to cellSite on the node.

Notes Indicates whether a note is associated with the node.

Events Indicates whether a recent event is associated with the node. (Even if the 
server purges all of the events associated with the node, the MWTM 
continues to display the event icon in this field.) To delete the:

• Event icon from MWTM displays for a specific node, select the node 
and click the icon.

• Event icon from MWTM displays for all nodes, choose Edit > Clear All 
Events from the MWTM main menu.

Note During discovery, the MWTM might flag most nodes with an event 
icon. If the event icons are too distracting, use the Edit > Clear All 
Events menu option to remove them.

Last Status Change Date and time that the status of the node last changed.

Column Description
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Signaling Points Table
The signaling points table displays information about the signaling points that the MWTM has 
discovered. To display the signaling points table, choose Summary Lists > Signaling Points.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the signaling points table except Internal ID, Instance Number, 
and Last Status Change.

For detailed information on working within tables, see the Navigating Table Columns, page 5-23.

Status Current status of the node. Possible values are:

Active (green)

Discovering (cyan)

Polling (cyan)

Unknown (red)

Unmanaged (gray)

Waiting (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Status Reason Reason for the current status of the node.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons appear in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description
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The signaling points table contains:

Column Description

Internal ID Internal ID of the signaling point. The internal ID is a unique ID for every 
object, which the MWTM assigns for its own internal use. It can also be 
useful when the TAC is debugging problems.

Name Name of the signaling point.

Node Name of the node associated with this signaling point.

Instance Number Number of the instance associated with the signaling point.

Network Name Name of the instance associated with the signaling point.

Point Code Primary point code of the signaling point.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Indicator Determines the type of call that is being placed. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates the networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call; used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates the networks.

Ignored Indicates whether to include the signaling point when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the signaling point. This is the default 
setting.

• Check the check box to exclude the signaling point.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the signaling point.
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Linksets Table
The linksets table displays information about the linksets that the MWTM has discovered. To display the 
linksets table, choose Summary Lists > Linksets.

Tip Linksets that are associated with nodes that are excluded from the current view are not visible in the 
linksets table. See Creating a New View, page 7-9 for more information about excluding nodes.

Events Indicates whether a recent event is associated with the signaling point. (Even 
if the server purges all of the events associated with the signaling point, the 
MWTM continues to display the event icon in this field.)

Note During discovery, the MWTM might flag most signaling points with 
an Event icon. If the event icons are too distracting, choose Edit > 
Clear All Events from the MWTM main menu to remove them.

Last Status Change Date and time that the status of the signaling point last changed.

Status Current status of the signaling point. Possible values are:

Active (green)

Unknown (red)

Unmanaged (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Points, page E-7.

Status Reason Reason for the current status of the signaling point.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file resides at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file reside in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full status reason in a mouse over help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description
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You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the linksets table except 
Internal ID, Node, SP, Congested Links, and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The linksets table contains:

Column Description

Internal ID Internal ID of the linkset. The internal ID is a unique ID for every object, which 
the MWTM assigns for its own internal use. It can also be useful when the TAC 
is debugging problems.

Name Name of the linkset.

Node Node associated with the linkset.

Signaling Point Signaling point associated with the linkset.

Local Point Code Point code of the primary signaling point for the linkset.

Adj Point Code Point code of the adjacent signaling point for the linkset.

Linkset Type Type of linkset, which the MWTM determines by examining the links defined in 
the linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control TCP/IP transport 
protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect signaling 
point instances running on the same node. The MWTM does not poll virtual 
linksets, nor does it display real-time data or accounting statistics for virtual 
linksets.

Note Prior to IOS release 12.2(23)SW1, the user manually created virtual 
linksets on multi-instance nodes. Within and after that release, users can 
now automatically create virtual linksets.

• Other—No links have been defined for this linkset.

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.

Ignored Indicates whether to include the linkset when aggregating and displaying 
MWTM status information:

• Uncheck the check box to include the linkset. This is the default setting.

• Check the check box to exclude the linkset.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the linkset.
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Events Indicates whether there is a recent event associated with the linkset. (Even if the 
server purges all of the events associated with the linkset, the MWTM continues 
to display the event icon in this field.) To delete the Event icon from MWTM 
displays for:

• A specific linkset, select the linkset and click the icon.

• All linksets, choose Edit > Clear All Events from the MWTM main menu.

Note During discovery, the MWTM might flag most linksets with an event 
icon. If the event icons are too distracting, choose Edit > Clear All Events 
to remove them.

Last Status Change Date and time that the status of the linkset last changed.

Status Current status of the linkset. Possible values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Linksets, page 
E-6.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If you installed 
the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Column Description
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Links Table
The links table displays information about the links that the MWTM has discovered. To display the links 
table, choose Summary Lists > Links.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the links table except Internal 
ID, Congestion Level, and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The links table contains:

Column Description

Internal ID Internal ID of the link. The internal ID is a unique ID for every object, which the 
MWTM assigns for its own internal use. This ID can also be useful when the TAC 
is debugging problems.

Node Name of the node associated with the link.

Signaling Point Name of the signaling point associated with the link.

Linkset Name of the linkset associated with the link.

SLC Signaling link code (SLC) ID for the link.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM high-speed protocol.

• SCTPIP—The link uses the Stream Control TCP/IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point instances 
running on the same node. The MWTM does not poll virtual links, nor does 
it display real-time data or accounting statistics for virtual links.

Congestion Level Indicates the level of congestion on the link. A link is congested if it has too many 
packets waiting to be sent. This condition could result from the failure of an 
element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 3, indicating levels of congestion from very light (1) to very 
heavy (3).

Ignored Indicates whether to include the link when aggregating and displaying MWTM 
status information:

• Uncheck the check box to include the link. This is the default setting.

• Check the check box to exclude the link.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the link.
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Events Indicates whether a recent event is associated with the link. (Even if the server 
purges all of the events associated with the link, the MWTM continues to display 
the event icon in this field.) To delete the Event icon from MWTM displays for:

• A specific link, select the link and click the icon.

• All links, choose Edit > Clear All Events from the MWTM main menu.

Note During discovery, the MWTM might flag most links with an event icon. 
If the event icons are too distracting, choose Edit > Clear All Events to 
remove them.

Last Status Change Date and time that the status of the link last changed.

Status Current status of the link. Possible values are:

Active (green)

Blocked (red)

Failed (red)

InhibitLoc (blue)

InhibitRem (blue)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Links, page E-5.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If you installed 
the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons appear in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Column Description
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Application Servers Table
The application servers table displays information about the application servers that the MWTM has 
discovered. To display the application servers table, choose Summary Lists > App. Servers.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the application servers table 
except Internal ID, Protocol, Routing Key, Traffic Mode, and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The application servers table contains:

Column Description

Internal ID Internal ID of the application server. The internal ID is a unique ID for every 
object, that the MWTM assigns for its own internal use. This ID can also be 
useful when the TAC is debugging problems.

Name Name of the application server.

Node Name of the node associated with the application server.

Signaling Point Name of the signaling point associated with the application server.

Protocol Protocol associated with the application server. Possible values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

Routing Key Routing key associated with the application server. The application server 
bases its routing decisions on the routing key value.

Traffic Mode Method by which the application server forwards requests to its active 
application server processes. Possible values are:

• overRide—One application server process takes over all traffic for the 
application server, possibly overriding any currently active application 
server process in the application server.

• broadcast—Every active application server process receives the same 
message.

• loadBind—Each application server process shares in the traffic 
distribution with every other currently active application server process, 
based on application server process bindings.

• loadRndRobin—Each application server process shares in the traffic 
distribution with every other currently active application server process, 
using a roundrobin algorithm.

• undefined—The traffic mode is not defined. The first application server 
process that becomes active defines the traffic mode.

Application Server 
Process Associations

Total number of application server processes associated with the application 
server.

Active ASP 
Associations

Number of currently active application server processes associated with the 
application server.
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Ignored Indicates whether to include the application server when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the application server. This is the 
default setting.

• Check the check box to exclude the application server.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the application server.

Events Indicates whether a recent event is associated with the application server. 
(Even if the server purges all of the events associated with the application 
server, the MWTM continues to display the event icon in this field.) To 
delete the Event icon from MWTM displays for:

• A specific application server, select the application server and click the 
icon.

• All application servers, choose Edit > Clear All Events from the 
MWTM main menu.

Note During discovery, the MWTM might flag most application servers 
with an event icon. If the event icons are too distracting, choose Edit 
> Clear All Events to remove them.

Last Status Change Date and time that the status of the application server last changed.

Status Current status of the application server. Possible values are:

Active (green)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Servers, page E-3.

Column Description
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Application Server Processes Table
The application server processes table displays information about the application server processes that 
the MWTM has discovered. To display the application server processes table, choose Summary Lists > 
App. Server Processes.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the application server 
processes table except Internal ID and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The application server processes table contains:

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description

Column Description

Internal ID Internal ID of the application server process. The internal ID is a unique ID for 
every object, that the MWTM assigns for its own internal use. This ID can also 
be useful when the TAC is debugging problems.

Name Name of the application server process.

Node Name of the node associated with the application server process.

Local IP Address Local IP address that the application server process is currently using.

Local Port Local port number that the application server process is currently using.
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Ignored Indicates whether to include the application server process when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the application server process. This is the 
default setting.

• Check the check box to exclude the application server process.

Users with authentication level Power User (level 2) and higher can edit this field.

Notes Indicates whether a note is associated with the application server process.

Events Indicates whether a recent event is associated with the application server process. 
(Even if the server purges all of the events associated with the application server 
process, the MWTM continues to display the event icon in this field.) To delete 
the Event icon from MWTM displays for:

• A specific application server process, select the application server process 
and click the icon.

• All application server processes, choose Edit > Clear All Events from the 
MWTM main menu.

Note During discovery, the MWTM might flag most application server 
processes with an event icon. If the event icons are too distracting, choose 
Edit > Clear All Events to remove them.

Last Status Change Date and time that the status of the application server process last changed.

Status Current status of the application server process. Possible values are:

Unknown (red)

Unmanaged (gray)

For detailed definitions of each status, see Status Definitions for Application 
Server Processes, page E-3.

Status Reason Reason for the current status of the application server process.

For a full list of possible reasons, see the stateReasons.html file. If you installed 
the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Column Description
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Application Server Process Associations Table
The application server process associations table displays information about the application server 
process associations that the MWTM has discovered. To display the application server process 
associations table, choose Summary Lists > App. Server Proc. Assoc.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the application server process 
associations table except Internal ID, Congestion Level, and Last Status Change.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The application server process associations table contains:

Column Description

Internal ID Internal ID of the application server process association. The internal ID is a 
unique ID for every object, that the MWTM assigns for its own internal use. The 
ID can also be useful when the TAC is debugging problems.

Name Name of the application server process association.

Node Name of the node associated with the application server process association.

Signaling Point Name of the signaling point associated with the application server process 
association.

Application Server Name of the application server associated with the application server process 
association.

Protocol Protocol associated with the application server process association. Possible 
values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

Congestion Level Indicates the level of congestion of an application server process association. An 
application server process association is congested if it has too many packets 
waiting to be sent. This condition could result from the failure of an element in 
your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Ignored Indicates whether to include the application server process association when 
aggregating and displaying MWTM status information:

• Uncheck the check box to include the application server process association. 
This is the default setting.

• Check the check box to exclude the application server process association.

Users with authentication level Power User (level 2) and higher can edit this field.

Notes Indicates whether a note is associated with the application server process 
association.
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Events Indicates whether a recent event is associated with the application server process 
association. (Even if the server purges all of the events associated with the 
application server process association, the MWTM continues to display the event 
icon in this field.) To delete the Event icon from MWTM displays for:

• A specific application server process association, select the application server 
process association and click the icon.

• All application server process associations, choose Edit > Clear All Events 
from the MWTM main menu.

Note During discovery, the MWTM might flag most application server process 
associations with an event icon. If the event icons are too distracting, 
choose Edit > Clear All Events to remove them.

Last Status Change Date and time that the status of the application server process association last 
changed.

Status Current status of the application server process association. Possible values are:

Active (green)

Blocked (red)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Server Process Associations, page E-3.

Status Reason Reason for the current status of the application server process association.

For a full list of possible reasons, see the stateReasons.html file. If you installed 
the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

Column Description
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Signaling Gateway Mated Pairs Table
The signaling gateway-mated pairs table displays information about the signaling gateway-mated pairs 
that the MWTM has discovered. To display the signaling gateway-mated pairs table, choose Summary 
Lists > Signaling Gateway Mated Pairs.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the signaling gateway-mated 
pairs table except Internal ID and Congestion Level.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The signaling gateway-mated pairs table contains:

Status Reason

(continued)

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Column Description

Column Description

Internal ID Internal ID of the signaling gateway-mated pair. The internal ID is a unique ID 
for every object, that the MWTM assigns for its own internal use. The ID can 
also be useful when the TAC is debugging problems.

Name Name of the signaling gateway-mated pair.

Mate Name of the node associated with the mate of the signaling gateway-mated 
pair.

Node Name of the node associated with the signaling gateway-mated pair.

Congestion Level Indicates the congestion level of a signaling gateway-mated pair. A signaling 
gateway-mated pair is congested if it has too many packets waiting to be sent. 
This condition could result from the failure of an element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to 
very heavy (7).

Ignored Indicates whether to include the signaling gateway-mated pair when 
aggregating and displaying MWTM status information:

• Uncheck the check box to include the signaling gateway-mated pair. This 
is the default setting.

• Check the check box to exclude the signaling gateway-mated pair.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the signaling gateway-mated pair.
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Events Indicates whether a recent event is associated with the signaling 
gateway-mated pair. (Even if the server purges all of the events associated with 
the signaling gateway-mated pair, the MWTM continues to display the event 
icon in this field.) To delete the Event icon from MWTM displays for:

• A specific signaling gateway-mated pair, select the signaling 
gateway-mated pair and click the icon.

• All signaling gateway-mated pairs, choose Edit > Clear All Events from 
the MWTM main menu.

Note During discovery, the MWTM might flag most signaling 
gateway-mated pairs with an event icon. If the event icons are too 
distracting, choose Edit > Clear All Events to remove them.

Last Status Change Date and time that the status of the signaling gateway-mated pair last changed.

Status Current status of the signaling gateway-mated pair. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Column Description
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Interfaces Table
The interfaces table displays information about the ITP or RAN interfaces that the MWTM has 
discovered. To display the interfaces table, choose Summary Lists > Interfaces.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the interfaces table except 
Interface Type, Last Status Change, Admin Status, and Operational Status.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The interfaces table contains:

Column Description

Name Name of the interface. The node specifies the name of the interface.

Node Name of the node with the interface.

Speed Speed of the interface in bits per second. 

Interface Index Unique numeric identifier of the interface. This identifier appears in the 
interface table (ifTable).

Maximum Packet 
Size

The maximum packet size that traverses the interface in bytes.

Physical Address The physical address of the interface. If a physical address does not apply to 
the interface, N/A appears in the table cell.

Ignored Indicates whether to include the interface when aggregating and displaying 
MWTM status information:

• Uncheck the check box to include the interface. This is the default setting.

• Check the check box to exclude the interface.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the interface.

Events Indicates whether a recent event is associated with the interface. (Even if the 
server purges all of the events associated with the interface, the MWTM 
continues to display the event icon in this field.) To delete the Event icon from 
MWTM displays for:

• A specific interface, select the interface and click the icon.

• All interfaces, choose Edit > Clear All Events from the MWTM main 
menu.

Note During discovery, the MWTM might flag most interfaces with an event 
icon. If the event icons are too distracting, choose Edit > Clear All 
Events to remove them.

Last Status Change Date and time that the status of the interface last changed.
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Status Current status of the interface. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for RAN-O 
Interfaces, page E-7.

Admin Status Desired state of the interface:

• Up

• Down

• Testing

• Shutdown

For detailed definitions of each status, see Admin Status, page E-8.

Operational Status Current operational state of the interface:

• Up

• Down

• Testing

• Unknown

• Dormant

• Not present

• Lower layer down

For detailed definitions of each status, see Operational Status, page E-8.

Status Reason Reason for the current status of the interface.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

Column Description
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Cards Table
The cards table displays information about the cards in the ONS 15454 RAN-O node that the MWTM 
has discovered. To display the cards table, choose Summary Lists > Cards.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the cards table except 
Internal ID, cardModelName, Last Status Change, Status Reason, Hardware Version, Firmware Version, 
and Software Version.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The cards table contains:

Status Reason 

(continued)

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Column Description

Column Description

Internal ID Internal ID of the card. The internal ID is a unique ID for every object, that the 
MWTM assigns for its own internal use. The ID can also be useful when the 
TAC is debugging problems.

Name Name of the card. The node specifies the name of the card.

Node Name of the node in which the card resides.

Card Type Type of the card in the node. 

Model Name Model name of the card (can include the part number).

Description Description of the card.

Slot Number The slot number of the card in the node.

Ignored Indicates whether to include the card when aggregating and displaying MWTM 
status information:

• Uncheck the check box to include the card. This is the default setting.

• Check the check box to exclude the card.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the card.
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Events Indicates whether a recent event is associated with the card. (Even if the server 
purges all of the events associated with the card, the MWTM continues to 
display the event icon in this field.) To delete the Event icon from MWTM 
displays for:

• A specific card, select the card and click the icon.

• All cards, choose Edit > Clear All Events from the MWTM main menu.

Note During discovery, the MWTM might flag most cards with an event 
icon. If the event icons are too distracting, choose Edit > Clear All 
Events to remove them.

Last Status Change Date and time that the status of the card last changed.

Status Current status of the card. Possible values are:

Active (green)

Down (red)

Inactive (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Cards, page 
E-10.

Status Reason Reason for the current status of the card.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Hardware Version Hardware version of the card.

Firmware Version Firmware version of the card.

Software Version Software version of the card.

Column Description
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RAN Backhauls Table
The RAN backhauls table displays information about the RAN backhauls that the MWTM has 
discovered. To display the RAN backhauls table, choose Summary Lists > RAN Backhauls.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the table except Internal ID, 
Type, User Bandwidth, System Bandwidth, Last Status Change, Acceptable Threshold, Warning 
Threshold, and Overloaded Threshold.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The RAN backhauls table contains:

Column Description

Internal ID Internal ID of the RAN backhaul. The internal ID is a unique ID for every 
object, that the MWTM assigns for its own internal use. The ID can also be 
useful when the TAC is debugging problems.

Name Name of the RAN backhaul.

Node Name of the node on which this RAN backhaul resides.

Location Location of the node (either at the cell site or the aggregation node site).

Peer Name Name of the object’s peer.

Peer Node Name of the node to which the peer object belongs.

Type Indicates whether the RAN backhaul is a normal backhaul or a virtual backhaul 
(see Creating Virtual RAN Backhauls, page 8-136).

User Bandwidth The bandwidth that the user specified for the backhaul. To change this value, 
see Editing Properties for a RAN-O Backhaul, page 6-33.

System Bandwidth The bandwidth that the system specifies for the backhaul. To change this value, 
see Editing Properties for a RAN-O Backhaul, page 6-33.

Ignored Indicates whether to include the RAN backhaul when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the RAN backhaul. This is the default 
setting.

• Check the check box to exclude the RAN backhaul.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the RAN backhaul.
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Events Indicates whether a recent event is associated with the RAN backhaul. (Even 
if the server purges all of the events associated with the RAN backhaul, the 
MWTM continues to display the event icon in this field.) To delete the Event 
icon from MWTM displays for:

• A specific RAN backhaul, select the RAN backhaul and click the icon.

• All RAN backhauls, choose Edit > Clear All Events from the MWTM 
main menu.

Note During discovery, the MWTM might flag most RAN backhauls with an 
event icon. If the event icons are too distracting, choose Edit > Clear 
All Events to remove them.

Last Status Change Date and time that the status of the backhaul last changed.

Status Current status of the RAN backhaul. Possible values are:

Active (green)

Failed (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for RAN-O 
Backhauls, page E-10.

Status Reason Reason for the current status of the card.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Accept Threshold The percentage threshold setting below which the backhaul utilization is 
considered acceptable.

Column Description
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RAN Shorthauls Table
The RAN shorthauls table displays information about the RAN shorthauls that the MWTM has 
discovered. To display the RAN shorthauls table, choose Summary Lists > RAN Shorthauls.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM displays all of the columns in the table except Internal ID, 
Interface Type, Speed (Bits/Sec), Interface Index, Maximum Packet Size, Physical Address, Last Status 
Change, Admin Status, and Operational Status.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The RAN shorthauls table contains:

Warning Threshold The percentage threshold setting beyond which the backhaul utilization issues 
a warning. Subsequent warnings are issued only if the utilization goes below 
the Acceptable Threshold.

Overload Threshold The percentage threshold setting beyond which the backhaul utilization is 
considered overloaded. Subsequent overload messages are issued only if the 
utilization goes below the Warning Threshold.

Column Description

Column Description

Internal ID Internal ID of the RAN shorthaul. The internal ID is a unique ID for every 
object, that the MWTM assigns for its own internal use. The ID can also be 
useful when the TAC is debugging problems.

Name Name of the RAN shorthaul.

Node Name of the node to which the RAN shorthaul is connected.

Type Type of shorthaul, either GSM or UMTS.

Location Location of the node (either at the cell site or the aggregation node site).

Peer Name Name of the object’s peer.

Peer Node Name of the node to which the peer object belongs.

Interface Type Type of interface (for example, a point-to-point interface or an ATM interface).

Speed (Bits/Sec) Speed of the interface in megabits per second (for example, 1.98M).

Interface Index Unique numeric identifier of the interface. This identifier appears in the 
interface table (ifTable).

Maximum Packet 
Size (bytes)

Maximum packet size on the interface in bytes.

Physical Address Physical address, if applicable, of the interface.
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Ignored Indicates whether to include the RAN shorthaul when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the RAN shorthaul. This is the default 
setting.

• Check the check box to exclude the RAN shorthaul.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the RAN shorthaul.

Events Indicates whether a recent event is associated with the RAN shorthaul. (Even 
if the server purges all of the events associated with the RAN shorthaul, the 
MWTM continues to display the event icon in this field.) To delete the Event 
icon from MWTM displays for:

• A specific RAN shorthaul, select the RAN shorthaul and click the icon.

• All RAN shorthauls, choose Edit > Clear All Events from the MWTM 
main menu.

Note During discovery, the MWTM might flag most RAN shorthauls with an 
event icon. If the event icons are too distracting, choose Edit > Clear 
All Events to remove them.

Last Status Change Date and time that the status of the shorthaul last changed.

Status Current status of the RAN shorthaul.

For detailed definitions of each status, see Status Definitions for RAN-O 
Backhauls, page E-10.

Admin Status Desired state of the interface:

• Up

• Down

• Testing

• Shutdown

For detailed definitions of each status, see Admin Status, page E-8.

Operational Status Current operational state of the interface:

• Up

• Down

• Testing

• Unknown

• Dormant

• Not present

• Lower layer down

For detailed definitions of each status, see Operational Status, page E-8.

Column Description
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Software Versions Table
The Software Versions table lists the software versions for each node the MWTM manages. This option 
is Web-only and does not appear in the MWTM client. 

For details on the Software Versions table, see Displaying Software Versions, page 11-28.

Editing Properties
In the Edit Properties dialog box you can change the basic properties associated with one of these 
objects:

• Views

• Nodes

• Signaling Points (ITP only)

• Application Server Processes (ITP only)

• Backhauls (RAN-O only), (see Editing Properties for a RAN-O Backhaul, page 6-33)

Example:

To edit a node’s properties, right-click the node in the Node table in the right pane or within a view in 
the navigation tree, and choose Edit > Properties in the right-click menu. The MWTM displays the Edit 
Properties dialog box.

Status Reason Reason for the current status of the card.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears first.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Column Description
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Figure 6-2 Edit Properties Dialog for a Node

The Edit Properties dialog box contains:

Field or Button Description

Name Name of the object.

• For application server processes only—This field cannot be edited.

• For nodes only—By default, this field displays the node’s DNS name, which 
the MWTM discovered. However, if you modified your preferences to identify 
nodes by their IP addresses, then that is how the node is identified in this field. 
For more information, see Node Name Settings, page 5-5.

• For signaling points only—By default, this field displays the signaling point’s 
point code and network name, which the MWTM discovered (for example, 
1.22.0:net0).

You can also use this field to specify a new, more meaningful name for the node or 
ITP signaling point. Remember that:

• You can change an object’s name to a new name or IP address.

• A new name can be from 1 to 30 characters, and can contain any letters (upper- 
or lowercase) and any numbers, as well as blank spaces ( ), hyphens (-), and 
underscores (_), but no periods (.). If you enter a name that is longer than 30 
characters, or if you enter any other special characters or periods, the MWTM 
beeps and retains the current name.

• If you enter a name that includes a period (.), the MWTM assumes that you are 
entering a new IP address. A new IP address must use the x.x.x.x format, where 
x is between 0 and 255, and must contain only numbers and periods (.), but no 
letters or special characters. If you enter an IP address that contains any letters 
or special characters, the MWTM beeps and retains the current IP address.
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Name

(continued)

• If you edit an object whose current name already contains invalid characters, 
the MWTM beeps and replaces the name with blanks. Enter a new name that 
uses only valid characters, or click Cancel to keep the existing name. If you 
click Cancel, the MWTM exits the Edit Properties dialog box without saving 
any changes to the Name, Connect Address, or Icon Name field.

• If you leave the Name field blank, the MWTM reverts to the object’s default 
name (dependent upon personalities, ITP or RAN-O).

• The new object’s name is used when launching context-based applications, 
such as CiscoWorks. Therefore, if the new name that you enter is not the 
object’s DNS name, and the application knows the object by its DNS name, 
context links into the application for that object might not work.

When you click Save, all MWTM windows are updated automatically to reflect the 
new name.

Connect Address 
(Nodes only)

Connect IP address to pass to the Telnet or SSH command.

A new Telnet or SSH IP address must use the x.x.x.x format, where x is between 
0 and 255, and must contain only numbers and periods, but no letters or special 
characters. If you enter a Telnet or SSH IP address that contains any letters or 
special characters, the MWTM beeps and retains the current IP address.

Connect Port 
(Nodes only)

Optional port number to pass to the Telnet or SSH command.

Icon Name Name of the graphic icon to assign to this object in topology maps. The MWTM 
automatically assigns an appropriate icon to each discovered node and to 
Unknown nodes; but, you can use this field to assign a different icon (for example, 
if you know that a given Unknown node is a mobile switching center).

Note Additional icon types appear in the list for user customization.

When the MWTM discovers a single-instance node, it assigns the icon that 
corresponds to the node. When the MWTM discovers a multi-instance node, it 
assigns a separate icon for each unique instance.

Icon names include the following:

• ASP—Application server process

• BSC—Base Station Controller 1

• BTS—Base Transceiver Station 1

• Building—Icon representing a collection of network objects within a building.

• Cisco2600—Cisco 2650, Cisco 2650XM, Cisco 2651, Cisco 2651XM

• Cisco2800

• Cisco3845

• Cisco7202, Cisco7204 (Cisco 7204, Cisco 7204VXR), Cisco7206 
(Cisco 7206, Cisco 7206VXR)

• Cisco7301, Cisco7304

• Cisco7505, Cisco7507 (Cisco 7507, Cisco 7507mx, Cisco 7507z), Cisco7513 
(Cisco 7513, Cisco 7513mx, Cisco 7513z)

Field or Button Description
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Icon Name

(continued)

• Cisco 7600—Cisco 7603, Cisco 7604, Cisco 7606, Cisco 7609, Cisco 7613

• CiscoMWR1900—Cisco Mobile Wireless Router 1900

• City—Icon representing a collection of network objects within a city.

• Cloud—Collection of network objects, called a submap. A submap can also 
contain other submaps.

• Database—Icon representing a database object.

• IPDevice—IP device, other than those listed previously.

• MatedPair—Mated pair of signaling points

• MSC—Mobile switching center.

• Node B—The radio transmission/reception unit for communication between 
radio cells 1

• PGW—Cisco Public Switched Telephone Network (PSTN) Gateway (PGW) 
2200 Softswitch

• RAN_SVC—RAN Service Module in the Cisco ONS 15454

• RNC—Radio Network Controller 1

• SCP—Service control point

• SignalingPoint—An SCP, SSP, or STP, or an ITP instance

• SSP—Service switching point

• STP—Signal transfer point

• Tower—Icon representing a PC tower.

• TrafficGenerator—Icon representing a device or emulator used to generate 
traffic, usually in a test environment.

• Unknown—The MWTM is unable to determine the node or signaling point 
type.

• Workstation—Icon representing a workstation.

• Workstation2—Icon representing a different workstation.

When you click Save, the topology window is updated automatically to reflect the 
new icon.

Save Saves changes that you make to the object information, updates all MWTM 
windows to reflect your changes, and exits the dialog box.

Restore Restores changes that you make to the Name and Icon Name fields of the Edit 
Properties dialog box, and leaves the dialog box open.

Cancel Exits the dialog box without saving any changes.

Help Displays online help for the dialog box.

1. The MWTM does not manage BSC, BTS, RNC, or Node B objects but displays them in the topology window to help you 
visualize the network.

Field or Button Description
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Editing Properties for a RAN-O Backhaul
To edit the properties of a backhaul interface, right-click the backhaul object in the navigation tree or 
right pane, and choose Edit > Properties in the right-click menu.

The MWTM displays the Edit RAN Backhaul Properties dialog box (Figure 6-3).

Figure 6-3 Edit RAN Backhaul Properties Dialog

The Edit RAN Properties dialog box contains:

Field or Button Description

Name Name of the backhaul.

You can use this field to specify a new, more meaningful name for the backhaul. 

Remember that:

• You can change a backhaul’s name to a new name. A new name can contain:

– From 1 to 30 characters

– Any letters (upper- or lowercase) 

– Any numbers, as well as blank spaces ( ), dashes (-), underscores (_), or 
periods (.)

If you enter a name that is longer than 30 characters, or if you enter any other 
special characters, the MWTM beeps and retains the current name.
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Attaching Notes
You use the MWTM to annotate an object, attaching a descriptive string to it. To attach a note to an 
object, right-click the object, then choose Edit > Notes. The MWTM displays the Edit Notes dialog box.

Example:

To attach a note to a node, right-click the node in the Node table in the right pane or within a view in the 
navigation tree, then choose Edit > Notes in the right-click menu.

Name 

(continued)

• If you edit an object whose current name already contains invalid characters, 
the MWTM beeps and replaces the name with blanks. Enter a new name that 
uses only valid characters, or click Cancel to keep the existing name. If you 
click Cancel, the MWTM exits the Edit RAN Backhaul Properties dialog box 
without saving any changes to the Name, Connect Address, or Icon Name field.

When you click Save, all MWTM windows are updated automatically to reflect the 
new name.

Threshold 
Information

Pane that displays three slider bars for controlling the Acceptable, Warning, and 
Overloaded threshold settings. Left-click the slider and drag it to the desired setting 
for each threshold. See Threshold Information (RAN-O Only), page 8-42 for 
descriptions of these thresholds.

Bandwidth 
Information

Pane that displays:

• User Bandwidth (Bits/Sec)—The bandwidth that you specify for the 
backhaul. The backhaul utilization appears in the backhaul real-time chart as a 
percentage of the User Bandwidth. The preset value for the User Bandwidth is 
the same as the System Bandwidth.

When you change the User Bandwidth, you are changing the scale of the Y axis 
of the backhaul real-time chart in the Performance tab (see Viewing Backhaul 
Performance Data, page 8-126). The X and Y values of the data do not change. 
The threshold ranges resize because they are percentages of User Bandwidth.

The User Bandwidth represents 100% utilization. Data points that are higher 
than the User Bandwidth will exceed 100% utilization. The Y axis dynamically 
increases to display all data points.

• System Bandwidth (Bits/sec)—The bandwidth that the system specifies for 
the backhaul. You cannot edit this field. 

Save Saves changes that you make to the object information, updates all MWTM 
windows to reflect your changes, and exits the dialog box.

Restore Restores changes that you make to the Name, and sets the Threshold Information, 
and Bandwidth Information fields to the system defaults. The dialog box is left 
open.

Cancel Exits the dialog box without saving any changes.

Help Displays online help for the dialog box.

Field or Button Description
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Figure 6-4 Edit Notes Dialog 

The Edit Notes dialog box contains:

Viewing Notes
You use the MWTM to view any notes that are associated with an object. To view a note:

• Select an object in the navigation tree, then click the Notes tab.

• Right-click an object in a window, then choose View > Notes. (The Notes option is dimmed if no 
note is associated with the selected object.)

The MWTM displays the Notes tab for the selected object, which shows:

• Notes associated with the object.

• The date and time the notes associated with the object were last updated, or the message Not Set if 
no notes are associated with the object.

• The message No Notes if no notes are associated with the object.

Field or Button Description

Name Name of the object. You cannot edit this field.

Note Last Updated Date and time the Notes field for this object was last updated. If no note is 
currently associated with this object, this field displays the value Not Set.

You cannot edit this field.

Notes Notes to associate with this object. In this field, you can enter any important 
information about the object, such as a detailed description, location, service 
history, and so on.

Save Saves changes that you make to the object’s notes, updates all MWTM windows 
to reflect your changes, and exits the dialog box.

When you annotate an object, the MWTM displays a note icon in the Notes 
column of all object tables for the annotated object, and the topology map in the 
topology window displays a note icon in the upper-left corner of the object.

Cancel Exits the dialog box without saving any changes.

Help Displays online help for the dialog box.
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Example:

To view a note for a node, right-click the node in the Node table in the right pane or within a view in the 
navigation tree, then choose View > Notes in the right-click menu. 

Deleting Objects
After discovery, the objects in your network are known to the MWTM and added to the MWTM 
database. Physically deleting objects from your network is not the same as deleting them from the 
MWTM database. These sections describe the differences between deleting objects from your network, 
the MWTM database, and the MWTM discovery database, and the procedures for doing so:

• Deleting an Object from Your Network, page 6-36

• Deleting an Object from the MWTM Database, page 6-36

Deleting an Object from Your Network
If you physically delete a known object from your network (for example, by powering down a node), it 
remains in the MWTM database, the MWTM labels it Unknown, and the system administrator is 
responsible for deleting it from the MWTM database, if you choose to do so. 

Note For nodes, the MWTM also labels all associated network objects Unknown because the MWTM attempts 
to poll the node and gets no response. For details on polling nodes, see Polling a Node, page 8-70.

Deleting an Object from the MWTM Database
Typically, you delete an object from the MWTM database for one of these reasons:

• You physically deleted the object from your network. This is the most common reason for deleting 
a object from the MWTM database.

• The object state is one of these:

Object States Applicable To

Node Unknown, Unmanaged ITP and RAN-O networks

Interface Unknown

Signaling Point Unknown, Unmanaged ITP networks only

Linkset Unknown

Link Unknown

Application Server Unknown

Application Server Process Unknown

Application Server Process 
Association

Unknown

Signaling Gateway Mated Pair Unknown
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You are aware of the reason for the state, and you no longer want to see the object in the MWTM 
displays. For example, the object might be a test lab device, or it could be associated with an object 
that was removed from the network.

Note If an object has at least one adjacent object in Active, Discovering, Waiting, or Warning 
state, you cannot delete the object. If you try, the MWTM cancels the deletion.

• If you delete all associated connections to an Unmanaged object, the MWTM does not automatically 
delete the object. Instead, you must manually delete the object.

If you have physically deleted a known object from your network, and you then delete it from the 
MWTM, it is no longer in the MWTM database, it does not appear in MWTM windows, and it is not 
discovered when you run discovery.

If you have not physically deleted a known object from your network, and you delete it from the MWTM, 
any associated objects are also automatically deleted from the MWTM database (if applicable). 
However, at the next poll the MWTM finds the object (and any associated objects) and adds it back to 
the MWTM database, setting the status appropriately. If this happens, do not delete the object again. 
Instead, set it to Ignored. See Ignoring and Unignoring Objects, page 6-39 for more information.

To delete an object from the MWTM database, use one of these procedures:

Note If you delete an object from the MWTM database, the object is deleted for all MWTM clients and views 
that are connected to that MWTM server.

• Select one or more objects in a window, then choose Edit > Delete from the MWTM main menu.

• Right-click the object in a window, then select Delete from the right-click menu. (You cannot delete 
more than one object at a time from the right-click menu.)

The MWTM asks you to confirm the deletion. Click:

• Yes to delete the selected objects. The MWTM deletes the objects from the MWTM database.

• No to return to the window without deleting any objects from the MWTM database.

You can also enter the mwtm delete commands from the command line interface to delete one or more 
objects from the MWTM database. See mwtm delete, page B-18 for more information on the use of this 
command.

Deleting a Node from the MWTM Discovery Dialog
If you want to completely eliminate a given node from the MWTM database, you can delete it from the 
MWTM Discovery dialog box, ensuring that the MWTM never even discovers it.

Note If you delete a node from the MWTM Discovery dialog box, the node is deleted for all MWTM clients 
and views connected to that MWTM server.
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To delete a node from the MWTM Discovery dialog box:

Step 1 Choose Network > Network Discovery from the MWTM main menu. The Discovery dialog box 
appears.

Step 2 Click the Discovery tab (Figure 4-4).

Step 3 In the Discovered Nodes table, select the node that you want to delete.

Step 4 Click Delete Node. 

The MWTM deletes the nodes from the MWTM database, without asking for confirmation. The MWTM 
will no longer discover the nodes.

Unmanaging and Managing Nodes or ITP Signaling Points
You use the MWTM to change a node or any associated signaling point to the Unmanaged state. You can 
also remove the Unmanaged state from these objects.

In some situations, you might not want to a node or signaling point to appear in MWTM windows. 
However, you might be unable to delete the object from the MWTM database. For example, if:

• You have not physically deleted a known node or signaling point from your network, and you delete 
it from the MWTM, the object is removed from the poll list. However, at the next poll, the MWTM 
returns the object to the DEFAULT view. If you are using a custom view, the MWTM labels the 
object as new.

• A node has at least one adjacent node in Active, Discovering, Waiting, or Warning state; or, if a 
signaling point has at least one adjacent signaling point in Active or Warning state, you cannot delete 
the node or signaling point. If you try, the MWTM cancels the deletion.

In these situations, you can label the object as Unmanaged. When you set a node or signaling point to 
the Unmanaged state, the MWTM removes the object from the poll list.

Note If you change a node or signaling point to the Unmanaged state, the object is Unmanaged for all MWTM 
clients and views connected to that MWTM server.

To label a node or signaling point Unmanaged:

Step 1 Choose the node or signaling point in a window.

Note You cannot label a node Unmanaged if it has a Node Type of Unknown. If you select a node with 
a Node Type of Unknown, this menu option is dimmed and cannot be selected. If you select more 
than one node, and at least one of them has a Node Type of Unknown, this menu option is 
grayed-out and cannot be selected.

Step 2 Select Unmanage from the right-click menu. The MWTM labels the selected node and any associated 
signaling point(s) Unmanaged and removes them from the poll list.
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Note When you set a node or signaling point to the Unmanaged state, the events for the object will 
continue to appear in the Events window. If you want to suppress events for unmanaged objects, 
see Setting an Event Filter, page 9-8).

You can also remove the Unmanaged status from a node or signaling point, when you are ready to return 
them to the MWTM poll list. To remove the Unmanaged status from an object:

Step 1 Select the node or signaling point in a window.

Note You cannot remove the Unmanaged status from a node with a Node Type of Unknown. If you 
select a node with a Node Type of Unknown, then this menu option is dimmed and cannot be 
selected. If you select more than one node, and at least one of them has a Node Type of 
Unknown, then this menu option is grayed-out and cannot be selected.

Step 2 Select Manage from the right-click menu. The MWTM removes the Unmanaged status from the selected 
node, returns it to the poll list, and polls it immediately.

Note (ITP only) You can also remove the Unmanaged status from a signaling point, when you are ready to 
return the signaling point to the MWTM poll list. To remove the Unmanaged status from a signaling 
point, right-click a signaling point in a window, then select Manage Node from the right-click menu. 
The MWTM removes the Unmanaged status from the selected signaling point, the node associated with 
the signaling point, and all other signaling points associated with that node. The MWTM then returns 
these objects to the poll list, and polls them immediately.

Excluding Nodes or ITP Signaling Points from a View
To exclude a node or signaling point from the current view, right-click the node or signaling point in a 
window, then select Exclude from View in the right-click menu. The MWTM excludes the node or 
signaling point from the current view. See Creating a New View, page 7-9 for more information about 
excluding objects from views.

Ignoring and Unignoring Objects
You can instruct the MWTM to ignore an object when it aggregates and displays network data. Setting 
objects to Ignored prevents known problems from affecting MWTM displays for associated network 
objects. In effect, you are preventing a known problem from distracting you from other, more urgent 
network problems.

Example:

You can set a node to Ignored before shutting down the node for maintenance.
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Note If you set an object to Ignored, the object is ignored for all MWTM clients and views connected to that 
MWTM server.

Also, if you set an object to Ignored, make a note of the change, and remember to reset the object when 
the problem is corrected or the maintenance is complete.

• To set an object to Ignored:

Right-click the object, then select Ignore from the menu

or

In the object window in the right pane, check the Ignored check box.

• To display all objects that are ignored in the object window, click the Ignored column heading. The 
MWTM displays all ignored objects at the top of the table.

• To set an object to ignore in the topology window, select an object in the topology map, then, in the 
left pane, select the Ignored check box for the object you want to ignore.

• To unignore an object, right-click the object, then select Unignore from the menu.
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Note The web interface does not support the views feature. You can create customized views only in the Cisco 
Mobile Wireless Transport Manager (MWTM) client interface.

This section contains:

• Overview, page 7-1

• Viewing Basic Information for Custom Views, page 7-2

• Viewing Detailed Information for Views, page 7-5

• Editing a View, page 7-6

• Saving a View, page 7-7

• Creating a New View, page 7-9

• Loading the DEFAULT View, page 7-15

• Loading a Client-Specific View, page 7-15

• Ignoring a View, page 7-17

• Viewing Ignored Views, page 7-17

Overview
This chapter describes how to create and manage multiple views of your network from the MWTM 
client. Before creating or managing a view, you must understand the basic concepts of a default view, a 
custom view (and its associated subviews), and the navigational features available in each view:

• Default View, page 7-2

• Custom View and Subviews, page 7-2

• Viewing Basic Information for Custom Views, page 7-2
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Default View
When the Cisco Mobile Wireless Transport Manager (MWTM) discovers your network, all discovered 
objects are placed in a DEFAULT view, which is stored on the MWTM server and shared by all MWTM 
clients. Clients cannot modify the DEFAULT view that is stored on the MWTM server. This view is 
always available for users who need to view the entire network.

Initially, all clients use the DEFAULT view. However, you can use the MWTM to create your own, 
client-specific views and subviews, which are subsets of the DEFAULT view, to meet your individual 
needs.

Custom View and Subviews
You can choose the nodes you are interested in managing, exclude all other nodes from your view, and 
change the layout of the topology map in the topology window. You can save all of this customized 
information in a custom view and set that view as the new default view for the MWTM client. 

You can use the MWTM client from then on to manage only the part of the network you are interested 
in, with the settings you prefer. When you modify the DEFAULT view in any way (except for modifying 
the layout of the topology map in the topology window), the MWTM prompts you to name the new, 
custom view.

You can also create many different views and subviews on a given MWTM client, with each view 
devoted to a different aspect of the network. You can then load a different view to manage a different 
part of the network, or switch to the DEFAULT view to see the entire network. For details on creating 
views, see Creating a New View, page 7-9.

If more than one person uses a certain MWTM, each user can create a personal view.

Also, you can create subviews within any custom view. The custom view becomes the parent view of one 
or more subviews. When you load a custom view that has subviews, the MWTM displays the Views label 
under Summary Lists in the navigation tree. When you click Views, the Views table appears in the right 
pane and lists all subviews of the custom (parent) view (see Views Summary List Table, page 7-3).

Note You cannot create subviews for the DEFAULT view. Subviews are valid only for custom views.

Viewing Basic Information for Custom Views
To see all subviews currently configured within a custom view:

Step 1 Load a custom view by choosing File > Load View.

Step 2 Select a custom view from the View List in the Load File dialog box and click OK.

If the selected custom view has associated subviews, the Views label appears under Summary Lists in 
the navigation tree.

Step 3 Click the turner beside Summary Lists, then click Views. 

The View Summary List window appears.
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Figure 7-1 View Summary List Window

The View Summary List window provides information about all subviews that have been defined for this 
custom view, including their status and other important information.

The View Summary List window contains these sections:

• Right-Click Menu for Views, page 7-3

• Views Summary List Table, page 7-3

Related Topics:

• Viewing Detailed Information for Views, page 7-5

• Navigating Table Columns, page 5-23

Right-Click Menu for Views
To see the right-click menu for views, under Summary Lists, select Views and right-click the mouse. For 
details on menu options, see Viewing the Right-Click Menu for an Object, page 8-3.

Note If the Views label does not appear under Summary Lists, you have loaded the DEFAULT view or a 
custom view that has no subviews.

Views Summary List Table
The views table shows information about the subviews that have been defined for a custom view. If a 
custom view has no subviews, this option is not available.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Status, and the MWTM shows all of the columns in the view table except Internal 
ID.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.
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The view table contains:

Column Description

Internal ID Internal ID of the view. The internal ID is a unique ID for every object, 
assigned by the MWTM for its own internal use. It can also be useful when 
the TAC is debugging problems.

Name Name of the subview that belongs to the custom (parent) view.

Parent View Name of the custom or parent view to which the subview belongs.

Ignored Indicates whether the subview should be included when aggregating and 
displaying MWTM status information:

• Check the check box to ignore the subview. 

• Uncheck the check box to include the subview. This is the default 
setting.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Notes Indicates whether a note is associated with the subview.

Events Indicates whether a recent event associated with a network object in the 
subview. (Even if the server purges all of the events associated with objects 
in the subview, the MWTM continues to display the event icon in this field.) 
To delete the event icon (orange triangle) from MWTM displays for:

• A specific subview, select the subview and click the icon.

• All subviews, choose Edit > Clear All Events from the MWTM main 
menu.

Note During Discovery, the MWTM might flag most views with an event 
icon. If the event icons are too distracting, use the Edit > Clear All 
Events menu option to remove them.

Changing a view (for example, by ignoring it or attaching a note to 
it) does not generate an event, and therefore does not cause an event 
icon to appear in this field.

Deleting an application server process, node, or signaling point with 
the Delete menu option does not generate an event, and therefore 
does not cause an event icon to appear in this field. However, if the 
MWTM rediscovers a deleted application server process, node, or 
signaling point, events are generated and logged for the deletion and 
the rediscovery, and the event icon appears in this field.

Last Status Change Date and time that the status of the subview last changed.
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Viewing Detailed Information for Views
The MWTM can display detailed information about a selected view, including its associated objects, 
status, and other information.

Updates for the view that are received from the MWTM server are reflected automatically in this 
window.

To display detailed information for a view, click the name of the view in the MWTM main window 
navigation tree. For example, to see detailed information for the DEFAULT view in the right pane, click 
DEFAULT View in the navigation tree.

Status Current status of the subview. Possible values are:

Active (green)

Unmanaged (gray)

Warning (yellow)

For detailed definitions of each status, see Appendix E, “Status Definitions.”

Status Reason Reason for the current status of the subview.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file resides at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file reside in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description
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Figure 7-2 View Details Window

The View Details window contains:

Editing a View
For details on editing a view, see Editing Properties, page 6-29.

 Function or Tab For More Information

Right-click menu Viewing the Right-Click Menu for an Object, page 8-3.

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44

Alarms Displaying Alarms, page 4-30
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Saving a View
You use the MWTM to save a specific view, change the list of views, and select one view to be loaded 
automatically when the associated preferences file is saved.

When you are satisfied with the changes you made to a view, use one of these procedures to save the 
view:

• To save the changes you made to the view without changing the name of the file, choose File > Save 
from the View Editor window menu.

Note You cannot save changes to the DEFAULT view. If you are currently using the DEFAULT view 
and you choose File > Save, the MWTM shows the Save File Dialog: View List dialog box 
(Figure 7-3).

• To save the changes you made to the view with a new name, choose File > Save As from the 
Discovery Dialog menu. The MWTM shows the Save File Dialog: View List dialog box 
(Figure 7-3).

The MWTM stores the view in the view file directory on the MWTM server:

• If you installed the MWTM in the default directory, /opt, then the MWTM view file directory is 
/opt/CSCOsgm/views.

• If you installed the MWTM in a different directory, then the MWTM view file directory resides in 
that directory.

Note If another user modifies and saves the view before you save your changes, the MWTM asks if you want 
to overwrite that user’s changes. If you choose to do so, the other user’s changes are overwritten and lost. 
If you choose not to do so, your changes are lost, unless you save the view to a different filename.

Figure 7-3 Save File Dialog: View List Dialog
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The Save File Dialog: View List contains:

Field or Button Description

Create New Folder Click this icon to create a new folder in the current directory. 
This action opens the Input dialog box. 

Enter a folder name and click OK. The new folder appears in 
the Save File dialog box. 

Double-click the folder to open it. You can save files in this 
folder or create another folder at this level.

Go Up One Folder Click this icon to go up one folder in the directory structure.

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the view file or folder.

Last Modified Date and time the view file or folder was last modified.

Size (bytes) Size of the view file or folder, in bytes.

Filename Name by which you want to save the view. You must specify 
a name other than DEFAULT view. You cannot save changes 
to the DEFAULT view.

When you create a new view filename, you can use any 
letters, numbers, or characters in the name that are allowed by 
your operating system. However, if you include any spaces in 
the new name, the MWTM converts those spaces to dashes. 
For example, the MWTM saves file a b c as a-b-c.

Make this my preferred startup option Specifies whether the selected view should be loaded 
automatically whenever the associated preferences file is 
loaded. To load the:

• Saved view, select the view, then check this check box.

• Last-used view, uncheck the check box. This is the 
default setting.

OK Saves any changes you made to the current named view or to 
the list of views and closes the dialog box.

To save the view with a new name, use one of these 
procedures. To save the file with:

• A completely new name, enter the new name and click 
OK.

• An existing name, overwriting an old view, select the 
name in the list and click OK.

The MWTM saves the view with the new name, closes the 
Save File Dialog: View List dialog box, and returns to the 
Discovery dialog box.

To save any changes you made to the list of files, click OK. 
The MWTM saves the changes and closes the Load File 
Dialog: View List dialog box.
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Creating a New View
You use the MWTM to specify the nodes and objects you want to see in MWTM displays. This view is 
called a client-specific network view. All changes you make are reflected in topology tables and maps 
as soon as you make the changes.

Before creating a client-specific network view, ensure that Discovery has been run at least once, and data 
appears in the server’s MWTM database. See Discovery Overview, page 4-4 for details.

To create a client-specific network view, choose Edit > Views from the MWTM main menu. The View 
Editor window appears.

Figure 7-4 View Editor Window

The View Editor window shows two tabs:

• The Edit View tab provides:

– All objects that are in the current view.

– All objects that have been excluded from the current view.

– New objects that the MWTM found.

• The Import Views tab provides:

– All views currently defined on this MWTM client.

– Data about the views.

Delete Deletes the selected file from the view list. The MWTM 
issues an informational message containing the name and 
location of the deleted file.

Cancel Closes the dialog box without saving the view or any changes 
to the view list.

Help Shows online help for the dialog box.

Number of Files
(visible in bottom left corner)

Total number of view files and folders.

Field or Button Description
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You use the View Editor window also to move objects into and out of the current view. All changes that 
you make in this window are reflected in the MWTM client, and in the topology tables and maps as soon 
as you make the changes.

The View Editor window contains:

• View Editor Window Menu, page 7-10

• Objects In Current View, page 7-11

• Excluded from View Pane, page 7-13

• New on the Network Pane, page 7-13

• Views List Pane, page 7-14

• View Data Pane, page 7-14

• Directory Listing Pane, page 7-15

• Closing the View Editor Window, page 7-15

Related Topic:

Chapter 10, “Viewing Network Topology”

View Editor Window Menu
The menu on the View Editor window contains:

Menu Command Description

File > Load 
DEFAULT View

Loads the DEFAULT view, which is the view into which the MWTM places all 
discovered objects when discovering the network. The DEFAULT view is stored 
on the MWTM server, where all MWTM clients share the view; but cannot 
modify it.

File > Load
(Ctrl-L)

Loads an already existing view.

If you have already saved a view and you want to change it, choose the File > 
Load menu option. The MWTM prompts you for the name of the view you want 
to load:

• Select the name of the view, or accept the default view name, then click OK 
to load the view.

• Click Cancel to close the prompt window without loading a view.

File > Save
(Ctrl-S)

Saves the current view. If you have:

• Not already saved the current view, opens the Save File Dialog: View List, 
which you use to enter or select a filename under which to save the current 
view.

• Already saved the current view, saves the view to that filename.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.
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Objects In Current View
The navigation tree in the left pane of the View Editor window lists nodes that the current view contains.

To see the objects that are associated with a node, and that are in the current view, click the turner beside 
the node.

To exclude any of these objects from the current view, select them in the navigation tree, then choose 
Edit > Exclude From View from the View Editor window to move them to the Excluded From View 
pane of the View Editor window.

File > Save As Opens the Save File Dialog: View List, which you use to save changes you made 
to the selected view with a new name, or overwrite an existing seed file. The view 
is updated immediately in the MWTM client.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

File > Close
(Ctrl-W)

Closes the View Editor window.

If you have modified the view, the MWTM asks if you want to save your changes. 
Click:

• Yes to save your changes to the current view.

• No to keep the current view as-is, without applying any changes. The 
MWTM closes the View Editor window.

• Cancel to close the prompt window and return to the View Editor window 
without applying any changes to the current view.

Edit > 
Create Subview
(Ctrl-N)

Creates a new subview for the selected view or subview. Enter a name for the new 
subview.

Edit > Rename 
View
(Ctrl-R)

Renames the selected view. The new name can be from 1 to 30 characters, and 
can contain any letters, numbers, or special characters.

Edit > Include In 
View
(Ctrl-I)

Includes the selected object in the view.

Edit > Exclude 
From View
(Alt-X)

Excludes the selected object from the view. The MWTM also excludes the object 
and associated objects from the topology map.

If you exclude all of the objects associated with a node, the node is excluded, too.

Edit > Delete View
(Ctrl-D)

Deletes the selected view.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.

Menu Command Description
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Note If you are using an MWTM client with the DEFAULT view set, the MWTM automatically adds all newly 
discovered objects to the navigation tree as soon as they are discovered.

If you delete an object, the MWTM removes it from the navigation tree. If the MWTM then discovers 
the object, the MWTM places it in the New on the Network pane. To see this object again in your current 
view, you must move it into the navigation tree using Edit > Include In View from the View Editor 
window.

The navigation tree in the View Editor window provides these right-click menus:

• Right-Click Menu for a View, page 7-12

• Right-Click Menu for a Subview, page 7-12

• Right-Click Menu for an Object, page 7-12

Right-Click Menu for a View

The right-click menu for a view in the navigation tree of the View Editor window provides these options:

Right-Click Menu for a Subview

The right-click menu for a subview in the navigation tree of the View Editor window contains:

Right-Click Menu for an Object

The right-click menu for an object in the navigation tree of the View Editor window provides this option:

Menu Command Description

Create Subview Creates a new subview for the selected view. Enter a name for the new subview.

Rename View Renames the selected view. The new name can be from 1 to 30 characters, and 
can contain any letters, numbers, or special characters.

Menu Command Description

Create Subview Creates a new subview for the selected subview. Enter a name for the new 
subview.

Rename View Renames the selected subview. The new name can be from 1 to 30 characters, and 
can contain any letters, numbers, or special characters.

Delete From View Deletes the selected subview from the view or subview.

Export View Opens the Save File Dialog: View List dialog box (Figure 7-3), which you use to 
save the subview as a unique view.

Menu Command Description

Exclude From View Excludes the selected object, and any lower-level associated objects, from the 
view or subview. This action also excludes the object from the topology map.
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Excluded from View Pane
The Excluded from View pane lists the objects that have been excluded from the current view. To add 
these objects to the current view, select them in the Excluded from View pane, then choose Edit > 
Include In View from the MWTM main menu to move them to the navigation tree of the View Editor 
window.

The Excluded from View pane provides this right-click option for an object:

New on the Network Pane
The New on the Network pane shows newly discovered objects, based on these criteria. If you are using 
an MWTM client with:

• The DEFAULT view set, this table never contains any objects. In the DEFAULT view, the MWTM 
adds all newly discovered objects to the navigation tree in the View Editor window as soon as they 
are discovered.

• A custom view set, this table contains all objects discovered since the View Editor window was 
opened in this session that have not been excluded in the Excluded from View pane or that are not 
in the current view.

When the MWTM discovers one or more new objects in the network, the MWTM also:

• Broadcasts the discovery of the new objects to all MWTM clients.

• Shows a New icon in the bottom of most MWTM windows. Clicking the New icon in the topology 
window opens the New Objects pane in the left pane. Clicking the New icon in any other window 
opens the Edit View tab of the View Editor window.

• Adds graphical elements for the newly discovered objects to the New Objects pane in the left pane 
of the topology window. For more information, see Printing the Topology Map, page 10-18.

To add a newly discovered object to the current view, select one or more objects in the New on the 
Network pane, then choose Edit > Include In View from the MWTM main menu to move them to the 
navigation tree in the View Editor window.

To exclude a newly discovered object from the current view, select one or more objects in the New on 
the Network pane, then choose Edit > Exclude From View from the MWTM main menu to move them 
to the Excluded From View pane of the View Editor window.

The New on the Network pane provides these right-click options for an object:

Menu Command Description

Include In View Includes the selected object, and any lower-level associated objects, in the 
selected view or subview.

Menu Command Description

Include In View Includes the selected object, and any lower-level associated objects, in the 
selected view or subview.

Exclude From View Excludes the selected object, and any lower-level associated objects, from the 
view or subview. The MWTM also removes the object from the topology map.
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Views List Pane
The Views List pane is under the Import Views tab of the View Editor window. The Views List pane lists 
all views that are currently defined on this MWTM client. If you have no views defined, this list will be 
empty.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Name, and the MWTM shows all of the columns in the Views List pane.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Views List pane contains these columns:

The Views List pane provides these right-click menu option for views:

The Views List pane provides these right-click menu option for folders:

View Data Pane
The View Data pane lists all subviews and objects that are in the view that is selected in the Views List 
pane. If you have not saved a view yet, and there are no views in the Views List pane, this pane does not 
appear.

The View Data pane provides these right-click menu option for views and subviews:

Column Description

Type Indicates whether the selected name is a directory or a file.

Name Name of the view.

Last Modified Date and time the view was last modified.

Size (bytes) Size of the view in bytes.

Menu Command Description

Import View Copies the selected view into the view or subview that is currently selected in the 
navigation tree of the View Editor window.

Delete View Deletes the selected folder, view, or subview. (You can delete a folder only if it 
contains no views or subviews.)

Menu Command Description

Open View Opens the selected folder, displaying views contained in the folder in the Views 
List pane.

Menu Command Description

Import View Copies the selected view or subview into the view or subview that is currently 
selected in the navigation tree of the View Editor window.
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Directory Listing Pane
The Directory Listing pane lists all subfolders that are in the folder that is selected in the Views List 
pane. If the Views List pane contains no views, or if a folder (not a file) exists in the Views List pane, 
the Directory Listing pane appears. If the Views List pane contains only files, the Directory Listing pane 
does not appear.

To see the Directory Listing pane, select a folder in the Views List pane.

Closing the View Editor Window
To close the View Editor window at any time, click File > Close. If you have modified the view, the 
MWTM asks if you want to apply the changes before leaving the window. Click:

• Yes to apply the changes to the current view. The MWTM applies the changes to all MWTM 
windows immediately. The MWTM then asks if you want to make this the default view. Click:

– Yes to make this view the new default view. In the future, when this client is started, this will 
be the default view.

– No to retain your old default view.

The MWTM closes the View Editor window.

• No to keep the current view unchanged, without applying any changes. The MWTM closes the View 
Editor window.

• Cancel to close the prompt window and return to the View Editor window without applying any 
changes to the current view.

If you are working in a custom view (that is, not in the DEFAULT view) and you exit the MWTM client, 
the MWTM automatically saves any changes you made to the view.

Loading the DEFAULT View
To load the DEFAULT network view, choose File > Load DEFAULT View from the MWTM main 
menu. You might be prompted to save the view in which you currently are. Once you have chosen 
whether to save your current view, the MWTM loads the DEFAULT view. 

Note Any custom views are saved in the View Editor window (Import Views tab) under the Edit > Views 
option in the MWTM main window.

Loading a Client-Specific View
You use the MWTM to load a specific view, change the list of views, and select one view to be loaded 
automatically when the associated preferences file is loaded.

To load a client-specific network view, choose Edit > Views from the MWTM main menu. The View 
Editor window appears (Figure 7-4). Then choose File > Load from the View Editor window menu. The 
MWTM shows the Load File Dialog: View List dialog box.
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Figure 7-5 Load File Dialog: View List Dialog

The Load File Dialog: View List contains:

Field or Button Description

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the view file or folder.

Last Modified Date and time the view file or folder was last modified.

Size (bytes) Size of the view file or folder, in bytes.

Make this my preferred start option Specifies whether the selected view should be loaded 
automatically whenever the associated preferences file is 
loaded. To load the:

• Selected view, select the view, then check this check box.

• Last-used view, uncheck the check box. This is the 
default setting.

Number of Files
(visible in bottom left corner)

Total number of view files and folders.

OK Loads the selected view, saves any changes you made to the 
list of views, closes the dialog box, and returns to the View 
Editor window.

To load a view, double-click it in the list, select it in the list 
and click OK, or enter the name of the view and click OK. 

Note If the network elements belonging to a client-specific 
view have been removed from the network, a message 
appears when you load the view. The message warns 
you that the network elements have been removed 
from the view. To prevent the warning from being 
issued the next time you load the view, save the view 
using the same name (File > Save from the View 
Editor window).
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Ignoring a View
You can instruct the MWTM to ignore a view when it aggregates and shows network data. Setting views 
to Ignored prevents known problems in the views from affecting MWTM displays for associated objects. 
In effect, you are preventing a known problem from distracting you from other, more urgent network 
problems.

For example, you can set a view to Ignored before shutting down objects in the view for maintenance.

Note If you set a view to Ignored, the view is ignored for only the current MWTM client.

Also, if you set a view to Ignored, make a note of the change, and do not forget to reset the view when 
the problem is corrected or the maintenance is complete.

You cannot ignore the DEFAULT view.

To set a view to Ignored, check the Ignored check box in the View window for the view you want the 
MWTM to ignore.

Viewing Ignored Views
To display all views that are Ignored, display the View window and click the Ignored column heading. 
The MWTM shows all ignored views at the top of the table.

Delete Deletes the selected file from the view list. The MWTM 
issues an informational message containing the name and 
location of the deleted file.

Cancel Closes the dialog box without loading a view or saving any 
changes to the view list.

Help Shows online help for the dialog box.

Field or Button Description
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Understanding Detailed Object Functions

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to view detailed information about 
any discovered MWTM object, including its associated objects, status, notes, events, and so on.

To display detailed information for an object, click the turner beside a view in the navigation tree of the 
MWTM main window, then select one of these objects:

Note Objects only appear if your network contains that particular object type.

Object Applicable Network Type

Nodes ITP and RAN-O

Signaling Points

Note In a multi-instance network, the signaling 
point name has the format 
pointcode:instanceName.

In a multi-instance network, the MWTM 
does not display signaling points that are 
only partly configured (that is, the variant 
and network name are configured, but not 
the primary point code).

ITP only

Linksets

Links

Application Servers

Application Server Processes

Application Server Process Associations

Signaling Gateway Mated Pairs

Interfaces ITP and RAN-O

Cards RAN-O only

RAN Backhauls

RAN Shorthauls
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The MWTM displays detailed tabular information within the content area for the selected object.

Note Updates for the object received from the MWTM server are automatically reflected in the tabs.

This chapter contains:

• Viewing the Right-Click Menu for an Object, page 8-3

• Deploying a File Associated with an ITP Node or Signaling Point, page 8-8

• Viewing Status Contributors, page 8-8

• Viewing Details, page 8-12

• Viewing Troubleshooting, page 8-42

• Viewing Recent Events, page 8-44

• Using ITP Provisioning, page 8-49

• Viewing Data for Nodes, page 8-52

• Viewing Real-Time Data for an Object, page 8-73

• Viewing ITP Linkset Access Lists, page 8-101

• Viewing Data Specific for ITP Signaling Points, page 8-103

• Viewing RAN-O Performance and Error Data, page 8-123

• Viewing RAN Shorthauls, page 8-136

• Creating Virtual RAN Backhauls, page 8-136

Note For details on viewing notes, see Viewing Notes, page 6-35.

Management Interfaces folder ITP and RAN-O

Physical folder

Object Applicable Network Type
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Viewing the Right-Click Menu for an Object
Right-clicking on any object within an MWTM view, summary list, or topology map provides you with 
numerous menu options.

Example:

To see the right-click menu for a node, select a node in the navigation tree and right-click the mouse 
button. 

These right-click menu options might be available on a given MWTM object:

Menu Command Description

Show In New Window Opens the Details window for the selected object in a new 
window.

Edit > Properties Opens the Edit Properties dialog box for the selected node 
or ITP signaling point.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Edit > Notes Opens the Edit Notes dialog box for the selected object.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Edit > SNMP IP Addresses Opens the Edit SNMP IP Addresses dialog box for the 
selected node.

This option is dimmed if the selected node has no 
associated SNMP IP addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Edit > Route Table (ITP only) Opens the Route Table dialog box, using a route table from 
the signaling point.

This option is not available if the node associated with 
selected signaling point is in Unknown or Unmanaged 
status.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Clear Event Icon Deletes the event icon from MWTM displays for the 
selected object, for this MWTM client only. The MWTM 
does not delete the actual events, but deletes only the event 
icon for the selected object for this MWTM client.

This option is dimmed if the selected object has no 
associated event icon.
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Delete Deletes the currently selected object from the MWTM 
database. The MWTM displays the Confirm Deletion 
dialog box. To:

• Delete the selected object, click Yes. The MWTM 
deletes the object from the MWTM database and 
closes the Confirm Deletion dialog box.

• Retain the selected object, click No. The MWTM 
retains the object in the MWTM database and closes 
the Confirm Deletion dialog box.

Note (ITP only) If you delete all linksets to an 
Unmanaged node, the MWTM does not 
automatically delete the node. Instead, you must 
manually delete the node. See Deleting Objects, 
page 6-36 for more information.

• Prevent the MWTM from displaying the Confirm 
Deletion dialog box, check the Do not show this again 
check box.

Note If you check the Do not show this again check box, 
and later you decide you want the MWTM to begin 
displaying the Confirm Deletion dialog box again, 
you must check the Confirm Deletions check box in 
the General GUI settings in the Preferences 
window. For more information, see the description 
of the Confirm Deletions check box in Startup/Exit 
Settings, page 5-4.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Go to > Object Navigates to the parent or peer (if applicable) window(s) 
for the selected object.

Back > List of windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of windows Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Show Peer (only for RAN Backhauls and 
RAN Shorthauls)

Shows the peer of the RAN backhaul or shorthaul that you 
select in the right pane. 

View > Status Contributors Displays the Status Contributors pane for the selected 
object. Objects in this pane contribute to the status of the 
selected object.

View > Details Displays the Details pane for the selected object.

View > Notes Displays the Notes pane for the selected object.

If no notes are associated with the selected object, this 
option is dimmed.

Menu Command Description
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View > Troubleshooting Displays the Troubleshooting pane for the selected object. 

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

View > Recent Events Displays the Recent Events pane for the selected object and 
any associated network objects.

View > Alarms Displays the Alarms pane for the selected view.

View > Real-Time Data and Charts Displays the MWTM Real-Time Statistics window for the 
selected object.

This option is not available if the object has no real-time 
charts or if the object status is Unknown or Unmanaged.

View > Center in Topo Opens the topology window and displays the object in the 
center of the topology map.

Archived Events > Status Changes Displays the archived status changes in a web browser. 

Archived Events > SNMP Traps Displays the archived SNMP traps in a web browser.

Archived Events > Status Changes and 
SNMP Traps

Displays both the archived status changes and archived 
SNMP traps in a web browser.

Ignore Ignores the selected object at the next polling cycle.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Unignore Stops ignoring the selected object at the next polling cycle.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 2) and higher.

Performance History

(RAN-O backhauls and shorthauls only)

Displays historical performance charts for the selected 
RAN-O backhaul or shorthaul in a web browser.

Error History

(RAN-O backhauls and shorthauls only)

Displays historical error charts for the selected RAN-O 
backhaul or shorthaul in a web browser.

Create Virtual RAN Backhaul

(RAN-O backhauls only)

Opens the Virtual RAN Backhaul Editor. For details, see 
Creating Virtual RAN Backhauls, page 8-136.

Drill-Down > List of windows Opens a specific tab for the selected object. Tabs listed start 
a poller.

This option is not available if the node is in Unknown or 
Unmanaged status.

Latest Reports Opens the latest reports for the object in a Web browser. 
For details on reports, see Chapter 12, “Managing ITP 
Reports.”

This option is not available if the node is in Unknown or 
Unmanaged status.

Provision Opens the web interface to the Provision tab of the selected 
object (see Using the Provisioning Wizard, page 8-50). 

Menu Command Description
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These menu options are available on nodes or ITP signaling points:

Node > Home Page Displays the home page of the node in a new web browser 
window. 

This option is dimmed if the selected node is not an ITP or 
RAN-O node. This option does not appear in the right-click 
menu for Cisco Optical Networking System (ONS) nodes.

Node > Launch CTC (ONS nodes only) Launches the Cisco Transport Controller (CTC) for 
managing ONS nodes. For more information about using 
the CTC, refer to the CTC Launcher Application Guide 
(http://www.cisco.com/en/US/products/hw/optical/ps2006
/prod_configuration_guide09186a008051ea52.html).

This option appears only for ONS nodes.

Node > Connect To Links to the node. 

This option is dimmed if the selected node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Poll Node > Normal Poll Polls all selected nodes or ITP signaling points, retaining 
all currently known objects.

Normal Poll retains all objects associated with polled 
nodes or signaling points, even objects that have been 
deleted and are, therefore, in Unknown status.

This option is dimmed if the selected node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Poll Node > Clean Poll Polls all selected nodes or ITP signaling points and 
removes any Unknown network objects after the 
completion of the poll.

Clean Poll removes all network objects from the node or 
signaling point at the completion of the poll.

This option is dimmed if the selected node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Operator (level 3) and higher.

Allow Trap Processing Enables the MWTM to process traps from the selected 
node. This is the default setting.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 4) and higher.

Menu Command Description

http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_configuration_guide09186a008051ea52.html
http://www.cisco.com/en/US/products/hw/optical/ps2006/prod_configuration_guide09186a008051ea52.html
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Disallow Trap Processing Prevents the MWTM from processing traps from the 
selected node.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level Power 
User (level 4) and higher.

Unmanage Labels the selected node or signaling point Unmanaged.

Note If you change a node to the Unmanaged status, the 
MWTM removes adjacent legacy nodes from the 
topology map.

You cannot label a node or signaling point Unmanaged if it 
has a Node Type of Unknown. If you select a node or 
signaling point with a Node Type of Unknown, then this 
menu option is dimmed and cannot be selected.

This option is dimmed if the selected node has no IP 
addresses.

Events for unmanaged objects will continue to appear in 
the Events window. To suppress events for unmanaged 
objects, set this option using an event filter (Setting an 
Event Filter, page 9-8).

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Manage Removes the Unmanaged status from the selected node or 
signaling point.

Note If you change a node to the Managed status, the 
MWTM adds adjacent legacy nodes back to the 
topology map.

You cannot remove the Unmanaged status from a node with 
a Node Type of Unknown. If you select a node with a Node 
Type of Unknown, then this menu option is dimmed.

This option is dimmed if the selected node has no IP 
addresses.

If you have implemented MWTM User-Based Access, this 
option is available to users with authentication level 
Network Administrator (level 4) and higher.

Exclude from View Excludes the selected node or signaling point from the 
current view. See Creating a New View, page 7-9 for more 
information about excluding objects.

The MWTM removes excluded objects and their associated 
objects from the topology map (see Excluded Objects Tab, 
page 10-11).

Menu Command Description
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Deploying a File Associated with an ITP Node or Signaling Point
You use the MWTM to deploy a GTT file or route table file associated with an ITP node or signaling 
point. To do so, right-click the ITP node or signaling point in a window, then choose Deploy Object > 
From Archive or From File in the right-click menu. The MWTM launches the Deployment Wizard for 
the selected ITP node or signaling point. See Deploying a Route Table File, page 13-13 and Deploying 
a GTT File, page 14-40 for more information.

Viewing Status Contributors
The Status Contributors section displays information about conditions that contribute to the overall 
status of the selected object. To view the Status Contributors section, select a view in the navigation tree, 
select an object, and then click the Status Contributors tab in the right pane.

Example:

To display the Status Contributors section for a node, within a view, select a node in the navigation tree, 
then click the Status Contributors tab in the right pane.

This section contains:

• Inventory Items

• Supplemental Alarms

Deploy Object > From Archive 
(ITP only)

Launches the Deployment Wizard for the selected node or 
ITP signaling point. See Deploying a File Associated with 
an ITP Node or Signaling Point, page 8-8 for more 
information about deploying to nodes or ITP signaling 
points.

Deploy Object > From File 
(ITP only)

Launches the Deployment Wizard for the selected node or 
ITP signaling point. See Deploying a File Associated with 
an ITP Node or Signaling Point, page 8-8 for more 
information about deploying to nodes or ITP signaling 
points.

Menu Command Description
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Figure 8-1 Status Contributors Tab

Inventory Items

Note The right pane lists all objects of the object type that you select in the navigation tree. To see the fully 
qualified domain name (FQDN) of any object in the right pane, hover over the object name with the 
mouse. A tooltip lists the FQDN for the object.

To see which object types pertain to the Status Contributors tab, see Appendix A, “Object Map 
Reference.” If the object does not have any associated objects, the Status Contributors tab will not 
appear.

The right pane contains a table of inventory items that contribute to the overall status of the selected 
object. You can resize each column, or sort the table based on the information in one of the columns. By 
default, the MWTM displays all of the columns except Internal ID.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Status Contributors table contains:

Column Description

Internal ID Internal ID of the object. The internal ID is a unique ID for every object, 
assigned by the MWTM for its own internal use. It can also be useful when 
the TAC is debugging problems.

Name Name of the object.

Object Type Type of network object.
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Ignored Indicates whether the object should be included when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the object. This is the default setting.

• Check the check box to exclude the object.

This field can be edited by users with authentication level Power User 
(level 2) and higher.

Notes Indicates whether a note is associated with the object.

Events Indicates whether the object has an associated recent event. (Even if the 
server purges all of the events associated with the object, the MWTM 
continues to display the event icon in this field.) To:

• Delete the event icon (orange triangle) from MWTM displays for a 
specific object, select the object and click the icon.

• Delete the event icon from MWTM displays for all objects, choose Edit 
> Clear All Events from the MWTM main menu.

Note During Discovery, the MWTM might flag objects with an event icon. 
If the event icons are too distracting, use the Edit > Clear All Events 
menu option to remove them.

Last Status Change Date and time that the status of the object last changed.

Status Current status of the object. Possible values are:

Active (green)

Blocked (red)

Discovering(cyan)

Down(red)

Failed (red)

Inactive(red)

Inhibited(blue)

InhibitLoc (blue)

InhibitRem (blue)

None(black)

Not Present(gray)

Column Description
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Supplemental Alarms
The Supplemental Alarms section contains a table that lists a category of alarms that you can manage 
with the same tools that the MWTM provides for event management. 

Note Trap event configuration settings (Raise Alarm and Correlate check boxes) determine whether the 
MWTM displays supplemental alarms for specific events. See Configuring Trap, Status Alarm, or User 
Action Events, page 9-36.

The Supplemental Alarms section provides the same tools and tabular information that the MWTM 
provides for events. For information about the tools, see Event Toolbar Buttons, page 9-3. For 
information about the columns that appear in the Supplemental Alarms table, see Event Table, page 9-5.

Status (continued) Old Unmanaged(black)

Pending(red)

Polling(cyan)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Unmanaged (gray)

Waiting(gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Status Reason Reason for the current status of the object.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is 
located at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The MWTM lists status reasons in order of decreasing magnitude. If two or 
more reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description
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Note The Supplemental Alarms table displays the Count (number of times that an alarm occurs) and Change 
Time (the most recent alarm update) columns by default. In the Events table, these columns are hidden. 

Viewing Details
The Details section displays information such as naming and status details for the selected object.

To view the Details section, select a view in the navigation tree, select an object, then click the Details 
tab in the right pane. 

Note If the selected object is a link, linkset, signaling gateway-mated pair, RAN-O backhaul or shorthaul, the 
Details tab displays both peers of the selected object in adjacent panes for easy comparison.

Example:

To display the Details section for a node, within a view, select a node in the navigation tree, then click 
on the Details tab in the content area.

Figure 8-2 Details Tab

The Details tab contains these sections (in alphabetical order):

Section Applicable Object(s) Applicable Network Type(s)

Address Information Interfaces ITP and RAN-O

Association Information Application Servers ITP only

Bandwidth Information Backhauls RAN-O only

Capability Point Code Signaling Points ITP only

Description Linksets, Signaling Points
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Tip If the pair of a link, linkset, or signaling gateway-mated pair is Unknown, and if the peer of a backhaul 
or shorthaul is Unknown, Unknown appears for the pair or peer fields in the Details tab.

Address Information
The Address Information section for interfaces contains:

Descriptive Information Cards, Nodes ITP and RAN-O

General Information Application Servers, Application 
Server Process Associations, 
Interfaces, Linksets, Shorthauls

Interface Information Links, Signaling Gateway Mated 
Pairs

ITP only

IP Addresses for SNMP
or
IP Addresses Not for SNMP

Nodes ITP and RAN-O

Links Information Linksets ITP only

Local IP Address Information Application Server Processes, 
Application Server Process 
Associations, Links, Signaling 
Gateway Mated Pairs

Naming Information All objects ITP and RAN-O

Point Code Signaling Points ITP only

Polling Information Nodes ITP and RAN-O

Protection Information Cards, ONS Nodes RAN-O only

QoS Information Signaling Points ITP only

RAN Information Interfaces, Shorthauls RAN-O only

Remote IP Address Information Application Server Process 
Associations, Links, Signaling 
Gateway Mated Pairs

ITP only

Status Information All objects ITP and RAN-O

Threshold Information (RAN-O 
Only)

Backhauls, Nodes RAN-O only

Uptime Information Nodes ITP and RAN-O

Section Applicable Object(s) Applicable Network Type(s)

Field Description

IP Address List of IP addresses that are assigned to the interface.
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Association Information
The Association Information section for ITP application servers contains:

Bandwidth Information
The Bandwidth Information section for RAN-O backhauls contains:

Capability Point Code
The Capability Point Code section for ITP signaling points contains:

Field Description

Number of ASPAs Number of application server process associations that are associated 
with this application server.

Number of Active ASPAs Number of active application server process associations that are 
associated with this application server.

Field Description

User Bandwidth (bits/sec) Bandwidth that the user specifies for the backhaul. By default, the user 
bandwidth is the same as the system bandwidth.

Note When you change the User Bandwidth (see Editing Properties 
for a RAN-O Backhaul, page 6-33), you are changing the scale 
of the Y axis of the backhaul real-time chart in the Performance 
tab (see Viewing Backhaul Performance Data, page 8-126). The 
X and Y values of the data do not change. The threshold ranges 
resize because they are percentages of User Bandwidth.

System Bandwidth (bits/sec) Bandwidth that the system specifies for the backhaul. You cannot edit 
this field.

Column Description

Point Code Capability point code of the signaling point.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC
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Description
The Description section contains a description of the ITP signaling point or linkset. If the signaling point 
or linkset has no description, this section is blank. If the linkset is unknown, Unknown appears in the 
Description section.

Descriptive Information
The Descriptive Information section for nodes and ONS cards contains:

Network Indicator Determines the type of call. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates networks.

Network Name Name of the network associated with the signaling point.

Column Description

Field Description

Software 
Description

Comprehensive information about the software that is installed on the node.

Software Version Version of software (for example, the ONS package or IOS version) that is 
installed on the node.

Description Full description of the ONS card (for example, RAN_SVC_LINE_CARD).

Hardware Version Version of the hardware of the ONS card (for example, VID=000, HwRev=29).

Firmware Version Version of the firmware on the ONS card, if applicable (for example, 12.2(24)St).
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General Information
The General Information section applies to these objects:

• Interfaces, page 8-16

• ITP Application Servers, page 8-16

• ITP Linksets, page 8-17

Interfaces

The General Information section for interfaces contains:

ITP Application Servers

The General Information section for ITP application servers contains:

Field Description

Maximum Packet 
Size

Maximum packet size on the interface in bytes.

Speed (Bits/Sec) Interface speed in bits per second.

Field Description

Protocol Protocol associated with the application server. Possible values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

QoS Quality of service (QoS) class of the application server.

Routing Key Routing key associated with the application server. The routing key is the 
value that determines the routing decisions that the application server makes.

Traffic Mode Method by which the application server forwards requests to its active 
application server processes. Possible values are:

• overRide—One application server process takes over all traffic for the 
application server, possibly overriding any currently active 
application server process in the application server.

• broadcast—Every active application server process receives the same 
message.

• loadBind—Each application server process shares in the traffic 
distribution with every other currently active application server 
process, based on application server process bindings.

• loadRndRobin—Each application server process shares in the traffic 
distribution with every other currently active application server 
process, using a round-robin algorithm.

• undefined—The traffic mode is not defined. The first application 
server process that becomes active defines the traffic mode.
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ITP Linksets

The General Information section for ITP linksets contains:

Interface Information
The Interface Information section for ITP links and application server process associations contains:

Field Description

Linkset Type Type of linkset, which the MWTM determines by examining the links 
defined in the linkset. Possible linkset types are:

• HSL—The links in this linkset use the SS7-over-ATM (Asynchronous 
Transfer Mode) high-speed protocol.

• SCTPIP—The links in this linkset use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol.

• Serial—The links in this linkset use the serial SS7 signaling protocol.

• Mixed—The links in this linkset are of two or more types. (This 
configuration is not recommended.)

• Virtual—The links in this linkset are virtual links, which connect 
signaling point instances running on the same node. The MWTM does 
not poll virtual linksets, nor does it display real-time data or accounting 
statistics for virtual linksets.

Note Prior to IOS release 12.2(23)SW1, the user manually created virtual 
linksets on multi-instance nodes. Within and after that release, the 
system automatically creates virtual linksets.

• Other—No links have been defined for this linkset.

Inbound ACL Inbound IP access control list (ACL) number for the linkset.

If no inbound ACL exists for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Outbound ACL Outbound ACL number for the linkset.

If no outbound ACL exists for the linkset, this field displays 0.

If the linkset is a Virtual linkset, this field displays N/A.

Field Description

Interface Name (HSL, Serial, and Virtual links only) Name of the interface.

Interface Index (HSL, Serial, and Virtual links only) Index into the SNMP interface 
table.

QoS (SCTP links only) Quality of service (QoS) class of the link.

Configured Local Port (SCTP links only) Local port for which the link was configured.

Local Port (SCTP links only) If the link is active, local port that the link is currently 
using. If the link is not active, 0 appears.
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IP Addresses for SNMP
The IP Addresses for SNMP section for nodes contains:

If there are no IP addresses defined for the node that are intended for SNMP, this field displays the 
description:

There are no other IP addresses defined for this node.

IP Addresses Not for SNMP
The IP Addresses Not for SNMP section for nodes contains:

If no IP addresses are defined for the node that are not intended for SNMP, this field displays the 
description:

There are no other IP addresses defined for this node.

Configured Remote Port (SCTP links only) Remote port for which the link was configured.

Actual Remote Port (SCTP links only) If the link is active, remote port that the link is 
currently using. If the link is not active, 0 appears.

Protocol Protocol associated with the application server process association. 
Possible values are:

• M3UA—MTP3-User Adaptation.

• SUA—SCCP-User Adaptation.

Field Description

Field Description

IP Address IP addresses associated with this node, including the primary SNMP 
address and all backup IP addresses, that are intended for SNMP.

Last Regular Poll Time Date and time of the last full poll of the node.

If the IP address has never been polled, the MWTM displays the 
description Never Polled.

SNMP Pollable Whether or not the IP address is used for SNMP polling.

Field Description

IP Address IP addresses associated with this node that are not intended for SNMP.
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Links Information
The Links Information section for ITP linksets contains:

Local IP Address Information
The Local IP Address Information section for ITP application server processes, application server 
process associations, SCTP links, and signaling gateway mated pairs contains:

Field Description

Links Total number of links in the linkset.

Active Links Number of links in the linkset that are Active.

Congested Links Number of links in the linkset that are Congested.

Field Description

IP Address Local IP address that the object is using, or the primary IP address that is 
configured for the object, or both.

The primary IP address is the first CS7 local IP address you configure in the 
node. For example, if you configure these IP addresses in the node:

cs7 local-peer 4180
local-ip 128.3.0.77
local-ip 128.3.0.254

then the MWTM uses 128.3.0.77 as the primary IP address. If someone deletes 
this IP address from the node configuration, or adds a new IP address to the 
beginning of the list, the MWTM detects the change and automatically updates 
this field to reflect the new primary IP address.

Interface Name Name of the interface to which the IP address is assigned. If the object has no 
interface name, this field is blank.

Status Current status of the IP address. Possible values are:

Active (green)—The IP address is currently fully functional.

Inactive (red)—The IP address is not currently functional.

Cfg Indicates whether this local IP address was configured for the object. Possible 
values are:

• Yes—This is the configured local IP address, and the object is currently 
using it.

• (blank)—This is not the configured local IP address.

Actual Indicates whether this local IP address is currently being used by the object. 
Possible values are:

• Yes—The object is currently using this IP address.

• (blank)—The object is not using this IP address.
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Naming Information
The Naming Information section applies to these objects:

• Nodes, page 8-20

• Cards, page 8-21

• Interfaces, page 8-22 (including RAN backhauls and shorthauls)

• ITP Application Servers, page 8-22

• ITP Application Server Processes, page 8-23

• ITP Application Server Process Associations, page 8-23

• ITP Links, page 8-23

• ITP Linksets, page 8-24

• ITP Signaling Gateway-Mated Pairs, page 8-24

• ITP Signaling Points, page 8-24

Nodes

The Naming Information section for nodes contains:

Field Description

Display Name Name of the node.

IP Address or 
DNS Hostname

IP address or DNS name of the node, as the MWTM discovered it. However, if you 
modified your preferences to identify nodes by their IP addresses, then this is 
method of node identification in this field. For more information, see Node Name 
Settings, page 5-5.

Node Type Type of node. Node types can be specific to ITP, RAN-O, or generic to both.

Note Additional icon types appear in the list for user customization.

ITP specific nodes include:

• Cisco2650XM, Cisco2651XM

• Cisco2811

• Cisco7204VXR, Cisco7206VXR

• Cisco7301

• Cisco7507, Cisco7507mx, Cisco7507z, Cisco7513, Cisco7513mx, 
Cisco7513z

• Cisco7604, Cisco7606, Cisco7609, Cisco7613
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Cards

The Naming Information section for ONS cards contains:

Node Type 
(continued)

RAN-O specific nodes include:

• CiscoMWR-1941-DC

• CiscoONS15454

• Node B—The radio transmission and reception unit for communication 
between radio cells

• RAN_SVC—RAN Service Module Card in the Cisco ONS 15454

Generic nodes include:

• IPDevice—IP device, other than those previously listed. You can assign this 
icon to an unknown node if you know that it is an IP device.

• Unknown—The MWTM is unable to determine the node type.

Chassis Type 
(ONS only)

Description of the chassis hardware type (for example, ONS 15454 SDH ETSI). 

Note This field appears only for the ONS chassis.

Serial Number Serial number of the node.

CLLI Code (ITP 
only)

COMMON LANGUAGE Location Identification Code for the node. A CLLI code 
is a standardized 11-character identifier that uniquely identifies the geographic 
location of the node. If the node has no CLLI code configured, this field is blank.

SNMP Access 
(RAN-O only)

Indicates the type of SNMP access:

• In-band—Access is through the backhaul interface (cell site).

• Out of band—Access is external to the backhaul interface (aggregation site).

• Undefined—Access is not defined.

Location (RAN-O 
only)

The location of the SNMP settings, whether at the cell site (BSC) or the 
aggregation node site (BTS). 1

Field Description

Field Description

Name Name of the card.

Card Type1 Type of card. Card types for ONS include:

• TCC—Control

• E1—Ethernet

• STM1—Synchronous Transport Module

• DS1—Digital Signal

• OC3—Optical

• XC—Cross-connect
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Interfaces

The Naming Information section for interfaces (which includes RAN backhaul and shorthaul interfaces) 
contains:

ITP Application Servers

The Naming Information section for ITP application servers contains:

Card Type 
(continued)

• RAN_SVC—RAN Service

• ALM_PWR—Alarm and Power

• CRFT_TMG—Craft Terminal

• AICI—Alarm Interface Controller

Model Name Model name of the card (for example, PartNum=800-26651-01).

Slot Number Slot number of the card in the ONS chassis.

Serial Number Serial number of the card.

1. See the Cisco ONS 15454 Product Overview for information about ONS cards: 
http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm

Field Description

Field Description

Name Name of the interface.

Node Name of the node to which the interface belongs.

Physical Address Physical address of the interface.

Interface Index Interface index number.

Interface Type Interface type.

RAN Connection To RAN connection that is associated with the interface.

Note Not visible for RAN backhauls.

Virtual RAN Backhaul Whether the RAN backhaul is a virtual backhaul. For more information 
about virtual RAN backhauls, see Creating Virtual RAN Backhauls, page 
8-136.

Note Visible only for RAN backhauls.

Field Description

Name Name of the application server.

Node Name of the node associated with the application server.

Signaling Point Name of the signaling point associated with the application server.

http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm
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ITP Application Server Processes

The Naming Information section for ITP application server processes contains:

ITP Application Server Process Associations

The Naming Information section for ITP application server process associations contains:

ITP Links

The Naming Information section for ITP links contains:

Field Description

Name Name of the application server process.

Node Name of the node associated with the application server process.

Local Port Local port number that the application server process is currently using.

Field Description

Name Name of the application server process association.

Node Name of the node associated with the application server process association.

Signaling Point Name of the signaling point associated with the application server process 
association.

Application Server Name of the application server associated with the application server process 
association.

Application Server 
Process

Name of the application server process associated with the application server 
process association.

Field Description

Node Name of the node associated with the link.

Signaling Point Name of the signaling point associated with the link.

Linkset Name of the linkset associated with the link.

SLC Signaling link code (SLC) ID for the link.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

• SCTPIP—The link uses the Stream Control Transmission Protocol (SCTP) IP 
transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point instances 
running on the same node. The MWTM does not poll virtual links, nor does it 
display real-time data or accounting statistics for virtual links.



 

8-24
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Details

ITP Linksets

The Naming Information section for ITP linksets contains:

ITP Signaling Gateway-Mated Pairs

The Naming Information section for ITP signaling gateway-mated pairs contains:

ITP Signaling Points

The Naming Information section for ITP signaling points contains:

Field Description

Name Name of the linkset.

Node Node associated with the linkset.

Signaling Point Signaling point associated with the linkset.

Local Point Code Point code of the primary signaling point for the linkset.

Adj Point Code Point code of the adjacent signaling point for the linkset.

Field Description

Name Name of the signaling gateway-mated pair.

Node Name of the node associated with the signaling gateway-mated pair.

Is Passive Indicates whether the signaling gateway-mated pair can initiate the connection to 
the mate:

• Yes—The signaling gateway-mated pair is passive, and cannot initiate the 
connection to the mate.

• No—The signaling gateway-mated pair is not passive, and can initiate the 
connection to the mate.

Column Description

Name Name of the signaling point.

Node Name of the node associated with the signaling point.

Network Name Name of the network associated with the signaling point.

Instance Number Number of the instance associated with the signaling point.
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Point Code
The Point Code section for ITP signaling points contains:

Polling Information
The Polling Information section for nodes contains:

Column Description

Point Code Primary and secondary point codes of the signaling point.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Indicator Determines the type of call. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates networks

Network Name Name of the network associated with the signaling point.

Field Description

Process Traps Indicates whether traps are processed. To change this setting, check 
or uncheck the check box in the Process Traps column of the Nodes 
table.

Trap Polling Indicates whether trap polling is enabled or not. 

For RAN-O nodes, if you want to:

• Enable trap polling, set ipran-mib snmp-access to outOfBand 
on the node.

• Disable trap polling, set ipran-mib snmp-access to inBand on 
the node.

Note For information about in-band and out-of-band 
management, see RAN-O Specific FAQs, page C-17.
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Protection Information
The Protection Information section for ONS nodes and cards contains:

Report Polling Indicates whether report polling is enabled or not. 

For RAN-O nodes, if you want to:

• Enable trap polling, set ipran-mib snmp-access to outOfBand 
on the node.

• Disable trap polling, set ipran-mib snmp-access to inBand on 
the node.

Note For information about in-band and out-of-band 
management, see RAN-O Specific FAQs, page C-17.

First Discovered Date and time that the MWTM first discovered the node.

Last Poll IP Address Last IP address that was polled for this node.

For a node that is not an ITP or RAN-O node, this field is blank.

Last Full Poll Time Date and time of the last full poll of the node for node-related MIBs 
(as opposed to a demand poll for just one associated object’s data).

For a node that is not an ITP or RAN-O node, this field is blank.

Last MWTM Poll Response 
(secs)

Time, in seconds, taken by this node to respond to the last MWTM 
poll request.

For a node that is not an ITP or RAN-O node, this field is blank.

Avg. MWTM Poll Response 
(secs)

Average time, in seconds, taken by this node to respond to MWTM 
poll requests.

For a node that is not an ITP or RAN-O node, this field is blank.

Field Description

Column Description

Card Type The type of card.

This column appears only when you select the ONS node in the navigation tree.

Protected Slot Slot number of the protected card, which is configured for protection.1

1. See the Cisco ONS 15454 Product Overview for information about protection schemes for ONS cards: 
http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm

Protecting Slot Slot number of the card that is protecting one or more cards.

Configured State The configured state of the selected card: Working or Protecting. The card is 
working normally or protecting another card.

Current State The current state of the selected card: Active or Standby.

http://www.cisco.com/univercd/cc/td/doc/product/ong/15400/45431po.htm
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QoS Information
The QoS Information section for ITP signaling points contains:

RAN Information

Note This subsection appears only for configured RAN interfaces (GSM Abis and UMTS Iub interfaces).

The RAN Information section contains:

Remote IP Address Information
The Remote IP Address Information section for ITP application server process associations, SCTP links, 
and signaling gateway mated pairs contains:

Column Description

QoS Quality of service (QoS) class of the signaling point. Valid QoS classes range from 
1 through 7. ALL indicates that the signaling point accepts all QoS classes.

ToS Type of service (ToS) of the signaling point.

DSCP IP differentiated-services-code-point (DSCP) of the signaling point.

Field Description

Protocol Protocol of the interface (GSM-Abis or UMTS-Iub).

Local IP Address IP address of the local node.

Local Port Local port that the interface uses.

Remote IP Address IP address of the remote (peer) node.

Remote Port Remote port that the interface uses.

Field Description

IP Address Remote IP address associated with the object.

Type Indicates whether this designated primary IP address is for the object (Primary), or is 
the IP address currently being used by the object (Effective), or both (Primary and 
Effective).

Usually, the same IP address is Primary and Effective. However, if the primary IP 
address is down for some reason, the object uses a different IP address and is labeled 
Effective.

Status Current status of the IP address. Possible values are:

Active (green)—The IP address is currently fully functional.

Inactive (red)—The IP address is not currently functional.
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Uptime Information
The Uptime Information section for nodes contains:

Status Information
The Status Information section applies to these objects:

• Nodes, page 8-29

• Interfaces and Cards, page 8-30 (includes RAN backhauls and shorthauls)

• ITP Application Servers, page 8-34

• ITP Application Server Processes, page 8-35

• ITP Application Server Process Associations, page 8-36

• ITP Links, page 8-38

• ITP Linksets, page 8-39

• ITP Signaling Gateway Mated Pairs, page 8-40

• ITP Signaling Points, page 8-41

Cfg (12.2(4)MB10 and later) Indicates whether this remote IP address was configured for 
the object. Possible values are:

• Yes—This is the configured remote IP address, and the object is currently using it.

• (blank)—This is not the configured remote IP address.

• N/A—The MWTM cannot determine whether this is the configured remote IP 
address.

For Cisco IOS software releases prior to 12.2(4)MB10, this field always displays N/A.

Actual Indicates whether the object is currently using this remote IP address. Possible values 
are:

• Yes—The object is using the IP address.

• (blank)—The object is not using the IP address.

Field Description

Field Description

Uptime Time the node is up, in days, hours, minutes, and seconds.

Reboot Reason Reason for the last reboot of the node.
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Nodes

The Status Information section for nodes contains:

Field Description

Is Ignored Indicates whether the node is Ignored (that is, whether to include the node 
when aggregating and displaying MWTM status information).

MTP3 Offload (ITP 
only)

Indicates whether MTP3 offload is configured for the node. Possible values 
are:

• Main—The MTP3 management function operates only on the main 
processor.

• Offload—The MTP3 management function operates on the main 
processor and on other available processors.

• N/A—MTP3 offload cannot be determined.

NSO Status (ITP 
only)

Current NSO status of the node, with a color-coded background. Possible 
values are:

Local (green)—NSO is configured and the secondary peer is in the appropriate 
status for failover support.

Local (yellow)—NSO is configured, but the secondary peer is not in the 
appropriate status for failover support.

None (black)—The node and MIB support NSO, but NSO is not configured on 
the ITP.

N/A (black)—The node and MIB do not support NSO, or the MWTM cannot 
determine the NSO status.

Status Current status of the node. Possible values are:

Active (green)

Discovering (cyan)

Polling (cyan)

Unknown (red)

Unmanaged (gray)

Waiting (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.
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Interfaces and Cards

The Status Information section for interfaces (including RAN backhaul and shorthaul interfaces) and 
cards contains:

Last Status Change Date and time that the status of the node last changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the interface or card is Ignored (that is, whether the interface 
or card should be included when aggregating and displaying MWTM status 
information).

Admin Status Displays the administrative status of the interface. Status can be:

Unknown (red)—Unknown administrative status.

Up (green)—Administratively up.

Shutdown (blue)—Administratively down.

Testing (blue)—Administrator is testing the interface.
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Operational Status Displays the operational status of the interface. Status can be:

Unknown (red)—Unknown operational status.

Up (green)—Interface is up.

Down (red)—Interface is down.

Testing (blue)—Interface is in test mode.

Dormant (red)—Interface is dormant.

Not Present (red)—An interface component is missing.

Lower Layer Down (red)—An interface is down because of a lower-layer 
interface.

Connect State
(for GSM Abis)

Displays the connection state of a GSM interface. States can be:

Connected (green)—The node is monitoring local and remote alarm status.

Disconnected (red)—The system ignores the local alarm status. The local 
transmitter on the shorthaul is disabled. Capability messages are transmitted to 
the remote describing the provisioning. The system stays disconnected until 
the remote capabilities are known and the peer state is transitioning to 
connected.

Send Connect (yellow)—One or more attempts have been made to connect to 
remote peer.

Receive Connect (yellow)—The local-peer has received a connect request 
from the remote-peer.

Connect Rejected (yellow)—Connection was rejected.

ACK Connect (yellow)—The initial connect request was sent and 
acknowledged by remote-peer. The local-peer is now waiting for a connect 
request from the remote-peer.

Check Connect (yellow)—The local peer has reason to believe its remote peer 
has failed. Additional tests are being processed to verify peer's state.

Field Description
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Connect State 
(for UMTS Iub)

Displays the connection state of a UMTS interface. States can be:

Initialized (yellow)—The connection is starting initialization.

Starting (red)—The shorthaul interface is administratively active, but the 
backhaul interface is down.

Closed (blue)—The backhaul interface is active, but the shorthaul is 
administratively closed.

Stopped (red)—Unable to connect to peer in specified time interval. 
Additional attempts will be tried based on peer request or restart timers.

Closing (blue)—Connection closed by administration request.

Stopping (yellow)—Connection shut down by peer's Term-Request. Will 
transition to stopped state. 

Connect Sent (yellow)—Connection request sent to peer.

ACK Received (yellow)—Connection request sent and acknowledgement is 
received from peer. Now waiting for peer's connection request.

ACK Sent (yellow)—Connection request received and acknowledgement is 
sent to peer. Connection request sent and waiting for peer's acknowledgement.

Open (green)—Connection open and available for traffic.

Local Receive Alarm 
State

Local Transmit Alarm 
State

Remote Receive 
Alarm State

Remote Transmit 
Alarm State

(for UMTS Iub)

Displays alarm states for UMTS Iub interface. States can be:

Remote Alarm (blue)—Indicates a problem at the remote end. The remote 
interface in the E1/T1 data stream generates and sends the alarm, and no other 
action is required. 

No Alarm (green)—No alarm is present. 

Local Alarm (red)—Indicates local interface problem. The interface has not 
received synchronization from the GSM node. The node stops transmitting 
backhaul samples.

Received Alarm (yellow)—Indicates receive problem in the local node. The 
remote node stops transmitting backhaul data and indicates a blue alarm.

Alarm State Unavailable (red)—Indicates the alarm state is not available. 
This state only applies to the remote and occurs when the peer connection is 
inactive.

Field Description
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Local State

Remote State

(for GSM Abis)

Displays alarm states for GSM Abis interface. States can be:

Remote Alarm (blue)—Indicates a problem at the remote end. The remote 
interface in the E1/T1 data stream is generates and sends the alarm, and no 
other action is required. 

No Alarm (green)—No alarm is present. 

Local Alarm (red)—Indicates local interface problem. The interface has not 
received synchronization from the GSM node. The node stops transmitting 
backhaul samples.

Received Alarm (yellow)—Indicates receive problem in the local node. The 
remote node stops transmitting backhaul data and indicates a blue alarm.

Alarm State Unavailable (red)—Indicates the alarm state is not available. 
This state only applies to the remote and occurs when the peer connection is 
inactive.

Redundancy State Displays information about the GSM Abis or UMTS Iub interface redundancy 
state. States can be:

Active (green)—Active owner of interface.

Standby (green)—Active owner of interface.

Status Current status of the interface or card. Possible values are:

Active (green)

Discovering (cyan)

Down (red)

Polling (cyan)

Unknown (red)

Unmanaged (gray)

Waiting (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Gateway Mated Pairs, page E-7.

Field Description
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ITP Application Servers

The Status Information section for ITP application servers contains:

Last Status Change Date and time of last change to status.

Status Reason Reason for the current status of the interface or card.

For a full list of possible reasons, see the stateReasons.html file. If:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network data 
and begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server 
to a state that would exist after a new installation of the MWTM, excluding the 
log files, which the MWTM retains. To also remove the log files, enter the 
mwtm cleanall command. For more information on the use of these 
commands, see the Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server is Ignored (that is, whether the application 
server should be included when aggregating and displaying MWTM status 
information).

Mate Status Current status of the application server on the signaling gateway mate. Possible 
values are:

Active (green)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Servers, page E-3.

Last Status 
Change

Date and time that the status of the application server last changed.
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ITP Application Server Processes

The Status Information section for ITP application server processes contains:

Status Current status of the application server. Possible values are:

Active (green)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Servers, page E-3.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file.To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server process is Ignored (that is, whether to 
include the application server process when aggregating and displaying MWTM 
status information).

Last Status 
Change

Date and time that the status of the application server process last changed.
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ITP Application Server Process Associations

The Status Information section for ITP application server process associations contains:

Status Current status of the application server process. Possible values are:

Unknown (red)

Unmanaged (gray)

For detailed definitions of each status, see Status Definitions for Application 
Server Processes, page E-3.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Field Description

Is Ignored Indicates whether the application server process association is Ignored (that is, 
whether the application server process association should be included when 
aggregating and displaying MWTM status information).

Congestion Level Indicates the level of congestion on the application server process association. An 
application server process association is congested if it has too many packets 
waiting to be sent. This condition could be caused by the failure of an element in 
your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).
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Instance Status Current status of the protocol associated with the application server process, with 
a color-coded background. Possible values are:

Active (green)—The protocol is available.

Shutdown (blue)—An administrator has forced the protocol to an unavailable 
state.

Unknown (red)—The MWTM cannot determine the current status of the protocol.

Status Current status of the application server process association. Possible values are:

Active (green)

Blocked (red)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Server Process Associations, page E-3.

Last Status 
Change

Date and time that the status of the application server process association last 
changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is located 
at /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are located in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description
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ITP Links

The Status Information section for ITP links contains:

Field Description

Is Ignored Indicates whether the link is Ignored (that is, whether the link should be included 
when aggregating and displaying MWTM status information).

Last Status 
Change

Date and time that the status of the link last changed.

Status Current status of the link. Possible values are:

Active (green)

Blocked (red)

Failed (red)

InhibitLoc (blue)

InhibitRem (blue)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Links, page E-5.

Status Reason Reason for the current status of the link.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Congestion Level Indicates the level of congestion on the link. A link is congested if it has too many 
packets waiting to be sent. This condition could be caused by the failure of an 
element in your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).
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ITP Linksets

The Status Information section for ITP linksets contains:

Receive 
Utilization

Indicates whether, on average, the link is under its configured receive utilization 
threshold (UnderThreshold) or over the threshold (OverThreshold).

Send Utilization Indicates whether, on average, the link is under its configured send utilization 
threshold (UnderThreshold) or over the threshold (OverThreshold).

Field Description

Field Description

Is Ignored Indicates whether the linkset is ignored (that is, whether the linkset should be 
included when aggregating and displaying MWTM status information).

Last Status Change Date and time that the status of the linkset last changed.

Status Current status of the linkset. Possible values are:

Active (green)

Shutdown (blue)

Unavailable (red)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Linksets, page 
E-6.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons appear(s) in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to 
a state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.



 

8-40
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Details

ITP Signaling Gateway Mated Pairs

The Status Information section for ITP signaling gateway mated pairs contains:

Field Description

Is Ignored Indicates whether the signaling gateway-mated pair is Ignored (that is, whether the 
signaling gateway-mated pair should be included when aggregating and displaying 
MWTM status information).

Congestion Level Indicates the level of congestion on the signaling gateway-mated pair. A signaling 
gateway-mated pair is congested if it has too many packets waiting to be sent. This 
condition could be caused by the failure of an element in your network.

Possible values for the Congestion Level field are None, indicating no congestion, 
and 1 to 7, indicating levels of congestion from very light (1) to very heavy (7).

Instance Status Current status of the protocol associated with the signaling gateway-mated pair, 
with a color-coded background. Possible values are:

Active (green)—The protocol is available.

Shutdown (blue)—An administrator has forced the protocol to an unavailable 
state.

Unknown (red)—The MWTM cannot determine the current status of the protocol.

Status Current status of the signaling gateway-mated pair. Possible values are:

Active (green)

Blocked (red)

Down (red)

Inactive (red)

Pending (red)

Shutdown (blue)

Unknown (red)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Application 
Server Process Associations, page E-3.
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ITP Signaling Points

The Status Information section for ITP signaling points contains:

Last Status 
Change

Date and time that the status of the signaling gateway-mated pair last changed.

Status Reason Reason for the current status of the signaling gateway-mated pair.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory and 
file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over the 
cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration and 
enter the mwtm cleandiscover command to delete all current network data and 
begin a discovery of the network. If the status reason remains Unsupported 
Configuration, enter the mwtm clean command to restore the MWTM server to a 
state that would exist after a new installation of the MWTM, excluding the log 
files, which the MWTM retains. To also remove the log files, enter the mwtm 
cleanall command. For more information on the use of these commands, see the 
Command Reference, page B-1.

Field Description

Column Description

Is Ignored Indicates whether the signaling point is Ignored (that is, whether the 
signaling point should be included when aggregating and displaying MWTM 
status information).

Last Status Change Date and time that the status of the signaling point last changed.

Status Current status of the signaling point. Possible values are:

Active (green)

Unknown (red)

Unmanaged (gray)

Warning (yellow)

For detailed definitions of each status, see Status Definitions for Signaling 
Points, page E-7.
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Threshold Information (RAN-O Only)
The Threshold Information section for RAN-O nodes contains:

Viewing Troubleshooting

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Operator (level 3) and higher.

You can run commands and view output in the Troubleshooting section available from the MWTM client 
or MWTM Web interface.

Status Reason Reason for the current status of the signaling point.

For a full list of possible reasons, see the stateReasons.html file. To:

• You installed the MWTM in the default directory, /opt, then the file is in 
the /opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• You installed the MWTM in a different directory, then the help directory 
and file are in that directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full text in a tooltip.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

Status Reason

(continued)

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the Command Reference, page B-1.

Column Description

Field Description

Acceptable The percentage threshold setting below which the backhaul utilization is considered 
acceptable. The default Acceptable threshold is 60 percent.1

1. To change the default setting, see Editing Properties for a RAN-O Backhaul, page 6-33.

Warning The percentage threshold setting beyond which the backhaul utilization issues a 
warning. Subsequent warnings are issued only if the utilization falls below the 
Acceptable threshold. The default Warning threshold is 70 percent.1

Overloaded The percentage threshold setting beyond which the backhaul utilization is considered 
overloaded. Subsequent overload messages are issued only if the utilization falls 
below the Acceptable threshold. The default Overloaded threshold is 80 percent.1
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To view the Troubleshooting section, within a view in the navigation tree, select an object, then click on 
the Troubleshooting tab in the right pane.

Note To see which object types pertain to this tab, see Appendix A, “Object Map Reference.”

Example:

To display the Troubleshooting section for a node, within a view, select a node in the navigation tree, 
then click on the Troubleshooting tab in the right pane.

Figure 8-3 Troubleshooting Tab

Tip To save the output of all executed commands to a log file, see mwtm tshootlog, page B-66. 

Before you can run commands and view output, you must properly configure credentials. You can 
configure credentials by using the CLI command (see mwtm addcreds, page B-6) or through the MWTM 
client (see Configuring Login Credentials, page 3-19). If credentials are not configured, the output pane 
displays this message:

No credentials are available for this node
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The Troubleshooting section displays these menus and toolbar buttons for the selected object:

Related Topics

• Configuring Login Credentials, page 3-19

• Troubleshooting IOS Commands on the Web, page D-4

• mwtm addcreds, page B-6

• mwtm tshootlog, page B-66

Viewing Recent Events
The Recent Events table displays information about all recent events associated with the selected object. 
You use the Recent Events table to perform event-related tasks, such as setting filters and acknowledging 
events.

To view the Recent Events section, within a view in the navigation tree, select an object, then click on 
the Recent Events tab in the content area.

Menu or Toolbar Button Description

Category A grouping of related commands. The MWTM provides default categories 
that you cannot modify. Additional categories are user-defined. You can 
execute all commands in a category at once by using the Execute Category 
button.

Note To define additional categories and create new commands within 
categories, see Creating New Troubleshooting Categories and 
Commands, page 3-22

Command List of commands or tasks associated with the selected category. The 
MWTM provides commands for default categories that you cannot modify. 
You can execute a selected command by using the Execute Command 
button.

Execute Command Executes the selected command only.

Note If you are using Microsoft Internet Explorer, the scroll bar may 
change position. 

Execute Category Executes all commands in the selected category.

Note If you are using Microsoft Internet Explorer, the scroll bar may 
change position. 

Cancel Execution Stops any execution process.

Save Output Saves output on screen to a file.

Copy Output Copies output on screen to the clipboard.

Print Output Prints output on screen.

Clear Output Clears all output from the screen.

Output Pane Pane where command output appears.
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Example:

To display the Recent Events section for a node, within a view, select a node in the navigation tree, then 
click on the Recent Events tab in the content area.

Figure 8-4 Recent Events Table for a Node

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the table except Internal ID, Note, Message Name, Ack By, 
Ack Time, Node, SP, Linkset, Link, SGMP, ASP, AS, ASPA, and Interface.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Node Details: Recent Events table contains:

Toolbar Button or Column Description

Set Filter Opens the Event Filter dialog box.

Apply Filter

or

Remove Filter

Applies and removes the event filter specified in the Event Filter dialog 
box. If:

• You apply the filter, the MWTM displays only those events that pass 
the filter.

• You remove the filter, the MWTM displays all events.

• You apply a filter in an object’s Recent Events table in the MWTM 
main window, the MWTM applies the filter to all Recent Events 
tables in the MWTM main window for all other network objects. 
The MWTM does not apply the filter in Recent Events tables in 
Show In New window windows or Real-Time Data and Charts 
windows.
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Pause

or

Resume

Pauses or resumes the table.

When you pause the table, the MWTM does not display new events in 
the table (unless you apply an event filter or edit your event preferences). 
When you resume the table, the MWTM adds to the display all new 
events since you paused the table.

If the MWTM deletes events while the table is paused, the MWTM does 
not remove them from the table. Instead, they are dimmed, and you 
cannot acknowledge or edit them. The MWTM removes deleted events 
from the table when you resume the table.

Acknowledge Makes the selected event or events acknowledged.

Unacknowledge Makes the selected event or events unacknowledged.

Event Properties Opens the Event Properties window.

Edit Notes Opens the Edit Event dialog box.

Time Difference Displays the difference in days, minutes, hours, and seconds between 
two events.

Find Finds specific text in the event table.

Create Sound Filter Opens the Event Sound Filters dialog box and the Event Sound Filters 
List dialog box, with fields populated based on the selected event.

Adjust Row Height Adjusts the table row height and wraps the message text. Click:

• Once to double the row height and wrap the message text.

• Again to triple the row height and wrap the message text.

• Again for single row height and no message text wrapping. This is 
the default setting.

The MWTM automatically saves this setting with your preferences.

Help for Event Displays context-sensitive help for the selected event in a separate web 
browser.

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, 
assigned by the MWTM for its own internal use. It can also be useful 
when the TAC is debugging problems.

Ack Indicates whether the event is acknowledged. To:

• Acknowledge an unacknowledged event, click the Acknowledge 
toolbar button.

• Make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Toolbar Button or Column Description
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Category Type of the event. Default values are:

• Create—Creation of a seed file.

• Delete—Deletion of an object or file.

• Discover—Discovery beginning.

• Edit—Edit an object.

• Ignore—A user has ignored a link or linkset.

• Login—A user has logged in to the MWTM.

• LoginDisable—The MWTM has disabled a user’s User-Based 
Access authentication as a result of too many failed attempts to log 
in.

• LoginFail—An attempt by a user to log in to the MWTM has failed.

• Logout—A user has logged out of the MWTM.

• OverWrite—An existing file, such as a seed file or route file, is 
overwritten.

• Poll—Such as an SNMP poll.

• Purge—A user has requested Discovery with Delete Existing Data 
selected, and the MWTM has deleted the existing MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field. See Changing Event Categories, page 9-33 
for more information.

Severity Severity of the event. 

Default values for nodes and interfaces are:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

Default values for all other ITP objects are:

• Admin—The default color is cyan.

• Error—The default color is coral.

• None—The default color is white.

• Normal—The default color is light green.

• Warning—The default color is yellow.

You can customize this field. See Changing Event Severities and Colors, 
page 9-35 for more information.

Toolbar Button or Column Description



 

8-48
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Recent Events

Original Severity Severity of the event and when the event occurred.

Count Number of occurrences. 

Note Indicates whether the event has an associated note.

Time Date and time the event was logged.

Change Time Date and time the event was last modified.

Change By User that changed this event.

Message Name User-specified message name for the event, used by the MWTM for trap 
forwarding. The default message name is MWTM.

For more information about user-specified message names and trap 
forwarding, see Forwarding Events as Traps to Other Hosts, page 9-40.

Ack By If: 

• You have not implemented MWTM User-Based Access, name of the 
node that last acknowledged the event.

• You have implemented MWTM User-Based Access, name of the 
user who last acknowledged the event.

• No one has acknowledged the event, this field is blank.

Ack Time Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If the event has no 
associated node, None appears.

Card Name of the card associated with the event. If the event has no 
associated card, None appears.

SP (ITP only) Name of the signaling point associated with the event. If the event has 
no associated signaling point, None appears.

Linkset (ITP only) Name of the linkset associated with the event. If the event has no 
associated linkset, None appears.

Link (ITP only) Name of the link associated with the event. If the event has no associated 
link, None appears.

SGMP (ITP only) Name of the signaling gateway-mated pair associated with the event. If 
the event has no associated signaling gateway-mated pair, None 
appears.

ASP (ITP only) Name of the application server process associated with the event. If the 
event has no application server process, None appears.

AS (ITP only) Name of the application server associated with the event. If the event has 
no associated application server, None appears.

ASPA (ITP only) Name of the application server process association associated with the 
event. If the event has no associated application server process 
association, None appears.

Interface Name of the interface associated with the event. If the event has no 
associated interface, None appears.

Message Text of the message.

You can customize this field. See Changing the Way the MWTM 
Processes Events, page 9-27 for more information.

Toolbar Button or Column Description



 

8-49
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Using ITP Provisioning

Using ITP Provisioning
Using MWTM provisioning through the MWTM Web interface, you can:

• Add, delete or modify ITP:

– Linksets

– Links, including SCTP, MTP2, HSMTP2 and HSL links

– Application servers, including m3ua and sua types

– Application server processes, including m3ua and sua types

– Local peer objects

– m3ua objects

– sua objects

– Channelized serial interfaces (under T1 / E1 controllers)

• Modify ITP:

– Physical serial interfaces

– Physical T1 / E1 controllers

– Physical ATM interfaces

– Physical Ethernet, FastEthernet, or GigabitEthernet interfaces

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Operator (level 3) and higher.

This section contains:

• Prerequisites for Using ITP Provisioning, page 8-49

• Using the Provisioning Wizard, page 8-50

Prerequisites for Using ITP Provisioning
Before you can provision an ITP object, you must set up:

• On the ITP:

– Basic IP connectivity

– SNMP community strings

– Credentials

– Telnet or SSH access allowed

– Basic signaling points configured

• MWTM must be able to successfully:

– Discover the ITP

– Retrieve running configuration from the ITP
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Setting Up the MWTM to Retrieve Running Configuration from the ITP

Before you can use the MWTM to provision ITP nodes, you must set up the MWTM to retrieve the 
running configuration from the ITP.

The MWTM inventory has two types of attributes: 

• Monitor attributes—Attributes obtained from SNMP polling and/or status monitoring

• Configuration attributes—Attributes obtained from IOS running configuration.

Setting up the MWTM to retrieve running configuration is a two-step process. You must:

1. Supply credentials for the target node(s). For details, see Configuring Login Credentials, page 3-19.

2. Ensure that the MWTM is getting the IOS running configuration successfully from the ITP. There 
are two approaches you can use:

– Automatic configuration synchronization—This is the default option. You can verify that the 
option in the System.properties file—look for the AUTO_SYNC_CONFIG field, which should 
be set to true. If you enable this option, the MWTM automatically retrieves the running 
configuration from the ITP after the MWTM processes a provisioning operation (from the GUI 
or NBAPI). During every status poll, the MWTM checks whether the running configuration has 
changed on the ITP. If the configuration has changed, the MWTM retrieves it.

– Manual configuration synchronization—In certain situations, you may choose to turn off 
automatic configuration synchronization and manage configuration synchronization manually. 
You can request manual configuration synchronization using the NBAPI or the CLI. For details, 
see the OSS Integration Guide for the Cisco Mobile Wireless Transport Manager 6.0.

Using the Provisioning Wizard

Note At varying stages within the wizard, you can click Next to continue, Previous to go back, Cancel to exit 
the wizard without saving changes, Refresh to reload the current window, or Submit to complete the 
provisioning.

To start provisioning by using the MWTM provisioning wizard:

Step 1 Open the MWTM web interface (for details, see Accessing the MWTM Web Interface, page 11-1). 

Step 2 Within a view in the navigation tree, select a relevant ITP object, then click on the Provision tab in the 
right pane.
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Figure 8-5 Provision Tab

Step 3 Select a Provision Choice and click Submit. The MWTM provisioning wizard appears.

There are three possible wizard stages: Basic, Features, and Summary. 

Note If you do not initiate activity on an active wizard screen, your session will time out after 60 
seconds, and the MWTM returns to the Provision Choices window.

Step 4 Enter the relevant information at the Basic stage and click Next to continue. 

Step 5 (Optional) Make your selections at the Features stage. Notice that as you enable features, they appear 
within the Wizard Steps pane under Features. Click Next to continue.

Step 6 (Optional) If you have added features, you can choose to configure aspects of each feature. Click Next 
to continue, or click the wizard stage in the left pane to jump between stages.

Step 7 The Summary stage appears, showing which IOS commands the MWTM will send to the ITP. You can 
optionally check the box Write to IOS startup-config, which saves your configuration changes 
permanently to the startup configuration on the ITP. This process can take time.

Step 8 Click Submit to send the provisioning to the ITP.

The provisioning wizard provides colored status balls within the Wizard Steps pane, which indicate:

• White—The stage you are in currently

• Red—A problem in the stage

• Yellow—Stage is not yet configured

• Green—Stage is configured successfully
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Viewing Data for Nodes
• Viewing the Syslog, page 8-52

• Viewing CPU Utilization, page 8-53

• Viewing Trap Settings, page 8-55

• Viewing ITP MTP3 Errors, page 8-58

• Viewing ITP MSU Rates, page 8-59

• Viewing ITP Non-Stop Operation, page 8-60

• Editing SNMP IP Addresses for a Node, page 8-68

• Polling a Node, page 8-70

• Allowing and Disallowing Trap Processing for a Node, page 8-73

Note To view node software versions, see Displaying Software Versions, page 11-28.

Viewing the Syslog
The Syslog section displays all messages in the system log for the selected node.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the Syslog section, within a view in the navigation tree, select a node, then click on the Syslog 
tab in the content area.

Figure 8-6 Syslog Tab
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The Syslog section displays these columns for the selected node:

Viewing CPU Utilization
The CPU Utilization section displays a summary of CPU utilization for all CPUs on a node, and CPU 
utilization per process for each CPU. 

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the CPU Utilization section, within a view in the navigation tree, select a node, then click on 
the CPU Utilization tab in the content area.

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Timestamp Date and time of the syslog message from the node.

Severity Severity of the syslog message. Possible values are:

• Alert—Conditions that require immediate action.

• Critical—Critical conditions.

• Debug—Debug conditions, log FTP commands, and WWW URLs.

• Emergency—System unusable conditions.

• Error—Error conditions.

• Info—Information conditions.

• Notice—Normal but significant conditions.

• Warning—Warning conditions.

Facility Name of the facility that generated the syslog message, such as SYS, SNMP, 
CS7MTP3, or CS7PING.

Name Short text identifier for the message type. A facility name in conjunction with a 
message name uniquely identifies a syslog message type.

Message Text of the syslog message.
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Figure 8-7 CPU Utilization Tab

The CPU Utilization section contains:

• Summary Table, page 8-54

• Slot/CPU Tables, page 8-55

Note The CPU Utilization pane is not available if the node is in Discovery, Polling, Unknown, or Unmanaged 
status.

Summary Table

The Summary table displays an overview of all slots and CPUs within the selected node.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Summary table except Slot.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Summary table contains:

Field or Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Slot Slot number on node. 

CPU Slot number (if known) and CPU number.

CPU Description Type of CPU.

5 Sec % Average CPU utilization over a five second interval. 

1 Min % Average CPU utilization over a one minute interval.

5 Min % Average CPU utilization over a five minute interval.
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Slot/CPU Tables

The Slot/CPU tables display details for the named slot and CPU (specified in the tab) within the selected 
node. If only a single CPU exists, one CPU number appears instead of the slot and CPU.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

Each Slot/CPU table contains:

Viewing Trap Settings
The Trap Settings section displays all trap settings for the selected node, as well as all hosts and port 
numbers to which the node sends traps.

If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level 5 (System Administrator).

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the Trap Settings section, within a view in the navigation tree, select a node, then click on the 
Trap Settings tab in the content area.

Field or Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

PID Process identifier.

Name Name of the process.

Time Total time since the process was created.

Total CPU time the process has used.

Times Number of times the process was invoked.

Average Average CPU time for each process invocation.

5 Sec % Average CPU utilization percentage for the node over the last 5 seconds.

1 Min % Average CPU utilization percentage for the node over the last minute.

5 Min % Average CPU utilization percentage for the node over the last 5 minutes.

Priority Process queue priority. Possible values are:

• Low

• Normal

• High

• Critical
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Figure 8-8 Trap Settings Tab

The Trap Settings section displays these columns for the selected node:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Release 2 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB4 trap settings are enabled:

• SCTP Remote Address Change

• Linkset State Change

• Link State Change

• Link Congestion State Change

• Link Receive Utilization Change

• Link Send Utilization Change

• Route State Change

• GTT MAP State Change
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Release 3 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB5 through 12.2(4)MB9a trap 
settings are enabled:

• ASP State Change

• AS State Change

• SGMP State Change

This column might not be visible if the ITP does not support ITP release 
12.2(4)MB5 through 12.2(4)MB9a traps.

Release 4 Trap 
Settings (ITP only)

Indicates whether these ITP release 12.2(4)MB10 through 12.2(20)SW trap 
settings are enabled:

• Linkset State Change

• Link State Change

• Link Congestion State Change

• Link Receive Utilization Change

• Link Send Utilization Change

• Route Destination State Change

• Route Mgmt. State Change

• Route Table Load

• GTT MAP State Change

• GTT Table Load

• ASP Congestion Change

• SNMP Congestion Change

This column might not be visible if the ITP does not support ITP release 
12.2(4)MB10 through 12.2(20)SW traps.

Release 6 Trap 
Settings (ITP only)

Indicates whether the following ITP release 12.2(25)SW3 trap setting is 
enabled:

• MLR Load Table

This column might not be visible if the ITP does not support ITP release 
12.2(25)SW3 traps.

RAN Trap Settings 
(RAN-O only)

Trap settings for the node. These settings include:

• GSM State Change

• UMTS State Change

Local IP Address IP address of a local host to which the node sends traps.

Port Port to which the node sends traps.

Trap Version Trap version sent to this IP address and port.

Community String SNMP community name used by the node for read access to the information 
maintained by the SNMP agent on the node.

Column Description
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Viewing ITP MTP3 Errors
The ITP MTP3 Errors table displays all MTP3 error information for the selected ITP node.

If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level System Administrator (level 5).

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the MTP3 Errors section, within a view in the navigation tree, select an ITP node, then click on 
the MTP3 Errors tab in the content area.

Figure 8-9 MTP3 Errors Tab

The MTP3 Errors section displays these columns for the selected node:

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change 
MWTM poller and counter settings. For more information, see Changing 
Real-Time Poller and Counter Settings, page 5-20.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot 
of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time 
they were reset by the user.

Poll Interval Poll interval used to collect data for the table.
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Viewing ITP MSU Rates
The ITP MSU Rates table displays all MSU rate information in charts for the selected ITP node.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

To view the MSU Rates section, within a view in the navigation tree, select an ITP node, then click on 
the MSU Rates tab in the content area.

Figure 8-10 MSU Rates Tab

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first 
polling cycle, the MWTM populates this field with the actual time of the last 
poll.

Count Number of times the indicated MTP3 error type was detected.

Error Description Description of the MTP3 error type.

Column Description
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The MSU Rates tab contains a Summary sub-tab, showing totals for all MSU rates. Each additional 
sub-tab shows MSU rates for a specific CPU (for example, 0/0 shows CPU 0 located in slot 0). The status 
ball on the sub-tab indicates the current threshold level of the CPU.

Right-click Menu

A right-click context menu provides options to modify how the chart appears:

Viewing ITP Non-Stop Operation
Non-Stop Operation (NSO) is an implementation of redundant data elements and software functionality 
that enables networks to approach 99.999% availability. The ITP Non-Stop Operation table displays 
detailed information about all NSO settings associated with the selected node.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-125.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

MSUs / sec Y-axis label that displays traffic rate in MSUs per second.

Time X-axis label that displays a real-time scale.

Legend Identifies the data series currently showing in the chart. 

• No Data—Data is not available. A vertical bar appears in the chart.

• CPU Threshold Crossed—One or more CPUs have crossed a processing 
threshold.

Menu options Description

Hide > field Hides the currently shown data series.

Show > field Shows the currently shown data series.

Reset Zoom If you have zoomed into a specific area of the chart, resets the zoom. 

Note To zoom into a specific area of the chart, use the left mouse button to drag 
a box around the area.

Grid On Displays a grid on the chart.

Grid Off Removes the grid from the chart.

Shapes On Displays individual data points as shapes on the MSU rate lines and the chart 
legend.

Shapes Off Removes shapes from the MSU rate lines and the chart legend.
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To view the Non-Stop Operation section, within a view in the navigation tree, select an ITP node, then 
click on the Non-Stop Operation tab in the content area. This tab appears only for Cisco 7500 and 
Cisco 7600 nodes.

Figure 8-11 Non-Stop Operation Tab

The Non-Stop Operation table displays these columns for the selected node:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the 
first polling cycle, the MWTM populates this field with the actual 
time of the last poll.
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Configuration: Split Mode Indicates whether redundant units can communicate 
synchronization messages with each other:

• Enabled—Communication is not permitted. The active unit 
does not communicate with the standby unit, and the standby 
unit progression does not occur. This mode can be useful during 
maintenance.

• Disabled—Communication is permitted. The active unit 
communicates with the standby unit, and the standby unit is 
reset to recover.

Configuration: 
Keepalive Threshold

On platforms that support keepalives, this field indicates the number 
of lost keepalives allowed before a failure occurs. If a failure occurs, 
a Switch of Activity (SWACT) notification switches the active unit 
to standby status, and vice versa.

On platforms that do not support keepalives, this field has no 
meaning.

Configuration: 
Keepalive Threshold Min

Minimum acceptable value for the Keepalive Threshold.

Configuration: 
Keepalive Threshold Max

Maximum acceptable value for the Keepalive Threshold.

Configuration: Keepalive Timer 
(msecs)

On platforms that support keepalives, this timer guards against lost 
keepalives. If the RF subsystem does not receive a keepalive before 
this timer expires, a SWACT notification switches the active unit to 
standby status, and vice versa.

On platforms that do not support keepalives, this field has no 
meaning.

Configuration: 
Keepalive Time Min (msecs)

Minimum acceptable value for the Keepalive Timer.

Configuration: 
Keepalive Time Max (msecs)

Maximum acceptable value for the Keepalive Timer.

Configuration: 
Notification Timer (msecs)

RF notification timer. As the standby unit progresses to the Hot 
Standby state, the active unit sends asynchronous messages to the 
standby unit, which then sends an acknowledgment back to the 
active unit. If the active unit:

• Receives the acknowledgement before this timer expires, the 
standby unit progresses normally.

• Does not receive a acknowledgement before this timer expires, 
a SWACT notification switches the active unit to standby status, 
and vice versa.

Configuration: 
Notification Timer Min (msecs)

Minimum acceptable value for the Notification Timer.

Configuration: 
Notification Timer Max (msecs)

Maximum acceptable value for the Notification Timer.

Configuration: RF Notification Indicates whether RF system notification is enabled or disabled.

Column Description
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Configuration: 
Maintenance Mode

Indicates whether the redundant system is in maintenance mode:

• Enabled—The redundant system is in maintenance mode. The 
active unit does not communicate with the standby unit, and the 
standby unit progression does not occur.

• Disabled—The redundant system is in normal operation mode, 
not maintenance mode. The active unit communicates with the 
standby unit, and the standby unit is reset to recover.

Configuration: 
Redundancy Mode

Redundancy mode configured on this system. Possible values are:

• Cold Standby Redundant—This system is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This system is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

• Static Load Share Redundant—This system is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—This system is not configured for 
redundancy, and it is not load-sharing.

• Static Load Share NonRedundant—This system is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This system is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This system is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This system is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

Configuration: 
Redundancy Mode Descr

Additional clarification or description of the Redundancy Mode.

Configuration: 
Oper Redundancy Mode

Operational redundancy mode of this unit. Possible values are:

• Cold Standby Redundant—This unit is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

Column Description
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Configuration: 
Oper Redundancy Mode

(continued)

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—This unit is not configured for redundancy, 
and it is not load-sharing.

• Static Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This unit is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This unit is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

History: Cold Starts Number of system cold starts, including automatic and manual 
SWACTs, since the last system initialization.

History: Available Standby Time Cumulative time that a standby redundant unit is available since the 
last system initialization.

Current Status: Unit ID Unique identifier for this redundant unit.

Current Status: Unit State Current RF status for this unit. Possible values are:

• Active—Active and is processing calls.

• Active Drain—Performing client cleanup.

• Active Extra Load—Active and is processing calls for all 
feature boards in the system.

• Active Fast—Performing call maintenance during a SWACT 
notification.

• Active Handback—Active, is processing calls, and is handing 
off some resources to the other RF unit.

• Active Preconfiguration—Active but has not yet read its 
configuration.

• Active Postconfiguration—Active and is processing its 
configuration.

Column Description
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Current Status: Unit State

(continued)

• Disabled—RF is not currently operating on this unit.

• Hot Standby—Ready to become the active unit.

• Initialization—Establishing necessary system services.

• Negotiation—Discovering and negotiating with its peer unit.

• Cold Standby—Running the client RF notification.

• Cold Standby Bulk—Synchronizing its client data with the 
peer (active) unit.

• Cold Standby Configuring—Synchronizing its configuration 
with the peer (active) unit.

• Cold Standby File System—Synchronizing its file system 
with the “V unit”.

• Unknown—The current RF state of this unit is not known.

Current Status: Peer Unit ID Unique identifier for the peer redundant unit.

Current Status: Peer Unit State Current RF status for this unit’s peer unit. Possible values are:

• Active—Active and is processing calls.

• Active Drain—Performing client cleanup.

• Active Extra Load—Active and is processing calls for all 
feature boards in the system.

• Active Fast—Performing call maintenance during a SWACT 
notification.

• Active Handback—Active, is processing calls, and is handing 
off some resources to the other RF unit.

• Active Preconfiguration—Active but has not yet read its 
configuration.

• Active Postconfiguration—Active and is processing its 
configuration.

• Disabled—RF is not currently operating on the peer unit.

• Hot Standby—Ready to become the active unit.

• Initialization—Establishing necessary system services.

• Negotiation—Discovering and negotiating with this unit.

• Cold Standby—Running the client RF notification.

• Cold Standby Bulk—Synchronizing its client data with this 
(active) unit.

• Cold Standby Configuring—Synchronizing its configuration 
with this (active) unit.

• Cold Standby File System—Synchronizing its file system 
with this (active) unit.

• Unknown—The current RF state of the peer unit is not known.

Column Description
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Current Status: Primary Mode Indicates whether this unit is the primary or secondary.

The primary unit has a higher priority than the secondary unit. In a 
race situation (for example, during initialization), or in any situation 
in which the units cannot successfully negotiate activity between 
themselves, the primary unit becomes the active unit and the 
secondary unit becomes the standby unit. Only one redundant unit 
can be the primary unit at any given time.

Current Status: Duplex Mode Indicates whether the peer unit is detected:

• Duplex—Detected.

• Simplex—Not detected.

Current Status: 
Manual Switch Inhibit

Indicates whether a manual Switch of Activity (SWACT) is 
allowed:

• Enabled—Not allowed.

• Disabled—Allowed.

Current Status: 
Last Switchover Reason

Reason for the last Switch of Activity (SWACT). Possible values 
are:

• Active Unit Failed—A failure of the active unit triggered an 
automatic SWACT.

• Active Unit Removed—The removal of the active unit 
triggered an automatic SWACT.

• None—No SWACT has occurred.

• Unknown—The reason for the last SWACT is not known.

• Unsupported—The reason code for the last SWACT is not 
supported.

• User Forced—A user forced a manual SWACT, ignoring 
preconditions, warnings, and safety checks.

• User Initiated—A user initiated a safe, manual SWACT.

Current Status: Total System Up 
Time

Date and time when this node was up.

Current Status: Last 
Failover Time

Date and time when the primary redundant unit became the active 
unit. If no failover has occurred, this field displays No Failover 
Has Occurred.

Current Status: 
Standby Available At Time

Date and time when the peer redundant unit entered the Hot Standby 
state. If a failover occurs, this fields displays System 
Initialization for a brief period until the system is back up.

Column Description
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Redundancy Mode Capability: 
Capability Mode and 
Description

List of redundancy modes that the unit can support. Possible values 
are:

• Cold Standby Redundant—This unit is configured for 
redundancy, but the redundant peer unit is not fully initialized 
and cannot retain established calls.

• Dynamic Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is based on the operational load (that is, it is based 
on the number of calls, or some other factor).

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is based on 
the operational load.

• NonRedundant—Redundancy is not configured on this unit, 
and it is not load-sharing.

• Static Load Share NonRedundant—This unit is not 
configured for redundancy, but it is load-sharing. The 
load-sharing is not based on the operational load.

• Static Load Share Redundant—This unit is configured for 
redundancy, and it is load-sharing. The load-sharing is not 
based on the operational load.

• Warm Standby Redundant—This unit is configured for 
redundancy, and the redundant peer unit can immediately 
handle new calls, but it cannot retain established calls.

• Hot Standby Redundant—This unit is configured for 
redundancy, the redundant peer unit can immediately handle 
new calls, and it can instantaneously retain established calls.

The Description column contains additional clarification or 
description of the Capability Mode.

Switchover History: Index Number identifying the entry in the Switchover History table.

Switchover History: Prev. ID Unit ID of the active unit that failed or was removed.

Switchover History: Curr. ID Unit ID of the standby unit that became the new active unit.

Switchover History: Reason Reason for the SWACT. Possible values are:

• Active Unit Failed—A failure of the active unit triggered an 
automatic SWACT.

• Active Unit Removed—The removal of the active unit 
triggered an automatic SWACT.

• None—No SWACT has occurred.

Column Description
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Editing SNMP IP Addresses for a Node
You use the MWTM to determine which IP addresses to use for SNMP polling.

To edit a node’s SNMP IP addresses, right-click a node in a window, choose Edit > SNMP IP Addresses 
in the right-click menu. The MWTM displays the Edit SNMP IP Addresses dialog box.

Figure 8-12 Edit SNMP IP Addresses Dialog

Switchover History: Reason

(continued)

• Unknown—The reason for the last SWACT is not known.

• Unsupported—The reason code for the last SWACT is not 
supported.

• User Forced—A user forced a manual SWACT, ignoring 
preconditions, warnings, and safety checks.

• User Initiated—A user initiated a safe, manual SWACT.

Switchover History: Time Date and time that the SWACT occurred.

Column Description
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The Edit SNMP IP Addresses dialog box contains:

Field or Button Description

Available IP 
Addresses

List of all IP addresses associated with this node that users could not or do not want 
the MWTM to use for SNMP polling. The MWTM does not send SNMP queries to 
IP addresses in this list.

This option appears only for ITP or RAN-O nodes.

IP Addresses for 
SNMP

List of all IP addresses associated with this node that the MWTM can use for SNMP 
polling:

• By default, the MWTM places all discovered IP addresses in this list, in the 
order in which they are discovered. The MWTM uses the IP address at the top 
of the list as the primary SNMP address for the node.

During SNMP polling of the node (status polling and demand polling), the 
MWTM first tries the primary SNMP address. If the primary is unavailable, the 
MWTM tries the other IP addresses, one-by-one, in descending order.

• To assign a new primary SNMP address, or to change the order of the 
secondary IP addresses, click the Raise Priority and Lower Priority buttons 
to move the IP addresses up and down in the list.

• You can also select IP addresses that you do not want the MWTM to use for 
SNMP polling. This feature is useful, for example, to separate management 
traffic from SMS traffic. To remove an IP address from the list, click Remove. 
The MWTM removes the IP address from the IP Addresses for SNMP list, 
places it in the Available IP Addresses list, and no longer uses it for SNMP 
polling.

To enable an IP address for SNMP polling again, select the address in the 
Available IP Addresses list and click Add. The IP address moves back into the 
IP Addresses for SNMP list and is again available for SNMP polling.

If you remove all IP addresses from the IP Addresses for SNMP list, you 
remove the node from the network, and the MWTM automatically labels the 
node Unmanaged in all MWTM windows.

When you click Save, all MWTM windows are updated automatically to reflect the 
changes.

This option appears only for ITP or RAN-O nodes.

Add Enables one or more selected IP addresses for SNMP polling. All selected 
IP addresses in the Available IP Addresses list are moved to the IP Addresses for 
SNMP list where the MWTM uses them again for SNMP polling.

Remove Disables one or more selected IP addresses for SNMP polling. All selected 
IP addresses in the IP Addresses for SNMP list are moved to the Available 
IP Addresses list, and are no longer used by the MWTM for SNMP polling.

Raise Priority Moves the selected IP addresses up in the IP Addresses for SNMP list. If you move 
an IP address to the top of the list, the MWTM uses that IP address as the new 
primary SNMP address for the node.

Lower Priority Moves the selected IP addresses down in the IP Addresses for SNMP list. If you 
remove an IP address from the top of the list, the MWTM no longer uses that IP 
address as the primary SNMP address for the node.
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Polling a Node
The MWTM automatically polls nodes at specified intervals. However, you can also request an 
immediate poll for a node. This section describes:

• Polling from the Discovery Dialog, page 8-70

• Performing a Normal Poll, page 8-71

• Performing a Clean Poll, page 8-72

Polling from the Discovery Dialog

To poll a node from the Discovery dialog box:

Step 1 Choose Network > Network Discovery from the MWTM main menu. 

The MWTM displays the Discovery dialog box (Figure 4-1).

Step 2 Select the Discovery tab. 

The MWTM displays the Discovery pane (Figure 4-5). The Discovered Nodes section of the Discovery 
pane lists all discovered nodes (all nodes, including new and excluded nodes, not just the nodes in the 
current view).

Step 3 Select one or more nodes. 

Note You cannot poll a node with a Primary SNMP Address of N/A. If you select a node with a 
Primary SNMP Address of N/A, then the Poll Node button is dimmed and cannot be selected.
If you select more than one node, and even one of them has a Primary SNMP Address of N/A, 
then the Poll Node button is dimmed and cannot be clicked.

Step 4 Click Poll Node. 

The MWTM begins a poll of the selected nodes. During polling, the Poll Node button is dimmed, the 
Selected nodes are being polled message appears at the bottom of the Discovery dialog box, and 
individual nodes might display the polling status.

Note If the node has only one IP address for the MWTM to poll, and the poll fails or times out, the 
MWTM issues an error message. If the node has more than one IP address for the MWTM to 
poll, and the polls of one or more IP addresses fail or time out, the MWTM issues warning 
messages. If all polls fail or time out, the MWTM issues an error message.

Save Saves changes that you made to the node information and exits the dialog box.

When you are satisfied with your changes, click Save. The MWTM saves your 
changes and updates all MWTM windows to reflect your changes.

Cancel Exits the dialog box without saving any changes.

At any time, you can click Cancel to exit the dialog box without saving any 
changes.

Help Displays online help for the dialog box.

Field or Button Description
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When the Selected nodes are being polled message disappears and no nodes are in polling status, 
polling is complete. The MWTM database immediately reflects any new or changed data for the selected 
nodes.

Performing a Normal Poll

A normal poll retains all objects associated with polled nodes, even objects that have been deleted and 
are therefore in Unknown status.

To poll one or more nodes, retaining all associated components in the MWTM database, use one of these 
procedures:

From a View in the Main Window

Step 1 Select a view in the navigation tree.

Step 2 Select one or more nodes in the navigation tree.

Step 3 Choose Network > Poll Nodes > Normal Poll. 

The MWTM polls all selected objects.

From Summary Lists

Step 1 Click Nodes under Summary Lists in the navigation tree.

Step 2 Select a node or adjacent node in the node table in the right pane.

Step 3 Choose Network > Poll Nodes > Normal Poll. 

The MWTM polls that node.

From Rick-click Menu in a View

Step 1 Select a view in the navigation tree.

Step 2 Right-click a node in the navigation tree.

Step 3 Choose Poll Node > Normal Poll from the right-click menu. 

The MWTM polls the node.
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Performing a Clean Poll

A clean poll removes all network objects from the node at the completion of the poll.

To poll one or more nodes, removing and then rediscovering all associated components, use one of these 
procedures:

From a View in the Main Window

Step 1 Select a view in the navigation tree.

Step 2 Select one or more nodes in the navigation tree.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls all selected nodes.

From Summary Lists

Step 1 Click Nodes under Summary Lists in the navigation tree.

Step 2 Select a node or adjacent node in the node table in the right pane.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls that node.

From Rick-click Menu in a View

Step 1 Select a view in the navigation tree.

Step 2 Right-click a node in the navigation tree.

Step 3 Choose Poll Node > Clean Poll from the right-click menu. 

The MWTM polls the node.

Clean Node for ITP Objects

Step 1 Select a view in the navigation tree.

Step 2 Select an application server, application server process, link, or linkset in the navigation tree or in the 
Summary Lists tables.

Step 3 Choose Network > Poll Nodes > Clean Poll. 

The MWTM polls all ITP nodes and adjacent nodes associated with the object.
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Allowing and Disallowing Trap Processing for a Node
By default, the MWTM processes traps from all discovered nodes. However, you can prevent the 
MWTM from processing traps from one or more nodes. For example, if a node is experiencing many link 
changes and generating too many traps, you can disallow traps from that node until the situation 
stabilizes.

Note If you prevent the MWTM from processing traps from a node, all MWTM clients and views connected 
to that MWTM server are prevented from processing traps from that node.

Also, if you prevent the MWTM from processing traps from a node, make a note of the change, and 
remember to reset the node when the problem is corrected or the maintenance is complete.

To prevent the MWTM from processing traps from a node, use one of these procedures:

• Uncheck the Process Traps check box for the node in the Node table.

Note By default, the Process Traps column is hidden. To display the Process Traps column, right-click 
in the table heading and select the Process Traps check box.

• Right-click the node in the navigation tree, then choose Disallow Trap Processing.

To allow the MWTM to process traps from a node, use one of these procedures:

• Check the Process Traps check box for the node in the Node table.

• Right-click the node in the navigation tree, then choose Allow Trap Processing.

Viewing Real-Time Data for an Object
You use the MWTM to view detailed statistics for a selected ITP or RAN-O node, or any of these ITP 
objects:

• Application Server

• Application Server Process Association

• Link

• Linkset

• Signaling Gateway Mated Pair

To display detailed statistics for one of these objects, right-click the object in the navigation tree and 
choose View > Real-Time Data and Charts from the menu. The MWTM displays the Real-Time 
Statistics window for the object.

For more information, see these sections:

• Viewing Real-Time Data for Nodes, page 8-74

• Viewing Real-Time Data for ITP Objects, page 8-76
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Viewing Real-Time Data for Nodes
You can use the MWTM to view the CPU utilization percentage for a node as a function of time. The 
MWTM displays a summary of CPU utilization for all CPUs on a node, and CPU utilization per process 
for each CPU.

To display CPU Utilization Percentage charts for a node, right-click a node in a window, then choose 
View > Real-Time Data and Charts from the right-click menu. (This option is available only if the 
MWTM can poll the node.)

If you right-click a node in the Summary Lists > Nodes folder in the navigation tree, then choose View 
> Real-Time Data and Charts, the MWTM displays the MWTM Real-Time Statistics window. Each 
tab is identified by its slot location and CPU number.

Moving the mouse over the tab shows the node name as a tooltip.

Figure 8-13 MWTM Real-Time Statistics Window

Changes you make in this window might not be reflected throughout the MWTM until the next poll (by 
default, every 15 seconds). For information about changing the poll interval, see the description of the 
Poll Interval (secs) drop-down list box in the following table.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.
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The MWTM Real-Time Statistics table displays these columns for the selected node:

Column Description

Node Name of the node for which CPU statistics are being visible.

Poll Interval 
(secs)

Field that specifies the poll interval, in seconds, for the MWTM Real-Time 
Statistics table.

The default value is 15 seconds. Valid values are between 5 and 60.

Time window 
(min)

Drop-down list box used to specify the length of time visible in the CPU Utilization 
Chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.

Last Poll Error Date and time that the node received the last polling error message. If no polling 
errors occurred, the MWTM displays None.

CPU Utilization 
Chart

Displays the CPU utilization percentage for the node as a function of time.

To see the exact time and data coordinates for a data point, left-click the data point. 
The coordinates are visible in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the CPU utilization percentage for that data point.

The Time window (mins) field specifies the total visible time in the chart.

New data points are added to the right side of the chart. When the chart reaches the 
end of the time window (for example, after 5 minutes, if the Time window (mins) 
field is set to 5), new data points continue to be added to the right side of the chart, 
while old data points drop off the left side of the chart.

If a poll is missed (for example, as a result of an SNMP timeout), the MWTM 
ignores the missing data point, stops drawing the line, and waits for the next valid 
data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding down 
Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while pressing Shift and the 
left mouse button.

To reset the chart to the default view and scaling, click Reset.

Time Average Displays three color-coded icons, one for each average calculation: 5 seconds, 
1 minute, and 5 minutes.

To remove the data for a given average from the chart, click the icon in this field. 
To return the data to the chart, click the icon again.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier to read.

Grid Off Removes the graphic grid from the chart.

Close Closes the MWTM Real-Time Statistics window.

Help Displays online help for the current window.



 

8-76
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data for an Object

Viewing Real-Time Data for ITP Objects
You use the MWTM to view detailed statistics for any of these ITP objects:

• Application Servers

• Application Server Process Associations

• Links

• Linksets

• Signaling Gateway Mated Pairs

To display detailed statistics for an object, within a view in the navigation tree, right-click an object, then 
choose View > Real-Time Data and Charts in the menu. The MWTM displays the Statistics Details 
window for the object.

Note The MWTM server automatically reflects updates for the objects received in this window.

Changes you make in this window might not be reflected throughout the MWTM until the next poll (by 
default, every 15 seconds). For information about changing the poll interval, see Poll Settings, page 
8-84.

The Statistics Details window contains these sections:

Section Applicable To Content Links

Charts • Application servers 

• Application server process 
associations

• Links 

• Linksets

Charts: Application Servers and 
Application Server Process 
Associations

Charts: Links and Linksets

Status Contributors Application Servers Viewing Status Contributors

Details All objects Viewing Details

Interface Details • Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

Interface Details: Application 
Server Process Associations, 
Links, and Signaling Gateway 
Mated Pairs

Linkset Access Lists Linksets Creating Virtual RAN Backhauls

Notes All objects

All objects

Viewing Notes

Poll Settings Poll Settings

Q.752 Measurements Links Q.752 Measurements: Links

Recent Events All objects Viewing Recent Events

Right-Click Menu Links Right-Click Menu: Links
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Charts: Application Servers and Application Server Process Associations

You use the MWTM to view real-time MTP3 and ASP packet rate information for the selected 
application server or application server process association. To do so, click the Charts tab in the Statistics 
Details window for an application server or application server process association, then click the relevant 
tab and the selected chart appears.

The Statistics Details: Charts section for application servers and application server process associations 
contains:

SCTP Association 
Configuration Details

• Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

SCTP Association Configuration 
Details: Application Server 
Process Associations, Links, and 
Signaling Gateway Mated Pairs

SCTP Association 
Statistics Details

• Application Server Process 
Associations

• Links

• Signaling Gateway Mated Pairs

SCTP Association Statistics 
Details: Application Server 
Process Associations, Links, and 
Signaling Gateway Mated Pairs

Statistics • Application Servers

• Application Server Process 
Associations

• Links

• Linksets

Statistics: Application Servers

Statistics: Application Server 
Process Associations

Statistics: Links and Linksets

Status Details Links Status Details: Links

Troubleshooting • Application Server Process 
Associations

• Links

• Linksets

Viewing Troubleshooting

Section Applicable To Content Links

Tab Description Applicable To

MTP3 Packet Rate Displays MTP3 packet rate information for a selected 
application server.

Application servers

ASP Packet Rate Displays real-time application server process packet 
rate information for a selected application server.

Application servers

Packets From ASP Rate Displays real-time rate information for packets 
received by the application server process for the 
selected application server or application server 
process association.

Application servers 
and application 
server process 
associations

Packets To ASP Rate Displays real-time rate information for packets sent to 
the application server process by the selected 
application server or application server process 
association.

Application servers 
and application 
server process 
associations
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The tabs in the Statistics Details: Charts section for application servers and application server process 
associations contain:

Packets From MTP3 Rate Displays real-time rate information for packets 
received by the selected application server or 
application server process association, from the 
MTP3 layer.

Application servers 
and application 
server process 
associations

Packets To MTP3 Rate Displays real-time rate information for packets sent to 
the MTP3 layer from the selected application server 
or application server process association.

Application servers 
and application 
server process 
associations

Tab Description Applicable To

Field or Button Description

Time window (mins) Drop-down list box used to specify the length of time appear in the selected 
chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.

<Type> Rate Chart Displays one of these rate charts for the selected application server or 
application server process association as a function of time:

• MTP3 Packet Rate Chart

• ASP Packet Rate Chart

• Packets From ASP Rate Chart

• Packets To ASP Rate Chart

• Packets From MTP3 Rate Chart

• Packets To MTP3 Rate Chart

<Type> Rate Chart

(continued)

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates appear in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the MTP3 packet rate for that data point.

The Time window (mins) field specifies the total visible time in the chart.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points drop off the left side of the chart.

If a poll is missed (for example, as a result of an SNMP timeout), the MWTM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while pressing Shift and 
the left mouse button.

To reset the chart to the default view and scaling, click Reset.
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Charts: Links and Linksets

You use the MWTM to view real-time received, sent, and dropped information for the selected link or 
linkset. To do so, click the Charts tab in the Statistics Details window for a link or linkset, then click the 
relevant tab and the selected chart appears.

The Statistics Details: Charts section for links and linksets contains:

AS or ASPA Displays color-coded icons for the application server process associations 
associated with the application server, or for the application server process 
association.

To add the data for an application server process association to the chart, click 
the icon in this field. To remove the data from the chart, click the icon again.

You use the MWTM to customize the symbols, line styles, and colors 
assigned to data points in real-time data charts. For more information, see 
Changing Charts Settings, page 5-13.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description

Tab Description

ReceivedUtilization Displays real-time ReceivedUtilization information for the 
selected link or linkset.

SendUtilization Displays real-time SendUtilization information for the 
selected link or linkset.

PktsRcvdPerSec Displays real-time packets-received-per-second information 
for the selected link or linkset.

PktsSentPerSec Displays real-time packets-sent-per-second information for 
the selected link or linkset.

BitsRcvdPerSec or BytesRcvdPerSec Displays real-time bits-received-per-second information for 
the selected link or linkset (or bytes-received-per-second 
information, if you unchecked the Show Details in Bits 
Instead of Bytes check box in the Preferences window).

BitsSentPerSec or BytesSentPerSec Displays real-time bits-sent-per-second information for the 
selected link or linkset (or bytes-sent-per-second information, 
if you unchecked the Show Details in Bits Instead of Bytes 
check box in the Preferences window).

Drops Displays drops information for the selected link or linkset.
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The tabs in the Statistics Details: Charts section for links and linksets contain:

Field or Button Description

Linkset Drop-down list box used to select the linkset from whose perspective data 
should be visible.

By default, data appears from the perspective of the selected linkset. To 
display data from the perspective of the adjacent linkset, select it in this list 
box.

Time window (mins) Drop-down list box used to specify the length of time visible in the selected 
chart.

Valid selections are 1, 2, 5, 10, 20, 40, or 60 minutes. The default selection is 
5 minutes.

<Type> Chart Displays one of these charts for the selected link (and all links on the linkset) 
or linkset (up to 16 links) as a function of time:

• Received Utilization Chart

• Send Utilization Chart

• Packets Received Chart

• Packets Sent Chart

• Bits or Bytes Received Chart

• Bits or Bytes Sent Chart

• Drops Chart

To see the exact time and data coordinates for a data point, left-click the data 
point. The coordinates are visible in the format (hh:mm:ss, dd.dd), where:

• hh:mm:ss is the time for that data point in hours, minutes, and seconds.

• dd.dd is the receive utilization percentage for that data point.

Note (For ReceivedUtilization and SendUtilization only) For serial and 
HSL links on Cisco 7507 and 7513 series routers, the visible 
utilization data can vary by up to 5% from the actual utilization—the 
MWTM might even display utilization data of more than 100%. This 
variance results from the synchronization of Layer 2 counters 
between the Versatile Interface Processor (VIP) CPU and the Route 
Switch Processor (RSP) CPU on 7500 series routers. This variance 
does not occur for links on Cisco 2600, 7200, or 7300 series routers.
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<Type> Chart

(continued)

If more than one link appears in the SLC field, you can compare the visible 
data to that of one or more of the other links by clicking the color-coded icons. 
To remove the data for the additional links, click the icons again.

The Time window (mins) field specifies the total visible time in the chart.

New data points are added to the right side of the chart. When the chart 
reaches the end of the time window (for example, after 5 minutes, if the Time 
window (mins) field is set to 5), new data points continue to be added to the 
right side of the chart, while old data points “drop off” the left side of the 
chart.

If a poll is missed (for example, as a result of an SNMP timeout), the MWTM 
ignores the missing data point, stops drawing the line, and waits for the next 
valid data point to begin drawing the line again.

To scroll left, right, up, or down in the chart, drag the cursor while holding 
down Ctrl and the left mouse button.

To zoom in on a section of the chart, drag the cursor while pressing Shift and 
the left mouse button.

To reset the chart to the default view and scaling, click Reset.

SLC Displays up to 17 color-coded icons. One for:

• Each link (SLC) in the selected chart, up to 16 total links.

• The average of all SLCs.

To add the data for a link or for the average to the chart, click the icon in this 
field. To remove the data from the chart, click the icon again.

You use the MWTM to customize the symbols, line styles, and colors 
assigned to data points in real-time data charts. For more information, see 
Changing Charts Settings, page 5-13.

Show threshold line for 
(Linksets only, 
ReceivedUtilization or 
SendUtilization)

Draws a horizontal line on the selected utilization chart, indicating the receive 
and send threshold for the selected link.

If you do not want to draw a threshold line, select None. This is the default 
setting.

Scale to threshold 
(Linksets only, 
ReceivedUtilization or 
SendUtilization)

Scales the selected utilization chart in order to draw the threshold selected in 
the Show threshold line for field. To:

• Scale the chart, check this check box.

• Remove the scaling from the chart, uncheck this check box. This is the 
default setting.

The Scale to threshold check box is not available if the Show threshold line 
for field is set to None.

Reset If you scrolled or zoomed the chart, resets the chart to the default view and 
scaling.

Grid On Superimposes a graphic grid on the chart. The grid can make the data easier 
to read.

Grid Off Removes the graphic grid from the chart.

Help Displays online help for the current window.

Field or Button Description
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Interface Details: Application Server Process Associations, Links, and Signaling Gateway Mated 
Pairs

You use the MWTM to view real-time interface details for the selected application server process 
association, link, or signaling gateway-mated pair. To do so, click the Interface Details tab in the 
Statistics Details window for an application server process association, link, or signaling gateway-mated 
pair, then select the relevant subtab and the selected data appears.

The Statistics Details: Interface Details section for application server process associations, links, and 
signaling gateway mated pairs contains:

Configuration Information

The Configuration Information subsection in the Statistics Details: Interface Details section for 
application server process associations, links, and signaling gateway mated pairs contains:

Section Description

Configuration Information Interface type, speed, and MTU. For SCTP links, this section also 
provides the IP address, mask, and physical address.

Status Information Length of time the interface is up, administrative and operational status, 
and status of the line protocol.

Statistics Information Number of bytes and packets that have been received and transmitted on 
the interface.

Errors Information Number of packet errors and discarded packets.

Field Description

Type Type of interface, such as Ethernet.

MTU Size, in bytes, of the largest datagram that can send or receive on the interface.

Speed (Bits/Sec) Estimate, in bits per second, of the interface’s current bandwidth. If the interface 
does not vary in bandwidth; or, if no accurate estimate can be made, this field 
displays the nominal bandwidth.

IP Address (SCTP links only) IP address corresponding to the media-dependent physical 
address. If the interface does not have such an address (for example, a serial line), 
this field displays N/A.

IP Mask (SCTP links only) Subnet mask corresponding to the media-dependent physical 
address. If the interface does not have such an address (for example, a serial line), 
this field displays N/A.

Physical Address (SCTP links only) Address of the interface at the protocol layer immediately 
below the network layer in the protocol stack. If the interface does not have such 
an address (for example, a serial line), this field displays N/A.



 

8-83
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data for an Object

Status Information

The Status Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Statistics Information

The Statistics Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Field Description

Uptime Time the interface is up, in days, hours, minutes, and seconds.

Admin Status State of the interface. Possible values are:

• Up

• Down

• Testing

Operational Status Current operational state of the interface. Possible values are:

• Up

• Down

• Testing

• Unknown

• Dormant

Line Protocol Status Current state of the line protocol. Possible values are:

• Up—Software processes that handle the line protocol consider the line 
to be usable (that is, keepalives are successful).

• Down—Software processes that handle the line protocol consider the 
line to be unusable.

You can use the Line Protocol together with Operational Status to 
troubleshoot interface connection problems. For example, if Operational 
Status is Up, but Line Protocol is Down, the interface has detected a carrier 
on the physical layer, but clocking or framing problems might occur.

Field Description

Bytes In per Sec Number of bytes received on the interface per second, including framing 
characters.

Bytes Out per Sec Number of bytes sent on the interface per second, including framing 
characters.

Packets In per Sec Number of packets delivered per second to a higher-layer protocol.

Packets Out per Sec Total number of packets that higher-level protocols requested to be sent to 
the network per second, including those that were discarded or not sent.
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Errors Information

The Errors Information subsection in the Statistics Details: Interface Details section for application 
server process associations, links, and signaling gateway mated pairs contains:

Poll Settings

To view or change poll settings for the object’s Statistics Details window, click Poll Settings in the left 
pane. The MWTM displays the Poll Settings pane in the right pane.

The Poll Settings pane contains:

Field Description

In Discards Number of inbound packets that were discarded, even though no errors were detected 
to prevent their delivery to a higher-layer protocol. For example, a packet might be 
discarded to free buffer space.

Out Discards Number of outbound packets that were discarded, even though no errors were 
detected to prevent their delivery to a higher-layer protocol. For example, a packet 
might be discarded to free buffer space.

In Errors Number of inbound packets that contained errors that prevented their delivery to a 
higher-layer protocol.

Out Errors Number of outbound packets that were not sent because of errors.

Field Description

Poll Interval (secs) New poll interval for the object’s Statistics Details window, in seconds.

Enter the new poll interval in this field. The valid range is 15 seconds to 
an unlimited number of seconds. The default value is 15 seconds.

Current Poll Interval Current poll interval for the object’s Statistics Details window, in 
seconds.

Number of Polls Received Total number of polls received since polling began for the object’s 
Statistics Details window.

Running Time Total elapsed time since polling began for the object’s Statistics Details 
window.

Last Message Date and time of the last poll for the object’s Statistics Details window.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that 
counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last 
reboot of the node, or since the node last reset the counters.

• Since Last Poll—Counters display values aggregated since the last 
poll.

• Since User Reset—Counters display values aggregated since the 
last time they were reset by the user.

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change 
MWTM poller and counter settings. For more information, see 
Changing Real-Time Poller and Counter Settings, page 5-20.
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Q.752 Measurements: Links

The Statistics Details: Q.752 Measurements section for links contains:

• Error Information, page 8-85

• Inhibited Information, page 8-85

• Retransmitted Information, page 8-85

• Congested Information, page 8-86

Statistics for links associated with the selected linkset are visible in the left column, and for links 
associated with the adjacent linkset in the right column.

Error Information

The Error Information subsection contains:

Inhibited Information

The Inhibited Information subsection contains:

Retransmitted Information

The Retransmitted Information subsection contains:

Field Description

Link Failure Count Number of times the link was unavailable for signaling.

Alignment Error Count Number of errors detected during link alignment. Link alignment occurs 
at start up, or when trying to bring up a failed link.

Negative ACKs Count Number of errors detected during link acknowledgement. 

Status Indicator Busy Count Number of times the Status Indicator Busy was received.

Field Description

Local Inhibit Onset Number of times a local ITP administrator has inhibited the link (that 
is, set the link to prevent traffic from flowing).

Local Inhibit Duration % Percentage of time the link is locally inhibited since the last reboot of 
the ITP, or since ITP last reset the counters.

Remote Inhibit Onset Number of times a remote ITP administrator has inhibited the link.

Remote Inhibit Duration % Percentage of time the link is remotely inhibited since the last reboot 
of the ITP, or since ITP last reset the counters.

Field Description

Packets Retransmitted per Sec Number of packets that the link transmits, per second.

Bytes Retransmitted per Sec Number of bytes that the link transmits, per second.
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Congested Information

The Congested Information subsection contains:

Right-Click Menu: Links

The Statistics Details window for a link provides a right-click menu. To see this menu for a link, click a 
link in the left pane of the Statistics Details window and right-click the mouse button. The link statistics 
details menu displays:

Local Automatic Change Over 
Count

Number of local automatic changeover events detected.

Local Automatic Change Back 
Count

Number of local automatic changeback events detected.

Field Description

Field or Column Description

Congestion Occurrences Number of times congestion has occurred on the link.

Congestion Duration % Percentage of time the link is congested since the last reboot of the ITP, 
or since ITP last reset the counters.

Congestion Level Level of congestion: 1, 2, or 3.

Packets Lost Number of packets lost by the link as a result of congestion at each level.

Packets Lost per Sec Number of packets per second that the link loses, as a result of 
congestion at each level.

Times At Level With Packet 
Loss

Number of times the link is congested and has lost packets at each level.

Menu Command Description

Delete Item Deletes the currently selected link from the MWTM database. The MWTM displays 
the Confirm Deletion dialog box, To:

• Delete the selected link, click Yes. The MWTM deletes the link from the 
MWTM database and closes the Confirm Deletion dialog box.

• Retain the selected link, click No. The MWTM retains the link in the MWTM 
database and closes the Confirm Deletion dialog box.

• Prevent the MWTM from displaying the Confirm Deletion dialog box, check 
the Do not show this again check box.

Delete Item

(continued)

Note If you check the Do not show this again check box, and you later decide 
you want the MWTM to begin displaying the Confirm Deletion dialog box 
again, you must check the Confirm Deletions check box in the General GUI 
settings in the Preferences window. For more information, see the 
description of the Confirm Deletions check box in Startup/Exit Settings, 
page 5-4.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Network Administrator (level 4) and higher.
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SCTP Association Configuration Details: Application Server Process Associations, Links, and 
Signaling Gateway Mated Pairs 

You use the MWTM to view Stream Control Transmission Protocol (SCTP) association configuration 
details for the selected application server process association, link, or signaling gateway-mated pair. To 
do so, select the SCTP Assoc. Config Details tab in the Statistics Details window for an application 
server process association, link, or signaling gateway-mated pair.

The Statistics Details: SCTP Assoc. Config Details section for application server process associations, 
links, and signaling gateway mated pairs contains:

Configuration Information

The Configuration Information subsection in the Statistics Details: SCTP Assoc. Config Details section 
for application server process associations, SCTP links, and signaling gateway mated pairs contains:

Ignore Item Ignores the link that you click at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Unignore Item Stops ignoring the selected link at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Menu Command Description

Section Description

Configuration Information Status information, length of time the link is up, remote and 
local numbers, and IP address information.

Local IP Address Information Local IP addresses associated with the link and the length 
of time each address is up.

Remote IP Address Information Remote IP addresses associated with the link, the length of 
time each address is up, and SCTP retry information.

Transmission Configuration Information The MTU, number of inbound and outbound streams, retry 
timeouts, local and remote receive window sizes, and 
chunk bundling information.

Field Description

Status Current status of the SCTP association. Possible values are:

• Closed

• CookieWait

• CookieEchoed

Status (continued) • DeleteTCB

• Established
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Local IP Address Information

The Local IP Address Information subsection in the Statistics Details: SCTP Assoc. Config Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Remote IP Address Information

The Remote IP Address Information subsection in the Statistics Details: SCTP Assoc. Config Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Status (continued) • ShutdownAckSent

• ShutdownPending

• ShutdownReceived

• ShutdownSent

For detailed information about each status, refer to RFC 2960, Stream Control 
Transmission Protocol.

Uptime Time the link is up, in days, hours, minutes, and seconds.

Remote Port Remote port number for the SCTP association.

Local Port Local port number for the SCTP association.

Primary IP Address Designated primary IP address for the SCTP association.

Effective IP Address IP address that the SCTP association uses.

Field Description

Field Description

IP Address Local IP addresses associated with the link.

Uptime Time each local IP address associated with the link is up, in days, hours, 
minutes, and seconds.

Field Description

IP Address Remote IP addresses associated with the link.

Uptime Time each remote IP address associated with the link is up, in days, hours, 
minutes, and seconds.

Retry Timeout (msecs) Current SCTP Retransmission Timeout (T3-rtx timer).

Maximum Retries Maximum allowable number of retransmissions before this IP address is 
considered inactive.

Retries Current retransmission count.
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Transmission Configuration Information

The Transmission Configuration Information subsection contains:

SCTP Association Statistics Details: Application Server Process Associations, Links, and Signaling 
Gateway Mated Pairs

You use the MWTM to view Stream Control Transmission Protocol (SCTP) association statistics details 
for the selected application server process association, link, or signaling gateway-mated pair. To do so, 
select the SCTP Assoc. Stats Details tab in the Statistics Details window for an application server 
process association, link, or signaling gateway-mated pair.

The Statistics Details: SCTP Assoc. Stats Details section for application server process associations, 
links, and signaling gateway mated pairs contains:

Field Description

MTU Maximum transmission unit (MTU) size that this SCTP association uses. Out 
of the IP addresses that the SCTP association uses, the smallest size that is 
supported.

In Streams Inbound streams as negotiated when the SCTP association was started.

Out Streams Outbound streams as negotiated when the SCTP association was started.

Maximum Retries Maximum number of data retransmissions in the SCTP association context.

Local Receive window 
Size

Current local receive window size for this SCTP association.

Remote Receive 
window Size

Current local send window size for this SCTP association.

Initial Retry Timeout 
(msecs)

Initial timeout value, in milliseconds, that the SCTP implementation permits 
for the retry timeout.

Minimum Retry 
Timeout (msecs)

Minimum timeout value, in milliseconds, that the SCTP implementation 
permits for the retry timeout.

Maximum Retry 
Timeout (msecs)

Maximum timeout value, in milliseconds, that the SCTP implementation 
permits for the retry timeout.

Bundle Chunks Indicates whether the SCTP protocol allows chunks to be bundled into a 
single datagram as follows. Valid values are:

• true (1)—Chunks are bundled.

• false (2)—Chunks are not bundled.

Bundle Timeout 
(msecs)

Time, in milliseconds, to wait to allow data chunks to accumulate so that 
they can be transmitted in the same datagram.

Section Description

Remote IP Address Information IP addresses, round-trip times, failure counts, and 
IP address status and heartbeat.

Statistics Information (per sec) Rates Sent and received counts for packets and chunks.
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Remote IP Address Information

The Remote IP Address Information subsection in the Statistics Details: SCTP Assoc. Stats Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Statistics Information (per sec) Rates

The Statistics Information (per sec) Rates subsection in the Statistics Details: SCTP Assoc. Stats Details 
section for application server process associations, SCTP links, and signaling gateway mated pairs 
contains:

Field Description

IP Address Remote IP addresses associated with the link.

Smoothed Round Trip 
Time (msecs)

Average, in milliseconds, of all round-trip times between the local and 
remote systems on an IP network.

Failure Count Number of times the remote IP address was marked as failed.

Heartbeat Status Current status of the heartbeat associated with the remote IP address. Valid 
values are Active and Inactive.

IP Status Current status of the remote IP address. Valid values are Active and Inactive.

Field Description

Packets Sent Number of IP datagrams that this SCTP association sends per second.

Packets Received Number of IP datagrams that this SCTP association receives per second.

Control Chunks Sent Number of control chunks that this SCTP association sends per second.

Control Chunks Rec Number of control chunks that this SCTP association receives per 
second.

Ordered Chunks Sent Number of ordered chunks that this SCTP association sends per second.

Ordered Chunks Rec Number of ordered chunks that this SCTP association receives per 
second.

Unordered Chunks Sent Number of unordered chunks that this SCTP association sends per 
second.

Unordered Chunks Rec Number of unordered chunks that this SCTP association receives per 
second.

Retransmitted Chunks Number of chunks that this SCTP association retransmits per second.

Retransmitted Fast Chunks Number of fast chunks that this SCTP association retransmits per 
second.
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Statistics: Application Servers

You use the MWTM to view statistics for a selected application server. To do so, select the Statistics tab 
in the Statistics Details window for an application server.

The Statistics Details: Statistics tab for application servers contains:

Statistics: Application Server Process Associations

You use the MWTM to view statistics for a selected application server process association. To do so, 
select the Statistics tab in the Statistics Details window for an application server process association.

The Statistics Details: Statistics tab for application server process associations contains:

• Packets Per Second Information, page 8-91

• Error Information, page 8-92

• ASP Initialization Counters, page 8-92

• Signaling Congestion Counters, page 8-93

• Destination Counters, page 8-93

Packets Per Second Information

The Packets Per Second Information section in the Statistics Details: Statistics tab for application server 
process associations contains:

Field Description

Active Duration Total time the application server is in service since the last reboot of 
the ITP, or since ITP last reset the counters.

MTP3 Packet Rate (per sec) Number of MTP3 packets that the application server receives per 
second.

This field initially displays the description Waiting for second 
poll. After two polling cycles, the MWTM populates this field with 
actual calculated rates.

ASP Packet Rate (per sec) Number of application server process packets that the application 
server sends per second.

This field initially displays the description Waiting for second 
poll. After two polling cycles, the MWTM populates this field with 
actual calculated rates.

Field Description

Packets From ASP Number of packets that the application server receives per second.

Packets To ASP Number of packets that the application server sends per second.

Packets From MTP3 Number of packets that the MTP3 layer receives per second.

Packets To MTP3 Number of packets that the MTP3 layer sends per second.



 

8-92
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Real-Time Data for an Object

Error Information

The Error Information section in the Statistics Details: Statistics tab for application server process 
associations contains:

ASP Initialization Counters

The ASP Initialization Counters section in the Statistics Details: Statistics tab for application server 
process associations contains:

Field Description

Errors Received Total number of error (ERR) messages that the application server process 
association receives.

Errors Sent Total number of error (ERR) messages that the application server process 
association sends.

Field Description

Up Messages Received Total number of application server process up (ASPUP) messages 
that the application server process association receives.

Up ACK Messages Sent Total number of application server process up acknowledgement 
(UPACK) messages that the application server process 
association sends.

Down Messages Received Total number of application server process down (ASPDN) 
messages that the application server process receives.

Down ACK Messages Sent Total number of application server process down 
acknowledgement (DOWNACK) messages that the application 
server process association sends.

Activation Messages Received Total number of application server process active messages that 
the application server process association receives.

Activation ACK Messages Sent Total number of application server process active 
acknowledgement messages that the application server process 
association sends.

Inactive Messages Received Total number of application server process inactive messages that 
the application server process association receives.

Inactive ACK Messages Sent Total number of application server process inactive 
acknowledgement messages that the application server process 
association sends.
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Signaling Congestion Counters

The Signaling Congestion Counters section in the Statistics Details: Statistics tab for application server 
process associations contains:

Destination Counters

The Destination Counters section in the Statistics Details: Statistics tab for application server process 
associations contains:

Field Description

Level 0 Messages Received Total number of signaling congestion level 0 (SCON0) messages that 
the application server process receives.

Level 1 Messages Received Total number of signaling congestion level 1 (SCON1) messages that 
the application server process receives.

Level 2 Messages Received Total number of signaling congestion level 2 (SCON2) messages that 
the application server process receives.

Level 3 Messages Received Total number of signaling congestion level 3 (SCON3) messages that 
the application server process receives.

Level 0 Messages Sent Total number of signaling congestion level 0 (SCON0) messages that 
the application server process sends.

Level 1 Messages Sent Total number of signaling congestion level 1 (SCON1) messages that 
the application server process sends.

Level 2 Messages Sent Total number of signaling congestion level 2 (SCON2) messages that 
the application server process sends.

Level 3 Messages Sent Total number of signaling congestion level 3 (SCON3) messages that 
the application server process sends.

Field Description

Unavailable Messages 
Received

Total number of destination unavailable (DUNA) messages that the 
application server process association receives.

Unavailable Messages 
Sent

Total number of destination unavailable (DUNA) messages that the 
application server process association sends.

Available Messages 
Received

Total number of destination available (DAVA) messages that the application 
server process association receives.

Available Messages 
Sent

Total number of destination available (DAVA) messages that the application 
server process association sends.

User Part Unavailable 
Messages Received

Total number of destination user part unavailable (DUPU) messages that the 
application server process association receives.

User Part Unavailable 
Messages Sent

Total number of destination user part unavailable (DUPU) messages that the 
application server process association sends.

State Audit Messages 
Received

Total number of destination state audit (DAUD) messages that the 
application server process association receives.

State Audit Messages 
Sent

Total number of destination state audit (DAUD) messages that the 
application server process association sends.
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Statistics: Links and Linksets

You use the MWTM to view statistics for a selected link or linkset. To do so, select the Statistics tab in 
the Statistics Details window for a link or linkset.

The Statistics Details: Statistics tab for links and linksets contains:

• Packet Information, page 8-94

• Bit Information or Byte Information, page 8-95

• LSSU Information (Links Only), page 8-95

• Utilization Information, page 8-95

• Service Information, page 8-97

Statistics for links associated with the selected linkset are visible in the left column, and for links 
associated with the adjacent linkset in the right column.

Packet Information

The Packet Information section in the Statistics Details: Statistics tab for links and linksets contains:

Field Description

Sent Per Sec Number of packets that the link or linkset sends per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Received Per Sec Number of packets that the link or linkset receives per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Drops Total number of packets that have been dropped by the link or linkset.

Transmit Queue Depth 
(links only)

Number of packets waiting to be sent on by the link.

Transmit Queue High Depth 
(links only)

Highest level reached by the transmit queue since the last reboot of the 
ITP, or since ITP last reset the averages as a result of bad data.

Transmit Queue High Reset 
(links only)

Level at which the link is to reset the transmit queue. If the link is never 
to reset the transmit queue, this field displays Never.

Signal Link Test (links only) Indicates whether test packets are being sent on the link. Valid values 
are:

• true (1)—Test packets are being sent.

• false (2)—Test packets are not being sent.
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Bit Information or Byte Information

The Bit Information section (or Byte Information section, if you unchecked the Show Details in Bits 
Instead of Bytes check box in the Preferences window) in the Statistics Details: Statistics tab for links 
and linksets contains these fields:

LSSU Information (Links Only)

The Links Status Signal Unit (LSSU) section in the Statistics Details: Statistics tab for links contains:

Utilization Information

The Utilization Information section in the Statistics Details: Statistics tab for links and linksets contains:

Field Description

Sent Per Sec Number of bits or bytes (as set in the Preferences window) that the link or 
linkset sends per second.

This field initially displays the description Waiting for second poll. After 
two polling cycles, the MWTM populates this field with actual calculated 
rates.

Received Per Sec Number of bits or bytes (as set in the Preferences window) that the link or 
linkset receives per second.

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates.

Field Description

LSSU Packets Sent Total number of LSSU packets that the link sends.

LSSU Packets Received Total number of SS7 Message Transfer Part Layer 2 (MTP2) LSSU 
packets that the link receives.

Field Description

Send Plan Capacity Planned capacity of the link or linkset to send, in bits per second. For a link 
or linkset of type:

• Serial or HSL, available bandwidth for the link/linkset.

• SCTPIP (or Mixed for linksets), set on the ITP by using the 
plan-capacity CS7 link or linkset configuration command.

If Send Plan Capacity is not set on the ITP for this link or linkset, this 
field displays the value 0.

• Other, this field always displays the value 0.

% Amount of the link or linkset’s send capacity being used, as a percentage or 
in Erlangs (E) as set in the Preferences window, calculated by using this 
formula:

Send Utilization = (Bits Sent Per Sec)/Planned Capacity
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%

(continued)

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates. For a link or linkset of type:

• SCTPIP (or Mixed for linksets), if Send Plan Capacity is not set on the 
ITP for this link, or for one or more of the links associated with this 
linkset, this field displays the description Set Plan Capacity on ITP.

• Other, this field always displays the description Set Plan Capacity on 
ITP.

Send Threshold % (links 
only)

Indicates when to generate the MWTM a cItpSpLinkSentUtilChange for the 
link, as a percent of its total send capacity. For example, if Send Plan 
Capacity is 64,000 bits per second, and Send Threshold % is 50, then the 
MWTM generates a cItpSpLinkSentUtilChange notification when the link 
reaches 50% of 64,000, or 32,000 bits per second.

Receive Plan Capacity Planned capacity of the link or linkset to receive, in bits per second. For a 
link or linkset of type:

• Serial or HSL, available bandwidth for the link.

• SCTPIP (or Mixed for linksets), set on the ITP using the plan-capacity 
CS7 link/linkset configuration command.

If Receive Plan Capacity is not set on the ITP for this link or linkset, 
this field displays the value 0.

• Other, this field always displays the value 0.

Receive Utilization % Amount of the link or linksets receive capacity being used, as a percentage 
or in Erlangs (E) as set in the Preferences window, calculated by using this 
formula:

Receive Utilization = (Bits Received Per Sec)/Receive Plan Capacity

This field initially displays the description Waiting for second poll. 
After two polling cycles, the MWTM populates this field with actual 
calculated rates. For a link or linkset of type:

• SCTPIP (or Mixed for linksets), if Receive Plan Capacity is not set on 
the ITP for this link, or for one or more of the links associated with this 
linkset, this field displays the description Set Plan Capacity on ITP.

• Other, this field always displays the description Set Plan Capacity on 
ITP.

Receive Threshold % 
(links only)

Indicates when to generate the MWTM a cItpSpLinkRcvdUtilChange for 
the link, as a percent of its total receive capacity. For example, if Receive 
Plan Capacity is 64,000 bits per second, and Receive Threshold % is 50, 
then the MWTM generates a cItpSpLinkRcvdUtilChange notification when 
the link reaches 50% of 64,000, or 32,000 bits per second.

Field Description
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Service Information

The Service Information section in the Statistics Details: Statistics tab for links and linksets contains:

Status Details: Links

You use the MWTM to view status details for a selected link. To do so, select the Status Details tab in 
the Statistics Details window for a link. 

The Statistics Details: Status Details tab for links contains:

Field Description

Duration In Service % Percentage of time the link or linkset is in service since the last reboot of 
the ITP, or since ITP last reset the counters.

Duration Out Of 
Service %

Percentage of time the link or linkset is out of service since the last reboot 
of the ITP, or since ITP last reset the counters.

MTP3 Accounting 
Enabled (linksets only)

Indicates whether the collection of MTP3 accounting statistics is enabled 
for the linkset.

If the linkset is a Virtual linkset, this field displays N/A.

GTT Accounting 
Enabled (linksets only)

Indicates whether the collection of GTT accounting statistics is enabled for 
the linkset.

For Cisco IOS software releases prior to 12.2(4)MB10, this field displays 
Unknown.

If the linkset is a Virtual linkset, this field displays N/A.

Column Description

Protocol State Details Detailed information about the state of the protocol for this link. Possible 
values are:

• Changeback control (TCBC)—Changeback control is buffering data on 
this link.

• Changeover control (TCOC)—Changeover control is buffering data on 
this link.

• Link availability control (TLAC)—Adjacent Signalling point is 
restarting.

• Link availability control (TLAC)—Emergency changeover is in 
progress on this link.

• Link availability control (TLAC)—Changeback is in progress on this 
link.

• Link availability control (TLAC)—Changeover is in progress on this 
link.

• Link availability control (TLAC)—The last changeover operation 
failed on this link.

• Link availability control (TLAC)—Inhibit command will be retried.
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Protocol State Details

(continued)

• Link availability control (TLAC)—Management request in progress for 
this link.

• Link availability control (TLAC)—Signalling point is in the process of 
a restart.

• Signalling routing control (TSRC)—Changeover request is complete.

• Signalling routing control (TSRC)—Adjacent Signalling Point is 
restarting.

• Link availability control (TLAC)—Link is inhibited by a local 
management operation.

• Link availability control (TLAC)—Link is inhibited by a remote 
management operation.

• Link availability control (TLAC)—Link is blocked because of a local 
processor outage.

• Link availability control (TLAC)—Link is blocked because of a remote 
processor outage.

Link Test Results Indicates the results of the link test. Possible results are:

• No Errors—The link did not detect any errors.

• Undefined OPC (Origination Point Code)—A signaling link test 
message arrived with an undefined OPC. This scenario can occur when a 
serial link connects incorrectly, or when you configure an SCTP link 
incorrectly. This scenario differs from Incorrect OPC because the 
signaling point is unaware of the point code in question. The point code 
is not defined for any linkset on this ITP.

• Incorrect OPC—A signaling link test message arrived with an incorrect 
OPC. This scenario can occur when a serial link connects incorrectly, or 
when you configure an SCTP link incorrectly. This scenario differs from 
Undefined OPC because the signaling point is aware of the point code 
in question, and the point code is defined for a linkset on this ITP, but the 
point code is not correct for the current linkset.

• Undefined SLC (Signaling Link Code)—A signaling link test message 
arrived with an undefined SLC. This scenario can occur when a serial link 
connects incorrectly, or when you configure an SCTP link incorrectly. 
The link connects to the correct linkset, but the linkset does not have a 
definition for the SLC in question.

• Incorrect SLC—A signaling link test message arrived with an incorrect 
SLC. This scenario can occur when a serial link connects incorrectly, or 
when you configure an SCTP link incorrectly. The link connects to the 
correct linkset, but to the wrong link within that linkset. That is, the 
signaling test receives the test packet on the wrong link.

Column Description
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Link Test Results

(continued)

• Incorrect NI (Network Indicator)—A signaling link test message 
arrived with an incorrect NI. This scenario can occur when links connect 
to the correct linkset and link, but the NIs of the two adjacent point codes 
are not the same.

• Bad Pattern—A signaling link test message arrived with an incorrect 
test pattern. This error occurs because the test pattern is corrupt. This 
scenario usually indicates a hardware or configuration issue related to the 
physical format of the data on the links, caused by a variant mismatch or 
incorrect definitions on the physical link.

• Non Adjacent—Received a signaling link test message from a 
nonadjacent node.

• Failed—Unable to run the test, or no response arrived within the 
specified interval.

Link Fail Reason If the link failed the link test, indicates the reason for the failure. Possible 
reasons are:

• None—No additional reason available.

• Changeover in progress—Changeover is in progress. This message 
diverts traffic away from a failed link.

• Management disconnect request—An MTP3 sent a request to stop the 
link.

• Link alignment lost—Link alignment is lost.

A link is in alignment when signal units are received in sequence, and 
with the proper number of octets. The signal unit must be a total length 
of eight-bit multiples. If the signal unit is not of eight-bit multiples, or if 
the signaling information field (SIF) exceeds the 272-octet capacity, the 
signaling unit is considered to be in error. If excessive errors are 
encountered on a link, it is considered to be out of alignment.

For M2PA links, this state reason is generated when the M2PA alignment 
timer T1 expires. This could indicate that the remote link is shutdown, or 
that intermittent IP connectivity problems exist.

• Link connection lost—Link connection is lost.

• Local Disconnect—A request to disconnect the link is received, but the 
link is already disconnected.

• Remote Disconnect—A remote disconnect request is received.

• Signal unit error rate monitor failure—The signal unit error rate 
monitor has failed.

• T1 timeout no FISU received—A T1 timeout no FISU is received. This 
timer avoids message mis-sequencing during changeover.

• T2 timeout no SIO received—A T2 timeout no SIO is received. This 
timer waits for a changeover acknowledgment.

Column Description
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Link Fail Reason

(continued)

• T3 timeout no SIN received—A T3 timeout no SIN is received. This 
timer controls diversion-delay to avoid mis-sequencing on changeback.

• T6 timeout excessive congestion—A T6 timeout excessive congestion is 
received. This timer avoids message mis-sequencing on controlled 
rerouting.

• T7 timeout excessive acknowledgement delay—A T7 timeout 
excessive acknowledgment delay is received. The T7 timer prevents a 
signaling point from waiting too long for a positive or negative 
acknowledgment. Usually, an acknowledgment is sent when a signaling 
point becomes idle and does not have any more traffic to transmit. When 
congestion occurs at a signaling point, or an extreme amount of traffic is 
present, the T7 could possibly time out and force retransmission of 
messages.

• Link proving failure—A link proving failure occurred.

• Abnormal BSN received—An abnormal Backward Sequence Number 
(BSN) is received.

• Abnormal FIB received—An abnormal Forward Indicator Bit (FIB) is 
received.

• Abnormal SIB received—An abnormal Status Indicator Busy (SIB) is 
received.

• Abnormal LSSU received—An abnormal Link Status Signal Unit 
(LSSU) is received.

• Peer not ready—An MTP3 tried to bring up a link that is still cleaning 
up after being stopped. In some cases, the MTP3 does not change over 
after a link failure, so the M2PA or SCTP waits for an event that will not 
occur. When an MTP3 tries to bring up the link again, the previous 
control structures must first be cleaned up. If M2PA gets a start request 
from an MTP3, and the previous structures are still being held, M2PA 
cleans them up and sends a PEER NOT READY to the MTP3 layer. A 
subsequent request to start the link from the MTP3 layer will then cause 
the link to come up.

• Communication lost—M2PA or SCTP has determined that the remote 
end signaling point is no longer reachable. Possible reasons include:

– The maximum number of consecutive retries of a packet is reached.

– In the absence of data, the MWTM failed to receive heartbeat ACKs 
in response to heartbeats, for the maximum number of retries.

• No Listen posted—An MTP3 tried to start a link, but the local-peer port 
associated with the link is not available, probably because of a bad 
configuration.

• Unable to allocate buffer—M2PAor SCTP cannot get buffers for 
sending or receiving packets. Buffer problems can be temporary or 
permanent. Temporary buffer problems will generally clear with little 
side effects. Permanent buffer problems can lead to failed linksets or 
links.

Column Description
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Viewing ITP Linkset Access Lists
The Linkset Access Lists section displays information about the access lists associated with the selected 
linkset and its adjacent linkset.

To view the Linkset Access List section, within a view in the navigation tree, select an ITP linkset, then 
click on the Linkset Access Lists tab in the content area.

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need it.

This window is not available if the linkset is a Virtual linkset.

Link Fail Reason

(continued)

• Link card removed—A link card is removed.

• Link card inserted—A link card is inserted.

• False link congestion—A false link congestion indication is received.

• Configuration downloading—The configuration is downloading.

• Locally inhibited—The link is locally inhibited by operator request.

• Locally uninhibited—An operator request locally uninhibited the link.

• Remotely inhibited—The link is remotely inhibited by operator request.

• Remotely uninhibited—The link is remotely uninhibited by operator 
request.

• Locally blocked—The link is blocked locally.

• Locally unblocked—The link is unblocked locally.

• Remotely blocked—The link is remotely blocked.

• Remotely unblocked—The link is remotely unblocked.

Column Description
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Figure 8-14 MWTM Linkset Access Lists Tab

For each linkset, the Linkset Access Lists section displays these columns:

Column Description

Poll Interval Used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Linkset Name of the linkset for which access lists appear.

In Inbound access lists for the linkset. If the linkset has no inbound access lists, this 
field displays None.

Out Outbound access lists for the linkset. If the linkset has no outbound access lists, this 
field displays None.

List # Access list number configured on the node and applied to the linkset. ITP uses 
access list numbers 2700 through 2799.

Access List List of commands in the access list.
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Viewing Data Specific for ITP Signaling Points
These sections are specific only to ITP signaling points:

• Viewing Route Detail, page 8-103

• Viewing GTT MAP Status, page 8-105

• Viewing GTT Statistics, page 8-107

• Viewing the MTP3 Event Log, page 8-110

• Viewing MLR Details, page 8-112

• Viewing RAN-O Performance and Error Data, page 8-123

Viewing Route Detail
The Route Detail table displays detailed information about routes associated with the selected signaling 
point, including dynamic and shadow routes. The Route Detail table automatically eliminates duplicate 
data in successive rows.

To view the Route Detail section, within a view in the navigation tree, select an ITP signaling point, then 
click on the Route Detail tab in the content area.

Figure 8-15 MWTM Route Detail Tab

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.
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The Route Detail table displays these columns for the selected signaling point:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Destination Point 
Code

Destination point code for packets on the selected signaling point. The 
destination point code is the point code to which a given packet is routed.

Mask Mask length for packets on the selected signaling point. The mask length is the 
number of significant leading bits in the point code. The mask length is always 
14 for ITU and 24 for ANSI.

Access Status of the destination. Possible values are:

• Accessible

• Inaccessible

• Restricted

• Unknown

Congestion Level Indicates the level of congestion on the route. A route is congested if it has too 
many packets waiting to be sent. This condition could be caused by the failure of 
an element in your network.

Possible values for the Congestion Level field are None, indicating no 
congestion, and 1 to 7, indicating levels of congestion from very light (1) to very 
heavy (7).

Number of Routes Number of routes to the selected destination route set (Destination Point Code 
plus Mask).

Cost Cost of the route to the destination, relative to other routes. The valid costs range 
from 1 (lowest cost and highest priority) through 9 (highest cost and lowest 
priority).

Destination Linkset Destination linkset associated with the destination point code. The destination 
linkset is also called the output linkset.

QoS Quality of service (QoS) class of the route, as configured by the network 
administrator. Valid QoS classes range from 1 through 7; ALL indicates that the 
route accepts all QoS classes.
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Viewing GTT MAP Status
The GTT MAP Status table displays detailed information about all GTT MAPs associated with the 
selected signaling point. The GTT MAP Detail table automatically eliminates duplicate data in 
successive rows.

To view the GTT MAP Status section, within a view in the navigation tree, select an ITP signaling point, 
then click on the GTT MAP Status tab in the content area.

Figure 8-16 MWTM GTT Map Status Tab

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

Management Status Accessibility of the destination from the adjacent point code at the remote end of 
the signaling point. Possible values are:

• Allowed—Traffic is allowed on the route without restriction.

• Prohibited—Traffic is prohibited on the route.

• Restricted—Traffic is restricted on the route.

• Unknown—Accessibility cannot be determined.

Route Status Status of the route. Possible values are:

• Available

• Restricted

• Unavailable

Column Description
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The GTT MAP Status table displays these columns for the selected signaling point:

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change MWTM 
poller and counter settings. For more information, see Changing Real-Time 
Poller and Counter Settings, page 5-20.

Poll Counter Mode Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot of 
the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time 
they were reset by the user.

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Point Code Primary point code for the GTT MAP.

Point Code Status Status of the primary point code. Possible values are:

• Allowed

• Prohibited—Either the point code cannot be reached, or the point code is 
labeled Prohibited by the SCCP protocol.

Congestion Level MTP3 congestion level for the primary point code. Possible values are:

• No congestion—Corresponds to None. The link is not congested.

• Congestion level 1—Corresponds to Low. The link is slightly congested.

• Congestion level 2—Corresponds to High. The link is congested.

• Congestion level 3—Corresponds to Very High. The link is very congested.

Low, High, and Very High correspond roughly to equivalent ANSI, 
China standard, ITU, NTT, and TTC congestion levels.

Point Code 
Congested

Number of times a point code was congested at the GTT MAP.

Point Code 
Unavailable

Number of times a point code was unavailable at the GTT MAP.

SCCP Unavailable Number of times an SCCP was unavailable at the GTT MAP. 

MTP3 Failures Number of times the MTP3 layer failed at the GTT MAP.

Number of 
Subsystems

Number of subsystems for the GTT MAP.

Subsystem Number Primary subsystem number (SSN) for the GTT MAP.
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Viewing GTT Statistics
The GTT Statistics table displays detailed statistical information about all GTTs that are associated with 
the selected signaling point. The GTT Statistics table automatically eliminates duplicate data in 
successive rows.

To view the GTT Statistics section, within a view in the navigation tree, select an ITP signaling point, 
then click on the GTT Statistics tab in the content area.

Figure 8-17 MWTM GTT Statistics Tab

Subsystem Status Status of the primary SSN. Possible values are:

• Allowed

• Prohibited—Either the remote subsystem cannot be reached, or the SCCP 
protocol labels the subsystem Prohibited.

Subsystem 
Unavailable

Number of times a subsystem was unavailable at the GTT MAP.

Subsystem 
Congested

Number of times a subsystem was congested at the GTT MAP.

Column Description
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Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The GTT Statistics table displays these columns for the selected signaling point:

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to 
change MWTM poller and counter settings. For more information, 
see Changing Real-Time Poller and Counter Settings, page 5-20.

Poll Counter Mode Displays the current mode for poll counters, and the date and time 
that counters were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the 
last reboot of the ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the 
last poll.

• Since User Reset—Counters display values aggregated since 
the last time they were reset by the user.

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the 
first polling cycle, the MWTM populates this field with the actual 
time of the last poll.

Uptime Time the node is up, in days, hours, minutes, and seconds.

Selector Entries Number of entries in the GTT Selector Table.

GTA Entries Number of entries in the GTT GTA Table.

Application Group Entries Number of entries in the GTT App Group Table.

Addr. Conversion Entries Number of entries in the GTT Address Conversion Table.

Point Code List Entries Number of entries in the GTT CPC List.

GTT Errors: Errors To MTP Number of Error messages (ERRs) sent by GTT to the MTP.

GTT Errors: Errors From MTP Number of Error messages (ERRs) received by GTT from the MTP.

GTT Errors: Translation Error Number of times translation was requested for a combination of 
Translation Type, Numbering Plan, and Nature of Address for 
which no translation exists in the signaling point. Occurs when no 
selector is available for the combination of parameters provided in 
the MSU.

GTT Errors: Unequipped 
Subsystem Error

Number of times GTT could not perform a translation due to an 
unequipped subsystem.

GTT Errors: Q752 Unqualified 
Error

Number of times GTT could not perform a translation due to an 
error type not covered by the other, more specific error types.

GTT Errors: 
Invalid GTT Format

Number of times GTT detected an invalid global title format while 
performing translation.

GTT Errors: Hop Count Error Number of times GTT detected a hop count violation in the MSU.
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GTT Errors: MAP Not Found Number of times a GTT to a point code or subsystem number was 
successful, but the point code or subsystem number was not found 
in the GTT MAP table.

GTT Errors: Counters Number of GTT errors of the specified type since MWTM polling 
began for the linkset, or since the MWTM last reset the averages as 
a result of bad data.

GTT Errors: Rate (per sec) Number of errors that GTT detected per second.

GTT Messages: Total Messages Number of messages that GTT handled from local and remote 
subsystems.

GTT Messages: Local Messages Number of messages that GTT handled from local subsystems only.

GTT Messages: 
Total GTT Messages

Number of messages that GTT handled that require translation.

GTT Messages: 
UDT Messages Sent

Number of unitdata messages (UDTs) that GTT sent.

GTT Messages: 
UDT Messages Received

Number of unitdata messages (UDTs) that GTT received.

GTT Messages: 
UDTS Messages Attempted

Number of unitdata service messages (UDTSs) GTT attempted to 
send.

GTT Messages: 
UDTS Messages Sent

Number of unitdata service messages (UDTSs) that GTT sent.

GTT Messages: 
UDTS Messages Received

Number of unitdata service messages (UDTSs) that GTT received.

GTT Messages: 
XUDT Messages Sent

Number of extended unitdata messages (XUDTs) GTT sent.

GTT Messages: 
XUDT Messages Received

Number of extended unitdata messages (XUDTs) that GTT 
received.

GTT Messages: 
XUDTS Messages Attempted

Number of extended unitdata service messages (XUDTSs) GTT 
attempted to send.

GTT Messages: 
XUDTS Messages Sent

Number of extended unitdata service messages (XUDTSs) that GTT 
sent.

GTT Messages: 
XUDTS Messages Received

Number of extended unitdata service messages (XUDTSs) that GTT 
received.

GTT Messages: 
LUDT Messages Sent

Number of long unitdata messages (LUDTs) that GTT sent.

GTT Messages: 
LUDT Messages Received

Number of long unitdata messages (LUDTs) that GTT received.

GTT Messages: 
LUDTS Messages Sent

Number of long unitdata service messages (LUDTSs) that GTT 
sent.

GTT Messages: 
LUDTS Messages Received

Number of long unitdata service messages (LUDTSs) that GTT 
received.

GTT Messages: 
CR Sent To MTP

Number of Connection Request (CR) message that GTT sent to the 
MTP. This count includes ISDN-UP messages with embedded CRs.

Column Description
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Viewing the MTP3 Event Log
The MTP3 Event Log table displays the most recent MTP3 events associated with the selected signaling 
point.

To view the MTP3 Event Log section, within a view in the navigation tree, select an ITP signaling point, 
then click on the MTP3 Event Log tab in the content area.

GTT Messages: 
CR Received From MTP

Number of Connection Request (CR) message that GTT received 
from the MTP.

GTT Messages: 
CREF Sent To MTP

Number of Connection Refusal (CREF) messages that GTT sent to 
the MTP. This count includes ISDN-UP messages with embedded 
CRs.

GTT Messages: 
CREF Received From MTP

Number of Connection Refusal (CREF) messages that GTT 
received from the MTP.

GTT Messages: 
RSR Sent To MTP

Number of Reset Request (RSR) messages that GTT sent to the 
MTP.

GTT Messages: 
RSR Received From MTP

Number of Reset Request (RSR) messages that GTT received from 
the MTP.

GTT Messages: Counters Number of GTT messages of the specified category since MWTM 
polling began for the linkset, or since the MWTM last reset the 
averages as a result of bad data.

GTT Messages: Rate (per sec) Number of errors messages handled by GTT, per second.

Column Description



 

8-111
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 8      Understanding Detailed Object Functions
  Viewing Data Specific for ITP Signaling Points

Figure 8-18 MWTM MTP3 Event Log Tab

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

The MTP3 Event Log table displays these columns for the selected signaling point:

Column Description

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

Logged Events Total number of MTP3 events that have been logged for this signaling point.

Dropped Events Total number of MTP3 events that have been dropped for this signaling point.

Max Events Maximum number of events that the event history can contain. When event history 
table is full, the oldest entries are deleted as new entries are added.

Allowed Events ITP parameter that specifies the absolute maximum for the Max Events field. That 
is, for this node, the Max Events field can range from 0 to the value specified by 
the Allowed Events field.
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Viewing MLR Details
The MLR Details tab displays the MLR counters, trigger configuration, and trigger results associated 
with the selected signaling point.

To view the MLR Details section, within a view in the navigation tree, select an ITP signaling point, then 
click on the MLR Details tab in the content area.

Figure 8-19 MWTM MLR Details Tab

Note This window polls your network periodically. To prevent unnecessary traffic on your network, close this 
window when you no longer need to refer to it.

Index Event number that the ITP assigns.

Message Message text for the event.

Column Description
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The MLR Details tab displays these columns for the selected signaling point:

Viewing MLR Counters

The MLR Counters table displays MLR counters associated with the selected signaling point.

You can resize each column, or sort tables based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the MLR Counters table.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The MLR Counters table displays these columns for the selected signaling point:

Column Description

Reset Counters Opens the MWTM Reset Counters dialog box, which you use to change MWTM 
poller and counter settings. For more information, see Changing Real-Time Poller 
and Counter Settings, page 5-20.

Poll Counter 
Mode

Displays the current mode for poll counters, and the date and time that counters 
were last reset. Possible modes are:

• Since Reboot—Counters display values aggregated since the last reboot of the 
ITP, or since ITP last reset the counters.

• Since Last Poll—Counters display values aggregated since the last poll.

• Since User Reset—Counters display values aggregated since the last time the 
user reset them.

Poll Interval Poll interval used to collect data for the table.

Last Poll Time the last poll was run.

This field initially displays the description Polling node. After the first polling 
cycle, the MWTM populates this field with the actual time of the last poll.

MLR Counters Displays the MLR Counters table. For more information, see Viewing MLR 
Counters, page 8-113.

MLR Trigger 
Config

Displays the MLR Trigger Configuration table. For more information, see Viewing 
MLR Trigger Config, page 8-115.

MLR Trigger 
Results

Displays the MLR Trigger Results table. For more information, see Viewing MLR 
Trigger Results, page 8-119.

Column Description

Processed: Routed Total number of packets routed by MLR, and the packet routing rate in 
packets per second.

Processed: MAP SMS-MO Number of MSUs of type GSM-MAP SMS-MO processed by MLR, and 
the GSM-MAP SMS-MO MSU processing rate in packets per second.

Processed: MAP SMS-MT Number of MSUs of type GSM-MAP SMS-MT processed by MLR, and 
the GSM-MAP SMS-MT MSU processing rate in packets per second.

Processed: MAP SRI-SM Number of MSUs of type GSM-MAP SRI-SM processed by MLR, and 
the GSM-MAP SRI-SM MSU processing rate in packets per second.

Processed: MAP AlertSc Number of MSUs of type GSM-MAP AlertSc processed by MLR, and 
the GSM-MAP AlertSc MSU processing rate in packets per second.
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Processed: 
ANSI-41 SMD-PP

Number of MSUs of type ANSI-41 SMD-PP processed by MLR, and the 
ANSI-41 SMD-PP MSU processing rate in packets per second.

Processed: 
ANSI-41 SMS Requests

Number of MSUs of type ANSI-41 SMSRequest processed by MLR, 
and the ANSI-41 SMSRequest MSU processing rate in packets per 
second.

Processed: 
ANSI-41 SMS Notifys

Number of MSUs of type ANSI-41 SMSNotify processed by MLR, and 
the ANSI-41 SMSNotify MSU processing rate in packets per second.

Aborts: Total Aborted Total number of MSUs aborted by MLR, and the MSU abort rate in 
packets per second.

Aborts: No Resources Number of MSUs aborted by MLR because of a shortage of resources, 
and the No Resources MSU abort rate in packets per second.

Aborts: Results Blocked Number of MSUs aborted by MLR with a result of block, and the 
Results Blocked MSU abort rate in packets per second.

Aborts: GTI Mismatches Number of MSUs aborted by MLR because of mismatched GTIs, and 
the GTI Mismatches MSU abort rate in packets per second.

Aborts: Address Conversion 
Failures

Number of MSUs aborted by MLR because of a failed GTA address 
conversion, and the Address Conversion Failures MSU abort rate in 
packets per second.

Aborts: Destination 
Unavailables

Number of MSUs aborted by MLR because the destination was 
unavailable, and the Destination Unavailables MSU abort rate in packets 
per second.

Aborts: No Server Aborteds Number of MSUs aborted by MLR because no server was available, and 
the No Server Aborteds MSU abort rate in packets per second.

Continues: Total Continued Total number of MSUs returned to SCCP by MLR with a result of 
continue, and the MSU return rate in packets per second.

Continues: Failed Triggers Number of MSUs returned to SCCP by MLR because of no trigger 
match, and the Failed Triggers MSU return rate in packets per second.

Continues: 
Result Continueds

Number of MSUs returned to SCCP by MLR with a result of 
continue, and the Result Continueds MSU return rate in packets per 
second.

Continues: Result GTTs Number of MSUs returned to SCCP by MLR with a result of GTT, and 
the Result GTTs MSU return rate in packets per second.

Continues: Unsupported 
SCCP Msg Types

Number of MSUs returned to SCCP by MLR because of unsupported 
message types, and the Unsupported SCCP Msg Types MSU return rate 
in packets per second.

Continues: Unsupported 
Segmented SCCP Msgs

Number of MSUs returned to SCCP by MLR because of unsupported 
segments, and the Unsupported Segmented SCCP Msg MSU return rate 
in packets per second.

Continues: 
Unsupported Messages

Number of MSUs returned to SCCP by MLR because of parse failures, 
and the Unsupported Messages MSU return rate in packets per second.

Continues: Parse Errors Number of MSUs returned to SCCP by MLR because of parse errors, 
and the Parse Errors MSU return rate in packets per second.

Column Description
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Viewing MLR Trigger Config

The MLR Trigger Config table displays the MLR trigger configuration associated with the selected 
signaling point, divided into these subtables:

• Triggers, page 8-115

• SubTriggers, page 8-116

• Ruleset, page 8-116

• Rules, page 8-117

• Addresses, page 8-117

• Results, page 8-118

Triggers

The Triggers subtable displays MLR trigger information associated with the selected signaling point.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Triggers subtable except Set Name, Start Date, End Date, 
and Status.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Triggers subtable displays these columns for the selected signaling point:

Continues: No Results Number of MSUs returned to SCCP by MLR with no results, and the No 
Results MSU return rate in packets per second.

Continues: 
No Server Continueds

Number of MSUs returned to SCCP by MLR because no server was 
available, and the No Server Continueds MSU return rate in packets per 
second.

Column Description

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the trigger.

Index Index number associated with the trigger.

SubTriggers Number of subtriggers associated with the selected trigger.

Start Date Date and time on which this trigger should begin filtering traffic.

If no Start Date is configured, this field displays N/A.

End Date Date and time on which this trigger should stop filtering traffic.

If no End Date is configured, this field displays N/A.
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SubTriggers

The SubTriggers subtable displays MLR subtrigger information associated with the selected signaling 
point and trigger.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the SubTriggers subtable.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The SubTriggers subtable displays these columns for the selected signaling point:

Ruleset

The Ruleset subtable displays MLR ruleset information associated with the selected signaling point and 
trigger or subtrigger.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Ruleset subtable except Start Date and End Date.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

Status Current status of the trigger. Possible values are:

• Active—A corresponding GTT table entry for the trigger or, if this is an 
MTP3 trigger, an available route to the appropriate point code exists.

• Inactive—No corresponding GTT table entry or available route to the 
appropriate point code for the trigger. The trigger will never match and a 
configuration error is likely.

Action Action taken by the trigger.

Prematches Preliminary count of trigger matches.

Prematch Rate Number of Prematches per second for the trigger.

Matches Number of trigger matches with result Action Performed.

Match Rate Number of Matches per second for the trigger.

Parameters Parameters that control the behavior of the trigger.

Column Description

Column Description

Trigger
(in subtable heading)

Set name of the parent trigger with which the selected subtrigger is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the subtrigger.

Index Index number associated with the subtrigger.

Action Action taken by the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Match Rate Number of Matches per second for the subtrigger.

Parameters Parameters that control the behavior of the subtrigger.
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The Ruleset subtable displays these columns for the selected signaling point:

Rules

The Rules subtable displays MLR rules information associated with the selected signaling point and 
ruleset.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Rules subtable except Set Name.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Rules subtable displays these columns for the selected signaling point:

Addresses

The Addresses subtable displays MLR address information associated with the selected signaling point 
and rule.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Addresses subtable except Set Name.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the ruleset.

Start Date Starting date and time for this ruleset to become active.

End Date Ending date and time for this ruleset to become active.

Segmented Indicates whether this ruleset should process segmented messages.

Protocol Default protocol for rules in this ruleset.

Search Type Search type that this ruleset should perform.

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the rule.

Index Index number associated with the rule.

Operation Type Types of messages on which this rule matches.

Protocol Protocol used for matching by this rule.

Matches Number of rule matches with result Action Performed.

Match Rate Number of Matches per second for the rule.

Rule Parameters Parameters that control the behavior of the rule.

Result Parameters Parameters that control the behavior of the result associated with this rule.
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The Addresses subtable displays these columns for the selected signaling point:

Results

The Results subtable displays MLR results information associated with the selected signaling point and 
rule or address.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Results subtable except Index.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Results subtable displays these columns for the selected signaling point:

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the address.

Address Type Type of address. The MWTM 6.0 supports these types of addresses:

• bch—Binary-coded hexadecimal

• gsmDa—Groupe Special Mobile (GSM) 7-bit default alphabet

Address Digits Address digits to be matched.

Exact Match Indicates whether an exact match to the Address Digits is required.

Matches Number of address matches with result Action Performed.

Match Rate Number of Matches per second for the address.

Result Parameters Parameters that control the behavior of the result associated with this 
address.

Column Description

Ruleset
(in subtable heading)

Ruleset associated with the results.

No Server Available 
Action
(in subtable heading)

Default behavior if no result is available. Possible actions are:

• Discard—Discard the packet without forwarding it.

• Resume—Return the unmodified packet to the higher level protocols for 
default routing.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the results.

Index Index number associated with the results.

Type Type of result. Possible values are:

• PC—Point code

• ASName—Application server name

Result Destination point code or name of the result.

Weight Weight for this result within its set of results.
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Viewing MLR Trigger Results

The MLR Trigger Results table displays the MLR results associated with the selected signaling point. 
You can use this subtable to determine which triggers, subtriggers, rules, and addresses are causing a 
particular result to execute.

The MLR Trigger Results table contains:

• Results, page 8-119

• Addresses, page 8-120

• Rules, page 8-120

• Ruleset, page 8-121

• SubTriggers, page 8-121

• Triggers, page 8-122

Results

The Results subtable displays all MLR results information associated with the selected signaling point.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Results subtable except Index.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Results subtable displays these columns for the selected signaling point:

Count Number of times this result is encountered.

Count Rate Number of times per second this result is encountered.

Column Description

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the results.

Index Index number associated with the results.

Type Type of result. Possible values are:

• PC—Point code

• ASName—Application server name

Result Destination point code or name of the result.

Weight Weight for this result within its set of results.

Count Number of times this result is encountered.

Count Rate Number of times per second this result is encountered.
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Addresses

The Addresses subtable displays MLR address information associated with the selected result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Addresses subtable except Set Name.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Addresses subtable displays these columns for the selected signaling point:

Rules

The Rules subtable displays MLR rules information associated with the selected result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Rules subtable except Set Name.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Rules subtable displays these columns for the selected signaling point:

Column Description

ResultSet
(in subtable heading)

Set of results associated with the addresses.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the address.

Address Type Type of address. The MWTM 6.0 supports these types of addresses:

• bch—Binary-coded hexadecimal

• gsmDa—Groupe Special Mobile (GSM) 7-bit default alphabet

Address Digits Address digits to be matched.

Exact Match Indicates whether an exact match to the Address Digits is required.

Matches Number of address matches with result Action Performed.

Match Rate Number of Matches per second for the address.

Result Parameters Parameters that control the behavior of the result associated with this 
address.

Column Description

ResultSet
(in subtable heading)

Set of results associated with the rules.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the rule.

Index Index number associated with the rule.

Operation Type Types of messages on which this rule matches.

Protocol Protocol used for matching by this rule.

Matches Number of rule matches with result Action Performed.
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Ruleset

The Ruleset subtable displays MLR ruleset information associated with the selected result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Ruleset subtable except Start Date and End Date.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Ruleset subtable displays these columns for the selected signaling point:

SubTriggers

The SubTriggers subtable displays MLR subtrigger information associated with the selected result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the SubTriggers subtable.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The SubTriggers subtable displays these columns for the selected signaling point:

Match Rate Number of Matches per second for the rule.

Rule Parameters Parameters that control the behavior of the rule.

Result Parameters Parameters that control the behavior of the result associated with this rule.

Column Description

Column Description

Rule Number
(in subtable heading)

Index number of the rule with which this ruleset is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the ruleset.

Start Date Starting date and time for this ruleset to become active.

End Date Ending date and time for this ruleset to become active.

Segmented Indicates whether this ruleset should process segmented messages.

Protocol Default protocol for rules in this ruleset.

Search Type Search type that this ruleset should perform.

Column Description

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the subtrigger.

Index Index number associated with the subtrigger.

Action Action taken by the subtrigger.

Matches Number of subtrigger matches with result Action Performed.
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Triggers

The Triggers subtable displays MLR trigger information associated with the selected result.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM displays all of the columns in the Triggers subtable except Set Name, Start Date, End Date, 
and Status.

For detailed information on working within tables, see Navigating Table Columns, page 5-23.

The Triggers subtable displays these columns for the selected signaling point:

Match Rate Number of Matches per second for the subtrigger.

Parameters Parameters that control the behavior of the subtrigger.

Column Description

Column Description

Ruleset
(in subtable heading)

Ruleset with which this trigger is associated.

Entries
(in subtable heading)

Total number of entries in the subtable.

Set Name Set name associated with the trigger.

Index Index number associated with the trigger.

SubTriggers Number of subtriggers associated with the selected trigger.

Start Date Date and time on which this trigger should begin filtering traffic.

If no Start Date is configured, this field displays N/A.

End Date Date and time on which this trigger should stop filtering traffic.

If no End Date is configured, this field displays N/A.

Status Current status of the trigger. Possible values are:

• Active—Either there is a corresponding GTT table entry for the trigger 
or, if this is an MTP3 trigger, there is an available route to the 
appropriate point code.

• Inactive—There is no corresponding GTT table entry or available route 
to the appropriate point code for the trigger. The trigger will never match 
and a configuration error is likely.

Action Action that the trigger takes.

Prematches Preliminary count of trigger matches.

Prematch Rate Number of Prematches per second for the trigger.

Matches Number of trigger matches with result Action Performed.

Match Rate Number of Matches per second for the trigger.

Parameters Parameters that control the behavior of the trigger.
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Viewing RAN-O Performance and Error Data
The MWTM client interface provides access to RAN-O real-time performance and error statistics that 
you can use to troubleshoot problems that occur in real time. The zoom and navigation features quickly 
enable isolating and focusing on a problem area. 

You use real-time charts in the MWTM client to view performance information and troubleshoot errors 
that occur on shorthaul and backhaul interfaces. To view performance data and errors for a shorthaul or 
backhaul interface, select the interface in the navigation tree, then click the Performance or Errors tab. 

For example, while viewing backhaul statistics in the Performance tab, you might observe a spike on the 
error chart. You can click the Errors tab to view the shorthaul error chart. From this chart, you can 
right-click and go to a specific shorthaul to view its performance and error details.

Note The web interface provides historical (not real-time) charts depicting performance and error information 
over user-specified time ranges. You can use historical statistics for capacity planning and trend analysis. 
See Displaying RAN-O Historical Statistics, page 11-29.

This section provides information about:

• Viewing Performance Data, page 8-123

• Viewing Error Data, page 8-130

Viewing Performance Data
You view performance data for a shorthaul or backhaul interface by selecting it in the navigation tree of 
the DEFAULT view (or any custom view) and clicking on the Performance tab in the right pane. 

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > RAN-O OS README.

• Client interface, choose View > Web > Administrative; then click RAN-O OS README.

The Performance tab displays one or more charts depending on whether you selected a shorthaul or a 
backhaul interface. These charts depict send and receive rates of optimized IP traffic over time. The 
charts display the traffic from 0 to the maximum speed on the interface. You can set the client preferences 
to display this data in bits or bytes per second. The default polling interval is 15 seconds, but you can 
change the frequency in the Poller Settings dialog box, which you launch by clicking the Change Poller 
button.

The Performance tab also shows total send and receive errors when you select a backhaul interface.

This section provides information about:

• Viewing Shorthaul Performance Data, page 8-124

• Viewing Backhaul Performance Data, page 8-126
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Viewing Shorthaul Performance Data

The Performance tab for a shorthaul interface displays a single chart that shows:

• The send rate plotted in one color and the receive rate plotted in a different color (Figure 8-20). 

• A vertical band when the congestion mechanism is active (see the Cisco MWR 1941-DC-A Mobile 
Wireless Edge Router Software Configuration Guide for congestion management information). 

• A different colored vertical band when no data exists. 

Figure 8-20 Performance Tab for Shorthaul Interface

Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-125.

Poll Interval Label that shows the current poll interval in seconds.

Bits or Bytes/Sec Y-axis label that displays traffic rate in bits or bytes per second. The default is bits 
per second. The Y axis automatically scales to the interface speed. To change the 
charts to show bytes per second, uncheck the Show Details in Bits instead of Bytes 
check box in the Preferences window (General Display Settings, page 5-4).

http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
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Change Poller

To change the poll interval, click the Change Poller button. The MWTM displays the Poller Settings 
dialog box (Figure 8-21).

Figure 8-21 Poller Settings Window

The Poller Settings window displays these labels and buttons for the selected shorthaul or backhaul 
interface:

Time X-axis label that displays a real-time scale and the server time zone.

Legend Identifies the data series currently showing in the chart. 

• No Data—Data is not available. A vertical bar appears in the chart.

• Congestion Active—Shows when the shorthaul is in a congested state. A 
vertical bar appears in the chart.

Note You can configure the congestion mechanism for low-latency GSM and 
UMTS traffic. Other traffic (for example, SNMP or file transfer) can be 
discarded without entering the congestion mechanism. For detailed 
information about GSM and UMTS congestion management, see the Cisco 
MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration 
Guide.

GUI Elements Description

Label/Button Description

Poll Interval 
(secs)

The poll interval, in seconds, for the selected node.

To set a new poll interval, click in the Poll Interval (secs) text box and enter a new 
value. The default value is 15 seconds. Valid values are between 5 and 60.

Current Poll 
Interval

Value of the poll interval currently in use.

Number of Polls 
Received

Number of polls received by the selected node.

Running Time Time in hours, minutes, and seconds that the poller is running.

Change Changes the poll interval from the current setting to the value you have entered in 
the Poll Interval (secs) text box.

http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
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Right-click Menu

A right-click context menu provides options to navigate to the backhauls that are associated with the 
selected shorthaul interface. You can also modify how the chart appears. The right-click menu contains:

Viewing Backhaul Performance Data

The Performance tab for a backhaul interface displays multiple charts within a split pane (Figure 8-22). 
The top pane displays send rate statistics, and the bottom pane displays receive rate statistics. You can 
maximize either pane to full screen size by using the split-pane control bar. 

Close Closes the Poller Settings window.

Help Displays online help for the current window.

Label/Button Description

Menu options Description

Goto > backhaul Opens the Performance tab for the backhaul interface associated with the selected 
shorthaul interface.

Hide > field Hides the currently shown data series.

Show > field Shows the currently shown data series.

Reset Zoom If you have zoomed into a specific area of the chart, resets the zoom. 

Note To zoom into a specific area of the chart, use the left mouse button to drag 
a box around the area.

Grid On Displays a grid on the chart.

Grid Off Removes the grid from the chart.

Shapes On Displays individual data points as shapes on the send and receive rate lines and the 
chart legend.

Shapes Off Removes shapes from the send and receive rate lines and the chart legend.
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Figure 8-22 Performance Tab for Backhaul Interface

Each pane contains three charts that share the same time domain: 

• Top chart—Displays total GSM traffic, total UMTS traffic, and total traffic (a summation of total 
GSM and total UMTS) in bits or bytes per second (left Y axis). The right Y axis displays the 
backhaul utilization as a percentage of the user bandwidth. You can change the scale of the Y axis 
by changing the User Bandwidth (see Editing Properties for a RAN-O Backhaul, page 6-33). The Y 
axis automatically scales to the User Bandwidth.

The top chart overlays the traffic display on top of threshold ranges (acceptable, warning, and 
overloaded) that are represented by color-coded, horizontal bands.

• Middle chart—Displays the traffic rates in bits or bytes per second for each shorthaul interface that 
is associated with the backhaul interface. 

• Bottom chart—Displays total send-and-receive errors per second over time for all of the shorthaul 
interfaces included in the backhaul interface.
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Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-125.

Poll Interval Label that shows the current poll interval in seconds.

SH or BH 
Bits or Bytes/Sec

Left Y-axis label that displays shorthaul (SH) or backhaul (BH) traffic rate in bits 
or bytes per second. The default is bits per second. This label appears for only the 
top and middle charts of both panes. The Y axis automatically scales to the User 
Bandwidth.

To change the charts to show bytes per second, uncheck the Show Details in Bits 
instead of Bytes check box in the Preferences window (General Display Settings, 
page 5-4).

% Utilization Y-axis label on the right side of the chart. The right-side axis displays the 
backhaul utilization as a percentage of the User Bandwidth. The chart background 
is color-coded to indicate these thresholds:

• Overloaded—Top portion of chart background

• Warning—Middle portion of chart background

• Acceptable—Bottom portion of chart background

For definitions of these thresholds, see Threshold Information (RAN-O Only), 
page 8-42.

To change threshold settings, including the User Bandwidth, see Editing 
Properties for a RAN-O Backhaul, page 6-33.

Errors/Sec Y-axis label that displays the total number of errors per second for send and 
receive traffic. This label appears only for the bottom chart of both panes.

Note The same Errors/Sec chart appears in each pane. 

Time X-axis label that displays real-time scales for all the charts in the pane. The chart 
also shows the server time zone.

Split-pane Control Pane sizing feature that separates the top and bottom panes. To fully expand the:

• Bottom pane, click the noninverted triangle on the control bar.

• Top pane, click the inverted triangle on the control bar.

To partially expand a pane, left-click the control bar and drag it up or down.

Legend Color-coded legend to the right of the charts that describes the information that 
appears in all three charts of the pane.
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Right-click Menu

A right-click context menu provides options to navigate to the shorthauls that are associated with the 
selected backhaul interface. You can also modify how the chart appears. 

The right-click menu contains:

Display Series Dialog Box

The Display Series dialog box allows you to select data series to show or hide. 

The Display Series dialog box contains:

Menu options Description

Goto > shorthaul Opens the Performance tab for the shorthaul interface associated with the selected 
backhaul interface.

Display Series... Opens the Display Series dialog box, which allows you to select data series to show 
or hide. See Display Series Dialog Box, page 8-129.

Reset Zoom If you have zoomed into a specific area of the chart, resets the zoom. 

Note To zoom into a specific area of the chart, use the left mouse button to drag 
a box around the area.

Grid On Displays a grid on the chart.

Grid Off Removes the grid from the chart.

Shapes On Displays data points as shapes on the send and receive rate lines and the chart 
legend.

Shapes Off Removes shapes from the send and receive rate lines and the chart legend.

Column or Button Description

Display Column of check boxes that allow you to display (by checking) or hide (by 
unchecking) the data series associated with the selected backhaul.

The MWTM displays no more than 12 series by default. You can change this setting 
for the MWTM Client Display or the MWTM Web Display:

Display 
(continued)

MWTM Client Display

To change the maximum number of data series that the MWTM client interface 
displays by default, edit the MAX_CHART_SERIES parameter in the client-side 
System.properties file:

• For the Windows client: C:\Program Files\Cisco Systems\MWTM Client
\properties\System.properties

• For Solaris or Linux client: /opt/CSCOsgmClient/System.properties

Caution Depending on the processing power and memory of your client system, 
setting the MAX_CHART_SERIES parameter too high can cause the 
client display to become unresponsive. If the client becomes 
unresponsive, set the MAX_CHART_SERIES to a lower value.

Remember to restart the client to activate the new MAX_CHART_SERIES value.
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Viewing Error Data
You view error data for a shorthaul or backhaul interface by selecting it in the navigation tree of the 
DEFAULT view (or any custom view) and clicking on the Errors tab in the right pane. 

The Errors tab shows shorthaul and backhaul errors for the selected interface.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > RAN-O OS README.

• Client interface, choose View > Web > Administrative; then click RAN-O OS README.

Viewing Shorthaul Errors

When you select a GSM Abis shorthaul interface in the navigation tree within the DEFAULT view (or 
any custom view), the MWTM displays optimization, missed packet, and miscellaneous errors in the 
right pane (Figure 8-23). When you select a UMTS Iub shorthaul interface, the MWTM displays 
optimization and miscellaneous errors. 

This window also includes a chart that displays the total number of errors per second. The chart has a 
right-click menu with options to similar to those of the right-click menu of the Performance window. 

Display 
(continued)

MWTM Web Display

To change the maximum number of data series that the MWTM web interface 
displays by default, edit the MAX_CHART_SERIES parameter in the server-side 
System.properties file: /opt/CSCOsgm/properties/System.properties.

Caution Depending on the number of shorthauls that you display, setting the 
MAX_CHART_SERIES parameter too high can cause the web display to 
become unresponsive. If the web become unresponsive, set the 
MAX_CHART_SERIES to a lower value.

Remember to restart the server to activate the new MAX_CHART_SERIES value.

Series Name Name of the data series to display or hide.

RAN Backhaul The RAN backhaul that is associated with the data series.

This column appears only when the selected backhaul is a virtual backhaul. For 
more information about virtual backhauls, see Creating Virtual RAN Backhauls, 
page 8-136.

Close Closes the Display Series dialog box.

Help Opens the help system for the Display Series dialog box.

Column or Button Description
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You can use the split pane control bar to resize or maximize the error tables or the error chart.

Figure 8-23 Example of Shorthaul Errors for GSM Abis Interface

Content Pane

The content (right) pane contains: 

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-125.

Reset Counters Opens the Reset Counters dialog box to configure the method of polling. See 
Changing Real-Time Poller and Counter Settings, page 5-20.

Poller Counter 
Mode

Label that displays the polling mode that you configure in the Reset Counters 
dialog box.

Poll Interval Label that shows the current poll interval in seconds.

Optimization 
Failures

Pane that displays optimization failures for the selected GSM Abis or UMTS Iub 
shorthaul interface. See Optimization Failures, page 8-132. 

Miscellaneous Pane that displays miscellaneous errors on the selected shorthaul interface. See 
Miscellaneous, page 8-133. 

Note This pane appears for both GSM Abis and UMTS Iub shorthaul interfaces 
but with some differences in the types of errors shown.
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Optimization Failures 

The Optimization Failures pane has a table that contains: 

Missed Packets Pane that displays missed packet errors on the selected GSM Abis shorthaul 
interface. See Missed Packets, page 8-134. 

Note This pane appears only for GSM Abis shorthaul interfaces.

Split-pane 
Control Bar

Pane sizing feature that separates the top and bottom panes. To fully expand the:

• Bottom pane, click the noninverted triangle on the control bar.

• Top pane, click the inverted triangle on the control bar.

To partially expand a pane, left-click the control bar and drag it up or down.

Total Errors / 
Second

Chart that displays the total number of errors per second on the shorthaul interface. 
See Total Errors per Second, page 8-135.

GUI Elements Description

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of optimization failure on the GSM Abis or UMTS Iub

• Counters—Number of errors of a particular type

• Rates (per sec)—Error rate for a particular type of error

Total Total number of optimization failures encountered during the compression and 
decompression of the GSM-Abis or UMTS-Iub traffic.

Packet 
Unavailable

The number of times compression failed because a packet was unavailable.

Reconstruction 
Failures

The number of times information in a packet could not be decompressed.

Encapsulation 
Errors

The number of times compression failed because of encapsulation errors.

QoS Drops The number of times compression failed because of quality of service errors or 
traffic load.

Peer Route 
Unavailable

The number of times compression failed because a route to the peer was not 
available.

Interface Down The number of times compression failed because an interface was down.

Congestion 
Drops (GSM 
Abis only)

The number of dropped GSM packets or UMTS cells because of traffic congestion.

Note You can configure the congestion mechanism for low-latency GSM and 
UMTS traffic. Other traffic (for example, SNMP or file transfer) can be 
discarded without entering the congestion mechanism. For detailed 
information about GSM and UMTS congestion management, see the Cisco 
MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration 
Guide.

http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_book09186a00804d4521.html
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Miscellaneous 

The Miscellaneous pane has a table that contains: 

Note The error types in the table apply to UMTS Iub and GSM Abis shorthaul interfaces unless otherwise 
noted.

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of miscellaneous error on the GSM Abis or UMTS Iub 
shorthaul.

• Counters—Number of errors of a particular type.

• Rates (per sec)—Error rate for a particular type of error.

Total Total number of miscellaneous failures encountered during the compression and 
decompression of the GSM-Abis or UMTS-Iub traffic.

Peer Not Ready The count of packets dropped on the backhaul because the peer was not ready.

Peer Not Active 
(GSM Abis only)

The count of packets dropped on the backhaul because the peer was reachable but 
not in an active state.

Invalid Packets The number of backhaul packets that were received and dropped because they 
contained invalid information.

Packet Allocation 
(UMTS Iub only)

The number of times a packet could not be allocated to send data on the UMTS Iub 
shorthaul interface.

Protocol 
Encapsulation 
Errors (UMTS 
Iub only)

The number of times compression failed because of encapsulation errors.

Local PVC 
Unavailable 
(UMTS Iub only)

The number of packets dropped because a local PVC was unavailable.

Remote PVC 
Unavailable 
(UMTS Iub only)

The number of packets dropped because a remote PVC was unavailable.

Backhaul Drops 
(UMTS Iub only)

The number of packets dropped on the backhaul.

Lost Received 
Packets (GSM 
Abis only)

The number of backhaul packets expected to be received but that never arrived.

Lost Sent Packets 
(GSM Abis only)

The number of backhaul packets sent but the peer never received.

Fast Send 
Failures (GSM 
Abis only)

The number of fast send failures on the shorthaul interface.

Transmit Failures 
(GSM Abis only)

The number of packet transmit failures on the shorthaul interface.
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Missed Packets 

The Missed Packets pane appears only for GSM Abis shorthaul interfaces and has a table that contains: 

Interrupt Failures 
(GSM Abis only)

The number of packets lost due to interrupt failures.

Late Arrivals 
(GSM Abis only)

The number of GSM packets that arrived later than the allowed time.

Early Arrivals 
(GSM Abis only)

The number of GSM packets that arrived earlier than the allowed time.

GUI Elements Description

GUI Elements Description

Columns Table columns that list:

• Type of error—Type of missed packet error on the GSM Abis shorthaul 
interface.

• Counters—Number of errors of a particular type.

• Rates (per sec)—Error rate for a particular type of error.

Total Total number of missed packet errors encountered during the compression and 
decompression of the GSM-Abis shorthaul interface.

Late Packets The number of packets missed on the backhaul because they arrived past the 
allowed time frame

Lost Packets The number of packets missed because they were lost on the backhaul

Overruns (GSM 
Abis only)

The number of packets missed due to the jitter buffer running out of available 
space.

Transmit 
Interface Resets 
(GSM Abis only)

The number of transmission interface resets.

Transmit Buffer 
Unavailable 
(GSM Abis only)

The number of times that the system is unable to allocate buffer for transmission.

Reset Event The number of packets missed on the backhaul because of a reset event

Insufficient 
Memory

The number of packets missed on the backhaul for lack of available memory to 
allocate the packet
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Total Errors per Second 

The Total Errors per Second pane displays a chart that contains: 

A right-click menu provides navigational and chart control options. See Right-click Menu, page 8-126.

Viewing Backhaul Errors

When you select a backhaul interface in the navigation tree, the MWTM displays a chart in the right pane 
(Figure 8-24). The charts shows GSM and UMTS errors per second for each shorthaul interface included 
in the backhaul. 

Figure 8-24 Example of Backhaul Errors Chart

GUI Elements Description

Total Errors/Second 
(shorthaul)

Chart title that lists the selected shorthaul.

Errors/Sec Y-axis label that displays errors per second for the selected shorthaul.

Time X-axis label that displays a real-time scale for the selected shorthaul. The chart 
also displays the server time zone.
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The content (right) pane contains: 

A right-click menu provides navigational and chart control options. See Right-click Menu, page 8-129.

Viewing RAN Shorthauls
To view RAN shorthauls that are associated with a RAN-O backhaul, select the backhaul object in the 
navigation tree in the left pane, and click the RAN Shorthauls tab in the right pane. The right pane 
displays a tabular list of RAN shorthauls that are associated with the selected backhaul.

To view descriptions of the columns of the RAN shorthauls table, see RAN Shorthauls Table, page 6-27.

Creating Virtual RAN Backhauls
You use the MWTM to create a virtual RAN backhaul by grouping real backhauls. A virtual backhaul is 
useful if you have configured several RAN backhauls for the same interface. To view the utilization for 
that interface, create a virtual RAN backhaul that contains all the real backhauls that you have configured 
for the interface.

To create a virtual RAN backhaul, right-click a RAN backhaul, then choose Create Virtual RAN 
Backhaul. The MWTM displays the Virtual RAN Backhaul Editor.

GUI Elements Description

Change Poller Button that opens the Poller Settings dialog box. See Change Poller, page 8-125.

Poll Interval Label that shows the current poll interval in seconds.

Last Poll Label that displays the date and time of the last poll.

GSM and UMTS 
Errors/Second

Chart title for GSM and UMTS errors.

Errors/Sec Y-axis label that displays errors per second.

Time X-axis label that displays a real-time scale and the server time zone.

Legend Color-coded legend for the shorthaul interfaces included in the selected backhaul.
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Figure 8-25 Virtual RAN Backhaul Editor 

The Virtual RAN Backhaul Editor contains:

To create a virtual RAN backhaul:

Step 1 Right-click a backhaul in the RAN Backhauls table or within a view in the navigation tree.

Step 2 Choose Create Virtual RAN Backhaul in the right-click menu.

The Virtual RAN Backhaul Editor appears.

Step 3 In the Available Backhauls pane, choose a backhaul from the table.

Step 4 Click Add to add the selected backhaul to the Included Backhauls table.

Step 5 Repeat Step 4 for each additional backhaul you want to include in the virtual backhaul.

Field or Button Description

Name Name of the virtual RAN backhaul.

Available 
Backhauls

Pane that contains the Available Backhauls table, which contains these columns:

• Name—Name of the RAN backhaul

• Node—Node to which the RAN backhaul belongs

Included Backhauls Pane that contains the Included Backhauls table, which contains these columns:

• Name—Name of the RAN backhaul

• Node—Node to which the RAN backhaul belongs

Add Adds the selected backhaul to the Included Backhauls table.

Remove Removes the selected backhaul from the Included Backhauls table.

Save Saves the virtual RAN backhaul and closes the Virtual RAN Backhaul Editor.

Cancel Cancels the current operation and closes the Virtual RAN Backhaul Editor.

Help Opens the Help window for this feature.
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Step 6 To remove a backhaul from the Included Backhauls table, choose a backhaul from the table and click 
Remove.

Step 7 In the Name field at the top of the dialog box, enter a name for the virtual backhaul.

Step 8 Click Save to create the virtual RAN backhaul and close the dialog box.
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Managing Events

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to view information about all 
discovered events, including their associated network objects and other information.

This chapter includes:

• Viewing Basic Information for All Events, page 9-2

• Viewing Events for a Specific Object, page 9-8

• Setting an Event Filter, page 9-8

• Loading an Existing Event Filter, page 9-16

• Saving an Event Filter File, page 9-17

• Viewing Event Properties, page 9-18

• Attaching a Note to an Event, page 9-21

• Setting an Event Filter, page 9-8

• Viewing Archived Event Files on the Web, page 9-22

• Viewing the Event Metrics Report on the Web, page 9-23

• Changing the Way the MWTM Processes Events, page 9-27

• Forwarding Events as Traps to Other Hosts, page 9-40

• Setting Sounds for Events at an MWTM Client, page 9-41

• Displaying Alarms, page 9-46
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Viewing Basic Information for All Events
To view basic information for all events, click Events in the navigation tree of the MWTM in either the 
client interface or the web interface. The Event window appears.

Note The client interface provides right-click menu options, toolbar buttons, and user-customized column 
display of event data. The web interface provides some slightly different toolbar buttons and columns. 
Differences are noted in this section.

Figure 9-1 Event Window of the Client Interface

The Event window shows information about the events that the MWTM event logger and event processor 
deliver for all objects in the current network view.

Note You can view multiple Event windows at the same time, with different event filtering in each window or 
dialog box.

The Event window is composed of these sections:

• Event Toolbar Buttons, page 9-3

• Right-Click Menu for All Events, page 9-4

• Right-Click Menu for a Specific Event, page 9-4

• Event Table, page 9-5
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Event Toolbar Buttons
The Event window within the client and the Web may provide these toolbar buttons:

Button Description

Set Filter Opens the Event Filter dialog box.

Apply Filter

or

Remove Filter

Activates and deactivates the event filter specified in the Event Filter 
dialog box. If:

• The filter is activated, the MWTM shows only those events that 
pass the filter.

• The filter is deactivated, the MWTM shows all events.

• You activate a filter in an object’s Recent Events table in the 
MWTM main window, the filter is activated in all Recent Events 
tables in the MWTM main window for all other objects. The filter 
is not activated in Recent Events tables in Show In New Window 
windows or Real-Time Data and Charts windows.

Archived 
(Web interface only)

By default, the Recent Events table appears on the Web. Clicking on 
Archived shows the Archived Events table. Click the Archived button 
again to switch back and forth.

Pause

or

Resume

(Client interface only)

Pauses or resumes the table.

While the table is paused, the MWTM does not display new events in 
the table (unless you apply an event filter or edit your event 
preferences). When the table is resumed, all new events since the table 
was paused are added to the display.

If events are deleted while the table is paused, they are not removed 
from the table. Instead, they are grayed-out and cannot be 
acknowledged or edited. Deleted events are removed from the table 
when you resume the table.

Acknowledge

(Client interface only)

Makes the selected event or events acknowledged.

Unacknowledge

(Client interface only)

Makes the selected event or events unacknowledged.

Event Properties

(Client interface only)

Opens the Event Properties window.

Edit Notes

(Client interface only)

Opens the Edit Event dialog box.

Time Difference

(Client interface only)

Shows the time difference in days, minutes, hours, and seconds 
between two events.

Find

(Client interface only)

Finds specific text in the event table.

Create Sound Filter

(Client interface only)

Opens the Event Sound Filters dialog box and the Event Sound Filters 
List dialog box, with fields populated based on the selected event.
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Right-Click Menu for All Events

Note This feature is available only in the MWTM client interface.

To see the right-click menu for all events, select Events in the navigation tree left pane and click the 
right mouse button. The events right-click menu provides these options:

Right-Click Menu for a Specific Event

Note This feature is available only in the MWTM client interface.

The Event window provides a subset of the MWTM main menu as a right-click menu. To see this menu, 
select an event and click the right mouse button. The event right-click menu provides these options:

Adjust Row Height

(Client interface only)

Adjusts the table row height and wraps the message text. Click:

• Once to double the row height and wrap the message text.

• Again to triple the row height and wrap the message text.

• Again for single row height and no message text wrapping. This 
is the default setting.

This setting is saved automatically with your preferences.

Help for Event Shows context-sensitive help for the selected event in a separate 
browser window.

Button Description

Menu Command Description

Show In New Window Opens the Event window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Menu Command Description

Edit Notes Opens the Edit Event dialog box for the selected event.

Go To > Object Shows the window for the object associated with the 
selected event.

If no object is associated with the event, this option is not 
visible.
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Event Table
The event table shows information about events that the MWTM event logger and event processor 
deliver.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM shows all of the columns in the event table except Internal ID, Event Name, Element Name, 
Original Severity, Count, Note, Change Time, Change By, Ack By, Node, Card, SP, Linkset, Link, 
SGMP, ASP, AS, ASPA, Interface, or RAN Backhaul.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

To see detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

Note The Event table in the web interface displays fewer columns than the client interface. Only the Category, 
Severity, Create Time, and Severity columns appear in the web interface. Resizing and hiding columns 
and right-click menus are possible only in the client interface. 

Change Severity Changes the severity of the event. Severities include:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event 
Severities and Colors, page 9-35).

Acknowledge Makes the event acknowledged and records the user ID.

Unacknowledge Makes a previously acknowledged event unacknowledged.

Event Properties Opens the Event Properties window.

Create Sound Filter Opens the Event Sound Filters dialog box and the Event 
Sound Filters List dialog box, with fields populated based 
on the selected event.

Help for Event Shows context-sensitive help for the selected event in a 
separate browser window.

Menu Command Description
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Column Description

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, that the 
MWTM assigns for its own internal use. This ID can also be useful when the Cisco 
Technical Assistance Center (TAC) is debugging problems.

Ack Indicates whether the event has been acknowledged. To:

• Acknowledge an unacknowledged event, use the Acknowledge toolbar button.

• Make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Event Name Name of the event.

Element Name Network element name associated with the event.

Category Type of the event. Default values include:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to log 
in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route file, 
has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing Data 
selected, and the MWTM has deleted the existing the MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field (see Changing Event Categories, page 9-33).
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Severity Severity of the event. Default values include:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event Severities and Colors, page 9-35).

Original 
Severity

Original severity of the event.

Count Number of times this event occurred.

Note Indicates whether a note associated with the event.

Create Time Time this event was received.

Change Time Time this event was last updated.

Change By User who last changed this event.

Ack By If you have not implemented the MWTM User-Based Access, name of the node that 
last acknowledged the event.

If you have implemented the MWTM User-Based Access, name of the user who last 
acknowledged the event.

If no one has acknowledged the event, this field is blank.

Node Name of the node associated with the event. If no node is associated with the event, 
None appears.

Card (RAN-O 
only)

Card associated with this event.

SP (ITP only) Name of the signaling point associated with the event. If no signaling point is 
associated with the event, None appears.

Linkset (ITP 
only)

Name of the linkset associated with the event. If no linkset is associated with the 
event, None appears.

Link (ITP only) Name of the link associated with the event. If no link is associated with the event, 
None appears.

SGMP (ITP 
only)

Name of the signaling gateway-mated pair associated with the event. If no signaling 
gateway-mated pair is associated with the event, None appears.

ASP (ITP only) Name of the application server process associated with the event. If no application 
server process is associated with the event, None appears.

AS (ITP only) Name of the application server associated with the event. If no application server is 
associated with the event, None appears.

ASPA (ITP 
only)

Name of the application server process association associated with the event. If no 
application server process association is associated with the event, None appears.

Column Description
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Viewing Events for a Specific Object
You can use the MWTM to view events for a selected object. To do so, right-click an object (for example, 
a node) in a window, then choose View > Recent Events from the right-click menu. The MWTM shows 
recent events for the selected object (see Viewing Recent Events, page 8-44).

Setting an Event Filter
You can use the MWTM to change the way event information appears.

Note You can access the Event Filter dialog box through either the client interface or the web interface. Minor 
differences that exist are noted in this section.

To change the way the MWTM presents event information, click Events in the navigation tree, then click 
the Event Filter tool at the top of the Event window. The Event Filter dialog box appears with the 
Properties tab selected.

Figure 9-2 Event Filter Dialog, Showing Event Properties

Interface Interface associated with this event.

RAN Backhaul 
(RAN-O only)

RAN backhaul associated with this event.

Column Description
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For more information about the Event Filter dialog box, see these sections:

• Event Filter Buttons, page 9-9

• Properties Settings, page 9-9

• Selected Objects Settings, page 9-12

• Event Filter Example, page 9-15

Related Topics:

• Loading an Existing Event Filter, page 9-16

• Saving an Event Filter File, page 9-17

• Viewing Event Properties, page 9-18

Event Filter Buttons
The Event Filter dialog box contains:

Properties Settings
You use the Properties settings in the Event Filter dialog box to specify the types of event the MWTM 
should display in the Event window, including the category and severity of event, whether the event is 
acknowledged, and other properties.

To display the Properties settings, click the Properties tab in the Event Filter dialog box.

The Properties settings contain these panes:

• Categories, page 9-10

• Severities, page 9-11

• Other, page 9-11

Button Description

Select All Checks all check boxes in the section.

Deselect All Unchecks all check boxes in the section.

OK Applies any changes you made to the event filter and closes the Event Filter dialog 
box.

Load Opens the Load File Dialog: Load Filter, which you use to load an already existing 
event filter file.

If you are viewing events for a specific object in the navigation tree of the MWTM 
main window, this button is not available.

Save Opens the Save File Dialog: Save Filter, which you use to save the event filter file with 
a new name, or overwrite an existing event filter file.

If you are viewing events for a specific object in the navigation tree of the MWTM 
main window, this button is not available.

Cancel Closes the Event Filter dialog box without applying any changes to the event filter.

Help Shows online help for the current dialog box.
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Categories

Use the Categories pane of the Properties settings to specify which event categories you want to display 
in the Event window.

The Categories pane contains these default fields and buttons:

Note These are the default categories; there might be additional categories that the MWTM system 
administrator defines. For information about custom categories, see Changing Event Categories, page 
9-33.

Check Box Description

Status Indicates whether Status events appear in the Event window. The check box is 
checked by default.

Trap Indicates whether Trap events appear in the Event window. The check box is 
checked by default.

Create Indicates whether Create events appear in the Event window. The check box is 
checked by default.

Delete Indicates whether Delete events appear in the Event window. The check box is 
checked by default.

Discover Indicates whether Discover events appear in the Event window. The check box is 
checked by default.

Edit Indicates whether Edit events appear in the Event window. The check box is 
checked by default.

Ignore Indicates whether Ignore events appear in the Event window. The check box is 
checked by default.

Login Indicates whether Login events appear in the Event window. The check box is 
checked by default.

LoginDisable Indicates whether LoginDisable events appear in the Event window. The check box 
is checked by default.

LoginFail Indicates whether LoginFail events appear in the Event window. The check box is 
checked by default.

Logout Indicates whether Logout events appear in the Event window. The check box is 
checked by default.

OverWrite Indicates whether OverWrite events appear in the Event window. The check box is 
checked by default.

Poll Indicates whether Poll events appear in the Event window. The check box is 
checked by default.

Purge Indicates whether Purge events appear in the Event window. The check box is 
checked by default.
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Severities

Use the Severities pane of the Properties settings to specify which event severities you want to display 
in the Event window.

The Severities pane contains these default fields:

Note These are the default severities; there might be additional severities that the MWTM system 
administrator defines. For information about custom severities, see Changing Event Severities and 
Colors, page 9-35.

Other

Use the Other pane of the Properties settings to further define the event filter for the Event window. 
These settings are applied to all event displays in the current view.

Check box Description

Informational Indicates whether events of the specified severity appear in the Event window. 
Severities include:

• Informational

• Normal

• Indeterminate

• Warning

• Critical

• Minor

• Major

Note Check boxes are checked by default.

Normal

Indeterminate

Warning

Critical

Minor

Major

Field Description

Acknowledged Check box indicating whether only acknowledged events appear in the Event 
window. This check box is unchecked by default.

Unacknowledged Check box indicating whether only unacknowledged events appear in the 
Event window. This check box is checked by default.

Time Before Check box indicating whether only events that the MWTM logs prior to a 
specified date and time appear in the Event window. This check box is 
unchecked by default.

Time Before Specifies the date and time prior to which events that the MWTM logs appear 
in the Event window. This field is dimmed unless the Time Before check box 
is checked.

Time After Check box indicating whether only events that the MWTM logs after a 
specified date and time appear in the Event window. This check box is 
unchecked by default.
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Selected Objects Settings

Note The Selected Objects tab is not available in the Events dialog box if you are viewing events:

• For a specific object in the navigation tree of the MWTM main window.

• Using the web interface.

To specify an object for which the MWTM should display events in the Event window:

Step 1 Click Events in the navigation tree.

The Events window appears in the right pane.

Step 2 Click the Event Filter tool at the top of the Event window. 

The Event Filter dialog box appears with the Properties tab selected.

Step 3 Click the Selected Objects tab in the Event Filter dialog box. 

The Event Filter dialog box appears with the Selected Objects tab highlighted.

Time After Specifies the date and time after which events that the MWTM logs appear in 
the Event window. This field is dimmed unless the Time After check box is 
checked.

Message Contains Check box indicating whether only events that contain the specified message 
text appear in the Event window. This check box is unchecked by default.

Match Case Check box indicating whether only events that match the case of the text in the 
Message Contains field appear in the Event window. This field is dimmed 
unless the Message Contains check box is checked. If the Message Contains 
check box is checked, the default setting for this check box is unchecked.

Suppress events for 
unmanaged nodes

Check box for suppressing events for any objects that have been set to the 
unmanaged state (see Unmanaging and Managing Nodes or ITP Signaling 
Points, page 6-38, for steps to set an object to the unmanaged state). To 
suppress events for unmanaged objects, check the check box. To retain events 
for unmanaged objects, uncheck the check box.

If you are viewing events for a specific object in the navigation tree of the 
MWTM main window, this button is not available.

Field Description
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Figure 9-3 Event Filter Dialog, Showing Event Selected Objects

The Selected Objects settings contains:

Field or Button Description

Node Drop-down list box of all nodes that the MWTM has discovered. If you:

• Want to filter events based on a node, select a node from the 
drop-down list box.

• Do not want to filter events based on a node, select None. The 
MWTM grays-out the other object fields. This is the default 
setting.

ApplicationServerProcess 
(ITP only)

Drop-down list box of all application server processes associated with 
the selected node:

• If you want to filter events based on an application server process, 
select an application server process from the drop-down list box.

• If you do not want to filter events based on an application server 
process, select None. This is the default setting.

SignalingGatewayMatedPair 
(ITP only)

Drop-down list box of all signaling gateway-mated pairs associated 
with the selected node:

• If you want to filter events based on a signaling gateway-mated 
pair, select a signaling gateway-mated pair from the drop-down list 
box.

• If you do not want to filter events based on a signaling 
gateway-mated pair, select None. This is the default setting.
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SignalingPoint (ITP only) Drop-down list box of all signaling points associated with the selected 
node:

• If you want to filter events based on a signaling point, select a 
signaling point from the drop-down list box.

• If you do not want to filter events based on a signaling point, select 
None. This is the default setting.

Linkset (ITP only) Drop-down list box of all linksets associated with the selected 
signaling point:

• If you want to filter events based on a linkset, select a linkset from 
the drop-down list box.

• If you do not want to filter events based on a linkset, select None. 
This is the default setting.

Link (ITP only) Drop-down list box of all links associated with the selected linkset:

• If you want to filter events based on a link, select a link from the 
drop-down list box.

• If you do not want to filter events based on a link, select None. This 
is the default setting.

ApplicationServer (ITP only) Drop-down list box of all application servers associated with the 
selected signaling point:

• If you want to filter events based on an application server, select an 
application server from the drop-down list box.

• If you do not want to filter events based on an application server, 
select None. This is the default setting.

ApplicationServerProcess
Association (ITP only)

Drop-down list box of all application server process associations 
associated with the selected application server:

• If you want to filter events based on an application server process 
association, select an application server process association from 
the drop-down list box.

• If you do not want to filter events based on an application server 
process association, select None. This is the default setting.

Card (RAN-O only) Drop-down list box of all cards associated with the selected node:

• If you want to filter events based on a card, select a card from the 
drop-down list box.

• If you do not want to filter events based on a card, select None. 
This is the default setting.

Interface Drop-down list box of all interfaces (including subinterfaces) 
associated with the selected node or card:

• If you want to filter events based on an interface, select an interface 
from the drop-down list box.

• If you do not want to filter events based on an interface, select 
None. This is the default setting.

Field or Button Description
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Event Filter Example
This example shows how to set an event filter to display trap messages for warning events for a specific 
node.

Step 1 Choose Events in the navigation tree of the MWTM main window of the client interface.

Step 2 Click the Event Filter tool at the top of the Event window. 

The Event Filter dialog box appears with the Properties tab selected.

Step 3 In the Categories pane, uncheck all check boxes except for the Trap check box.

Step 4 In the Severities pane, uncheck all check boxes except for the Warning check box.

Step 5 Click the Selected Objects tab.

Step 6 In the drop-down list box, choose a node from the list of discovered nodes.

Backhaul (RAN-O only) Drop-down list box of all RAN backhauls associated with the selected 
node or card:

• If you want to filter events based on an interface, select an interface 
from the drop-down list box.

• If you do not want to filter events based on an interface, select 
None. This is the default setting.

Selected Objects: Object 
Type

Indicates the type of object, if any, on which the event filter is based.

Selected Objects: AS (ITP 
only)

Indicates the application server, if any, on which the event filter is 
based.

Selected Objects: ASP (ITP 
only)

Indicates the application server process, if any, on which the event filter 
is based.

Selected Objects: ASPA (ITP 
only)

Indicates the application server process application, if any, on which 
the event filter is based.

Selected Objects: Link (ITP 
only)

Indicates the link, if any, on which the event filter is based.

Selected Objects: Linkset 
(ITP only)

Indicates the linkset, if any, on which the event filter is based.

Selected Objects: Node Indicates the node, if any, on which the event filter is based.

Selected Objects: SGMP (ITP 
only)

Indicates the signaling gateway-mated pair, if any, on which the event 
filter is based.

Selected Objects: SP (ITP 
only)

Indicates the signaling point, if any, on which the event filter is based.

Selected Objects: Card 
(RAN-O only)

Indicates the card, if any, on which the event filter is based.

Selected Objects: Interface Indicates the interface or subinterface, if any, on which the event filter 
is based.

Selected Objects: Backhaul 
(RAN-O only)

Indicates the RAN backhaul, if any, on which the event filter is based.

Field or Button Description
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Step 7 To activate the event filter and close the Event Filter dialog box, click OK.

Step 8 To save the event filter for future use:

a. In the Event Filter dialog box, click Save. This action opens the Save Filter dialog box.

b. In the Save Filter dialog box, enter a meaningful name in the Filename text box (for example, 
Node109-WarningTraps).

c. Click OK to close the Save Filter dialog box.

d. Click OK to close the Event Filter dialog box.

In the future, to view traps for warning events for Node109, click Load in the Event Filter dialog 
box, choose the Node109-WarningTraps filter, then click OK. The Events window will only display 
warning traps for Node109 until you load a different event filter or change the current one. 

Loading an Existing Event Filter
You use the MWTM to load a specific event filter file and change the list of event filter files.

To load an existing event filter, click Load in the Event Filter dialog box. The Load File Dialog: Load 
Filter dialog box appears.

Figure 9-4 Load File Dialog: Load Filter Dialog

The Load File Dialog: Load Filter contains:

Field or Button or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.

Number of Files
(appears in lower -eft corner)

Total number of event filter files and folders.
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Saving an Event Filter File
You use the MWTM to save a specific event filter file and change the list of event filter files.

When you are satisfied with the filter settings, click Save in the Event Filter dialog box. The Save File 
Dialog:Save Filter dialog box appears.

Figure 9-5 Save File Dialog: Save Filter Dialog

The Save File Dialog: Save Filter contains:

OK Loads the selected event filter, saves any changes you made to the 
list of files, and closes the dialog box.

To load an event filter file, double-click it in the list, select it in 
the list and click OK, or enter the name of the file and click OK. 
The MWTM loads the event filter file, saves any changes you 
made to the list of files, closes the Load File Dialog: Load Filter 
dialog box, and returns to the Event Filter dialog box.

Delete Deletes the selected file from the event filter file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without loading an event filter file or saving 
any changes to the event filter file list.

Help Shows online help for the dialog box.

Field or Button or Icon Description

Field or Button or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.
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Viewing Event Properties
You use the MWTM to view detailed information about a selected event, including its associated object, 
status, and other information.

To view detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

The Event Properties dialog box appears.

Filename Name by which you want to save the event filter file.

If you create a new event filter filename, you can use any letters, 
numbers, or characters in the name that are allowed by your 
operating system. However, if you include any spaces in the new 
name, the MWTM converts those spaces to dashes. For example, 
the MWTM saves file a b c as a-b-c.

Number of Files
(displayed in bottom left corner)

Total number of event filter files and folders.

OK Saves any changes you made to the current event filter file and 
closes the dialog box.

To save the event filter file with a new name, use one of these 
procedures. To save the file with:

• A completely new name, enter the new name and click OK.

• An existing name, overwriting an old event filter file, select 
the name in the list and click OK.

The MWTM saves the event filter file with the new name, saves 
any changes you made to the list of files, closes the Save File 
Dialog: Save Filter dialog box, and returns to the Event Filter 
dialog box.

Delete Deletes the selected file from the event filter file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without saving the event filter file or saving 
any changes to the event filter file list.

Help Shows online help for the dialog box.

Field or Button or Icon Description
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Figure 9-6 Event Properties Dialog

The Event Properties dialog box contains:

Tab, Field, or Button Description

Properties Tab that shows detailed information about the selected event.

Message Message text for the event.

You can customize this field (see Changing the Way the MWTM Processes 
Events, page 9-27).

Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has ignored a link or linkset.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts 
to log in to the MWTM.

• LoginFail—LoginFail event. A user’s attempt to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.
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Category (continued) • OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing 
Data selected, and the MWTM has deleted the existing MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field (see Changing Event Categories, page 9-33).

Severity Severity of the event. Default values are:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event Severities and Colors, page 
9-35).

Timestamp Date and time the event was logged.

Message Name User-specified message name for the event that the MWTM uses for trap 
forwarding. The default message name is MWTM.

For more information about user-specified message names and trap 
forwarding, see Forwarding Events as Traps to Other Hosts, page 9-40.

Acknowledged Indicates whether the event has been acknowledged.

Acknowledged By Name of the node that last acknowledged the event. If no one has 
acknowledged the event, this field is blank.

Ack Timestamp Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If no node is associated with the 
event, None appears.

Signaling Point (ITP 
only)

Name of the signaling point associated with the event. If no signaling point is 
associated with the event, None appears.

Linkset (ITP only) Name of the linkset associated with the event. If no linkset is associated with 
the event, None appears.

Link (ITP only) Name of the link associated with the event. If no link is associated with the 
event, None appears.

AS (ITP only) Name of the application server associated with the event. If no application 
server is associated with the event, None appears.

ASP (ITP only) Name of the application server process associated with the event. If no 
application server process is associated with the event, None appears.

Tab, Field, or Button Description
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Related Topic:

Viewing Basic Information for All Events, page 9-2

Attaching a Note to an Event
You use the MWTM to annotate an event, attaching a descriptive string to the event.

To annotate an event, right-click an event in the Event window, then select Edit Notes in the right-click 
menu.

The Edit Event dialog box appears.

Figure 9-7 Edit Event Dialog

ASPA (ITP only) Name of the application server process association associated with the event. 
If no application server process association is associated with the event, None 
appears.

SGMP (ITP only) Name of the signaling gateway-mated pair associated with the event. If no 
signaling gateway-mated pair is associated with the event, None appears.

Rtr Interface Name of the interface associated with the event.

Ran Backhaul 
(RAN-O only)

Name of the RAN backhaul associated with the event.

Card (RAN-O only) Name of the card associated with the event. 

Notes Tab that shows notes associated with this event.

Last Update Date and time the Notes field for this event was last updated. If no note is 
currently associated with this event, this field shows the value Not Set.

Notes Notes associated with this event. If no note is currently associated with this 
event, this field shows the value No Notes.

Close Closes the Event Properties dialog box.

Details Tab that shows specific event attributes.

Tab, Field, or Button Description
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The Edit Event dialog box contains:

Related Topics:

• Viewing Basic Information for All Events, page 9-2

• Viewing Event Properties, page 9-18

Viewing Archived Event Files on the Web
The All Network Event Archived Files page provides access to archived event files within ITP or RAN-O 
networks for the server to which you are connected.

To access archived event files:

Step 1 Within a Web browser, navigate to the MWTM web interface (for details, see Accessing the MWTM Web 
Interface, page 11-1).

Step 2 Choose File Archive > Events from the Web navigation tree.

Within the Last Modified Date column, choose the day you want to view archived event files for.

Step 3 Adjacent to the date you have chosen, click on the Status Changes and SNMP Traps link under View. 
The Network Status Archive page appears, showing a list of the status and trap messages in the archive.

Field or Button Description

Name Message text of the event.

Last Update Date and time the Notes field for this event was last updated. If no note is currently 
associated with this event, this field shows the value Not Set.

You cannot edit this field.

Notes Notes to associate with this event. In this field, you can enter any important 
information about the event, such as its associated object, what triggered the event, 
how often it has occurred, and so on.

Save Saves changes you have made to the event information and exits the Edit Event 
dialog box.

Cancel Exits the Edit Event dialog box without saving any changes.

Help Shows online help for the current window.
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Viewing the Event Metrics Report on the Web
The Event Metrics Report page shows a number of metrics for the MWTM, based on the number of 
messages of each type and severity that the MWTM receives. This report is applicable for both ITP and 
RAN-O networks.

To view the event metrics report using the MWTM Web interface:

Step 1 Within a Web browser, navigate to the MWTM Web interface (for details, see Accessing the MWTM 
Web Interface, page 11-1).

Step 2 Click Reports > Statistics > Events, or from the Reports page, click Events.

The Event Metrics Report page contains the following tables:

• Message Types Table, page 9-23

• Message Severity Table, page 9-24

• Status Messages Table, page 9-24

• Trap Messages Table, page 9-25

• Messages/Day Table, page 9-26

• Status Change Messages/Day Table, page 9-26

• SNMP Trap Messages/Day Table, page 9-26

• Files Processed Table, page 9-27

• Date Range Table, page 9-27

Message Types Table
The Message Types table contains the following columns:

Column Description

Message Types Total number of messages of each type that the MWTM received. Possible types are:

• Total Messages—Total number of messages of all types

• Total Status—Total number of status change messages

• Total Traps—Total number of SNMP trap messages

Num Number of messages of each type that the MWTM received.

Num/Total Number of messages of a given type that the MWTM received, divided by the total 
number of messages that the MWTM received, shown as a percentage.
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Message Severity Table
The Message Severity table contains the following columns:

Status Messages Table
The Status Messages table contains the following columns:

Column Description

Message 
Severity

Total number of messages (status change messages and SNMP trap messages) of each 
severity that the MWTM received:

• Total Warning

• Total Normal

• Total Unclass

• Total Minor

• Total Major

• Total Informational

• Total Error

• Total Critical

• Total Admin

Num Number of messages of each severity that the MWTM received.

Num/Total Number of messages of a given severity that the MWTM received, divided by the total 
number of messages that the MWTM received, shown as a percentage.

Column Description

Status 
Messages

Total number of status change messages of each severity that the MWTM received. 
Possible severities are:

• Status Minor

• Status Normal

• Status Major

• Status Warning

• Status Informational

• Status Critical

• Status Unclass

• Status Error

• Status Admin

Num Number of status change messages of each severity that the MWTM received.
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Trap Messages Table
The Trap Messages table contains the following columns:

Num/Status Number of status change messages of a given severity that the MWTM received, 
divided by the total number of status change messages that the MWTM received, 
shown as a percentage.

Num/Total Number of status change messages of a given severity that the MWTM received, 
divided by the total number of messages (status change messages and SNMP trap 
messages) that the MWTM received, shown as a percentage.

Column Description

Column Description

Trap Messages Total number of SNMP trap messages of each severity that the MWTM received. 
Possible severities are:

• Trap Warning

• Trap Unclass

• Trap Normal

• Trap Minor

• Trap Major

• Trap Informational

• Trap Error

• Trap Critical

• Trap Admin

Num Number of SNMP trap messages of each severity that the MWTM received.

Num/Trap Number of SNMP trap messages of a given severity that the MWTM received, 
divided by the total number of SNMP trap messages that the MWTM received, shown 
as a percentage.

Num/Total Number of SNMP trap messages of a given severity received by the MWT, divided 
by the total number of messages (status change messages and SNMP trap messages) 
that the MWTM received, shown as a percentage.
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Messages/Day Table
The Messages/Day table contains the following columns:

Status Change Messages/Day Table
The Status Change Messages/Day table contains the following columns:

SNMP Trap Messages/Day Table
The Status Change Messages/Day table contains the following columns:

Column Description

Day Date for which metrics are calculated.

NumMsgs Total number of messages that the MWTM received on a given day.

NumMsgs/TotalMsgs Number of messages that the MWTM received on a given day, divided by the 
total number of messages (status change messages and SNMP trap messages) 
that the MWTM received on all days, shown as a percentage.

Column Description

Day Date for which metrics are calculated.

NumStatMsgs Total number of status change messages that the MWTM received 
on a given day.

NumStatMsgs/TotalMsgs Number of status change messages that the MWTM received on a 
given day, divided by the total number of messages (status change 
messages and SNMP trap messages) that the MWTM received on all 
days, shown as a percentage.

NumStatMsgs/TotalStatMsgs Number of status change messages that the MWTM received on a 
given day, divided by the total number of status change messages 
that the MWTM received on all days, shown as a percentage.

Column Description

Day Date for which metrics are calculated.

NumTrapMsgs Total number of SNMP trap messages that the MWTM received 
on a given day.

NumTrapMsgs/TotalMsgs Number of SNMP trap messages that the MWTM received on a 
given day, divided by the total number of messages (status change 
messages and SNMP trap messages) that the MWTM received on 
all days, shown as a percentage.

NumTrapMsgs/TotalTrapMsgs Number of SNMP trap messages that the MWTM received on a 
given day, divided by the total number of SNMP trap messages 
that the MWTM received on all days, shown as a percentage.
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Files Processed Table
The Files Processed table lists all files that the MWTM has processed.

Date Range Table
The Date Range table displays the date and time when the MWTM began collecting metrics, and the date 
and time of the most recent metrics.

Changing the Way the MWTM Processes Events
The three types of MWTM events are:

• Trap events—Incoming events that the MWTM does not solicit

• Status events—Status changes that the MWTM detects

• User Action events—Events that user actions trigger

Within those broad types, there occur subordinate types of events, each with a default category, severity, 
color, message text, and event help file. You use the MWTM to change the default characteristics of each 
type of event, tailoring them to meet your needs.

Note Changes you make to the MWTM event processing can adversely affect your operating environment. In 
most environments, the MWTM recommends that you use the default event-processing settings without 
modification.

To change the MWTM event processing, use one of these procedures:

• Choose Tools > Event Editor from the MWTM main menu.

• Choose Start > Programs > Cisco MWTM Client > MWTM Event Editor in Windows.

• Enter the mwtm eventeditor command (see mwtm eventeditor, page B-22).

The MWTM launches the MWTM Event Editor.
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Figure 9-8 MWTM Event Editor

You use the Event Editor to customize the visible category, severity, color, and message associated with 
events; and load, save, and deploy customized event configurations. You can also specify a list of SNMP 
servers to which the MWTM should forward events in the form of traps.

The high-level MWTM event processing settings appear in the navigation tree in the left pane in the 
MWTM Event Editor window. The detailed settings for each high-level setting appear in the content area 
in the right pane.

The MWTM Event Editor menu provides these options:

Menu Command Description

File > Load Draft Loads the local copy of the event configuration that you saved.

File > Save Draft
(Ctrl-S)

Saves a local copy of the event configuration, including any changes you 
made by using the Event Editor. You can save only one local copy of the event 
configuration. You cannot specify a filename for the local copy.

File > Load Default Loads the default event configuration on this MWTM client.

The default event configuration is the standard event configuration that the 
MWTM uses when it is first installed. The default event configuration stored 
on the MWTM server and shared by all MWTM clients, but the clients cannot 
modify it.

File > Load Running Loads the event configuration that is currently running on the MWTM server.

File > Load Backup Loads the backup event configuration from the MWTM server.

The MWTM creates a backup event configuration every time the event 
configuration on the MWTM server is overwritten.

File > Revert Reverts to the last event configuration that was loaded on the MWTM client. 
This could be the draft, default, running, or backup event configuration.



 

9-29
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 9      Managing Events
  Changing the Way the MWTM Processes Events

This section provides this information:

• Changing Event Limits, page 9-30

• Specifying a List of SNMP Servers for Trap Forwarding, page 9-32

• Changing Event Categories, page 9-33

• Changing Event Severities and Colors, page 9-35

• Configuring Trap, Status Alarm, or User Action Events, page 9-36

File > Deploy Deploys the event configuration that is currently being edited on this MWTM 
client to the MWTM server.

The deployed event configuration does not take effect until you restart the 
MWTM server. When you restart the MWTM server, the MWTM 
automatically reflects your changes to the event configuration on the MWTM 
server and on all MWTM clients that connect to that server, and reflects any 
new or changed categories, severities, and other event characteristics in its 
web navigation bars.

File > Exit Closes the Event Editor window. If you have made any changes to the event 
configuration, the MWTM asks if you want to save the changes before leaving 
the window. Click:

• Save Draft to save the changes in a local copy of the event configuration. 
You can save only one local copy of the event configuration. You cannot 
specify a filename for the local copy.

• Deploy to deploy the event configuration, including any changes you 
made, to the MWTM server.

The deployed event configuration does not take effect until you restart 
the MWTM server. When you restart the MWTM server, the MWTM 
automatically reflects your changes to the event configuration on the 
MWTM server and on all MWTM clients that connect to that server, and 
reflects any new or changed categories, severities, and other event 
characteristics in its web display navigation bars.

• No or Cancel to close the prompt window and return to the Event Editor 
window.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.

Menu Command Description
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Changing Event Limits
To change limits for the MWTM event database, select the turner beside Event Configuration, then click 
Limits. The Limits Configuration window appears in the right pane.

Field Description

MaxEventDbRecords Sets the maximum number of events allowed in the in-memory 
database. You can observe these events in the client NBAPI. The 
MWTM archives deleted events.

By default, the MWTM event database can hold a maximum of 5,000 
events. If the database exceeds 5,000 events, the MWTM deletes the 
oldest events until the database is reduced to 5,000 events.

To change the size of the MWTM event database, enter the new size, 
in number of events, in this field. The valid range is 0 events (that is, 
no limit) to an unlimited number of events. The default setting is 
5,000 events.

Note As you increase the size of the event database, you negatively 
impact the performance of the MWTM server and clients is 
impacted.

MaxEventTimeToLive Sets the maximum length of time, in days, the MWTM should retain 
events in the in-memory database.You can observe these events in the 
client NBAPI. The MWTM archives deleted events.

By default, the MWTM event database retains events a maximum of 
7 days. The MWTM deletes events that are older than 7 days.

To change the maximum age for events, enter the new age, in days, in 
this field. The valid range is 0 days (events are purged at each 
maintenance interval) to an unlimited number of days. The default 
setting is 7 days.

CompressEventDbInterval Sets the length of time, in minutes, between maintenance checks of the 
in-memory database. The MWTM archives these events when this 
task runs. Also, the oldest archived events may be deleted from the 
database.

By default, the MWTM performs maintenance on the event database 
every 15 minutes, deleting all events in excess of 5000 and all events 
older than 7 days.

To change the maintenance interval, enter the new interval, in minutes, 
in this field. The valid range is 0 minutes (perform continual 
maintenance; not advised) to an unlimited number of minutes. The 
default setting is 60 minutes.

Note The smaller the maintenance interval, the greater the negative 
impact on the performance of the MWTM server and clients.
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AutomationTimeout Sets the maximum length of time, in seconds, the MWTM should 
allow an event automation script to run.

By default, the MWTM event database allows an event automation 
script to run for 300 seconds (5 minutes) before canceling the script 
and moving on.

To change the event automation timeout interval, enter the new 
interval, in seconds, in this field. The valid range is 0 seconds (no 
automation) to an unlimited number of seconds. The default setting is 
300 seconds.

Note The MWTM runs each automation script sequentially, not in 
parallel. Therefore, the longer the automation timeout 
interval, the greater the chance that a failed script can delay 
subsequent scripts.

ProcessUndiscovered Determines whether the MWTM should process events from 
undiscovered nodes:

• False—Do not process events from undiscovered nodes. This 
setting is the default.

• True—Begin processing events from undiscovered nodes.

Send Updates Determines whether the MWTM should send traps northbound:

• False—Do not send traps northbound when an event is updated or 
deleted. Only send traps when an event is new. This setting is the 
default.

• True—Send traps northbound when an event is updated, deleted, 
or new.

ProcessUnrecognizedTraps Determines whether the MWTM should create events for 
unrecognized traps:

• False—(Default setting) Do not create events for unrecognized 
traps.

• True—Create events for unrecognized traps. This setting is the 
default.

TrapGenThrottle A delay (in milliseconds) between each trap sent to a northbound host. 
This value is helpful if the MWTM is sending traps faster than the 
northbound host can receive them. The default is 10 milliseconds.

HeartbeatTrapInterval A delay (in seconds) between each heartbeat trap sent to a northbound 
host. If this value is zero or less than one, no heartbeat trap is sent. The 
default is 0.

ArchiveAge The maximum age, in days, of all archived events and alarms in the 
database. The default is 31 days.

MaxAlarmAge The maximum age, in days, of all active alarms in the database. The 
default is 7 days.

Field Description
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Specifying a List of SNMP Servers for Trap Forwarding
You use the MWTM to specify a list of SNMP servers, or hosts, to which the MWTM should forward 
events in the form of traps.

For more information about enabling MWTM trap forwarding, see Forwarding Events as Traps to Other 
Hosts, page 9-40.

To specify the list of hosts, select the turner beside Event Configuration, then click SNMP Servers. The 
SNMP Servers Configuration window appears in the content area in the right pane.

CloneAlarms Determines whether the MWTM should create separate alarm 
instances from underlying events: 

• False—No alarms are created. 

• True—Alarms are created from underlying events. This setting is 
the default. 

AllowEventDeduplication Determines whether the MWTM should eliminate redundant 
(duplicate) events if a correlation key has been specified and enabled:

• False—The MWTM does not eliminate duplicate alarms. This 
setting is the default.

• True—The MWTM eliminates duplicate alarms. 

AllowStateAggregation Determines whether the MWTM should allow alarms to change the 
state of the node:

• False—Alarms will not affect the node state. 

• True—Alarms will affect the node state. This setting is the 
default.

ClearedAlarmsTimetoLive The time, in minutes, before the MWTM archives cleared alarms.

SendEvents Determines whether the MWTM should send events to a northbound 
system:

• False—Does not send events to the northbound system.

• True—Sends events to the northbound system. This setting is the 
default.

SendAlarms Determines whether the MWTM should send alarms to a northbound 
system:

• False—Does not send alarms to the northbound system. This 
setting is the default.

• True—Sends alarms to the northbound system. 

Field Description

Field or Button Description

Host Name of the host NMS that should receive traps from the MWTM. The host must 
be IP-routable, and the name must be a valid IP address or DNS name.

Port Host port number to which the MWTM should forward traps.

Community SNMP community string that the MWTM should include in forwarded traps.
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Changing Event Categories
To change categories for the MWTM event database, click the turner beside Event Configuration, then 
click Categories. The Categories Configuration window appears in the content area in the right pane.

Version Trap version to forward. Valid values are 1 and 2c.

Trap Type Type of trap that the MWTM should forward to this host. Valid trap types are:

• CISCO-SYSLOG: The CISCO-SYSLOG-MIB clogMessageGenerated trap.

• CISCO-EPM-NOTIFICATION: CISCO-EPM-NOTIFICATION-MIB 
ciscoEpmNotificationRev1 trap.

Add Adds a new hostname to the bottom of the list. Type over the default values with 
the new values.

Delete Deletes the selected hostname from the list.

Send a trap for all 
events

Checks the Send Traps check box for all MWTM events. Click this button if you 
want the MWTM to forward all events to the list of hosts.

If you click this radio button, and then you uncheck even a single Send Traps 
check box for any event, the MWTM unchecks this button.

This radio button is mutually exclusive with the Send a trap for no events 
button.

Send a trap for no 
events

Unchecks the Send Traps check box for all MWTM events. Click this button if 
you do not want the MWTM to forward any events to the list of hosts. This is the 
default setting.

If you click this radio button, and then you check even a single Send Traps check 
box for any event, the MWTM unchecks this button.

This radio button is mutually exclusive with the Send a trap for all events 
button.

Field or Button Description

Field or Button Description

Category Name Lists the names of the currently defined MWTM event categories.

By default, the MWTM provides these event categories:

• Status—Status change message generated.

• Trap—SNMP trap message generated.

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

Category Name

(continued)

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an event, linkset, or node.

• Ignore—Ignore event. A user has Ignored a link or linkset.
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Category Name

(continued)

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to 
log in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM 
has failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing 
Data selected, and the MWTM has deleted the existing the MWTM database.

To change the name of an existing event category, highlight the category name 
and type over it with the new name. For example, you could replace every 
occurrence of LoginFail with BadLogin.

Add Adds a new category name to the bottom of the list. Type over the default 
category name with the new name.

Delete Deletes the selected category name from the list.

If events in the MWTM database use the deleted category name, the Entry 
Substitution dialog box appears. Use this dialog box to select a new category 
name in place of the deleted category name. Select an existing category name 
from the drop-down list box, or enter a new category name. If you enter a new 
category name, the MWTM adds it to the Category Name field.

Field or Button Description
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Changing Event Severities and Colors
To change severities or colors for the MWTM event database, select the turner beside Event 
Configuration, then click Severities. The Severities Configuration window appears in the content area 
in the right pane.

Field or Button Description

Severity Name Lists the names of the currently defined MWTM event severities.

By default, the MWTM provides these event severities:

• Informational

• Normal

• Indeterminate

• Warning

• Critical

• Minor

• Major

To change the name of an existing event severity, highlight the severity name and type 
over it with the new name. For example, you could replace every occurrence of 
Normal with Clean.

Severity Color Lists the colors of the currently defined MWTM event severities.

By default, the MWTM provides these event colors:

• Informational—The default color is white.

• Normal—The default color is green.

• Indeterminate—The default color is aqua.

• Warning—The default color is blue.

• Critical—The default color is red.

• Minor—The default color is yellow.

• Major—The default color is orange.

To change the color associated with an existing severity, select the current color, then 
select a new color from the drop-down list box. For example, you can display Warning 
events in maroon instead of yellow.

Add Adds a new severity name to the bottom of the list. Type over the default severity 
name with the new name, then select a color from the drop-down list box. The default 
color is white.

Delete Deletes the selected severity name from the list.

If events in the MWTM database use the deleted severity name, the Entry Substitution 
dialog box appears. Use this dialog box to select a new severity name in place of the 
deleted severity name. Select an existing severity name from the drop-down list box, 
or enter a new severity name. If you enter a new severity name, the MTWM adds it to 
the Severity Name field.
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Configuring Trap, Status Alarm, or User Action Events
The MWTM can detect these event types:

• Traps—Events that are triggered by SNMP traps or notifications

• Status Alarms—Events that are triggered by status changes

• User Actions—Events that are triggered by user actions

To configure the event parameters for any of these event types:

Step 1 Choose Tools > Event Editor from the MWTM main menu.

Step 2 Select the turner beside Event Configuration.

Step 3 Select the turner beside the event type that you want to configure (Traps, Status Alarms, or User 
Actions). 

The MWTM lists the currently defined events in the navigation tree under the event type.

Step 4 To add an event to an event type, right-click the event type and select Add from the right-click menu. 

The MWTM opens the Add Entry dialog box, which lists the events that the MWTM supports but have 
not yet been configured. 

Step 5 Select an event that you want to configure and click Add. 

The MWTM adds the selected event to the list of configured events and creates a Default entry for the 
event in the left pane.

Step 6 Click the Default entry in the left pane.

The Event Configuration pane appears in the right pane.

Move Up

Caution Do not move the Normal severity from the top of this list! Moving this 
severity category lower in the list will negatively impact the handling of 
events in the MWTM.

Moves the selected severity up in the list.

The order of the severities that appear in this list determines the sort order of the 
Severity column in the event table (see Event Table, page 9-5).

To move a severity higher in the order of severities, click Move Up.

Move Down

Caution Do not move the Normal severity from the top of this list! Moving this 
severity category lower in the list will negatively impact the handling of 
events in the MWTM.

Moves the selected severity down in the list.

The order of the severities that appear in this list determines the sort order of the 
Severity column in the event table (see Event Table, page 9-5).

To move a severity lower in the order of severities, click Move Down.

Field or Button Description
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Step 7 Configure the event by adjusting the parameters.

Step 8 To delete an event, right-click the event in the left pane and click Delete.

The Event Configuration pane contains:

Field or Button Description

Name Name of the event, such as cItpRouteStateChange. You cannot change this field.

Event Keys and 
Setting

Names of the event keys, such as RouteDestinationState, and their settings, such 
as False.

You cannot change the names of the event keys, but you can change their settings. 
To change an event key setting, select a new setting from the drop-down list box. 
For example, you can change the setting for RouteDestinationState from 
Accessible to Unknown.

Category Category of the event, such as Trap.

To change the category, select a new category from the drop-down list box. 

Severity Severity of the event, such as Normal.

To change the severity, select a new severity from the drop-down list box.

Note The order of the severities affects the sort order of the severities in the 
MWTM client tables.

Event Name User-specified name for the event, that the MWTM uses for trap forwarding.

If you want the MWTM to forward this event in the form of a trap to another host, 
you can specify a new, more meaningful name for the event. The new name can 
be from 1 to 30 characters, and can contain any letters (upper- or lowercase), any 
numbers, and any special characters. If you do not specify a new name, the 
MWTM uses the default name, MWTM.

For more information about trap forwarding, see Forwarding Events as Traps to 
Other Hosts, page 9-40.

Message Message text associated with the event.

To change the message text, type over the message text.

You can also insert variable text in the message. To do so, right-click in the 
message text area. A popup menu of the valid substitutions for this event appears. 
To insert a variable in the text area, select from the popup menu.
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Help File Help file associated with the event.

By default, the MWTM provides extensive type-specific help for events. 
However, you can use the MWTM to provide your own enterprise-specific 
instructions to operators in the help file.

To change the help file, create a new HTML help file or change the default 
MWTM help file. If you installed the MWTM in:

• The default directory, /opt, then the default help files are in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the default help directory and files are located in 
that directory.

If you use an MWTM help file as a basis for your help file, rename it when you 
save it; do not use the existing MWTM name. If you do, the next time you install 
the MWTM, the MWTM overwrites the file and you lose your changes.

When you have created your new help files, store them in the 
/opt/CSCOsgm/apache/share/htdocs/customHelp directory. This directory and 
its contents are preserved when you upgrade to a new MWTM release. If you do 
not store your new help files in the /customHelp directory, the files are lost the 
next time you upgrade to a new MWTM release.

When you have created your new help files and stored them in the /customHelp 
directory, enter the new help file path and filename in the Help File field.

After you deploy the new event settings and restart the MWTM server, whenever 
you display help for the trap, the MWTM shows your new, custom help file.

Open Opens the help file associated with the event.

To see the help file, click Open. The MWTM shows context-sensitive help for 
the selected event in a separate web browser.

Action: Run Automation command or script for the event that a UNIX process runs.

You use the MWTM to automate events. That is, you can configure the MWTM 
to call a UNIX script to drive automatic paging or e-mail, for example, whenever 
the MWTM logs an event for which you have defined an automation script.

To configure automation for an event, enter a Run line with this format:

UNIXCommand EventParameters

where:

• UnixCommand specifies either a binary command name or a shell script.

• EventParameters are information from the event that the MWTM sends to 
UnixCommand as parameters. The set of EventParameters is the same as the 
set of Message element parameters, and they are specified the same way.

Field or Button Description
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Action: Run 
(continued)

For example, this Run line:

/users/johndoe/auto-inhibit.exp $NodeDisplayName $User

causes these automatic actions whenever the MWTM logs the associated event:

• The MWTM spawns a UNIX process to execute the 
/users/johndoe/auto-inhibit.exp script.

• The MWTM passes the $NodeDisplayName and $User parameters to the 
script.

After you deploy the new event settings and restart the MWTM server, the 
specified event causes the automation script to run.

When configuring automation for events, remember:

• Detailed information about event automation scripts, including the times 
they start and stop and any output produced by the scripts, is recorded in the 
MWTM system event automation log file (see Viewing the Event 
Automation Log, page 11-21).

• The MWTM event automation scripts run separately from all other MWTM 
processes.

• If the MWTM logs more than one automated event in rapid succession, the 
MWTM runs each automation script sequentially, not in parallel. The 
MWTM spawns a new UNIX process for each script, and waits for it to 
complete before running the next script.

• By default, the MWTM allows an event automation script to run for 
300 seconds (5 minutes) before canceling the script and moving on to the 
next script. To change the maximum run-time for event automation scripts, 
see Changing Event Limits, page 9-30.

Action: Poll 
(available only for 
Trap events)

Check box indicating whether MWTM should poll the associated nodes. If you:

• Want MWTM to poll the nodes, check the check box. 

• Do not want MWTM to poll the nodes, uncheck the check box.

Action: Send Trap Check box indicating whether the MWTM should forward the event as a trap to 
other systems. If you:

• Want MWTM to forward the event, check the check box.

• Do not want MWTM to forward the event, uncheck the check box. This is 
the default setting.

Raise Alarm

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

If the Raise Alarm check box is checked, then, when this event happens, an alarm 
appears in the Supplemental Alarms table.

Field or Button Description
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Forwarding Events as Traps to Other Hosts
You use the MWTM to forward MWTM events to other hosts, in the form of SNMP traps. This operation 
enables the MWTM to integrate with high-level event- and alarm-monitoring systems such as the Cisco 
Info Center (CIC). These systems can provide a single high-level view of all alarm monitoring in your 
network, making it easier to detect and resolve problems.

To forward MWTM events to other hosts:

Step 1 Specify the list of SNMP servers, or hosts, to which you want the MWTM to forward traps (see 
Specifying a List of SNMP Servers for Trap Forwarding, page 9-32).

Step 2 Specify the events you want to forward, using one of these procedures. To forward:

a. All MWTM events, click the Send a trap for all events radio button in the SNMP Servers 
Configuration window of the MWTM Event Editor. For more information, see Specifying a List of 
SNMP Servers for Trap Forwarding, page 9-32.

b. Only selected events, edit the events in the MWTM Event Editor and check the Send Trap check 
box. For more information, see the description of the Send Trap field in Configuring Trap, Status 
Alarm, or User Action Events, page 9-36.

Step 3 (Optional) Specify new, more meaningful names for the events that you want to forward. If you do not 
specify a new message name for an event, the MWTM uses the default message name, MWTM. For more 
information, see the description of the Message Name field in Configuring Trap, Status Alarm, or User 
Action Events, page 9-36.

Step 4 Save your new event settings, deploy them to the MWTM server, and restart the MWTM server.

Note For more details, see the Cisco Mobile Wireless Transport Manager 6.0 OSS Integration Guide.

Correlate

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

When you check the this check box, you can then define a key in the Key field.

Key

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

You can define a key to correlate appropriate events. The EPM notification 
includes this key for use by the north-bound system. Right-click in the text field 
to select a key.

Disable Check box to disable this event without removing the event configuration from 
the /opt/CSCOsgm/etc file.

Errors Error messages associated with the event. Correct all errors before deploying the 
new event configuration.

Field or Button Description
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Setting Sounds for Events at an MWTM Client
You use the MWTM to create and change event sound filters for the MWTM client. Event sound filters 
determine the sounds that the MWTM client plays when specific events are logged. The MWTM client 
plays the sounds even if the Event window is not currently visible.

On Solaris and Linux systems, the root user can access the sound feature from a local or remote device. 
However, users other than the root user must use a local device and client, not a remote MWTM client 
accessed by using the xhost + UNIX command.

This section includes:

• Listing Event Sound Filters, page 9-41

• Creating a New Event Sound Filter, page 9-43

• Adding a Sound File to the MWTM, page 9-45

• Changing an Existing Event Sound Filter, page 9-45

• Deleting an Event Sound Filter, page 9-46

• Playing and Muting Event Sounds, page 9-46

Listing Event Sound Filters
You use the MWTM to change the list of event sound filters that the MWTM client applies to events, or 
prevent the MWTM client from playing sounds for events.

To work with the list of event sound filters, choose Tools > Event Sounds from the MWTM main menu. 
The Event Sound Filters List dialog box appears.

Figure 9-9 Event Sound Filters List Dialog
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The Event Sound Filters List dialog box lists all event sound filters that have been defined.

Related Topics:

• Setting Sounds for Events at an MWTM Client, page 9-41

• Managing Events, page 9-1

Field or Button Description

Sound filters 
applied in 
order

Indicates the order in which sound filters are to be applied, from top to bottom. That 
is, if an event matches two or more filters in the list, the top-most filter determines 
the sound that the MWTM client plays.

This field is blank until you have created at least one new sound filter for events.

Move Up Moves the selected event sound filter up in the Sound filters applied in order list.

Move Down Moves the selected event sound filter down in the Sound filters applied in order list.

New Opens the Event Sound Filters dialog box, which you use to create a new event sound 
filter.

Edit Opens the Event Sound Filters dialog box, which you use to change an existing event 
sound filter in the Sound filters applied in order list.

Delete Deletes the selected event sound filter from the Sound filters applied in order list.

Mute Sounds Check box indicating whether the MWTM client should play event sounds. To:

• Play event sounds, check the check box. This is the default setting.

• Not play event sounds, uncheck the check box.

OK Applies any changes you made to the event sound filters list and closes the Event 
Sound Filters List dialog box. When you are satisfied with the changes you made to 
the event sound filters list, click OK.

Apply Applies any changes you made to the event sound filters list without closing the Event 
Sound Filters List dialog box.

Cancel Closes the Event Sound Filters List dialog box without applying any changes to the 
event sound filters list.

Help Shows online help for the current window.
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Creating a New Event Sound Filter
You use the MWTM to create a new event sound filter. Open the Event Sound Filters List dialog box, as 
described in Listing Event Sound Filters, page 9-41, then click New. The Event Sound Filters dialog box 
appears.

Figure 9-10 Event Sound Filters Dialog

The Event sound filters dialog box contains:

Button or Field Description

Filter Name Name of the event sound filter file.

Enter a name for the filter, then specify filter criteria for this event sound filter in the 
Event Sound Filter Criteria field.

Event Sound 
Filter Criteria

Table listing the filter criteria for this event sound filter. To add a criteria, select 
options from the drop-down list boxes:

• To filter based on message text:

a. Select Message Text from the first drop-down list box.

b. Select Contains, Equals, Does Not Contain, or Does Not Equal from the 
second drop-down list box.

c. Enter the message text in the character string field.

• To filter based on event severity:

a. Select Severity from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a severity, such as Normal, from the third drop-down list box, the 
message text.
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Related Topics:

• Listing Event Sound Filters, page 9-41

• Managing Events, page 9-1

Event Sound 
Filter Criteria
(continued)

• To filter based on event category:

a. Select Category from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a category, such as Status or Purge, from the third drop-down list 
box, the message text.

• To filter based on the name of the node associated with the event:

a. Select Node from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a node from the third drop-down list box. The MWTM lists all nodes 
that have been discovered in the drop-down list box.

More Adds one or more additional filter criteria to the event sound filter.

To add a filter criteria to the event sound filter, click More. The MWTM adds a new 
criteria to the bottom of the list.

Fewer Removes one or more filter criteria from the event sound filter.

To remove a filter criteria from the event sound filter, click Fewer. The MWTM 
deletes the last criteria in the list.

Play this 
sound:

Drop-down list box indicating the sound to play if an event matches this event sound 
filter.

The MWTM client sound files are stored in the MWTM client’s /sounds directory. If 
you installed the MWTM client:

• For Solaris/Linux in the default directory, /opt, then the sound file directory is 
/opt/CSCOsgmClient/sounds.

• For Windows in the default directory, /Program Files, then the sound file 
directory is C:\Program Files\MWTMClient\sounds.

• In a different directory, then the sound file directory is located in that directory.

To add a sound file to the MWTM, add it to the /sounds directory (see Adding a Sound 
File to the MWTM, page 9-45).

Play Plays a sample of the sound selected in the Play this sound drop-down list box.

OK Applies any changes you made to the event sound filter criteria and closes the Event 
Sound Filters dialog box.

When you are satisfied with the changes you made to the event sound filters, click 
OK.

Cancel Closes the Event Sound Filters dialog box without applying any changes to the event 
sound filter criteria.

Help Shows online help for the current window.

Button or Field Description
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Adding a Sound File to the MWTM
You can add sound files to an MWTM client. The MWTM clients can play these sound file formats: 

• AIFC 

• AIFF 

• AU

• SND

• WAV

Note WAV files encoded using MPEG Layer-3 are not supported.

The MWTM client sound files are stored in the MWTM client’s /sounds directory. If you installed the 
MWTM client:

• For Solaris/Linux in the default directory, /opt, then the sound file directory is 
/opt/CSCOsgmClient/sounds.

• For Windows in the default directory, /Program Files, then the sound file directory is 
C:\Program Files\MWTMClient\sounds.

• In a different directory, then the sound file directory is located in that directory.

If for some reason the MWTM cannot play a specified sound file, the MWTM plays a default beep. For 
example, the MWTM cannot play a sound file if one of these conditions exists:

• The file has been moved or deleted from the /sounds directory.

• The /sounds directory has been deleted or cannot be found.

• Some other application is using all of the sound resources.

• No sound card is present.

Related Topics:

• Creating a New Event Sound Filter, page 9-43

• Managing Events, page 9-1

Changing an Existing Event Sound Filter
You use the MWTM to change an existing event sound filter. Open the Event Sound Filters List dialog 
box, as described in Listing Event Sound Filters, page 9-41, select the filter in the Sound filters applied 
in order list, then click Edit. The MWTM shows the Event Sound Filters dialog box (Figure 9-9), 
populated with the selected filter’s settings.

Change the settings as needed, then click OK. The MWTM applies your changes and closes the Event 
Sound Filters dialog box.
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Deleting an Event Sound Filter
You use the MWTM to delete an existing event sound filter. Open the Event Sound Filters List dialog 
box, as described in Listing Event Sound Filters, page 9-41, select the filter in the Sound filters applied 
in order list, then click Delete. The MWTM deletes the selected filter.

Playing and Muting Event Sounds
You use the MWTM to specify whether you want the MWTM client to play event sounds. To do so, open 
the Event Sound Filters List dialog box, as described in Listing Event Sound Filters, page 9-41. To:

• Play event sounds, uncheck the Mute Sounds check box. This is the default setting.

• Not play event sounds, check the Mute Sounds check box.

Displaying Alarms
You use the MWTM to view a summary of all currently active alarms in your network, including the 
current status of the associated network object. An active alarm is a network object with this status:

• A link, signaling gateway-mated pair, or application server process that is Warning (yellow) or 
worse and is not Ignored.

• A linkset, signaling point, node, application server, interface, card, or backhaul that is Pending (red) 
or worse and is not Ignored.

To see a summary of all currently active alarms, click Alarms in the navigation tree left pane. The 
MWTM shows the Active Alarms window in the right pane (see Figure 9-11).

• Right-click Alarms in the navigation tree to display the right-click menu for all alarms (see 
Right-Click Menu for All Alarms, page 9-49).

• Right-click an alarm in the content area in the right pane to display the right-click menu for a 
specific alarm (see Right-Click Menu for a Specific Alarm, page 9-49).

Figure 9-11 Active Alarms Window
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The Active Alarms window provides basic information about all currently active alarms in your network, 
that are not excluded from your current view. The MWTM updates the information in the window at least 
once every minute.

To see the tooltip for each column in the table, place the cursor over a column heading.

If a cell is too small to show all of its text, place the cursor over the cell to see the complete text in a 
tooltip.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Age, with the most recent alarms at the top, and the MWTM shows all of the 
columns in the table except Last Status Change.

• To display hidden columns, right-click in the table heading and check the check boxes for the 
columns you want to display.

• To hide columns, right-click in the table heading and uncheck the check boxes for the columns you 
want to hide.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

The Active Alarms window contains:

Column Description

Type Type of network object associated with the selected alarm.

To see all higher-level alarms associated with the network object, select the 
turner beside the object. The MWTM shows the higher-level alarms 
underneath the selected alarm. For example, if you select the turner beside a 
link, the MWTM shows the alarms for the linkset, signaling point, and node 
associated with that link.

Name Name of the network object associated with the selected alarm.

Status Current status of the network object associated with the selected alarm. 
Possible values include:

• None: Black

• Unknown: Red

• Unavailable: Red

• Inactive: Red

• Failed: Red

• Down: Red

• Blocked: Red

• Pending: Red

• Warning: Yellow

• Shutdown: Blue

• Inhibited: Blue
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Status (continued) • InhibitLoc: Blue

• InhibitRem: Blue

• Discovering: Cyan

• Polling: Cyan

• Waiting: Gray

• Unmanaged: Gray

• Active: Green

For detailed definitions of each status for each type of network object, see 
Status Definitions, page E-1.

Status Reason Reason for the current status of the network object associated with the 
selected alarm.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• In a different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full status reason in a tooltip help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see Command Reference, page B-1.

Last Status Change Date and time that the status of the network object associated with the 
selected alarm last changed.

Age Age of the selected alarm, in days, hours, and minutes.

Column Description
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Right-Click Menu for All Alarms
To see the right-click menu for all active alarms, select Alarms in the navigation tree and right-click the 
mouse button. 

Right-Click Menu for a Specific Alarm
The active alarms table provides a subset of the MWTM main menu as a right-click menu. To see this 
menu, select an alarm and right-click the mouse button. 

The alarm right-click menu provides the same options as the right-click menu for the associated network 
object, plus these additional options:

Menu Command Description

Show In New Window Opens the Active Alarms window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Menu Command Description

Expand All Shows all higher-level alarms associated with all network objects in the active 
alarms table.

Collapse All Does not display higher-level alarms in the active alarms table.

Edit Notes Opens the Edit Event dialog box for the selected event.

Clear Event Icon Deletes the event icon from MWTM displays for the selected object, for this 
MWTM client only. The actual events are not deleted from the MWTM, only the 
event icon for the selected object for this MWTM client.

This option is grayed-out if the selected object has no associated event icon.

Delete Deletes the selected alarm.

Go To > Object Shows the window for the object associated with the selected event.

If no object is associated with the event, this option is not visible.

Back > List of 
Windows

Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

View > Status 
Contributors

Displays the Status Contributors pane for the selected object. Objects in this pane 
contribute to the status of the selected object.

View > Details Displays the Details pane for the selected object.

View > Notes Displays the Notes pane for the selected object. If there are no notes associated 
with the selected object, this option is grayed-out.
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Caution The alarms visible in the active alarms table are the actual network objects in the MWTM. Options you 
select in the right-click menu affect the object in the MWTM. For example, if you delete a node in the 
active alarms table, you delete that node from the MWTM database.

View > 
Troubleshooting

Displays the Troubleshooting pane for the selected object. 

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Network Operator (level 3) and higher.

View > Recent 
Events

Displays the Recent Events pane for the selected object and any associated 
network objects.

Archived Events > 
Status Changes

Displays the archived status changes in a web browser.

Archived Events > 
SNMP Traps

Displays the archived SNMP traps in a web browser.

Archived Events > 
Status Changes and 
SNMP Traps

Displays both the archived status changes and archived SNMP traps in a web 
browser.

Ignore Ignores the selected object at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Menu Command Description



C H A P T E R
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Note The web interface does not support viewing the network topology. You can view the network topology 
only in the MWTM client interface.

In addition to tabular (text) views of your network, the Cisco Mobile Wireless Transport Manager 
(MWTM) provides a topological (graphical) view of the objects in your network, including:

• RAN-O nodes

• RAN-O service modules

• RAN-O interfaces

• ITP signaling points

• ITP application servers

• ITP application server process associations

• ITP linksets

• Adjacent legacy nodes

Note The MWTM does not manage legacy nodes, but displays them in the topology map to help 
you visualize the interconnections between network objects.

Any associated events also appear in the topology window. You can use the MWTM to customize the 
topological view (for details, see Chapter 7, “Managing Views”).

To view the topology of your network, use one of these procedures:

• Choose View > Topology from the MWTM main menu.

• Right-click an object, then choose View > Center in Topo in the right-click menu.

The topology window appears.
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Figure 10-1 Topology Window

The topology window shows tabular information about MWTM objects in the left pane and the graphical 
topology map in the right pane. Events associated with the selected object appear in the bottom pane.

The topology window contains:

• Topology Menu, page 10-3

• Topology Toolbar Buttons, page 10-4

• Topology Tabs, page 10-6

• Topology Map, page 10-11

• Topology Event Pane, page 10-16
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The MWTM provides these functions related to the topology map:

• Creating a Custom Layout, page 10-16

• Finding an Object, page 10-17

• Centering the Topology Map on an Object, page 10-18

• Displaying Detailed Information About a Topology Map Element, page 10-18

• Printing the Topology Map, page 10-18

• Saving the Topology Map as a JPEG File, page 10-18

• Selecting a Directory for the JPEG File, page 10-19

• Activating a Magnetic Grid on the Topology Map, page 10-21

• Specifying a Color for the Magnetic Grid, page 10-22

• Specifying a Background Color for the Topology Map, page 10-24

• Aligning Objects on the Topology Map, page 10-25

• Hiding and Displaying Non-ITP Nodes and Linksets, page 10-26

• Locking and Unlocking the Position of an Icon, page 10-27

• Improving Topology Performance, page 10-27

• Saving the Topology Map, page 10-28

• Restoring the Topology Map, page 10-28

Related Topics:

• Diagnosing a Typical Network Problem, page D-5

• Changing MWTM Server Poller Settings, page 3-2

• Chapter 7, “Managing Views”

Topology Menu
The topology window is identical to the MWTM main menu. For detailed descriptions of the options it 
provides, see Using the MWTM Main Menu, page 4-33.
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Topology Toolbar Buttons
The topology window contains these toolbar buttons:

Button Description

Close view tab Closes the currently visible view in the topology window.

This option is dimmed if the currently visible view is the 
highest-level parent view.

Open parent view Opens the parent view of the currently visible view in the 
topology window.

This option is dimmed if the currently visible view is the 
highest-level parent view.

Lay out nodes in a circle Shows the map in a circular layout.

Lay out nodes in a spring Shows the map in a spring layout. That is, the MWTM draws 
nodes with the most lines closer to the center of the map, and 
draws nodes with fewer lines farther away. This is the default 
setting the first time the map appears.

Note You can change how far apart to space the nodes when 
the MWTM draws the spring layout (see Changing 
Topology Settings, page 5-8).

Zoom in by a factor of 200% Makes the map twice as large.

Zoom out by a factor of 50% Makes the map half as large.

Zoom by percentage Zooms the map by a selected percentage. You can select a 
percentage from the drop-down list box; or, enter a percentage 
and click Enter. Valid values are integers in the range 
5 through 400.

Zoom in on an area Zooms in on the selected area of the map. Click the button, then 
click in the topology map and drag a rectangle around the area 
on which you want to zoom. The MWTM expands the selected 
area to fill the topology map.

Zoom to fit window Adjusts the size of the map to fit in the window. This is the 
default setting the first time the map appears.

Find objects Opens the Find Objects dialog box, which you use to find and 
highlight an object in the topology window.

Set magnetic grid properties Opens the Magnetic Grid Settings dialog box, which you use to 
activate and deactivate the magnetic topology grid, and 
modifies how it appears. With the grid activated, when you 
move objects on the topology map they automatically align 
with the grid.

Align objects on map Opens the Align Objects dialog box, which you use to align two 
or more objects on the topology map.
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Hiding/Showing non-ITP nodes 
(ITP only)

Hides or shows all non-ITP signaling points and linksets on the 
topology map. (Hidden signaling points and linksets still 
appear in the left pane.)

The process determines whether the node's parent (visible on 
the topology maps) has an ITP MIB or not. If not, it is classified 
as a non-ITP node and it will be hidden or visible when the 
button is toggled.

The MWTM automatically saves this setting (with non-ITP 
nodes and linksets either hidden or visible) with your 
preferences.

Node Dragging Optimizer Turns the Node Dragging Optimizer on or off:

• When the Node Dragging Optimizer is On, the MWTM 
hides linkset lines as you drag an object around the 
topology map. The MWTM draws the linkset lines when 
you drop the object in its final position. This is the default 
setting.

• When the Node Dragging Optimizer is Off, the MWTM 
continually redraws linkset lines as you drag an object 
around the topology map.

The MWTM automatically saves this setting (with the Node 
Dragging Optimizer on or off) with your preferences.

Hiding/Showing Dangling 
Connections

Hides or shows connections to objects that are not visible in the 
current view, which are called dangling connections. When the 
Hiding Dangling Connections is set to:

• Hide, the MWTM hides dangling connections. This is the 
default setting.

• Show, the MWTM shows dangling connections, drawing 
the objects in shades of gray to distinguish them from 
actual objects in the current view.

The MWTM does not save this setting (with the Hiding 
Dangling Connections set to Show or Hide) when you save the 
view.

To include a dangling connections in the current view, select the 
connection, then select Include In View.

Button Description
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Topology Tabs
In the topology window, you can access:

• Tables Tab, page 10-6

• New Objects Tab, page 10-10

• Excluded Objects Tab, page 10-11

Tables Tab
The Tables tab in the left pane of the topology window contains: 

• View Objects Table, page 10-6

• Connections Table, page 10-8

To display the Tables tab, select the Tables tab in the left pane of the topology window. 

View Objects Table

The View Objects table shows information about the MWTM objects that are currently visible in the 
topology map:

• To redraw the topology map centered on a specific object, double-click the object in this table.

• You cannot select more than one object at a time in this table.

• To see the tooltip for each column in the table, place the cursor over a column heading.

• If a cell is too small to show all of its data, place the cursor over the cell to see the full data in a 
tooltip.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
MWTM shows only the Type, Name, and Status columns in the View Objects table. By default, the 
MWTM sorts this table by Status. 

Show/Hide event panel Shows or hides the event panel at bottom.

Lock position

or

Unlock position

Locks or unlocks the position of an icon on the topology map. 
Locking the position of an icon can be useful if you want to 
keep the icon in its position, and you want to ensure you do not 
move it inadvertently. Locked icons do not appear in the 
circular or spring layouts. To lock the position of an icon, 
select:

• An unlocked icon, then select Lock position.

• A locked icon, then select Unlock position. This is the 
default setting.

The MWTM automatically saves this setting (with icon 
positions locked or unlocked) with your view.

Button Description
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To:

• Display hidden columns, right-click in the table heading and check the check boxes for the columns 
you want to display.

• Hide columns, right-click in the table heading and uncheck the check boxes for the columns you 
want to hide.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

The View Objects table contains:

Column Description

Internal ID Internal ID of the object. The internal ID is a unique ID for every object, that 
MWTM assigns for its own internal use. It can also be useful when the TAC 
is debugging problems.

Type Object types can be ITP only, RAN-O only, or General to both types of 
networks. 

General object types include:

• Node—Any interconnecting node that is not an MWR node.

• View—Custom view (if one exists).

ITP only object types include:

• ASP—An application server process.

• SP—A signaling point.

RAN-O only object types include:

• RAN Node—Mobile Wireless Router (MWR) node.

• RAN SVC Node—A RAN service card in an Optical Networking 
System (ONS) node.

Name Name of the object.

Node Name of the node associated with the object.

Notes Indicates whether a note is associate with the object.

Events Indicates whether the object has a recent event. (Even if the server purges all 
of the events associated with the object, the MWTM continues to display the 
event icon in this field.)

During Discovery, the MWTM might flag most objects with an event 
icon. If the event icons are too distracting, choose Edit > Clear All Events 
from the MWTM main menu to remove them.

Last Status Change Date and time that the status of the object last changed.



 

10-8
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 10      Viewing Network Topology
  Topology Tabs

Connections Table

The Connections table shows information about the connections associated with the object that you 
selected in the View Objects table, or the object currently selected in the topology map.

• To redraw the topology map centered on a specific object, double-click the object in this table.

• You cannot select more than one object at a time in this table.

• To see the tooltip for each column in the table, place the cursor over a column heading.

Status Current status of the object. Possible values are:

• Active (green)

• Unknown (red)

• Unmanaged (gray)

• Warning (yellow)

For detailed definitions of each status, see the “Status Definitions” section 
on page E-1.

Status Reason Reason for the current status of the object.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed MWTM in:

• The default directory, /opt, then the file resides at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file reside in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full status reason in a tooltip.

The MWTM lists status reasons in order of decreasing magnitude. If two or 
more reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see the “Command Reference” section on 
page B-1.

Ignored Indicates whether the object should be included when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the object. This is the default setting.

• Check the check box to exclude the object.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Column Description
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• If a cell is too small to show all of its data, place the cursor over the cell to see the full data in a 
tooltip.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
MWTM shows only the Type, Name, and Status columns in the View Objects table. By default, the 
MWTM sorts this table by Status. To:

• Display hidden columns, right-click in the table heading and check the check boxes for the columns 
that you want to display.

• Hide columns, right-click in the table heading and uncheck the check boxes for the columns that you 
want to hide.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

The View Connections table contains:

Column Description

Internal ID Internal ID of the object. The internal ID is a unique ID for every object, 
which MWTM assigns for its own internal use. It can also be useful when 
the TAC is debugging problems.

Type Object types can be ITP only or RAN-O only. 

ITP only object types include:

• Linkset—A linkset associated with a signaling point.

• ASPA—An application server process association associated with a 
signaling point.

RAN-O only object types include:

• RAN Backhaul—Virtual RAN backhaul associated with a RAN node or 
RAN SVC node.

• GSM Interface—GSM interface associated with a RAN node or RAN 
SVC node.

• Universal Mobile Telecommunications System (UMTS) 
Interface—UMTS interface associated with a RAN node or RAN SVC 
node.

Name Name of the object.

Node Name of the node that is associated with the object.

Notes Indicates whether the object has an associated note.

Events Indicates whether a recent event is associated with the object. (Even if the 
server purges all of the events associated with the object, MWTM continues 
to display the event icon in this field.)

During Discovery, the MWTM might flag most objects with an event 
icon. If the event icons are too distracting, choose Edit > Clear All Events 
from the MWTM main menu to remove them.

Last Status Change Date and time that the status of the object last changed.



 

10-10
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 10      Viewing Network Topology
  Topology Tabs

New Objects Tab
The New Objects tab in the left pane of the topology window shows graphical elements for newly 
discovered objects, based on these criteria. If you are using an MWTM client with:

• The DEFAULT view set, this tab never contains any objects. In the DEFAULT view, the MWTM 
adds all newly discovered objects to the topology map as soon as they are discovered.

• A custom view set, this tab contains all objects discovered since the topology window was opened 
in this session that have not been excluded in the Excluded from View table of the View Editor 
window, or that are not in the current view.

Status Current status of the object. Possible values are:

• Active (green)

• Unknown (red)

• Unmanaged (gray)

• Warning (yellow)

For detailed definitions of each status, see Status Definitions, page E-1.

Status Reason Reason for the current status of the object.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM file in:

• The default directory, /opt, then the file resides at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the help directory and file reside in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full status reason in a tooltip.

The status reasons appear in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see Command Reference, page B-1.

Ignored Indicates whether the object should be included when aggregating and 
displaying MWTM status information:

• Uncheck the check box to include the object. This is the default setting.

• Check the check box to exclude the object.

Users with authentication level Power User (level 2) and higher can edit this 
field.

Column Description
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To display the topology New Objects tab, select the New Objects tab in the left pane of the topology 
window.

To add a newly discovered object to the topology map, select one or more objects and hold down the left 
mouse button to drag them to the map.

To exclude a newly discovered object, use the View Editor window (see Creating a New View, page 7-9).

Excluded Objects Tab
The topology Excluded Objects tab in the left pane of the topology window shows graphical elements 
for excluded objects. Excluded objects are objects that you:

• Exclude from the topology map by right-clicking the object and selecting Exclude From View.

• Move to the Excluded from View table of the View Editor window (see Creating a New View, page 
7-9).

To display the topology Excluded Objects tab, select the Excluded Objects tab in the left pane of the 
topology window.

To add an excluded object to the topology map, select the object hold down the left mouse button to drag 
it to the map. The MWTM no longer excludes the object, and removes it from the:

• Excluded Objects tab of the topology window.

• Excluded from View table of the View Editor window.

When you exclude a node from the topology map, the MWTM also removes adjacent legacy nodes from 
the map. When you add an excluded node back to the topology map, the adjacent legacy nodes reappear.

Topology Map
The topology map in the right pane of the topology window shows the objects and views in your network 
in an easy-to-read graphical format.

Views

If you have defined custom views, you can view them in the topology map. The MWTM shows a tab for 
each visible view. Each tab shows a colored ball that indicates the current status of that view:

• Active (green)

• Warning (yellow)

Note For detailed definitions of each status, see Status Definitions for Views, page E-2.

Excluded and Unmanaged Objects

The MWTM removes from the topology map any objects and their associated objects (including adjacent 
legacy nodes) that you exclude from the current view (see Excluded Objects Tab, page 10-11 and 
Creating a New View, page 7-9).

If you unmanage an object from the topology map right-click menu (see Topology Right-Click Menu: 
Object, page 10-16) the MWTM marks the object status as Unmanaged and removes any adjacent legacy 
nodes from the topology map.
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Tooltips

To see a tooltip, place the cursor over an object. For details on turning off tooltips, see Changing 
Topology Settings, page 5-8.

Viewing Associated Objects

To view objects associated with a selected object, within the:

• Tabs in the View Objects pane, click an object. Any associated objects (such as signaling points with 
associated linksets) appear in the Connections pane.

• Content area, click a single line, a heavy line, a diamond, circle, arrowhead, or double-triangle to:

– Highlight the closest associated node in the View Objects pane within a tab. For example, if a 
line connects node sgm-2600a and node sgm-2600b, and you click the line closer to node 
sgm-2600a, then the MWTM highlights that node in the View Objects pane.

– Display all objects (if any) associated with that node in the Connections pane within a tab.

– Highlight the clicked object (if it is configured) in the Connections pane within a tab.

Viewing Details for an Object

To display the Details tab for any object in the map, double-click it. If multiple options are possible, the 
Selection dialog box appears. Highlight the object, then click Select. 

Navigating and Scrolling

To:

• Scroll around in the topology map using keyboard options, click anywhere in the map, then click the 
arrow, Page Up, and Page Down keys.

• Redraw the topology map centered on a specific object, double-click the object in the View Objects 
pane within a tab.

• Activate or change the magnetic topology grid, which can help you align objects when you move 
them, use the Magnetic Grid Settings dialog box (see Activating a Magnetic Grid on the Topology 
Map, page 10-21).

• Align two or more objects on the topology map, use the Align Objects dialog box (see Aligning 
Objects on the Topology Map, page 10-25).

Saving the Topology Map

To save the topology map as a JPEG file, use the Save as JPEG dialog box (see Saving the Topology Map 
as a JPEG File, page 10-18).

Hiding or Showing Dangling Connections

To hide objects that connect to objects that are not in the current view (called dangling connections), 
click the Hiding/Showing Dangling Connections button to set it to Hide. To show dangling 
connections, click the Hiding/Showing Dangling Connections button to set it to Show. The MWTM 
draws the objects in shades of gray to distinguish them from actual objects in the current view. The 
MWTM does not save this setting (with the Hiding Dangling Connections set to Show or Hide). To 
include a dangling object in the current view, right-click the object and select Include In View.
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Locking and Unlocking Icon Positions

To lock the position of an icon on the topology map, select an unlocked icon, then select Lock position.

Locking the position of an icon can be useful if you want to keep the icon in its position, and you want 
to ensure that you do not move it inadvertently. The MWTM does not include locked icons in the circular 
or spring layouts.

To unlock the position of an icon on the topology map, click a locked icon, then select Unlock position.

Object Types within the Topology Map

The topology map might contain graphical elements for any of these objects, which the MWTM 
automatically assigns:

• Application server process

• BTS—Cisco Broadband Telephony Services (BTS) 10200 Softswitch

• Cisco 2600 series router—Cisco 2650, Cisco 2650XM, Cisco 2651, Cisco 2651XM

• Cisco 2811 series router

• Cisco 7202 series router

• Cisco 7204 series router—Cisco 7204, Cisco 7204VXR

• Cisco 7206 series router—Cisco 7206, Cisco 7206VXR

• Cisco 7301 series router

• Cisco 7304 series router

• Cisco 7505 series router

• Cisco 7507 series router: Cisco 7507, Cisco 7507mx, Cisco 7507z

• Cisco 7513 series router: Cisco 7513, Cisco 7513mx, Cisco 7513z

• Cisco 7600 series router: Cisco 7603, Cisco 7604, Cisco 7606, Cisco 7609, Cisco 7613

• Cisco MWR 1900 series router

• Cloud— A collection of objects, called a submap. A submap can also contain other submaps.

• IP device, other than other than those listed previously (if assigned by a user; see Editing Properties, 
page 6-29)

• PGW—Cisco Public Switched Telephone Network (PSTN) Gateway (PGW) 2200 Softswitch

• Signaling point instance—An SCP, SSP, or STP, or an ITP instance (if the ITP is configured for 
multi-instance)

• SS7—The MWTM is unable to determine the node type.

• A line indicates a single logical connection configured between two nodes. A line that:

– Ends in a diamond indicates that the connection has at least one configured interface or linkset 
associated with the node. 

– Ends in a circle indicates that the connection is a virtual linkset, associated with a signaling 
point. 

– Does not end in a diamond or circle indicates that the interface or linkset is not configured on 
the node or cannot be shown because the MWTM is not managing the node. 

– Ends in an arrowhead indicates that the connection is an application server process association. 

– Ends in a double-triangle indicates a connection to a view that has multiple interfaces. 
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• A heavy line indicates that two or more interfaces or linksets exist between two nodes, or between 
views and other objects.

In addition, users can assign graphical elements for these objects (see Editing Properties, page 6-29):

• Building—Icon representing a collection of objects within a building.

• City—Icon representing a collection of objects within a city.

• Database—Icon representing a database object.

• MatedPair—Mated pair of signaling points.

• MSC—Mobile switching center.

• Node-B—Radio transmission (or reception) unit for communication between radio cells in a UMTS 
network (Node-B resides at the cell site).

Note The MWTM does not manage the Node B but displays the object in the topology window to 
help you visualize the network.

• RAN SVC Node—RAN service module card.

• RNC—Radio Network Controller used in a UMTS network to aggregate multiple Node-B units.

Note The MWTM does not manage the RNC but displays the object in the topology window to 
help you visualize the network.

• SCP—Service control point.

• SSP—Service switching point.

• STP—Signal transfer point.

• Tower—Icon representing a PC tower.

• TrafficGenerator—Icon representing a device or emulator used to generate traffic, usually in a test 
environment.

• Unknown—Node that does not respond to SNMP requests for supported MIBs.

• Workstation—Icon representing a workstation.

• Workstation2—Icon representing a different workstation.

The color of a graphical element indicates its current status. For detailed definitions of each status, see 
Status Definitions, page E-1.

Note If more than one object is configured on the connection, the color associated with the object that is in 
the most compromised state represents the status color of the connection. See Table 10-1 for examples.

Table 10-1 describes the color of the connection state when objects in a configured connection have the 
possible colors (which represent states) associated with them.
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A note icon in the upper-left corner of an object means a user has attached a descriptive string.

An event icon in the upper-right corner of an object means it has a recent event associated.

The topology map also provides right-click menus for elements. For more information, see these 
sections:

• Topology Right-Click Menu: Map, page 10-15

• Topology Right-Click Menu: Object, page 10-16

Topology Right-Click Menu: Map
The topology window provides a subset of the MWTM main menu as a right-click menu. To see this 
menu for a map, right-click in a blank area of the topology map. The topology map right-click menu 
displays:

Table 10-1 Configured Connection Status Colors and States

If… …then the connection status color is …and the state is

All objects are green Green Active

At least one object is yellow, and 
the others are green

Yellow Warning

At least one object is red, and the 
others are green or yellow

Red Alarm

Command Description

Zoom In
(Ctrl-=)

Makes the map twice as large.

Zoom Out
(Ctrl-- or Ctrl-Minus)

Makes the map half as large.

Zoom Area Zooms in on the selected area of the map.

Zoom Fit Adjusts the size of the map to fit in the window. This is the default setting the 
first time the map appears.

Layout > Circular Shows the map in a circular layout.

Layout > Spring Shows the map in a spring layout. That is, the MWTM draws nodes with the 
most links closer to the center of the map, and draws nodes with fewer links 
farther away. This is the default setting the first time the map appears.

Find Opens the Find Objects dialog box, which you use to find and highlight an 
object in the topology window.

Restore Positions Restores the view to the last saved view.

Save As JPEG
(Ctrl-J)

Opens the Save as JPEG dialog box, enabling you to save the topology map to 
a JPEG file.

Magnetic Grid Opens the Magnetic Grid Settings dialog box.

Change Background 
Color

Opens the Select Background Color dialog box, which you use to select a 
color for the background of the topology map.
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Topology Right-Click Menu: Object
The topology window displays a subset of the MWTM main menu as a right-click menu. To see this 
menu for any object in the topology window, right-click on an object in the topology map in the right 
pane. Options may vary depending on the selected object type. 

For a list of right-click menu options, see Viewing the Right-Click Menu for an Object, page 8-3.

Topology Event Pane
The event pane at the bottom of the topology window shows any current events on the selected object. 
For details about the buttons and fields in the event pane, see Chapter 9, “Managing Events.”

Creating a Custom Layout
You can use the MWTM to create a custom layout for the topology map by manually moving objects on 
the map and by grouping them or isolating them to meet your needs. To move:

• A single object, click and drag the object to its new position.

• More than one object at the same time, press the Shift key and at the same time, select the objects 
and drag them. Objects keep their positions relative to one another. 

When you are satisfied with the new topology map layout, choose File > Save View from the MWTM 
main menu. The MWTM saves the changes you have made to the network view, including any changes 
you have made to the topology map layout.

Align Opens the Align Objects dialog box, which you use to align two or more 
objects on the topology map.

Create Subview Opens the View Editor window, which you use to select a new view to display 
in the topology window.

Open Parent View Opens the parent view of the currently visible view in the topology window.

This option is dimmed if the currently visible view is the highest level parent 
view.

Close View Closes the currently visible view in the topology window.

This option is dimmed if the currently visible view is the highest level parent 
view.

Command Description
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Finding an Object
Some topology maps are so large and complex that it can be difficult to find a specific object.

If the object appears in the tabs in the left pane, select the object, and the MWTM highlights it in the 
topology map.

If the object does not appear in the tabs in the left pane, click the Find objects button in the topology 
window; or, choose Edit > Find from the MWTM main menu. The Find Object dialog box appears.

You can search by using the:

• Name

• Point code (for ITP signaling points)

• IP address (for RAN-O nodes)

The Find Object dialog box contains:

Using the Selection Dialog
If more than one object matches the Search string in the Find Objects dialog box, the Selection dialog 
box appears.

The Selection dialog box contains:

Field or Button Description

Search string Character string for which the MWTM should search.

OK Launches the search. If:

• No matching object is found, the MWTM shows an appropriate 
message.

• Exactly one object is found that matches the Search string, the 
MWTM highlights the object in the Tables pane of the topology 
window, and zooms in on the selected object in the topology map.

• More than one object is found that matches the Search string, the 
Choose dialog box appears, in which you can select from a list of the 
found objects (see Using the Selection Dialog, page 10-17).

Cancel Closes the Find Objects dialog box without launching the search.

Field or Button Description

Select one in list Type, Name, or Status of the found objects. Select the object you want 
to find.

Select Highlights the selected object in the left pane of the topology window, 
and zooms in on the selected object in the topology map.

Cancel Closes the Selection dialog box without selecting an object.
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Centering the Topology Map on an Object
To redraw the topology map centered on a specific object, double-click the object in one of the tabs.

Displaying Detailed Information About a Topology Map Element
To display detailed information about an element in the map, double-click it within the map, then 
respond to the prompts. Double click:

• An object to view the Details tab in the MWTM main menu for that object.

• A single line, or a diamond, circle, or arrowhead at the end of a single line, to display the MWTM 
main window details for that linkset or application server process association.

• A double-triangle at the end of a heavy line to display the Selection dialog box. (A heavy line 
indicates that two or more interfaces or linksets exist between two objects, or between views and 
other objects.) Then, select one of the interfaces or linksets to display the Selection dialog box for 
that interface or linkset.

Printing the Topology Map
To print the topology map, see Printing Windows, page 5-24.

Saving the Topology Map as a JPEG File
You can use the MWTM to save the topology map to a JPEG file. You can save the entire topology map, 
or just the current window.

To save the topology map to a JPEG file, choose Topology Tools > Save as JPEG from the topology 
window.

The Save as JPEG dialog box appears.

Figure 10-2 Save as JPEG Dialog
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The Save as JPEG dialog box contains:

Selecting a Directory for the JPEG File
You can use the MWTM to specify or select a name or directory when you save a topology map to a 
JPEG file. You can save the entire topology map, or just the current window.

To specify a name or directory for the JPEG file, click Browse in the Save as JPEG dialog box.

The Save dialog box appears for a topology map.

Field or Button Description

All Saves the entire topology map as a JPEG file. This check box is checked by 
default.

Current Window Saves just the portion of the topology map visible in the current window as a 
JPEG file. This check box is unchecked by default, which saves the entire map; 
not just the current window.

Quality Specifies the quality of the JPEG file, from 0 (lowest quality) to 1.0 (highest 
quality). The default setting is 0.7, which is sufficient for most JPEG files.

Max. Size Specifies the size of the JPEG file, in pixels. Choose a value from the 
drop-down list box. The valid range is 400-2400 pixels. The default value is 
400 pixels, which is sufficient for most JPEG files.

Name Enter a name for the JPEG file, or accept the default filename, out.jpg.

The default directory for the JPEG file is the directory in which you installed 
the MWTM client:

• In Solaris/Linux, the default installation directory for the MWTM client is 
/opt/CSCOsgmClient.

• In Windows, the default installation directory for the MWTM client is 
C:\Program Files\SGMClient\.

• If you installed the MWTM client in a different directory, then the 
installation directory resides in that directory.

If you do not want to save the JPEG file to the default directory, click Browse 
to select a different directory.

Browse Opens the Save dialog box for a topology map (Figure 10-3), which you use to 
specify or select a name when you save the JPEG file. If you do not want to 
save the JPEG file to the default directory, click Browse to select a different 
directory.

Save Saves the JPEG file and closes the Save as JPEG dialog box.

Cancel Closes the Save as JPEG dialog box without saving the JPEG file.
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Figure 10-3 Save Dialog for a Topology Map

The Save dialog box for a topology map contains:

Field or Button Description

Save In Selects the directory in which you want to save the topology map JPEG file. 
You can accept the default directory, or select a new directory from the 
drop-down list box.

File Name Enter a name for the JPEG file, or select a file from those listed in the Save In 
field.

Files of Type Specifies the type of file to save, and shows all files of that type in the selected 
directory. Select a file type from the drop-down list box:

• All files—Shows all files in the selected directory, and saves the topology 
map file as a JPEG file.

• jpg files—Shows only JPEG files in the selected directory, and saves the 
topology map file as a JPEG file. This is the default value.

Up One Level Shows the subfolders and files that are in the folder that is up one level from 
the currently visible folder.

Desktop Shows the subfolders and files that are on your workstation desktop.

Create New Folder Creates a new subfolder in the currently visible folder.

List Shows only icons for subfolders and files.

Details Shows detailed information for subfolders and files, including their size, type, 
date they were last modified, and so on.

Save Saves the file and closes the Save dialog box for a topology map.

When you are satisfied with the settings, click Save. The MWTM closes the 
Save dialog box for a topology map and populates the Name field in the Save 
as JPEG dialog box with the new name and directory.

Cancel Closes the Save dialog box for a topology map without saving the file.
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Activating a Magnetic Grid on the Topology Map
You can use the MWTM to activate the magnetic topology grid and change how it appears. With the grid 
activated, when you move objects on the topology map they align with the grid.

Note Magnetic grid settings are not saved when you save the view.

To activate or change the magnetic topology grid, choose Topology Tools > Magnetic Grid from the 
topology window. The Magnetic Grid Settings dialog box appears.

Figure 10-4 Magnetic Grid Settings Dialog

The Magnetic Grid Settings dialog box contains:

Field or Button Description

Grid Activated Specifies whether the magnetic topology grid is activated. To:

• Activate the grid, check this check box.

• Deactivate the grid, uncheck this check box. This is the default setting.

Display Grid Specifies whether the grid should be visible on the topology map. To:

• Display the grid, check this check box. This is the default setting.

• Hide the grid, uncheck this check box.

If Grid Activated is not checked, this check box is dimmed.

Grid Spacing Specifies the spacing between lines on the grid, in pixels.

To specify the spacing between lines on the grid, in pixels, check the Grid 
Activated check box, then select a Grid Spacing level. The valid range is 
0-150 pixels. The default setting is 50 pixels, which is sufficient for most 
topology maps.

Grid Color Opens the Select Grid Color dialog box.

To specify a color for the grid, check the Grid Activated check box, then click 
Change Color in the Grid Color field. The MWTM opens the Select Grid 
Color dialog box (Figure 10-5).
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Specifying a Color for the Magnetic Grid
You can use the MWTM to customize the color of the magnetic topology grid.

Note The grid color is not saved when you save the view.

To specify a color for the grid, check the Grid Activated check box in the Magnetic Grid Settings dialog 
box, then click Select in the Grid Color field.

The Select Grid Color dialog box opens.

Figure 10-5 Select Grid Color Dialog

The Select Grid Color dialog box contains:

• Swatches Pane (Recommended), page 10-23

• HSB Pane, page 10-23

• RGB Pane, page 10-23

• Select Grid Color Field and Buttons, page 10-23

Related Topic:

Activating a Magnetic Grid on the Topology Map, page 10-21

OK Sets the new grid settings and closes the Magnetic Grid Settings dialog box.

When you are satisfied with the magnetic grid settings, click OK.

Cancel Closes the Magnetic Grid Settings dialog box without changing any settings.

Field or Button Description
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Swatches Pane (Recommended)
You can use the Swatches pane of the Select Grid Color dialog box to select a grid color from a set of 
color swatches. This is the recommended method for selecting a grid color.

To display the Swatches pane, click the Swatches tab in the Select Grid Color dialog box.

To select a grid color, select a swatch. The selected color appears in the Preview field. When you are 
satisfied with the color, click OK.

HSB Pane
You can use the HSB pane of the Select Grid Color dialog box to select a grid color based on color hue, 
saturation, and brightness (HSB).

To display the HSB pane, click the HSB tab in the Select Grid Color dialog box.

To select a grid color, use one of these procedures:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the hue (H), saturation (S), and brightness (B) fields.

The selected color appears in the Preview field. When you are satisfied with the color, click OK.

RGB Pane
You can use the RGB pane of the Select Grid Color dialog box to select a grid color based on the red, 
green, and blue (RGB) content of the color.

To display the RGB pane, click the RGB tab in the Select Grid Color dialog box.

To select a grid color, select values for the Red, Green, and Blue fields. The selected color appears in the 
Preview field. When you are satisfied with the color, click OK.

Select Grid Color Field and Buttons
The Select Grid Color dialog box contains:

Field Description

Preview Shows a preview of the currently selected grid color.

Whichever method you choose to select a grid color, the selected color appears 
in the Preview field. When you are satisfied with the color, click OK.

OK Sets the grid color as shown in the Preview field, and closes the Select Grid 
Color dialog box.

Cancel Closes the Select Grid Color dialog box without selecting a grid color.

Reset Resets the grid color to its initial setting.
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Specifying a Background Color for the Topology Map
You can use the MWTM to customize the background color of the topology map.

Note The background color is not saved when you save the view.

To specify a background color for the topology map, right-click in a blank area of the topology map, then 
select Change Background Color from the right-click menu.

The Select Background Color dialog box contains:

• Swatches Pane (Recommended), page 10-24

• HSB Pane, page 10-24

• RGB Pane, page 10-24

• Select Background Color Field and Buttons, page 10-25

Swatches Pane (Recommended)
You can use the Swatches pane of the Select Background Color dialog box to select a background color 
from a set of color swatches. This is the recommended method for selecting a background color.

To display the Swatches pane, click the Swatches tab in the Select Background Color dialog box.

To select a background color, select a swatch. The selected color appears in the Preview field. When you 
are satisfied with the color, click OK.

HSB Pane
You can use the HSB pane of the Select Background Color dialog box to select a background color based 
on color hue, saturation, and brightness (HSB).

To display the HSB pane, click the HSB tab in the Select Background Color dialog box.

To select a grid color, use one of these procedures:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the hue (H), saturation (S), and brightness (B) fields.

The selected color appears in the Preview field. When you are satisfied with the color, click OK.

RGB Pane
You can use the RGB pane of the Select Background Color dialog box to select a background color based 
on the red, green, and blue (RGB) content of the color.

To display the RGB pane, click the RGB tab in the Select Background Color dialog box.

To select a background color, select values for the Red, Green, and Blue fields. The selected color 
appears in the Preview field. When you are satisfied with the color, click OK.
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Select Background Color Field and Buttons
The Select Background Color dialog box contains:

Aligning Objects on the Topology Map

Note To unalign objects, drag and drop the object to move it on the topology map. 

You can use the MWTM to align two or more objects on the topology map. You can align the objects 
based on their left, right, top, or bottom edges, or you can center them in the map. The MWTM saves the 
alignment when you save the view.

To align objects, select the objects that you want to align, then choose Topology Tools > Align from the 
topology window. The Align dialog box appears.

Figure 10-6 Align Dialog

Field Description

Preview Shows a preview of the currently selected background color.

Whichever method you choose to select a background color, the selected color 
appears in the Preview field. When you are satisfied with the color, click OK.

OK Sets the background color as shown in the Preview field, and closes the Select 
Background Color dialog box.

Cancel Closes the Select Background Color dialog box without selecting a 
background color.

Reset Resets the background color to its initial setting.



 

10-26
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 10      Viewing Network Topology
  Hiding and Displaying Non-ITP Nodes and Linksets

The Align dialog box contains:

Hiding and Displaying Non-ITP Nodes and Linksets

Note This function applies only to ITP objects. If you have not discovered ITP objects in your network, the 
Hiding/Showing Non-ITP Nodes button does not appear.

To hide all non-ITP nodes and linksets on the topology map (the default setting), click the 
Hiding/Showing Non-ITP Nodes button. (The hidden signaling points and linksets are still visible in 
the left pane.)

To display all hidden nodes and linksets on the topology map, click the Hiding/Showing Non-ITP 
Nodes button again.

The MWTM automatically saves this setting (with non-ITP nodes and linksets either hidden or visible) 
with your preferences.

Field Description

Vertically: None Does not align the selected objects vertically.

Vertically: Left Aligns the selected objects vertically, aligned with the left edge of the 
left selected object.

Vertically: Center Aligns the selected objects vertically, with centers aligned.

Vertically: Right Aligns the selected objects vertically, aligned with the right edge of the 
right selected object.

Vertically: Side by side Aligns the selected objects vertically, aligned side-by-side, with no 
horizontal space between the objects. (There might still be vertical space 
between the objects.)

Horizontally: None Does not align the selected objects horizontally.

Horizontally: Top Aligns the selected objects horizontally, aligned with the top edge of the 
top selected object.

Horizontally: Center Aligns the selected objects horizontally, with centers aligned.

Horizontally: Bottom Aligns the selected objects horizontally, aligned with the bottom edge of 
the bottom selected object.

Horizontally: Side by side Aligns the selected objects horizontally, aligned side-by-side, with no 
vertical space between the objects. (There might still be horizontal space 
between the objects.)

Apply Aligns the selected objects and keeps the Align dialog box open, 
enabling you to continue aligning objects.

OK Aligns the selected objects and closes the Align dialog box.

Cancel Closes the Align dialog box. Changes you applied are saved; other 
changes are not saved.

Help Opens the Help window for this object. 
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Locking and Unlocking the Position of an Icon
You can use the MWTM to lock the position of an icon on the topology map. Locking the position of an 
icon can be useful if you want to keep the icon in its position, and you want to ensure that you do not 
move it inadvertently. The MWTM does not include locked icons in the circular or spring layouts.

• To lock the position of an icon on the topology map, right-click an unlocked icon, then select Lock 
Position.

• To unlock the position of an icon on the topology map, right-click a locked icon, then select Unlock 
Position. This is the default setting.

The MWTM saves this setting (with icon positions locked or unlocked) when you save the view.

Improving Topology Performance
In certain cases, you can enhance topology performance by:

• Turning Off Antialiasing, page 10-27

• Connecting Locally for Large Networks—Solaris Clients Only, page 10-27

• Hiding and Redrawing Connections When Redrawing, page 10-28

• Hiding and Showing Connections When Redrawing, page 10-28

Turning Off Antialiasing
Antialiasing, which is on by default, improves the appearance of the icons and connections in the 
topology map. However, antialiasing can cause an unexpected delay in the MWTM client on a remote 
workstation (that is, a Solaris/Linux workstation using xhost, or a Windows workstation by using an 
X-Window system emulator such as eXceed or Reflection X).

You can use the MWTM to turn off antialiasing to improve the performance of the MWTM client on a 
remote workstation. To do so, check the X Performance Enhancer (AntiAliasing Off) check box in the 
Topology settings in the Preferences window (see Changing Topology Settings, page 5-8).

To turn antialiasing back on, uncheck the check box.

Tip Keep in mind that for small networks, performance is always better if you access the MWTM by 
installing the MWTM client on the remote workstation.

Connecting Locally for Large Networks—Solaris Clients Only
If you are using a remote Solaris client and you have a large network, use a local Solaris client with a 
graphics card and an attached monitor, rather than remote access, to improve topology performance.

Note This issue might also cause an unexpected delay in the unsupported Linux client.
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Hiding and Redrawing Connections When Redrawing
To aid performance, you can use the MWTM to hide connection lines as you drag an object around the 
topology map, then re-draw the connection lines when you drop the object in its final position. To do so, 
click the Node Dragging Optimizer button to turn it on. This is the default setting.

To have the MWTM continually redraw connection lines as you drag an object around the topology map, 
click the Node Dragging Optimizer button to turn it off.

The MWTM automatically saves this setting (with the Node Dragging Optimizer on or off) with your 
preferences.

Hiding and Showing Connections When Redrawing
To aid performance, you can use the MWTM to hide connections linked to objects that are not in the 
current view, called dangling connections. To do so, click the Hiding/Showing Dangling Connections 
button to set it to Hide. This is the default setting.

To show dangling connections, click the Hiding/Showing Dangling Connections button to set it to 
Show. The MWTM draws the connections in shades of gray to distinguish them from actual objects in 
the current view.

The MWTM does not save this setting (with the Hiding Dangling Connections set to Show or Hide) when 
you save the view.

To include a dangling connection in the current view, right-click the connection and select Include In 
View.

Saving the Topology Map
When you are ready to close the topology window, choose File > Save View from the MWTM main 
menu. The MWTM prompts you to save any changes you made to the network view, including any 
changes you have made to the topology map layout, and closes the window (see Closing the View Editor 
Window, page 7-15).

Restoring the Topology Map
You can use the MWTM to restore the topology map to the way it looked in the last saved view. To do 
so, choose Topology Tools > Restore Positions from the topology window. The MWTM restores the 
view.
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This chapter provides information about accessing Cisco Mobile Wireless Transport Manager (MWTM) 
data from the MWTM web interface by using a web browser. This chapter includes:

• Accessing the MWTM Web Interface, page 11-1

• Overview of the MWTM Web Interface, page 11-2

• Displaying the Home Page, page 11-6

• Displaying the Administrative Page, page 11-9

• Displaying Alarms, page 11-27

• Displaying Events, page 11-28

• Displaying Summary Lists, page 11-28

• Displaying Reports, page 11-29

• Displaying Objects within a View, page 11-29

• Displaying RAN-O Historical Statistics, page 11-29

Accessing the MWTM Web Interface
The home page of the MWTM web interface is the first window to appear when you launch the MWTM 
web interface. 

To access the MWTM web interface, use one of these methods:

• Open a browser and enter http://server_name:1774 in the Address field.

Note 1774 is the default port.

• From the MWTM client interface, choose View > Web > Home.

The MWTM Home page window opens in the browser window. For details about the Home page, see 
Displaying the Home Page, page 11-6.
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Overview of the MWTM Web Interface
The MWTM web interface shows basic information about the events and objects that the MWTM 
manages.

Figure 11-1 MWTM Web Interface

The MWTM web interface shows these panes:

Pane Description

Title Bar Shows:

• Mobile Wireless Transport Manager, version, and server name

• Personalities (ITP, RAN-O, or both)

• Logout (appears only if you enable user access; see Configuring User 
Access, page 2-1)

• Help—Click this link to access context-sensitive online help

• Preferences—Click this link to access preferences that you can change from 
the web interface (see Changing Web Preference Settings, page 5-19)

Navigation Tree In the left pane, shows a tree of information organized by categories (see MWTM 
Web Interface Navigation Tree, page 11-3).

Content Area In the right pane, shows detailed information about the object selected in the 
navigation tree (see MWTM Web Interface Content Area, page 11-4).
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MWTM Web Interface Navigation Tree
You can easily navigate the features of the MWTM web interface by using the navigation tree in the left 
pane. To view detailed information about a selection in the navigation tree, click the item in the tree. The 
content area in the right pane shows details about the selected item. A plus (+) or minus (-) just to the 
left of the item indicates whether the item has subtending items under its domain. 

The MWTM automatically updates the navigation tree when changes occur to discovered nodes or to the 
network. When any changes occur in the MWTM client navigation tree, the MWTM web interface 
reflects these changes in its navigation tree. For example, if you delete a node in the MWTM client, the 
MWTM web interface removes that node from its navigation tree. 

Note For information about the navigation tree in the MWTM client interface, see MWTM Client Navigation 
Tree, page 4-25.

The MWTM web interface navigation tree contains:

GUI Element Description

Home Shows links to MWTM client software, Cisco 
documentation, and information about the MWTM on the 
Cisco web (see Displaying the Home Page, page 11-6).

Administrative Shows MWTM system information including messages, logs, 
status, and properties (see Displaying the Administrative 
Page, page 11-9).

If MWTM User-Based Access is enabled, only users with 
authentication level 3 (Network Operator) and higher can see 
all options. Users of all other levels see only the System 
Information and System Status panes.

Alarms Shows alarms (see Displaying Alarms, page 11-27).

Events Shows information about the events delivered by the MWTM 
event logger and event processor for events that the MWTM 
event logger and event processor deliver for all objects in the 
current network view (see Displaying Events, page 11-28).

Summary Lists Shows summaries of all objects that the MWTM manages 
(see Displaying Summary Lists, page 11-28).

Reports Shows:

• ITP historical reports for a specified time period (see 
Displaying Reports, page 11-29). 

• Event reports for RAN-O and ITP networks (see Setting 
an Event Filter, page 9-8).

If MWTM User-Based Access is enabled, only users with 
authentication level 4 (Network Administrator) and higher 
can see the Reports menu.

DEFAULT View Shows a current list of nodes in the DEFAULT view (see 
Displaying Objects within a View, page 11-29).
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MWTM Web Interface Content Area
The content area of the MWTM client interface is fully described in MWTM Client Content Area, page 
4-26. That description also applies to the web interface. Additional navigational features that appear only 
in the web interface include:

• Customizing the Date Range, page 11-4

• Using the Toolbar, page 11-4

Customizing the Date Range

Some windows require that you select date ranges for generating historical charts (see Displaying 
RAN-O Historical Statistics, page 11-29). Standard date ranges (for example, Last 24 Hours or Last 7 
Days) are available from a drop-down menu. However, if you want to customize the date range:

Step 1 Click the Customize Date and Time Range tool in the toolbar of the content area. A dialog box appears. 

Step 2 Enter a:

a. Begin Date and End Date; or, select those dates by clicking the Calendar tool. 

b. Begin Hour and End Hour from the drop-down menus, if they are available.

Note The dialog box shows an error if the End Date is equal to or less than the Begin Date. Correct 
the error before proceeding. 

Step 3 Click OK to accept the date and time changes; or, Cancel to cancel this operation.

The MWTM web interface generates a report for the specified time period.

Using the Toolbar

The web interface toolbar provides these context-sensitive tools depending on the object that you select 
in the navigation tree:

Tool or Function Description

Modify event filter Opens the Event Filter dialog box. You can create a filter to display only the 
events in which you are interested (see Setting an Event Filter, page 9-8).

Remove filter Applies or removes a filter that you created. 

Customize Date and 
Time Range

Opens the Customize Date and Time Range dialog box (see Customizing the 
Date Range, page 11-4).

Graph Series Editor Opens the Graph Series Editor dialog box, which provides a check box for 
each shorthaul that is associated with the selected RAN backhaul. To display 
a data series, check the check box. To hide a series, uncheck the check box.

The MWTM displays no more than 12 series by default. To change this 
default setting, see Display Series Dialog Box, page 8-129.

Run Runs the report type for the selected duration.
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Export Exports the raw chart data to a report with comma-separated values (CSV 
file). You can save this file to disk or open it with an application that you 
choose (for example, Microsoft Excel).

> Advances the display to the next page of information.

>> Advances the display to the last page of information.

< Advances the display to the previous page of information.

<< Advances the display to the first page of information.

Data Range Label that shows the selected time range for the historical statistics.

Duration Drop-down list of default time ranges. Select one of these options, then click 
the Run tool. To specify a nondefault time range, click the Customize Date 
and Time Range tool.

Page Size Drop-down list of different page sizes (the number of table rows in the 
display). Click the drop-down arrow to select a different value. The value 
that you select becomes the default page size for all pages in the web 
interface. 

The title bar displays the current page and total number of table entries.

Status Refresh Interval Allows you change the default refresh interval of 180 seconds. Enter a value 
between 180 and 900 seconds. 

Note Changes you make are temporary to the current page. Navigating 
away from the page sets the status refresh interval back to the default 
setting. To change the default setting, see Changing Web Preference 
Settings, page 5-19.

Slow Poller Interval Allows you to change the default slow poller interval of 60 seconds. Enter a 
value between 60 and 300 seconds. 

Note Changes you make are temporary to the current page. Navigating 
away from the page sets the status refresh interval back to the default 
setting. To change the default setting, see Changing Web Preference 
Settings, page 5-19.

Type Drop-down list of different types of reports that you can generate.

For descriptions of the different report types, see:

• Displaying Shorthaul Performance Statistics, page 11-31

• Displaying Backhaul Performance Statistics, page 11-32

• Displaying Shorthaul Error Statistics, page 11-35

• Displaying Backhaul Error Statistics, page 11-37

Tool or Function Description
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Displaying the Home Page
The MWTM web interface Home page provides access to MWTM client software, Cisco documentation, 
and information about the MWTM.

To access the Home page of the MWTM web interface, click Home under the navigation tree in the left 
pane. 

The content area in the right pane shows these GUI elements:

Pane GUI Element Description

Client Software Download Windows 
Client

Download Solaris 
Client

Download Linux 
Client

Browser Checker

Shows the download instructions for the:

• Windows client

• Solaris client

• Linux client

• Information about the browser and screen display

For details, see Downloading the MWTM Client from the 
Web, page 11-7.

MWTM on 
Cisco.com Cisco Home Page

MWTM Home Page

Engineering Software 
Updates (FTP)

MWTM Software 
Download Page

Latest MWTM 
Documentation

Shows hyperlinks to:

• http://www.cisco.com

• MWTM information on the Cisco web

• Software updates provided by Cisco Engineering

• MWTM software download from Cisco.com

• Most recent versions of MWTM documentation

For details, see Accessing Software Updates and Additional 
Information, page 11-8.

Documentation Help Home Page

User Guide

Install Guide

Release Notes

Frequently Asked 
Questions

MWTM Server Help 
Command

Shows: 

• Online Help system for the MWTM

• PDF versions1 of the:

– User Guide for the Cisco Mobile Wireless 
Transport Manager

– Installation Guide for the Cisco Mobile Wireless 
Transport Manager

– Release Notes for the Cisco Mobile Wireless 
Transport Manager

• HTML version1 of the FAQs

• CLI output of the mwtm help command

For details, see Viewing the MWTM Technical 
Documentation, page 11-9.

1. To access the latest versions, go to the parent index for Cisco MWTM user documents: 
http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html

http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html
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Downloading the MWTM Client from the Web
You can access the MWTM client installation software for Linux (unsupported), Solaris, and Windows 
from the MWTM web interface Home page. This access is useful if you do not have the CD-ROM, or if 
you prefer to download the software by using your web browser. Once you have downloaded the MWTM 
client installation software to your workstation, you must install the software on your local system.

For more information about installing the MWTM client software by using a web server, see the 
following chapters in the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0:

• “Installing the MWTM on Solaris”

• “Installing the MWTM on Windows”

• “Installing the MWTM on Linux” 

Download the Solaris Client

To access the MWTM Client for Solaris page, select Download Solaris Client.

The web interface shows the supported Solaris versions and instructions for downloading the Solaris 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Download the Windows Client

To access the MWTM Client for Windows page, select Download Windows Client.

The web interface shows supported Windows versions and instructions for downloading the Windows 
setup program. After downloading the setup program onto your desktop or other Windows directory, 
double-click the setup.exe icon to start the setup program and launch the installation wizard. See the 
Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 for detailed procedures.

To start the client after installation, launch it from the Windows Start menu or double-click the MWTM 
Client icon on your desktop.

Download the Linux Client (Unsupported)

To access the MWTM Client for Linux page, select Download Linux Client. 

Note The MWTM does not support the MWTM client for Linux. Use the MWTM Linux client under 
advisement.

The web interface shows the supported Linux versions and instructions for downloading the Linux 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.
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Checking Your Browser

Note Supported browsers for the MWTM include Mozilla 1.4 or greater, Firefox 1.5 or greater, and IE 6 or 
greater. Opening the MWTM in an unsupported browser generates a warning. Also, if JavaScript is not 
enabled, the MWTM web interface cannot function.

To check your browser and screen settings, select Browser Checker. 

The Browser Checker window contains:

Accessing Software Updates and Additional Information
You can access this information about the MWTM from the MWTM web interface Home page. To:

• View information about the MWTM or any other Cisco product available on Cisco.com, select Cisco 
Home Page.

• Read Cisco literature associated with the MWTM, including product data sheets, Q and As, and 
helpful presentations, select MWTM Home Page.

• Access software updates for the MWTM from Cisco.com for FTP, select Engineering Software 
Updates (FTP). The Cisco Systems Engineering FTP server page appears.

Pane or Field Description

Browser Information:

Browser The name and version of the browser you are using. For example, Firefox 
1.5.0.9.

Browser User Agent Text string sent to identify the user agent to the server. Typically includes 
includes information such as the application name, version, host operating 
system, and language.

Platform The platform type. For example, Win32.

Cookies Enabled Whether you have cookies enabled on the browser (Yes or No). 

Javascript Enabled Whether Javascript is enabled (Yes or No).

AJAX Component The Asynchronous JavaScript and XML (AJAX) component sends 
asynchronous HTTP update requests. The MWTM web application is only 
accessible to web browsers that have an AJAX component enabled. 
Typical values include XMLHttpRequest (for Mozilla-based browsers) 
and MSXML2.XmlHttp (for IE 6).

Screen Information:

Size Resolution of the display; for example, 1024 x 768. 

Color Depth Depth of the color display; for example, 16. 
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• Access software updates for the MWTM from Cisco.com, select MWTM Software Download 
Page. The Software Download page for the MWTM appears.

• Access the most recent versions of customer documentation for the MWTM, select Latest MWTM 
Documentation. The Cisco Mobile Wireless Transport Manager documentation page on Cisco.com 
appears. From this page, you can view the latest versions of MWTM release notes, installation 
guides, and end-user guides.

Note If you cannot access Cisco.com from your location, you can always view the customer 
documentation that was delivered with the MWTM software. See the “Viewing the MWTM 
Technical Documentation” section on page 11-9.

Viewing the MWTM Technical Documentation
From the MWTM web interface Home page, you can view this MWTM technical documentation. To 
view the:

• Entire Cisco Mobile Wireless Transport Manager Help System, select Help Home Page.

• Entire User Guide for the Cisco Mobile Wireless Transport Manager 6.0 as a PDF file on the web, 
using the Adobe Acrobat Reader, select User Guide (PDF).

• Entire Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 as a PDF file on the 
web, using the Adobe Acrobat Reader, select Install Guide (PDF).

• Entire Release Notes for the Cisco Mobile Wireless Transport Manager 6.0 as a PDF file on the web, 
using the Adobe Acrobat Reader, select Release Notes (PDF).

• Frequently Asked Questions (FAQs) about the MWTM, select Frequently Asked Questions.

• Syntax for every MWTM command, select MWTM Server Help Command.

Caution These PDF versions of technical documents might not be the latest versions. For the latest versions, go 
to: http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html.

Displaying the Administrative Page
The MWTM web interface Administrative page provides access to MWTM system information, 
including messages, logs, status, and properties.

To access the Administrative page of the MWTM web interface, click Administrative under the 
navigation tree in the left pane. The right pane displays the information indicated in Table 11-1.

Note If MWTM User-Based Access is enabled, only users with authentication level 3 (Network Operator) and 
higher can see all options. Users of all other levels see only the System Information and System Status 
panes.

http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html
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Table 11-1 Administrative Home Page Information

Pane GUI Elements Description Reference

System 
Information

• README

• ITP OS README

• RAN-O OS 
README

• MIBs

• README.txt file

• MWTM-OS-Info-ITP file

• MWTM-OS-Info-RAN-O 
file

• Lists of MIBs, including:

– RAN MIBs

– ITP MIBs 

For details, see Viewing 
System Information for 
the MWTM, page 11-11.

System 
Messages

• Info Messages

• Error Messages

• User Actions

• Message Archives

Shows tabular information 
about different types of system 
messages. 

For details, see Viewing 
System Messages, page 
11-12.

System Status • System Status

• System Versions

• Connected Clients

• User Accounts

Shows the output of these 
system commands: 

• mwtm status 

• mwtm version 

• mwtm who 

• mwtm users 

For details, see Viewing 
System Status 
Information, page 11-17.

System Logs • Console Log

• Command Log

• Event Automation 
Log

• Security Log

• Install Log

• Web Access Log

• Web Error Log

• Report Log

Shows the contents of these 
system logs:

• sgmConsoleLog.txt

• sgmCommandLog.txt

• eventAutomationLog.txt

• sgmSecurityLog.txt

• cisco_sgmsvr_install.log

• access_log

• error_log

• sgmReportLog.txt

For details, see Viewing 
System Logs, page 11-19.

Properties • System

• Server

• WebConfig

• Reports

• Trap Forwarding

Shows the contents of these 
system property files:

• System.properties

• Server.properties

• WebConfig.properties

• Reports.properties

• TrapForwarder.properties

For details, see Viewing 
Properties, page 11-23.
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Viewing System Information for the MWTM
You can view this MWTM system information from the Administrative page:

• README—Shows the contents of the /opt/CSCOsgm/install/README.txt file. This file provides 
a brief overview of the system requirements and the tasks that are necessary to install this software 
release.

To access the MWTM README page, select README from the Administrative page.

• ITP OS README—Shows the contents of the /opt/CSCOsgm/install/MWTM-OS-Info-ITP file. 
This file contains a list of the supported OS software images for:

– ITP nodes

– GTT encoding scheme

– MLR address table configuration

– GTT accounting statistics reports

– Route table and GTT table deployment

– MSU rates

– ITP provisioning

To access the MWTM ITP OS README page, select ITP OS README from the Administrative 
page.

• RAN-O OS README—Shows the contents of the /opt/CSCOsgm/install/MWTM-OS-Info-RAN-O 
file. This file contains a list of the supported OS software images for:

– MWR nodes 

– ONS nodes

– RAN SVC cards

To access the MWTM RAN-O OS README page, select RAN-O OS README from the 
Administrative page.

• MIBs—Shows a list of the RAN or ITP MIBs (or both) on the server to which you are connected, 
and which is currently running the MWTM. 

Each MIB appears in a list as a clickable link. You can open or download the contents of the MIB 
by clicking the MIB name. See Appendix F, “MIB Reference,” for a complete list and high-level 
description of each supported MIB.

To access the MIBs page, select MIBs from the Administrative page of the MWTM web interface.
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Viewing System Messages
You can view these MWTM system messages from the Administrative page:

Note These messages are related to the MWTM system itself, not to your network.

• Viewing Info Messages, page 11-12

• Viewing Error Messages, page 11-13

• Viewing MWTM User Action Messages, page 11-13

• Viewing All Archived MWTM Messages, page 11-16

Viewing Info Messages

The System Messages: Last number Info Messages page shows informational messages in the MWTM 
system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems.

To access this page, click Info Messages from the Administrative page, or Info from the web page 
menu bar, if visible.

The Last Info Messages table contains:

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the MWTM last updated the information on the page.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the hostname of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; 
or in the event that two or more clients are running on the same node, connected 
to the same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.
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Viewing Error Messages

The System Messages: Last number Error Messages page shows error messages stored in the MWTM 
system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems.

To access this page, click:

• Error Messages from the Administrative page.

• Error from the web page menu bar, if visible.

The Last Error Messages table contains:

Viewing MWTM User Action Messages

The System Messages: Last number Action Messages page shows user action messages stored in the 
MWTM system log. These messages can be useful when diagnosing and correcting MWTM operational 
problems, and when monitoring audit trails of user actions.

To access this page, use one of these procedures. Click:

• User Actions from the Administrative page.

• Action from the web page menu bar, if visible.

The MWTM shows the System Messages: Last number Action Messages page.

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the MWTM last updated the information on the page.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the hostname of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; 
or in the event that two or more clients are running on the same node, connected 
to the same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.
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Figure 11-2 System Messages: Last X Action Messages Page

The System Messages: Last number Action Messages page has these sections:

• Last Action Messages Menu, page 11-15

• Last Action Messages Table, page 11-15
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Last Action Messages Menu

By default, the MWTM shows action messages of all classes on the System Messages: Last number 
Action Messages page. However, the MWTM provides menu options that enable you to display only 
messages of a specific class on the page.

The Last Action Messages menu contains:

Last Action Messages Table

The Last Action Messages table contains:

Column Description

Create Opens the System Messages: Last number Action: specified web page:

• Create—Opens the Create Messages web page, showing only Create action 
messages.

• Delete—Opens the Delete Messages web page, showing only Delete action 
messages.

• Discover—Opens the Discover Messages web page, showing only Discover 
action messages.

• Edit—Opens the Edit Messages web page, showing only Edit action messages.

• Ignore—Opens the Ignore Messages web page, showing only Ignore action 
messages.

• OverWrite—Opens the OverWrite Messages web page, showing only 
OverWrite action messages.

• Poll—Opens the Poll Messages web page, showing only Poll action messages.

• Purge—Opens the Purge Messages web page, showing only Purge action 
messages.

• LogInOut—Opens the LogInOut Messages web page, showing only Log in and 
Log out action messages.

• All—Opens a web page that shows all action messages.

• Provision—Opens a web page that shows all provisioning messages.

Delete

Discover

Edit

Ignore

OverWrite

Poll

Purge

LogInOut

All

Provision

Column Description

Period
(in heading)

Collection period of the table, such as Since Server Restart.

Timestamp
(in heading)

Date and time the information on the page was last updated by the MWTM.

Row Unique number identifying each entry in the table. You cannot edit this field.

Time Date and time the message was logged.

To sort the messages by time, click the Time heading.
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Viewing All Archived MWTM Messages

The System Message Archives: All Messages page shows all archived messages in the MWTM system 
logs, including:

• error

• informational

• trace

• debug 

• dump

• messages

• SNMP

To access the System Message Archives: All Messages page, use one of these options. Click:

• Message Archives from the Administrative page.

• Archives from the web page menu bar, if visible.

On the System Message Archives: All Messages page, messages are archived by timestamp. Each 
archived file contains all MWTM system messages for a single session for the server to which you are 
connected, and which is currently running the MWTM server. (If you restart the server, the MWTM 
creates a new file.)

Class Class of the message. Possible classes are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has flagged a link or linkset as Ignored.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to log 
in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route file, 
has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing Data 
selected, and the MWTM has deleted the existing MWTM database.

To sort the messages by class, click the Class heading.

Message Text of the message.

To sort the messages alphabetically by message text, click the Message heading.

Column Description
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To view archived messages, click a timestamp. The System Messages Archive: Last number All 
Messages page appears, which shows all messages that were in the system log at the specified timestamp.

Note You might observe an entry labeled messageLog-old among a list of files that have timestamps in the 
filenames. A daily cron job creates the files with the timestamps. The cron job, which runs at midnight, 
searches through the messageLog.txt and messageLog-old.txt files for all entries from the past day. The 
messageLog-old.txt file exists only if the size of messageLog.txt exceeds the limit set by the mwtm 
msglogsize command. The MWTM lists the contents of messageLog-old.txt because it could contain 
important data from the day the message log file rolled over. 

The Last All Messages table contains this information (without column headers):

Viewing System Status Information
You can view this MWTM system status information from the Administrative page:

• Viewing System Status, page 11-18

• Viewing System Versions, page 11-18

• Viewing Connected Clients, page 11-18

• Viewing User Accounts, page 11-18

Description Information Displayed

Index Message number that the MWTM assigns to the message.

Time Date and time the message was logged.

Type Type of message. Possible types are:

• Action

• Debug

• Dump

• Error

• Info

• SNMP

• Trace

Source Source for the message, with the format process.host.id, where:

• process is the process that logged the message.

• host is the hostname of the process that logged the message.

• id is an MWTM ID that uniquely identifies the process that logged the message; or, 
in the event that two or more clients are running on the same node, connected to the 
same MWTM server.

Task Task, or thread, that logged the message.

Message Text of the message.
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Viewing System Status

To access system status information, click System Status from the Administrative page. (The MWTM 
might take a few seconds to display this page.) This page shows the status of all MWTM servers, local 
clients, and processes. 

Viewing System Versions

To access version information, click System Versions from the Administrative page. (The MWTM 
might take a few seconds to display this page.) This page shows version information for all MWTM 
servers, clients, and processes. 

Viewing Connected Clients

To access connected client information, click Connected Clients from the Administrative page. This 
page lists all MWTM clients that are currently connected to the MWTM server. It also lists all Solaris 
and Linux users that are logged in to the MWTM server.

Viewing User Accounts

To access user account information, click User Accounts from the Administrative page. This page shows 
information about all user accounts that have been defined for the MWTM server. If no user accounts 
have been defined, the MWTM shows this message:

User Database is Empty

The user accounts page displays the output of the mwtm users command. For example:

/opt/CSCOsgm/bin/mwtm users

User Name Last Login Level Name & Number Status
-----------------------------------------------------------------
User1 Wed Jan 17 14:03:13 EST 2007 System Admin 5 [Account Enabled]
User2 Unknown  System Admin 5 [Account Enabled]
User3 Wed Jan 17 13:43:30 EST 2007 System Admin 5 [Account Enabled]

User Based Access Protection is Enabled.

Authentication type = local

The the mwtm users command output contains:

Heading Description

User Name The MWTM user for whom a User-Based Access account has been set up.

Last Login Date and time the user last logged in to the MWTM.
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Viewing System Logs
From the Administrative page, you can view: 

• Viewing the Console Log, page 11-19

• Viewing the Command Log, page 11-20

• Viewing the Event Automation Log, page 11-21

• Viewing the Security Log, page 11-21

• Viewing the Install Log, page 11-22

• Viewing the Web Access Logs, page 11-22

• Viewing the Web Error Logs, page 11-22

• Viewing the Report Log, page 11-22

Viewing the Console Log

The Console Log shows the contents of the MWTM system console log file for the server to which you 
are connected, and which is currently running the MWTM. The console log file contains unexpected 
error and warning messages from the MWTM server, such as those that might occur if the MWTM server 
cannot start. It also provides a history of start-up messages for server processes and the time each 
message appeared.

To access the Console Log, click Console Log in the System Logs pane of the Administrative page. You 
can also view the Console Log with the mwtm console command.

Level Name & 
Number

Authentication level and number for the user. Valid levels and numbers are:

• Basic User, 1

• Power User, 2

• Network Operator, 3

• Network Administrator, 4

• System Administrator, 5

Status Current status of the user’s account. Valid status settings are:

• Account Enabled—The account has been enabled and is functioning normally.

• Account Disabled—The account has been disabled for one of these reasons:

– A System Administrator disabled the account. See the “mwtm disablepass” 
section on page B-19 and the “mwtm disableuser” section on page B-20 for 
more information.

– The MWTM disabled the account as a result of too many failed attempts to 
log in using the account. See the “mwtm badlogindisable” section on 
page B-9 for more information.

– The MWTM disabled the account because it was inactive for too many 
days. See the “mwtm inactiveuserdays” section on page B-26 for more 
information.

Heading Description
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Viewing the Command Log

The Command Log shows the contents of the MWTM system command log file for the server to which 
you are connected, and which is currently running the MWTM server. The system command log lists all 
mwtm commands that have been entered for the MWTM server, the time each command was entered, 
and the user who entered the command.

To access the Command Log, click Command Log in the System Logs pane of the Administrative page. 
You can also view the Command Log with the mwtm cmdlog command.

The MWTM Command Log page appears.

Figure 11-3 MWTM Command Log Page

The Command Log table contains:

Column Description

Timestamp Date and time the command was logged.

To sort the messages by time, click the Timestamp heading.

User User who entered the command.

To sort the commands by user, click the User heading.

Command Text of the command.

To sort the messages alphabetically by command text, click the Command heading.
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Viewing the Event Automation Log

The Event Automation Log shows the contents of the system event automation log file for the server to 
which you are connected, and which is currently running the MWTM server. The system event 
automation log lists all messages that event automation scripts generate.

The default path and filename for the system event automation log file is 
/opt/CSCOsgm/logs/eventAutomationLog.txt. If you installed the MWTM in a directory other than /opt, 
then the system event automation log file is in that directory.

To access the Event Automation Log, click Event Automation Log in the System Logs pane of the 
Administrative page. You can also view the Event Automation Log with the mwtm eventautolog 
command.

Related Topic

Changing the Way the MWTM Processes Events, page 9-27

Viewing the Security Log

The Security Log shows the contents of the MWTM system security log file for the server to which you 
are connected, and which is currently running the MWTM server. The system security log lists:

• All security events that have occurred for the MWTM server

• The time each event occurred

• The user and command that triggered the event

• The text of any associated message

The default path and filename for the system security log file is /opt/CSCOsgm/logs/sgmSecurityLog.txt. 
If you installed the MWTM in a directory other than /opt, then the system security log file is in that 
directory.

To access the Security Log, click Security Log in the System Logs pane of the Administrative page. You 
can also view the Security Log with the mwtm seclog command.

The Last Security Entries table contains these columns:

Column Description

Timestamp Date and time the security event occurred.

To sort the entries by time, click the Time heading.

User User who triggered the security event.

To sort the entries by user, click the User heading.

Message Text of the security event message.

To sort the entries alphabetically by message text, click the Message heading.

Command Text of the command that triggered the security event.

To sort the entries alphabetically by command text, click the Command heading.
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Viewing the Install Log 

The Install Log shows the contents of the MWTM system installation log. The installation log contains 
messages and other information recorded during installation, which can be useful when troubleshooting 
problems. The Install Log also records the installer’s selections (for example, whether the installer chose 
to configure the MWTM to receive SNMP traps).

The default path and filename for the install log file is /opt/CSCOsgm/install/cisco_sgmsvr_install.log. 
If you installed the MWTM in a directory other than /opt, then the install log file is in that directory.

To access the Install Log, click Install Log in the System Logs pane of the Administrative page. You can 
also view the Install Log with the mwtm installlog command.

Viewing the Web Access Logs

The Web Access Logs page shows a list of web access log files for the server to which you are connected, 
and which is currently running the MWTM server. The web access log lists all system web access 
messages that have been logged for the MWTM server, providing an audit trail of all access to the 
MWTM server through the MWTM web interface.

The default path and filename for the web access log file is /opt/CSCOsgm/apache/logs/access_log. If 
you installed the MWTM in a directory other than /opt, then the web access log file is in that directory.

To access the Web Access Logs page, click Web Access Logs from with the System Logs pane of the 
Administrative page. You can also view the Web Access Logs page using the mwtm webaccesslog 
command.

Viewing the Web Error Logs

The Web Error Logs page shows a list of web error log files for the server to which you are connected, 
and which is currently running the MWTM server. The web server error log lists all system web error 
messages that have been logged for the MWTM web server. You can use the web error log to 
troubleshoot the source of problems that users may have encountered while navigating the MWTM web 
interface.

The default path and filename for the web error log file is /opt/CSCOsgm/apache/logs/error_log. If you 
installed the MWTM in a directory other than /opt, then the web error log file is in that directory.

To access the Web Error Logs page, click Web Error Logs in the System Logs pane of the 
Administrative page. You can also view the Web Error Logs page using the mwtm weberrorlog 
command.

Viewing the Report Log

The Report Log shows the message log for ITP reports for the server to which you are connected, and 
which is currently running the MWTM server. You can view this log to determine the beginning and 
finish times for report generation. The log also records errors that occurred during report generation (for 
example, server connection errors).

The default path and filename for the report log file is /opt/CSCOsgm/logs/sgmReportLog.txt. If you 
installed the MWTM in a directory other than /opt, then the report log file is in that directory.

To access the Report Log, click Report Log in the System Logs pane of the Administrative page. You 
can also view the Report Log with the mwtm replog command.
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Viewing Properties
Property files for the MWTM are in the /opt/CSCOsgm/properties directory. You can view these MWTM 
properties from the Administrative page.

• Viewing Properties, page 11-23

• Viewing Server Properties, page 11-24

• Viewing Web Configuration Properties, page 11-24

• Viewing Reports Properties, page 11-26

• Viewing Trap Forwarding Properties, page 11-27

Viewing Properties

To access the System Properties file, click System in the Properties pane of the Administrative page. The 
MWTM shows the contents of the /opt/CSCOsgm/properties/System.properties file.

The System Properties file contains MWTM server and client properties that control various MWTM 
configuration parameters. 

You can use MWTM commands to change these system properties:

To change this system property Use this MWTM command

ATBLDIR mwtm atbldir, page B-78

BADLOGIN_TRIES_ALARM mwtm badloginalarm, page B-9

BADLOGIN_TRIES_DISABLE mwtm badlogindisable, page B-9

GTTDIR mwtm gttdir, page B-86

JSP_PORT mwtm jspport, page B-29

LOGAGE mwtm msglogage, page B-35

LOGDIR mwtm msglogdir, page B-35

LOGSIZE mwtm msglogsize, page B-36

LOGTIMEMODE mwtm logtimemode, page B-31

LOG_TROUBLESHOOTING mwtm tshootlog, page B-66

MANAGE_ITP mwtm manage, page B-31

MANAGE_RAN-O mwtm manage, page B-31

ROUTEDIR mwtm routedir, page B-102

SBACKUPDIR mwtm backupdir, page B-8

SNMPCONFFILE mwtm snmpconf, page B-51

SSL_ENABLE mwtm ssl, page B-59

USE_TELNET_PROXY mwtm tnproxy, page B-64

VCS_REPOSITORY_DIR mwtm archivedir, page B-76

WEB_PORT mwtm webport, page B-71

WEB_BROWSER mwtm browserpath, page B-10
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Viewing Server Properties

To access the Server Properties file, click Server in the Properties pane of the Administrative page. The 
MWTM shows the contents of the /opt/CSCOsgm/properties/Server.properties file.

The Server Properties file contains MWTM various properties that control the MWTM server.

You can use MWTM commands to change these server properties:

To change poller parameters in the Server Properties file, see the “Changing MWTM Server Poller 
Settings” section on page 3-2.

Viewing Web Configuration Properties

To access the Web Configuration Properties file, click WebConfig in the Properties pane of the 
Administrative page. The MWTM shows the contents of the /opt/CSCOsgm/properties/
WebConfig.properties file. 

The Web Configuration Properties file contains properties that control the configuration of the MWTM 
web interface. For example:

MAX_ASCII_ROWS      = 6000
MAX_HTML_ROWS       = 100

# The selectable page sizes start at MIN_SELECTABLE_PAGE_SIZE and doubles until
# the MAX_SELECTABLE_PAGE_SIZE value is reached
# (e.g. 25, 50, 100, 200, 400, 800)
MIN_SELECTABLE_PAGE_SIZE = 25
MAX_SELECTABLE_PAGE_SIZE = 800
LOG_UPDATE_INTERVAL = 300
WEB_UTIL            = percent
WEB_NAMES           = display
MAX_EV_HIST         = 15000

To change this server property Use this MWTM command

DEMAND_POLLER_TIMELIMIT mwtm pollertimeout, page B-39

SNMP_MAX_ROWS mwtm snmpwalk, page B-56

UNKNOWN_AGING_TIMEOUT mwtm unknownage, page B-66
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You can use the MWTM to change the web configuration properties:

Web Configuration Property Changing Default Setting

LOG_UPDATE_INTERVAL To control how often, in seconds, the MWTM updates certain web 
output, use the mwtm weblogupdate command. The valid range is 1 
second to an unlimited number of seconds. The default value is 300 
seconds (5 minutes).

MAX_ASCII_ROWS To set the maximum number of rows for MWTM ASCII web output, 
such as displays of detailed debugging information, use the mwtm 
maxasciirows command. The valid range is 1 row to an unlimited 
number of rows. The default value is 6,000 rows.

MAX_EV_HIST To set the maximum number of rows for MWTM to search in the event 
history logs, use the mwtm maxevhist command. The event history 
logs are the current and archived MWTM network status logs for status 
change and SNMP trap messages. The MWTM sends the results of the 
search to the web browser, where the results are further limited by the 
setting of the mwtm maxhtmlrows command. The valid range is 1 row 
to an unlimited number of rows. The default value is 15,000 rows.

MAX_HTML_ROWS To set the maximum number of rows for MWTM HTML web output, 
such as displays of statistics reports, status change messages, or SNMP 
trap messages, use the mwtm maxhtmlrows command. This lets you 
select a page size (if you have not explicitly chosen a page size). Once 
you select a page size from any page, the MWTM remembers your 
preference until you delete your browser cookies. The default value is 
100 rows.

MIN_SELECTABLE_PAGE
_SIZE

This setting determines the minimum page size for the user to select 
from the Page Size drop-down menu. The page size values start with the 
MIN_SELECTABLE_PAGE_SIZE and double until they reach the 
MAX_SELECTABLE_PAGE_SIZE.

MAX_SELECTABLE_
PAGE_SIZE

This setting determines the maximum page size for the user to select 
from the Page Size drop-down menu. The page size values start with the 
MIN_SELECTABLE_PAGE_SIZE and double until they reach the 
MAX_SELECTABLE_PAGE_SIZE.
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Each of the web configuration commands requires you to be logged in as the root user, as described in 
the “Becoming the Root User (Server Only)” section on page 4-2, or as a superuser, as described in the 
“Specifying a Super User (Server Only)” section on page 2-18.

Related Topic

Link Reports, page 12-21

Viewing Reports Properties

To access the Reports Properties file, click Reports in the Properties pane of the Administrative page. 
The MWTM shows the contents of the /opt/CSCOsgm/properties/Reports.properties file.

The Reports Properties file contains properties that control various aspects of the reports that are 
available in the MWTM web interface. 

You can use MWTM commands to change these reports properties:

WEB_NAMES To specify whether the MWTM should show real DNS names or display 
names in web pages, enter the mwtm webnames command. To show:

• The real DNS names of nodes, as discovered by the MWTM, enter 
mwtm webnames real.

• Display names, enter mwtm webnames display. Display names 
are new names that you specify for nodes. This is the default 
setting. For more information about display names, see the 
“Editing Properties” section on page 6-29.

WEB_UTIL To specify whether the MWTM should display send and receive 
utilization as percentages or in Erlangs in web pages, enter the mwtm 
who command. To show:

• Utilization as a percentage, enter mwtm webutil percent. This is 
the default setting.

• Display utilization in Erlangs (E), enter mwtm webutil erlangs.

See Chapter 8, “Viewing RAN-O Performance and Error Data” for 
more information on send and receive utilization for shorthauls and 
backhauls. 

See Chapter 12, “Managing ITP Reports” for more information on send 
and receive utilization for linksets and links. 

Web Configuration Property Changing Default Setting

To change this server property Use this MWTM command

ACC_REPORTS mwtm accstats, page B-75

GTT_REPORTS mwtm gttstats, page B-88

LINK_REPORTS mwtm linkstats, page B-89

MLR_REPORTS mwtm mlrstats, page B-93

MSU_REPORTS mwtm statreps msu, page B-112

Q752_REPORTS mwtm q752stats, page B-99

RPT_15MIN_AGE mwtm rep15minage, page B-43
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Viewing Trap Forwarding Properties

To access the Trap Forwarding Properties file, click TrapForwarding in the Properties pane of the 
Administrative page. The MWTM shows the contents of the 
/opt/CSCOsgm/properties/TrapForwarder.properties file.

The Trap Forwarder Properties file contains a list of the destination addresses for the trap forwarder. 
Enter each destination address on its own line and use this format:

SERVERxx=destination_IP_address[:port_number]

The port_number parameter is optional.

Displaying Alarms
Displaying alarms in the web interface is essentially the same as displaying them in the MWTM client. 
Only minor differences exist. The Alarms table in the web interface:

• Shows only those columns that the client interface shows by default. 

• Has a paging feature. See the “Using the Toolbar” section on page 11-4.

• Has a refresh interval that you can change. See the “Using the Toolbar” section on page 11-4.

For descriptions of the columns in the Alarms table, see the “Displaying Alarms” section on page 4-30.

RPT_CUSTOM_AGE mwtm repcustage, page B-100

RPT_DAILY_AGE mwtm repdailyage, page B-43

RPT_HOURLY_AGE mwtm rephourlyage, page B-44

RPT_IPLINKS mwtm statreps iplinks, page B-110

RPT_MONTHLY_AGE mwtm repmonthlyage, page B-44

RPT_NULLCAPS mwtm statreps nullcaps, page B-113

RPT_SERVRATIO mwtm statreps servratio, page B-114

RPT_TIMEMODE mwtm statreps timemode, page B-115

STATS_REPORTS mwtm statreps servratio, page B-114

XUA_REPORTS mwtm xuastats, page B-117

To change this server property Use this MWTM command
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Displaying Events
The Events table lists the events that the MWTM manages. To access the Events table of the MWTM 
web interface, click Events in the navigation tree in the left pane. The content area in the right pane 
shows the Events table. 

Some differences exist between the web and client interface displays of the Events table. For example, 
the Events table in the MWTM web interface also shows archived events in addition to recent events. 
The MWTM web interface also shows fewer columns, has fewer buttons on the toolbar, and displays 
colored status balls in the Severity column. 

For descriptions of the columns, see the “Event Table” section on page 9-5. 

For descriptions of the tools in the toolbar, see the “Using the Toolbar” section on page 11-4. 

To navigate the columns of the Events table, see Navigating Table Columns, page 5-23.

Displaying Summary Lists
Displaying Summary Lists in the web interface is essentially the same as displaying them in the MWTM 
client. Only minor differences exist. Clicking on an object under the Summary Lists in the web interface 
causes the content area to show information about the object. The content area:

• Shows only those columns that the client interface shows by default. 

• Has a refresh interval that you can change. See the “Using the Toolbar” section on page 11-4.

For complete information about Summary Lists, see the “Displaying Object Windows” section on 
page 6-2.

Displaying Software Versions
The Software Versions table lists the software versions for each node the MWTM manages.

To access the Software Versions page:

• From the Web interface navigation tree, select Summary Lists > Software Versions.

• From the MWTM main window, select View > Web > Software Versions.

For details on navigating the columns of the Software Versions table, see Navigating Table Columns, 
page 5-23.

The Software Versions table contains:

Column Description

Refresh 
Interval 
(seconds)

Refresh interval in seconds.

To change the refresh interval, click Refresh Interval (seconds) or click the current 
value that appears. Then change the current value to a new one.

Last Updated Date and time when this information on this page was last updated.

Name Name of the node.

Node Type Type of node.
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Displaying Reports

Note If MWTM User-Based Access is enabled, only users with authentication level 4 (Network 
Administrator) and higher can see the Reports menu.

You can display reports primarily for ITP objects in the MWTM Web interface. An overview and a 
complete list and description of these reports is available in Chapter 12, “Managing ITP Reports.”

Event reports are also available for both RAN-O and ITP networks, also available within the Reports 
menu. For details, see the “Viewing Archived Event Files on the Web” section on page 9-22 and the 
“Viewing the Event Metrics Report on the Web” section on page 9-23.

Displaying Objects within a View
Displaying objects within a view in the MWTM web interface is essentially the same as viewing them 
in the MWTM client. Only minor differences exist. The MWTM web interface:

• Shows a subset of the columns that the client interface shows. 

• Has a paging feature. See the “Using the Toolbar” section on page 11-4.

• Has a refresh interval that you can change.

For details on each object type, see the “Displaying Object Windows” section on page 6-2.

Displaying RAN-O Historical Statistics
The MWTM web interface provides access to RAN-O historical statistics in the MWTM database. You 
can use these statistics for capacity planning and trend analysis. For example, you can generate charts:

• For a specified time range to display historical statistics for customer busy-hours. 

• To show the maximum send and receive traffic over a specified time period. 

• To show data on a 15-minute, daily, or hourly basis. 

Using this information, you can perform detailed analysis of historical traffic utilization on the backhaul 
and shorthaul links to plan future facility upgrades.

Note The MWTM client provides real-time (not historical) charts depicting performance and error 
information occurring in real time. You use real-time statistics for troubleshooting active problem areas 
in your network. See the “Viewing RAN-O Performance and Error Data” section on page 8-123.

Software 
Version

Software version used by the node.

Software 
Description

Full software version information. 

Column Description
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This section provides information about:

• Displaying Performance Statistics, page 11-30

• Displaying Error Statistics, page 11-34

• Generating RAN Data Export Files, page 11-38

Displaying Performance Statistics
You can view performance data for a shorthaul or backhaul interface within the MWTM:

• Web interface by selecting an interface in the navigation tree and clicking the Performance tab in 
the right pane.

• Client interface by right-clicking an interface in the navigation tree and clicking Performance 
History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > RAN-O OS README.

• Client interface, choose View > Web > Administrative; then click RAN-O OS README.

The Performance tab shows one or more charts depending on whether you selected a shorthaul or a 
backhaul interface. These charts depict send and receive rates of optimized IP traffic over a specified 
time range. The charts display the traffic in bits per second. Each data series shows maximum, minimum, 
and average rates of optimized traffic.

The Performance tab for a backhaul interface shows total rates for GSM and UMTS traffic, including 
total error rates.

This section provides information about:

• Displaying Shorthaul Performance Statistics, page 11-31

• Displaying Backhaul Performance Statistics, page 11-32
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Displaying Shorthaul Performance Statistics

The Performance tab for a shorthaul interface shows the maximum, minimum, and average rates for send 
and receive traffic. 

Figure 11-4 Example of Performance Tab for Shorthaul Interface

The Performance tab for a shorthaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select a report type and duration, and to export the report to 
a CSV file. See the “Using the Toolbar” section on page 11-4.

Type:

Capacity 
Summary

A comprehensive summary of minimum, average, and maximum capacity statistics 
for send and receive traffic on the RAN shorthaul. You can choose from 15-minute, 
hourly, or daily data report types.

Expand to Full 
Screen

Text link that shows a chart in a new, full-screen window for easier viewing.

Bits/Sec Y-axis label that shows traffic rate in bits per second. The Y axis automatically 
scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.
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Displaying Backhaul Performance Statistics

The Performance tab for a backhaul interface shows minimum, average, and maximum traffic rates for 
send and receive traffic. You can also determine the percentage of backhaul utilization that various traffic 
types occupy. Error rates appear, too. 

Figure 11-5 Example of Performance Tab for Backhaul Interface

Time X-axis label that shows a historical time scale and the server time zone.

Legend Color-coded legend that shows labels for traffic rates.

GUI Elements Description
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The Performance tab for a backhaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select a report type and duration, customize the display of 
associated shorthauls, and export the report to a CSV file. See the “Using the 
Toolbar” section on page 11-4.

Type:

Capacity 
Summary

A comprehensive summary of minimum, average, and maximum capacity statistics 
for total (GSM-Abis and UMTS-Iub) traffic, total GSM-Abis traffic, and total 
UMTS-Iub traffic. You can choose from 15-minute, hourly, or daily data report 
types.

Statistics appear in three fully expandable charts:

• Top—Capacity statistics for send traffic rates, including percentage of 
backhaul utilization (right side of chart).

• Middle—Capacity statistics for receive traffic rates, including percentage of 
backhaul utilization (right side of chart).

• Bottom—Error counts for send and receive traffic.

Type:

Capacity 

Depending on your selection, the minimum, average, or maximum capacity 
statistics for the backhaul interface. You can choose from 15-minute, hourly, or 
daily data report types.

Send and receive rate statistics appear in separate panes. Each pane shows two fully 
expandable charts:

• Top—Shows total (GSM-Abis and UMTS-Iub), total GSM-Abis, and total 
UMTS-Iub traffic rates, including percentage of backhaul utilization (right 
side of chart).

• Bottom—Shows traffic rates for each shorthaul interface that belongs to the 
backhaul.

Expand to Full 
Screen

Text link that shows a chart in a new, full-screen window for easier viewing.

Bits/Sec Primary Y-axis label (left side of chart) that shows traffic rate in bits per second. 
The Y axis automatically scales to the User Bandwidth. See the“Editing Properties 
for a RAN-O Backhaul” section on page 6-33. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.

% Utilization Secondary Y-axis label (right side of chart) that shows the backhaul utilization as 
a percentage of the User Bandwidth. The chart background has three horizontal 
bars that are color-coded to indicate these thresholds:

• Overloaded—Top portion of chart.

• Warning—Middle portion of chart.

• Acceptable—Bottom portion of chart.

For definitions of these thresholds, see the “Threshold Information (RAN-O Only)” 
section on page 8-42.

To change the threshold settings, see the “Editing Properties for a RAN-O 
Backhaul” section on page 6-33.
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Displaying Error Statistics
You can view error data for a shorthaul or backhaul interface within the MWTM: 

• Web interface by selecting an interface in the navigation tree and clicking the Errors tab in the 
content area.

• Client by right-clicking an interface in the navigation tree and clicking Error History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > RAN-O OS README.

• Client interface, choose View > Web > Administrative; then click RAN-O OS README.

You view error data for a shorthaul or backhaul interface by selecting the interface in the navigation tree 
and clicking the Errors tab in the content area. The Errors tab shows total error counts and average error 
rates in table and chart format. 

This section provides information about:

• Displaying Shorthaul Error Statistics, page 11-35

• Displaying Backhaul Error Statistics, page 11-37

Time X-axis label that shows a user-specified, historical time scale and the server time 
zone.

Legend Color-coded legend that shows labels for traffic and error rates.

GUI Elements Description
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Displaying Shorthaul Error Statistics

The Errors tab for a shorthaul interface shows a single table and a chart that shows the error rates and 
counts for different types of GSM-Abis and UMTS-Iub errors. 

Figure 11-6 Example of Errors Tab for Shorthaul Interface

The Errors tab for a shorthaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select a report type and duration, and to export the report 
to a CSV file. See the “Using the Toolbar” section on page 11-4.

Type:

Errors Summary

A comprehensive summary of total error counts and average error rates for 
optimization, missed-packet, and miscellaneous errors for the selected shorthaul. 
You can choose from 15-minute, hourly, or daily data report types. Statistics 
appear in table and chart format. 
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Type:

Errors 

Depending on your selection, the optimization, missed packet, or miscellaneous 
errors for the shorthaul interface. You can choose from 15-minute, hourly, or 
daily data report types. Statistics appear in table and chart format.

For definitions of these error types, see the:

• “Optimization Failures” section on page 8-132

• “Miscellaneous” section on page 8-133

• “Missed Packets” section on page 8-134

Table Table that shows these columns:

• Data type—Category of error for which statistics are gathered. Types 
include optimization, missed packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for 
each error type over the duration of the data range that you selected.

Note You can sort the contents of the Total Counts and Avg. Error Rate (Per 
Sec) columns in ascending or descending order by clicking the column 
heading.

Expand to Full 
Screen

Text link that shows a chart in a new, full-screen window for easier viewing.

Error Counts Y-axis label on left side of chart that shows traffic rate in bits per second. 

Note If no data exists between any two data points, the graph displays a 
color-coded vertical bar to show the period for which no data is available.

Time X-axis label that shows a user-specified, historical time scale and the server time 
zone.

Legend Color-coded legend that shows labels for traffic and error rates.

GUI Elements Description
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Displaying Backhaul Error Statistics

The Errors tab for a RAN backhaul interface shows a single table and a chart that shows the error rates 
and counts for different interfaces belonging to the backhaul. 

Figure 11-7 Example of Errors Tab for Backhaul Interface
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The Errors tab for a backhaul interface contains: 

Generating RAN Data Export Files
You can easily generate historical reports for RAN backhauls and shorthauls in the web interface. You 
can then export this data to a report with comma-separated values (CSV file). You can save this file to 
disk or open it with an application that you choose (for example, Microsoft Excel). 

To export RAN data:

Step 1 Select a RAN backhaul or shorthaul in the navigation tree of the web interface.

Step 2 Click the Performance or Errors tab in the right pane.

Step 3 Generate a report.

Step 4 Click the Export the report as a CSV file icon. 

GUI Elements Description

Toolbar Provides functions to select a report type and duration, customize the display of 
associated shorthauls, and export the report to a CSV file. See the “Using the 
Toolbar” section on page 11-4.

Table Table that shows these columns:

• Data type—Category of error for which statistics are gathered. Types 
include the errors for each shorthaul interface in the backhaul, total 
GSM-Abis errors, total UMTS-Iub errors, and the combined total of both 
GSM and UMTS errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second 
for each error type over the duration of the data range that you selected.

Note You can sort the contents of the Total Counts and Avg. Error Rate (Per 
Sec) columns in ascending or descending order by clicking the column 
heading.

Expand to Full 
Screen

Text link that shows a chart in a new, full-screen window for easier viewing.

Error Counts Y-axis label on left side of chart that shows traffic rate in bits per second. 

Time X-axis label that shows a user-specified, historical time scale and the server time 
zone.

Legend Color-coded legend that shows labels for traffic and error rates.
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Managing ITP Reports

At scheduled intervals, you can configure the Cisco Mobile Wireless Transport Manager (MWTM) to 
gather critical information from network objects that it detects. The MWTM uses that information to 
calculate statistics (accounting statistics, inventory statistics, and so on) and generates reports based on 
those statistics.

This chapter contains:

• Enabling ITP Reports, page 12-2

• Viewing Reports by Using the MWTM Web Interface, page 12-3

• Including or Excluding Specified Objects in ITP Reports, page 12-6

• Customizing ITP Report Preferences, page 12-7

• Locating Stored ITP Reports, page 12-9

• Changing the MWTM Reports Directory, page 12-10

• Understanding ITP Reports, page 12-10

• Enabling Custom Archived Statistics Reports, page 12-49

• Understanding Custom Archived Reports, page 12-54

• Understanding Network Statistics Archived Reports, page 12-70

• Viewing the MWTM Statistics Reports Logs, page 12-71
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Enabling ITP Reports
You can enable ITP reports on the MWTM server by using CLI commands to configure general or 
custom reports:

• General CLI commands continuously generate reports for all objects of a specified type. 

• Custom CLI commands perform a one-time report generation for one or more objects of a specified 
type.

To see which reports are enabled or disabled, and which general CLI commands configure and disable 
each report:

Step 1 Do one of the following:

• Within a Web browser, launch the MWTM Web interface (see Accessing the MWTM Web Interface, 
page 11-1). In the navigation tree, click Reports. 

• From the MWTM client, within the MWTM main window, choose View > Web > Reports.

Note If you enable MWTM User-Based Access, the Reports menu is available to users with 
authentication level 4 (Network Administrator) and higher.

Step 2 The Reports page in the content area shows the Report Type and the Data Collection Status (enabled or 
disabled).
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Step 3 Click the plus (+) sign to expand a Report Type. The associated Data Collection Status appears next to 
each Report Type. Note that clicking a Report Type takes you directly to the report data page.

If you enable the Data Collection Status, a green status ball appears next to the word Enabled. 

If the Data Collection Status is disabled, a red status ball appears next to the word Disabled. To see which 
general CLI command enables a disabled report, click Disabled (you must expand the Report type to see 
the Disabled link). A popup window appears with the Enable command. As the root user, you can log 
in to the MWTM server and run the specified command to enable the report. 

Note For more descriptions of CLI commands, see Appendix B, “Command Reference.”

Viewing Reports by Using the MWTM Web Interface
Once you enable ITP reports by using the CLI commands, you can view the reports by using the MWTM 
web interface. You can view reports for all objects of a specific type (for example, all link reports for all 
links); or, reports for a specific object (for example, all link reports for a specific link).

You access ITP reports in the MWTM web interface through these categories:

Category Report Type Related Content

Reports > 
Statistics

AS Application Server Reports, page 12-11

ASP Application Server Process Reports, page 12-14

Events The event metrics reports are applicable for RAN-O and 
ITP networks. You can find information on event metrics 
reports in the “Managing Events” chapter (see Viewing the 
Event Metrics Report on the Web, page 9-23).

Link Link Reports, page 12-21

Linkset Linkset Reports, page 12-28

MLR MLR Reports, page 12-33

MSU Rates MSU Rates Reports, page 12-39

Reports > 
Accounting

GTT GTT Accounting Reports, page 12-41

MTP3 MTP3 Accounting Reports, page 12-43

Point Codes ITP Point Code Reports, page 12-45

File Archive > 
Events

N/A Archived event reports are applicable for RAN-O and ITP 
networks. You can find information on archived event 
reports in the “Managing Events” chapter (see Viewing the 
Event Metrics Report on the Web, page 9-23).
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Note If you enable MWTM User-Based Access, the Reports and File Archive menus are available to users 
with authentication level 4 (Network Administrator) and higher.

File Archive > 
Reports

Custom Understanding Custom Archived Reports, page 12-54

Daily Daily Network Statistics Archived Reports, page 12-70

Hourly Linkset Reports, page 12-28

Rolling Rolling Network Statistics Archived Reports, page 12-71

AS • Daily Application Server Archived Reports, page 
12-13

• Hourly Application Server Archived Reports, page 
12-14

• Custom Application Server Statistics Detail Reports, 
page 12-65

ASP • Daily Application Server Process Archived Reports, 
page 12-20

• Hourly Application Server Process Archived Reports, 
page 12-21

• Custom Application Server Process Statistics Detail 
Reports, page 12-66

GTT • Daily GTT Accounting Statistics Archived Reports, 
page 12-42

• Custom GTT Accounting Detail Reports, page 12-56

Link • Hourly Link Statistics Archived Reports, page 12-27

• Daily Link Statistics Archived Reports, page 12-27

• Custom Link Statistics Detail Reports, page 12-67

Linkset • Hourly Linkset Statistics Archived Reports, page 
12-32

• Daily Linkset Statistics Archived Reports, page 12-32

• Custom Linkset Statistics Detail Reports, page 12-68

MLR • Daily MLR Statistics Archived Reports, page 12-39

• Custom MLR Statistics Detail Reports, page 12-57

MTP3 • Daily MTP3 Accounting Statistics Archived Reports, 
page 12-45

• Custom MTP3 Accounting Detail Reports, page 12-64

Point Codes Daily Point Code Archived Reports, page 12-47

Q752 Enabling Custom Archived Statistics Reports, page 12-49

Category Report Type Related Content
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To view a Web report:

Step 1 For all objects of a specified type:

• From the MWTM web navigation tree, in Reports or File Archive, click the type of report you want 
to view in the web navigation tree; for example, if you want to view current link reports, select 
Reports > Statistics > Link. All link reports appear.

For a single object of a specified type do one of the following. From the MWTM:

• Web navigation tree, in DEFAULT View, click a node or drill down to click an object in a node. In 
the content area in the right pane, click the Reports tab. Reports appear for the active object only.

• Client, right-click an object and click Latest Reports. The Reports tab in the MWTM web interface 
opens for the active object only.

Figure 12-1 MWTM Web Interface—Reports

Note In the MWTM web interface, if you do not enable data collection on the active report, a red status 
indicator and the words Data Collection Disabled appear next to the report title. Click the 
Data Collection Disabled link to see which command enables the report.

Step 2 Choose the Type and Duration from the drop-down lists; for example, if you wanted to view hourly link 
reports for the last 12 hours, choose Link Hourly from the Type list and Last 12 Hours from the 
Duration list. 

Step 3 (Optional) For most Statistics and Accounting reports, to customize the date or time range, or both you 
click the Customize icon.

Step 4 Click the green arrow to run the report. If you change the Type or Duration, an information message 
appears: 

Click the green arrow to show the selected report. 
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Step 5 To disable this error message, click Hide Message. To display the message again, click the Information 
icon.

Step 6 (Optional) For Statistics and Accounting reports, to export the report as a .csv file, click the Export 
icon.

Note For more details on using the MWTM web interface, see Chapter 11, “Accessing Data from the 
Web Interface.”

Once you open a report, you can drill down to:

• See raw data for an object (helpful in diagnosing problems,) click the first Filter icon located at the 
beginning of a row, next to the Date column.

• Drill down under an object, click the Filter icon located on the left of the object. Drilling down 
shows objects beneath other objects.

Note To navigate to the Details tab for an object, click the underlined object in the report; for example, to go 
to the Details tab for a node, click the underlined node in the reports table.

Including or Excluding Specified Objects in ITP Reports
You can include or exclude specific nodes, signaling points, or linksets in ITP reports by creating a 
user-defined file, named:

• nodes.include—Includes only specified nodes or signaling points in reports

• nodes.exclude—Excludes only specified nodes or signaling points in reports

• linksets.include—Includes only specified linksets in reports

• linksets.exclude—Excludes only specified linksets in reports

The nodes, signaling points, and/or linksets that you specify in these files will be included or excluded 
from all enabled MWTM statistics reports and in custom reports enabled with the default keyword (or 
no node-list keyword at all), which include:

• mwtm accstats

• mwtm gttstats

• mwtm linkstats

• mwtm mlrstats

• mwtm mtpevents

• mwtm q752stats

• mwtm xuastats
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When creating user-defined files, remember that if you installed the MWTM in:

• The default directory, /opt, then the user-defined file resides within 
/opt/CSCOsgm/reports/etc/<user-defined file>.

A different directory, or if you moved the report files directory using the mwtm repdir command, 
then the /reports/etc/<user-defined file> resides in that directory.

• Wildcard matching is not supported.

• If a node, signaling point, or linkset appears in both the include file and the exclude file, it is 
excluded. That is, excluding an object overrides including the same object.

• If you specify a special include file on the mwtm accstats, mwtm gttstats, mwtm linkstats, 
mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command, the MWTM 
ignores the include or exclude file. 

When creating a nodes.include or nodes.exclude file:

• Each line in the file must contain a single node name, or node name and signaling point name, 
separated by a colon (:) that matches exactly the real, fully qualified name of the node; for example:

mwtm-75-59a.cisco.com
mwtm-26-51a.cisco.com

To include a specific signaling point, specify the node name and signaling point:

mwtm-75-59a.cisco.com:1.2.7;net0
mwtm-26-51a.cisco.com:1.2.7;net0

When creating a linksets.include or linksets.exclude file:

• Each line in the file must contain a single linkset name that matches exactly the real, fully qualified 
linkset name of the linkset, including the node name and signaling point name; for example:

mwtm-75-59a.cisco.com:1.2.7;net0:linkset2
mwtm-26-51a.cisco.com:1.2.7;net0:linkset1

Customizing ITP Report Preferences
This table lists server CLI commands that allow you to customize your report preferences:

Command Description

mwtm evreps clean, page B-83 Removes all data from MTP3 event reports, 
restoring the reports to a “clean” state.

mwtm evreps cleancustom, page B-83 Removes all data from one or more MTP3 event 
reports, restoring the reports to a “clean” state.

mwtm evreps diskcheck, page B-83 Specifies whether the MWTM should verify that a 
disk has at least 10 MB of space remaining before 
enabling MTP3 event reports.

mwtm evreps hourlyage, page B-84 Maximum number of days the MWTM should 
archive hourly MTP3 event reports.

mwtm evreps status, page B-85 Shows the current status of all MWTM network 
MTP3 event report parameters.

mwtm evreps timer, page B-85 Shows the timer file for MTP3 event reports.
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mwtm replog, page B-101 Uses PAGER to display the contents of the system 
reports log. The reports log lists all messages 
about the creation and maintenance of reports.

Note You can also view the reports log on the 
web. For more information, see Viewing 
the MWTM Report Log, page 12-71.

mwtm statreps clean, page B-105 Removes all data from MWTM network statistics 
and accounting reports, restoring the reports to a 
clean (normal) state.

mwtm statreps cleancustom, page B-106 Removes all data from one or more custom 
statistics and accounting reports, restoring the 
custom reports to a clean (normal) state.

mwtm statreps custage, page B-106

or

mwtm repcustage, page B-100

Sets the maximum number of days the MWTM 
should archive custom network statistics and 
accounting reports.

mwtm statreps dailyage, page B-107

or

mwtm repdailyage, page B-43

Sets the maximum number of days the MWTM 
should archive daily network statistics and 
accounting reports.

mwtm statreps diskcheck, page B-107 Specifies whether the MWTM should verify that a 
disk has at least 10 MB of space remaining before 
enabling network statistics and accounting 
reports.

mwtm statreps servratio, page B-114

or

mwtm rephourlyage, page B-44

Sets the maximum number of days the MWTM 
should archive hourly network statistics and 
accounting reports.

mwtm statreps iplinks, page B-110 Specifies whether the MWTM should include 
links that use the Stream Control Transmission 
Protocol (SCTP) IP transport protocol in network 
statistics and accounting reports.

mwtm statreps nullcaps, page B-113 Specifies whether the MWTM should include 
SCTP links that do not have planned send and 
receive capacities in network statistics, and 
accounting reports.

mwtm statreps servratio, page B-114 Specifies whether the MWTM should display a 
gray background in the In-Service cell in a 
network statistics and accounting report.

mwtm statreps status, page B-114 Shows the current status of all MWTM network 
statistics and accounting report parameters.

mwtm statreps timemode, page B-115 Sets the time mode for dates in network statistics 
and accounting reports.

mwtm statreps timer, page B-115 Shows the timer file for MWTM network statistics 
and accounting reports.

Command Description
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Locating Stored ITP Reports
The MWTM stores all reports in the report files directory on the /reports directory. If you installed the 
MWTM in:

• The default directory, /opt, then the default report files directory is /opt/CSCOsgm/reports.

• A different directory or used the mwtm repdir command to specify a new directory in which the 
MWTM should store report files, then the default report files directory resides in that directory.

Note For details on changing the default reports directory by using the mwtm repdir command, see Changing 
the MWTM Reports Directory, page 12-10.

The /reports directory contains these subdirectories:

mwtm statreps utilratio, page B-116 Specifies whether the MWTM should display a 
gray background in the Send Utilization or 
Receive Utilization cell in a network statistics and 
accounting report.

mwtm webnames, page B-71 Specifies whether the MWTM should show real 
node names or display names in web pages.

Note For more information about display 
names, see Editing Properties, page 6-29.

mwtm who, page B-72 Specifies whether the MWTM should display send 
and receive utilization for linksets and links as a 
percentage (%) or in Erlangs (E) on web pages.

Command Description

Subdirectory Description

/custom Contains all custom report files. These are the report files that you enable by using 
these commands:
mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, 
mwtm mtpevents, mwtm q752stats, and mwtm xuastats 

Note A unique ID tag, specified when you enter the command, identifies each 
file. If the user does not specify an ID tag, the MWTM uses the process ID 
of the command.

/daily Contains all daily report files, stored in .Z format.

/etc Contains additional files that the MWTM reporting scripts and web pages use, 
including the nodes.include, linksets.include, nodes.exclude, and linksets.exclude 
files, if they exist.

/exportdaily Contains all daily report files, edited and formatted for export, which are stored 
as .zip files in comma-separated value (CSV) format.

/exporthourly Contains all hourly report files, edited and formatted for export, which are stored 
as .zip files in CSV format.
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Changing the MWTM Reports Directory
On the server, you can change the directory in which the MWTM stores reports.

To change the MWTM report files directory, log in as the root user, as described in Starting the MWTM 
Client, page 4-2; or, as a superuser, as described in Specifying a Super User (Server Only), page 2-18, 
and enter:

# cd /opt/CSCOsgm/bin
# ./mwtm repdir directory

where directory is the new directory.

Note This command copies all files in the current directory to the new directory. If you log in as the superuser 
and you do not own the new directory, you might not be able to copy the files. In that case, you must 
specify a directory that you own or log in as the root user.

Understanding ITP Reports
This section contains:

• Application Server Reports, page 12-11

• Application Server Process Reports, page 12-14

• Link Reports, page 12-21

• Linkset Reports, page 12-28

• MLR Reports, page 12-33

• MSU Rates Reports, page 12-39

• GTT Accounting Reports, page 12-41

• MTP3 Accounting Reports, page 12-43

• ITP Point Code Reports, page 12-45

• MTP3 Event Reports, page 12-47

/exportrolling Contains all rolling report files, edited and formatted for export, which are stored 
as .zip files in CSV format. The MWTM rebuilds the files in this subdirectory every 
hour.

/hourly Contains all hourly report files, which are stored in .Z format.

Subdirectory Description
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Application Server Reports

Note If you enable MWTM User-Based Access, these reports are available to users with authentication level 
4 (Network Administrator) and higher.

The xUA statistics encompass Message Transfer Part 3 User Adaptation (M3UA) and Signaling 
Connection Control Part User Adaptation (SUA). xUA connects application servers to SS7 networks.

You can view summary reports of hourly and daily xUA statistics. You can also export the reports.

This section covers:

• Hourly Application Server Reports, page 12-11

• Daily Application Server Reports, page 12-12

• Daily Application Server Peaks Reports, page 12-12

• Daily Application Server Archived Reports, page 12-13

• Hourly Application Server Archived Reports, page 12-14

Hourly Application Server Reports

You can view hourly summaries of xUA statistics for all application servers that the MWTM detects for 
the specified date and hour range. The AS Hourly Report page shows summary reports of hourly 
application server statistics by date and hour.

The AS Hourly Report table is sorted based on the information in the Packets From MTP3 column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server.

Packets From MTP3 Total number of packets that the application server received, sent from the 
MTP3 layer.

Packets To ASPs Total number of packets that the application server sent to the application 
server processes.



 

12-12
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 12      Managing ITP Reports
  Understanding ITP Reports

Daily Application Server Reports

You can view a daily summary of statistics for all application servers that the MWTM detects for a 
specified date range. The AS Daily Report page shows summary reports of daily application server 
statistics that are archived by date and hour.

The AS Daily Report table is sorted based on the information in the Packets From MTP3 column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily Application Server Peaks Reports

You can view an application server statistics Peaks Report to see peak values for each day and the hour 
in which each peak value occurred. The AS Peaks Daily Report page shows summary reports of daily 
application server peak statistics by date and hour.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server.

Packets From MTP3 Total number of packets that the application server receives from the 
MTP3 layer for the specified date.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server for the 
specified date.

Peak From Hour Hour in which the Peak From MTP3 for the application server occurred 
for the specified date.

Click the hour to see the AS Hourly Report for the selected application 
server and hour.

Packets To ASPs Total number of packets that the application server sent to the application 
server processes for the specified date.

Peak To ASPs Highest hourly Packets To ASPs for the application server for the 
specified date.

Peak To Hour Hour in which the Peak To ASPs for the application server occurred for 
the specified date.

Click the hour to see the AS Hourly Report for the selected application 
server and hour.
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The AS Peaks Daily Report table is sorted based on the information in the Peak From MTP3 column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appears next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily Application Server Archived Reports

The AS Daily Archived Reports page shows summary reports for all archived MWTM daily network 
statistics for all application servers that the MWTM detects for the server to which you connect. The 
information is stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmASEStats.DailySum.2007-02-13.csv.zip 
file contains the summary report for daily application server statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application servers that the MWTM detects on that date and hour. You can 
download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of daily application server statistics archived reports, see 
Application Server Statistics Daily and Peaks Daily Format, page I-4.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server.

Network Name Name of the network for the application server.

Signaling Point Name of the signaling point for the application server.

AS Name of the application server that recorded the peak value.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server for the last 
30 days.

Peak From Hour Hour in which the Peak From MTP3 for the application server occurred.

Click the hour to see the AS Hourly Report for the selected application 
server and hour.

Peak To ASPs Highest hourly Packets To ASPs for the application server for the last 30 
days.

Peak To Hour Hour in which the Peak To ASPs for the application server occurred.

Click the hour to see the AS Hourly Report for the selected application 
server and hour.
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Hourly Application Server Archived Reports

The AS Hourly Archived Reports page shows all summary reports for archived MWTM hourly network 
statistics for all application servers that the MWTM detects for the server to which you connect. The 
information is stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmASEStats.2007-02-13-08.csv.zip 
file contains the summary report for hourly application server statistics for the 8th hour on February 13, 
2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all application servers that the MWTM detected on that date and hour. You 
can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of hourly application server statistics archived reports, see 
Application Server Statistics Hourly Format, page I-5.

Application Server Process Reports

Note If you enabled MWTM User-Based Access, these reports are available to users with authentication level 
4 (Network Administrator) and higher.

You can view summary reports of hourly and daily xUA statistics. You can also export the reports.

The xUA statistics encompass Message Transfer Part 3 User Adaptation (M3UA) and Signalling 
Connection Control Part User Adaptation (SUA). xUA connects application servers to SS7 networks.

This section covers:

• Hourly Application Server Process Reports, page 12-15

• Daily Application Server Process Reports, page 12-16

• Daily Application Server Process Peaks Reports, page 12-18

• Daily Application Server Process MTP3 Peaks Reports, page 12-19

• Daily Application Server Process Archived Reports, page 12-20

• Hourly Application Server Process Archived Reports, page 12-21
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Hourly Application Server Process Reports

You can view hourly summaries of statistics for all application server processes that the MWTM detects 
on the specified date and hour. The ASP Hourly Report page shows summary reports of hourly 
application server process statistics by date and hour.

The ASP Hourly Report table is sorted based on the information in the Packets From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From ASP Total number of packets that the application server process send for the 
specified date and hour.

Packets To ASP Total number of packets sent to the application server process for the 
specified date and hour.

Packets From MTP3 Total number of packets that the application server process received from 
the MTP3 layer for the specified date and hour.

Packets To MTP3 Total number of packets the application server process sent to the MTP3 
layer for the specified date and hour.

Send Errors Total number of errors that occurred when sending packets to the 
application server process for the specified date and hour.

Receive Errors Total number of errors that occurred when receiving packets from the 
application server process for the specified date and hour.
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Daily Application Server Process Reports

You can view a daily summary of statistics for all application server processes that the MWTM detects 
on a specified date. The ASP Daily Report page shows summary reports of daily application server 
process statistics, archived by date and hour.

The ASP Daily Report table is sorted based on the information in the Packets From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From ASP Total number of packets that the application server process sent for the 
specified date.

Peak From ASP Highest hourly Pkts From ASP for the application server for the specified 
date.

Peak From Hour Hour in which the Peak From ASP for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Packets To ASP Total number of packets that the application server sent to the application 
server processes for the specified date.

Peak To ASP Highest hourly Pkts To ASP for the application server for the specified 
date.

Peak To Hour Hour in which the Peak To ASP for the application server process occurred 
for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Send Errors Total number of errors that occurred when sending packets to the 
application server processes for the specified date.

Peak Send Errors Highest hourly Send Errors for the application server for the specified 
date.

Peak Send Hour Hour in which the Peak Send Errors for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.
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Daily Application Server Process MTP3 Reports

The ASP MTP3 Daily Report page shows a daily summary of MTP3 statistics for all application server 
processes that the MWTM detects on a specified date. The ASP MTP3 Daily Report page shows a 
summary report of daily application server process MTP3 statistics by date and hour.

The ASP MTP3 Daily Report table is sorted based on the information in the Packets From MTP3 
column; however, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appears next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Receive Errors Total number of errors that occurred when receiving packets from the 
application server processes for the specified date.

Peak Receive Errors Highest hourly receive errors for the application server for the specified 
date.

Peak Receive Hour Hour in which the peak receive errors for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process.

Packets From MTP3 Total number of packets that the application server process receives from 
the MTP3 layer for the specified date.

Peak From MTP3 Highest hourly Packets From MTP3 for the application server process for 
the specified date.

Peak From Hour Hour in which the Peak From MTP3 for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Packets To MTP3 Total number of packets sent to the MTP3 layer by the application server 
process for the specified date.

Peak To MTP3 Highest hourly Packets To MTP3 for the application server process for the 
specified date.
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Daily Application Server Process Peaks Reports

You can view a report of the statistics peaks for the application server process. The peaks report shows 
peak values for each day of the last 30 days, and the hour in which each peak occurred. The ASP Peaks 
Daily Report page shows a summary report of the daily application server process peak statistics by date 
and hour.

The ASP Peaks Daily Report table is sorted based on the information in the Peak From ASP column; 
however, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak To Hour Hour in which the Peak To MTP3 for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Send Errors Total number of errors that occurred when sending packets to the MTP3 
layer for the specified date.

Peak Send Errors Highest hourly Send Errors for the application server process for the 
specified date.

Peak Send Hour Hour in which the Peak Send Errors for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Receive Errors Total number of errors that occurred when receiving packets from the 
MTP3 layer for the specified date.

Peak Receive Errors Highest hourly Receive Errors for the application server process for the 
specified date.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process 
occurred for the specified date.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the application server process.

ASP Name of the application server process that recorded the peak value.
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Daily Application Server Process MTP3 Peaks Reports

You can view a peaks report of the application server process MTP3 statistics. The peaks report shows 
peak values for each day and the hour in which each peak value occurred. The ASP MTP3 Peaks Daily 
Report page shows summary reports of the daily application server process MTP3 peak statistics by date 
and hour.

The ASP MTP3 Peaks Daily Report table is sorted based on the information in the Peak From MTP3 
column; however, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak From ASP Highest hourly Packets From ASP for the application server for the 
selected day.

Peak From Hour Hour in which the Peak From ASP for the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak To ASP Highest hourly Packets To ASP for the application server for the selected 
day.

Peak To Hour Hour in which the Peak To ASP for the application server process occurred 
for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak Send Errors Highest hourly Send Errors for the application server for the last 30 days.

Peak Send Hour Hour in which the Peak Send Errors for the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak Receive Errors Highest hourly Receive Errors for the application server for the last 30 
days.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Field or Column Description
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Daily Application Server Process Archived Reports

The ASP Daily Archived Reports page shows summary reports of all archived MWTM daily network 
statistics for all application server processes that the MWTM detects for the server to which connect, 
stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmASPStats.DailySum.2007-02-13.csv.zip 
file contains the summary report of daily application server process statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application server processes that the MWTM detected on that date and hour. 
You can download the .zip files and extract them.

To download a .zip file, right-click a filename, then save the file to a location of your choice. You can 
also import the file into Microsoft Excel.

For more information about the format of daily application server process statistics archived reports, see 
Application Server Process Statistics Daily and Peaks Daily Format, page I-2.

Field or Column Description

Date Date on which the peak values occurred.

Node Name of the node for the application server process.

ASP Name of the application server process that recorded the peak value.

Peak From MTP3 Highest hourly Packets From MTP3 to the application server process for 
the selected day.

Peak From Hour Hour in which the Peak From MTP3 to the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak To MTP3 Highest hourly Packets to MTP3 from the application server process for 
the selected day.

Peak To Hour Hour in which the Peak to MTP3 from the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak Send Errors Highest hourly Send Errors for the application server process for the 
selected day.

Peak Send Hour Hour in which the Peak Send Errors for the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.

Peak Receive Errors Highest hourly Receive Errors for the application server process for the 
selected day.

Peak Receive Hour Hour in which the Peak Receive Errors for the application server process 
occurred for the selected day.

Click the hour to see the ASP Hourly Report for the selected application 
server process and hour.
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Hourly Application Server Process Archived Reports

The ASP Hourly Archived Reports page shows the summary reports of all archived MWTM hourly 
network statistics for all application server processes that the MWTM detects for the server to which you 
connect, stored as downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmASPStats.2007-02-13.csv.zip file 
contains the summary report of daily application server process statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with the summary report for 
hourly network statistics for all application server processes that the MWTM detected on that date and 
hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of hourly application server process statistics archived reports, 
see Application Server Process Statistics Hourly Format, page I-3.

Link Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

You can view summary reports of hourly and daily statistics for links, and export the reports.

This section covers:

• Hourly Link Reports, page 12-22

• Daily Link Reports, page 12-23

• Daily Link Peaks Reports, page 12-25

• Link Multi-Day Utilization Report, page 12-26

• Hourly Link Statistics Archived Reports, page 12-27

• Daily Link Statistics Archived Reports, page 12-27

• Linkset Reports, page 12-28

• Daily Network Statistics Archived Reports, page 12-70

• Rolling Network Statistics Archived Reports, page 12-71
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Hourly Link Reports

You can view hourly summaries of statistics for all links or a specific link that the MWTM detected on 
the specified date and hour. The Link Hourly Report page shows summary reports of hourly link 
statistics by date and hour.

The Link Hourly Report table is sorted based on the information in the Send Utilization or Send Erlangs 
column; however, you can sort the table based on the information in one of the other columns (see 
Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the link.

Network Name Name of the network for the link.

Signaling Point Name of the signaling point for the link.

Link Name of the link.

Type Type of link. Possible link types are:

• HSL—Uses the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

• SCTP—Uses the Stream Control Transmission Protocol (SCTP) IP 
transport protocol.

• Serial—Uses the serial SS7 signaling protocol.

• Virtual—A virtual link that connects signaling point instances that 
run on the same node. The MWTM does not poll virtual links; nor 
does it display real-time data or accounting statistics for virtual links.

Send Utilization
or
Send Erlangs

Average Send Utilization for the link, expressed as a utilization percentage 
or number of Erlangs (E) (as set with the mwtm webutil command) for the 
specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field.

Receive Utilization
or
Receive Erlangs

Average Receive Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field
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Daily Link Reports

You can view daily summaries of statistics for all links or for a specific link that the MWTM detected 
on the specified date and hour. The Link Daily Report page shows summary reports of daily link 
statistics by date and hour.

The Link Daily Report table is sorted based on the information in the Avg Send Utilization or Avg Send 
Erlangs column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appears next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command), since MWTM polling began for the link, or since the MWTM 
last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the link, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the link, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field.

Send MSUs Total number of MTP3 message signal units (MSUs) sent on the specified 
date and hour.

Receive MSUs Total number of MTP3 MSUs received on the specified date and hour.

Congestion % Percentage of time the link was congested on the specified date and hour.

Hourly In-Service Percentage of time the link was in service on the specified date and hour.

Long Term In-Service Average percentage of time the link was in service since MWTM polling 
began for the link, or since the MWTM last reset the averages as a result 
of bad data.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the link.

Network Name Name of the network for the link.

Signaling Point Name of the signaling point for the link.

Link Name of the link.
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Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer 
Mode) high-speed protocol.

• SCTP—The link uses the Stream Control Transmission Protocol 
(SCTP) IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point 
instances running on the same node. The MWTM does not poll virtual 
links, nor does it display real-time data or accounting statistics for 
virtual links.

Avg Send Utilization
or
Avg Send Erlangs

Average Send Utilization for the link, expressed as a utilization percentage 
or number of Erlangs (E) (as set with the mwtm webutil command) for the 
specified date.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field. 

Peak Send Utilization
or
Peak Send Erlangs

Highest hourly Average Send Utilization for the link, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for the specified date.

Peak Send Hour Hour in which the Peak Send Utilization for the link occurred for the 
specified date.

Click the hour to see the Link Hourly Report for the selected link and hour.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command), since MWTM polling began for the link, or since the MWTM 
last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field.

Avg Receive Utilization
or
Avg Receive Erlangs

Average Receive Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field.

Peak Receive Utilization
or
Peak Receive Erlangs

Highest hourly Average Receive Utilization for the link, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for the specified date.

Peak Receive Hour Hour in which the Peak Receive Utilization for the link occurred for the 
specified date.

Click the hour to see the Link Hourly Report for the selected link and hour.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the link, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the link, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field.

Field or Column Description
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Daily Link Peaks Reports

You can view a daily link statistics peaks report using the Link Peaks Daily Report page. The peaks 
report shows peak values for each day and the hour in which each peak value occurred. 

The Link Peaks Daily table is sorted based on the information in the Peak Send Utilization or Peak Send 
Erlangs column. However, you can sort the table based on the information in one of the other columns 
(see Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Avg Congestion % Average percentage of time the link was congested on the specified date.

Daily In-Service Average percentage of time the link was in service on the specified date.

Long Term In-Service Average percentage of time the link was in service since MWTM polling 
began for the link, or since the MWTM last reset the averages as a result 
of bad data.

Daily Low In-Service Lowest hourly in-service percentage for the link for the specified date.

Low Srv Hour Hour in which the lowest in-service percentage occurred for the specified 
date.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the link.

Network Name Name of the network for the link.

Signaling Point Name of the signaling point for the link.

Link Name of the link that recorded the peak value.
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Link Multi-Day Utilization Report

The Link Multi-Day Report page shows send and receive utilization percentages for all links for the last 
three or five days.

The Link Multi-Day table is sorted based on the information in the Avg Send Utilization column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer 
Mode) high-speed protocol.

• SCTP—The link uses the Stream Control Transmission Protocol 
(SCTP) IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point 
instances running on the same node. The MWTM does not poll virtual 
links, nor does it display real-time data or accounting statistics for 
virtual links.

Peak Send Utilization
or
Peak Send Erlangs

Peak Send Utilization for the link for the selected day, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command).

Peak Send Hour Hour in which the Peak Send Utilization occurred for the selected day.

Click the hour to see the Link Hourly Report for the selected link and hour.

Peak Receive Utilization
or
Peak Receive Erlangs

Peak Receive Utilization for the link for the selected day, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command).

Peak Receive Hour Hour in which the Peak Receive Utilization occurred for the selected day.

Click the hour to see the Link Hourly Report for the selected link and hour.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Field or Column Description

Field or Column Description

Node Name of the node for the link.

Network Name Name of the network for the link.

Signaling Point Name of the signaling point for the link.
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Hourly Link Statistics Archived Reports

The Link Hourly Archived Reports page shows summary reports for all archived MWTM hourly network 
statistics for all links that the MWTM detected for the server to which you connect, stored as 
downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmLinkStats.2007-02-13-09.csv.zip 
file contains the summary reports for daily link statistics for February 13, 2007 at 9:00am.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of an 
hourly network statistics for all links that the MWTM detected on that date and hour. You can download 
the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of hourly link statistics archived reports, see Link Statistics 
Hourly Format, page I-7.

Daily Link Statistics Archived Reports

The Link Daily Archived Reports page shows summary reports for all archived MWTM daily network 
statistics for all links that the MWTM detected for the server to which you connect, stored as 
downloadable .zip files.

The .zip files are archived by type and date; for example, the sgmLinkStats.DailySum.2007-02-13.csv.zip 
file contains the summary report of daily link statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all links that the MWTM detected on that date and hour. You can download the .zip 
files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of daily link statistics archived reports, see Link Statistics Daily 
and Peaks Daily Format, page I-6.

Link Name of the link.

Avg. Send Utilization Send Utilization for the link, expressed as a utilization percentage or 
number of Erlangs (E) (as set with the mwtm webutil command) for each 
of the last five days.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field.

Avg. Receive Utilization Receive Utilization for the link, expressed as a utilization percentage or 
number of Erlangs (E) (as set with the mwtm webutil command) for each 
of the last five days.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field.

Field or Column Description
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Linkset Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

You can view summary reports of hourly and daily statistics for linksets, and export the reports.

This section covers:

• Hourly Linkset Reports, page 12-28

• Daily Linkset Reports, page 12-29

• Daily Linkset Peaks Reports, page 12-31

• Hourly Linkset Statistics Archived Reports, page 12-32

• Daily Linkset Statistics Archived Reports, page 12-32

Hourly Linkset Reports

You can view hourly summaries of statistics for all linksets or for a specific linkset that the MWTM 
detected on the specified date and hour. The Linkset Hourly Report page shows summary reports for all 
archived MWTM hourly linkset statistics by date and hour.

The Linkset Hourly Report table is sorted based on the information in the Hourly In-Service column, 
then by the information in the Send Utilization or Send Erlangs column. However, you can sort the table 
based on the information in one of the other columns (see Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Column Description

Date Date and time of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Name of the linkset.

Hourly In-Service Percentage of time the linkset was in service on the specified date and 
hour.

Long Term In-Service Average percentage of time the linkset was in service since the MWTM 
polling began for the linkset, or since the MWTM last reset the averages 
as a result of bad data.
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Daily Linkset Reports

You can view daily summaries of statistics for all linksets or for a specific linkset that the MWTM 
detected on the specified date and hour. The Linkset Daily Report page shows summary reports of all 
archived MWTM daily linkset statistics by date and hour.

The Linkset Daily Report table is sorted based on the information in the Daily In-Service column, then 
by the information in the Avg Send Utilization or Avg Send Erlangs column. You can sort the table based 
on the information in one of the other columns (see Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Send Utilization
or
Send Erlangs

Average Send Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned send capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Receive Utilization
or
Receive Erlangs

Average Receive Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned receive capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.
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Signaling Point Name of the signaling point for the linkset.

Linkset Name of the linkset.

Daily In-Service Average percentage of time the linkset was in service on the specified date.

Long Term In-Service Average percentage of time the linkset was in service since MWTM 
polling began for the linkset, or since the MWTM last reset the averages 
as a result of bad data.

Daily Low In-Service Lowest hourly in-service percentage for the linkset for the specified date.

Low Srv Hour Hour in which the lowest in-service percentage occurred for the specified 
date.

Avg Send Utilization
or
Avg Send Erlangs

Average Send Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date.

If you do not set the planned send capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Peak Send Utilization
or
Peak Send Erlangs

Highest hourly Average Send Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for the specified date.

Peak Send Hour Hour in which the Peak Send Utilization for the linkset occurred for the 
specified date.

Click the hour to see the Link Hourly Report for all links associated with 
the selected linkset for the selected hour.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Avg Receive Utilization
or
Avg Receive Erlangs

Average Receive Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date.

If you do not set the planned receive capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Peak Receive Utilization
or
Peak Receive Erlangs

Highest hourly Average Receive Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command) for the specified date.

Field or Column Description
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Daily Linkset Peaks Reports

You can view a daily linkset statistics peaks report using the Linkset Peaks Daily Report page. The peaks 
report shows peak values for each day and the hour in which each peak value occurred.

The Linkset Peaks Daily Report table is sorted based on the information in the Peak Send Utilization or 
Peak Send Erlangs column. However, you can sort the table based on the information in one of the other 
columns (see Navigating Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Peak Receive Hour Hour in which the Peak Receive Utilization for the linkset occurred for the 
specified date.

Click the hour to see the Link Hourly Report for all links associated with 
the selected linkset for the selected hour.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for one or more of the SCTP 
links associated with the linkset, then NoCap appears in the field.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Name of the linkset that recorded the peak value.

Peak Send Utilization
or
Peak Send Erlangs

Peak Send Utilization for the linkset for the selected day, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command).

Peak Send Hour Hour in which the Peak Send Utilization occurred for the selected day.

To see the Link Statistics - Hourly Report for all links associated with the 
selected linkset for the selected hour, click the hour.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.
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Hourly Linkset Statistics Archived Reports

The Linkset Hourly Archived Reports page shows summary reports of all archived MWTM hourly 
network statistics for all linksets that the MWTM detects for the server to which you connect, stored as 
downloadable .zip files.

The .zip files are archived by type, date, and hour; for example, the sgmLinksetStats.2007-02-13.csv.zip 
file contains the summary report for the daily linkset statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all linksets that the MWTM detected on that date and hour. You can 
download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of hourly linkset statistics archived reports, see Linkset Statistics 
Hourly Format, page I-9.

Daily Linkset Statistics Archived Reports

The Linkset Daily Archived Reports page shows the summary report of all archived MWTM daily 
network statistics for all linksets that the MWTM detected for the server to which you connect, stored 
as downloadable .zip files.

The .zip files are archived by type and date; for example, the 
sgmLinksetStats.DailySum.2007-02-13.csv.zip file contains the summary reports of daily linkset 
statistics for February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all linksets that the MWTM detected on that date and hour. You can download the 
.zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of daily linkset statistics archived reports, see Linkset Statistics 
Daily and Peaks Daily Format, page I-8.

Peak Receive Utilization
or
Peak Receive Erlangs

Peak Receive Utilization for the linkset for the selected day, expressed as 
a utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command).

Peak Receive Hour Hour in which the Peak Receive Utilization occurred for the selected day.

Click the hour to see the Link Hourly Report for all links associated with 
the selected linkset for the selected hour.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

Field or Column Description
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MLR Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

Multi-Layer SMS Routing, or MLR, is a routing scheme that enables intelligent routing of Short 
Message Service (SMS) mobile originated (MO) messages based on the application or service from 
which they originated or to which they are destined. The MLR feature can make SMS message routing 
decisions based on information found in the TCAP, MAP, and MAP-user layers; MAP operation codes 
MAP-MT-FORWARD-SM and SEND-ROUTING-INFO-FOR-SM; and ANSI TCAP and IS-41 MAP 
operations.

You can view a summary report of daily statistics for MLR. You can also export the reports.

This section covers:

• Daily MLR Reports, page 12-33

• Daily MLR Statistics Archived Reports, page 12-39

Daily MLR Reports

You can view a summary report of MLR processed, aborts, continues, result invokes, rule matches, 
subtriggers, and triggers statistics for the MWTM on a specified date. The MLR type Daily Report page 
shows reports of all archived MWTM daily MLR processed, aborts, continues, result invokes, rule 
matches, subtriggers, and triggers by date.

These archived daily MLR reports are available:

• Daily MLR Aborts Reports, page 12-33

• Daily MLR Continues Reports, page 12-34

• Daily MLR Processed Reports, page 12-35

• Daily MLR Result Invokes Reports, page 12-36

• Daily MLR RuleMatches Reports, page 12-37

• Daily MLR SubTriggers Reports, page 12-37

• Daily MLR Triggers Reports, page 12-38

Daily MLR Aborts Reports

The MLR Aborts Daily Report table is sorted based on the information in the Total Aborted column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.
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Daily MLR Continues Reports

The MLR Continues Daily Report table is sorted based on the information in the Total Continued 
column. However, you can sort the table based on the information in one of the columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Total Aborted Total number of MSUs aborted by MLR on the specified date.

No Resources Number of MSUs aborted by MLR because of a shortage of resources on 
the specified date.

Results Blocked Number of MSUs aborted by MLR with a result of block on the specified 
date.

GTI Mismatches Number of MSUs aborted by MLR because of mis-matched GTIs on the 
specified date.

Addr Conv Fails Number of MSUs aborted by MLR because of a failed GTA address 
conversion on the specified date.

Dest Unavails Number of MSUs aborted by MLR because the destination was 
unavailable on the specified date.

No Server Aborteds Number of MSUs aborted by MLR because no server was available on the 
specified date.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Total Continued Total number of MSUs returned to SCCP by MLR with a result of 
continue on the specified date.

Unsupp Msg Type Number of MSUs returned to SCCP by MLR because of unsupported 
message types on the specified date.
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Daily MLR Processed Reports

The MLR Processed Daily Report table is sorted based on the information in the Routed column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Unsupp Seg SCCP Number of MSUs returned to SCCP by MLR because of unsupported 
SCCP segments on the specified date.

Unsupported Msgs Number of MSUs returned to SCCP by MLR because of parse failures 
resulting from unsupported messages on the specified date.

Parse Errors Number of MSUs returned to SCCP by MLR because of parse errors on 
the specified date.

No Results Number of MSUs returned to SCCP by MLR with no results on the 
specified date.

Result Continueds Number of MSUs returned to SCCP by MLR with a result of continue on 
the specified date.

No Server Continueds Number of MSUs returned to SCCP by MLR because no server was 
available on the specified date.

Result GTTs Number of MSUs returned to SCCP by MLR with a result of GTT on the 
specified date.

Failed Trigs Number of MSUs returned to SCCP by MLR because of no trigger match 
on the specified date.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Routed Total number of packets routed by MLR on the specified date.

Total Continued Total number of MSUs passed back to SCCP processing by MLR on the 
specified date.

Total Aborted Total number of MSUs not processed by MLR because of invalid data or 
a blocked MSU.

MAP SMS-MOs Number of MSUs of type GSM-MAP SMS-MO processed by MLR on the 
specified date.
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Daily MLR Result Invokes Reports

The MLR Result Invokes Daily Report table is sorted based on the information in the Invokes column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

MAP SMS-MTs Number of MSUs of type GSM-MAP SMS-MT processed by MLR on the 
specified date.

MAP SRI-SMs Number of MSUs of type GSM-MAP SRI-SM processed by MLR on the 
specified date.

MAP AlertScs Number of MSUs of type GSM-MAP AlertSc processed by MLR on the 
specified date.

ANSI-41 SMD-PPs Number of MSUs of type ANSI-41 SMD-PP processed by MLR on the 
specified date.

ANSI-41 SMS-Reqs Number of MSUs of type ANSI-41 SMSRequest processed by MLR on the 
specified date.

ANSI-41 SMS-Notifys Number of MSUs of type ANSI-41 SMSNotify processed by MLR on the 
specified date.

Links Contains links to related MLR reports (Aborts, Continues, Triggers, 
SubTriggers, RuleMatches, and ResultInvokes). The target report is 
filtered by the signaling point. 

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

ResultSet Name of the result set of which this result is a member.

Result Number Number of this result within the result set.

Invokes Total number of times this result was invoked.
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Daily MLR RuleMatches Reports

The MLR RuleMatches Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Daily MLR SubTriggers Reports

The MLR SubTriggers Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

RuleSet Name of the rule set of which this rule is a member.

Rule Number Number of this rule within the rule set.

Matches Total number of times this rule was matched.

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Trigger Index Index number associated with the trigger.

Sub Trigger Index Index number associated with the subtrigger.
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Daily MLR Triggers Reports

The MLR Triggers Daily Report table is sorted based on the information in the Matches column. 
However, you can sort the table based on the information in one of the columns (see Navigating Table 
Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Action Action taken by the subtrigger. Clicking on the ruleset name highlights the 
the signaling point in the navigation tree and opens the MLR Trigger 
Config tab for the selected ruleset.

Parameters Parameters that control the behavior of the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Field or Column Description

Field or Column Description

Date Date of the report.

Node Name of the node for the signaling point.

Network Name Name of the network for the signaling point.

Signaling Point Name of the signaling point.

Trigger Index Index number associated with the trigger.

Action Action taken by the trigger. Clicking on the ruleset name highlights the the 
signaling point in the navigation tree and opens the MLR Trigger Config 
tab for the selected ruleset.

Parameters Parameters that control the behavior of the trigger.

Preliminary Matches Preliminary count of trigger matches.

Matches Number of trigger matches with result Action Performed.

Links Contains links to related MLR SubTrigger reports. The target report is 
filtered by the signaling point. 
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Daily MLR Statistics Archived Reports

The MLR Daily Archived Reports page shows all archived MWTM daily MLR processed, aborts, 
continues, result invokes, rule matches, subtriggers, and triggers statistics reports for the server to which 
you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the:

• mwtmMLRStats.DailyAbortCons.2007-02-13.csv.zip file contains the daily MLR aborts and report 
for February 13, 2007.

• mwtmMLRStats.DailyProcessed.2007-02-13.csv.zip file contains the daily MLR processed report 
for February 13, 2007.

• mwtmMLRStats.DailyResultInvokes.2007-02-13.csv.zip file contains the daily MLR result invokes 
report for February 13, 2007.

• mwtmMLRStats.DailyRuleMatches.2007-02-13.csv.zip file contains the daily MLR rule matches 
report for February 13, 2007.

• mwtmMLRStats.DailySubTriggers.2007-02-13.csv.zip file contains the daily MLR subtriggers 
report for February 13, 2007.

• mwtmMLRStats.DailyTriggers.2007-02-13.csv.zip file contains the daily MLR triggers report for 
February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily MLR statistics 
report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of MLR statistics archived reports, see:

• MLR Aborts and Continues Daily Format, page I-10

• MLR Processed Statistics Daily Format, page I-10

• MLR Result Invokes Statistics Daily Format, page I-11

• MLR Rule Matches Statistics Daily Format, page I-11

• MLR SubTriggers Daily Format, page I-12

• MLR Triggers Daily Format, page I-12

MSU Rates Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

You can view 15 minute, hourly and daily MSU rates reports. You can also export the reports. 

This section covers:

• MSU Load Reports, page 12-40

• MSU Peaks Reports, page 12-40
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MSU Load Reports

You can view a 15 minute, hourly, or daily report of MSU load rates for all nodes that the MWTM 
detected in that time. The MSU Load Report provides the distribution of send and receive MSU packets, 
pertaining to overload thresholds for every CPU. 

The MSU Load Report tables are sorted based on the information in the Date column. However, you can 
sort the tables based on the information in one of the columns (see Navigating Table Columns, page 
5-23).

MSU Peaks Reports

You can view a 15 minute, hourly, or daily report of MSU peak rates for all nodes that the MWTM 
detected in that time. The MSU Peaks Report page provides information that helps you analyze the 
maximum send and receive rates for each processor in MSU units per second. 

The MSU Peaks Report tables are sorted based on the information in the Send column. However, you 
can sort the tables based on the information in one of the columns (see Navigating Table Columns, page 
5-23).

Field or Column Description

Date Date of the report.

Node Name of the node.

Processor Slot/Bay The number of the slot and bay containing the processor. This number is 
set to zero when the platform does not support processors in multiple slots 
or bays.

Overloaded Threshold Over this rate of traffic, MSU traffic handling may be impacted.

Duration % Send Duration of time the send MSU rate is within the specified percentage.

Duration % Receive Duration in time the receive MSU rate is within the specified percentage.

Field or Column Description

Date Date of the report.

Node Name of the node.

Processor Slot/Bay Number of the slot and bay containing the processor. This number is set to 
zero when the platform does not support processors in multiple slots or 
bays.

Max Rate Send This value records the highest rate of MSUs per second sent by the 
processor since the measurement was cleared.

Max Rate Receive This value records the highest rate of MSU per second received by the 
processor since the measurement was cleared.

Threshold Acceptable Specifies a level of traffic below which traffic is considered to be 
acceptable. Once the traffic rate exceeds the Warning threshold, it is not 
Acceptable until traffic falls below this threshold.

Threshold Warning Specifies a level of traffic that should be avoided, but is below a level that 
impacts MSU routing. Once the traffic rate exceeds the Overloaded 
threshold, it is not considered non-impacting until the traffic falls below 
this threshold.
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GTT Accounting Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

You can view summary reports of hourly and daily GTT accounting statistics. You can also export the 
reports.

This section covers:

• GTT Accounting Statistics Daily Summary Reports, page 12-41

• Daily GTT Accounting Statistics Archived Reports, page 12-42

GTT Accounting Statistics Daily Summary Reports

You can view a daily summary of GTT accounting statistics for all nodes that the MWTM detected on a 
specified date. The GTT Accounting Daily Report page shows all MWTM daily GTT accounting 
statistics detail reports by date. Each file contains a daily summary of GTT accounting statistics for all 
nodes that the MWTM detected on a specified date.

The GTT Accounting Daily Report table is sorted based on the information in the Packets column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Threshold Overloaded Specifies a level of traffic indicating a rate that may impact MSU routing. 

Duration in Acceptable 
Threshold Send

Rate of traffic (in seconds) sent by this processor considered as acceptable.

Duration in Acceptable 
Threshold Receive

Rate of traffic (in seconds) received by this processor considered as 
acceptable.

Duration in Warning 
Threshold Send

Rate of traffic (in seconds) sent by this processor considered above the 
acceptable level and below a level that impacts MSU routing.

Duration in Warning 
Threshold Receive

Rate of traffic (in seconds) received by this processor considered above the 
acceptable level and below a level that impacts MSU routing.

Duration in Overloaded 
Threshold Send

Rate of traffic (in seconds) sent by this processor at a level that may impact 
MSU routing. 

Duration in Overloaded 
Threshold Receive

Rate of traffic (in seconds) received by this processor at a level that may 
impact MSU routing. 

Field or Column Description
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Daily GTT Accounting Statistics Archived Reports

The GTT Daily Archived Accounting Reports page shows all archived MWTM daily GTT accounting 
statistics reports for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and date; for example, the 
sgmGTTStats.DailyDetail.2007-02-13.csv.zip file contains the daily GTT accounting statistics report for 
February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a daily GTT accounting 
statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of GTT accounting statistics archived reports, see GTT 
Accounting Statistics Daily Format, page I-5.

Field or Column Description

Date Date of the report.

Node Name of the node associated with the From Network Name for which 
data is visible.

From Network Name Name of the network from which GTT traffic originated, and for which 
data is visible.

Signaling Point Name of the signaling point associated with the From Network Name 
instance for which data is visible.

Linkset Name of the linkset associated with the From Network Name instance for 
which data is visible.

Selector Name of the selector.

GTA Global Title Address (GTA) associated with the selector.

To Network Name For version 4.1 GTT files (corresponding to ITP software release 
12.2(20)SW or greater) and 4.2 GTT files (corresponding to ITP software 
release 12.2(21)SW1 or greater), name of the network in which the 
translated point code resides.

For version 3.1 GTT files (corresponding to ITP software releases 
12.2(4)MB9 and 12.2(4)MB9a) and 4.0 GTT files (corresponding to ITP 
software release 12.2(4)MB10 or greater), the value of this field is 
identical to that of the From Network Name field.

Point Code Destination point code for the GTA.

Packets Total number of packets translated by GTT on the specified date.

Octets Total number of octets translated by GTT on the specified date.
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MTP3 Accounting Reports

Note If you enable MWTM User-Based Access, these reports are available to users with authentication level 
4 (Network Administrator) and higher.

You can view a daily summary of MTP3 accounting statistics for the MWTM on a specified date. You 
can also export the reports.

This section covers:

• MTP3 Accounting Statistics Daily Detail Reports, page 12-43

• Daily MTP3 Accounting Statistics Archived Reports, page 12-45

Note Every five minutes (by default), the ITP moves data records from a quick-access table to a database that 
stores long term accounting records. This database contains accumulated accounting data since the last 
clearing or from the time accounting was originally enabled. The MWTM shows only the data from this 
database, not from the quick-access table.

MTP3 Accounting Statistics Daily Detail Reports

You can view a daily summary of MTP3 accounting statistics for the MWTM on a specified date. The 
MTP3 Accounting Daily Report page shows detail reports of all MWTM daily MTP3 accounting 
statistics by date. Each file contains a daily summary of MTP3 accounting statistics for the MWTM on 
a specified date.

The MTP3 Accounting Daily Report table is sorted based on the information in the Send MSUs column. 
However, you can sort the table based on the information in one of the other columns (see Navigating 
Table Columns, page 5-23).

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

Date Date of the report.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Signaling Point Name of the signaling point for the linkset.

Linkset Name of the linkset.
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Gateway Screening Indicates whether the traffic passed or failed the Gateway Screening test 
at the ITP.

To see only statistics that passed or failed for a specific linkset, select a 
linkset and click Pass, Fail, or Unroutable.

OPC Originating point code of the traffic, which is a unique identifier for each 
set of statistics.

To see only statistics that match a specific OPC for a given linkset, find 
the linkset and click the point code.

DPC Destination point code of the traffic.

To see only statistics that match a specific DPC for a given linkset, find 
the linkset and click the point code.

SI Service indicator, which indicates the type of SS7 traffic. Valid values 
include:

• 0—Signaling Network Management Message (SNM) 

• 1—Maintenance Regular Message (MTN) 

• 2—Maintenance Special Message (MTNS) 

• 3—Signaling Connection Control Part (SCCP) 

• 4—Telephone User Part (TUP) 

• 5—ISDN User Part (ISUP) 

• 6—Data User Part (call and circuit-related messages) 

• 7—Data User Part (facility registration/cancellation messages)

To see only more information for a specific type of SI, click the SI type.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Send Bytes Total number of bytes sent on the specified date.

Receive Bytes Total number of bytes received on the specified date.

Field or Column Description
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Daily MTP3 Accounting Statistics Archived Reports

The MTP3 Daily Archived Accounting Reports page shows all archived MWTM daily MTP3 accounting 
statistics reports for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by date; for example, the sgmAccStats.DailyDetail.2007-02-13.csv.zip file 
contains the daily MTP3 accounting statistics report for February 13, 2007.

Note To limit the maximum number of rows in export CSV files (for example, Excel can only handle about 
65535 rows) see mwtm statreps maxcsvrows, page B-111. 

Each archived .zip file contains a comma-separated value (CSV) text file with a daily MTP3 accounting 
statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of accounting statistics archived reports, see MTP3 Accounting 
Statistics Daily Format, page I-14.

ITP Point Code Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

You can view current and daily point code inventory reports using the MWTM. You can also export the 
reports.

This section covers:

• Current Point Code Inventory, page 12-45

• Daily Point Code Archived Reports, page 12-47

Current Point Code Inventory

The Point Codes Report page shows all point codes that are currently being used by all nodes that the 
MWTM detected.

The MWTM shows the Point Codes Report page.
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Figure 12-2 Point Codes Report Page

The Point Codes Report table is sorted based on the information in the Node column. However, you can 
sort the table based on the information in any of the columns (see Navigating Table Columns, page 5-23).

Field or Column Description

Signaling Point Signaling point that is currently being used by a node.

To sort the point codes by signaling point in descending order, click the 
Signaling Points heading.

Click again to sort the point codes in ascending order.

Point Code Point code that is currently being used by a node.

To sort the point codes by point code in ascending order, click the Point 
Codes heading. This is the default display.

Click again to sort the point codes in descending order.
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Daily Point Code Archived Reports

The Point Codes Daily Archived Reports page shows all archived MWTM daily point code inventory 
reports for the server to which you connect, stored as downloadable .zip files.

On the Point Codes Daily Archived Reports page, the .zip files are archived by date; for example, the 
sgmPointCodes.DailyInv.2007-02-13.csv.zip file contains the daily point code inventory report for 
February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a list of all point codes 
that were being used by all nodes that the MWTM detected on that date. You can download the The .zip 
files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

For more information about the format of point code inventory archived reports, see Point Code 
Inventory Format, page I-15.

MTP3 Event Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

This section contains:

• Hourly MTP3 Event Reports, page 12-48

• Custom MTP3 Event Reports, page 12-48

Node Name or IP address of the node.

To see more information for the node, click the node name.

To sort the point codes by node in descending order, click the Node 
heading.

Click again to sort the point codes in ascending order.

Point Code Type Type of point code:

• Primary—Main point code used by a node.

• Secondary—Alternate or backup point code used by a node.

• Capability—Shared by more than one node, each of which is also 
assigned a real point code. Also called an alias point code.

To sort the point codes by type in ascending order, click the Point Code 
Type heading.

Click again to sort the point codes in descending order.

Field or Column Description
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Hourly MTP3 Event Reports

To create hourly MTP3 event reports for the MWTM:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter these commands:

# cd /opt/CSCOsgm/bin
# ./mwtm evreps enable
# ./mwtm evreps mtp

For more details on the mwtm evreps commands, see Appendix B, “Command Reference.”

The MTP3 Events Hourly Archived Reports page shows all hourly MWTM MTP3 event reports for the 
server to which you connect. 

The .zip files are archived by type, date, and hour; for example, the 
sgmMTP3Events.2006-06-29-08.csv.zip file contains a summary report of the hourly MTP3 event for the 
eighth hour on June 29, 2006.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of an 
hourly MTP3 event for all objects that the MWTM detected on that date and hour. You can download the 
.zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

Custom MTP3 Event Reports

To create custom MTP3 event reports for the MWTM:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter these commands:

# cd /opt/CSCOsgm/bin
# ./mwtm mtpevents

For more details on the mwtm mtpevents command, see Appendix B, “Command Reference.”

The Custom MTP3 Events Archived Reports page shows all custom MWTM MTP3 event reports for the 
server to which you connect.
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Enabling Custom Archived Statistics Reports

Note If you have MWTM User-Based Access enabled, these reports are available to users with authentication 
level 4 (Network Administrator) and higher.

In the MWTM, you can create summary reports of custom archived statistics and accounting and send 
them to an export file. 

To create a custom archived report for the MWTM:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

# cd /opt/CSCOsgm/bin

Step 3 Based on the type of custom report you want to generate, enter one of these commands and arguments 
to enable that report:

Field or Column Description

Export File Name of the custom network events export .zip file, archived by type, date, and 
hour; for example, the sgmMTP3Events.custom.20867.2006-02-13-16-15.csv.zip 
file contains the summary report of custom network events with ID tag 20867 for 
the 15th minute of the 16th hour on February 13, 2006.

Each archived .zip file contains a comma-separated value (CSV) text file with a 
daily statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your 
choice. You can also import the file directly into Microsoft Excel.

For more information about the format of custom statistics archived reports, see 
Custom Network Reports File Formats, page I-17.

Report Start Date 
(EST)

Date and time the custom report began.

Report Finish 
Date (EST)

Date and time the custom report ended.

Last Modified 
Date (EST)

Date and time the custom report was last modified.

View Shows the custom detail report for the object.

Custom Report Command

Application server and 
application server processes 
custom statistics

# ./mwtm xuastats [node-list [id-tag]] [sort-option] [quiet]

GTT accounting statistics # ./mwtm gttstats [node-list [id-tag]] [sort-option] [quiet]
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Note For more information about these commands, see Appendix B, “Command Reference.”

• (Optional) To include or exclude specific nodes, signaling points or linksets in the report, use the 
node-list argument. See these sections for more information:

– Including Specified Nodes or Signaling Points in Custom Archived Reports, page 12-52

– Including Specified Linksets in Custom Archived Reports, page 12-53

– Excluding Specified Nodes or Signaling Points from Custom Archived Reports, page 12-53

– Excluding Specified Linksets from Custom Archived Reports, page 12-53

• (Optional) If you specify a node-list, you can also specify an id-tag to identify the report. The id-tag 
can be any meaningful character string, but it cannot contain any spaces. The default value for id-tag 
is the process ID of the mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, mwtm 
mtpevents, mwtm q752stats, or mwtm xuastats command.

• (Optional) To specify a sort order for a report, specify a sort-option. For further information on sort 
options, see the descriptions of the mwtm accstats, mwtm gttstats, mwtm linkstats, 
mwtm mlrstats, or mwtm xuastats commands in Appendix B, “Command Reference.”

• (Optional) To disable automatic output to the terminal when running this command in a script, 
specify the quiet keyword. The MWTM generates the report in export format, which you can view 
using the MWTM web interface.

For example, to generate a custom accounting statistics report for links and linksets, that includes only 
information for node mwtm-2600a.cisco.com, sorted in ascending order based on the node name, and 
identified by ID tag test1, enter:

# ./mwtm accstats mwtm-2600a.cisco.com test1 -sno

Step 4 (First-time users only) If this is the first time that you use the mwtm accstats, mwtm gttstats, 
mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command to enable a report, 
you must enter the command one more time. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the data being collected appears 
valid, begins generating the report.

Thereafter, you need only enter this command once to enable the report.

Link and linkset summary # ./mwtm linkstats [node-list [id-tag]] [sort-option] [quiet]

MLR statistics # ./mwtm mlrstats [node-list [id-tag]] [sort-option] [quiet]

MTP3 accounting statistics # ./mwtm accstats [node-list [id-tag]] [sort-option] [quiet]

MTP3 event summary # ./mwtm mtpevents [node-list [id-tag]] [quiet]

Q.752 statistics # ./mwtm q752stats [node-list [id-tag]] [quiet]

Custom Report Command
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Step 5 (First-time users only) If this is the first time that you use the mwtm linkstats command to enable a 
report, you must enter the command two more times. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful link and linkset statistics.

• Third entry continues to calculate statistics, calculates long-term averages, and, if the data being 
collected appears to be valid, begins generating the report.

Thereafter, you need only enter this command once to enable the report.

Step 6 The MWTM generates the custom statistics report and stores it in the /custom directory, identified by its 
ID tag.

For example, if you entered the command:

# ./mwtm accstats mwtm-2600a.cisco.com test1 -sno

The MWTM generates these reports:

mwtmAccStats.custom.test1.2004-02-13:15.csv.zip
mwtmAccStats.custom.test1.2004-02-13:15.csv.zip

If you installed the MWTM in the default directory, /opt, then the /custom directory resides at 
/opt/CSCOsgm/reports/custom.

If you installed the MWTM in a different directory, or if you moved the report files directory using the 
mwtm repdir command, then the /custom directory resides in that directory.

Step 7 You can view custom reports on the MWTM Web interface under Reports > Archive > Custom.

Including and Excluding Specified Objects in Custom Archived Reports
When you enable a custom archived report, you can limit the report to one or more specific objects, or 
you can exclude one or more specific objects:

• Including Specified Nodes or Signaling Points in Custom Archived Reports, page 12-52

• Including Specified Linksets in Custom Archived Reports, page 12-53

• Excluding Specified Nodes or Signaling Points from Custom Archived Reports, page 12-53

• Excluding Specified Linksets from Custom Archived Reports, page 12-53
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Including Specified Nodes or Signaling Points in Custom Archived Reports

When you enable a custom archived report, you can limit the report to one or more specific objects:

• To enable a report that includes all nodes that the MWTM detected, specify all in place of the 
node-list argument in the mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, 
mwtm mtpevents, mwtm q752stats, or mwtm xuastats command; for example, this command 
enables an accounting statistics report for all nodes:

./mwtm accstats all

• To enable a report for a single node, specify the node name in place of the node-list argument in the 
mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, mwtm mtpevents, 
mwtm q752stats, or mwtm xuastats command. The node name must match exactly the node name 
as discovered by the MWTM, including the domain name; for example, this command enables an 
accounting statistics report for node mwtm-2600a.cisco.com:

./mwtm accstats mwtm-2600a.cisco.com

• To enable a report that includes only the nodes and signaling points listed in the user-defined 
nodes.include file, create the file, then specify default in place of the node-list argument in the 
mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, mwtm mtpevents, 
mwtm q752stats, or mwtm xuastats command. This is also the default setting for this command, 
if you do not specify a node-list keyword.

For example, this command enables an accounting statistics report that includes only the nodes and 
signaling points specified in the nodes.include file:

./mwtm accstats default

• To enable a report that includes only a group of nodes or signaling points other than the nodes and 
signaling points listed in the nodes.include file, create a file that contains the list of nodes and 
signaling points to be included and specify the full path and name of the file in place of the node-list 
argument in the mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, 
mwtm mtpevents, mwtm q752stats, or mwtm xuastats command.

For example, this command enables an accounting statistics report that includes only the nodes and 
signaling points specified in /tmp/mynodes file:

./mwtm accstats /tmp/mynodes

Note For more information on creating the nodes.include file, see Including or Excluding Specified 
Objects in ITP Reports, page 12-6.
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Including Specified Linksets in Custom Archived Reports

When you enable a custom archived report, you can limit the report to one or more specific linksets.

To enable a report that includes only the linksets listed in the user-defined linksets.include file, create 
the file, then specify default in place of the node-list argument in the mwtm accstats, mwtm gttstats, 
mwtm linkstats, mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command.

For example, this command enables an accounting statistics report that includes only the linksets 
specified in the linksets.include file:

./mwtm accstats default

Note For more information on creating the linksets.include file, see Including or Excluding Specified 
Objects in ITP Reports, page 12-6.

Excluding Specified Nodes or Signaling Points from Custom Archived Reports

When you enable a custom archived report, you can exclude one or more specific nodes or signaling 
points from the report.

To enable a report that excludes the nodes and signaling points listed in the user-defined nodes.exclude 
file, create the file, then specify default in place of the node-list argument in the mwtm accstats, 
mwtm gttstats, mwtm linkstats, mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or 
mwtm xuastats command.

For example, this command enables an accounting statistics report that excludes the nodes and signaling 
points specified in the nodes.exclude file:

./mwtm accstats default

Note For more information on creating the nodes.exclude file, see Including or Excluding Specified 
Objects in ITP Reports, page 12-6.

Excluding Specified Linksets from Custom Archived Reports

When you enable a custom archived report, you can exclude one or more specific linksets from the 
report.

To enable a report that excludes the linksets listed in the user-defined linksets.exclude file, create the file, 
then specify default in place of the node-list argument in the mwtm accstats, mwtm gttstats, 
mwtm linkstats, mwtm mlrstats, mwtm mtpevents, mwtm q752stats, or mwtm xuastats command.

For example, this command enables an accounting statistics report that excludes the linksets specified 
in the linksets.exclude file:

./mwtm accstats default

Note For more information on creating the linksets.exclude file, see Including or Excluding Specified 
Objects in ITP Reports, page 12-6.
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Understanding Custom Archived Reports
The Custom Archived Report pages show all archived MWTM custom network and accounting statistics 
reports for the server to which you connect. These reports can be viewed on the Web, or downloaded as 
.zip files. These .zip files are also stored in the default directory (/opt/CSCOsgm by default) within the 
/reports/custom directory.

Note Custom (and hourly) Q.752 reports are only available as .zip files.

Custom archived reports are those that you enable by using the mwtm accstats, mwtm gttstats, 
mwtm linkstats, mwtm mlrstats, mwtm mtpevents, mwtm q752stats, and mwtm xuastats 
commands.

The Custom Report tables are sorted based on the information in the Export File column. However, you 
can sort a table based on the information in one of the other columns (see Navigating Table Columns, 
page 5-23).

The Custom Report tables contain:

To show details in HTML for custom archived reports, within the View column of the Custom Archived 
Report page, click one of the following links:

Column Description

Export File Name of the custom statistics export .zip file, archived by type, date, and hour; for 
example, the sgmLinksetStats.custom.20867.2007-02-13-16:15.csv.zip file 
contains the summary report of custom linkset statistics with the ID tag 20867 for 
the 15th minute of the 16th hour on February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a 
daily statistics report for that date. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your 
choice. You can also import the file directly into Microsoft Excel.

For more information about the format of custom statistics archived reports, see 
GTT Accounting Statistics Daily Format, page I-5.

Report Start Date 
(EST)

Date and time the custom report began.

Report Finish 
Date (EST)

Date and time the custom report ended.

Last Modified 
Date (EST)

Date and time the custom report was last modified.

View Shows the custom detail report for the object. Not available for Q.752 reports.

View Content Link

Aborts and 
Continues

Custom MLR Abort and Continues Detail Reports, page 12-58

Application 
Servers

Custom Application Server Statistics Detail Reports, page 12-65
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All custom detail reports contain these headings and general menu options:

Application 
Server Processes

Custom Application Server Process Statistics Detail Reports, page 12-66

Events Custom MTP3 Events Detail Reports, page 12-56

GTT Custom GTT Accounting Detail Reports, page 12-56

Links Custom Link Statistics Detail Reports, page 12-67

Linksets Custom Linkset Statistics Detail Reports, page 12-68

Processed Custom MLR Processed Detail Reports, page 12-60

ResultInvokes Custom MLR Result Invokes Detail Reports, page 12-61

RuleMatches Custom MLR Rule Matches Detail Reports, page 12-62

SubTriggers Custom MLR Subtriggers Detail Reports, page 12-62

Triggers Custom MLR Triggers Detail Reports, page 12-63

View Content Link

Heading/ Menu 
Option Description

Date and Hour
(in heading)

Date and hour of the report.

Offset
(in heading)

Shows the number of rows in the table, prior to the first visible row; for example, if 
the first visible row is 501, the Offset is 500.

Number and 
Sort Order
(in heading)

Shows the number of records (rows) in the table, the column by which the table is 
sorted, and whether the sort is in ascending or descending order.

10/Page Shows 10 rows in the table.

20/Page Shows 20 rows in the table.

50/Page Shows 50 rows in the table.

100/Page Shows 100 rows in the table.

300/Page Shows 300 rows in the table.

500/Page Shows 500 rows in the table.

Max Shows up to 15,000 rows in the table.

Note Depending on the number of rows, this could take up to 15 minutes.

DefPrefs Resets the /Page preferences for this web page to the default settings for the MWTM 
server.

First
(at bottom of 
table)

Shows the first page of entries for the table.

For example, if the table is sorted by Total Aborted in descending order, clicking this 
field shows the entries with the highest number of MSUs aborted by MLR.

You cannot click this field if the first page of entries is already visible.
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Custom MTP3 Events Detail Reports
The Custom MTP3 Events Detail Reports page shows details for all archived MWTM custom MTP3 
event reports for all nodes that the MWTM detected when you enabled the report. You enable Custom 
event reports by using the mwtm mtpevents command.

Custom GTT Accounting Detail Reports
The Custom GTT Accounting Detail Reports page shows details for all archived MWTM custom GTT 
accounting reports for all nodes that the MWTM detects when you enabled the report. You enable 
Custom GTT accounting reports by using the mwtm gttstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Previous 
(Rows)
(at bottom of 
table)

Shows the previous page of entries for the table.

You cannot click this field if the first page of entries is already visible.

Next (Rows)
(at bottom of 
table)

Shows the next page of entries for the table.

You cannot click this field if the last page of entries is already visible.

Last
(at bottom of 
table)

Shows the last page of entries for the table.

For example, if the table is sorted by Total Aborted in descending order, clicking this 
field shows the entries with the lowest number of MSUs aborted by MLR.

You cannot click this field if the last page of entries is already visible.

Total
(at bottom of 
table)

Shows the total number of entries in the table.

Heading/ Menu 
Option Description

Field or Column Description

ID Identifier for the custom report, specified when you entered the mwtm mtpevents 
command. If you did not specify an ID, this field shows the process ID of the 
command that enabled the report.

Node Name of the node.

Index Number in the list shown in the CLI. 

MTP3 Event Text MTP3 event message as seen on the CLI.
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Custom MLR Statistics Detail Reports
Using the MWTM, you can view the following custom MLR statistics detail reports:

• Custom MLR Abort and Continues Detail Reports, page 12-58

• Custom MLR Processed Detail Reports, page 12-60

• Custom MLR Result Invokes Detail Reports, page 12-61

• Custom MLR Rule Matches Detail Reports, page 12-62

• Custom MLR Subtriggers Detail Reports, page 12-62

• Custom MLR Triggers Detail Reports, page 12-63

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily GTT accounting 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
GTT Accounting Data Record page for that date in text format. The 
GTT Accounting Data Record can be useful when the TAC is debugging 
problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

Linkset Name Name of the linkset associated with the Network Name for which data is 
visible.

Selector Name of the selector.

GTA Global Title Address (GTA) associated with the selector.

To Network Name For version 4.1 GTT files (corresponding to ITP software release 
12.2(20)SW or greater) and 4.2 GTT files (corresponding to ITP software 
release 12.2(21)SW1 or greater), name of the instance in which the 
translated point code resides.

For version 3.1 GTT files (corresponding to ITP software releases 
12.2(4)MB9 and 12.2(4)MB9a) and 4.0 GTT files (corresponding to ITP 
software release 12.2(4)MB10 or greater), the value of this field is 
identical to that of the Network Name field.

PC Destination point code for the GTA.

Pkts Total number of packets translated by GTT on the specified date.

Octets Total number of octets translated by GTT on the specified date.
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Custom MLR Abort and Continues Detail Reports

The Custom MLR Abort and Continues Detail Reports page shows details for all archived MWTM 
custom MLR abort and continues reports for all nodes that the MWTM detects when you enabled the 
report. You enable Custom MLR abort and continues reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

The Custom MLR Abort Detail Reports table contains:

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR aborts 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Aborts/Continues Data Record page for that date in text format. The 
MLR Aborts/Continues Data Record can be useful when the TAC is 
debugging problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

Total Aborted Total number of MSUs aborted by MLR, and the MSU abort rate in 
packets per second.

No Resources Number of MSUs aborted by MLR because of a shortage of resources, and 
the No Resources MSU abort rate in packets per second.

Results Blocked Number of MSUs aborted by MLR with a result of block, and the Results 
Blocked MSU abort rate in packets per second.

GTI Mismatches Number of MSUs aborted by MLR because of mis-matched GTIs, and the 
GTI Mismatches MSU abort rate in packets per second.

Addr Conv Fails Number of MSUs aborted by MLR because of a failed GTA address 
conversion, and the Address Conversion Failures MSU abort rate in 
packets per second.

Dest Unavails Number of MSUs aborted by MLR because the destination was 
unavailable, and the Destination Unavailables MSU abort rate in packets 
per second.

No Server Aborteds Number of MSUs aborted by MLR because no server was available, and 
the No Server Aborteds MSU abort rate in packets per second.
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The Custom MLR Continues Detail Reports table contains:

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR continues 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Aborts/Continues Data Record page for that date in text format. The 
MLR Aborts/Continues Data Record can be useful when the TAC is 
debugging problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

Total Continued Total number of MSUs returned to SCCP by MLR with a result of 
continue, and the MSU return rate in packets per second.

Unsupp Msg Type Number of MSUs returned to SCCP by MLR because of unsupported 
message types, and the Unsupported SCCP Msg Types MSU return rate in 
packets per second.

Unsupp Seg SCCP Number of MSUs returned to SCCP by MLR because of unsupported 
segments, and the Unsupported Segmented SCCP Msgs MSU return rate 
in packets per second.

Unsupp Msgs Number of MSUs returned to SCCP by MLR because of parse failures, and 
the Unsupported Messages MSU return rate in packets per second.

Parse Errors Number of MSUs returned to SCCP by MLR because of parse errors, and 
the Parse Errors MSU return rate in packets per second.

No Results Number of MSUs returned to SCCP by MLR with no results, and the No 
Results MSU return rate in packets per second.

Result Continueds Number of MSUs returned to SCCP by MLR with a result of continue, and 
the Result Continueds MSU return rate in packets per second.

No Server Continueds Number of MSUs returned to SCCP by MLR because no server was 
available, and the No Server Continueds MSU return rate in packets per 
second.

Result GTTs Number of MSUs returned to SCCP by MLR with a result of GTT, and the 
Result GTTs MSU return rate in packets per second.

Failed Trigs Number of MSUs returned to SCCP by MLR because of no trigger match, 
and the Failed Triggers MSU return rate in packets per second.
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Custom MLR Processed Detail Reports

The Custom MLR Processed Detail Reports page shows details for all archived MWTM custom MLR 
processed reports for all nodes that the MWTM detects when you enabled the report. You enable Custom 
MLR processed reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR processed 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Processed Data Record page for that date in text format. The 
MLR Processed Data Record can be useful when the TAC is debugging 
problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

Routed Total number of packets routed by MLR on the specified date.

Total Aborted Total number of MSUs not processed by MLR because of invalid data or 
a blocked MSU.

Total Continued Total number of MSUs passed back to SCCP processing by MLR on the 
specified date.

MAP SMS-MOs Number of MSUs of type GSM-MAP SMS-MO processed by MLR on the 
specified date.

MAP SMS-MTs Number of MSUs of type GSM-MAP SMS-MT processed by MLR on the 
specified date.

MAP SRI-SMs Number of MSUs of type GSM-MAP SRI-SM processed by MLR on the 
specified date.

MAP AlertScs Number of MSUs of type GSM-MAP AlertSc processed by MLR on the 
specified date.

ANSI-41 SMD-PPs Number of MSUs of type ANSI-41 SMD-PP processed by MLR on the 
specified date.

ANSI-41 SMS Reqs Number of MSUs of type ANSI-41 SMSRequest processed by MLR on the 
specified date.

ANSI-41 SMS Notifys Number of MSUs of type ANSI-41 SMSNotify processed by MLR on the 
specified date.
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Custom MLR Result Invokes Detail Reports

The Custom MLR Result Invokes Detail Reports page shows details for all archived MWTM custom 
MLR result invokes reports for all nodes that the MWTM detects when you enabled the report. You 
enable Custom MLR result invokes reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Links: Aborts Opens the MLR Statistics: Custom Aborts Report page for the node and 
signaling point in the selected row.

Links: Continues Opens the MLR Statistics: Custom Continues Report page for the node 
and signaling point in the selected row.

Links: Triggers Opens the MLR Statistics: Custom Triggers Report page for the node and 
signaling point in the selected row.

Links: SubTriggers Opens the MLR Statistics: Custom SubTriggers Report page for the node 
and signaling point in the selected row.

Links: RuleMatches Opens the MLR Statistics: Custom RuleMatches Report page for the node 
and signaling point in the selected row

Links: ResultInvokes Opens the MLR Statistics: Custom ResultInvokes Report page for the 
node and signaling point in the selected row

Field or Column Description

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR processed 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Result Invokes Stats Data Record page for that date in text format. 
The MLR Result Invokes Stats Data Record can be useful when the TAC 
is debugging problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

ResultSet Name of the result set of which this result is a member.

Result Num Number of this result within the result set.

Invokes Total number of times this result was invoked.
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Custom MLR Rule Matches Detail Reports

The Custom MLR Rule Matches Detail Reports page shows details for all archived MWTM custom MLR 
rule matches reports for all nodes that the MWTM detects when you enabled the report. You enable 
Custom MLR rule matches reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Custom MLR Subtriggers Detail Reports

The Custom MLR Subtriggers Detail Reports page shows details for all archived MWTM custom MLR 
subtrigger reports for all nodes that the MWTM detects when you enabled the report. You enable Custom 
MLR subtrigger reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR processed 
statistics detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Rule Matches Stats Data Record page for that date in text format. 
The MLR Rule Matches Stats Data Record can be useful when the TAC is 
debugging problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

RuleSet Name of the rule set of which this rule is a member.

Rule Num Number of this rule within the rule set.

Matches Total number of times this rule was matched.
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Custom MLR Triggers Detail Reports

The Custom MLR Triggers Detail Reports page shows details for all archived MWTM custom MLR 
trigger reports for all nodes that the MWTM detects when you enabled the report. You enable Custom 
MLR trigger reports by using the mwtm mlrstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR statistics 
detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR SubTrigger Stats Data Record page for that date in text format. The 
MLR SubTrigger Stats Data Record can be useful when the TAC is 
debugging problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.

Trig Index Index number associated with the trigger.

SubTrig Index Index number associated with the subtrigger.

Action Action taken by the subtrigger.

Parameters Parameters that control the behavior of the subtrigger.

Matches Number of subtrigger matches with result Action Performed.

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected daily MLR statistics 
detail report.

To see the entire detailed report, click the ID. The MWTM shows the 
MLR Trigger Stats Data Record page for that date in text format. The 
MLR Trigger Stats Data Record can be useful when the TAC is debugging 
problems.

Node Name of the node associated with the Network Name for which data is 
visible.

Network Name Network name for which data is visible.

Sig Point Name of the signaling point associated with the Network Name for which 
data is visible.
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Custom MTP3 Accounting Detail Reports
The Custom MTP3 Accounting Detail Reports page shows a custom summary of MTP3 accounting 
statistics for links and linksets in the MWTM. Custom MTP3 accounting reports are enabled using the 
mwtm accstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Trig Index Index number associated with the trigger.

Action Action taken by the trigger.

Parameters Parameters that control the behavior of the trigger.

Prelim Matches Preliminary count of trigger matches.

Matches Number of trigger matches with result Action Performed.

Links: SubTriggers Opens the MLR Statistics: Daily SubTriggers Report page for the 
signaling point in the selected row.

Field or Column Description

Field or Column Description

ID Internal ID, assigned by the MWTM, of the selected hourly accounting 
statistics report.

To see the entire detailed report, click the ID. The MWTM shows the 
Accounting Data Record # X for Date for that date and hour, in text 
format. The Accounting Data Record # X for Date can be useful when the 
TAC is debugging problems.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Sig Point Name of the signaling point for the linkset.

Linkset Name of the linkset.

Gateway Screening Indicates whether the traffic passed or failed the Gateway Screening test 
at the ITP.

To see only statistics that passed or failed for a specific linkset, select a 
linkset and click Pass, Fail, or Unroutable.

OPC Originating point code of the traffic, which is a unique identifier for each 
set of statistics.

To see only statistics that match a specific OPC for a given linkset, find 
the linkset and click the point code.
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Custom Application Server Statistics Detail Reports
The Custom Application Server Statistics Detail Reports page shows a custom summary of application 
server statistics in the MWTM. Custom application server statistics reports are enabled using the 
mwtm xuastats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

DPC Destination point code of the traffic.

To see only statistics that match a specific DPC for a given linkset, find 
the linkset and click the point code.

SI Service indicator, which indicates the type of SS7 traffic. Valid values 
include:

• 0—Signaling Network Management Message (SNM) 

• 1—Maintenance Regular Message (MTN) 

• 2—Maintenance Special Message (MTNS) 

• 3—Signaling Connection Control Part (SCCP) 

• 4—Telephone User Part (TUP) 

• 5—ISDN User Part (ISUP) 

• 6—Data User Part (call and circuit-related messages) 

• 7—Data User Part (facility registration/cancellation messages)

To see only detailed information for a specific type of SI, click the SI type.

Send MSUs Total number of MTP3 MSUs sent on the specified date.

Receive MSUs Total number of MTP3 MSUs received on the specified date.

Send Bytes Total number of bytes sent on the specified date.

Receive Bytes Total number of bytes received on the specified date.

Field or Column Description

Field or Column Description

ID Internal ID that the MWTM assigns of the selected summary report of 
hourly application server statistics.

To see the entire detailed report, click the ID. The MWTM shows the AS 
Data Record page for that application server, date, and hour, in text format. 
The AS Data Record can be useful when the TAC is debugging problems.

Node Name of the node for the application server.

Sig Point Name of the signaling point for the application server.
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Custom Application Server Process Statistics Detail Reports
The Custom Application Server Process Statistics Detail Reports page shows a custom summary of 
application server process statistics in the MWTM. You enable Custom application server process 
statistics reports by using the mwtm xuastats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

AS Name Name of the application server.

Packets From MTP3 Total number of packets received by the application server, sent from the 
MTP3 layer for the specified date and hour.

Packets To ASPs Total number of packets sent to the application server processes by the 
application server for the specified date and hour.

Field or Column Description

Field or Column Description

ID Internal ID that the MWTM assigns of a summary report of the selected 
hourly application server process statistics.

To see the entire detailed report, click the ID. The MWTM shows the ASP 
Data Record page for that application server process, date, and hour, in 
text format. The ASP Data Record can be useful when the TAC is 
debugging problems.

Node Name of the node for the application server process.

Sig Point Name of the signaling point for the application server process.

ASP Name Name of the application server process.

Packets From ASP Total number of packets received from the application server process for 
the specified date and hour.

Packets To ASP Total number of packets sent to the application server process for the 
specified date and hour.

Packets From MTP3 Total number of packets received by the application server process, sent 
from the MTP3 layer for the specified date and hour.

Packets To MTP3 Total number of packets sent to the MTP3 layer by the application server 
process for the specified date and hour.
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Custom Link Statistics Detail Reports
The Custom Link Statistics Detail Reports page shows a custom summary of link statistics in the 
MWTM. Custom link statistics reports are enabled using the mwtm linkstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Send Errors Total number of errors that occurred when sending packets to the 
application server processes and to the MTP3 layer for the specified date 
and hour.

Receive Errors Total number of errors that occurred when receiving packets from the 
application server processes and from the MTP3 layer for the specified 
date and hour.

Field or Column Description

Field or Column Description

ID Internal ID that the MWTM assigns of the summary report of selected 
hourly link statistics.

To see the entire detailed report, click the ID. The MWTM shows the Link 
Data Record page for that link, date, and hour, in text format. The Link 
Data Record can be useful when the TAC is debugging problems.

Node Name of the node for the link.

Network Name Name of the network for the link.

Sig Point Name of the signaling point for the link.

Link Name Name of the link.

Type Type of link. Possible link types are:

• HSL—The link uses the SS7-over-ATM (Asynchronous Transfer 
Mode) high-speed protocol.

• SCTP—The link uses the Stream Control Transmission Protocol 
(SCTP) IP transport protocol.

• Serial—The link uses the serial SS7 signaling protocol.

• Virtual—The link is a virtual link, which connects signaling point 
instances running on the same node. The MWTM does not poll virtual 
links, nor does it display real-time data or accounting statistics for 
virtual links.
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Custom Linkset Statistics Detail Reports
The Custom Linkset Statistics Detail Reports page shows a custom summary of linkset statistics in the 
MWTM. Custom linkset statistics reports are enabled using the mwtm linkstats command.

Note If you do not enable data collection on the active report, a red status indicator and the words Data 
Collection Disabled appear next to the report title. Click the Data Collection Disabled link to see 
which command enables the report.

If a statistics calculation results in an undefined value, such as a number divided by zero (0), or an 
undefined number, based on the configuration, then MathError appears in the field.

Send Utilization
or
Send Erlangs

Average Send Utilization for the link, expressed as a utilization percentage 
or number of Erlangs (E) (as set with the mwtm webutil command) for the 
specified date and hour.

If you do not set the planned send capacity for the SCTP link, then NoCap 
appears in the field.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command), since MWTM polling began for the link, or since the MWTM 
last reset the averages as a result of bad data.

If you do not set the planned send capacity for the SCTP link, this field 
shows NoCap.

Receive Utilization
or
Receive Erlangs

Average Receive Utilization for the link, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned receive capacity for the SCTP link, this field 
shows NoCap.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the link, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the link, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for the SCTP link, then 
NoCap appears in the field.

Send MSUs Total number of MTP3 MSUs sent on the specified date and hour.

Receive MSUs Total number of MTP3 MSUs received on the specified date and hour.

Congestion % Total percentage of congestion on the specified date and hour.

Hourly In-Service Percentage of time the link was in service on the specified date and hour.

Long Term In-Service Average percentage of time the link was in service since MWTM polling 
began for the link, or since the MWTM last reset the averages as a result 
of bad data.

Field or Column Description
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Field or Column Description

ID Internal ID that the MWTM assigns of the summary report of selected 
hourly linkset statistics.

To see the entire detailed report, click the ID. The MWTM shows the 
Linkset Data Record page for that linkset, date, and hour, in text format. 
The Linkset Data Record can be useful when the TAC is debugging 
problems.

Node Name of the node for the linkset.

Network Name Name of the network for the linkset.

Sig Point Name of the signaling point for the linkset.

Linkset Name Name of the linkset.

Hourly In-Service Percentage of time the linkset was in service on the specified date and 
hour.

Long Term In-Service Average percentage of time the linkset was in service since MWTM 
polling began for the linkset, or since the MWTM last reset the averages 
as a result of bad data.

Send Utilization
or
Send Erlangs

Average Send Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned send capacity for the linkset, then NoCap 
appears in the field.

Long Term Send 
Utilization
or
Long Term Send Erlangs

Long-term average Send Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned send capacity for the linkset, then NoCap 
appears in the field.

Receive Utilization
or
Receive Erlangs

Average Receive Utilization for the linkset, expressed as a utilization 
percentage or number of Erlangs (E) (as set with the mwtm webutil 
command) for the specified date and hour.

If you do not set the planned receive capacity for the linkset, then NoCap 
appears in the field.

Long Term Receive 
Utilization
or
Long Term Receive 
Erlangs

Long-term average Receive Utilization for the linkset, expressed as a 
utilization percentage or number of Erlangs (E) (as set with the 
mwtm webutil command), since MWTM polling began for the linkset, or 
since the MWTM last reset the averages as a result of bad data.

If you do not set the planned receive capacity for the linkset, then NoCap 
appears in the field.



 

12-70
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 12      Managing ITP Reports
  Understanding Network Statistics Archived Reports

Understanding Network Statistics Archived Reports
This section contains:

• Hourly Network Statistics Archived Reports, page 12-70

• Daily Network Statistics Archived Reports, page 12-70

• Rolling Network Statistics Archived Reports, page 12-71

Hourly Network Statistics Archived Reports
The Hourly Archived Reports pages show summary reports for all archived MWTM hourly network 
statistics for all of the following that the MWTM detects for the server to which you connect:

• Application servers

• Application server processes

• Links

• Linksets

• Q752 links 

The summary reports of archived hourly network statistics are stored as downloadable .zip files. The .zip 
files are archived by type, date, and hour; for example, the sgmLinksetStats.2007-02-13-08.csv.zip file 
contains summary reports for the hourly linkset statistics for the eighth hour on February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of 
hourly network statistics for all application servers, application server processes, links, or linksets that 
the MWTM detects on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

See Appendix I, “Archived Reports File Formats” for more information about the format of hourly 
network statistics archived reports.

Daily Network Statistics Archived Reports
The Daily Archived Reports pages display summary reports for all archived MWTM daily network 
statistics for all application servers, application server processes, links, linksets, MLR, or point codes 
that the MWTM detects for the server to which you connect, stored as downloadable .zip files.

The .zip files are archived by type and hour; for example, the 
sgmLinksetStats.DailySum.2007-02-13.csv.zip file contains the summary report of daily linkset statistics 
for the February 13, 2007.

Each archived .zip file contains a comma-separated value (CSV) text file with a summary report of daily 
network statistics for all application servers, application server processes, links, linksets, MLR, or point 
codes that the MWTM detected on that date and hour. You can download the .zip files and extract them.

To download a .zip file, click a filename, then save the file to a location of your choice. You can also 
import the file directly into Microsoft Excel.

See Appendix I, “Archived Reports File Formats” for more information about the format of daily 
network statistics archived reports.
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Rolling Network Statistics Archived Reports
The All Rolling Reports page shows summary reports of concatenated MWTM hourly and daily network 
statistics for all of the following objects detected by the MWTM for the server you are connected to:

• Application servers

• Application server processes

• Links 

• Linksets

These statistics are stored as downloadable .zip files. The .zip files are archived by type and number of 
days (7 or 30). For example:

• The sgmLinkStats.RollingSevenDayAllHours.csv.zip file contains summary reports of the hourly 
link statistics for the last seven (7) days, concatenated into one comma-separated value (CSV) text 
file.

• The sgmLinkStats.Rolling30DayAllDays.csv.zip file contains summary reports of the daily link 
statistics for the last 30 days, concatenated into one comma-separated value (CSV) text file.

Note To limit the maximum number of rows in export CSV files (for example, Excel can only handle 
65,535 rows) see mwtm statreps maxcsvrows, page B-111. 

The MWTM creates a new set of files every hour.

You can download the .zip files and extract them. To download a .zip file, click a filename, then save the 
file to a location of your choice. You can also import the file directly into Microsoft Excel.

For more information about the format of rolling statistics archived reports, see Rolling Network Reports 
File Formats, page I-18.

Viewing the MWTM Statistics Reports Logs
You can view a log that contains all messages pertaining to MWTM ITP reports, and a display of the 
current values of MWTM report parameters and timers.

This section contains this information:

• Viewing the MWTM Report Log, page 12-71

• Viewing the MWTM Report Parameters and Timers, page 12-72

Viewing the MWTM Report Log
For details on viewing the MWTM report log, see Viewing the Report Log, page 11-22.
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Viewing the MWTM Report Parameters and Timers
The Report Parameters and Timers page shows the current values of report parameters and timers for the 
server to which you connect, and which is currently running the MWTM server.

To access the Report Parameters and Timers page:

Step 1 Choose Reports from the MWTM web navigation tree.

Step 2 Click Report Parameters and Timers.

Column Description

Report Dir Path and name of the directory in which the MWTM stores reports. The default 
reports directory is /opt/CSCOsgm/reports, but you can change the reports 
directory using the mwtm repdir command (see mwtm repdir, page B-100).

Status Indicates whether the MWTM should generate network statistics reports. For more 
information, see the description of the mwtm statreps [disable | enable] command 
in mwtm statreps servratio, page B-114.

ExportReports Indicates whether the MWTM should generate network statistics reports in export 
format. For more information, see the description of the mwtm statreps 
[export | noexport] command in mwtm statreps export, page B-108.

LinkReports Indicates whether the MWTM should generate summary reports of link and linkset 
statistics. For more information, see the description of the mwtm statreps 
[link | nolink] command in mwtm statreps link, page B-110.

AcctReports Indicates whether the MWTM should generate MTP3 accounting statistics reports. 
For more information, see the description of the mwtm statreps [acct | noacct] 
command in mwtm statreps acct, page B-105.

GTTReports Indicates whether the MWTM should generate GTT accounting statistics reports. 
For more information, see the description of the mwtm statreps [gtt | nogtt] 
command in mwtm statreps gtt, page B-109.

MLRReports Indicates whether the MWTM should generate MLR statistics reports. For more 
information, see the description of the mwtm statreps [mlr | nomlr] command in 
mwtm statreps mlr, page B-111.

XUAReports Indicates whether the MWTM should generate accounting statistics reports for 
application servers and application server processes. For more information, see the 
description of the mwtm statreps [xua | noxua] command in mwtm statreps xua, 
page B-116.

MSUReports Indicates whether the MWTM should generate MSU rates reports. For more 
information, see the description of the mwtm statreps [msu | nomsu] command in 
mwtm statreps msu, page B-112.

IPLinks Indicates whether the MWTM should include links that use the Stream Control 
Transmission Protocol (SCTP) IP transport protocol in network statistics reports. 
For more information, see the description of the mwtm statreps 
[iplinks | noiplinks] command in mwtm statreps iplinks, page B-110.
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Q752Reports Indicates whether the MWTM should generate Q.752 reports. For more 
information, see the description of the mwtm statreps [q752 | noq752] command 
in mwtm statreps q752, page B-113.

NullCaps Indicates whether the MWTM should include SCTP links that do not have planned 
send and receive capacities in network statistics reports. For more information, see 
the description of the mwtm statreps [nullcaps | nonullcaps] command in mwtm 
statreps nullcaps, page B-113.

TimeMode Indicates the time mode for dates in network statistics reports. For more 
information, see the description of the mwtm statreps timemode [12 | 24] 
command in mwtm statreps timemode, page B-115.

DiskCheck Indicates whether the MWTM should verify that a disk has at least 10 MB of space 
remaining before enabling network statistics reports. For more information, see the 
description of the mwtm statreps [diskcheck | nodiskcheck] command in mwtm 
statreps diskcheck, page B-107.

UtilRatio Utilization values that are outside a normal range are indicated with a red status ball 
icon within the Send Utilization or Receive Utilization cell. A Utilization value is 
outside the normal range if the following condition is met:

Current Utilization > factor * Long-Term Utilization

This inequality is used to recognize increases in the Utilization value. Assuming 
the default factor of 1.5, the Current Utilization value must be less than or equal to 
150% of the Long-Term Utilization value to be within the normal range.

The default value for factor is 1.5.

For more information, see the description of the mwtm statreps utilratio 
command in mwtm statreps utilratio, page B-116.

ServRatio In-Service values that are outside a normal range are indicated with a red status ball 
icon in the In-Service cell. An In-Service value is outside the normal range if the 
following condition is met:

Current In-Service < factor * Long-Term In-Service

This inequality is used to recognize drops in the In-Service value. Assuming the 
default factor of 0.95, the Current In-Service value must be greater than or equal to 
95% of the Long-Term In-Service value to be within the normal range.

For more information, see the description of the mwtm statreps servratio 
command in mwtm statreps servratio, page B-114.

Hourly Age Indicates the maximum number of days the MWTM should archive hourly network 
statistics reports. For more information, see the description of the mwtm statreps 
hourlyage and mwtm rephourlyage commands in mwtm statreps servratio, page 
B-114.

Daily Age Indicates the maximum number of days the MWTM should archive daily network 
statistics reports. For more information, see the description of the mwtm statreps 
dailyage and mwtm repdailyage commands in mwtm statreps dailyage, page 
B-107.

Column Description
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Custom Age Indicates the maximum number of days the MWTM should archive custom network 
statistics reports. For more information, see the description of the mwtm statreps 
custage and mwtm repcustage commands in mwtm statreps custage, page B-106.

Max CSV Rows Indicates the maximum number of rows the MWTM should include in export CSV 
files. For more information, see the description of the mwtm statreps maxcsvrows 
command in mwtm statreps maxcsvrows, page B-111.

Web Names Indicates whether the MWTM should show real node names or display names in 
web pages. For more information, see the description of the mwtm webnames 
[display | real] command in the “mwtm webnames” section on page B-71.

Web Util Indicates whether the MWTM should display send and receive utilization for 
linksets and links as percentages or in Erlangs (E), in web pages. For more 
information, see the description of the mwtm webutil [percent | erlangs] 
command in mwtm who, page B-72.

Timer files Indicates timer activities during the last report run by the MWTM. The timer file is 
useful for identifying how much time the MWTM spends gathering report data and 
generating reports.

Column Description
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Editing an ITP Route Table File

Cisco IP Transfer Points (ITPs) use a route table to select the appropriate signaling path for each 
message, or signal unit, that it must forward. The route table provides the destination point code of the 
packet and the linkset name that it uses to forward the packet.

Note ITP route tables do not support Virtual linksets, and the Cisco Mobile Wireless Transport Manager 
(MWTM) does not display Virtual linksets in the Route Table dialog box.

This chapter contains this information:

• Editing an MWTM ITP Route Table File, page 13-1

• Editing a Non-MWTM ITP Route Table, page 13-16

Editing an MWTM ITP Route Table File
You use the MWTM to edit ITP route table files for an ITP.

To edit a route table file by using the MWTM, open the route table file by using one of these procedures:

• Opening a Route Table File from a File, page 13-2

• Opening a Route Table File from a Node, page 13-3

• Opening a Route Table File from an Archive, page 13-4 

• Editing ITP Route Tables, page 13-6

• Loading an Existing Route Table File, page 13-12

• Deploying a Route Table File, page 13-13

• Saving a Route Table File, page 13-14

• Reverting to the Last Saved Route Table File, page 13-15
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Opening a Route Table File from a File
To open a route table file from a file, choose Tools > Route Table Editor > From File from the MWTM 
main menu, select the name of a route table file, then click OK.

Note When you open a route table from a file or archive, the MWTM preserves the order of entries 
that have the same Destination Point Code, Mask, and Cost.

If the selected route table file contains incorrect linkset entries (for example, if your network 
configuration changed since the last time the route table file was saved), the Replace Linkset dialog box 
appears.

Figure 13-1 Replace Linkset Dialog

You use the Replace Linkset dialog box to quickly replace incorrect linkset entries in route table files 
when your network configuration changes.

Field or Button Description

Linksets That Are No Longer 
Valid

Indicates the incorrect linksets in the route table file.

Auto Replace with Linkset Replaces the highlighted incorrect linkset with a correct linkset, 
selected from the drop-down list box, in all affected entries in the 
route table file.

To replace an incorrect linkset with a correct linkset, select an 
incorrect linkset in the Linksets That Are No Longer Valid table, 
then select a correct linkset from the Auto Replace with Linkset 
drop-down list box, then click Apply. The MWTM automatically 
replaces the incorrect linkset with the selected correct linkset in all 
affected entries in the route table file.
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If the selected route table file does not contain any incorrect linkset entries, the MWTM skips the 
Replace Linkset dialog box and the Route Table dialog box appears (Figure 13-4).

Related Topic:

Editing ITP Route Tables, page 13-6

Opening a Route Table File from a Node
To open a route table file from a node, use one of these procedures:

• Select a network object in a window, then choose Tools > Route Table Editor > From Node from 
the MWTM main menu. (If you select an Unmanaged node, this option is dimmed and cannot be 
selected.)

• Right-click a signaling point in a window, then choose Edit > Route Table from the right-click 
menu. (If you select an Unmanaged signaling point, this option is dimmed and cannot be selected.)

Note When you open a route table from a node, the MWTM cannot preserve the order of entries that 
have the same Destination Point Code, Mask, and Cost. Instead, the MWTM loads the entries 
based on the Destination Linkset. If you need to preserve the order of entries that have the same 
Destination Point Code, Mask, and Cost, right-click one of the entries and select Move Up or 
Move Down to move the entry up or down in the route table. The MWTM preserves the new 
order of the entries when you save the route table.

If more than one signaling point is associated with the node, the Choose Signaling Point dialog box 
appears, which you use to select the signaling point whose route table you want to edit.

Remove Entries Containing 
Selected Linkset

Removes all entries that contain the highlighted incorrect linkset 
from the route table file.

To remove all entries that contain an incorrect linkset from the route 
table fie, select an incorrect linkset in the Linksets That Are No 
Longer Valid table, then check the Remove Entries Containing 
Selected Linkset check box, then click Apply. The MWTM 
automatically removes all entries that contain the incorrect linkset 
from the route table file.

Apply Applies any changes you made to the route table file and closes the 
Replace Linkset dialog box. When you have corrected all incorrect 
linkset entries in the route table file, the Apply button becomes the 
Done button.

Done Closes the Replace Linkset dialog box and opens the Route Table 
dialog box.

When you have corrected all incorrect linksets in the route table file, 
click Done. The Route Table dialog box appears (Figure 13-4).

Cancel Closes the Replace Linkset dialog box without saving any changes 
to the route table file.

Help Shows online help for the current window.

Field or Button Description
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Figure 13-2 Choose Signaling Point Dialog

Related Topic:

Editing ITP Route Tables, page 13-6

Opening a Route Table File from an Archive
To open a route table file from an archive, use one of these procedures:

• Select a network object in a window, then choose Tools > Route Table Editor > From Archive 
from the MWTM main menu. (If you select an Unmanaged node, this option is dimmed and cannot 
be selected.)

• From the Route Table dialog box, choose File > Load from Archive.

• From the Archive Management window, select a route table file from the list, then choose 
File > Open File.

Note When you open a route table from a file or archive, the MWTM preserves the order of entries 
that have the same Destination Point Code, Mask, and Cost.

The Load Route Table from Archive wizard appears. If more than one signaling point is associated with 
the node, the Select Node/SP dialog box appears, which you use to select the node and signaling point 
whose route table you want to edit.

Field or Button Description

Signaling Point List Drop-down list box of signaling points. Select the signaling point with the 
point code, variant, and network name that matches the route table file you 
want to edit. If you select a signaling point that has the:

• Wrong variant, the MWTM shows the message:

Point code out of range.

• Correct variant but the wrong instance, the Replace Linkset dialog box 
appears, prompting you to replace or remove most or all of the linksets.

OK Opens the route table associated with the selected signaling point.

The MWTM reads the active route table from the node and shows it in the 
Route Table dialog box (Figure 13-4).

Cancel Closes the Choose Signaling Point dialog box without selecting a signaling 
point.

Help Shows online help for the Choose Signaling Point dialog box.
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Figure 13-3 Load Route Table from Archive Wizard

The left pane of the Load Route Table from Archive wizard contains:

Related Topic:

Editing ITP Route Tables, page 13-6

Field or Button Description

Select Node/SP You can select the signaling point from which the route table file should be 
loaded. You can optionally check the Filter by Node check box, which limits 
signaling point selection to a specific node. 

Select a signaling point and node (optional) from the drop-down list boxes 
in the right pane, then click Next. The MWTM retrieves route table 
filenames from the selected signaling point. 

If no route table filenames are available, the process ends with errors. If route 
table filenames are available, the MWTM proceeds directly to the Select 
Version step.

Select Version You can select the version you want to load. Click on a version to highlight 
it, then select Next. The table includes:

• Rev—Revision number.

• Date—Date and time the version was created.

• Comments—Provided at the time of creation, if applicable.

• Author—Initiator of the comments.

Load Loads the selected file.

Next> Advances to the next step in the Deployment wizard.

Cancel Closes the wizard without loading a file.

Help Shows online help for the Load Route Table from Archive wizard.
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Editing ITP Route Tables
You use the MWTM to edit ITP route tables for an ITP. ITP uses route tables to locate a destination 
linkset for a packet whose destination point code does not match the ITP's local point code.

The Route Table dialog box appears when you open a route table from one of these objects:

• File—See Opening a Route Table File from a File, page 13-2

• ITP—See Opening a Route Table File from a Node, page 13-3

• Archive—See Opening a Route Table File from an Archive, page 13-4

The Route Table dialog box appears.

Figure 13-4 Route Table Dialog

The Route Table dialog box contains:

• Route Table Dialog Menu, page 13-7

• Route Table Dialog Right-Click Menu, page 13-8

• Route Table, page 13-8

Related Topic:

Editing an MWTM ITP Route Table File, page 13-1
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Route Table Dialog Menu

The menu on the Route Table dialog box contains:

Menu Command Description

File > Load from 
Archive
(Ctrl-H)

Opens the Load Route Table from Archive wizard, which you use to load an 
archived route table. 

File > Load from 
File
(Ctrl-L)

Opens the Load File dialog, which you use to load an already existing route table.

File > Load from 
Signaling Point
(Ctrl-F)

Opens the Choose Signaling Point dialog box (Figure 13-2), which you use to 
select the signaling point whose route table you want to edit.

File > Revert
(Ctrl-R)

Reverts to the last saved version of the route table file.

File > Save to File
(Ctrl-S)

Saves changes you made to the route table. If you are editing a route table from:

• An ITP (that is, if you selected Tools > Route Table Editor > From ITP 
from the MWTM main menu), the default filename is the name of the 
signaling point.

• A file (that is, if you selected Tools > Route Table Editor > From File from 
the MWTM main menu), the default filename is the name of the file that you 
are currently editing.

The MWTM stores the modified route table file in the route table directory on 
the MWTM server. If you installed the MWTM in:

• The default directory, /opt, then the MWTM route table directory is 
/opt/CSCOsgm/routes.

• A different directory, then the MWTM route table directory resides in that 
directory.

File > Save As Opens the Save File dialog: Route Table file list, which you use to save the route 
table file with a new name, or overwrite an existing route table file.

File > Print
(Ctrl-P)

Opens the Print window where you can:

• Specify options for printing.

• Print the current window.

• Save the current window to a file.

The MWTM printing options require that you define a printer on your system. If 
you click Print and the Print window does not appear, ensure that you defined a 
printer on your system.

File > Find
(Ctrl-F)

Opens the Find dialog box, which you use to find a specific character string in 
the window (see Finding Information in a Window, page 5-22).

File > Deploy
(Ctrl-Y)

Opens the Deployment wizard, which you use to validate a route table file, 
upload it to an ITP, and activate it on the ITP.
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Route Table Dialog Right-Click Menu

The right-click menu on the Route Table dialog box contains:

Note The only entries that you can move up or down in the route table are adjacent entries that have the same 
Destination Point Code, Mask, and Cost.

Route Table

The route table lists destination point codes and associated destination linkset names, as well as other 
important information used to route packets on a node.

Press Enter to move down to the next row in the route table; press Tab to move to the next field.

You can resize each column in the route table, but you cannot sort the table based on the information in 
one of the columns (see Navigating Table Columns, page 5-23).

File > Close
(Ctrl-W)

Closes the Route Table dialog box. If you made any changes, the MWTM asks if 
you want to apply the changes before leaving the window. Click:

• Yes to apply the changes and close the prompt window and the Route Table 
dialog box.

• No to close the prompt window and the Route Table dialog box without 
applying or saving any changes.

• Cancel to close the prompt window without applying any changes. The 
Route Table dialog box remains open.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.

Menu Command Description

Menu Command Description

Move Up Moves the selected entry up in the route table. The MWTM preserves the new 
order of the entries when you save the route table.

Move Down Moves the selected entry down in the route table. The MWTM preserves the new 
order of the entries when you save the route table.
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Column or 
Button Description

Title Bar When you first open a route table, the title bar of the Route Table dialog box shows:

MWTM: Route Table Dialog -- SP: <point code:optional network name>

If you save the route table, the title bar shows:

MWTM: Route Table Dialog -- SP: <point code:optional network name> -- 

File: <filename>

If MWTM user access is enabled, and you do not have permission to edit the route 
table, the title bar shows:

MWTM: Route Table Dialog (view only mode) -- SP: <point code:optional 

network name>

Row Num Unique number identifying each entry in the route table. You cannot edit this field, 
but the number might change as you add entries to or delete entries from the route 
table.

Destination 
Point Code

Destination point code for packets on the selected node. The destination point code 
is the point code to which a given packet is routed. To edit the destination point code, 
enter the new code in this field.

If you enter a new destination point code that is less restrictive than the mask, the 
MWTM shows a message to that effect at the bottom of the Route Table dialog box, 
and performs one of these actions. If you:

• Modified an existing point code, the MWTM restores the previous point code.

• Entered an entirely new point code, the MWTM leaves this field blank.

For example, a destination point code of 7.7.7, which specifies 14 bits, is less 
restrictive than a mask of 7.255.0, which specifies only 11 bits. The MWTM ignores 
the extra bits in the last digit of the destination point code and converts it to 7.7.0.

To add a new route to the route table, select the Destination Point Code field in a 
blank row, then fill in the field with the destination point code for the new route. 
When you move the cursor to another field in the row, the MWTM automatically 
populates the rest of the fields with the default values for those fields.

Note You can prevent the MWTM from automatically populating the fields with 
default values (see mwtm routetabledefs, page B-103).

You can specify the point code mask when you enter a destination point code. To do 
so, enter the destination point code, then a slash (/), then the number of bits in the 
mask. For example, if you specify 7.255.6/14, the MWTM shows 7.255.7 in the 
Destination Point Code field and 7.255.7 (or 14) in the Mask field.
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Mask Mask specifying the significant bits of the point code.

The MWTM can display point code masks in dotted-decimal format (the default 
setting) or as a number of bits (see General Display Settings, page 5-4). For:

• ANSI and China standard networks using the default 24-bit point code format, 
the default mask is 255.255.255 (or 24).

If the Destination Point Code is a network route with the format x.x.0, the default 
mask is 255.255.0 (or 16).

If the Destination Point Code is a cluster route with the format x.0.0, the default 
mask is 255.0.0 (or 8).

• ITU networks using the default 14-bit point code format, the default mask is 
7.255.7 (or 14).

If the Destination Point Code is a network route with the format x.x.0, the default 
mask is 7.255.0 (or 11).

If the Destination Point Code is a cluster route with the format x.0.0, the default 
mask is 7.0.0 (or 3).

• NTT and TTC networks using the default 16-bit point code format, the default 
mask is 31.15.127 (or 16).

If the Destination Point Code is a network route with the format x.x.0, the default 
mask is 31.15.0 (or 9).

If the Destination Point Code is a cluster route with the format x.0.0, the default 
mask is 31.0.0 (or 5).

To edit the mask, make the changes in this field.

Column or 
Button Description
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Mask
(continued)

If you enter a new mask, the binary conversion of the mask cannot contain ones (1) 
to the right of zeros (0). For example:

• 7.255.7 is a valid mask because it converts to binary 111.11111111.111.

• 7.255.1 is not a valid mask because it converts to binary 111.11111111.001.

If you enter an invalid mask, such as 7.255.1, a message appears to that effect at the 
bottom of the Route Table dialog box, and performs one of these actions. If you:

• Modified an existing mask, the MWTM restores the previous mask.

• Entered an entirely new mask, the MWTM leaves this field blank.

If you enter a new mask that is more restrictive than the destination point code, the 
MWTM asks if you want to adjust the point code automatically based on the new 
mask. Click:

• Yes if you want to adjust the point code. For example, if the point code is 7.7.7, 
and you enter the new mask 7.255.0, the MWTM automatically adjusts the point 
code to 7.7.0.

• No if you do not want to adjust the point code. If you:

– Modified an existing mask, the MWTM restores the previous mask.

– Entered an entirely new mask, the MWTM leaves this field blank.

If the MWTM is displaying point code masks in dotted-decimal format and you enter 
a number of bits, the MWTM automatically converts the number of bits to 
dotted-decimal format. For example, if you enter 24, the MWTM automatically 
converts the mask to 255.255.255.

If the MWTM is displaying point code masks in bits format and you enter a mask in 
dotted-decimal format, the MWTM automatically converts the mask to a number of 
bits. For example, if you enter 255.255.255, the MWTM automatically converts the 
mask to 24.

Cost Cost of the route to the destination, relative to other routes. Select a cost from the 
drop-down list box. The valid costs range from 1 (lowest cost and highest priority) 
through 9 (highest cost and lowest priority).

Note If you configure two routes to the same node and do not specify a cost for one 
of them, then the cost for that node defaults automatically to 5. The default 
cost appears here in the Cost column, and in the output of the show cs7 route 
command.

Similarly, if you add a new line to this table and leave the Cost column blank, 
the MWTM automatically enters a default cost of 5.

Linksets with the same cost form a combined linkset. Do not specify more 
than two linksets with the same cost, under the same destination point code 
and mask.

If the Destination Point Code is an adjacent point code, the default Cost is 1.

Destination 
Linkset

Destination linkset associated with the destination point code. The destination linkset 
is also called the output linkset. To edit the destination linkset, select a destination 
linkset from the drop-down list box. None is the default setting.

Column or 
Button Description
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Loading an Existing Route Table File
You use the MWTM to load a specific route table file and change the list of route table files. To load an 
existing route table file, use one of these procedures. Choose:

• File > Load from Archive from the route table menu. The Load Route Table from Archive wizard 
appears (Figure 13-3). For details, see Opening a Route Table File from an Archive, page 13-4.

• File > Load from Signaling Point from the route table menu. The Choose Signaling Point dialog 
box appears (Figure 13-2). For details, see Opening a Route Table File from a Node, page 13-3. In 
the Signaling Point List drop-down list box, select the signaling point with the point code, variant, 
and network name that matches the route table file that you want to edit, then click OK. The MWTM 
reads the active route table from the ITP and shows it in the Route Table dialog box (Figure 13-4). 
For details, see Editing ITP Route Tables, page 13-6.

• File > Load from File from the route table menu. The Load File dialog: Route Table file list appears 
(Figure 13-5).

QoS Quality of service (QoS) class of the route, that the network administrator configured. 
To edit the QoS class of the route, select a QoS class from the drop-down list box. 
Valid QoS classes range from 1 through 7. Select ALL if you want the route to accept 
all QoS classes. ALL is the default value.

When you change the QoS class for a route, the MWTM automatically changes the 
QoS classes for all other routes in that route set (that is, all other routes with the same 
Destination Point Code) to the new class.

Sort Table Sorts the entries in the route table field-by-field, beginning with Dest. Point Code, 
then Mask, Cost, Dest.Linkset, and finally QoS.

Add Entry Scrolls to a blank row in the route table and selects the Destination Point Code field. 
Fill in the field with the destination point code for the new route, then fill in the rest 
of the fields in the row.

Delete Entry Deletes one or more selected rows from the table. The Confirm Deletion dialog box 
appears. To:

• Delete the selected rows, click Yes. The rows are deleted from the table and the 
Confirm Deletion dialog box closes.

• Retain the selected rows, click No. The rows are kept in the table and the Confirm 
Deletion dialog box closes.

• Prevent MWTM from displaying the Confirm Deletion dialog box, check the Do 
not show this again check box.

Note If you check the Do not show this again check box, and you later decide you 
want MWTM to begin displaying the Confirm Deletion dialog box again, you 
must check the Confirm Deletions check box in the General GUI settings in 
the Preferences window. For more information, see the description of the 
Confirm Deletions check box in Startup/Exit Settings, page 5-4.

If you have implemented MWTM User-Based Access, this option is available to users 
with authentication level Network Administrator (level 4) and higher.

Column or 
Button Description
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Figure 13-5 Load File Dialog: Route Table File List

Deploying a Route Table File
You use the Deployment wizard to validate a route table file, upload it to an ITP, archive the file, and 
activate it on the ITP. To launch the Deployment wizard for a route table file, choose File > Deploy from 
the from the route table menu (see Deploying ITP Files, page 5-35).

Field, Button, or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the route table file or folder.

Last Modified Date and time the route table file or folder was last modified.

Size (bytes) Size of the route table file or folder, in bytes.

Number of Files
(visible in bottom left corner)

Total number of route table files and folders.

OK Loads the selected route table file, saves any changes you made to 
the list of files, and closes the dialog box.

To load a route table file, double-click it in the list, select it in the 
list and click OK; or, enter the name of the file and click OK. The 
MWTM loads the route table file, saves any changes you made to 
the list of files, closes the Load File dialog: Route Table file list, 
and returns to the Route Table dialog box.

Delete Deletes the selected file from the route table file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without loading a route table file or saving 
any changes to the route table file list.

Help Shows online help for the dialog box.
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Saving a Route Table File
You use the MWTM to save a specific route table file and change the list of route table files.

Use one of these procedures. To save the changes you made to the route table file:

• Without changing the name of the file, choose File > Save from the route table menu.

• With a new name, choose File > Save As from the route table menu. The Save File dialog: Route 
Table file list dialog box appears (Figure 13-6).

The MWTM stores the modified route table file in the route table file directory on the MWTM server. If 
you installed the MWTM in:

• The default directory, /opt, then the MWTM route table file directory is /opt/CSCOsgm/routes.

• A different directory, then the MWTM route table file directory resides in that directory.

You can use the mwtm routedir command to change the directory in which the MWTM stores ITP route 
table files (see mwtm routedir, page B-102).

Note If another user modifies and saves the route table file before you save your changes, the MWTM asks if 
you want to overwrite that user’s changes. If you do, the other user’s changes are overwritten and lost. 
If you do not, your changes are lost, unless you save the route table file to a different filename.

Figure 13-6 Save File Dialog: Route Table File List Dialog

Field, Button, or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the route table file or folder.

Last Modified Date and time the route table file or folder was last modified.

Size (bytes) Size of the route table file or folder, in bytes.
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Reverting to the Last Saved Route Table File
To revert to the last saved version of the route table file, choose File > Revert from the route table menu. 
The MWTM shows the last saved version of the file.

Filename Name by which you want to save the route table file.

If you create a new route table filename, you can use any letters, 
numbers, or characters in the name that your operating system 
allows. However, if you include any spaces in the new name, the 
MWTM converts those spaces to dashes. For example, the 
MWTM saves file a b c as a-b-c.

Number of Files
(visible in bottom left corner)

Total number of route table files and folders.

OK Saves any changes you made to the route table file being edited 
and any changes you made to the list of files and closes the dialog 
box.

To save the route table file with a new name, use one of these 
procedures. To save the file with:

• A completely new name, enter the new name and click OK.

• An existing name, overwriting an old route table file, select 
the name in the list and click OK.

The MWTM saves the route table file with the new name, saves 
any changes you made to the list of files, closes the Save File 
dialog: Route Table file list dialog box, and returns to the Route 
Table dialog box.

If two or more entries in the route table have the same Destination 
Point Code, Mask, and Cost, the MWTM preserves the order of 
the entries when you save the route table.

Delete Deletes the selected file from the route table file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without saving the route table file or saving 
any changes to the route table file list.

Help Shows online help for the dialog box.

Field, Button, or Icon Description
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Editing a Non-MWTM ITP Route Table
You use the MWTM to create and edit ITP route table files for an ITP (see Editing an MWTM ITP Route 
Table File, page 13-1).

If you want to edit a route table file that was created with a product other than the MWTM, to ensure 
that the MWTM can use the file, you must:

Step 1 Ensure that the route table file uses the MWTM route table file extension, .rou.

Step 2 Place the route table file in the MWTM route table directory on the MWTM server. If you installed the 
MWTM in:

• The default directory, /opt, then the MWTM route table directory is /opt/CSCOsgm/routes.

• A different directory, then the MWTM route table directory resides in that directory.

Step 3 Ensure that the MWTM header lines in the file precede the ITP route table entries. The MWTM header 
lines use this format:

!! Created by MWTM 6.0.0
on Feb 13, 2004 6:42:54 PM
!! Do not edit this file by hand.
!v4.1.0
!ted220dbc4a
!p2851:ITU:National:[net0]

where:

• Comment lines begin with double exclamation points (!!).

• The version line begins with !v. This line indicates the version of MWTM that was used to create 
the file.

• The timestamp line begins with !t. This line indicates the date and time, in hexadecimal, that the file 
was created.

• The point code line begins with !p. This line indicates the point code that the ITP used, in 
hexadecimal, followed by the point code variant (ANSI, China, ITU, NTT, or TTC), the network 
indicator (National, NationalSpare, International, or InternationalSpare), and the network name. In 
this example:

!p8b0:ITU:National:[net0]

the point code is 1.22.0, the point code variant is ITU, the network indicator is National, and the 
network name is net0.
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Editing an ITP Global Title Translation Table

You can use the Global Title Translation (GTT) Editor of the Cisco Mobile Wireless Transport Manager 
(MWTM) to configure GTT entries.

A global title is an application address, such as a toll-free telephone number, calling card number, or 
mobile subscriber identification number. GTT is the process by which the Signaling Connection Control 
Part (SCCP) translates a global title into the point code and subsystem number (SSN) of the destination 
service switching point (SSP), where higher-layer protocol processing occurs. GTT entries reside in 
GTT files, which are comma-separated value (CSV) text files with point codes written in hexadecimal 
notation.

Note The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 4.1, 4.2. or 4.3. You can load 
GTT files that use lower or higher file-format versions; but, fields or features that are unique to the lower 
or higher version are not visible and they disappear from the GTT file the next time you save the file. 
The file is saved as a version 3.1 file if the file is lower than version 3.1; or, as a version 4.3 file if the 
file is higher than version 4.3.

For more detailed information about GTT, including configuration procedures and scenarios, see the 
IP Transfer Point (ITP) feature module for Cisco IOS software release 12.2(25)SW4 or later.

This chapter contains:

• Launching the GTT Editor, page 14-2

• Editing a GTT Table, page 14-16

• Adding a Selector to a Selector Table, page 14-17

• Adding a GTA Entry to a GTT, page 14-18

• Searching the GTA Table for GTA Digits, page 14-21

• Adding an Application Group Entry to an App Group Table, page 14-23

• Adding a MAP Entry to a GTT, page 14-25

• Adding a CPC List to a GTT, page 14-27

• Adding a GTT Address Conversion Table, page 14-28

• Adding an Entry to a GTT Conversion Table Entry, page 14-30

• Deleting Rows from a Table, page 14-31

• Creating a New GTT File, page 14-32

• Loading an Existing GTT File, page 14-33
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• Loading a GTT File from a Node, page 14-35

• Loading a GTT File from the Archive, page 14-37

• Displaying the Progress Dialog Box, page 14-38

• Checking the Semantics of a GTT File, page 14-39

• Deploying a GTT File, page 14-40

• Displaying Basic Information About a GTT File, page 14-41

• Supporting Cross-Instance GTT Files, page 14-42

• Saving a GTT File, page 14-46

• Reverting to the Last Saved GTT File, page 14-48

Launching the GTT Editor
The MWTM provides you with a GTT Editor to edit GTT files. The GTT Editor runs as a separate 
application in the MWTM; so, it requires a separate login, just like the MWTM client.

To launch the GTT Editor, use one of these procedures:

• Choose Tools > Global Title Translator Editor from the MWTM main menu.

• Enter the mwtm gttclient command (see mwtm gttclient, page B-86).

The Startup Options dialog box appears, which you use to load a specific GTT file or create a new GTT 
file.

The Startup Options dialog box provides options to load GTT data from:

When you close the Startup Options dialog box by creating a new GTT file or loading an existing GTT 
file, the GTT Editor window appears with the Selectors and GTA tab clicked.

Field or Button Description

New File Opens the Create New Table dialog box, which you use to create a new GTT 
file (see Creating a New GTT File, page 14-32). Create the new GTT file.

File Opens the Load File dialog box: GTT File List, which you use to load a 
specific GTT file and change the list of GTT files (see Loading an Existing 
GTT File, page 14-33). Select a GTT file to load.

ITP Opens the Load GTT from ITP wizard, which you use to choose the node and 
signaling point whose GTT file you want to edit (see Loading a GTT File 
from a Node, page 14-35).

Archive Opens the Load GTT from Archive wizard, which you use to choose the node 
and signaling point whose GTT file you want to edit (see Loading a GTT File 
from the Archive, page 14-37). 
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Figure 14-1 GTT Editor—Selectors and GTA Tab

The GTT Editor window provides a set of tabs. Each tab contains a series of tables with GTT data. Some 
of the tables may be blank at first, while others contain rows of data.

In each table, you can edit the values in each row by typing over the current value or selecting a new 
value from a drop-down list box.

To reset a cell to its previous value, press Esc. (If you have edited more than one cell in a row, pressing 
Esc resets all cells in the row.) To save your changes, click outside the row. Once you save your changes, 
pressing Esc does not reset the cells in the row.

To add a row to a table, select the table, then choose Edit > Add from the GTT menu or Add from the 
right-click menu.

To delete one or more rows from a table, select the rows, then choose Edit > Delete from the GTT menu 
or Delete from the right-click menu (see Deleting Rows from a Table, page 14-31).

The GTT Editor window contains:

• GTT Menu, page 14-4

• GTT Editor: Selectors and GTA Tab, page 14-6

• GTT Editor: App Group Tab, page 14-10

• GTT Editor: MAPs Tab, page 14-11

• GTT Editor: CPC Tab, page 14-12

• GTT Editor: Address Conversion Tab, page 14-13
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GTT Menu
The menu on the GTT Editor window contains:

Menu Command Description

File > New Table
(Ctrl-N)

Opens the Create New Table dialog box.

File > Load > Load From 
Archive (Ctrl-H)

Opens the Load GTT from Archive wizard from which you choose 
the node and signaling point whose GTT file you want to edit (see 
Loading a GTT File from the Archive, page 14-37). 

If you have implemented MWTM User-Based Access, this option is 
available to users with authentication level Network Operator (level 
3) and higher.

File > Load > Load From File
(Ctrl-L)

Loads an already existing GTT file. The MWTM prompts you for 
the name of the GTT file you want to load:

• Enter the name of the GTT file; or, choose the file from the list, 
then click OK to load the GTT file. 

• Click Cancel to close the prompt window without loading a 
GTT file.

See Loading an Existing GTT File, page 14-33.

File > Load > Load From ITP
(Ctrl-T)

Opens the Load GTT from ITP wizard, which you use to choose the 
node and signaling point whose GTT file you want to edit (see 
Loading a GTT File from a Node, page 14-35).

If you implement MWTM User-Based Access, this option is 
available to users with authentication level Network Operator (level 
3) and higher.

File > Revert
(Ctrl-R)

Reverts to the last saved version of the GTT file.

File > Save
(Ctrl-S)

Saves the changes you made to the GTT file.

File > Save As Opens the Save File dialog box: GTT File List, which you use to 
save the GTT file with a new name or overwrite an existing GTT 
file.

File > Semantic Check
(Ctrl-K)

Opens the Semantic Check GTT dialog box, which you use to check 
the semantics of a GTT file against a specific ITP.

File > Deploy
(Ctrl-Y)

Opens the Deployment wizard, which you use to validate a GTT 
file, upload it to an ITP, and activate it on the ITP.
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File > Exit
(Ctrl-Q)

Closes the GTT Editor window. If you make any changes to the GTT 
file, the MWTM asks if you want to save the changes before leaving 
the window. Click:

• Yes to save the changes.

The MWTM opens the Save File dialog box: GTT File List, 
which you use to save the GTT file with a new name, or 
overwrite an existing GTT file.

• No to close the prompt window.

The MWTM closes the GTT Editor window without saving any 
changes to the GTT file.

Edit > Version and Instance
(Ctrl-I)

Opens the Edit GTT Table dialog box, which you use to change the 
variant, version, and instance number of a GTT file.

Edit > Add
(Ctrl-E)

Opens the Add dialog box for the selected table.

For example, if you click the Selector Table, opens the Selector Add 
dialog box.

Edit > Delete
(Ctrl-Delete)

Deletes one or more selected rows from a GTT table. The Confirm 
Delete dialog box appears, in which you confirm the deletion. To:

• Delete the selected rows, click Yes. The rows disappear from 
the table and the Confirm Delete dialog box closes.

• Retain the selected rows, click No. The rows remain in the table 
and the Confirm Delete dialog box closes.

You can select more than one row to delete; but, all selected rows 
must reside in the same table. For example, you cannot 
simultaneously delete rows from the Selector Table and the MAP 
(mated application) Table.

If deleting a row from a table causes one or more rows in the table 
to remain at the top of the page or the bottom of the next, such that 
no remaining entries reference the single rows, the MWTM shows 
the number of single rows and asks whether you also want to delete 
the single rows. (The MWTM shows the number of rows and not the 
rows themselves; because, a document could contain thousands of 
single rows.)

Edit > Node Archive 
Management

Opens the Archive Management dialog box, which you use to 
manage archived GTT, route table, and MLR address table files.

If you have implemented MWTM User-Based Access, this option is 
available to users with authentication level Network Administrator 
(level 4) and higher.

Edit > Node File Management Opens the Node File Management dialog box, which you use to 
manage GTT files and route table files.

If you implement MWTM User-Based Access, this option is 
available to users with authentication level Network Administrator 
(level 4) and higher.

Menu Command Description
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GTT Editor: Selectors and GTA Tab
Click the Selectors and GTA tab to display data for a specific GTT selector and see the GTA entries for 
that selector.

A GTT selector defines the parameters that select the translation table that the MWTM uses to translate 
an SCCP message to its next or final destination.

A Global Title Address (GTA) entry is associated with a selector and defines the result of a translation 
for a particular address mask. The result of a GTA entry can be a final translation or an intermediate 
translation.

The GTT Editor: Selectors and GTA tab contains:

• Selector Table, page 14-7

• GTA Table, page 14-8

• App Group Table, page 14-8

• MAP Table, page 14-9

• CPC List, page 14-10

When you click the GTT Editor: Selectors and GTA tab, the MWTM might populate the Selector Table 
and the other tables with data. To populate the:

• Selector Table, right-click in the table and choose Add. See Adding a Selector to a Selector Table, 
page 14-17.

• GTA Table, select a row in the Selector Table. The MWTM populates the GTA Table with all 
associated GTA entries.

If the GTA Table remains blank, the selected row has no associated GTA entries. You can also add 
entries to the GTA Table, by right-clicking in the table and choosing Add from the right-click menu 
(see Adding a GTA Entry to a GTT, page 14-18).

View > Phone Number Config
(Ctrl-P)

Opens the Phone Number Lookup dialog box in which you search 
the GTA Table for the Global Title Address Digits for a specific 
selector.

View > GTT Table Info
(Ctrl-G)

Opens the GTT Table Info dialog box, which shows basic 
information about the currently visible GTT file.

View > Network Name 
Configuration
(Ctrl-F)

Opens the Network Name Configuration dialog box, which maps 
network names to variants and network indicators, in support of 
cross-instance GTT files.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information 
about the MWTM application.

Menu Command Description
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• App Group Table, select a row in the GTA Table that has an associated Application Group. The 
MWTM populates the App Group Table with all application group entries for that application group 
name.

You can also add entries to the App Group Table, by right-clicking in the table and choosing Add 
from the right-click menu (see Adding an Application Group Entry to an App Group Table, page 
14-23).

• MAP Table, select a row in the GTA Table that does not have an associated Application Group. The 
MWTM populates the MAP Table with all MAP entries that match the selected row's point 
code-SSN combination.

To add entries to the MAP Table, right-click in the table and choose Add from the right-click menu 
(see Adding a MAP Entry to a GTT, page 14-25).

• CPC List, select a row in the MAP Table that has an associated CPC List Name. The MWTM 
populates the CPC List with all point codes in that CPC list.

To add entries to the CPC List, right-click in the list and choose Add from the right-click menu (see 
Adding a CPC List to a GTT, page 14-27).

Selector Table

The Selector Table contains:

Column Description

Name Name of the selector.

Translation Type Translation type that the selector uses. Valid values are in the range 
0 through 255.

Global Title Indicator (China, ITU, NTT, and TTC only) Global title indicator for the selector. 
Valid values are in the range 2 and 4.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan for the selector. 
Valid values are in the range 0 through 15.

Nature of Address Indicator (China, ITU, NTT, and TTC only) Nature of address indicator for the 
selector. Valid values are in the range 0 through 127.

Pre-Address Conversion GTT address conversion table to apply prior to performing local GTT 
translation. If:

• This field contains an address conversion table name, the referenced 
table must exist and contain at least one address-conversion entry.

• This field is blank, no address conversion is necessary.

Post-Address Conversion GTT address conversion table to apply after performing local GTT 
translation. If:

• This field contains an address conversion table name, the referenced 
table must exist and contain at least one address conversion entry.

• This field is blank, no address conversion is necessary.

QoS Quality of service (QoS) class of the selector. Valid QoS classes range 
from 1 through 7. ALL indicates that the selector accepts all QoS 
classes.



 

14-8
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 14      Editing an ITP Global Title Translation Table
  Launching the GTT Editor

GTA Table

The GTA Table contains:

App Group Table

The App Group Table contains:

Column Description

Name Selector name for this GTA.

Global Title Address Digits Address digits for the GTA.superuser

Point Code Destination point code for the GTA.

Routing Indicator Routing indicator for the GTA. Valid values are:

• none—No routing indicator.

• gt—Route on the global title.

• pcssn—Route on the point code and SSN.

This field is dimmed if you check Configure By App Group (see Adding 
a GTA Entry to a GTT, page 14-18).

Subsystem Number Destination SSN for the GTA. Valid values are in the range 
2 through 255.

New Translation Type Translation type that the GTA uses. Valid values are in the range 
0 through 255.

Application Group Name of the application group that should provide the point code, 
routing indicator, and SSN that the GTA uses.

Application Server Name Name of the application server that should provide the point code, 
routing indicator, and SSN that the GTA uses.

QoS Quality of service (QoS) class of the GTA. Valid QoS classes range from 
1 through 7. ALL indicates that the GTA accepts all QoS classes.

Column Description

Name Name of the application group.

For ITPs with multiple instances enabled, do not use the same application 
group name in two or more different instances. For example, if you use 
application group name appgrp1 in instance 1, then do not use appgrp1 in 
instance 0, or any other instance.

Multiplicity Multiplicity setting for the application group. Valid values are:

• cgp—Use SCCP calling party address (CGPA) load sharing, if 
available. CGPA load sharing uses a weighting factor to choose the 
destination.

• cos—Use the destination with the least cost, if available.

• sha—Share equally among all destinations.
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MAP Table

The MAP Table contains:

Weight Factor or Cost If you set multiplicity to cgp, this field specifies the relative weighting 
factor of the application group. Choose a relative cost, 1 through 999, 
from the drop-down list box. The default value is 1.

If you set multiplicity to cos or sha, this field specifies the relative cost of 
the application group. Choose a relative cost, 1 through 8, from the 
drop-down list box. The default value is 1.

Point Code Destination point code for the application group.

Routing Indicator Routing indicator for the application group. Valid values are:

• none—No routing indicator.

• gt—Route on the global title. This is the default routing indicator.

• pcssn—Route on the point code and SSN.

Subsystem Number Destination SSN for the application group. Valid values are in the range 
2 through 255.

Application Server Name Name of the application server.

Network Name Network name that the application group uses.

Column Description

Column Description

Primary Pt. Code Primary point code for the MAP.

Primary SSN Primary SSN for the MAP. Valid values are in the range 2 through 255.

Multiplicity Multiplicity setting for the MAP. Valid values are:

• dom—Dominant. Always translate to the primary point-code-SSN 
combination if it is available. Translate to the backup point code-SSN 
combination only if the primary combination is not available.

• sha—Share equally between the primary point-code-SSN combination 
and the backup point-code-SSN combination.

• sol—Solitary MAP. No alternate if the point code or SSN is not 
available.

Backup Pt. Code Backup point code for the MAP.

Backup SSN Backup SSN for the MAP. Valid values are in the range 2 through 255.

Re-route if Congested Indicates whether to route the MAP to the backup point-code-SSN 
combination if the primary combination is congested. If you: 

• Check the check box, you route the MAP to the backup combination 
when the primary combination is congested.

• Uncheck the check box, you do not route the MAP to the backup.
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CPC List

The CPC List contains:

GTT Editor: App Group Tab
Click the App Group tab to display data for application groups. The App Group tab shows the same 
information as the Selectors and GTA tab; but, from the perspective of the application groups.

An application group is an alternative result for the explicit point code and SSN in a GTA entry. You can 
use an application group entry for:

• Intermediate translation.

• Load-sharing across more than two destinations.

• Load-sharing of intermediate translation.

The GTT Editor: App Group tab contains:

• App Group Table, page 14-8

• MAP Table, page 14-9

• CPC List, page 14-10

• Selector Table, page 14-7

• GTA Table, page 14-8

When you click the GTT Editor: App Group tab, the App Group Table and Selector Table might 
contain data. To:

• Add entries to the App Group Table, right-click in the table and choose Add from the right-click 
menu (see Adding an Application Group Entry to an App Group Table, page 14-23).

• Add entries to the Selector Table, right-click in the table and choose Add from the right-click menu 
(see Adding a Selector to a Selector Table, page 14-17).

• Populate the MAP Table, select a row in the App Group Table. The MAP Table contains all MAP 
entries that match the selected row's point code-SSN combination.

You can also add entries to the MAP Table, by right-clicking in the table and choosing Add from 
the right-click menu (see Adding a MAP Entry to a GTT, page 14-25).

Adjacency Indicates whether to consider a point-code-SSN combination adjacent to the 
local node for SCCP management. If you: 

• Check the check box, you do consider the point code-SSN combination 
adjacent to the local node.

• Uncheck the check box, you do not consider the point code-SSN 
combination adjacent to the local node.

CPC List Name Name of the CPC list associated with this MAP.

Column Description

Field Description

Point Code Point codes in the selected CPC list.
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• Populate the CPC List, select a row in the MAP Table that has an associated CPC List Name. The 
CPC List contains all point codes in that CPC list.

You can also add entries to the CPC List, by right-clicking in the list and choosing Add from the 
right-click menu (see Editing an ITP Global Title Translation Table, page 14-1).

• Populate the GTA Table, select a row in the Selector Table. The GTA Table contains all associated 
GTA entries.

If the GTA Table remains blank, the selected row has no associated GTA entries. You can also add 
entries to the GTA Table, by right-clicking in the table and choosing Add from the right-click menu 
(see Editing an ITP Global Title Translation Table, page 14-1).

You can also add entries to the Selector Table, by right-clicking in the list and choosing Add from 
the right-click menu (see Adding a Selector to a Selector Table, page 14-17).

GTT Editor: MAPs Tab
Click the MAPs tab if you are primarily interested in displaying data for MAPs. The MAPs tab shows 
the same information as the Selectors and GTA tab, but from the perspective of the MAPs.

A mated application (MAP) entry has two uses:

• The SCCP application uses MAP entries internally to track point code states and SSN states, such 
as congestion and availability.

• To define backups or alternates for point code-SSN combination.

The GTT Editor: Maps tab contains:

• MAP Table, page 14-9

• CPC List, page 14-10

• Selector Table, page 14-7

• GTA Table, page 14-8

• App Group Table, page 14-8

When you launch the GTT Editor: MAPs tab, the MAP Table and Selector Table might or might not be 
populated with data. To: 

• Add entries to the MAP Table, right-click in the table and choose Add from the right-click menu 
(see Adding a MAP Entry to a GTT, page 14-25).

• Add entries to the Selector Table, right-click in the table and choose Add from the right-click menu 
(see Adding a Selector to a Selector Table, page 14-17).
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• Populate the CPC List, select a row in the MAP Table that has an associated CPC List Name. The 
CPC List contains all point codes in that CPC list.

You can also add entries to the CPC List, by right-clicking in the list and choosing Add from the 
right-click menu (see Editing an ITP Global Title Translation Table, page 14-1).

• Populate the App Group Table and GTA Table, select a row in the MAP Table. The App Group Table 
and GTA Table contain all application group and GTA entries that match the selected row's point 
code-SSN combination.

If the App Group Table or GTA Table remains blank, the selected row has no associated application 
group or GTA entries.

You can add entries to the App Group Table, by right-clicking in the table and choosing Add from 
the right-click menu (see Adding an Application Group Entry to an App Group Table, page 14-23).

You can add entries to the GTA Table, by right-clicking in the table and choosing Add from the 
right-click menu (see Editing an ITP Global Title Translation Table, page 14-1).

GTT Editor: CPC Tab
A concerned point code (CPC) is a node that should be notified when the status of the associated SSN 
changes.

Click the CPC tab if you are primarily interested in displaying data for concerned point code names. The 
CPC tab appears.

Figure 14-2 GTT Editor, Showing CPC Tab

The GTT Editor: CPC tab contains:

• Concerned Pt. Code Name List, page 14-13

• CPC List, page 14-10

• MAP Table, page 14-9

When you launch the GTT Editor: CPC tab, the Concerned Pt. Code Name List contains data. To 
populate the CPC List and MAP Table, select a row in the Concerned Pt. Code Name List. The CPC List 
and MAP Table contain all point codes and MAP entries that match that concerned point code name.
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Concerned Pt. Code Name List

The Concerned Pt. Code Name List contains:

To copy one or more point codes from one CPC list to another, select a CPC list in the CPC List Name 
column. The MWTM shows the point codes that are associated with that CPC list in the Point Code 
column. Select one or more of the point codes and drag them to the new CPC list.

Note The MWTM copies the point codes to the new CPC list; it does not move them from the old CPC list. If 
you want to move the point codes, you must copy them to the new CPC list, then delete them from the 
old CPC list.

GTT Editor: Address Conversion Tab
You use GTT address conversion tables to specify mappings such as E.212-to-E.214 address conversion 
and E.212-to-E.164 address conversion in ITU networks.

Click the Address Conversion tab to display GTT address conversion tables. The Address Conversion 
tab appears.

Figure 14-3 GTT Editor, Showing Address Conversion Tab

The GTT Editor: Address Conversion tab contains:

• Address Conversion Table, page 14-14

• Conversion Entry Table, page 14-14

• Selector Table for Address Conversion, page 14-15

Field Description

CPC List Name Name of the CPC list to add. Enter an alphanumeric string between 1 
and 12 characters.

CPC List List of point codes associated with the entered CPC list name.
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Address Conversion Table

The Address Conversion Table contains:

Conversion Entry Table

The Conversion Entry Table contains:

Field Description

Name Name of the GTT address conversion table. Enter a 1- to 
12-character name.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan associated with 
the address conversion table. For all addresses that are converted, 
the numbering plan is converted to the value of this field.

The valid range is 0 to 15.

Nature of Address Indicator (China, ITU, NTT, and TTC only) Nature of address indicator 
associated with the address conversion table. For all addresses that 
are converted, the nature of address indicator is converted to the 
value of this field.

The valid range is 0 to 127.

Field Description

In Address Input SCCP address entry. Enter an address as a 1- to 15-digit 
hexadecimal string.

Out Address Output SCCP address entry. Enter an address as a 1- to 15-digit 
hexadecimal string.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan associated with 
this entry in the address conversion table. If specified, the value of 
this field overrides the value of the Numbering Plan field in the 
Address Conversion Table for this entry.

The valid range is 0 to 15.

Nature of Address Indicator (China, ITU, NTT, and TTC only) Nature of address indicator 
associated with this entry in the address conversion table. If 
specified, the value of this field overrides the value of the Nature of 
Address Indicator field in the Address Conversion Table for this 
entry.

The valid range is 0 to 127.
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Selector Table for Address Conversion

The Selector Table for Address Conversion contains:

Column Description

Name Name of the selector.

Translation Type Translation type that the selector uses. Valid values are in the range 
0 through 255.

Global Title Indicator Global title indicator for the selector. Valid values are in the range 
2 and 4.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan for the selector. 
Valid values are in the range 0 through 15.

Nature of Address Indicator (China, ITU, NTT, and TTC only) Nature of address indicator for the 
selector. Valid values are in the range 0 through 127.

Pre-Address Conversion GTT address conversion table to apply prior to performing local GTT 
translation.

If this field contains an address conversion table name, the referenced 
table must exist and it must contain at least one address-conversion 
entry.

If this field is blank, no address conversion is necessary.

Post-Address Conversion GTT address conversion table to apply after performing local GTT 
translation.

If this field contains an address-conversion table name, the referenced 
table must exist and it must contain at least one address conversion entry.

If this field is blank, no address conversion is necessary.

QoS Quality of service (QoS) class of the selector. Valid QoS classes range 
from 1 through 7. ALL indicates that the selector accepts all QoS 
classes.
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Editing a GTT Table
You use the MWTM to change the variant and instance number associated with a GTT file.

To change the variant and instance number associated with a GTT file choose Edit > Version and 
Instance from the GTT menu. The Edit GTT Table dialog box appears.

Figure 14-4 Edit GTT Table Dialog Box

Field or Button Description

Variant SS7 protocol variant. You cannot edit this field.

Version Version of the file format that the GTT uses. Valid versions are:

• 3.1 (MB9, MB9a)—Corresponds to ITP software releases 12.2(4)MB9 and 
12.2(4)MB9a. Two or more entries in the same application group can have the 
same cost. This version is the default in the MWTM.

• 4.0 (MB10+)—Corresponds to ITP software release 12.2(4)MB10 or higher. 
Supports multiple instances on a single node.

• 4.1 (12.2(20)SW+)—Corresponds to ITP software release 12.2(20)SW or 
higher. Supports multiple instances on a single node.

• 4.2 (12.2(21)SW1+)—Corresponds to ITP software release 12.2(21)SW1 or 
higher. Supports subsystem numbers equal to zero (0) for GTA entries and 
application group entries.

• 4.3 (12.2(23)SW1+)—Corresponds to ITP software release 12.2(23)SW1 or 
higher. Supports latest encoding scheme (not for ANSI).

The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 4.1, 
4.2, or 4.3. You can load GTT files that use lower or higher file format versions; 
but, fields or features that are unique to the lower or higher version are not visible 
and they disappear from the GTT file the next time you save. The MWTM 
automatically saves the file as a version 3.1 file if the file is lower than version 3.1; 
or, as a version 4.3 file if the file is higher than version 4.3.

Instance Number Number of the instance that the GTT uses. Valid IDs are 0 to 7. The default instance 
number is 0.

This list box is available only if you choose version 4.0.
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Adding a Selector to a Selector Table
You use the MWTM to add a selector to a GTT. A GTT selector defines the parameters that select the 
translation table used to translate an SCCP message to its next or final destination.

To add a new selector to a Selector Table, choose a Selector Table in the GTT Editor window, then use 
one of these procedures. From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The Selector Add dialog box appears.

Figure 14-5 Selector Add Dialog Box

Network Name Network name that the GTT uses.

If you change the network name for an existing GTT file, the new network name 
must use the same variant.

This field is available only if you choose version 4.1 or higher.

OK Saves the changes to the GTT file.

Enter or choose values for the new variant and instance number, then click OK. The 
MWTM saves your changes to the GTT file.

Cancel Closes the Edit GTT Table dialog box without saving any changes to the GTT file.

To close the Edit GTT Table dialog box at any time without saving any changes to 
the GTT file, click Cancel.

Help Shows online help for the current window.

Field or Button Description

Field or Button Description

Selector Name Name of the selector to add. Enter 1- to 12-character alphanumeric string.

Translation Type Translation type that the selector uses. Enter a value in the range 
0 through 255.
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Adding a GTA Entry to a GTT
You use the MWTM to add a Global Title Address (GTA) entry to a GTT. A GTA entry is associated 
with a selector and defines the result of a translation for a particular address mask. The result of a GTA 
entry can be a final translation or an intermediate translation.

Global Title Indicator (China, ITU, NTT, and TTC only) Global title indicator for the selector. 
Choose a value from the drop-down list box. Valid values are:

• 2

• 4

The default value is 4.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan for the selector. Enter 
a value in the range 0 through 15.

This field is dimmed if Global Title Indicator is set to 2.

Nature of Addr. Indicator (China, ITU, NTT, and TTC only) Nature of address indicator for the 
selector. Enter a value in the range 0 through 127.

This field is dimmed if Global Title Indicator is set to 2.

Pre-Conversion Table 
Name

GTT address conversion table to apply prior to performing local GTT 
translation.

If this field contains an address conversion table name, the referenced 
table must exist and it must contain at least one address conversion entry.

If this field is blank, no address conversion is necessary.

Post-Conversion Table 
Name

GTT address conversion table to apply after performing local GTT 
translation.

If this field contains an address conversion table name, the referenced 
table must exist and it must contain at least one address conversion entry.

If this field is blank, no address conversion is necessary.

QoS Quality of service (QoS) class of the selector. Choose a value from the 
drop-down list box. Valid QoS classes range from 1 through 7. Choose 
ALL if you want the selector to accept all QoS classes. The default value 
is ALL.

Add Adds the selector to the GTT.

Enter or choose values for the new selector, then click Add. The MWTM 
adds the selector to the Selector Table.

Close Closes the Selector Add dialog box.

When you finish adding selectors, click Close.

Help Shows online help for the current window.

Field or Button Description
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To add a new GTA entry to a GTA Table, choose a selector in the GTT Editor window and a GTA Table; 
then, use one of these procedures. 

From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The GTA Add dialog box appears.

Figure 14-6 GTA Add Dialog Box

Field Description

Selector Name Name of the selector associated with this GTA. You cannot edit this 
field.

Global Title Addr. Digits Address digits for the GTA. Enter a 1- to 15-digit hexadecimal string.

QoS Quality of service (QoS) class of the GTA. Choose a value from the 
drop-down list box. Valid QoS classes range from 1 through 7. Choose 
ALL if you want the GTA to accept all QoS classes. The default value 
is ALL.

Configure By Point Code Indicates whether to configure the GTA by point code. To configure the 
GTA by point code, click this radio button.

The MWTM makes the Config By Point Code fields available, and dims 
the Config By App Group fields. This is the default setting.
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Configure By App Group Indicates whether to configure the GTA by application group. To 
configure the GTA by application group, click this radio button.

The MWTM makes the Config By App Group fields available and, dims 
the Config By Point Code fields.

Configure By Application 
Server Name

Indicates whether to configure the GTA by application server name. To 
configure the GTA by application server name, click this radio button.

The MWTM replaces the Config By Point Code fields with the Config 
By Application Server name fields, and dims the Config By App Group 
fields.

Point Code Destination point code for the GTA. Enter a point code.

This field is available only if you choose Configure By Point Code.

Routing Indicator Routing indicator for the GTA. Choose a value from the drop-down list 
box. Valid values are:

• gt—Route on the global title. This is the default routing indicator.

• pcssn—Route on the point code and SSN.

This field is available only if you chose Configure By Point Code or 
Configure By Application Server Name.

Subsystem Number Destination SSN for the GTA. Enter a value in the range 2 through 255.

This field is mutually exclusive with the New Translation Type field.

This field is available only if you chose Configure By Point Code or 
Configure By Application Server Name.

New Translation Type Translation type that the GTA uses. Enter a value in the range 
0 through 255.

This field is mutually exclusive with the Subsystem Number field.

This field is available only if you chose Configure By Point Code or 
Configure By Application Server Name.

App. Group Name of the application group that should provide the point code, 
routing indicator, and SSN that the GTA uses. Enter the name of an 
application group.

This field is available only if Configure By App Group is checked (see 
Adding a GTA Entry to a GTT, page 14-18).

Application Server Name Name of the application server that should provide the point code, 
routing indicator, and SSN that the GTA uses. Enter the name of an 
application server.

This field is available only if you chose Configure By Application 
Server Name.

Add Adds the GTA to the GTT.

Enter or choose values for the new GTA entry, then click Add. The 
MWTM adds the GTA entry to the GTA Table.

Field Description
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Searching the GTA Table for GTA Digits
You use the MWTM to search the GTA Table for the Global Title Address Digits for a specific selector. 
The MWTM shows the entries that contain the GTA digits in the GTA Table.

To search the GTA Table, click the Selectors and GTA tab in the GTT Editor window, then choose 
View > Phone Number Config from the GTT menu. The Phone Number Lookup dialog box appears.

Figure 14-7 Phone Number Lookup Dialog Box

Close Closes the GTA Add dialog box.

When you finish adding GTA entries, click Close to close the GTA Add 
dialog box.

Help Shows online help for the current window.

Field Description
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Table, Field, or 
Button Description

Selector Table Selector Table associated with the GTA Table to search. Choose one or more 
Selector Tables.

For descriptions of the fields in this table, see Selector Table, page 14-7.

Phone Number GTA digits to search for in the GTA Table.

Choose a Selector Table and enter a telephone number or prefix as a 1- to 15-digit 
hexadecimal string with no spaces, dashes, or other special characters.

For example, to search for a specific telephone number, such as 919-555-6384, 
enter 9195556384. To search for all entries that begin with the 919-555 telephone 
prefix, enter 919555.

Perform Lookup Launches the search for the GTA digits. If:

• It finds one or more matching entries, shows the entries that contain the GTA 
digits in the GTA Table.

• The Selector Table being searched performs pre-address conversion, the 
converted address, numbering plan, and nature of address indicator are 
visible in the Pre-Address Conversion Results field.

• The Selector Table being searched performs post-address conversion, the 
converted address, numbering plan, and nature of address indicator are 
visible in the Post-Address Conversion Results field.

• It does not find matching entries or the Selector Table has no associated GTA 
Table, an error message appears at the bottom of the window:

Could not find GTA for selector and phone number

Pre-Address 
Conversion Entry 
Used

Entry in the GTT address conversion table used for pre-address conversion, if the 
Selector Table being searched performs pre-address conversion.

For China, ITU, NTT, and TTC variants, pre-address conversion might result in 
a numbering plan or nature of address indicator that is different from the selected 
Selector Table. If this occurs, the MWTM searches for a selector in the Selector 
Table that matches the new numbering plan and nature of address indicator. If the 
MWTM:

• Finds a matching selector, it uses that selector to complete the search.

• Does not find a matching selector, the search fails.

Pre-Address 
Conversion Results

Results of the pre-address conversion (converted address, numbering plan, and 
nature of address indicator), if the Selector Table being searched performs 
pre-address conversion.

Selector Entry Used Selector Entry that was searched.

For descriptions of the fields in this table, see Selector Table, page 14-7.

GTA Entry Found GTA Table in which the GTA digits reside.

For descriptions of the fields in this table, see GTA Table, page 14-8.

MAP Table MAP Table, if any, associated with the GTA Table in which the GTA digits were 
found.

For descriptions of the fields in this table, see MAP Table, page 14-9.
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Related Topic:

Launching the GTT Editor, page 14-2

Adding an Application Group Entry to an App Group Table
You use the MWTM to add an application group to a GTT. An application group is an alternative result 
for the explicit point code and SSN in a GTA entry. You can use an application group entry for:

• Intermediate translation.

• Load-sharing across more than two destinations.

• Load-sharing of intermediate translation.

To add an application group to a GTT, choose an App Group Table in the GTT Editor window, then use 
one of these procedures. 

From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The App Group Add dialog box appears.

CPC List CPC List, if any, associated with the GTA Table in which the GTA digits reside.

For descriptions of the fields in this list, see CPC List, page 14-10.

Post-Address 
Conversion Entry 
Used

Entry in the GTT address conversion table used for post-address conversion, if 
the Selector Table being searched performs post-address conversion.

Post-Address 
Conversion Results

Results of the post-address conversion (converted address, numbering plan, and 
nature of address indicator), if the Selector Table being searched performs 
post-address conversion.

Table, Field, or 
Button Description
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Figure 14-8 App Group Add Dialog Box

Field or Button Description

App. Group Name of the application group to add. Enter 1- to 12-character 
alphanumeric string.

Multiplicity Multiplicity setting for the application group. Choose a value from the 
drop-down list box. Valid values are:

• cos—Use the destination with the least cost, if available.

• sha—Share equally between all destinations. This is the default value.

Weight Factor or Cost If Multiplicity is set to cgp, this field specifies the relative weighting factor 
of the application group. Choose a relative cost, 1 through 999, from the 
drop-down list box. The default value is 1.

If Multiplicity is set to cos or sha, this field specifies the relative cost of 
the application group. Choose a relative cost, 1 through 8, from the 
drop-down list box. The default value is 1.

Point Code Destination point code for the application group. Click this radio button 
and enter a point code. This field is mutually exclusive with the 
Application Server Name field.

Application Server Name Name of the application server. Click this radio button and enter an 
application server name. This field is mutually exclusive with the Point 
Code field.

Routing Indicator Routing indicator for the application group. Choose a value from the 
drop-down list box.

Network Name Network name that the application group uses. Choose a network name 
from the drop-down list box.

Subsystem Number Destination SSN for the application group. Enter a value in the range 
2 through 255.
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Adding a MAP Entry to a GTT
You use the MWTM to add a mated application (MAP) entry to a GTT. 

A MAP entry has two purposes:

• The SCCP application uses them internally to track point-code states and SSN states, such as 
congestion and availability.

• To define backups or alternates for point-code-SSN combination.

To add a MAP entry, choose a MAP Table in the GTT Editor window, then use one of these procedures. 

From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

(Optional) To add a new MAP entry to a MAP Table, choose a MAP Table, then use one of these 
procedures. 

From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The MAP Add dialog box appears.

Add Adds the application group to the GTT.

Enter or choose values for the new application group entry, then click Add. 
The MWTM adds the application group entry to the App Group Table.

Close Closes the App Group Add dialog box.

When you finish adding application group entries, click Close to close the 
App Group Add dialog box.

Help Shows online help for the current window.

Field or Button Description
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Figure 14-9 MAP Add Dialog Box

Field or Button Description

Primary Pt. Code Primary point code for the MAP. Enter a point code.

Primary SSN Primary SSN for the MAP. Enter a value in the range 2 through 255.

Multiplicity Multiplicity setting for the MAP. Choose a value from the drop-down list 
box. Valid values are:

• dom—Dominant. Always translate to the primary point-code-SSN 
combination if it is available. Translate to the backup point-code-SSN 
combination only if the primary combination is not available.

• sha—Share equally between the primary point-code-SSN combination 
and the backup point code-SSN combination. This is the default value.

• sol—Solitary MAP. No alternate if the point code or SSN is not 
available.

Backup Pt. Code Backup point code for the MAP. Enter a point code.

Backup SSN Backup SSN for the MAP. Enter an a value in the range 2 through 255.

CPC List Name Name of the CPC list to be associated with this MAP. Enter a CPC list name.

Re-route if Congested Indicates whether the MAP should be routed to the backup point code-SSN 
combination if the primary combination is congested. If you:

• Want to route the MAP to the backup combination when the primary 
combination is congested, check the check box.

• Do not want to route the MAP to the backup, uncheck the check box. 
This is the default setting.
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Adding a CPC List to a GTT
You use the MWTM to add a new concerned point code (CPC) list to a GTT. A CPC is a node that should 
be notified when the status of the associated SSN changes.

To add a new CPC list, choose a Concerned Pt. Code Name List or a CPC List in the GTT Editor window, 
then use one of these procedures. From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The CPC Add dialog box appears.

Adjacency Indicates whether a point code-SSN combination should be considered 
adjacent to the local node for SCCP management. If you:

• Want the point code-SSN combination be considered adjacent to the 
local node, check the check box.

• Do not want the point code-SSN combination be considered adjacent to 
the local node, uncheck the check box. This is the default setting.

Add Adds the MAP to the GTT.

Enter or choose values for the new MAP entry, then click Add. The MWTM 
adds the MAP entry to the MAP Table.

Close Closes the MAP Add dialog box.

When you finish adding MAP entries, click Close to close the MAP Add 
dialog box.

Help Shows online help for the current window.

Field or Button Description
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Figure 14-10 CPC Add Dialog Box

Adding a GTT Address Conversion Table
You use the MWTM to add a new address conversion table to a GTT. To do so, choose an Address 
Conversion Table in the GTT Editor window, then use one of these procedures. From the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The Address Conversion Add dialog for a Table window appears.

Field or Button Description

CPC List Name Name of the CPC list to be added. Enter 1- to 12-character alphanumeric 
string.

Concerned Pt. Code List One or more CPCs to be added to the new CPC list. Enter one or more 
CPCs, separated by spaces.

Add Adds the CPC list to the GTT.

Enter or choose values for the new CPC list, then click Add. The 
MWTM adds the CPC list to the MAP Table.

Close Closes the CPC Add dialog box.

When you finish adding CPC lists, click Close to close the CPC Add 
dialog box.

Help Shows online help for the current window.
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Figure 14-11 Address Conversion Add Dialog Box for a Table

Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Field or Button Description

Name Name of the GTT address conversion table. Enter a 1- to 12-character name.

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan associated with the 
address conversion table. For all addresses that are converted, the numbering 
plan is converted to the value of this field.

The valid range is 0 to 15.

Nature of Addr. 
Indicator

(China, ITU, NTT, and TTC only) Nature of address indicator associated 
with the address conversion table. For all addresses that are converted, the 
nature of address indicator is converted to the value of this field.

The valid range is 0 to 127.

Add Adds the address conversion table to the GTT.

Enter or choose values for the new Address Conversion Table, then click 
Add. The MWTM adds the Address Conversion Table to the GTT file.

Close Closes the Address Conversion Add dialog box for a table.

When you finish adding Address Conversion Tables, click Close to close the 
Address Conversion Add dialog box for a table.

Help Shows online help for the current window.
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Adding an Entry to a GTT Conversion Table Entry
You use the MWTM to add a new entry to a GTT Conversion Entry Table. To do so, choose a Conversion 
Entry Table in the Address Conversion tab of the GTT Editor, then use one of these procedures. From 
the:

• GTT menu, choose Edit > Add.

• Right-click menu, choose Add.

The Address Conversion Add dialog for an entry window appears.

Figure 14-12 Address Conversion Add Dialog Box for an Entry

Field or Button Description

Name Name of the GTT address conversion table. Enter a 1- to 12-character name. 
If the table name does not already exist, the MWTM creates a new address 
conversion table with this name.

Table Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan associated with the 
address conversion table. For all addresses that are converted, the numbering 
plan is converted to the value of this field.

The valid range is 0 to 15.

Table Nature of Addr. 
Indicator

(China, ITU, NTT, and TTC only) Nature of address indicator associated 
with the address conversion table. For all addresses that are converted, the 
nature of address indicator is converted to the value of this field.

The valid range is 0 to 127.

In Address Input SCCP address entry. Enter an address as a 1- to 15-digit hexadecimal 
string.

Out Address Output SCCP address entry. Enter an address as a 1- to 15-digit hexadecimal 
string.
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Deleting Rows from a Table
To delete one or more rows from a table, select the rows, then choose Edit > Delete from the GTT menu 
or Delete from the right-click menu. The Confirm Delete dialog box appears to confirm the deletion. To:

• Delete the selected rows, click Yes. The rows are deleted from the table and the Confirm Delete 
dialog box closes.

• Retain the selected rows, click No. The rows are kept in the table and the Confirm Delete dialog box 
closes.

You can select more than one row to delete, but all selected rows must be in the same table. For example, 
you cannot delete rows from both the Selector Table and the MAP Table at the same time.

If deleting a row from a table causes one or more rows in the table to remain at the top of the page or the 
bottom of the next, such that no remaining entries reference the single rows, the MWTM shows the 
number of single rows and asks whether you want to also delete the single rows. (The MWTM shows the 
number of rows and not the rows themselves, because there could be thousands of single rows.)

Numbering Plan (China, ITU, NTT, and TTC only) Numbering plan associated with this entry 
in the address conversion table. If specified, the value of this field overrides 
the value of the Numbering Plan field in the Address Conversion Table, for 
this entry.

The valid range is 0 to 15.

Nature of Address 
Indicator

(China, ITU, NTT, and TTC only) Nature of address indicator associated 
with this entry in the address conversion table. If specified, the value of this 
field overrides the value of the Nature of Address Indicator field in the 
Address Conversion Table, for this entry.

The valid range is 0 to 127.

Add Adds the address conversion table to the GTT.

Enter or choose values for the new entry, then click Add. The MWTM adds 
the entry to the Conversion Entry Table.

Close Closes the Address Conversion Add dialog box for a table.

When you finish adding entries, click Close to close the Address Conversion 
Add dialog box for an entry.

Help Shows online help for the current window.

Field or Button Description
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Creating a New GTT File
You use the MWTM to create a new GTT file. To do so, choose File > New Table from the GTT menu.

The Create New Table dialog box appears.

Figure 14-13 Create New Table Dialog Box

Field or Button Description

Variant SS7 protocol variant. Choose a variant from the drop-down list box. Valid variants 
are:

• ANSI

• China

• ITU

• NTT

• TTC

Version Version of the file format that the GTT uses. Choose a version from the drop-down 
list box. Valid versions are:

• 3.1 (MB9, MB9a)—Corresponds to ITP software releases 12.2(4)MB9 and 
12.2(4)MB9a. Two or more entries in the same application group can have the 
same cost. This is the default version in the MWTM.

• 4.0 (MB10+)—Corresponds to ITP software release 12.2(4)MB10 or higher. 
Supports multiple instances on a single node.

• 4.1 (12.2(20)SW+)—Corresponds to ITP software release 12.2(20)SW or 
higher. Supports multiple instances on a single node.
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Loading an Existing GTT File
You use the MWTM to load a specific GTT file and change the list of GTT files.

When you load a GTT file, the name of the server associated with the GTT Editor and the filename are 
visible in the window name:

MWTM: GTT Editor -- mwtm-sun8 -- GTT.File.1

If you have not yet loaded or saved a GTT file, the MWTM displays a No File Loaded message in place 
of the GTT filename.

Note The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 4.1, 4.2, or 4.3. You can load 
GTT files that use lower or higher file-format versions; but, fields or features that are unique to the lower 
or higher version are not visible and they disappear from the GTT file the next time you save. The file 
is saved as a version 3.1 file if the file is lower than version 3.1, or as a version 4.3 file if the file is higher 
than version 4.3.

Field or Button Description

Version 
(continued)

• 4.2 (12.2(21)SW1+)—Corresponds to ITP software release 12.2(21)SW1 or 
higher. Supports subsystem numbers equal to zero (0) for GTA entries and 
application group entries.

• 4.3 (12.2(23)SW1+)—Corresponds to ITP software release 12.2(23)SW1 or 
higher. Supports latest encoding scheme (not for ANSI).

The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 4.1, 
4.2, or 4.3. You can load GTT files that use lower or higher file format versions; 
but, fields or features that are unique to the lower or higher version are not visible 
and they are removed from the GTT file the next time it is saved. The file is saved 
as a version 3.1 file if the file is lower than version 3.1, or as a version 4.3 file if 
the file is higher than version 4.3.

Instance Number Number of the instance that the GTT uses. Choose an instance number from the 
drop-down list box. Valid IDs are 0 to 7. The default instance number is 0.

This list box is available only if you chose version 4.0.

Network Name Network name that the GTT uses. Choose a network name from the drop-down list 
box. When you choose the network name, The MWTM automatically sets the 
corresponding variant in the Variant field.

If you change the network name for an existing GTT file, the new network name 
must use the same variant.

This list box is available only if you chose version 4.1 or higher.

OK Creates the new GTT file and closes the Create New Table dialog box.

Choose a variant, version, and instance for the new GTT file, then click OK. The 
MWTM creates the new GTT file and closes the Create New Table dialog box.

Cancel Closes the Create New Table dialog box without creating a new GTT file.

Help Shows online help for the current window.
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To load an existing GTT file, or to change the list of GTT files, choose File > Load > Load From File 
from the GTT menu. The Load File dialog box: GTT File List appears.

Figure 14-14 Load File Dialog Box: GTT File List

Field or Button Description

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the GTT file or folder.

Last Modified Date and time the GTT file or folder was last modified.

Size (bytes) Size of the GTT file or folder, in bytes.

Number of Files
(visible in bottom left corner)

Total number of GTT files and folders.
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Related Topics:

• Launching the GTT Editor, page 14-2

• Loading a GTT File from a Node, page 14-35

• Loading a GTT File from the Archive, page 14-37

Loading a GTT File from a Node
You use the Load GTT from Node wizard to choose the node and signaling point whose GTT file you 
want to edit.

To launch the Load GTT from Node wizard, choose File > Load > Load From Node from the GTT 
menu. Or, from the Startup Options dialog box, choose Load GTT Data From: Node. If you have 
implemented MWTM User-Based Access, this option is available to users with authentication level 
Network Operator (level 3) and higher.

The Load GTT from Node wizard appears.

OK Loads the selected GTT file, saves any changes you make to 
the list of files, closes the Load File dialog box: GTT File 
List, opens the Progress dialog box, and begins loading the 
GTT file.

To load a GTT file, double-click it in the list; select it in the 
list and click OK; or enter the name of the file and click OK. 
The MWTM closes the Load File dialog box: GTT File List 
and the Progress dialog box appears (Figure 14-17).

The Progress dialog box shows the progress of the GTT file 
load, as well as any messages that appear while loading the 
file.

When the file is loaded, click OK. The MWTM closes the 
Progress dialog box, loads the GTT file, and returns to the 
GTT Configuration window.

Delete Deletes the selected file from the GTT file list. The MWTM 
issues an informational message containing the name and 
location of the deleted file.

Cancel Closes the dialog box without loading a GTT file or saving 
any changes to the GTT file list.

Help Shows online help for the dialog box.

Field or Button Description
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Figure 14-15 Load GTT from Node Wizard

The left pane of the Load GTT from Node wizard contains:

The bottom line of the Load GTT from Node wizard contains:

Step Description

Select Node/SP You can choose the signaling point from which to load the GTT file. You can 
optionally check the Filter by Node check box, which limits signaling point 
selection to a specific node. 

Choose a signaling point and node (optional) from the drop-down list boxes, then 
click Next. The MWTM retrieves GTT filenames from the selected signaling point. 

If no GTT filenames are available, the process ends with errors. If GTT filenames 
are available, the MWTM proceeds directly to the Login step.

Login You can log in to the signaling point. Once you have logged in initially, the MWTM 
skips this step. Enter the:

• Log in username and password.

• Enable username and password.

Note To avoid entering username and password information each time, you can 
set up credentials (see Configuring Login Credentials, page 3-19).

Load Reads the GTT table from the node and loads it into the GTT Editor.

Field or Button Description

Progress Bar Indicates that the file is being validated or uploaded.

Show Log/Hide Log Shows or hides the session between the MWTM and the node.

Next > Advances to the next step in the wizard.

Finish Closes the wizard. The Finish button appears when deployment completes 
successfully; or, when it detects errors and cancels the process.

Cancel Closes the wizard without deploying the file.

Help Shows online help for the wizard.
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Related Topics:

• Launching the GTT Editor, page 14-2

• Loading a GTT File from the Archive, page 14-37

Loading a GTT File from the Archive
You use the Load GTT from Archive wizard to choose the node and signaling point whose archived GTT 
file you want to edit. 

To launch the Load GTT from Archive wizard, choose File > Load > Load From Archive from the GTT 
menu; or, from the Startup Options dialog box, choose Load GTT Data From: Archive. If you 
implement MWTM User-Based Access, this option is available to users with authentication level 
Network Operator (level 3) and higher.

The Load GTT from Archive wizard appears.

Figure 14-16 Load GTT from Archive Wizard 

The left pane of the Load GTT from Archive wizard contains:

Step Description

Select Node/SP You can choose the signaling point from which to load the GTT file. You can 
optionally check the Filter by Node check box, which limits signaling-point 
selection to a specific node. 

Choose a signaling point and node (optional) from the drop-down list boxes, then 
click Next. The MWTM retrieves GTT filenames from the selected signaling point. 

If no GTT filenames are available, the process ends with errors. If GTT filenames 
are available, the MWTM proceeds directly to the Select Version step.

Select Version Select a previously deployed version of the configuration from the archive.

Load Checks the archived GTT file for errors and loads the file into the GTT Editor.
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The bottom line of the Load GTT from Archive wizard contains:

Displaying the Progress Dialog Box
The Progress dialog box shows the percent of a GTT file that was loaded, saved, or checked semantically, 
as well as any messages that appear while loading or checking the file.

To display the Progress dialog box, use one of these procedures. 

Choose:

• File > Load > Load From File or Load From ITP from the GTT menu, then select a GTT file from 
the Load File dialog box: GTT File List and click OK.

• File > Save As from the GTT menu, then select a GTT file from the Load File dialog box: GTT File 
List and click OK.

• File > Semantic Check from the GTT menu, then enter an ITP’s name or IP address in the Semantic 
Check GTT dialog box and click OK.

The Progress dialog box appears.

Figure 14-17 Progress Dialog Box

Field or Button Description

Progress Bar Indicates that the file is being validated or uploaded.

Next > Advances to the next step in the wizard.

Finish Closes the wizard. The Finish button appears when deployment is 
successful; or, it encounters errors and cancels the process.

Cancel Closes the wizard without deploying the file.

Help Shows online help for the wizard.
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Related Topics:

• Checking the Semantics of a GTT File, page 14-39

• Launching the GTT Editor, page 14-2

• Loading an Existing GTT File, page 14-33

• Saving a GTT File, page 14-46

Checking the Semantics of a GTT File
The MWTM strongly recommends that you check the semantics of a GTT file against a specific ITP and 
validate this data in the GTT file:

• ITP Point Code—For version 2.0 GTT files, the point code in the GTT file must differ from the 
primary, secondary, or capability point code of the ITP. If the file is the same, the MWTM generates 
an error. This restriction is not for GTT files of version 3.0 or later.

• Route Table—The ITP route table must contain all point codes in the GTT file, other than the 
primary, secondary, or capability point code of the ITP. If the route table does not contain the point 
codes, the MWTM generates an error.

• Route Status—All route entries for point codes in the GTT file, other than the ITP’s primary, 
secondary, or capability point code, must be available. If they are not, the MWTM generates a 
warning.

• GTA and Application Group—If an application server configures the GTA or the application 
group, then that application server must reside on the ITP. If it does not, the MWTM generates an 
error.

If the application server resides on the ITP, but it is not available, the MWTM generates a warning.

For example, ITP limits XUA configuration to instance 0. The MWTM semantic check verifies that XUA 
is not configured on any other instance.

To check the semantics of a GTT file, choose File > Semantic Check from the GTT menu. The Semantic 
Check GTT dialog box appears.

Field or Button Description

Progress Bar Indicates the percent of the GTT file that was loaded, saved, or checked.

Messages Messages that appear while loading, saving, or checking the GTT file.

OK Closes the Progress dialog box.

This button is dimmed until the MWTM finishes loading, saving, or checking the 
GTT file; or, until you click Cancel to stop loading, saving, or checking the file.

When the file is loaded, saved, or checked, click OK. The MWTM closes the 
Progress dialog box and returns to the GTT Configuration window.

Cancel Stops loading, saving, or checking the GTT file.

This button is dimmed when the MWTM finishes loading, saving, or checking the 
GTT file; or, if loading, saving, or checking stops.

Help Shows online help for the current window.
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Figure 14-18 Semantic Check GTT Dialog Box

Note You can also use the mwtm checkgtt command to semantics of a GTT file (see mwtm checkgtt, page 
B-79).

Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Deploying a GTT File
You use the Deployment wizard to validate a GTT file, upload it to an ITP, archive the file, and activate 
it on the ITP. To launch the Deployment wizard for a GTT file, choose File > Deploy from the GTT menu 
(see Deploying ITP Files, page 5-35).

Field or Button Description

ITP Name or IP Address Name or IP address of the ITP against which to check the GTT file.

OK Closes the Semantic Check GTT dialog box and opens the Progress 
dialog box, which shows the progress of the semantic check for the 
GTT file.

Enter the name or IP address of an ITP, and click OK. The MWTM 
closes the Semantic Check GTT dialog box and opens the Progress 
dialog box (Figure 14-17).

The Progress dialog box shows the progress of the semantic check for 
the GTT file and any messages that appear while checking the file.

After the check, click OK. The MWTM closes the Progress dialog box 
and returns to the Semantic Check GTT dialog box.

Cancel Closes the Semantic Check GTT dialog box without checking the 
semantics of the GTT file.
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Displaying Basic Information About a GTT File
You use the MWTM to view basic information about the current GTT file. Choose View > GTT Table 
Info from the GTT menu. The GTT Table Info dialog box appears.

Figure 14-19 GTT Table Info Dialog Box

Field or Button Description

Filename Name of the GTT file.

Version Version of the file format that the GTT uses. Valid versions are:

• 3.1 (MB9, MB9a)—Corresponds to ITP software releases 12.2(4)MB9 
and 12.2(4)MB9a. Two or more entries in the same application group 
can have the same cost. This is the default version in the MWTM.

• 4.0 (MB10+)—Corresponds to ITP software release 12.2(4)MB10 or 
higher. Supports multiple instances on a single node.

• 4.1 (12.2(20)SW+)—Corresponds to ITP software release 12.2(20)SW 
or higher. Supports multiple instances on a single node.

• 4.2 (12.2(21)SW1+)—Corresponds to ITP software release 
12.2(21)SW1 or higher. Supports subsystem numbers equal to zero (0) 
for GTA entries and application group entries.

• 4.3 (12.2(23)SW1+)—Corresponds to ITP software release 
12.2(23)SW1 or higher. Supports latest encoding scheme (not for 
ANSI).

The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 
4.1, 4.2, or 4.3. You can load GTT files that use lower or higher file format 
versions; but, fields or features that are unique to the lower or higher version 
are not visible and they disappear from the GTT file the next time you save. 
The file is saved as a version 3.1 file if the file is lower than version 3.1 or 
as a version 4.3 file if the file is higher than version 4.3.
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Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Supporting Cross-Instance GTT Files
You use the ITP Multiple Instance feature to connect an ITP to more than one network at the same time, 
each with specific variant and network indicator values. The ITP treats each combination of variant and 
network indicator as a separate instance with its own local point code, routing table, and GTT file on the 
ITP. Instances in the same network must have the same network name.

In support of the Multiple Instance feature, ITP Instance Translation enables the conversion of packets 
between instances of any variants. Each instance is a separate domain with a defined variant, network 
indicator, ITP point code, optional capability point code, and optional secondary point code.

For more information about the ITP Multiple Instance and Instance Translation features, see the 
IP Transfer Point (ITP) feature module for Cisco IOS software release 12.2(4)MB10 or later.

GTT files that support the Multiple Instance and Instance Translation features are called cross-instance 
GTT files, because they contain application groups that reference point codes in other GTT files.

To handle cross-instance GTT files, the MWTM uses a server-wide network name mapping file, which 
maps the available network names to GTT variants and network indicators. The MWTM looks up 
network names in the file to parse point codes correctly, based on the user’s cross-instance configuration.

When the MWTM discovers your network, it automatically creates and populates the network 
name-mapping file. Therefore, in most cases, you do not need to manually create the network name 
mapping file. For more information about running Discovery, see Managing and Deploying ITP Files, 
page 5-25.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Name Network name that the GTT file uses.

This field appears only for GTT files of version 4.1 or higher.

Instance Number Number of the instance that the GTT uses. Valid numbers are 0 to 7. The 
default instance number is 0.

If no instance is associated with the GTT, this field contains N/A. This field 
appears only for GTT files of version 4.0.

Last Modified Date and time the GTT file was last modified.

Total Entries Total number of entries in the GTT file.

OK Closes the GTT Table Info dialog box.

Field or Button Description
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In some cases, you might want to create the network name mapping file manually; for example, if you 
have not run Discovery yet, but you want to prepare for a future GTT configuration. Also, while you 
cannot change or delete entries that the MWTM automatically populated, you can add entries manually, 
and you can change or delete those manual entries.

To create the network name mapping file manually; or, to add, change, or delete manual entries, choose 
View > Network Name Configuration from the GTT menu. If you have implemented MWTM 
User-Based Access, this option is available to users with authentication level System Administrator 
(level 5). The Network Name Configuration dialog box appears.

Figure 14-20 Network Name Configuration Dialog Box

The Network Name Configuration dialog box contains:

• Network Name Configuration Dialog Box Menu, page 14-44

• Network Name Configuration Dialog Box Table, page 14-45
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Network Name Configuration Dialog Box Menu
The menu on the Network Name Configuration dialog box contains:

Menu Command Description

File > Revert
(Ctrl-R)

Loads the most recent network name mapping file from the MWTM server.

If the MWTM discovers new entries for the network name mapping file while 
you are editing a GTT file (for example, if it adds a new network instance or it 
discovers a new network), the GTT Editor is unaware of the new entries and 
they are not visible in the Network Name Configuration dialog box. To see the 
new entries in the dialog box, choose File > Revert. (You can also restart the 
GTT Editor to automatically load the most recent network name mapping file 
from the MWTM server.)

File > Save
(Ctrl-S)

Saves the changes you make to the network name mapping file.

After you add, change, or delete entries and save the file, the MWTM uses the 
file the next time it discovers the network. However, if the MWTM discovers 
entries that conflict with manual entries in the file, the MWTM uses (and 
shows in the Network Name Configuration dialog box) the discovered entries, 
not the manual entries.

File > Print
(Ctrl-P)

Prints the contents of the network name mapping file.

File > Close
(Ctrl-W)

Closes the network name mapping file without saving any additions, changes, 
or deletions.

Edit > Add
(Alt-A)

Adds an entry to the network name mapping file.

Edit > Delete
(Delete)

Deletes the selected entry from the network name mapping file.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.



 

14-45
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 14      Editing an ITP Global Title Translation Table
  Supporting Cross-Instance GTT Files

Network Name Configuration Dialog Box Table
The Network Name Configuration dialog box table contains:

Related Topic:

Editing an ITP Global Title Translation Table, page 14-1

Field Description

Network Name Network name that the GTT file uses.

If you change the network name for an existing GTT file, the new network 
name must use the same variant.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Indicator Type of call that is placed. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
the Network Indicator differentiates networks.

Discovered Indicates whether the MWTM (Yes) or a user manually (No) discovered the 
entry.
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Saving a GTT File
You use the MWTM to save a specific GTT file and change the list of GTT files.

Note The MWTM 6.0 supports only GTT files with file format versions  3.1, 4.0, 4.1, 4.2, or 4.3. You can load 
GTT files that use lower or higher file format versions; but, fields or features that are unique to the lower 
or higher version are not visible and they disappear from the GTT file the next time you save. The file 
is saved as a version 3.1 file if the file is lower than version 3.1 or as a version 4.3 file if the file is higher 
than version 4.3.

To save the changes make to a GTT file or change the list of GTT files, use one of these procedures. To 
save the changes you have made to the GTT file:

• Without changing the name of the file, choose File > Save from the GTT menu.

• With a new name, choose File > Save As from the GTT menu. The Save File dialog box: GTT File 
List appears.

Figure 14-21 Save File Dialog Box: GTT File List

Field or Button Description

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the GTT file or folder.

Last Modified Date and time the GTT file or folder was last modified.

Size (bytes) Size of the GTT file or folder, in bytes.

Filename Name by which you want to save the GTT file.

If you create a new GTT filename, you can use any letters, 
numbers, or characters in the name that your operating 
system allows. However, if you include any spaces in the new 
name, the MWTM converts those spaces to hyphens (-). For 
example, the MWTM saves file a b c as a-b-c.

Number of Files
(visible in bottom left corner)

Total number of GTT files and folders.
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When you are ready to exit the GTT Editor window, choose File > Exit from the GTT menu.

If you make any changes to the GTT file, the MWTM asks if you want to save the changes before leaving 
the window. Click:

• Yes to save the changes.

The MWTM opens the Save File dialog box: GTT File List, which you use to save the GTT file with 
a new name, or overwrite an existing GTT file.

• No to close the prompt window.

The MWTM closes the GTT Editor window without saving any changes to the GTT file.

By default, GTT files reside in the MWTM installation directory. If you installed the MWTM in:

• The default directory, /opt, then the default directory is /opt/CSCOsgm/gtt.

• A different directory, then the default directory resides in that directory.

To change the directory in which the MWTM stores GTT files, use the mwtm gttdir command (see 
mwtm gttdir, page B-86).

OK Saves the GTT file or any changes you make to the list of files 
and closes the dialog box.

To save the GTT file with a new name, use one of these 
procedures. To save the file with:

• A completely new name, enter the new name and click 
OK.

• An existing name, overwriting an old GTT file, choose 
the name from the list and click OK.

The MWTM closes the Save File dialog box: GTT File List 
and the Progress dialog box appears (Figure 14-17).

The Progress dialog box shows the progress of the GTT file 
save, as well as any messages that appear while saving the 
file.

When the file is saved, click OK. The MWTM closes the 
Progress dialog box, saves the GTT file with the new name, 
and returns to the GTT Configuration window.

Note If another user modifies and saves the GTT file before 
you save your changes, the MWTM asks if you want 
to overwrite that user’s changes. If you do, the other 
user’s changes are overwritten and lost. If you choose 
not to, your changes are lost; unless you save the GTT 
file to a different filename.

Delete Deletes the selected file from the GTT file list. An 
informational message appears that contains the name and 
location of the deleted file.

Cancel Closes the dialog box without saving the GTT file or any 
changes to the GTT file list.

Help Shows online help for the dialog box.

Field or Button Description
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Reverting to the Last Saved GTT File
To revert to the last saved version of the GTT file, choose File > Revert from the GTT menu. The 
MWTM shows the last saved version of the file.



C H A P T E R
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Editing ITP MLR Address Table Files

You use the Cisco Mobile Wireless Transport Manager (MWTM) to configure Multi-Layer Routing 
(MLR) address table files by using the MWTM Address Table Editor. You can:

• Create new address table files.

• Load existing address table files.

• Edit address table files.

• Perform semantic checks on address table files.

• Deploy address table files to an ITP.

• Save address table files.

If you implement MWTM User-Based Access, the Address Table Editor is available to users with 
authentication level Network Operator (level 3) and higher. 

For more detailed information about address tables, including configuration procedures and scenarios, 
see the IP Transfer Point (ITP) feature module for Cisco IOS software release 12.2(25)SW3 or later.

This chapter contains:

• Launching the Address Table Editor, page 15-2

• Creating a New Address Table File, page 15-6

• Loading an Existing Address Table File, page 15-8

• Loading an Address Table File from a Node, page 15-10

• Loading an Address Table File from the Archive, page 15-12

• Working Within Address Table Files, page 15-14

• Editing Address Table Properties, page 15-16

• Checking the Semantics of an Address Table File, page 15-17

• Deploying an Address Table File, page 15-18

• Displaying Basic Information About an Address Table File, page 15-19

• Listing Archived Address Tables, page 15-20

• Creating Network Name Mapping Files, page 15-20

• Saving an Address Table File, page 15-23

• Reverting to the Last Saved Address Table File, page 15-25
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Launching the Address Table Editor
The Address Table Editor runs as a separate application in the MWTM, so it requires a separate log in, 
just like the MWTM client.

If you implement MWTM User-Based Access, the Address Table Editor is available to users with 
authentication level Network Operator (level 3) and higher. 

To launch the Address Table Editor, use one of these procedures:

• Choose Tools > Address Table Editor from the MWTM main menu.

• Enter the mwtm atblclient command (see mwtm atblclient, page B-77).

The Startup Options dialog box appears, which you use to load a specific address-table file or create a 
new address table file.

The Startup Options dialog box contains options for loading or creating the address table data from:

Once you close the Startup Options dialog box by creating a new address table file or loading an existing 
address table file, the Address Table Editor window appears. If you have created a new address table file, 
the table will be blank. If you have opened an existing address table file, the table will be populated.

Field or Button Description

New File Opens the Address Table Properties dialog box, which you use to create a 
new address table file (see Creating a New Address Table File, page 15-6). 
Create the new address table file.

If you implement MWTM User-Based Access, this option is available to 
users with authentication level Network Administrator (level 4) and higher. 

From File Opens the Load File Dialog: Address Table File list, which you use to load 
a specific address table file and change the list of address table files (see 
Loading an Existing Address Table File, page 15-8). Select an address table 
file to load.

From ITP Opens the Load Address Table from ITP wizard, which you use to select the 
ITP release 12.2(25)SW3 or later signaling point whose address table file 
you want to edit (see Loading an Address Table File from a Node, page 
15-10). Select a signaling point.

If you implement MWTM User-Based Access, this option is available to 
users with authentication level Network Operator (level 3) and higher. 

From Archive Opens the Load Address Table from Archive wizard, which you use to select 
the ITP release 12.2(25)SW3 or later node and signaling point whose address 
table file you want to edit (see Loading an Address Table File from the 
Archive, page 15-12). Select a signaling point and table type.

If you implement MWTM User-Based Access, this option is available to 
users with authentication level Network Operator (level 3) and higher.
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Figure 15-1 Address Table Editor Window

Address Table Menu
The menu on the Address Table Editor window contains:

Menu Command Description

File > New Table
(Ctrl-N)

Opens the Address Table Properties dialog box. The MWTM 
prompts you to:

• Enter the table name, variant, instance number, and network 
name, then click OK to create the address table file. 

• Click Cancel to close the prompt window without creating an 
address table file.

For more information, see Creating a New Address Table File, page 
15-6.

If you implement MWTM User-Based Access, this option is 
available to users with authentication level Network Administrator 
(level 4) and higher. 

File > Load > Load From File
(Ctrl-L)

Opens the Load File dialog box, allowing you to load an already 
existing address table file. The MWTM prompts you to:

• Select the file from the list, then click OK to load the address 
table file. 

• Click Cancel to close the prompt window without loading an 
address table file.

For more information, see Loading an Existing Address Table File, 
page 15-8.
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File > Load > Load From Node
(Ctrl-T)

Opens the Load Address Table from ITP Wizard, which you use to 
select the ITP release 12.2(25)SW3 or later signaling point whose 
address table file you want to edit, as well as the table type.

Tip Click Show Log at any time to view the process details.

To load the address table from a node:

1. Select a node and signaling point from the drop-down list 
boxes, then click Next to load the address table list. 

2. Select an address table list from the drop-down list box, then 
click Next to enter your passwords.

3. Enter the login password, then click Next.

4. Enter the enable password, then click Next.

5. Click Finish to complete the loading process. 

If you have implemented MWTM User-Based Access, this option is 
available to users with authentication level Network Operator (level 
3) and higher.

For more information, see Loading an Address Table File from a 
Node, page 15-10.

File > Load > Load From 
Archive
(Ctrl-H)

Opens the Load Address Table from Archive Wizard, which you use 
to select the ITP release 12.2(25)SW3 or later node and signaling 
point whose address table file you want to edit.

To load the address from archive:

1. Select a node and signaling point from the drop-down list 
boxes, then click Next to load the address table list. 

2. Select the address table list from the drop-down list box, then 
click Next to enter your passwords.

3. Select the version from the table by clicking on it, then click 
Next.

4. Click Finish to complete the loading process. 

If you have implemented MWTM User-Based Access, this option is 
available to users with authentication level Network Operator (level 
3) and higher.

For more information, see Loading an Address Table File from the 
Archive, page 15-12

File > Revert
(Ctrl-R)

Reverts to the last saved version of the address table file.

File > Save
(Ctrl-S)

Saves the changes that you make to the address table file.

File > Save As Opens the Save File Dialog: Address Table File list, which you use 
to save the address table file with a new name or overwrite an 
existing address table file.

Menu Command Description
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File > Semantic Check
(Ctrl-K)

Opens the Semantic Check address table dialog box, which you use 
to check the semantics of an address table file against a specific ITP 
(see Checking the Semantics of an Address Table File, page 15-17).

File > Deploy
(Ctrl-Y)

Opens the Deployment wizard, which you use to validate an address 
table file, upload it to an ITP, and activate it on the ITP.

Note If you have not saved the current address table file, the Save 
File Dialog: Address Table File List appears, prompting you 
to save the file before continuing.

For more information, see Deploying an Address Table File, page 
15-18.

File > Exit
(Ctrl-Q)

Closes the Address Table Editor window. The MWTM prompts you 
to confirm this action. Ensure that you save any changes before 
exiting, if necessary. Click:

• Yes to exit.

• No to close the window.

Edit > Address Table Properties
(Ctrl-P)

Opens the Edit Address Table Properties dialog box, which you use 
to change the name, variant, version, instance ID, and network name 
associated with an address table file (see Editing Address Table 
Properties, page 15-16).

Edit > Add
(Ctrl-E)

Adds a row to the address table.

Edit > Delete
(Ctrl-Delete)

Deletes one or more selected rows from an address table. The 
Confirm Delete dialog box appears. To:

• Delete the selected rows, click Yes. The rows disappear from 
the table and the Confirm Delete dialog box closes.

• Retain the selected rows, click No. The rows remain in the table 
and the Confirm Delete dialog box closes.

Edit > Node Archive 
Management

Opens the Node Archive Management dialog box, which you use to 
view the contents of the archive, open a version with its 
corresponding editor, and delete all versions of a file (see Node 
Archive Management, page 5-32).

If you implement MWTM User-Based Access, this option is 
available to users with authentication level Network Administrator 
(level 4) and higher.

Edit > Node File Management Opens the Node File Management dialog box, which you use to 
transfer address table files to and from the ITP (see Node File 
Management, page 5-25).

If you implement MWTM User-Based Access, this option is 
available to users with authentication level Network Administrator 
(level 4) and higher.

View > Address Table Info
(Ctrl-I)

Opens the Address Table Information dialog box, which shows 
basic information about the currently visible address table file.

Menu Command Description
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Creating a New Address Table File
You use the MWTM to create a new address table file. If you:

• Launch the Address Table Editor from the Startup Options window, click New File.

• Are already in the Address Table Editor, choose File > New Table from the Address Table Editor 
menu. You are prompted to save changes if you are currently working on an unsaved file. 

Note If you implement MWTM User-Based Access, this option is available to users with authentication level 
Network Administrator (level 4) and higher. 

The Address Table Properties dialog box appears.

Figure 15-2 Address Table Properties Dialog

View > Network Name 
Configuration
(Ctrl-F)

Opens the Network Name Configuration dialog box, which maps 
network names to variants and network indicators, in support of 
cross-instance address table files.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information 
about the MWTM application.

Menu Command Description
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Related Topics:

• Loading an Existing Address Table File, page 15-8

• Loading an Address Table File from a Node, page 15-10

Field or Button Description

Table Name User-defined unique table name. 

Variant SS7 protocol variant. Select a variant from the drop-down list box. Valid variants 
are:

• ANSI

• China

• ITU

• NTT

• TTC

Version Version of the file format that the address table uses. You cannot edit this field. 

Instance Number Number of the instance that the address table uses. Select an instance number from 
the drop-down list box. Valid numbers are 0 to 7. The default instance number is 0.

Network Name Network name that the address table uses. Select a network name from the 
drop-down list box. When you select the network name, the MWTM automatically 
sets the corresponding variant in the Variant field.

If you change the network name for an existing address table file, the new network 
name must use the same variant.

OK Creates the new address table file and closes the Address Table Properties dialog 
box.

Enter or select values for the new address table file, then click OK. The MWTM 
creates the new address table file and closes the Address Table Properties dialog 
box.

Cancel Closes the Address Table Properties dialog box without creating a new address 
table file.

To close the Address Table Properties dialog box without creating a new address 
table file, click Cancel.

Help Shows online help for the current window.
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Loading an Existing Address Table File
You use the MWTM to load a specific address table file and change the list of address table files. If you:

• Launch the Address Table Editor from the Startup Options window, click From File.

• Are already in the Address Table Editor, choose File > Load > Load From File from the Address 
Table Editor menu. You are prompted to save changes if you are currently working on an unsaved 
file. 

Note When you load an address table file, the name of the server that is associated with the address table client 
and the filename, as well as the table type and mode (can be edit or view only), appear in the window 
name:

MWTM: Address Table Editor -- mwtm-sun8 -- address table.File.1 (MLR edit mode)

If you have not yet loaded or saved an address table file, the message No File Loaded appears in 
place of the address-table filename.

The Load File Dialog: Address Table File List appears.

Figure 15-3 Load File Dialog: Address Table File List

Field or Button Description

File Types Drop-down list only includes MLR.

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the address table file or folder.

Last Modified Date and time the address table file or folder was last 
modified.

Size (bytes) Size of the address table file or folder, in bytes.
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Related Topics:

• Launching the Address Table Editor, page 15-2

• Loading an Address Table File from a Node, page 15-10

Number of Files
(in lower-left corner)

Total number of address table files and folders.

OK When you click this button, it:

• Loads the selected address table file.

• Saves any changes you made to the list of files.

• Closes the Load File Dialog: Address Table File list.

• Opens the Progress dialog box

• Begins loading the address table file.

To load an address table file:

• Double-click it in the list

• Select it in the list and click OK.

– Or, enter the name of the file and click OK. 

The MWTM closes the Load File Dialog: Address 
Table File list and the Progress dialog box appears, 
which shows the progress of the address table file 
load, as well as any messages that appear while 
loading the file.

• When the file has been loaded, click OK. 

The MWTM closes the Progress dialog box, loads the 
address table file, and returns to the Address Table Editor 
window.

Delete Deletes the selected file from the address table file list. The 
MWTM issues an informational message containing the 
name and location of the deleted file.

Cancel Closes the dialog box without loading an address table file or 
saving any changes to the address table file list.

Help Shows online help for the dialog box.

Field or Button Description
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Loading an Address Table File from a Node

Note Before using the Load Address Table From ITP wizard to load address table files, you must enable TFTP 
file transfer for the address table staging directory by using the mwtm atbldir command (see mwtm 
atbldir, page B-78).

You use the Load Address Table From ITP wizard to load an existing address table file from a node. If 
you:

• Launch the Address Table Editor from the Startup Options window, click From Node.

• Are already in the Address Table Editor, choose File > Load > Load From Node from the Address 
Table Editor menu.

If you implement MWTM User-Based Access, this option is available to users with authentication level 
Network Operator (level 3) and higher.

The Load Address Table From ITP wizard appears.

Figure 15-4 Load Address Table From ITP wizard
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The left pane of the Load Address Table From ITP wizard contains:

The bottom line of the Load Address Table From ITP wizard contains:

Related Topics:

• Launching the Address Table Editor, page 15-2

• Loading an Existing Address Table File, page 15-8

• Editing Address Table Properties, page 15-16

Step Description

Select Node/SP You can select the signaling point from which the address table should be loaded. 
You can optionally check the Filter by Node check box, which limits signaling 
point selection to a specific node. 

Select a signaling point and node (optional) from the drop-down list boxes, then 
click Next . The MWTM retrieves address table names from the selected signaling 
point. 

If no address table names are available, the process ends with errors. If address 
table names are available, the MWTM proceeds directly to the Select Table step.

Login You can log in to the ITP. Enter the:

• Log in password, if required.

• Enable password, if required.

Note To avoid entering username and password information each time, you can 
set up credentials (see Configuring Login Credentials, page 3-19).

Load Uploads the address table file to the MWTM.

If the file upload ends with no errors, the process is successful. Click Finish.

Field or Button Description

Progress Bar Indicates that the address table file is being uploaded.

Show Log/Hide Log Shows or hides the log file for the Load Address Table From ITP wizard.

Next > Advances to the next step in the Load Address Table From ITP wizard.

Finish Closes the Load Address Table From ITP wizard. The Finish button appears 
when loading ends successfully or the wizard detects errors and the process 
is cancelled.

Cancel Closes the Load Address Table From ITP wizard without loading the file.

Help Shows online help for the Load Address Table From ITP wizard.
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Loading an Address Table File from the Archive

Note Before using the Load Address Table From Archive wizard to load address table files, you must use the 
mwtm atbldir command to enable TFTP file transfer for the address table staging directory (see mwtm 
atbldir, page B-78).

You can use the Load Address Table From Archive wizard to load an existing address table file from the 
archive. If you:

• Launch the Address Table Editor, from the Startup Options window, click From Archive.

• Are already in the Address Table Editor, choose File > Load > Load From Archive from the 
Address Table Editor menu.

If you implement MWTM User-Based Access, this option is available to users with authentication level 
Network Operator (level 3) and higher.

The Load Address Table From Archive wizard appears.

Figure 15-5 Load Address Table From Archive wizard
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The left pane of the Load Address Table From Archive wizard contains:

The bottom line of the Load Address Table From Archive wizard contains:

Related Topics:

• Launching the Address Table Editor, page 15-2

• Loading an Existing Address Table File, page 15-8

• Loading an Address Table File from a Node, page 15-10

• Editing Address Table Properties, page 15-16

Step Description

Select Node/SP You can select the signaling point from which to load the address table. You can 
optionally check the Filter by Node check box, which limits signaling point 
selection to a specific node. 

Select a signaling point and node (optional) from the drop-down list boxes, then 
click Next . The MWTM retrieves address table names from the selected signaling 
point. 

If no address table names are available, the process completes with errors. If 
address table names are available, the MWTM proceeds directly to the Select Table 
step.

Select Version You can select the version you want to load. Click on a version to highlight it, then 
click Next. The table contains:

• Rev—Revision number.

• Date—Date and time the version was created.

• Comments—Provided at the time of creation, if applicable.

• Author—Initiator of the comments.

Load Uploads the address table file to the MWTM.

If the file upload ends with no errors, the process is successful. Click Finish.

Field or Button Description

Progress Bar Indicates that the address table file is being uploaded.

Next > Advances to the next step in the Load Address Table From ITP wizard.

Finish Closes the Load Address Table From ITP wizard. The Finish button appears 
when loading completes successfully or it detects errors and the process is 
cancelled.

Cancel Closes the Load Address Table From ITP wizard without loading the file.

Help Shows online help for the Load Address Table From ITP wizard.
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Working Within Address Table Files
Once you create a new address table file or load an existing address table file, you can manage the 
address table entries. 

If you implement MWTM User-Based Access, these options are available to users with authentication 
level Network Administrator (level 4) and higher. To:

• Add a row to a table, select the table and choose Edit > Add from the address table menu; or, Add 
from the right-click menu.

• Delete one or more rows from a table, select the rows and choose Edit > Delete from the address 
table menu; or, Delete from the right-click menu. 

• Edit the values in each row in each table, type over the current value or select a new value from a 
drop-down list box. If you are editing a row, you cannot move on until all fields in the row are 
completed.

• Reset a cell to its previous value. Press Esc. Press Esc twice to reset the entire row. 

• Commit your changes, click outside the row or press Enter. 

Note Once you commit your changes, pressing Esc does not reset the cells in the row.

The Address Table Editor window contains:

Heading Description

Address Digits Address digits for the address table. Enter a 1- to 20-digit hexadecimal string. 
The value must be unique in an address table. 

Exact Match Considers the address an exact match.

Result Type Type of action to perform on a match. 

Result Value Values to use with the matching action. 
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Result Types and Values 
This table defines the list of result types from which to choose when you click in the Result Types 
column and the drop-down arrow that appears, and the corresponding result values that you enter for 
MLR address tables:

Result Type Result Value Description

asname Route to the specified 
application server. 

Message is routed to a particular destination M3UA 
or SUA application server.

block none Indicates that you should discard the short message.

continue none Message that the normal SCCP routing will process 
the message.

group Specify the name of the result 
group to which to route.

Indicates that a result group is used for routing.

gt <SCCP address> tt <number> 
gti <number>

Indicates that the message is routed by using SCCP 
global title. Places the specified address in the SCCP 
Called Party Address. The routing indicator changes 
to RI=GT. Then routed based on the locally 
provisioned global-title translation table. When you 
select this parameter and click on the corresponding 
space in the Result Value column, the Edit GTT 
dialog box appears and contains:

• SCCP Address—An address string of 1-15 
hexadecimal characters. The string is not input 
in BCD-String format, but in normal form.

• Translation Type—Identifies the translation 
type that the address specifies. Valid values are 
0-255.

• Global Title Indicator—Identifies the global 
title indicator value for the specified address. 
This value is always 2 for an ANSI variant and 
might be 2 or 4 for other variant types.

• Numbering Plan—Identifies the numbering 
plan of the specified address. This value is only 
specified when the gti parameter value is 4. 
Valid values are 0-15.

• Nature of Address Indicator—Identifies the 
nature of the specified address. This value is 
only specified when the gti parameter value is 4. 
Valid values are 0-127.

• Add—Adds the current values.

• Close—Closes the dialog box.

• Help—Launches the online help window for the 
current dialog box.
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Editing Address Table Properties
You can use the MWTM to edit the address table properties associated with an address table file. Choose 
Edit > Address Table Properties from the Address Table Editor menu. The Edit Address Table 
Properties dialog box appears.

Figure 15-6 Edit Address Table Properties Dialog

none none A result is not specified.

pc <point code> ssn <number> Indicates that pc or pc/ssn routing is used. When you 
select this parameter and click on the corresponding 
space in the Result Value column, the Edit Point 
Code dialog box appears and displays these fields 
and buttons:

• Point Code—Point code to route the message.

• SSN —Specify a subsystem number. Valid 
values are 2-255. 

• Add—Adds the current values.

• Close—Closes the dialog box.

• Help—Launches the online help window for the 
current dialog box.

Result Type Result Value Description

Field or Button Description

Table Name User-defined unique table name. 

Variant SS7 protocol variant. You cannot edit this field.

Version Version of the file format that the address table uses. You cannot edit this field.

Instance Number Number of the instance that the address table uses. Valid numbers are 0 to 7; the 
default instance number is 0.



 

15-17
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 15      Editing ITP MLR Address Table Files
  Checking the Semantics of an Address Table File

Checking the Semantics of an Address Table File
In using the MWTM, Cisco strongly recommends that you check the semantics of an address table file 
against a specific ITP, validating these data in the address table file:

Group Name—In the Address Table entries, when the result type is group the result value is a group 
name. You must configure the group name in the address entry on the ITP prior to the deployment of the 
address table. During the validation process, if the group name in the address entry does not have a 
corresponding match on the ITP, the MWTM generates an error.

To check the semantics of an address table file, choose File > Semantic Check from the Address Table 
Editor menu. The Semantic Check address table dialog box appears.

Figure 15-7 Semantic Check Address Table Dialog

Network Name Network name that the address table uses.

If you change the network name for an existing address table file, the new network 
name must use the same variant.

OK Saves the changes to the address table file.

Enter or select values, then click OK. The MWTM saves your changes to the 
address table file.

Cancel Closes the Edit Address Table Properties dialog box without saving any changes to 
the address table file.

To close the Edit Address Table Properties dialog box at any time without saving 
any changes to the address table file, click Cancel.

Help Shows online help for the current window.

Field or Button Description
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Note You can also use the mwtm checkmlr command to check the semantics of an MLR address table file 
(see mwtm checkmlr, page B-79).

Deploying an Address Table File
You use the Deployment wizard to validate an address table file, upload it to an ITP, archive the file, and 
activate it on the ITP. To launch the Deployment wizard for an address table file, use one of these 
procedures:

• Choose File > Deploy from the Address Table Editor menu (see Deploying ITP Files, page 5-35).

• Enter the mwtm pushmlr command (see mwtm pushmlr, page B-97).

Field or Button Description

ITP Name or IP Address Name or IP address of the ITP against which to check the address table 
file.

OK Closes the Semantic Check Address Table dialog box and opens the 
Progress dialog box, which shows the progress of the semantic check 
for the address table file.

Enter the name or IP address of an ITP, and click OK. The the 
Semantic Check Address Table dialog box closes and the Progress 
dialog box opens, which shows the progress of the semantic check for 
the address table file and any messages that appear while checking the 
file.

When the check ends, click OK. The Progress dialog box closes and 
returns to the Semantic Check Address Table dialog box.

Cancel Closes the Semantic Check Address Table dialog Box without 
checking the semantics of the address table file.
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Displaying Basic Information About an Address Table File
You use the MWTM to view basic information about the current address table file. Choose View > 
Address Table Info from the address table menu. The Address Table Information dialog box appears.

Figure 15-8 Address Table Information Dialog

The Address Table Information dialog box is read-only.

Field or Button Description

Table Name User-defined unique table name. 

Filename Name of the address table file.

Version Version of the file format that the address table uses. 

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Name Network name that the address table file uses.

Instance Number Number of the instance that the address table uses. Valid numbers are 0 to 7. 
The default instance number is 0.

Last Modified Date and time that someone last modified the address table file.

Total Entries Total number of entries in the address table file.

OK Closes the address table Table Info dialog box.
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Listing Archived Address Tables
To view a list of deployed and archived MLR address tables, do one of the following:

• Enter the mwtm listarchive command (see mwtm listarchive, page B-91). 

• In the MWTM Address Table Editor, choose Edit > Node Archive Management (see Node Archive 
Management, page 5-32). 

For a list of current MLR address table files in the address table staging directory, enter the mwtm 
listmlr command (see mwtm listmlr, page B-92).

Creating Network Name Mapping Files
When the MWTM discovers your network, it automatically creates and populates the network 
name-mapping file; therefore, in most cases, you do not need to manually create the network 
name-mapping file. For more information about running Discovery, see Discovering Your Network, page 
4-4.

In some cases, you might want to manually create the network name-mapping file; for example, you 
might not have run Discovery yet, but you want to prepare for a future address table configuration. Also, 
while you cannot change or delete entries that have been populated automatically by the MWTM, you 
can add entries manually; and, you can change or delete those manual entries.

To create the network name-mapping file manually; or, add, change, or delete manual entries, choose 
View > Network Name Configuration from the address table menu. If you implement MWTM 
User-Based Access, this option is available to users with authentication level System Administrator 
(level 5). The Network Name Configuration dialog box appears.

Figure 15-9 Network Name Configuration Dialog

The Network Name Configuration dialog box contains:

• Network Name Configuration Dialog Menu, page 15-21

• Network Name Configuration Dialog Table, page 15-22
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Network Name Configuration Dialog Menu
The menu on the Network Name Configuration dialog box contains:

Menu Command Description

File > Revert
(Ctrl-R)

Loads the most recent network name-mapping file from the MWTM server.

If the MWTM discovers new entries for the network name-mapping file while 
you are editing an address table file (for example, if a new network instance is 
added, or a new network is discovered), the Address Table Editor does not 
detect the new entries and they do not appear in the Network Name 
Configuration dialog box. To see the new entries in the dialog box, choose File 
> Revert. (You can also restart the Address Table Editor to automatically load 
the most recent network name-mapping file from the MWTM server.)

File > Save
(Ctrl-S)

Saves the changes that you make to the network name-mapping file.

After you add, change, or delete entries and save the file, the MWTM uses the 
file the next time it discovers the network. However, if the MWTM discovers 
entries that conflict with manual entries in the file, the MWTM uses (and 
shows in the Network Name Configuration dialog box) the discovered entries; 
not the manual entries.

File > Print
(Ctrl-P)

Prints the contents of the network name-mapping file.

File > Close
(Ctrl-W)

Closes the network name-mapping file without saving any additions, changes, 
or deletions.

Edit > Add
(Alt-A)

Adds an entry to the network name-mapping file.

Edit > Delete
(Delete)

Deletes the selected entry from the network name-mapping file.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.
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Network Name Configuration Dialog Table
The Network Name Configuration Dialog table contains:

Field Description

Network Name Network name that the address table file uses.

If you change the network name for an existing address table file, the new 
network name must use the same variant.

Variant SS7 protocol variant. Valid variants are:

• ANSI

• China

• ITU

• NTT

• TTC

Network Indicator Type of call that a user places. Valid values are:

• National—National-bound call. The MWTM routes national calls 
through the national network.

• NationalSpare—National-bound call, used in countries in which more 
than one carrier can share a point code. In those countries, the Network 
Indicator differentiates networks.

• International—International-bound call. The MWTM forwards 
international-bound calls to an STP pair that acts as an international 
gateway.

• InternationalSpare—International-bound call, used in countries in 
which more than one carrier can share a point code. In those countries, 
networks are differentiated by the Network Indicator.

Discovered Indicates whether the:

• MWTM (Yes) discovered the entry.

• A user entered it manually (No).
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Saving an Address Table File
You use the MWTM to save a specific address table file and change the list of address table files.

If you implement MWTM User-Based Access, this option is available to users with authentication level 
Network Administrator (level 4) and higher. 

To save the changes that you make to an address table file or change the list of address table files, use 
one of these procedures. To save the changes that you make to the address table file:

• Without changing the name of the file, choose File > Save from the address table menu.

• With a new name, choose File > Save As from the address table menu. The Save File Dialog: 
Address Table File List appears.

Figure 15-10 Save File Dialog: Address Table File List

Field or Button or Icon Description

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the address table file or folder.

Last Modified Date and time a user last modified the address table file or 
folder.

Size (bytes) Size of the address table file or folder, in bytes.

Filename Name by which you want to save the address table file.

If you create a new address table filename, you can use any 
letters, numbers, or characters in the name that your 
operating system allows. However, if you include spaces in 
the new name, the MWTM converts those spaces to hyphens 
(-); for example, the MWTM saves file a b c as a-b-c.

Number of Files
(visible in bottom left corner)

Total number of address table files and folders.



 

15-24
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 15      Editing ITP MLR Address Table Files
  Saving an Address Table File

When you are ready to exit the Address Table Editor window, choose File > Exit from the address table 
menu.

If you made any changes to the address table file, the MWTM asks if you want to save the changes before 
leaving the window. Click:

• Yes to save the changes.

The MWTM opens the Save File Dialog: Address Table File List, which you use to save the address 
table file with a new name, or overwrite an existing address table file.

• No to close the prompt window.

The MWTM closes the Address Table Editor window without saving any changes to the address 
table file.

OK Saves the address table file or any changes you made to the 
list of files and closes the dialog box.

To save the address table file with a new name, use one of 
these procedures. To save the file with:

• A completely new name, enter the new name and click 
OK.

• An existing name, overwriting an old address table file, 
select the name in the list and click OK.

The MWTM closes the Save File Dialog: Address Table File 
List and the Progress dialog box appears, which shows the 
progress of the address table file save, as well as any 
messages that appear while saving the file.

When the file is saved, click OK. The MWTM:

• Closes the Progress dialog box.

• Saves the address table file with the new name

• Returns to the Address Table Editor window.

Note If another user modifies and saves the address table 
file before you save your changes, the MWTM asks if 
you want to overwrite that user’s changes. If you do, 
the other user’s changes are overwritten and lost. If 
you choose not to, your changes are lost; unless you 
save the address table file to a different filename.

Delete Deletes the selected file from the address table file list. The 
MWTM issues an informational message containing the 
name and location of the deleted file.

Cancel Closes the dialog box without saving the address table file or 
any changes to the address table file list.

Help Shows online help for the dialog box.

Field or Button or Icon Description
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By default, address table files reside in the MWTM installation directory. If you installed the MWTM in:

• The default directory, /opt, then the default directory is /opt/CSCOsgm/atbl.

• A different directory, then the default directory resides in that directory.

To change the directory in which the MWTM stores address table files, use the mwtm atbldir command 
(see mwtm atbldir, page B-78).

Reverting to the Last Saved Address Table File
To revert to the last saved version of the address table file, choose File > Revert from the address table 
menu. The MWTM shows the last saved version of the file.

If you implement MWTM User-Based Access, this option is available to users with authentication level 
Network Administrator (level 4) and higher. 
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In the Mobile Wireless Transport Manager (MWTM) navigation tree, if you click on an object within a 
view, the associated tabs appear in the content area in the right pane. This appendix provides an overview 
of the tabs available for each MWTM object within a view, and contains:

Object Type Related Content Applicable To

Nodes • ITP Node Tabs, page A-2

• MWR Node Tabs, page A-2

• ONS Node Tabs, page A-3

• RAN Service Module Node 
Tabs, page A-3

ITP and RAN-O networks

Signaling Points Signaling Point Tabs, page A-4 ITP networks only

Linksets Linkset Tabs, page A-5

Links Link Tabs, page A-5

Application Servers Application Server Tabs, page 
A-6

Application Server Processes Application Server Process Tabs, 
page A-6

Application Server Process 
Associations

Application Server Process 
Association Tabs, page A-7

Signaling Gateway-Mated Pairs Signaling Gateway-Mated Pair 
Tabs, page A-7

Interfaces Interface Tabs, page A-8 ITP and RAN-O networks

RAN Shorthauls UMTS and GSM Interface Tabs, 
page A-8

RAN-O networks only

Cards Card Tabs, page A-9

RAN Backhauls RAN Backhaul Tabs, page A-9

Folders Physical and Management 
Interface Folder Tabs, page A-10

ITP and RAN-O networks
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ITP Node Tabs
Clicking on an IP Transfer Point (ITP) node within a MWTM view provides you with these tabs:

Note To view all nodes in your system, see Nodes Table, page 6-4.

MWR Node Tabs
Clicking on a Mobile Wireless Router (MWR) node within a MWTM view provides you with these tabs:

Note To view all nodes in your system, see Nodes Table, page 6-4.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Syslog Viewing the Syslog, page 8-52

CPU Utilization Viewing CPU Utilization, page 8-53

Trap Settings Viewing Trap Settings, page 8-55

MTP3 Errors Viewing ITP MTP3 Errors, page 8-58

MSU Rates Viewing ITP MSU Rates, page 8-59

Non-Stop Operation Viewing ITP Non-Stop Operation, page 8-60

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Syslog Viewing the Syslog, page 8-52

CPU Utilization Viewing CPU Utilization, page 8-53

Trap Settings Viewing Trap Settings, page 8-55
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ONS Node Tabs
Clicking on an Optical Networking System (ONS) node within a MWTM view provides you with these 
tabs:

Note To view all nodes in your system, see Nodes Table, page 6-4.

RAN Service Module Node Tabs
Clicking on a Radio Access Network (RAN) Service Module node within a MWTM view provides you 
with these tabs:

Note To view all nodes in your system, see Nodes Table, page 6-4.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Syslog Viewing the Syslog, page 8-52

CPU Utilization Viewing CPU Utilization, page 8-53

Trap Settings Viewing Trap Settings, page 8-55
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Signaling Point Tabs
Clicking on a signaling point within a MWTM view provides you with these tabs:

Note To view all signaling points in your system, see Signaling Points Table, page 6-6.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

ITP Access Lists Viewing Route Detail, page 8-103

Route Detail Viewing Route Detail, page 8-103

GTT MAP Status Viewing GTT MAP Status, page 8-105

GTT Statistics Viewing GTT Statistics, page 8-107

MTP3 Event Log Viewing the MTP3 Event Log, page 8-110

MLR Details Viewing MLR Details, page 8-112
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Linkset Tabs
Clicking on a linkset within a MWTM view provides you with these tabs:

Note To view all linksets in your system, see Linksets Table, page 6-8.

Link Tabs
Clicking on a link within a MWTM view provides you with these tabs:

Note To view all links in your system, see Links Table, page 6-11.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Linkset Access Lists Creating Virtual RAN Backhauls, page 8-136

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44



 

A-6
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix A      Object Map Reference
  Application Server Tabs

Application Server Tabs
Clicking on an application server within a MWTM view provides you with these tabs:

Note To view all application servers in your system, see Application Servers Table, page 6-13.

Application Server Process Tabs
Clicking on an application server process within a MWTM view provides you with these tabs:

Note To view all application server processes in your system, see Application Server Processes Table, page 
6-15.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44
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Application Server Process Association Tabs
Clicking on an application server process association within a MWTM view provides you with these 
tabs:

Note To view all application server process associations in your system, see Application Server Process 
Associations Table, page 6-17.

Signaling Gateway-Mated Pair Tabs
Clicking on a signaling gateway-mated pair within a MWTM view provides you with these tabs:

Note To view all signaling gateway-mated pairs in your system, see Signaling Gateway Mated Pairs Table, 
page 6-19.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44
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Interface Tabs
Clicking on an interface within a MWTM view provides you with these tabs:

Note To view all interfaces in your system, see Interfaces Table, page 6-21.

UMTS and GSM Interface Tabs
Clicking on a RAN shorthaul (either UMTS or GSM) within a MWTM view provides you with these 
tabs:

Note To view all interfaces in your system, see Interfaces Table, page 6-21.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Performance Viewing Shorthaul Performance Data, page 8-124

Errors Viewing Shorthaul Errors, page 8-130
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Card Tabs
Clicking on a card within a MWTM view provides you with these tabs:

Note To view all cards in your system, see Cards Table, page 6-23.

RAN Backhaul Tabs
Clicking on a RAN backhaul within a MWTM view provides you with these tabs:

Note To view all RAN backhauls in your system, see RAN Backhauls Table, page 6-25.

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Troubleshooting Viewing Troubleshooting, page 8-42

Recent Events Viewing Recent Events, page 8-44

Performance Viewing Backhaul Performance Data, page 8-126 
(Real-time data on the MWTM client)

Displaying Backhaul Performance Statistics, page 
11-32 (Historical data on the MWTM web 
interface)

Errors Viewing Backhaul Errors, page 8-135 (Real-time 
data on the MWTM client)

Displaying Backhaul Error Statistics, page 11-37 
(Historical data on the MWTM web interface)

RAN Shorthauls Viewing RAN Shorthauls, page 8-136
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Physical and Management Interface Folder Tabs
The Physical folder that contains a list of the physical interfaces and cards that belong to the node. The 
Management Interface folder contains a list of interfaces that the MWTM uses to manage the node.

Clicking on a Physical or Management Interface folder within a MWTM view provides you with these 
tabs:

Tab Related Content

Status Contributors Viewing Status Contributors, page 8-8

Details Viewing Details, page 8-12

Notes Viewing Notes, page 6-35

Recent Events Viewing Recent Events, page 8-44
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This appendix provides the format and a brief description of these Cisco Mobile Wireless Transport 
Manager (MWTM) commands, listed alphabetically. Each command is available on the:

• Server only (including Solaris and Linux).

• Server and Solaris or Linux clients only.

• Server and all clients (including windows) as indicated. 

You can run commands from:

• install_directory/bin

where install_directory is the directory where the MWTM server is installed (by default, 
/opt/CSCOsgm). 

• Alternatively, if you have the install_directory/bin in your path, you can simply run commands from 
within your path.

This appendix contains:

• General Commands, page B-1

• ITP Commands, page B-73

Note General commands are for ITP and RAN-O networks; ITP commands are only for ITP networks.

General Commands
General commands for the MWTM include:

• mwtm, page B-5

• mwtm ?, page B-5

• mwtm addcreds, page B-6

• mwtm adduser, page B-6

• mwtm authtype, page B-7

• mwtm backup, page B-8

• mwtm backupdir, page B-8

• mwtm badloginalarm, page B-9
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• mwtm badlogindisable, page B-9

• mwtm browserpath, page B-10

• mwtm certgui, page B-10

• mwtm certtool, page B-10

• mwtm changes, page B-11

• mwtm checksystem, page B-11

• mwtm clean, page B-12

• mwtm cleanall, page B-12

• mwtm cleandb, page B-13

• mwtm cleandiscover, page B-14

• mwtm cliconntimer, page B-14

• mwtm client, page B-15

• mwtm clientlogs, page B-15

• mwtm clitimeout, page B-15

• mwtm cmdlog, page B-16

• mwtm console, page B-16

• mwtm countnodes, page B-16

• mwtm countobjects, page B-17

• mwtm cwsetup, page B-17 

• mwtm dbtool, page B-17

• mwtm delete, page B-18

• mwtm deletecreds, page B-18

• mwtm deluser, page B-19

• mwtm disablepass, page B-19

• mwtm disableuser, page B-20

• mwtm discover, page B-20

• mwtm enableuser, page B-21

• mwtm eventautolog, page B-21

• mwtm eventconfig, page B-21

• mwtm eventeditor, page B-22

• mwtm eventtool, page B-22

• mwtm evilstop, page B-24

• mwtm export, page B-24

• mwtm export cw, page B-25

• mwtm help, page B-25

• mwtm inactiveuserdays, page B-26

• mwtm installlog, page B-26

• mwtm inventorytool, page B-27
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• mwtm ipaccess, page B-28

• mwtm jspport, page B-29

• mwtm keytool, page B-29

• mwtm killclients, page B-30

• mwtm listusers, page B-30

• mwtm logger, page B-31

• mwtm logtimemode, page B-31

• mwtm manage, page B-31

• mwtm maxasciirows, page B-32

• mwtm maxevhist, page B-32

• mwtm maxhtmlrows, page B-33

• mwtm mldebug, page B-33

• mwtm motd, page B-34

• mwtm msglog, page B-35

• mwtm msglogage, page B-35

• mwtm msglogdir, page B-35

• mwtm msglogsize, page B-36

• mwtm netlog, page B-37

• mwtm netlogger, page B-37

• mwtm newlevel, page B-37

• mwtm osinfo, page B-38

• mwtm passwordage, page B-38

• mwtm patchlog, page B-39

• mwtm poll, page B-39

• mwtm pollertimeout, page B-39

• mwtm print, page B-40

• mwtm props, page B-40

• mwtm provisiontool, page B-40

• mwtm purgedb, page B-41

• mwtm readme, page B-42

• mwtm reboot, page B-42

• mwtm rep15minage, page B-43

• mwtm repdailyage, page B-43

• mwtm rephelp, page B-43

• mwtm rephourlyage, page B-44

• mwtm repmonthlyage, page B-44

• mwtm restart, page B-45

• mwtm restore, page B-45
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• mwtm restoreprops, page B-46

• mwtm rootvars, page B-46

• mwtm sechelp, page B-46

• mwtm seclog, page B-47

• mwtm secondaryserver, page B-47

• mwtm servername, page B-48

• mwtm setpath, page B-49

• mwtm showcreds, page B-50

• mwtm snmpcomm, page B-50

• mwtm snmpconf, page B-51

• mwtm snmpget, page B-51

• mwtm snmphelp, page B-53

• mwtm snmpnext, page B-54

• mwtm snmpwalk, page B-56

• mwtm sounddir, page B-58

• mwtm ssl, page B-59

• mwtm sslstatus, page B-60

• mwtm start, page B-60

• mwtm start client, page B-60

• mwtm start jsp, page B-61

• mwtm start pm, page B-61

• mwtm start web, page B-61

• mwtm status, page B-61

• mwtm stop, page B-61

• mwtm stopclients, page B-62

• mwtm stop jsp, page B-62

• mwtm stop pm, page B-62

• mwtm stop web, page B-62

• mwtm superuser, page B-62

• mwtm syncusers, page B-63

• mwtm tac, page B-63

• mwtm tnproxy, page B-64

• mwtm trapaccess, page B-64

• mwtm trapsetup, page B-65

• mwtm trapstatus, page B-65

• mwtm tshootlog, page B-66

• mwtm uninstall, page B-66

• mwtm unknownage, page B-66
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• mwtm updateuser, page B-67

• mwtm useraccess, page B-67

• mwtm userpass, page B-68

• mwtm version, page B-68

• mwtm viewlog, page B-68

• mwtm wall, page B-69

• mwtm webaccesslog, page B-69

• mwtm weberrorlog, page B-70

• mwtm weblogupdate, page B-70

• mwtm webnames, page B-71

• mwtm webport, page B-71

• mwtm webutil, page B-72

• mwtm who, page B-72

• mwtm xtermpath, page B-72

mwtm

Server and Solaris or Linux Clients Only

Command Description

Displays the command syntax for the mwtm command and all of its options. The function of this 
command is identical to mwtm help.

MWTM help is personality specific; so, only the commands pertaining to each personality are shown. If 
you set the RAN-O personality, only RAN-O commands appear within the help; same for ITP. If you set 
both personalities, you can see all the commands.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm ?

Server and Solaris or Linux Clients Only

Command Description

Displays the command syntax for the mwtm command and all of its options. The function of this 
command is identical to mwtm help.

MWTM help is personality specific, so only the commands pertaining to each personality are shown. If 
you set the RAN-O personality, only RAN-O commands appear within the help; same for ITP. If you set 
both personalities, you see all the commands listed.‘

Related Topic

Chapter 11, “Accessing Data from the Web Interface”
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mwtm addcreds

Server Only

Full Syntax

mwtm addcreds [-d nodetype] [-u username -n enable username] [-i ipaddress] [-r protocoltype]

Command Description

Adds credentials for a given IP address, if specified; otherwise, credentials are added to the system as 
Default, which applies the specified credentials to all nodes in the MWTM database.

• To add credentials for a specific node type, specify -d and the nodetype, which can be:

– itp—ITP nodes

– ons—ONS nodes

– ran-o—MWR nodes

– ran_svc—RAN_SVC nodes

• To add username credentials, specify -u and the username.

• To add enable username credentials, specify -n and the enable username. 

• To add credentials for a particular IP address only, specify -i and the IP address of the node.

• To add the protocol type, specify -r and one protocol, which can be:

– telnet—Telnet access

– ssh—Secure shell access

You must log in as the root user or superuser to use this command.

Related Topic

Configuring Login Credentials, page 3-19

mwtm adduser

Server Only

Full Syntax

mwtm adduser [username]

Command Description

If you enable MWTM User-Based Access, adds the specified user to the authentication list.

When you add a user, the MWTM prompts you for this information:

• User’s password. When setting the password, follow the rules and considerations in Creating Secure 
Passwords, page 2-5.

• Whether to force the user to change the password at the next log in. The default is not to force the 
user to change the password.
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• Authentication level for the user. Valid levels are:

– 1—Basic User

– 2—Power User

– 3—Network Operator

– 4—Network Administrator

– 5—System Administrator

You must log in as the root user or superuser to use this command.

Note If you enable Solaris authentication, you must log in as the root user, not as superuser, to use this 
command (see Implementing Secure User Access (Server Only), page 2-2).

Related Topic

• Configuring User Access, page 2-1

• Implementing Secure User Access (Server Only), page 2-2

mwtm authtype

Server Only

Full Syntax

mwtm authtype [local | solaris | linux]

Command Description

Configures MWTM security authentication:

• local—Allows creation of user accounts and passwords that are local to the MWTM system. When 
using this method, you manage user names, passwords, and access levels by using MWTM 
commands.

• solaris—Uses standard Solaris-based user accounts and passwords, as the /etc/nsswitch.conf file 
specifies. You can provide authentication with the local /etc/passwd file or a distributed Network 
Information Services (NIS) system.

• linux—Uses standard Linux-based user accounts and passwords, as the /etc/nsswitch.conf file 
specifies. You can provide authentication with the local /etc/passwd file or from a distributed 
Network Information Services (NIS) system.

You must log in as the root user or superuser to use this command.

Related Topic

• Configuring User Access, page 2-1

• Implementing Secure User Access (Server Only), page 2-2
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mwtm backup

Server Only

Command Description

Backs up MWTM data files to the MWTM installation directory. The MWTM automatically backs up 
all data files nightly at 1:30 AM; but, you can use this command to back up the files at any other time. 
If you installed the MWTM in:

• The default directory, /opt, then the locations of the backup files are 
/opt/mwtm60-client-backup.tar.Z and /opt/mwtm60-server-backup.tar.Z.

• A different directory, then the backup files reside in that directory.

To restore the MWTM data files from the previous night’s backup, use the mwtm restore command. Do 
not try to extract the backup files manually.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Configuring a Backup MWTM Server, page 3-9

mwtm backupdir

Server Only

Full Syntax

mwtm backupdir [directory]

Command Description

Note You must stop the MWTM server before performing this command. You are prompted whether to 
continue.

You can change the directory in which the MWTM stores its nightly backup files. The default backup 
directory is the directory in which the MWTM is installed. If you installed the MWTM in:

• The default directory, /opt, then the default backup directory is also /opt.

• A different directory, then the default backup directory is that directory.

If you specify a new directory that does not exist, the MWTM does not change the directory and issues 
an appropriate message.

You must log in as the root user to use this command.

Related Topic

Configuring a Backup MWTM Server, page 3-9
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mwtm badloginalarm

Server Only

Full Syntax

mwtm badloginalarm [number-of-attempts | clear]

Command Description

If you enable MWTM User-Based Access, number of unsuccessful log-in attempts allowed before the 
MWTM generates an alarm.

The valid range is 1 unsuccessful attempt to an unlimited number of unsuccessful attempts. The default 
value is 5 unsuccessful attempts.

The MWTM records alarms in the system security log file. The default path and filename for the system 
security log file is /opt/CSCOsgm/logs/sgmSecurityLog.txt. If you installed the MWTM in a directory 
other than /opt, then the system security log file resides in that directory.

To view the system security log file, enter mwtm seclog. You can also view the system security log on 
the MWTM System Security Log web page (see Displaying the Contents of the System Security Log 
(Server Only), page 2-16).

To disable this function (that is, to prevent the MWTM from automatically generating an alarm after 
unsuccessful log-in attempts), enter mwtm badloginalarm clear.

You must log in as the root user or superuser to use this command.

Related Topic

Automatically Disabling Users and Passwords (Server Only), page 2-8

mwtm badlogindisable

Server Only

Full Syntax

mwtm badlogindisable [number-of-attempts | clear]

Command Description

If you enable MWTM User-Based Access, number of unsuccessful log-in attempts by a user allowed 
before the MWTM disables the user’s authentication. The MWTM does not delete the user from the 
authentication list, the MWTM only disables the user’s authentication. To re-enable the user’s 
authentication, use the mwtm enableuser command.

The valid range is 1 unsuccessful attempt to an unlimited number of unsuccessful attempts. The default 
value is 10 unsuccessful attempts.

To disable this function (that is, to prevent the MWTM from automatically disabling a user’s 
authentication after unsuccessful log-in attempts), enter mwtm badlogindisable clear.

You must log in as the root user or superuser to use this command.

Related Topic

Automatically Disabling Users and Passwords (Server Only), page 2-8



 

B-10
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  General Commands

mwtm browserpath

Server and Solaris or Linux Clients Only

Command Description

Sets a user-defined MWTM web browser path and verifies that the browser specified by the user exists.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm certgui

Solaris Clients Only

Command Description

If you enable the Secure Sockets Layer (SSL) on your MWTM system, opens the MWTM Certificate 
Tool window in which you manage SSL certificates on the MWTM client.

Note If you installed the MWTM server and client on the same workstation, running this command is not 
necessary. Instead, when you use the mwtm keytool command to manage SSL certificates on the server, 
the MWTM automatically manages the certificates on the client.

You must log in as the root user (not as a superuser) to use this command in Solaris.

Related Topic

Launching the MWTM Certificate Tool for SSL, page 2-24

mwtm certtool

Server and Solaris Clients Only

Full Syntax

mwtm certtool [clear | delete alias | export alias [-file filename] | import alias [-file filename] | list]

Command Description

If you enable the Secure Sockets Layer (SSL) ion your MWTM system, you can use this command to 
manage SSL certificates on the MWTM client from the command line.

Note If you installed the MWTM server and client on the same workstation, running this command is not 
necessary. Instead, when you use the mwtm keytool command to manage SSL certificates on the server, 
the MWTM automatically manages the certificates on the client.
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Use these keywords and arguments with this command:

• import alias [-file filename]—Imports a signed SSL certificate in X.509 format. This is the most 
common use for this command.

The alias argument can be any character string; the hostname of the server from which you are 
importing the certificate is a good choice.

To import the certificate from a file, specify the optional -file keyword and a filename.

• export alias [-file filename]—Exports the specified SSL certificate in X.509 format.

To export the certificate to a file, specify the optional -file keyword and a filename.

• list—Lists all SSL certificates on the MWTM client.

• delete alias—Removes the specified SSL certificate from the MWTM client.

• clear—Removes all SSL certificates from the MWTM client.

Solaris Only: You must log in as the root user (not as a superuser) to use this command in Solaris.

Related Topic

Importing an SSL Certificate to an MWTM Client, page 2-26

mwtm changes

Server Only

Command Description

Displays the contents of the MWTM CHANGES file. The CHANGES file lists all bugs that have been 
resolved in the MWTM, sorted by release, from the current release back to Release 5.0. If you installed 
the MWTM in:

• The default directory, /opt, then the MWTM CHANGES file resides in the /opt/CSCOsgm/install 
directory.

• A different directory, then the file resides in that directory.

mwtm checksystem

Server Only

Command Description

Checks the system for a server installation and reviews the:

• System requirements

• TCP/IP address and port usage checks

• Disk space usage check

• Server summary

• Error summary

You must log in as the root user (not as a superuser) to use all features of this command. The 
logs/troubleshooting folder has limited permissions to read when the user is not a root user.
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mwtm clean

Server Only

Command Description

Removes all MWTM data from the MWTM server, excluding message log files, backup files, and report 
files. This command restores the MWTM server to a state that would exist after a new installation of the 
MWTM; except for the message log files, backup files, and report files.

Removed data includes all:

• MWTM data

• Notes

• Preferences

• Security settings

• Route files

• GTT files

• Seed files

• Event filters

• Report control files

• Views

• Any user-created files stored in the MWTM directories

You must log in as the root user (not as a superuser) to use this command.

mwtm cleanall

Server Only

Command Description

Removes all MWTM data from the MWTM server, including message log files, backup files, report files, 
configuration settings, and security settings. This command restores the MWTM server to a state that 
would exist after a new installation of the MWTM.

Data removed includes all:

• MWTM data

• Notes

• Preferences

• Security settings

• Route files

• GTT files

• Seed files

• Event filters

• Report control files
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• Views

• Any user-created files stored in the MWTM directories

You must log in as the root user (not as a superuser) to use this command.

mwtm cleandb

Server Only

Command Description

Removes all MWTM data from the MWTM server, including the:

• Core data model database

• All view files

• Notes associated with objects

• Event filters

Excludes:

• Message log files

• Backup files

• Report files

• Configuration settings

• Security settings

• User credentials

• Route files

• GTT files

This command restores the MWTM server to a state that would exist after a new installation of the 
MWTM; except for the presence of the retained files.

Data removed includes all:

• MWTM data

• Notes

• Event filters

• Views

• Any user-created files stored in the MWTM directories

You must log in as the root user (not as a superuser) to use this command.
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mwtm cleandiscover

Server Only

Full Syntax

mwtm cleandiscover [seed-node] [seed-node]...

Command Description

You can use this command to delete all current network data and begin a clean discovery of the ITP 
network from the command line. Use the seed-node arguments to specify the DNS names or IP addresses 
of one or more seed nodes.

Note When you begin a clean discovery, the MWTM stops any real-time polls that are running and issues 
appropriate messages.

Running this command does not remove any notes, preferences, route files, views, message log files, 
backup files, or report files, nor any user-created files stored in the MWTM directories.

You must log in as the root user or superuser to use this command.

Related Topic

Discovering Your Network, page 4-4

mwtm cliconntimer

Server Only

Full Syntax

mwtm cliconntimer [number-of-seconds | clear]

Command Description

Specifies how long, in seconds, an MWTM client should wait for a message from the MWTM server 
before exiting. If the timer expires, the client pings the server and takes one of these actions. If the server:

• Responds to the ping, the client reconnects to the server.

• Does not respond to the ping, but a backup server is configured, the client connects to the backup 
server.

• Does not respond to the ping and no backup server is configured, the client stops.

The valid range is 10 seconds to an unlimited number of seconds. The default value is 60 seconds.

To restore the default timeout of 60 seconds, enter the mwtm cliconntimer clear command.

Any changes you make take effect when you restart the MWTM server.

You must log in as the root user or superuser to use this command.
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mwtm client

Solaris or Linux Clients Only

Full Syntax

mwtm client [hostname]

Command Description

Starts an MWTM client on the specified host. If no hostname is specified, starts an MWTM client on the 
default host, as specified during installation. See Connecting to a New Server, page 5-42 for information 
about determining the default host.

If you access a remote workstation by Telnet, the DISPLAY variable must be set to your local display or 
you cannot use this command. If the DISPLAY variable is not set automatically, you must set it 
manually. See Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3 for details.

Related Topic

Starting the MWTM Client, page 4-2

mwtm clientlogs

Server Only

Command Description

Uses PAGER to display the MWTM client log files.

The MWTM client log files contain client console output for all MWTM clients, one file per local or 
remote client. The MWTM automatically creates the file for a client when the client starts. If you 
installed the MWTM in:

• The default directory, /opt, then the MWTM client log file resides in the 
/opt/CSCOsgm/logs/clientLogs directory.

• A different directory, then the file resides in that directory.

mwtm clitimeout

Server Only

Full Syntax

mwtm clitimeout [number-of-minutes | clear]

Command Description

Specifies how long, in minutes, an MWTM client can be inactive before the MWTM automatically 
disconnects it.

This function is disabled by default. If you do not specify this command, clients are never disconnected 
as a result of inactivity.

If you enter the mwtm clitimeout command, the valid range is 1 minute to an unlimited number of 
minutes. No default value exists.
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If you enable this function and you want to disable it (that is, never disconnect a client as a result of 
inactivity), enter the mwtm clitimeout clear command.

You must log in as the root user or superuser to use this command.

Related Topic

Automatically Disabling Users and Passwords (Server Only), page 2-8

mwtm cmdlog

Server Only

Full Syntax

mwtm cmdlog [clear | -r]

Command Description

Uses PAGER to display the contents of the system command log. The system command log lists:

• All mwtm commands that were entered for the MWTM server.

• The time each command was entered.

• The user who entered the command.

To clear the log, enter mwtm cmdlog clear.

To display the contents of the log in reverse order, with the most recent commands at the beginning of 
the log, enter mwtm cmdlog -r.

You must log in as the root user or superuser to use this command.

mwtm console

Server Only

Command Description

Displays the contents of the console log file, sgmConsoleLog.latest. The console log file contains 
unexpected error and warning messages from the MWTM server, such as those that might occur if the 
MWTM server cannot start.

You must log in as the root user or superuser to use this command.

mwtm countnodes

Server Only

Command Description

Displays the number of nodes in the current MWTM database.

You must log in as the root user or superuser to use this command.
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mwtm countobjects

Server Only

Command Description

Displays a count of all objects in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm cwsetup

Solaris Server Only

Full Syntax

mwtm cwsetup [install | uninstall]

Command Description

Manages the integration of the MWTM with CiscoWorks:

• install—Checks to see which CiscoWorks files are installed and installs additional files as 
necessary. Use this command to integrate the MWTM and CiscoWorks in these instances:

– You installed CiscoWorks after you installed the MWTM.

– The MWTM and CiscoWorks are no longer integrated for some reason.

• uninstall—Removes MWTM files from the CiscoWorks area.

Note Always run mwtm cwsetup uninstall before uninstalling CiscoWorks from your system.

You must log in as the root user (not as a superuser) to use this command.

mwtm dbtool

Server Only

Full Syntax

mwtm dbtool {SQL}

Command Description

Issues a SQL query against the MWTM database. Use a standard SQL query, except replace any 
instances of the asterisk (*) with a question mark (?) instead. For example, a sample SQL query might be:

“select * from events”

Using the mwtm dbtool command, this SQL query would be:

mwtm dbtool “select ? from events”

You must log in as the root user or superuser to use this command.
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mwtm delete

Server Only

Full Syntax

mwtm delete [all | node [all | node [node]...] | sp [all | point-code:net [point-code:net]...] | linkset [all | 
node/linkset [node/linkset]...]

Command Description

Deletes objects from the MWTM database.

• all—Deletes all objects from the MWTM database.

• node all—Deletes all nodes from the MWTM database.

• node node [node]...—Deletes one or more nodes from the MWTM database. Use the node 
arguments to specify one or more nodes.

• sp all—Deletes all nodes from the MWTM database.

• sp point-code:net [point-code:net]...—Deletes one or more signaling points from the MWTM 
database. Use the point-code:net arguments to specify one or more signaling points, which the point 
code and network name identify; for example, 1.22.0:net0.

• linkset all—Deletes all linksets from the MWTM database.

• linkset node/linkset [node/linkset]...—Deletes one or more linksets from the MWTM database. Use 
the node/linkset arguments to specify one or more linksets associated with specific nodes.

You must log in as the root user or superuser to use this command.

Related Topic

Deleting Objects, page 6-36

mwtm deletecreds

Server Only

Full Syntax

mwtm deletecreds [-d nodetype] [-i ipaddress] [-a]

Command Description

Deletes credentials for a given IP address, if specified. Otherwise, Default credentials are deleted. To 
delete: 

• Credentials for a specific node type, specify -d and the nodetype:

– itp—ITP nodes

– ons—ONS nodes

– ran-o—MWR nodes

– ran_svc—RAN_SVC nodes



 

B-19
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  General Commands

• Credentials for a particular IP address only, specify -i and the IP address of the node.

• All credentials, specify -a.

Related Topic

Configuring Login Credentials, page 3-19

mwtm deluser

Server Only

Full Syntax

mwtm deluser [username]

Command Description

If you enable MWTM user-based access, deletes the specified user from the authentication list. To add 
the user back to the list, use the mwtm adduser command.

You must log in as the root user or superuser to use this command.

Related Topic

Manually Disabling Users and Passwords (Server Only), page 2-11

mwtm disablepass

Server Only

Full Syntax

mwtm disablepass [username]

Command Description

If you enable the MWTM User-Based Access, and set mwtm authtype to local, disables the specified 
user’s authentication and password. The MWTM does not delete the user from the authentication list; 
rather, the MWTM only disables the user’s authentication and password. To re-enable the user’s 
authentication with:

• The same password as before, use the mwtm enableuser command.

• A new password, use the mwtm userpass command.

Note The user can re-enable authentication with a new password by attempting to log in by using 
the old password; the MWTM then prompts the user for a new password.
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If you set mwtm authtype to solaris or linux, you cannot use this command; instead, you must manage 
passwords on the external authentication servers.

You must log in as the root user or superuser to use this command. You must also set the mwtm authtype 
to local.

Related Topic

Manually Disabling Users and Passwords (Server Only), page 2-11

mwtm disableuser

Server Only

Full Syntax

mwtm disableuser [username]

Command Description

If you enable MWTM User-Based Access, disables the specified user’s authentication.The MWTM does 
not delete the user from the authentication list, the MWTM only disables the user’s authentication. To 
re-enable the user’s authentication with:

• The same password as before, use the mwtm enableuser command.

• A new password, use the mwtm userpass command.

You must log in as the root user or superuser to use this command.

Related Topic

Manually Disabling Users and Passwords (Server Only), page 2-11

mwtm discover

Server Only

Full Syntax

mwtm discover [seed-node] [seed-node]...

Command Description

You use this command to discover the ITP network from the command line. Use the seed-node arguments 
to specify the DNS names or IP addresses of one or more seed nodes.

Note This command does not perform a clean discovery. To do so, see the mwtm cleandiscover command.

You must log in as the root user or superuser to use this command.

Related Topic

Discovering Your Network, page 4-4
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mwtm enableuser

Server Only

Full Syntax

mwtm enableuser [username]

Command Description

If you enable MWTM user-based access, re-enables the specified user’s authentication, which had been 
disabled either automatically by the MWTM or by a superuser.

The user’s authentication is re-enabled with the same password as before.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling and Changing Users and Passwords (Server Only), page 2-12

mwtm eventautolog

Server Only

Full Syntax

mwtm eventautolog [clear | -r]

Command Description

Uses PAGER to display the contents of the MWTM event automation log. The event automation log lists 
all messages generated by scripts launched by event automation.

To clear the log and restart the server, enter mwtm eventautolog clear.

To display the contents of the log in reverse order, with the most recent events at the beginning of the 
log, enter mwtm eventautolog -r.

You must log in as the root user or superuser to use this command.

mwtm eventconfig

Server Only

Full Syntax

mwtm eventconfig [view | edit |restore | master]

Command Description

Allows you to manage the event configuration:

• To view the event configuration file, use the mwtm evenconfig view command.

• To edit the event configuration file in your environment with a text editor, use the mwtm 
eventconfig edit command. (The default text editor is 'vi'.)
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• To restore the event configuration file to the last active copy, use the mwtm eventconfig restore 
command.

• To restore the event configuration file to the master copy (the default copy shipped with the 
MWTM), use the mwtm eventconfig master command.

You must log in as the root user or superuser to use this command.

mwtm eventeditor

Solaris or Linux Clients Only

Full Syntax

mwtm eventeditor [hostname]

Command Description

Starts an MWTM Event Editor on the specified host. If no hostname is specified, starts an MWTM Event 
Editor on the default host, as specified during installation. See Connecting to a New Server, page 5-42 
for information about determining the default host.

For more information about the MWTM Event Editor, see Changing the Way the MWTM Processes 
Events, page 9-27.

If you Telnet into a remote workstation, the DISPLAY variable must be set to your local display, or you 
cannot use this command. If the DISPLAY variable is not set automatically, you must set it manually 
(see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).

Related Topic

• Chapter 9, “Managing Events”

mwtm eventtool

Server Only

Full Syntax

mwtm eventtool {-a actionName} {parameters}

Command Description

Invokes MWTM event API operations. 
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These action names (and any corresponding required parameters) can be specified with the -a option:

These parameters can be used:

Option Action Names Required Parameters

-a acknowledgeEvents -l or -L

-u

-n

appendNote -e

-n

-u

changeSeverities -s

-l or -L

-u

-n

clearEvents -l or -L

-u

-n

deleteEvents -l or -L

-u

-n

getAllEventsAsTraps -t

getFilteredEventsAsTraps -t

-f

getNote -e

setNote -e

-n

-u

Parameter Description

-e Specifies an event ID parameter.

-f Specifies a file name for EventFilter, which is an XML element defined in 
MWTM WSDL definitions.

-l Specifies a file name for EventIDList, which is an XML element defined in 
MWTM WSDL definitions.

-n Specifies an event note string.

-s Specifies an event severity.

-t Specifies a file name for TrapTarget, which is an XML element defined in 
MWTM WSDL definitions.
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You must log in as the root user or superuser to use this command.

Related Documentation

See the Cisco Mobile Wireless Transport Manager 6.0 OSS Integration Guide.

mwtm evilstop

Server Only

Command Description

Forcefully stops all MWTM servers on the local host. This command can be useful if a normal 
mwtm stop does not stop the servers.

You must log in as the root user (not as a superuser) to use this command.

mwtm export

Server Only

Full Syntax

mwtm export [-d {bar | comma | tab}] [all | as | asp | aspa | links | linksets | nodes | mwtmp | sps]

Command Description

Exports current MWTM data.

By default, the MWTM separates data fields with vertical bars (|). However, you can specify commas (,) 
or tabs as the separator:

• -d bar—Separate data fields with vertical bars (|). This is the default setting.

• -d comma—Separate data fields with commas (,).

• -d tab—Separate data fields with tabs.

By default, the MWTM exports all data. However, you can limit the data that the MWTM exports:

• all—Export all current MWTM data. This is the default selection.

• as—Exports only application server data.

• asp—Exports only application server process data.

-u Specifies a user ID for event operation.

-H Specifies a hostname to connect to. If unspecified, the default value is obtained 
from the MWTM server System.properties file, SERVER_NAME property.

-p Specifies a port to connect to. If unspecified, the default value is obtained from 
the MWTM server System.properties file, WEB_PORT property.

-L Specifies a list of event IDs, separated by '|'.

-S Specifies whether to use SSL (https) for NBAPI access. Default is no SSL. 

-h Prints help information.

Parameter Description
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• aspa—Exports only application server process association data.

• links—Export only link data.

• linksets—Export only linkset data.

Note Links and linkset output totals might not match what appears in the MWTM client (see ITP 
Specific FAQs, page C-13).

• nodes—Export only node data.

• mwtmp—Exports only signaling gateway-mated pair data.

• sps—Exports only signaling point data.

You must log in as the root user or superuser to use this command.

Related Topic

Exporting Data, page 5-38

mwtm export cw

Solaris Server Only

Full Syntax

mwtm export cw

Command Description

Exports current MWTM node names, and read and write SNMP community names, in CiscoWorks 
import format, with fields separated by commas (,). You can export this data to a file, then use the file 
to import the nodes into the CiscoWorks database.

You must log in as the root user or superuser to use this command.

Related Topic

Exporting Data, page 5-38.

mwtm help

Server and Solaris or Linux Clients Only

Full Syntax

mwtm help [keyword]

Command Description

Displays the command syntax for the mwtm command and all of its options. The function of this 
command is identical to mwtm ?.

MWTM help is personality specific; so, only the commands pertaining to each personality appear. If you 
have the RAN-O personality set, only RAN-O commands appear within the help; the same goes for ITP. 
If you set both personalities, all the commands are visible.
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To see the command syntax for a specific keyword, enter mwtm help and that keyword. For example, if 
you enter mwtm help restart, the MWTM displays:

mwtm restart     - Restarts all MWTM Servers on the local host.
mwtm restart web - Restarts Web servers on the local host.
mwtm restart jsp - Restarts JSP servers on the local host.
mwtm restart pm - Restarts Process Manager on the local host.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm inactiveuserdays

Server Only

Full Syntax

mwtm inactiveuserdays [number-of-days | clear]

Command Description

If you enable MWTM user-based access, number of days a user can be inactive before disabling that user 
account.

This function is disabled by default. If you do not specify this command, user accounts are never disabled 
as a result of inactivity.

If you enter the mwtm inactiveuserdays command, the valid range is 1 day to an unlimited number of 
days. There is no default setting.

If you have enabled this function and you want to disable it (that is, prevent the MWTM from 
automatically disabling user accounts as a result of inactivity), enter mwtm inactiveuserdays clear.

To re-enable the user’s authentication, use the mwtm enableuser command.

You must log in as the root user or superuser to use this command.

Related Topics

• Chapter 2, “Configuring Security”

• Automatically Disabling Users and Passwords (Server Only), page 2-8

mwtm installlog

Server and Solaris or Linux Clients Only

Full Syntax

mwtm installlog [server | client]

Command Description

Displays the latest install log for the server or client. If you do not specify server or client, displays the 
latest install log for both the server and client.

You must log in as the root user or superuser to use this command.
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mwtm inventorytool

Server Only

Full Syntax

mwtm inventorytool -a actionName [parameters]

Command Description

Invokes inventory API operations. 

These action names (and any corresponding required parameters) can be specified with the -a option:

You can use these parameters:

Option Action Names Parameters

-a getAllNEs -c

-H

-p

-S

-h

getRootNEs

getNE -f

-c

-H

-p

-S

-h

getChildNEs

getDescendantNEs

getNote

setNote -f

-u

-n

-H

-p

-S

-h

appendNote

Parameter Description

-c (Optional) Specifies the context of the inventory. Valid contexts include: config, 
monitor, and all. If unspecified, the default value is all.

-f Specifies a fully qualified domain name (FQDN).

-S (Optional) Specifies whether to use SSL (https) for NBAPI access. The default is 
no SSL.

-n Specifies a note string. Enclose the string in double quotes.
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You must log in as the root user or superuser to use this command.

Related Documentation

See the Cisco Mobile Wireless Transport Manager 6.0 OSS Integration Guide.

mwtm ipaccess

Server Only

Full Syntax

mwtm ipaccess [add [ip-addr] | clear | edit | list | rem [ip-addr] | sample]

Command Description

You use this command to create and manage a list of client IP addresses that can onnect to the MWTM 
server.

The list of allowed client IP addresses resides in the ipaccess.conf file. By default, when you first install 
the MWTM, the ipaccess.conf file does not exist and all client IP addresses can connect to the MWTM 
server. To create the ipaccess.conf file and specify the list of allowed client IP addresses, use one of these 
keywords:

• add—Add the specified client IP address to the ipaccess.conf file. If the ipaccess.conf file does not 
already exist, this command creates a file with the first entry.

• clear—Remove all client IP addresses from the ipaccess.conf file and allow connections from any 
MWTM client IP address.

• edit—Open and edit the ipaccess.conf file directly. If the ipaccess.conf file does not already exist, 
this command creates an empty file.

• list—List all client IP addresses currently in the ipaccess.conf file. If no client IP addresses appear 
(that is, the list is empty), connections from any MWTM client IP address are allowed.

• rem—Remove the specified client IP address from the ipaccess.conf file.

• sample—Print out a sample ipaccess.conf file.

Any changes you make take effect when you restart the MWTM server.

See Implementing Secure User Access (Server Only), page 2-2 for more information about using this 
command.

You must log in as the root user or superuser to use this command.

-u Specifies a user ID for inventory operation.

-H (Optional) Specifies a hostname to connect to. If unspecified, the system obtains 
the default value from the MWTM server System.properties file, 
SERVER_NAME property.

-p (Optional) Specifies a port to which to connect. If unspecified, the system obtains 
the default value from the MWTM server System.properties file, WEB_PORT 
property.

-h (Optional) Prints help information.

Parameter Description
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mwtm jspport

Server Only

Full Syntax

mwtm jspport [port-number]

Command Description

Sets a new port number for the JSP server, where port-number is the new, numeric port number. The 
MWTM verifies that the new port number is not already in use.

This command is needed only if you must change the port number after you install the MWTM; because 
another application must use the current port number.

The new port number must contain only numbers. If you enter a port number that contains nonnumeric 
characters, such as mwtm13, an error message appears, and the MWTM returns to the command prompt 
without changing the port number.

You must log in as the root user (not as a superuser) to use this command.

mwtm keytool

Solaris Server Only

Full Syntax

mwtm keytool [clear | genkey | import_cert cert_filename | import_key key_filename cert_filename | 
list | print_csr | print_crt]

Command Description

If you implement SSL in your MWTM system, manages SSL keys and certificates on the MWTM server.

If you installed the MWTM server and client on the same workstation, it also automatically manages the 
certificates on the client.

Use these keywords and arguments with this command:

• clear—Stops the MWTM server, if necessary, and removes all SSL keys and certificates from the 
server. Before restarting the server, you must either generate new SSL keys by using the mwtm 
keytool genkey command; or, you must completely disable SSL by using the mwtm ssl disable 
command.

• genkey—Stops the MWTM server, if necessary, and generates a new self-signed public or private 
SSL key pair on the MWTM server. The new keys take effect when you restart the server.

• import_cert cert_filename—Imports the specified signed SSL certificate in X.509 format. 

• import_key key_filename cert_filename—Imports the specified SSL key in OpenSSL format and 
the specified signed SSL certificate in X.509 format.



 

B-30
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  General Commands

• list—Lists all SSL key-certificate pairs on the MWTM server.

• print_csr—Prints a certificate signing request (CSR) in X.509 format.

• print_crt—Prints the MWTM server’s SSL certificate in X.509 format.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Implementing SSL Support in the MWTM, page 2-20

mwtm killclients

Server Only

Command Description

Forcefully stops all MWTM clients on the local host, including all GTT clients and Event Editors.

You must log in as the root user (not as a superuser) to use this command.

mwtm listusers

Server Only

Full Syntax

mwtm listusers [username]

Command Description

If you enable MWTM User-Based Access, lists all currently defined users in the authentication list, 
including this information for each user:

• User name.

• Last time the user logged in.

• User’s authentication access level.

• User’s current authentication status, such as Account Enabled or Password Disabled.

To list information for a specific user, use the username argument to specify the user.

You must log in as the root user or superuser to use this command.

Related Topic

Listing All Currently Defined Users (Server Only), page 2-16
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mwtm logger

Server Only

Command Description

Displays the system messages messageLog.txt file with tail -f.

To stop the display, press Ctrl-C.

mwtm logtimemode

Server Only

Full Syntax

mwtm logtimemode [12 | 24]

Command Description

Sets the time mode for dates in log files:

• 12—Use 12-hour time, with AM and PM so that 1:00 in the afternoon is 1:00 PM.

• 24—Use 24-hour time, also called military time so that 1:00 in the afternoon is 13:00. This is the 
default setting.

You must log in as the root user or superuser to use this command.

mwtm manage

Full Syntax

mwtm manage [itp enable | disable] [ran-o enable | disable] [status] 

Command Description

Enables, disables, or checks the status of managed network(s):

• itp enable—Enables ITP networks.

• itp disable—Disables ITP networks.

• ran-o enable—Enables RAN-O networks.

• ran-o disable—Disables RAN-O networks.

• status—Displays the status of ITP and RAN-O networks (enabled or disabled).

You must log in as the root user or superuser to use this command.
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mwtm maxasciirows

Server Only

Full Syntax

mwtm maxasciirows [number-of-rows]

Command Description

Sets the maximum number of rows for MWTM ASCII web output; for example, detailed debugging 
information.

If you enter this command without the number-of-rows argument, the MWTM displays the current 
maximum number of rows. You can then change that value or leave it. The valid range is 1 row to an 
unlimited number of rows. The default value is 6000 rows.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm maxevhist

Server Only

Full Syntax

mwtm maxevhist [number-of-rows]

Command Description

Sets the maximum number of rows for the MWTM to search in the event history logs. The event history 
logs are the current and archived MWTM network status logs for status change and SNMP trap 
messages. The MWTM sends the results of the search to the web browser, where the setting of the mwtm 
maxhtmlrows command further limits the results.

If you enter this command without the number-of-rows argument, the MWTM displays the current 
maximum number of rows. You can then change that value or leave it. The valid range is 1 row to an 
unlimited number of rows. The default value is 15,000 rows.

The default setting is sufficient in most MWTM environments. However, you might need to increase the 
setting if the MWTM has archived a large number of event history logs, each log contains thousands of 
messages, and you want to search more than 15,000 rows. Remember that increasing this setting can 
increase the search time.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”
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mwtm maxhtmlrows

Server Only

Full Syntax

mwtm maxhtmlrows [number-of-rows]

Command Description

Sets the maximum number of rows for MWTM HTML web output; for example, statistics reports, status 
change messages, or SNMP trap messages.

Note If you have set the Page Size on the MWTM web interface, this command does not override that setting. 
When you set the Page Size feature on the MWTM web interface, browser cookies store the setting until 
the cookie expires or the MWTM deletes it.

If you enter this command without the number-of-rows argument, the MWTM displays the current 
maximum number of rows. You can then change that value or leave it. The valid range is 1 row to an 
unlimited number of rows. The default value is 200 rows.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm mldebug

Server Only

Full Syntax

mwtm mldebug [mode]

Command Description

Sets the mode for logging MWTM debug messages:

• normal—Logs all action, error, and info messages. Use mwtm mldebug normal to revert to the 
default settings if you accidentally enter the mwtm mldebug command.

• list—Displays the current settings for the mwtm mldebug command.

• all—Logs all messages, of any type.

• none—Logs no messages at all.

• minimal—Logs all error messages.

• action—Logs all action messages.

• debug—Logs all debug messages.

• dump—Logs all dump messages.

• error—Logs all error messages.

• info—Logs all info messages.
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• NBAPI-SOAP—Logs all northbound SOAP messages.

• snmp—Logs all SNMP messages.

• trace—Logs all trace messages.

• trapsIn—Logs all incoming trap messages.

• trapsOut—Logs all outgoing trap messages.

This command can adversely affect the MWTM performance. Use this command only under guidance 
from the Cisco Technical Assistance Center (TAC).

You must log in as the root user or superuser to use this command.

mwtm motd

Server Only

Full Syntax

mwtm motd [cat | disable | edit | enable]

Command Description

Manages the MWTM message of the day file, which is a user-specified MWTM system notice. You can 
set the message of the day to inform users of important changes or events in the MWTM system. The 
message of the day also provides users with the chance to exit the MWTM or GTT client before 
launching.

If you enable the message of the day, it appears whenever a user attempts to launch an MWTM or GTT 
client. If the user:

• Accepts the message, the client launches.

• Declines the message, the client does not launch.

Use these keywords with this command:

• enable—Enables the message of the day function. Initially, the message of the day file is blank; use 
the mwtm motd edit command to specify the message text.

• edit—Edits the message of the day.

• cat—Displays the contents of the message of the day file.

• disable—Disables this function (that is, stops displaying the message of the day whenever a user 
attempts to launch an MWTM or GTT client).

You must log in as the root user or superuser to use this command.

Related Topic

Displaying a Message of the Day (Server Only), page 2-13
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mwtm msglog

Server Only

Full Syntax

mwtm msglog [clear | -r]

Command Description

Uses PAGER to display the contents of the system message log.

To save the current contents of the log, clear the log, and restart the server, enter mwtm msglog clear.

To display the contents of the log in reverse order, with the most recent messages at the beginning of the 
log, enter mwtm msglog -r.

You must log in as the root user or superuser to use this command.

mwtm msglogage

Server Only

Full Syntax

mwtm msglogage [number-of-days]

Command Description

Sets the maximum number of days to archive system message log files before deleting them from the 
MWTM server.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days.

You must log in as the root user or superuser to use this command.

mwtm msglogdir

Server Only

Full Syntax

mwtm msglogdir [directory]

Command Description

Note You must stop the MWTM server before performing this command. You are prompted whether to 
continue.

Changes the default location of all MWTM system message log files. By default, the system message 
log files reside on the MWTM server at /opt/CSCOsgm/logs.
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Note Do not set the new directory to any of these: /usr, /var, /opt, or /tmp. Also, do not set the new directory 
to the same directory in which you are storing GTT files (mwtm gttdir), report files (mwtm repdir), 
route table files (mwtm routedir), or address table files (mwtm atbldir).

After you change the directory, the MWTM asks if you want to restart the MWTM server. The new 
directory takes effect when you restart the MWTM server.

You must log in as the root user or superuser to use this command. If you change to a default location 
outside the MWTM, you must have appropriate permissions for that location.

mwtm msglogsize

Server Only

Full Syntax

mwtm msglogsize [number-of-lines]

Command Description

Sets the maximum number of lines to write to the message log file before starting a new file.

If you enter this command without the number-of-lines argument, the MWTM displays the current 
maximum number of lines. You can then change that value or leave it.

The message log process maintains two log files while it is running:

• messageLog.txt

• messageLog-old.txt

When messageLog.txt reaches the number of lines specified by the mwtm msglogsize command, the 
MWTM copies the contents of the messageLog.txt file to the messageLog-old.txt file, and starts a new 
messageLog.txt file.

The default value for number-of-lines is 50,000 lines.

The valid range is 1,000 lines to an unlimited number of lines. The default value is 50,000 lines. If you 
specify a larger file size for the message log file, the message log file and its copy require proportionally 
more disk space.

When changing the number of lines to display, remember that every 5,000 lines require approximately 
1 MB of disk space. You need to balance your need to refer to old messages against the amount of disk 
space they occupy.

You must log in as the root user or superuser to use this command. If you change the number-of-lines 
value, you must restart the server (see mwtm restart, page B-45).
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mwtm netlog

Server Only

Full Syntax

mwtm netlog [clear | -r]

Command Description

Uses PAGER to display the contents of the network status log. To:

• Save the current contents of the log, clear the log, and restart the server, enter mwtm netlog clear.

• Display the contents of the log in reverse order, with the most recent network status messages at the 
beginning of the log, enter mwtm netlog -r.

You must log in as the root user or superuser to use this command.

mwtm netlogger

Server Only

Command Description

Displays the current contents of the network status log file with tail -f.

To stop the display, enter Ctrl-c.

mwtm newlevel

Server Only

Full Syntax

mwtm newlevel [username]

Command Description

If you enable MWTM User-Based Access, changes the authentication level for the specified user. Valid 
levels are:

• 1—Basic User

• 2—Power User

• 3—Network Operator

• 4—Network Administrator

• 5—System Administrator

You must log in as the root user or superuser to use this command.

Related Topic

Enabling and Changing Users and Passwords (Server Only), page 2-12
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mwtm osinfo

Server Only

Command Description

Depending on the personality you have set (ITP, RAN-O, or both) displays the operating system versions 
of ITP and/or RAN-O software that the MWTM supports.

mwtm passwordage

Note You must have already changed your password at least once for this command to properly age the 
password.

Server Only

Full Syntax

mwtm passwordage [number-of-days | clear]

Command Description

If you enable MWTM User-Based Access and you set mwtm authtype to local, number of days allowed 
before forcing users to change passwords.

This function is disabled by default. If you do not specify this command, users will never need to change 
their passwords.

If you enter the mwtm passwordage command, the valid range is 1 day to an unlimited number of days. 
No default setting exists.

If you enabled this function and you want to disable it (that is, prevent the MWTM from forcing users 
to change passwords), enter mwtm passwordage clear.

Note If mwtm authtype is set to solaris, you cannot use this command; instead, you must manage passwords 
on the external authentication servers.

You must log in as the root user or superuser to use this command.

Related Topic

Automatically Disabling Users and Passwords (Server Only), page 2-8
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mwtm patchlog

Server Only

Full Syntax

mwtm patchlog

Command Description

Uses PAGER to display the contents of the patch log, which lists the patches that you installed on the 
MWTM server.

The default path and filename for the patch log file is /opt/CSCOsgm/install/sgmPatch.log. If you 
installed the MWTM in a directory other than /opt, then the patch log file resides in that directory.

You must log in as the root user or superuser to use this command.

mwtm poll

Server Only

Full Syntax

mwtm poll [node] [node]...

Command Description

You use this command to poll one or more known nodes from the command line. Use the node arguments 
to specify the DNS names or IP addresses of one or more known nodes.

You must log in as the root user or superuser to use this command.

mwtm pollertimeout

Server Only

Full Syntax

mwtm pollertimeout [number-of-seconds]

Command Description

Specifies how long, in seconds, MWTM clients that are connected to the MWTM server can run a 
demand poller, as in a real-time data window or web page, before the MWTM automatically stops the 
poller to prevent unnecessary traffic on the network. When the demand poller times out, the MWTM 
stops the poller and sends an appropriate error message to the client.

The valid range is 1 second to an unlimited number of seconds. The default timeout is 8 hours (28800 
seconds).

After you change the timeout, the MWTM asks if you want to restart the MWTM server. The new poller 
timeout takes effect when you restart the MWTM server.

See Server Status Information:Pollers, page 5-44 for more information on demand pollers.

You must log in as the root user or superuser to use this command.
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mwtm print

Server Only

Full Syntax

mwtm print {all | device | snmp | task}

Command Description

Displays information about device versions, SNMP settings, running tasks, or all three.

You must log in as the root user or superuser to use this command.

mwtm props

Server and Solaris or Linux Clients Only

Command Description

Displays the contents of the System.properties files for both MWTM server and client installs.

You must log in as the root user or superuser to use this command.

mwtm provisiontool

Server Only

Full Syntax

mwtm provisiontool -a actionName [parameters]

Command Description

Invokes provisioning API operations. 

You can specify these action names (and any corresponding required parameters) by using the -a option:

Option Action Names Parameters

-a provision -r

-H

-p

-S

-h

syncFromDevice -f

-H

-p

-S

-h

iosWriteToStartup
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You can use these parameters:

You must log in as the root user or superuser to use this command.

Related Documentation

See the Cisco Mobile Wireless Transport Manager 6.0 OSS Integration Guide.

mwtm purgedb

Server Only

Command Description

Permanently deletes all components in the MWTM database marked for deletion. 

You might need to use this command if you made a network configuration change and, as a result, 
mismatched node IP addresses or signaling-point codes appear in the MWTM client. For example, you 
create this problem if you assign an IP address or point code to an ITP node that was previously assigned 
to another ITP node.

If you reassign a point code to a different ITP node, when a new discovery is performed, the MWTM 
compares the newly discovered configuration with the previously discovered configuration. Any 
components (nodes, signaling points, linksets, and so on) not in the new configuration are marked as 
deleted in the MWTM database. However, the MWTM does not immediately delete the associated 
information from the database but keeps it for a period of time to preserve any existing user-customized 
attributes. In this way, if you restore the component back to the configuration, user-customized changes 
remain unchanged and you do not have to re-enter them.

Parameter Description

-r Specifies a file name for ProvisionRequest, which is an XML element from the 
MWTM WSDL definitions.

-f Specifies a fully qualified domain name (FQDN).

-H (Optional) Specifies a hostname to connect to. If unspecified, the system obtains 
the default value from the MWTM server System.properties file, 
SERVER_NAME property.

-p (Optional) Specifies a port to which to connect. If unspecified, the system obtains 
the default value from the MWTM server System.properties file, WEB_PORT 
property.

-S (Optional) Specifies whether to use SSL (https) for NBAPI access. The default is 
no SSL.

-h (Optional) Print help information.
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Unfortunately, this benefit has a side effect. If you restore a deleted component but in a different location 
(for example, if you restore a point code that was once on one node but is now on a different node), the 
MWTM uses the old information in the database; rather than the new information. Ultimately, some of 
the configuration changes are not detected and the viewable data from the client application is incorrect.

Note The mwtm purgedb command does not cause the loss of any collected statistical data.

You must log in as the root user or superuser to use this command.

mwtm readme

Server and Solaris or Linux Clients Only

Command Description

Displays the contents of the README file for the MWTM.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm reboot

Server Only

Command Description

Reboots the Solaris MWTM system.

Note Use this command with care. Rebooting the Solaris MWTM system disconnects all MWTM clients that 
are using the system. Before using this command, use the mwtm who command to list all current users; 
and, the mwtm wall command to warn all current users that you are rebooting the system.

You must log in as the root user (not as a superuser) to use this command.
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mwtm rep15minage

Server Only

Full Syntax

mwtm rep15minage [number-of-days]

Command Description

Maximum number of days the MWTM should archive 15-minute reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days. 

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm repdailyage

Server Only

Full Syntax

mwtm repdailyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive daily reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 90 days.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm rephelp

Server Only

Command Description

Displays help for all commands that are related to MWTM reports.

You must log in as the root user or superuser to use this command.
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mwtm rephourlyage

Server Only

Full Syntax

mwtm rephourlyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive hourly reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm repmonthlyage

Server Only

Full Syntax

mwtm repmonthlyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive monthly reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 3650 days.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm restart

Server Only

Full Syntax

mwtm restart [jsp | pm | web]

Command Description

Restarts MWTM servers on the local host:

• jsp—Restarts the MWTM JSP Server.

• pm—Restarts the MWTM Process Manager and all managed processes.

• web—Restarts the MWTM web Server.

If you do not specify a keyword, mwtm restart restarts all MWTM servers.

You must log in as the root user or superuser to use this command.

mwtm restore

Server Only

Full Syntax

mwtm restore [archive | atbl | gtt | logs | reports | routes | security]

Command Description

Restores the MWTM data files from the previous night’s backup, stored in the MWTM installation 
directory. If you installed the MWTM in:

• The default directory, /opt, then the locations of the backup files are 
/opt/mwtm60-client-backup.tar.Z and /opt/mwtm60-server-backup.tar.Z.

• A different directory, then the backup files reside in that directory.

You can restore data files on the same Solaris or Linux server; or, on a different Solaris or Linux server 
that is running MWTM 6.0. 

To restore only specific parts of the MWTM data files, use these keywords:

• archive—Restores the MWTM archive repository.

• atbl—Restores only MWTM Address Table Editor files. 

• gtt—Restores only MWTM GTT files.

• logs—Restores only MWTM log files, such as the message log files.

• reports—Restores only MWTM report files, such as the statistics report files.
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• routes—Restores only MWTM ITP route table files.

• security—Restores only the security-related parts of the MWTM data files. This command is useful 
if you inadvertently delete your user accounts or make other unwanted changes to your MWTM 
security information.

To change the directory in which the MWTM stores these backup files, use the mwtm backupdir 
command.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Backing Up or Restoring MWTM Files (Server Only), page 2-32

mwtm restoreprops

Server and Solaris or Linux Clients Only

Command Description

Restores the MWTM server and client System.properties files and other important configuration files to 
the backup versions of the files.

You must log in as the root user (not as a superuser) to use this command.

mwtm rootvars

Server and Solaris or Linux Clients Only

Command Description

Displays the contents of the /etc/CSCOsgm.sh file, which determines the root location of the MWTM 
server and client installation.

mwtm sechelp

Server Only

Command Description

Displays help for all commands that are related to MWTM security.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 2, “Configuring Security”
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mwtm seclog

Server Only

Full Syntax

mwtm seclog [clear | -r]

Command Description

Uses PAGER to display the contents of the system security log.

These security events are recorded in the log:

• All changes to system security, including adding users.

• Log-in attempts, whether successful or unsuccessful, and logoffs.

• Attempts to switch to another user's account, whether successful or unsuccessful.

• Attempts to access files or resources of higher authentication level.

• Access to all privileged files and processes.

• Operating system configuration changes and program changes, at the Solaris level.

• The MWTM restarts.

• Failures of computers, programs, communications, and operations, at the Solaris level.

To clear the log, enter mwtm seclog clear.

To display the contents of the log in reverse order, with the most recent security events at the beginning 
of the log, enter mwtm seclog -r.

The default path and filename for the system security log file is /opt/CSCOsgm/logs/sgmSecurityLog.txt. 
If you installed the MWTM in a directory other than /opt, then the system security log file resides in that 
directory.

You must log in as the root user or superuser to use this command.

Related Topic

Displaying the Contents of the System Security Log (Server Only), page 2-16

mwtm secondaryserver

Server Only

Full Syntax

mwtm secondaryserver [hostname [naming-port] | list]

Command Description

Configures a secondary MWTM server, where:

• hostname is the name of the host on which you installed the secondary MWTM server.

• naming-port is the MWTM Naming Server port number for the secondary MWTM server. The 
default port number is 44742.

For best results, Cisco recommends that you configure the primary server and the secondary server as 
secondaries for each other.
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If you use the mwtm secondaryserver command to configure a secondary MWTM server, but the 
primary MWTM server fails before you launch the MWTM client, the MWTM client does not detect the 
secondary server.

To list the secondary MWTM server that you configured for this primary MWTM server, enter the mwtm 
secondaryserver list command.

You must log in as the root user or superuser to use this command.

Related Topic

Configuring a Backup MWTM Server, page 3-9

mwtm servername

Server and Solaris or Linux Clients Only

Full Syntax

mwtm servername [hostname]

Command Description

Resets the MWTM server’ default hostname, where hostname is the new default hostname:

• Ensure that the new default hostname is valid and defined in your /etc/hosts file. If not, you might 
not be able to start the MWTM server.

• If you are not logged in as the root user or as a superuser when you enter this command from an 
MWTM client, the default hostname changes only for that MWTM client and the user who entered 
the command.

• If you are logged in as the root user or superuser when you enter this command, the default hostname 
changes for the MWTM server and client, and it restarts the MWTM server. The MWTM server uses 
the new default hostname to register RMI services, and MWTM clients use the new default 
hostname to connect to the server.

• If you are logged into a client-only installation as the root user or as a superuser when you enter this 
command, the default hostname changes only for that MWTM client. The MWTM client uses the 
new default hostname to connect to the MWTM server.

Note Using the mwtm servername command to reset the MWTM server's default hostname does not affect 
communication between the MWTM server and the ITPs.

Related Topic

• Appendix C, “FAQs”

• Appendix H, “Configuring MWTM to Run with Various Networking Options”
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mwtm setpath

Server and Solaris or Linux Clients Only

Full Syntax

mwtm setpath [username]

Command Description

Appends binary (bin) directories to the path for a user. Users can then append the proper MWTM binary 
directories to their paths without manually editing the .profile and .cshrc files.

This command appends lines such as these to the user's .profile file:

PATH=$PATH:/opt/CSCOsgm/bin:/opt/CSCOsgmClient/bin # CiscoSGM

and appends lines such as these to the user's .cshrc file:

set path=($path /opt/CSCOsgm/bin /opt/CSCOsgmClient/bin) # CiscoSGM

Thereafter, you can enter MWTM commands as:

mwtm help

instead of:

/opt/CSCOsgm/bin/mwtm help

When entering this command, remember that:

• If you enter this command and you do not specify a username, the MWTM appends the bin 
directories to your path (that is, to the path for the user who is currently logged in and entering the 
mwtm setpath command).

• If you enter this command and you specify a username, the MWTM appends the bin directories to 
the path for the specified user. To specify a username, follow these conditions:

– You must log in as the root user.

– The specified username must exist in the local /etc/passwd file.

– You cannot specify a username that is defined in a distributed Network Information Services 
(NIS) system or in an Network File System-mounted (NFS-mounted) home directory.

• If you enter this command more than once for the same user, each command overwrites the previous 
command. The MWTM does not append multiple bin directories to the same path.

• You might have to use the su - command when you enter root-level commands. If you use the su 
command to become the root user, rather than logging in as the root user, then you must use the - 
option.
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mwtm showcreds

Server Only

Full Syntax

mwtm showcreds [-i ipaddress] [-d nodetype]

Command Description

Displays credentials for a given IP address, if specified; otherwise, displays the Default credentials. To: 

• Display credentials for a particular IP address only, use -i and the IP address of the node.

• Add credentials for a specific node type, specify -d and the nodetype, which can be:

– itp—ITP nodes.

– ons—ONS nodes.

– ran-o—MWR nodes.

– ran_svc—RAN_SVC nodes.

You must log in as the root user or superuser to use this command.

Related Topic

Credentials Commands, page 3-22

mwtm snmpcomm

Server Only

Full Syntax

mwtm snmpcomm [name]

Command Description

You use this command to set a new default SNMP read community name. The MWTM automatically 
updates the name in the SNMP parameters file. The default path and filename for the SNMP parameters 
file is /opt/CSCOsgm/etc/communities.conf.

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18
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mwtm snmpconf

Server Only

Full Syntax

mwtm snmpconf [filename]

Command Description

Sets the file used for SNMP parameters, such as community names, timeouts, and retries.

The default path and filename for the SNMP parameters file is /opt/CSCOsgm/etc/communities.conf. If 
you installed the MWTM in a directory other than /opt, then the file resides in that directory.

When you specify a new path or filename, the MWTM restarts the servers.

Note The SNMP parameters file uses the HP OpenView format; therefore, you can set this path and filename 
to point to the HP OpenView ovsnmp.conf file in an existing OpenView system. For information about 
exporting SNMP community names from CiscoWorks Resource Manager Essentials (RME), see 
Importing SNMP Community Names from CiscoWorks (Solaris Only), page 3-2.

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18

mwtm snmpget

Server Only

Full Syntax

mwtm snmpget [-JJVM_ARG1 [-JJVM_ARG2]...] [-v snmp_version] [-c community_string] [-r retry] 
[-t timeout] [-d output_delimiter] [--header|--no-header] [--raw-octets|--no-raw-octets] 
[--str-octets|--no-str-octets] [--raw-timeticks|--no-raw-timeticks] 
[--resolve-integer|--no-resolve-integer] [--resolve-bits|--no-resolve-bits] 
[--get-sysuptime|--no-get-sysuptime] [--detect-mib-error] [--instance oids] [--int-instance integer] 
[--str-instance string] [hostname] [oid] [oid]...

Command Description

Queries the specified hostname by using SNMP GetRequests. Use these optional keywords and 
arguments with this command:

• -JJVM_ARG1—JVM options. You must specify the -J keyword and arguments before any other 
keywords and arguments.

For example, by default JVM uses a maximum of 64 MB of memory; however, if you are walking a 
large table, JVM might require more memory. To enable JVM to use a maximum of 256 MB of 
memory, use this syntax:

-J-Xmx256m

• -v snmp_version—SNMP protocol version. Valid versions are 1 or 2c. The default version is 2c.
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• -c community_string—SNMP community string. You specify the default community string in the 
SNMP parameters file, communities.conf.

• -r retry—SNMP retry count. You specify the default retry count in the SNMP parameters file, 
communities.conf.

• -t timeout—SNMP timeout, in seconds. You specify the default timeout in the SNMP parameters 
file, communities.conf.

• -d output_delimiter—Output delimiter. The default output delimiter is a colon (:).

• --header|--no-header—Specifies whether to display variable names as table headers:

– Specify --header to display variable names as table headers for tabular output, or to display 
MIB variable OIDs with the value for nontabular output. This is the default setting.

– Specify --no-header if you do not want to display variable names as table headers for tabular 
output, or MIB variable OIDs with the value for nontabular output.

• --raw-octets|--no-raw-octets—Specifies whether to display octets as raw octets:

– Specify --raw-octets to display raw octets, such as 6c 69 6e 6b, for octet strings.

– Specify --no-raw-octets if you do not want to display raw octets for octet strings. This is the 
default setting.

The other option for displaying octets is --str-octets|--no-str-octets.

• --str-octets|--no-str-octets—Specifies whether to display octets as strings:

– Specify --str-octets to display octets as strings, such as link. This is the default setting.

– Specify --no-str-octets if you do not want to display octets as strings.

The other option for displaying octets is --raw-octets|--no-raw-octets.

• --raw-timeticks|--no-raw-timeticks—Specifies the time format:

– Specify --raw-timeticks to specify raw timeticks, such as 2313894.

– Specify --no-raw-timeticks to specify formatted timeticks, such as 6 Hours 26 Mins 12 Secs. 
This is the default setting.

• --resolve-integer|--no-resolve-integer—Specifies the time format. Use:

– --resolve-integer to display integers using the string description in the MIB, such as available 
or unavailable.

– --no-resolve-integer to display integers as numbers. This is the default setting.

• --resolve-bits|--no-resolve-bits—Specifies the time format. Use:

– --resolve-bits to display bits using the string description in the MIB, such as continue or 
ruleset.

– --no-resolve-bits to display bits as numbers, such as 1 or 14. This is the default setting.

• --get-sysuptime|--no-get-sysuptime—Specifies whether to retrieve the sysuptime. Use:

– --get-sysuptime to retrieve the sysuptime in the same packet as each SNMP operation.

– --no-get-sysuptime if you do not want to retrieve the sysuptime in the same packet. This s the 
default setting.
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• --detect-mib-error—Detects errors in returned MIB variables, such as noSuchInstance, 
noSuchObject, and endOfMibView. If the system detects any such errors, an error message and 
error code appear.

Sometimes multiple MIB variables are returned at the same time, some of which are in error; others 
are not. If this occurs and you:

– Specified --detect-mib-error, none of the correct values appear, only the error message, and it 
returns an error code.

– Did not specify --detect-mib-error, a return code of 0 is returned and all MIB variables appear. 
(Even noSuchInstance appears as a returned value.) This is the default setting, with 
--detect-mib-error not specified.

• --instance oids—Appends instance OIDs to each polling MIB variable. For example, these 
commands perform the same function:

mwtm snmpget --instance 172.18.16.10 node_1 ipAdEntIfIndex ipAdEntNetMask

mwtm snmpget node_1 ipAdEntIfIndex.172.18.16.10 ipAdEntNetMask.172.18.16.10

• --int-instance integer—Appends the specified integer instance OID to each polling MIB variable.

• --str-instance string—Appends string instance OIDs to each polling MIB variable; for example, 
these commands perform the same function:

mwtm snmpget --str-instance link_1 node_1 cItpSpLinksetState

mwtm snmpget node_1 cItpSpLinksetState.6.108.115.110.97.109.101

• hostname—Name of the host to query.

• oid—One or more OIDs or variable names.

The default path for the SNMP parameters file, communities.conf, is /opt/CSCOsgm/etc/
communities.conf. If you installed the MWTM in a directory other than /opt, then the file resides in that 
directory. You can edit the file manually or using the MWTM client (see Launching the Discovery 
Dialog, page 4-6).

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18

mwtm snmphelp

Server Only

Command Description

Displays help for all commands that are related to SNMP queries.

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18
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mwtm snmpnext

Server Only

Full Syntax

mwtm snmpnext [-JJVM_ARG1 [-JJVM_ARG2]...] [-v snmp_version] [-c community_string] [-r retry] 
[-t timeout] [-d output_delimiter] [--header|--no-header] [--raw-octets|--no-raw-octets] 
[--str-octets|--no-str-octets] [--raw-timeticks|--no-raw-timeticks] 
[--resolve-integer|--no-resolve-integer] [--resolve-bits|--no-resolve-bits] 
[--get-sysuptime|--no-get-sysuptime] [--detect-mib-error] [--instance oids] [--int-instance integer] 
[--str-instance string] [hostname] [oid] [oid]...

Command Description

Queries the specified hostname by using SNMP GetNextRequests. Use these optional keywords and 
arguments with this command:

• -JJVM_ARG1—JVM options. You must specify the -J keyword and arguments before any other 
keywords and arguments.

For example, by default JVM uses a maximum of 64 MB of memory; however, if you explore a large 
table, JVM might require more memory. To enable JVM to use a maximum of 256 MB of memory, 
use this option:

-J-Xmx256m

• -v snmp_version—SNMP protocol version. Valid versions are 1 or 2c. The default version is 2c.

• -c community_string—SNMP community string. You specify the default community string in the 
SNMP parameters file, communities.conf.

• -r retry—SNMP retry count. You specify the default retry count in the SNMP parameters file, 
communities.conf.

• -t timeout—SNMP timeout, in seconds. You specify the default timeout in the SNMP parameters 
file, communities.conf.

• -d output_delimiter—Output delimiter. The default output delimiter is a colon (:).

• --header|--no-header—Specifies whether to display variable names as table headers:

– Specify --header to display variable names as table headers for tabular output or MIB variable 
OIDs with the value for nontabular output. This is the default setting.

– Specify --no-header if you do not want to display variable names as table headers for tabular 
output or MIB variable OIDs with the value for nontabular output.

• --raw-octets|--no-raw-octets—Specifies whether to display octets as raw octets. Use:

– --raw-octets to display raw octets, such as 6c 69 6e 6b, for octet strings.

– --no-raw-octets if you do not want to display raw octets for octet strings. This is the default 
setting.

The other option for displaying octets is --str-octets|--no-str-octets.

• --str-octets|--no-str-octets—Specifies whether to display octets as strings. Use:

– --str-octets to display octets as strings, such as link. This is the default setting.

– --no-str-octets if you do not want to display octets as strings.

The other option for displaying octets is --raw-octets|--no-raw-octets.
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• --raw-timeticks|--no-raw-timeticks—Specifies the time format:

– Specify --raw-timeticks to specify raw timeticks, such as 2313894.

– Specify --no-raw-timeticks to specify formatted timeticks, such as 6 Hours 26 Mins 12 Secs. 
This is the default setting.

• --resolve-integer|--no-resolve-integer—Specifies the time format. Use:

– --resolve-integer to display integers using the string description in the MIB, such as available 
or unavailable.

– --no-resolve-integer to display integers as numbers. This is the default setting.

• --resolve-bits|--no-resolve-bits—Specifies the time format:

– Specify --resolve-bits to display bits using the string description in the MIB, such as continue 
or ruleset.

– Specify --no-resolve-bits to display bits as numbers, such as 1 or 14. This is the default setting.

• --get-sysuptime|--no-get-sysuptime—Specifies whether to retrieve the sysuptime. Use:

– --get-sysuptime to retrieve the sysuptime in the same packet as each SNMP operation.

– --no-get-sysuptime if you do not want to retrieve the sysuptime in the same packet. This is the 
default setting.

• --detect-mib-error—Detects errors in returned MIB variables, such as noSuchInstance, 
noSuchObject, and endOfMibView. If the system detects any such errors, an error message appears 
and an error code is returned.

Sometimes multiple MIB variables are returned at the same time, some of which are in error; others 
are not. If this occurs and you:

– Specified --detect-mib-error, none of the correct values appear, only the error message and it 
returns an error code.

– Did not specify --detect-mib-error, a return code of 0 is returned and all MIB variables appear 
(even noSuchInstance appears as a returned value). This is the default setting, with 
--detect-mib-error not specified.

• --instance oids—Appends instance OIDs to each polling MIB variable. For example, these 
commands perform the same function:

mwtm snmpget --instance 172.18.16.10 node_1 ipAdEntIfIndex ipAdEntNetMask

mwtm snmpget node_1 ipAdEntIfIndex.172.18.16.10 ipAdEntNetMask.172.18.16.10

• --int-instance integer—Appends the specified integer instance OID to each polling MIB variable.

• --str-instance string—Appends string instance OIDs to each polling MIB variable. For example, 
these commands perform the same function:

mwtm snmpget --str-instance link_1 node_1 cItpSpLinksetState

mwtm snmpget node_1 cItpSpLinksetState.6.108.115.110.97.109.101

• hostname—Name of the host to be queried.

• oid—One or more OIDs or variable names.
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The default path for the SNMP parameters file, communities.conf, is 
/opt/CSCOsgm/etc/communities.conf. If you installed the MWTM in a directory other than /opt, then the 
file resides in that directory. You can edit the file manually or by using the MWTM client (see Launching 
the Discovery Dialog, page 4-6).

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18

mwtm snmpwalk

Server Only

Full Syntax

mwtm snmpwalk [-JJVM_ARG1 [-JJVM_ARG2]...] [-v snmp_version] [-c community_string] 
[-r retry] [-t timeout] [-x maximum_rows] [-d output_delimiter] [--tabular|--no-tabular] 
[--getbulk|--no-getbulk] [--header|--no-header] [--raw-octets|--no-raw-octets] 
[--str-octets|--no-str-octets] [--raw-timeticks|--no-raw-timeticks] 
[--resolve-integer|--no-resolve-integer] [--resolve-bits|--no-resolve-bits] 
[--get-sysuptime|--no-get-sysuptime] [--detect-mib-error] [--instance oids] [--int-instance integer] 
[--str-instance string] [hostname] [oid] [oid]...

Command Description

Queries the specified hostname by using SNMP GetNextRequests to go through the MIB. Use these 
optional keywords and arguments with this command:

• -JJVM_ARG1—JVM options. You must specify the -J keyword and arguments before any other 
keywords and arguments.

For example, by default JVM uses a maximum of 64 MB of memory; however, if you are going 
through a large table, JVM might require more memory. To enable JVM to use a maximum of 
256 MB of memory, use this option:

-J-Xmx256m

• -v snmp_version—SNMP protocol version. Valid versions are 1 or 2c. The default version is 2c.

• -c community_string—SNMP community string. You specify the default community string in the 
SNMP parameters file, communities.conf.

• -r retry—SNMP retry count. You specify the default retry count in the SNMP parameters file, 
communities.conf.

• -t timeout—SNMP timeout, in seconds. You specify the default timeout in the SNMP parameters 
file, communities.conf.

• -x maximum_rows—Maximum number of rows to go through. If a table has more than the maximum 
number of rows, the mwtm snmpwalk command fails. You can use the -m keyword and argument 
to increase the maximum number of rows to go through. The default setting is 10,000 rows.

However, for every 10,000 rows gone through, JVM requires an additional 10 MB of memory. You 
can use the -J keyword and argument to increase the memory available to JVM.

• -d output_delimiter—Output delimiter. The default output delimiter is a colon (:).
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• --tabular|--no-tabular—Specifies whether to print the result of the query in tabular format. Use:

– --tabular to print the result in tabular format. This is the default setting.

– --no-tabular if you do not want to print the result in tabular format.

• --getbulk|--no-getbulk—(SNMP version 2c only) Specifies whether to use the getbulk command 
to go through the table. Use:

– --getbulk to use the getbulk command. This is the default setting.

– --no-getbulk if you do not want to use the getbulk command.

• --header|--no-header—Specifies whether to display variable names as table headers. Use:

– --header to display variable names as table headers for tabular output or to display MIB variable 
OIDs with the value for nontabular output. This is the default setting.

– --no-header if you do not want to display variable names as table headers for tabular output or 
MIB variable OIDs with the value for nontabular output.

• --raw-octets|--no-raw-octets—Specifies whether to display octets as raw octets. Use:

– --raw-octets to display raw octets, such as 6c 69 6e 6b, for octet strings.

– --no-raw-octets if you do not want to display raw octets for octet strings. This is the default 
setting.

The other option for displaying octets is --str-octets|--no-str-octets.

• --str-octets|--no-str-octets—Specifies whether to display octets as strings. Use:

– --str-octets to display octets as strings, such as link. This is the default setting.

– --no-str-octets if you do not want to display octets as strings.

The other option for displaying octets is --raw-octets|--no-raw-octets.

• --raw-timeticks|--no-raw-timeticks—Specifies the time format. Use:

– --raw-timeticks to specify raw timeticks, such as 2313894.

– --no-raw-timeticks to specify formatted timeticks, such as 6 Hours 26 Mins 12 Secs. This is 
the default setting.

• --resolve-integer|--no-resolve-integer—Specifies the time format. Use:

– --resolve-integer to display integers using the string description in the MIB, such as available 
or unavailable.

– --no-resolve-integer to display integers as numbers. This is the default setting.

• --resolve-bits|--no-resolve-bits—Specifies the time format. Use:

– --resolve-bits to display bits using the string description in the MIB, such as continue or 
ruleset.

– --no-resolve-bits to display bits as numbers, such as 1 or 14. This is the default setting.

• --get-sysuptime|--no-get-sysuptime—Specifies whether to retrieve the sysuptime. Use:

– --get-sysuptime to retrieve the sysuptime in the same packet as each SNMP operation.

– --no-get-sysuptime if you do not want to retrieve the sysuptime in the same packet. This is the 
default setting.
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• --detect-mib-error—Detects errors in returned MIB variables, such as noSuchInstance, 
noSuchObject, and endOfMibView. If the system detects any such errors, an error message and 
error code appear.

Sometimes multiple MIB variables are returned at the same time, some of which are in error; others 
are not. If this occurs and you:

– Specified --detect-mib-error, none of the correct values appear, only the error message and an 
error code is returned.

– Did not specify --detect-mib-error, a return code of 0 and all MIB variables appear; even 
noSuchInstance appears as a returned value. This is the default setting, with --detect-mib-error 
not specified.

• --instance oids—Appends instance OIDs to each polling MIB variable. For example, these 
commands perform the same function:

mwtm snmpget --instance 172.18.16.10 node_1 ipAdEntIfIndex ipAdEntNetMask

mwtm snmpget node_1 ipAdEntIfIndex.172.18.16.10 ipAdEntNetMask.172.18.16.10

• --int-instance integer—Appends the specified integer instance OID to each polling MIB variable.

• --str-instance string—Appends string instance OIDs to each polling MIB variable. For example, 
these commands perform the same function:

mwtm snmpget --str-instance link_1 node_1 cItpSpLinksetState

mwtm snmpget node_1 cItpSpLinksetState.6.108.115.110.97.109.101

• hostname—Name of the host to query.

• oid—One or more OIDs or variable names.

The default path for the SNMP parameters file, communities.conf, is 
/opt/CSCOsgm/etc/communities.conf. If you installed the MWTM in a directory other than /opt, then the 
file resides in that directory. You can edit the file manually or using the MWTM client (see Launching 
the Discovery Dialog, page 4-6).

You must log in as the root user or superuser to use this command.

Related Topic

SNMP Configuration Commands, page 3-18

mwtm sounddir

Server Only

Full Syntax

mwtm sounddir [directory]

Command Description

Note You must stop the MWTM server before performing this command. You are prompted whether to 
continue.



 

B-59
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  General Commands

Sets the directory in which the MWTM server stores event automation sound files (see Changing the Way 
the MWTM Processes Events, page 9-27 for information about sound files).

The default directory for sound files resides in the MWTM installation directory. If you installed the 
MWTM in:

• The default directory, /opt, then the default directory is /opt/CSCOsgm/sounds.

• A different directory, then the default directory resides in that directory.

Use this command if you want to use a different directory for MWTM server event automation sound 
files, such as a Network File System location on another server.

Note This command copies all files in the current directory to the new directory. If you are not logged in as 
the superuser and you do not own the new directory, you might not be able to copy the files. In that case, 
you must specify a directory that you own, or you must log in as the root user.

You must log in as the root user to use this command.

mwtm ssl

Server Only

Full Syntax

mwtm ssl [enable | disable | status]

Command Description

If you enable the SSL on the MWTM and you have an SSL key-certificate pair on the MWTM, you can 
use this command to manage SSL support in the MWTM:

• enable—Enables SSL support.

• disable—Disables SSL support.

• status—Displays the current status of SSL support in the MWTM, including whether you enabled 
or disabled SSL support, and which SSL keys and certificates exist.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Implementing SSL Support in the MWTM, page 2-20
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mwtm sslstatus

Server Only

Command Description

Displays the current status for SSL that the MWTM supports, including whether you enabled or disabled 
SSL support; and, which SSL keys and certificates exist.

You must log in as the root user to use this command.

Related Topic

Implementing SSL Support in the MWTM, page 2-20

mwtm start

Server Only

Command Description

Starts all MWTM servers on the local host.

You must log in as the root user or superuser to use this command.

Related Topic

Starting the MWTM Server, page 4-1

mwtm start client

Server and all Clients

Full Syntax

mwtm start client [hostname]

Command Description

Starts an MWTM client on the specified host. If you did not specify a hostname, starts an MWTM client 
on the default host, as specified during installation. See Connecting to a New Server, page 5-42 for 
information about determining the default host.

If you log in to a remote workstation through Telnet or SSH, you must set the DISPLAY variable to your 
local display, or you cannot use this command. If the DISPLAY variable is not set automatically, you 
must set it manually (see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).

This command has the same function as the mwtm client command.
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mwtm start jsp

Server Only

Command Description

Starts the MWTM JSP Server on the local host.

You must log in as the root user or superuser to use this command.

mwtm start pm

Server Only

Command Description

Starts the MWTM Process Manager and all managed processes on the local host.

You must log in as the root user or superuser to use this command.

mwtm start web

Server Only

Command Description

Starts the MWTM web server on the local host.

You must log in as the root user or superuser to use this command.

mwtm status

Server Only

Command Description

Displays the status of all MWTM servers on the local host.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm stop

Server Only

Command Description

Stops all MWTM servers on the local host.

You must log in as the root user or superuser to use this command.
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mwtm stopclients

Server and Solaris or Linux Clients Only

Command Description

Stops all MWTM clients, including all GTT clients and Event Editors, on the local host.

You must log in as the root user (not as a superuser) to use this command.

mwtm stop jsp

Server Only

Command Description

Stops the MWTM JSP Server on the local host.

You must log in as the root user or superuser to use this command.

mwtm stop pm

Server Only

Command Description

Stops the MWTM Process Manager and all managed processes on the local host.

You must log in as the root user or superuser to use this command.

mwtm stop web

Server Only

Command Description

Stops the MWTM web server on the local host.

You must log in as the root user or superuser to use this command.

mwtm superuser

Server Only

Full Syntax

mwtm superuser [username]
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Command Description

Allows the specified user to perform most functions that otherwise require the user to log in as the root 
user. (The root user can still perform those functions, too.) The specified user account must exist in the 
local /etc/passwd file. You cannot specify a user that is defined in a distributed Network Information 
Services (NIS) system.

Note As a superuser, you can adversely affect your operating environment if you lack a sufficient 
understanding of the commands that you use. If you are a relatively inexperienced UNIX user, Cisco 
recommends that you limit your activities as a superuser to the tasks in this document.

For a complete list of the MWTM commands that a superuser cannot use, as well as other superuser 
considerations, see Specifying a Super User (Server Only), page 2-18.

You must log in as the root user (not as a superuser) to use this command.

mwtm syncusers

Server Only

Command Description

If you enable MWTM User-Based Access and you set mwtm authtype to solaris, synchronizes local 
MWTM passwords with Solaris.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

Manually Synchronizing Local MWTM Passwords (Server Only), page 2-15

mwtm tac

Server Only

Command Description

Collects important troubleshooting information for the Cisco Technical Assistance Center and writes the 
information to the /opt/CSCOsgm/tmp/cisco_mwtm_tshoot.log file.

You must log in as the root user or superuser to use this command.

Related Topic

Appendix D, “Troubleshooting the MWTM and the Network”
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mwtm tnproxy

Server Only

Full Syntax

mwtm tnproxy [disable | enable | status]

Command Description

Manages a Telnet proxy that resides on a server and forwards Telnet requests from clients to ITPs that 
are accessible only from that server. You use a Telnet proxy to enable remote clients on desktop networks 
to Telnet to ITPs that otherwise would be unreachable. You can use these options with this command:

• disable—Disables MWTM Telnet proxy support. This is the default setting.

• enable—Enables the MWTM to use a Telnet proxy and prompts you to restart the MWTM server. 
When you restart the server, the MWTM automatically starts the Telnet proxy process.

• status—Indicates whether MWTM Telnet proxy support is currently enabled or disabled.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling the Telnet Server Proxy Service, page 3-11

mwtm trapaccess

Server Only

Full Syntax

mwtm trapaccess [add [ip-addr] | clear | edit | list | rem [ip-addr] | sample]

Command Description

You use this command to create and manage a list of ITP IP addresses that can send traps to the MWTM 
server.

The list of allowed ITP IP addresses resides in the trapaccess.conf file. By default, when you first install 
the MWTM, the trapaccess.conf file does not exist and the MWTM allows all IP addresses to send traps 
to the MWTM server. To create the trapaccess.conf file and work with the list of allowed client IP 
addresses, specify one of these keywords:

• add—Add the specified IP address to the trapaccess.conf file. If the file does not already exist, this 
command creates the file containing the first entry.

• clear—Remove all IP addresses from the trapaccess.conf file and allow traps from any MWTM 
client IP address.

• edit—Open and edit the trapaccess.conf file directly. If the trapaccess.conf file does not already 
exist, this command creates an empty file.

• list—List all IP addresses currently in the trapaccess.conf file. If no IP addresses appear (that is, the 
list is empty), the system allows traps from any MWTM IP address.
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• rem—Remove the specified IP address from the trapaccess.conf file.

• sample—Print out a sample trapaccess.conf file.

Any changes that you make take effect when you restart the MWTM server.

See Limiting Traps by IP Address, page 3-8 for more information about using this command.

You must log in as the root user or superuser to use this command.

mwtm trapsetup

Server Only

Full Syntax

mwtm trapsetup [disable]

Command Description

Stops the MWTM server, configures the MWTM to receive SNMP traps (or prevents the MWTM from 
receiving traps), then restarts the MWTM server.

When you select an SNMP trap port number for the MWTM server, ensure that your ITPs use the same 
SNMP trap port number. See the description of the snmp-server host command in the “ITP 
Requirements” section of the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0 
for more information.

To prevent the MWTM from receiving traps, enter the mwtm trapsetup disable command. The MWTM 
restarts the MWTM server.

You must log in as the root user (not as a superuser) to use this command.

Related Topic

• Chapter 2, “Configuring Security”

• Enabling SNMP Traps, page 3-7

mwtm trapstatus

Server Only

Command Description

Displays the current trap reception configuration for the MWTM, including:

• Whether you enabled or disabled receiving traps.

• On which UDP port the MWTM trap receiver listens.

Related Topic

Enabling SNMP Traps, page 3-7
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mwtm tshootlog

Server Only

Full Syntax

mwtm tshootlog {enable | disable | status}

Command Description

The MWTM can record all output from troubleshooting commands into a log file. To:

• Record all troubleshooting output to a log file, specify enable.

• Stop the MWTM from recording all troubleshooting output to a log file, specify disable.

• View the status of this command, specify status.

The default path for the troubleshooting log file is /opt/CSCOsgm/logs/troubleshooting. If you installed 
the MWTM in a directory other than /opt, then the troubleshooting log file resides in that directory.

Related Topic

Appendix D, “Troubleshooting the MWTM and the Network”

mwtm uninstall

Server and Solaris or Linux Clients Only

Command Description

Uninstalls the MWTM.

You must log in as the root user (not as a superuser) to use this command.

mwtm unknownage

Server Only

Full Syntax

mwtm unknownage [number-of-days]

Command Description

Sets the maximum number of days to retain Unknown objects before deleting them from the MWTM 
database.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 7 days. Setting this value to 0 days means that, after one 
hour, the system deletes Unknown.

You must log in as the root user or superuser to use this command.
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mwtm updateuser

Server Only

Full Syntax

mwtm updateuser [username]

Command Description

If you enable MWTM User-Based Access, changes the authentication level for the specified user. Valid 
levels are:

• 1—Basic User.

• 2—Power User.

• 3—Network Operator.

• 4—Network Administrator.

• 5—System Administrator.

If you set mwtm authtype to local, you also use this command to change the user’s password. When 
setting the password, follow the rules and considerations in Creating Secure Passwords, page 2-5.

See Enabling and Changing Users and Passwords (Server Only), page 2-12 for more information on 
authentication levels and the use of this command.

You must log in as the root user or superuser to use this command.

Note If you have enabled Solaris authentication, you must log in as the root user, not a superuser, to use this 
command (see Configuring User Access, page 2-1).

mwtm useraccess

Server Only

Full Syntax

mwtm useraccess [disable | enable]

Command Description

Enables or disables MWTM User-Based Access.

User-Based Access provides multilevel password-protected access to MWTM features. Each user can 
have a unique user name and password. You can also assign each user to one of five levels of access, 
which control the list of MWTM features accessible by that user.

You must enable MWTM User-Based Access to use the associated MWTM security commands (see 
Configuring User Access, page 2-1).

You must log in as the root user or superuser to use this command.
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mwtm userpass

Server Only

Full Syntax

mwtm userpass [username]

Command Description

If you enable MWTM User-Based Access and mwtm authtype is set to local, changes the specified 
user’s MWTM security authentication password.

If the MWTM or a superuser automatically disables the user’s authentication, this command re-enables 
the user’s authentication with a new password.

If mwtm authtype is set to solaris, you cannot use this command; instead, you must manage passwords 
on the external authentication servers.

You must log in as the root user to use this command.

Related Topic

Enabling and Changing Users and Passwords (Server Only), page 2-12

mwtm version

Server and Solaris or Linux Clients Only

Command Description

Displays version information for MWTM servers and clients on the local host.

Related Topic

Chapter 11, “Accessing Data from the Web Interface”

mwtm viewlog

Server Only

Command Description

Uses PAGER to display the contents of the system message log. To:

• Save the current contents of the log, clear the log, and restart the server, enter mwtm viewlog clear.

• Display the contents of the log in reverse order, with the most recent messages at the beginning of 
the log, enter mwtm msglog -r.

This command has the same function as the mwtm msglog command.

You must log in as the root user or superuser to use this command.



 

B-69
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  General Commands

mwtm wall

Server Only

Full Syntax

mwtm wall message_string

Command Description

Sends a message to all clients that are connected to the server. For example:

./mwtm wall Server going down at 9:00 pm tonight.

sends this message:

Server going down at 9:00 pm tonight.

The MWTM ignores quotation marks (““) in message_string. To include quotation marks (““), use the 
escape character (\) in combination with quotation marks (““). For example:

./mwtm wall Example of the \”mwtm wall\” command.

sends this message:

Example of the “mwtm wall” command.

You must log in as the root user or superuser to use this command.

mwtm webaccesslog

Server Only

Full Syntax

mwtm webaccesslog [clear | -r]

Command Description

Uses PAGER to display the MWTM system web access log file for the server to which you connect and 
which is currently running the MWTM server. The system web access log lists all MWTM system web 
access messages that it logged for the MWTM server. This method provides an audit trail of all access 
to the MWTM server via the web interface. To:

• Clear the log and restart the server, enter mwtm webaccesslog clear.

• Display the contents of the log in reverse order, with the most recent web access messages at the 
beginning of the log, enter mwtm webaccesslog -r.

You must log in as the root user or superuser to use this command.
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mwtm weberrorlog

Server Only

Full Syntax

mwtm weberrorlog [clear | -r]

Command Description

Uses PAGER to display the MWTM web server error log file for the server to which you connect, and 
which is currently running the MWTM server. The web server error log lists all MWTM web error 
messages that it logged for the MWTM web server. To:

• Clear the log and restart the server, enter mwtm weberrorlog clear.

• Display the contents of the log in reverse order, with the most recent web error messages at the 
beginning of the log, enter mwtm weberrorlog -r.

You must log in as the root user or superuser to use this command.

mwtm weblogupdate

Server Only

Full Syntax

mwtm weblogupdate [interval | disable]

Command Description

Controls how often, in seconds, the MWTM updates certain web output.

When you enter this command, the MWTM displays the current interval. You can then change that value 
or leave it. The valid range is 1 second to an unlimited number of seconds. The default value is 
300 seconds (5 minutes).

To disable the update interval, enter the mwtm weblogupdate disable command. This option reduces 
the CPU usage on the server and client.

You must log in as the root user or superuser to use this command.
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mwtm webnames

Server Only

Full Syntax

mwtm webnames [display | real]

Command Description

Specifies whether the MWTM should show real node names or display names in web pages:

• real—Display the real DNS names of nodes in web pages, as the MWTM discovered.

• display—Show display names in web pages. Display names are new names that you specify for 
nodes. This is the default setting. For more information about display names, see Editing Properties, 
page 6-29.

You must log in as the root user or superuser to use this command.

mwtm webport

Server Only

Full Syntax

mwtm webport [port-number]

Command Description

Sets a new port number for the web server, where port-number is the new, numeric port number. The 
MWTM verifies that the new port number is not already in use.

The new port number must contain only numbers. If you enter a port number that contains nonnumeric 
characters, such as mwtm13, the MWTM displays an error message and returns to the command prompt 
without changing the port number.

You must log in as the root user (not as a superuser) to use this command.
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mwtm webutil

Server Only

Full Syntax

mwtm webutil [percent | erlangs]

Command Description

Specifies whether the MWTM should display send and receive utilization for linksets and links as 
percentages or in Erlangs (E), in web pages:

• percent—The MWTM displays utilization as a percentage (%). This is the default setting.

• erlangs—The MWTM displays utilization in Erlangs (E).

You must log in as the root user or superuser to use this command.

Related Topic

• Chapter 11, “Accessing Data from the Web Interface”

• Chapter 12, “Managing ITP Reports”

• Customizing ITP Report Preferences, page 12-7

mwtm who

Server Only

Command Description

Displays a list of all client user names and processes connected to the server.

mwtm xtermpath

Server or Solaris or Linux Clients Only

Command Description

Specifies the path to the xterm application to use for xterm sessions on the MWTM client, as well as 
any special parameters to pass to the xterm application. The default path is /usr/openwin/bin/xterm.

If one of the special parameters that you pass to the xterm application is a title, the title can contain 
hyphens (-) and underscores (_), but no spaces.

You must log in as the root user (not as a superuser) to use this command.
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ITP Commands
ITP commands include:

• mwtm accstats, page B-75

• mwtm archivedir, page B-76

• mwtm atblclient, page B-77

• mwtm atbldir, page B-78

• mwtm autosyncconfig, page B-79

• mwtm checkgtt, page B-79

• mwtm checkgtt, page B-79

• mwtm checkmlr, page B-79

• mwtm checkroute, page B-80

• mwtm countas, page B-80

• mwtm countasp, page B-80

• mwtm countaspa, page B-80

• mwtm countlinks, page B-80

• mwtm countlinksets, page B-81

• mwtm countsgmp, page B-81

• mwtm countsps, page B-81

• mwtm deletearchive, page B-81

• mwtm deployarchive, page B-82

• mwtm deploycomments, page B-82

• mwtm evreps clean, page B-83

• mwtm evreps cleancustom, page B-83

• mwtm evreps diskcheck, page B-83

• mwtm evreps enable, page B-84

• mwtm evreps hourlyage, page B-84

• mwtm evreps mtp, page B-85

• mwtm evreps status, page B-85

• mwtm evreps timer, page B-85

• mwtm gttclient, page B-86

• mwtm gttdir, page B-86

• mwtm gttstats, page B-88

• mwtm linkstats, page B-89

• mwtm listarchive, page B-91

• mwtm listgtt, page B-91

• mwtm listgtt, page B-91

• mwtm listhistory, page B-92
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• mwtm listmlr, page B-92

• mwtm listroute, page B-92

• mwtm mlrstats, page B-93

• mwtm mtpevents, page B-95

• mwtm pcformat, page B-96

• mwtm pclist, page B-96

• mwtm pushgtt, page B-97

• mwtm pushgtt, page B-97

• mwtm pushmlr, page B-97

• mwtm pushroute, page B-98

• mwtm q752stats, page B-99

• mwtm repcustage, page B-100

• mwtm repdir, page B-100

• mwtm replog, page B-101

• mwtm routedir, page B-102

• mwtm routetabledefs, page B-103

• mwtm start atblclient, page B-103

• mwtm start gttclient, page B-104

• mwtm statreps 15minage, page B-104

• mwtm statreps acct, page B-105

• mwtm statreps clean, page B-105

• mwtm statreps cleancustom, page B-106

• mwtm statreps custage, page B-106

• mwtm statreps dailyage, page B-107

• mwtm statreps diskcheck, page B-107

• mwtm statreps enable, page B-108

• mwtm statreps enable, page B-108

• mwtm statreps export, page B-108

• mwtm statreps gtt, page B-109

• mwtm statreps hourlyage, page B-109

• mwtm statreps iplinks, page B-110

• mwtm statreps link, page B-110

• mwtm statreps maxcsvrows, page B-111

• mwtm statreps mlr, page B-111

• mwtm statreps monthlyage, page B-112

• mwtm statreps msu, page B-112

• mwtm statreps nullcaps, page B-113

• mwtm statreps q752, page B-113
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• mwtm statreps servratio, page B-114

• mwtm statreps status, page B-114

• mwtm statreps timemode, page B-115

• mwtm statreps timer, page B-115

• mwtm statreps xua, page B-116

• mwtm webutil, page B-72

• mwtm xuastats, page B-117

mwtm accstats

Server Only

Full Syntax

mwtm accstats [node-list [id-tag]] [sort-option] [quiet]

Command Description

Generates MWTM accounting statistics reports. To:

• Include or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling-point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name; for example:

mwtm-75-59a.cisco.com

To specify a node name and signaling point:

mwtm-75-59a.cisco.com;net0

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This is also the 
default setting for this command; you only need to specify default if you also want to specify 
an id-tag, sort-option, or quiet.

– A group of nodes or signaling points other than the one specified in the nodes.include file, create 
a file that contains the list of nodes and signaling points to include and specify the full path and 
name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm accstats command.
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• Specify the sort order for the reports, specify one of these keywords for the sort-option argument:

– -sdp—Sort based on the destination point code (DPC) of the node, in ascending order.

– -sno—Sort based on the node name, in ascending order.

– -sop—Sort based on the originating point code (OPC) of the node, in ascending order.

– -srb—Sort based on the number of bytes received, in descending order.

– -srm—Sort based on the number of MTP3 message signal units (MSUs) received, in descending 
order.

– -ssb—Sort based on the number of bytes sent, in descending order.

– -ssi—Sort numerically based on service indicator (SI), in ascending order.

– -ssm—Sort based on the number of MTP3 MSUs sent, in descending order.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you view by using the MWTM 
web interface.

Before entering this command, you must enable the MWTM to generate accounting statistics reports. 
See the description of the mwtm statreps [acct | noacct] command for more information.

The first time you use the mwtm accstats command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you need only to enter this command once to generate the report.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49

mwtm archivedir

Server Only

Full Syntax

mwtm archivedir [directory]

Command Description

Note You must stop the MWTM server before performing this command. The system prompts you whether to 
continue.

Sets the Version Control System (VCS) repository directory, the directory in which the MWTM stores 
archived files. 
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The default VCS repository directory resides in the MWTM installation directory. If you installed the 
MWTM in:

• The default directory, /opt, then the directory is /opt/CSCOsgm/vcs-repository.

• A different directory, then the directory resides in that directory.

Use this command if you want to use a different directory; for example, a Network File System location 
on another server.

• This command copies all files in the current directory to the new directory. If you do not log in as 
the superuser and do not own the new directory, you might not be able to copy the files. In that case, 
you must specify a directory that you own or you must log in as the root user. Do not set the new 
directory to:

– Any of these: /usr, /var, /opt, or /tmp.

– The same directory in which you are storing message log files (mwtm msglogdir), report files 
(mwtm repdir), route table files (mwtm routedir), GTT files (mwtm gttdir), or address table 
files (mwtm atbldir).

You must log in as the root user or superuser to use this command.

Note If you are setting up a new repository directory on a Network File System location on another (remote) 
server, ensure that the server allows read-write access to the user account that you use to run the MWTM 
and run this command as a superuser.

mwtm atblclient

Solaris or Linux Clients Only

Full Syntax

mwtm atblclient [hostname]

Command Description

Starts an MWTM Address Table Editor client on the specified host. If you do not specify a hostname, 
starts an MWTM Address Table Editor client on the default host, as specified during installation. See 
Connecting to a New Server, page 5-42 for information about determining the default host.

For more information about the MWTM Address Table Editor, see Chapter 15, “Editing ITP MLR 
Address Table Files.”

If you log in to a remote workstation through Telnet, you must set the DISPLAY variable to your local 
display or you cannot use this command. If the system does not automatically set the DISPLAY variable, 
you must set it manually (see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).
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mwtm atbldir

Server Only

Full Syntax

mwtm atbldir [directory]

Command Description

Note You must stop the MWTM server before performing this command. The system then prompts you 
whether to continue.

Sets the address-table staging directory, the directory in which the MWTM stores address table files. For 
more information about address table files, see Chapter 15, “Editing ITP MLR Address Table Files.”

The default address table staging directory resides in the MWTM installation directory. If you installed 
the MWTM in:

• The default directory, /opt, then the directory is /opt/CSCOsgm/atbl.

• A different directory, then the directory resides in that directory.

Use this command if you want to use a different address table staging directory, such as /tftpboot, or such 
as a Network File System location on another server, used as the TFTP server for server configuration 
files for ITPs in the network.

• This command copies all files in the current directory to the new directory. If you are not logged in 
as the superuser and do not own the new directory, you might not be able to copy the files. In that 
case, you must specify a directory that you own or you must log in as the root user. Do not set the 
new directory to:

– Any of these: /usr, /var, /opt, or /tmp.

– The same directory in which you are storing message log files (mwtm msglogdir), report files 
(mwtm repdir), route table files (mwtm routedir), or GTT files (mwtm gttdir).

When you enter this command, the MWTM also prompts you to enable TFTP file transfer for the address 
table staging directory and prompts you for the TFTP path for the directory, tftp://hostname/path, 
where:

• hostname is the name or IP address of the host on which the address-table staging directory resides.

If you enter a DNS name (such as mwm-jumbo) instead of an IP address (such as 172.18.12.10), 
then the ITP must be able to resolve the DNS name; otherwise, when you try to deploy a file, the 
MWTM issues an appropriate error message and does not deploy the file.

To enable the ITP to resolve DNS names, enter the ip domain-lookup command on the ITP. For 
more information about this command, see the Cisco IOS IP Command Reference, Volume 1 of 4: 
Addressing and Services, Release 12.3 or later.

• path is the path to the address table staging directory. Do not include the TFTP root directory 
(/tftpboot, by default) in the path.
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After you change the directory or enable TFTP file transfer for the directory, the MWTM asks if you 
want to restart the MWTM server. The new directory and TFTP setting take effect when you restart the 
MWTM server.

You must log in as the root user or superuser to use this command.

Note If you are setting up a new address table staging directory on a Network File System location on another 
(remote) server, ensure that the server allows read-write access to the user account through which the 
MWTM is running and run this command as a superuser.

mwtm autosyncconfig

Server Only

Full Syntax

mwtm autosyncconfig [enable | disable | status]

Command Description

Manages auto sync configuration settings to automatically save the IOS configuration changes.

mwtm checkgtt

Server Only

Full Syntax

mwtm checkgtt [-l logfilename] filename signalingpointname

Command Description

Checks the semantics and syntax of the specified GTT file on the specified signaling point. To write 
detailed syntax- and semantics-checking results to a file, specify -l and the name of the file.

You must log in as the root user or superuser to use this command.

mwtm checkmlr

Server Only

Full Syntax

mwtm checkmlr [-l logfilename] filename signalingpointname

Command Description

Checks the semantics and syntax of the specified MLR address table on the specified signaling point. To 
write detailed syntax- and semantics-checking results to a file, specify -l and the name of the file.

You must log in as the root user or superuser to use this command.
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mwtm checkroute

Server Only

Full Syntax

mwtm checkroute [-l logfilename] filename signalingpointname

Command Description

Checks the semantics and syntax of the specified route table file on the specified signaling point. To 
write detailed syntax- and semantics-checking results to a file, specify -l and the name of the file.

You must log in as the root user or superuser to use this command.

mwtm countas

Server Only

Command Description

Displays a count of application servers in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm countasp

Server Only

Command Description

Displays a count of application server processes in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm countaspa

Server Only

Command Description

Displays a count of application server process applications in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm countlinks

Server Only

Command Description

Displays a count of links in the current MWTM database.

You must log in as the root user or superuser to use this command.
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mwtm countlinksets

Server Only

Command Description

Displays a count of linksets in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm countsgmp

Server Only

Command Description

Displays a count of signaling gateway-mated pairs in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm countsps

Server Only

Command Description

Displays a count of signaling points in the current MWTM database.

You must log in as the root user or superuser to use this command.

mwtm deletearchive

Server Only

Full Syntax

mwtm deletearchive {-s signaling-point-name} {-t type} [-a address-table-name]

Command Description

Deletes a file from the archive.

• To delete an archived file, specify -s and the name of the signaling point, and specify -t and the type, 
which can be one of these:

– gtt

– route

– mlr*

*If you specify the type as mlr, you must also specify -a and the name of the address table. 

You must log in as the root user or superuser to use this command.
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mwtm deployarchive

Server Only

Full Syntax

mwtm deployarchive {-s signaling point name of source configuration} {-t type} [-a address table 
name] [-r revision number of file] [-c archive comment for deploy]

Command Description

Allows you to deploy an archived file to a specified signaling point. To:

• Deploy an archived file, specify -s and the name of the source configuration signaling point and 
specify -t and the type, which can be one of these:

– gtt

– route

– mlr*

*If you specify the type as mlr, you must also specify -a and the name of the address table. 

• Deploy a specific revision number of the archive file, specify -r and the revision number. If the 
revision is not specified, the current revision is deployed.

• Provide archive comments during deployment, specify -c and add your comments.

Once you have entered the command, you will receive a prompt to enter the destination signaling-point 
name. 

You must log in as the root user or superuser to use this command.

mwtm deploycomments

Server Only

Full Syntax

mwtm deploycomments {required | optional | status} 

Command Description

Allows you to require or make optional user comments during deployment. To:

• Prompt the user for comments during file archiving by using the wizard, specify required.

• Skip the prompt for comments during file archiving by using the wizard, specify optional. You can 
still specify comments by using CLI commands, such as mwtm pushgtt, mwtm pushmlr, and 
mwtm pushroute.

• Show the current settings on the command line, specify status.

You must log in as the root user or superuser to use this command.
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mwtm evreps clean

Server Only

Command Description

Removes all data from MWTM network event reports, restoring the reports to an unchanged state.

You must log in as the root user or superuser to use this command.

mwtm evreps cleancustom

Server Only

Full Syntax

mwtm evreps cleancustom [tag]

Command Description

Removes all data from one or more MWTM custom event reports, restoring the reports to an unchanged 
state. To clean:

• All custom reports, enter mwtm evreps cleancustom.

• A single custom report, enter mwtm evreps cleancustom tag, where tag is the ID tag of the custom 
report that you want to clean.

You must log in as the root user or superuser to use this command.

mwtm evreps diskcheck

Full Syntax

mwtm evreps [diskcheck | nodiskcheck]

Command Description

Specifies whether the MWTM should verify that a disk has at least 10 MB of space remaining before 
generating network event reports:

• diskcheck—Verify the disk space. This is the default setting.

• nodiskcheck—Do not verify the disk space.

If your system does not return the necessary amount of free space in a correct format that the MWTM 
can parse, use this command to disable checking and to allow reporting to continue.

See Chapter 12, “Managing ITP Reports” for more information on the output of this command.

You must log in as the root user or superuser to use this command.
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mwtm evreps enable

Server Only

Full Syntax

mwtm evreps [disable | enable]

Command Description

Enables the MWTM to generate event reports:

• enable—Generate network event reports. This is the default setting.

• disable—Do not generate network event reports.

The mwtm evreps command enables or disables the MWTM event reporting feature. To enable a 
specific type of event reporting, you must also enable that report type.

Note In this release, the only event reports that the MWTM can generate are MTP3 events (see mwtm evreps 
mtp, page B-85). To enable the MWTM event reporting feature, enter mwtm evreps enable. Then, to 
enable MTP3 event reporting, enter mwtm evreps mtp. To manually generate an MTP report from the 
command line, see mwtm mtpevents, page B-95.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 12, “Managing ITP Reports”

mwtm evreps hourlyage

Server Only

Full Syntax

mwtm evreps hourlyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive hourly network event reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days.

You must log in as the root user or superuser to use this command.
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mwtm evreps mtp

Server Only

Full Syntax

mwtm evreps [mtp | nomtp]

Command Description

Specifies whether the MWTM should generate MTP3 event reports:

• mtp—Generate MTP3 event reports.

• nomtp—Do not generate MTP3 event reports. This is the default setting.

Note The default setting for MTP3 event reporting is disabled. To enable MTP3 event reporting, first enter 
mwtm evreps enable (see mwtm evreps enable, page B-84). Then enter mwtm evreps mtp.

You must log in as the root user or superuser to use this command.

Related Topic

Chapter 12, “Managing ITP Reports”

mwtm evreps status

Server Only

Command Description

Displays the current status of all MWTM network event report parameters. You set these parameters by 
using the other mwtm evreps commands, such as:

• mwtm evreps [disable | enable] 

• mwtm evreps [diskcheck | nodiskcheck]

You must log in as the root user or superuser to use this command.

mwtm evreps timer

Server Only

Command Description

Displays the timer file for MWTM network event reports. The timer file is useful for identifying how 
much time the MWTM spends gathering report data and generating reports.

You must log in as the root user or superuser to use this command.
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mwtm gttclient

Solaris or Linux Clients Only

Full Syntax

mwtm gttclient [hostname]

Command Description

Starts an MWTM GTT client on the specified host. If no hostname is specified, starts an MWTM GTT 
client on the default host, as specified during installation. See Connecting to a New Server, page 5-42 
for information about determining the default host.

For more information about the MWTM GTT client, see Chapter 14, “Editing an ITP Global Title 
Translation Table.”

If you access a remote workstation through Telnet, you must set the DISPLAY variable to your local 
display or you cannot use this command. If the DISPLAY variable is not set automatically, you must set 
it manually (see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).

mwtm gttdir

Server Only

Full Syntax

mwtm gttdir [directory]

Command Description

Note You must stop the MWTM server before performing this command. The system prompts you whether to 
continue.

Sets the GTT staging directory, the directory in which the MWTM stores GTT files and enables Trivial 
File Transfer Protocol (TFTP) file transfer for the directory. See Chapter 14, “Editing an ITP Global 
Title Translation Table” for information about GTT files.

The default GTT staging directory resides in the MWTM installation directory. If you installed the 
MWTM in:

• The default directory, /opt, then the directory is /opt/CSCOsgm/gtt.

• A different directory, then the directory resides in that directory.

Use this command if you want to use a different GTT staging directory, such as /tftpboot or the Network 
File System location on another server, which is used as the TFTP server for server configuration files 
for ITPs in the network.This command copies all files in the current directory to the new directory. If 
you are not logged in as the superuser and do not own the new directory, you might not be able to copy 
the files. In this case, you must specify a directory that you own or log in as the root user.

Do not set the new directory to any of these: /usr, /var, /opt, or /tmp.
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Do not set the new directory to the same directory in which you are storing:

• Message log files (mwtm msglogdir)

• Report files (mwtm repdir)

• Route table files (mwtm routedir)

When you enter this command, the MWTM also prompts you to enable TFTP file transfer for the GTT 
staging directory and prompts you for the TFTP path for the directory, tftp://hostname/path, where:

• hostname is the name or IP address of the host on which the GTT staging directory resides.

If you enter a DNS name (such as mwm-jumbo) instead of an IP address (such as 172.18.12.10), 
then the ITP must be able to resolve the DNS name; otherwise, when you try to deploy a file, the 
MWTM issues an appropriate error message and does not deploy the file.

To enable the ITP to resolve DNS names, enter the ip domain-lookup command on the ITP. For 
more information about this command, see the Cisco IOS IP Command Reference, Volume 1 of 4: 
Addressing and Services, Release 12.3 or later.

• path is the path to the GTT staging directory. Do not include the TFTP root directory (/tftpboot, by 
default) in the path.

After you change the directory or enable TFTP file transfer for the directory, the MWTM asks if you 
want to restart the MWTM server. The new directory and TFTP setting take effect when you restart the 
MWTM server.

You must log in as the root user or superuser to use this command.

Note If you are setting up a new GTT staging directory on a Network File System location on another (remote) 
server, ensure that the server allows read-write access to the user account through which the MWTM is 
running and run this command as a superuser.
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mwtm gttstats

Server Only

Full Syntax

mwtm gttstats [node-list [id-tag]] [sort-option] [quiet]

Command Description

Generates MWTM GTT accounting statistics reports. To:

• Include or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

A single node or signaling point, specify a single node name, or node name and signaling-point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

To specify a node name and signaling point, enter:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This setting is 
also the default for this command; you only need to specify default if you also want to specify 
an id-tag, sort-option, or quiet.

– A group of nodes or signaling points other than the one that the nodes.include file specifies, 
create a file that contains the list of nodes and signaling points to include, and specify the full 
path and name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm gttstats command.

• Specify the sort order for the reports, specify one of these keywords for the sort-option argument:

– -sgt—Sort based on the GTA, in descending order.

– -sno—Sort based on the node name, in ascending order.

– -spc—Sort based on the point code, in ascending order.

– -ssn—Sort based on the selector name, in ascending order.

– -sto—Sort based on the total number of octets translated by GTT, in descending order.

– -stp—Sort based on the total number of packets translated by GTT, in descending order. This is 
the default setting.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.

Before entering this command, you must enable the MWTM to generate GTT accounting statistics 
reports. See the description of the mwtm statreps [gtt | nogtt] command for more information.
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The first time you use the mwtm gttstats command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you only need to enter this command once to generate the report.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49

mwtm linkstats

Server Only

Full Syntax

mwtm linkstats [node-list [id-tag]] [sort-option] [quiet]

Command Description

Generates MWTM link and linkset statistics summary reports. To include:

• Or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling-point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

A node name and signaling point:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This setting is 
also the default for this command; you only need to specify default if you also want to specify 
an id-tag, sort-option, or quiet.

– A group of nodes or signaling points other than the one specified in the nodes.include file, create 
a file that contains the list of nodes and signaling points to include; and, specify the full path 
and name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm linkstats command.
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• Specify the sort order for the reports, specify one of these keywords for the sort-option argument:

– -sco—Sort based on the average Congestion for each link (Avg Cong %), in descending order.

– -sis—Sort based on in-service percentage for each link (InSrv), in descending order.

– -sls—Sort based on the linkset name, in ascending order.

– -srm—Sort based on the total number of MTP3 MSUs that each link (Recv MSUs) receives, in 
descending order.

– -sru—Sort based on the average Receive Utilization for each link (Avg Receive Util or Avg 
Receive Erls), in descending order.

– -ssm—Sort based on the total number of MTP3 MSUs that each link (Send MSUs) sends, in 
descending order.

– -ssu—Sort based on the average Send Utilization for each link (Avg Send Util or Avg Send 
Erls), in descending order. This is the default setting.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.

Before entering this command, you must enable the MWTM to generate link and linkset statistics 
summary reports. See the description of the mwtm statreps [link | nolink] command for more 
information.

The first time you use the mwtm linkstats command to generate a report, you must enter the command 
at least three times. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful link and linkset statistics.

• Third entry continues to calculate statistics, calculates long-term averages; and, if the collected data 
appears valid, begins generating the report.

Thereafter, you only need to enter this command once to generate the report.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49
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mwtm listarchive

Server Only

Full Syntax

mwtm listarchive {-n node name | -s signaling point name} {-t type} [-a address table name]

Command Description

Displays a list of all the files in the Version Control System (VCS) archive or just those of a particular 
type for a specified node or signaling point. To show a list of files in the VCS of a particular:

• Node, specify -n and the node name. 

• Signaling point, specify -s and the name of the signaling point.

• Type, specify -t and the type, which can be one of these:

– gtt

– route

– mlr*

*If you specify the type as mlr, you must also specify -a and the name of the address table. 

You must log in as the root user or superuser to use this command.

mwtm listgtt

Server Only

Full Syntax

mwtm listgtt [directory]

Command Description

Lists all current GTT files in the specified directory (directory must be a subdirectory of the GTT staging 
directory). If no directory is specified, lists all current GTT files in the GTT staging directory.

You must log in as the root user or superuser to use this command.
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mwtm listhistory

Server Only

Full Syntax

mwtm listhistory {-s signaling point name} {-t type} [-a address table name]

Command Description

Displays the revision history for a specified archive file. To show the revision history for a particular:

• Signaling point, specify -s and the name of the signaling point.

• Type of file, specify -t and the type, which can be one of these:

– gtt

– route

– mlr*

*If you specify the type as mlr, you must also specify -a and the name of the address table. 

You must log in as the root user or superuser to use this command.

mwtm listmlr

Server Only

Full Syntax

mwtm listmlr [directory]

Command Description

Lists all current MLR address files in the address table staging directory (for details on setting the 
address table staging directory, see mwtm atbldir, page B-78.) If a subdirectory is specified, lists all 
current MLR address files in the specified subdirectory (directory must be a subdirectory of the address 
table staging directory). 

You must log in as the root user or superuser to use this command.

mwtm listroute

Server Only

Full Syntax

mwtm listroute [directory]

Command Description

Lists all current route table files in the specified directory (directory must be a subdirectory of the DPC 
Route staging directory). If no directory is specified, lists all current route table files in the DPC Route 
staging directory.

You must log in as the root user or superuser to use this command.
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mwtm mlrstats

Server Only

Full Syntax

mwtm mlrstats [node-list [id-tag]] [sort-option] [quiet]

Command Description

Generates MWTM MLR processed, aborts, continues, result invokes, rule matches, subtriggers, and 
triggers reports. To:

• Include or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

To specify a node name and signaling point:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This setting is 
also the default for this command; you only need to specify default if you also want to specify 
an id-tag, sort-option, or quiet.

– A group of nodes or signaling points other than the one specified in the nodes.include file, create 
a file that contains the list of nodes and signaling points to include and specify the full path and 
name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm mlrstats command.

• Specify the sort order for the reports, specify one of these keywords for the sort-option argument:

– -sab—Sort based on the number of MSUs not processed by MLR (Aborts), in descending order.

– -sal—Sort based on the number of MSUs of type GSM-MAP AlertSc that MLR (MAP Alerts) 
processed, in descending order.

– -sco—Sort based on the number of MSUs passed back to SCCP that MLR (Continue) 
processed, in descending order.

– -smo—Sort based on the number of MSUs of type GSM-MAP SMS-MO that MLR (MAP 
SMS-MOs) processed, in descending order.

– -smt—Sort based on the number of MSUs of type GSM-MAP SMS-MT that MLR (MAP 
SMS-MTs) processed, in descending order.

– -sno—Sort based on the node name, in ascending order.

– -snt—Sort based on the number of MSUs of type ANSI-41 SMSNotify that MLR (ANSI-41 
SMS-Notifys) processed, in descending order.
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– -spp—Sort based on the number of MSUs of type ANSI-41 SMD-PP that MLR (ANSI-41 
SMD-PPs) processed, in descending order.

– -sre—Sort based on the number of MSUs of type ANSI-41 SMSRequest that MLR (ANSI-41 
SMD-Reqs) processed, in descending order.

– -sri—Sort based on the number of MSUs of type GSM-MAP SRI-SM that MLR (MAP 
SRI-SMs) processed, in descending order.

– -sro—Sort based on the number of packets that MLR (Routed) routed, in descending order.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.

If you do not specify the quiet keyword (that is, if you view the output on your terminal), the 
MWTM displays only instance-level statistics (as listed in the description of the sort-option 
argument). To see the full set of trigger-level statistics, you must use the MWTM web interface (see 
MLR Reports, page 12-33).

Before entering this command, you must enable the MWTM to generate MLR processed, aborts, 
continues, result invokes, rule matches, subtriggers, and triggers reports. See the description of the 
mwtm statreps [mlr | nomlr] command for more information.

The first time you use the mwtm mlrstats command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you only need to enter this command once to generate the report.

See MLR Reports, page 12-33 for more information on MLR reports.

You must log in as the root user or superuser to use this command.
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mwtm mtpevents

Server Only

Full Syntax

mwtm mtpevents [node-list [id-tag]] [quiet]

Command Description

Generates MWTM MTP3 event reports. To:

• Include or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling-point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

To specify a node name and signaling point:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This setting is 
also the default for this command; you only need to specify default if you also want to specify 
an id-tag or quiet.

– A group of nodes or signaling points other than the one that the nodes.include file specified, 
create a file that contains the list of nodes and signaling points to include; and, specify the full 
path and name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm mtpevents command.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.

The first time you use the mwtm mtpevents command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you need only enter this command once to generate the report.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49
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mwtm pcformat

Server Only

Full Syntax

mwtm pcformat {edit | list | master | restore}

Command Description

You use this command to set the point code format for this MWTM server and for all associated MWTM 
clients to use. You need to set the point code format usually only once, after installation.

You also use this command to configure the MWTM to recognize a single-instance ITP connecting to 
multiple instances on a multiple-instance ITP. In effect, the MWTM views the multiple networks as a 
single all-encompassing network.

The point code format configuration is contained in the PointCodeFormat.xml file. To work with the file, 
specify one of these keywords:

• edit—Opens the PointCodeFormat.xml file for editing.

• list—Displays the current contents of the PointCodeFormat.xml file.

• master—Restores the PointCodeFormat.xml file to the default settings.

• restore—Restores the PointCodeFormat.xml file to the last saved copy.

Any changes that you make take effect when you restart the MWTM server.

The MWTM preserves customized point code formats when you upgrade to a new version or release of 
the MWTM.

See Setting the ITP Point Code Format, page 3-5 and Connecting a Single-Instance ITP to a 
Multiple-Instance ITP, page 3-6 for more information about using this command.

You must log in as the root user or superuser to use this command.

mwtm pclist

Server Only

Command Description

Lists all point codes that all nodes that the MWTM detects are currently using.

You must log in as the root user or superuser to use this command.
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mwtm pushgtt

Server Only

Full Syntax

mwtm pushgtt [-l logfilename] [-u username] [-p password] [-n enableusername] [-e enablepassword] 
[-s storagedevicename] [-c archive comments] [--overwrite|--no-overwrite] [--activate|--no-activate] 
filename signalingpointname

Command Description

Uploads the specified GTT file to the specified ITP signaling point.

Use these keywords and arguments with this command. If you do not specify a required keyword or 
argument, the MWTM prompts you to specify it.

• -l logfilename—Writes detailed syntax and semantics checking results, as well as a detailed Telnet 
log, to the specified file.

• -u username—Log in username, if required by the ITP.

• -p password—Log in password, if required by the ITP.

• -n enableusername—Enable username, if required by the ITP.

• -e enablepassword—Enable password, if required by the ITP.

• -s storagedevicename—If the ITP has more than one storage device, uploads the file to the specified 
device, such as disk1, flash, or slot2.

• -c archive comments—Allows you to provide optional archive comments.

• --overwrite—If the specified file already exists on the specified ITP signaling point, overwrites the 
file.

• --no-overwrite—If the specified file already exists on the specified ITP signaling point, does not 
overwrite the file.

• --activate—Uploads the file and activates it (replaces the currently running file with the uploaded 
file).

• --no-activate—Uploads the file without activating it (does not replace the currently running file).

You must log in as the root user or superuser to use this command.

mwtm pushmlr

Server Only

Full Syntax

mwtm pushmlr [-l logfilename] [-u username] [-p password] [-n enableusername] 
[-e enablepassword] [-s storagedevicename] [-c archive comments] [--overwrite|--no-overwrite] 
[--activate|--no-activate] filename signalingpointname

Command Description

Uploads the specified address table file to the specified ITP signaling point.

Use these keywords and arguments with this command. If you do not specify a required keyword or 
argument, the MWTM prompts you to specify it.
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• -l logfilename—Writes detailed syntax and semantics checking results, as well as a detailed Telnet 
log, to the specified file.

• -u username—Log in username, if the ITP requires.

• -p password—Log in password, if the ITP requires.

• -n enableusername—Enable username, if the ITP requires.

• -e enablepassword—Enable password, if the ITP requires.

• -s storagedevicename—If the ITP has more than one storage device, uploads the file to the specified 
device, such as disk1, flash, or slot2.

• -c archive comments—Allows you to provide optional archive comments.

• --overwrite—If the specified file already exists on the specified ITP signaling point, overwrites the 
file.

• --no-overwrite—If the specified file already exists on the specified ITP signaling point, does not 
overwrite the file.

• --activate—Uploads the file and activates it (replaces the currently running file with the uploaded 
file).

• --no-activate—Uploads the file without activating it (does not replace the currently running file).

You must log in as the root user or superuser to use this command.

mwtm pushroute

Server Only

Full Syntax

mwtm pushroute [-l logfilename] [-u username] [-p password] [-n enableusername] 
[-e enablepassword] [-s storagedevicename] [-c archive comments] [--overwrite|--no-overwrite] 
[--activate|--no-activate] filename signalingpointname

Command Description

Uploads the specified route table file to the specified ITP signaling point.

Use these keywords and arguments with this command. If you do not specify a required keyword or 
argument, the MWTM prompts you to specify it.

• -l logfilename—Writes detailed syntax and semantics checking results, as well as a detailed Telnet 
log, to the specified file.

• -u username—Log in username, if the ITP requires.

• -p password—Log in password, if the ITP requires.

• -n enableusername—Enable username, if the ITP requires.

• -e enablepassword—Enable password, if the ITP requires.

• -s storagedevicename—If the ITP has more than one storage device, uploads the file to the specified 
device, such as disk1, flash, or slot2.

• -c archive comments—Allows you to provide optional archive comments.

• --overwrite—If the specified file already exists on the specified ITP signaling point, overwrites the 
file.
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• --no-overwrite—If the specified file already exists on the specified ITP signaling point, does not 
overwrite the file.

• --activate—Uploads the file and activates it (replaces the currently running file with the uploaded 
file).

• --no-activate—Uploads the file without activating it (does not replace the currently running file).

You must log in as the root user or superuser to use this command.

mwtm q752stats

Server Only

Full Syntax

mwtm q752stats [node-list [id-tag]] [quiet]

Command Description

.Manually generates MWTM Q.752 statistics reports. To include:

• Or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

To specify a node name and signaling point:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This is also the 
default setting for this command; you only need to specify default if you also want to specify 
an id-tag or quiet.

– A group of nodes or signaling points other than the one specified in the nodes.include file, create 
a file that contains the list of nodes and signaling points to include and specify the full path and 
name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm q752stats command.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.



 

B-100
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  ITP Commands

The first time you use the mwtm q752stats command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you only need to enter this command once to generate the report.

You must log in as the root user or superuser to use this command. 

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49

mwtm repcustage

Server Only

Full Syntax

mwtm repcustage [number-of-days]

Command Description

Maximum number of days the MWTM should archive custom reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 10 days.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm repdir

Server Only

Full Syntax

mwtm repdir [directory]

Command Description

Note You must stop the MWTM server before performing this command. You are prompted whether to 
continue.

Sets the directory in which the MWTM stores report files. See Chapter 12, “Managing ITP Reports” for 
information about MWTM reports.
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The default directory for report files resides in the MWTM installation directory. If you installed the 
MWTM in:

• The default directory, /opt, then the default directory is /opt/CSCOsgm/reports.

• A different directory, then the default directory resides in that directory.

Use this command if you want to store report files in a different directory; for example, in a Network 
File System location on another server.

Note This command copies all files in the current directory to the new directory. If you are not logged in as 
the superuser and you do not own the new directory, you might not be able to copy the files. In that case, 
you must specify a directory that you own or log in as the root user.

Do not set the new directory to any of these: /usr, /var, /opt, or /tmp.

Do not set the new directory to the same directory in which you are storing GTT files (mwtm gttdir), 
message log files (mwtm msglogdir), route table files (mwtm routedir), or address table files 
(mwtm atbldir).

After you change the directory, the MWTM asks if you want to restart the MWTM server. The new 
directory takes effect when you restart the MWTM server.

You must log in as the root user or superuser to use this command.

mwtm replog

Server Only

Full Syntax

mwtm replog [clear | -r]

Command Description

Uses PAGER to display the contents of the system reports log. The reports log lists all messages that you 
use for the creation and maintenance of MWTM reports.

To clear the log and restart the server, enter mwtm replog clear.

To display the contents of the log in reverse order, with the most recent commands at the beginning of 
the log, enter mwtm replog -r.

The default path and filename for the system reports log file is /opt/CSCOsgm/logs/sgmReportLog.txt. 
If you installed the MWTM in a directory other than /opt, then the system reports log file resides in that 
directory.

You must log in as the root user or superuser to use this command.



 

B-102
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  ITP Commands

mwtm routedir

Server Only

Full Syntax

mwtm routedir [directory]

Command Description

Note You must stop the MWTM server before performing this command. The system prompts you whether to 
continue.

Sets the DPC Route staging directory, the directory in which the MWTM stores ITP route table files, and 
enables Trivial File Transfer Protocol (TFTP) file transfer for the directory. See Chapter 13, “Editing an 
ITP Route Table File” for information about ITP route table files.

The default DPC Route staging directory resides in the MWTM installation directory. If you installed 
the MWTM in:

• The default directory, /opt, then the directory is /opt/CSCOsgm/routes.

• A different directory, then the directory resides in that directory.

Use this command if you want to use a different DPC Route staging directory, such as /tftpboot or a 
Network File System location on another server that is used as the Trivial File Transfer Protocol (TFTP) 
server for server configuration files for ITPs in the network.

Note This command copies all files in the current directory to the new directory. If you do not log in as the 
superuser and own the new directory, you might not be able to copy the files. In this case, you must 
specify a directory that you own or log in as the root user.

Do not set the new directory to any of these: /usr, /var, /opt, or /tmp.

Do not set the new directory to the same directory in which the GTT files (mwtm gttdir), message log 
files (mwtm msglogdir), report files (mwtm repdir), or address table files (mwtm atbldir) reside.

When you enter this command, the MWTM also prompts you to enable TFTP file transfer for the DPC 
Route staging directory and for the TFTP path for the directory, tftp://hostname/path, where:

• hostname is the name or IP address of the host on which the DPC Route staging directory resides.

If you enter a DNS name (such as mwm-jumbo) instead of an IP address (such as 172.18.12.10), 
then the ITP must be able to resolve the DNS name; otherwise, when you try to deploy a file, the 
MWTM issues an appropriate error message and does not deploy the file.

To enable the ITP to resolve DNS names, enter the ip domain-lookup command on the ITP. For 
more information about this command, see the Cisco IOS IP Command Reference, Volume 1 of 4: 
Addressing and Services, Release 12.3 or later.

• path is the path to the DPC Route staging directory. Do not include the TFTP root directory 
(/tftpboot, by default) in the path.
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After you change the directory or enable TFTP file transfer for the directory, the MWTM asks if you 
want to restart the MWTM server. The new directory and TFTP setting take effect when you restart the 
MWTM server.

You must log in as the root user or superuser to use this command.

Note If you are setting up a new DPC Route staging directory on a Network File System location on another 
(remote) server, ensure that the server allows read-write access to the user account through which the 
MWTM runs and run this command as a superuser.

mwtm routetabledefs

Server Only

Full Syntax

mwtm routetabledefs [true | false]

Command Description

Specifies whether the MWTM should automatically populate the Route Table dialog box with default 
values:

• true—Automatically populate the Route Table dialog box with default values. This is the default 
setting.

• false—Do not automatically populate the Route Table dialog box with default values; that is, force 
the user to enter values in the dialog box.

When you enter this command, the new setting takes effect when you restart the MWTM server.

You must log in as the root user or superuser to use this command.

mwtm start atblclient

Server and all Clients

Full Syntax

mwtm start atblclient [hostname]

Command Description

Starts an MWTM Address Table Editor client on the specified host. If no hostname is specified, starts 
an MWTM Address Table Editor client on the default host, as specified during installation. See 
Connecting to a New Server, page 5-42 for information about determining the default host.

If you access a remote workstation through Telnet, you must set the DISPLAY variable to your local 
display or you cannot use this command. If the DISPLAY variable is not set automatically, you must set 
it manually (see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).

This command has the same function as the mwtm atblclient command.
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mwtm start gttclient

Server and all Clients

Full Syntax

mwtm start gttclient [hostname]

Command Description

Starts an MWTM GTT client on the specified host. If no hostname is specified, starts an MWTM GTT 
client on the default host, as specified during installation. See Connecting to a New Server, page 5-42 
for information about determining the default host.

If you access a remote workstation through Telnet, you must set the DISPLAY variable to your local 
display or you cannot use this command. If the DISPLAY variable is not set automatically, you must set 
it manually (see Setting the DISPLAY Variable for Solaris or Linux Clients, page 4-3).

This command has the same function as the mwtm gttclient command.

mwtm statreps 15minage

Server Only

Full Syntax

mwtm statreps 15minage [number-of-days]

Command Description

Maximum number of days the MWTM should archive 15-minute network statistics reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days.

This command has the same function as the mwtm rep15minage command.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps acct

Server Only

Full Syntax

mwtm statreps [acct | noacct]

Command Description

Specifies whether the MWTM should generate MTP3 accounting statistics reports:

• acct—Generate MTP3 accounting statistics reports. You must enable MTP3 accounting on the links 
for the MWTM to generate MTP3 accounting statistics.

• noacct—Do not generate MTP3 accounting statistics reports. This is the default setting.

Note This command does not trigger the immediate collection of statistics. By default, MWTM 
collects MTP3 accounting statistics nightly. It might take up to 2 days before the first reports are 
generated.

See MTP3 Accounting Reports, page 12-43 for more information on MTP3 accounting statistics reports.

You must log in as the root user or superuser to use this command.

mwtm statreps clean

Server Only

Command Description

Removes all data from MWTM network statistics reports, restoring the reports to an unchanged state.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps cleancustom

Server Only

Full Syntax

mwtm statreps cleancustom [tag]

Command Description

Removes all data from one or more MWTM custom statistics reports, restoring the reports to an 
unchanged state. To clean:

• All custom reports, enter mwtm statreps cleancustom.

• A single custom report, enter mwtm statreps cleancustom tag, where tag is the ID tag of the 
custom report that you want to clean.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps custage

Server Only

Full Syntax

mwtm statreps custage [number-of-days]

Command Description

Maximum number of days the MWTM should archive custom reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 10 days.

This command has the same function as the mwtm repcustage command.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps dailyage

Server Only

Full Syntax

mwtm statreps dailyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive daily network statistics reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 90 days.

This command has the same function as the mwtm repdailyage command.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps diskcheck

Server Only

Full Syntax

mwtm statreps [diskcheck | nodiskcheck]

Command Description

Specifies whether the MWTM should verify that a disk has at least 10 MB of space remaining before 
generating network statistics reports:

• diskcheck—Verify the disk space. This is the default setting.

• nodiskcheck—Do not verify the disk space.

If your system does not return the necessary amount of free space, in a correct format that the MWTM 
can parse, use this command to disable checking to allow reporting to continue.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps enable

Server Only

Full Syntax

mwtm statreps [disable | enable]

Command Description

Use to generate network statistics and accounting reports:

• enable—Generate network statistics and accounting reports. This is the default setting.

• disable—Do not generate network statistics and accounting reports.

You must enter this command to generate network statistics and accounting reports before entering the 
mwtm accstats, mwtm gttstats, mwtm linkstats, mwtm mlrstats, and mwtm xuastats commands.

See Chapter 12, “Managing ITP Reports” for more information on network statistics and accounting 
reports.

You must log in as the root user or superuser to use this command.

mwtm statreps export

Server Only

Full Syntax

mwtm statreps [export | noexport]

Command Description

Specifies whether the MWTM should generate network statistics and accounting reports in export 
format:

• export—Generate network statistics reports in export format. This is the default setting.

• noexport—Do not generate network statistics reports in export format.

Network statistics reports in export format are .zip files that contain comma-separated value (CSV) text 
files that you can download and unzip.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling ITP Reports, page 12-2
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mwtm statreps gtt

Server Only

Full Syntax

mwtm statreps [gtt | nogtt]

Command Description

Specifies whether the MWTM should generate GTT accounting statistics reports:

• gtt—Generate GTT accounting statistics reports. You must enable GTT accounting for the MWTM 
to generate GTT accounting statistics.

• nogtt—Do not generate GTT accounting statistics reports. This is the default setting.

Note This command does not trigger immediate collection of statistics. By default, MWTM collects 
GTT accounting statistics nightly. It might take up to 2 days before the first reports are 
generated. 

See GTT Accounting Reports, page 12-41 for more information on GTT accounting statistics reports.

You must log in as the root user or superuser to use this command.

mwtm statreps hourlyage

Server Only

Full Syntax

mwtm statreps hourlyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive hourly network statistics reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 31 days.

This command has the same function as the mwtm rephourlyage command.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps iplinks

Server Only

Full Syntax

mwtm statreps [iplinks | noiplinks]

Command Description

Specifies whether the MWTM should include links that use the Stream Control Transmission Protocol 
(SCTP) IP transport protocol in network statistics reports:

• iplinks—Include SCTPIP links. This is the default setting.

• noiplinks—Do not include SCTPIP links.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps link

Server Only

Full Syntax

mwtm statreps [link | nolink]

Command Description

Specifies whether the MWTM should generate link and linkset statistics summary reports:

• link—Generate link and linkset statistics summary reports.

• nolink—Do not generate link and linkset statistics summary reports. This is the default setting.

Note This command does not trigger immediate collection of statistics. By default, MWTM collects 
link and linkset statistics hourly. It might take up to 2 hours before the first reports are generated. 
See Link Reports, page 12-21 and Linkset Reports, page 12-28 for more information on link and 
linkset statistics summary reports.

You must log in as the root user or superuser to use this command.
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mwtm statreps maxcsvrows

Server Only

Full Syntax

mwtm statreps maxcsvrows [rows]

Command Description

Specifies the maximum number of rows that the MWTM includes in export CSV files:

• rows—Maximum number of rows to include.

Note If you want to limit export CSV files to a size that Microsoft Excel can handle, set the value to 
65535.

This command only applies to these files:

• MWTMLinksetStats.RollingSevenDayAllHours.csv.zip

• MWTMLinkStats.RollingSevenDayAllHours.csv.zip

• MWTMAccStats.DailyDetail.<yyyy-mm-dd>.csv.zip

See Rolling Network Statistics Archived Reports, page 12-71 and Daily MTP3 Accounting Statistics 
Archived Reports, page 12-45 for more information on affected CSV files.

You must log in as the root user or superuser to use this command.

mwtm statreps mlr

Server Only

Full Syntax

mwtm statreps [mlr | nomlr]

Command Description

Specifies whether the MWTM should generate MLR accounting reports:

• mlr—Generate MLR reports. You must also enable MLR reporting for the MWTM to generate MLR 
reports.

• nomlr—Do not generate MLR reports. This is the default setting.

Note This command does not trigger immediate collection of statistics. By default, MWTM collects 
MLR accounting statistics nightly. It might take up to 2 days before the first reports are 
generated. 

See MLR Reports, page 12-33 for more information on MLR reports.

You must log in as the root user or superuser to use this command.



 

B-112
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix B      Command Reference
  ITP Commands

mwtm statreps monthlyage

Server Only

Full Syntax

mwtm statreps monthlyage [number-of-days]

Command Description

Maximum number of days the MWTM should archive monthly network statistics reports.

If you enter this command without the number-of-days argument, the MWTM displays the current 
maximum number of days. You can then change that value or leave it. The valid range is 1 day to an 
unlimited number of days. The default value is 3650 days.

This command has the same function as the mwtm repmonthlyage command.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps msu

Server Only

Full Syntax

mwtm statreps [msu | nomsu]

Command Description

Specifies whether the MWTM should generate MSU rates reports:

• msu—Generate MSU rates reports. You must also enable reporting for the MWTM to generate MSU 
rates reports.

• nomsu—Do not generate MSU rates reports. This is the default setting.

See MSU Rates Reports, page 12-39 for more information on MSU rates reports.

You must log in as the root user or superuser to use this command.
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mwtm statreps nullcaps

Server Only

Full Syntax

mwtm statreps [nullcaps | nonullcaps]

Command Description

Specifies whether the MWTM should include SCTP links that do not have planned send and receive 
capacities in network statistics reports:

• nullcaps—Include SCTP links that do not have planned send and receive capacities. This is the 
default setting.

• nonullcaps—Do not include SCTP links that do not have planned send and receive capacities.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps q752

Server Only

Full Syntax

mwtm statreps [q752 | noq752]

Command Description

Specifies whether the MWTM should generate Q.752 daily statistics reports:

• q752—Generate Q.752 statistics reports. 

• noq752—Do not generate Q.752 statistics reports. This is the default setting.

Note This command does not trigger immediate collection of statistics. By default, MWTM collects 
Q.752 statistics nightly. It might take up to 2 days before the first reports are generated. 

You must log in as the root user or superuser to use this command.
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mwtm statreps servratio

Server Only

Full Syntax

mwtm statreps servratio [factor]

Command Description

Displays a gray background in the InSrv cell in a network statistics report, if this condition is met:

Current In-Service < factor * Long-Term In-Service

The default value for factor is 0.95.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps status

Server Only

Command Description

Displays the current status of all MWTM network statistics report parameters. You use the other 
mwtm statreps commands, such as mwtm statreps [disable | enable] and mwtm statreps 
[diskcheck | nodiskcheck] to set these parameters.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps timemode

Server Only

Full Syntax

mwtm statreps timemode [12 | 24]

Command Description

Sets the time mode for dates in network statistics reports:

• 12—Use 12-hour clock, with AM and PM. 1:00 in the afternoon is 1:00 PM.

• 24—Use 24-hour clock, also called military time. 1:00 in the afternoon is 13:00. This is the default 
setting.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps timer

Server Only

Command Description

Displays the timer file for MWTM network statistics reports. The timer file is useful for identifying how 
much time the MWTM spends gathering report data and generating reports.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7
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mwtm statreps utilratio

Server Only

Full Syntax

mwtm statreps utilratio [factor]

Command Description

Displays a gray background in the Send Utilization or Receive Utilization cell in a network statistics 
report, if this condition is met:

Current Utilization > factor * Long-Term Utilization

The default value for factor is 1.50.

You must log in as the root user or superuser to use this command.

Related Topic

Customizing ITP Report Preferences, page 12-7

mwtm statreps xua

Server Only

Full Syntax

mwtm statreps [xua | noxua]

Command Description

Specifies whether the MWTM should generate statistics reports for application servers and application 
server processes:

• xua—Generate statistics reports for application servers and application server processes.

• noxua—Do not generate statistics reports for application servers and application server processes. 
This is the default setting.

Note This command does not trigger immediate collection of statistics. By default, MWTM collects 
xUA statistics hourly. It might take up to 2 hours before the first reports are generated. 

See Application Server Reports, page 12-11 and Application Server Process Reports, page 12-14 for 
more information on statistics reports for application servers and application server processes.

You must log in as the root user or superuser to use this command.
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mwtm xuastats

Server Only

Full Syntax

mwtm xuastats [node-list [id-tag]] [sort-option] [quiet]

Command Description

Generates MWTM accounting statistics reports for application servers and application server processes. 
To:

• Include or exclude specific objects in the reports, use the node-list argument. To include:

– All nodes, specify all.

– A single node or signaling point, specify a single node name, or node name and signaling-point 
name, as the node-list argument. The node name must exactly match the node name that the 
MWTM discovered, including the domain name, and each line must end with a colon (:). 

For example:

mwtm-75-59a.cisco.com:

To specify a node name and signaling point:

mwtm-75-59a.cisco.com;net0:

– Or exclude objects based on the contents of the user-defined nodes.include, linksets.include, 
nodes.exclude, and linksets.exclude files, create the files, then specify default. This is also the 
default setting for this command; you only need to specify default if you also want to specify 
an id-tag, sort-option, or quiet.

– A group of nodes or signaling points other than the one specified in the nodes.include file, create 
a file that contains the list of nodes and signaling points to include and specify the full path and 
name of the file as the node-list argument.

If you specify a node-list, you can also specify an id-tag to identify the reports. The id-tag can be 
any meaningful character string, but it cannot contain any spaces. The default value for id-tag is the 
process ID of the mwtm xuastats command.

• Specify the sort order for an application server report, specify one of these keywords for the 
sort-option argument:

– -sfm—Sort based on the Packets From MTP3 column, in descending order. This is the default 
setting.

– -sta—Sort based on the Packets To ASPs column, in descending order.

• Specify the sort order for an application server process report, specify one of these keywords for the 
sort-option argument:

– -sfa—Sort based on the Packets From ASPs column, in descending order. This is the default 
setting.

– -sfm—Sort based on the Packets From MTP3 column, in descending order.

– -sre—Sort based on the Receive Errors column, in descending order.
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– -sse—Sort based on the Send Errors column, in descending order.

– -sta—Sort based on the Packets To ASPs column, in descending order.

– -stm—Sort based on the Packets To MTP3 column, in descending order.

• Disable automatic output to the terminal when running this command in a script, specify the quiet 
keyword. The MWTM generates the report in export format, which you can view by using the 
MWTM web interface.

Before entering this command, you must enable the MWTM to generate accounting statistics reports for 
application servers and application server processes. See the description of the mwtm statreps 
[xua | noxua] command for more information.

The first time you use the mwtm xuastats command to generate a report, you must enter the command 
at least twice. The:

• First entry gets the first set of raw data.

• Second entry begins calculating useful accounting statistics and, if the collected data appears valid, 
begins generating the report.

Thereafter, you need only enter this command once to generate the report.

You must log in as the root user or superuser to use this command.

Related Topic

Enabling Custom Archived Statistics Reports, page 12-49
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This appendix contains:

• General FAQs, page C-1

• ITP Specific FAQs, page C-13

• RAN-O Specific FAQs, page C-17

General FAQs
These categories of frequently asked questions are general questions about the Cisco Mobile Wireless 
Transport Manager (MWTM):

• Installation Questions, page C-1

• Server Questions, page C-2

• GUI Questions, page C-5

• Browser Questions, page C-6

• Topology Questions, page C-6

• Events and Alarms Questions, page C-7

• Polling Questions, page C-8

• MIB Questions, page C-9

• Miscellaneous Questions, page C-9

Installation Questions
This section addresses the following installation questions:

• How do I install the MWTM client?, page C-2

• After a failed uninstall of the Windows client, I am prompted to uninstall again, but the procedure 
does not work. Why?, page C-2

• Why do I see strange character strings when I install the MWTM?, page C-2
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How do I install the MWTM client?

You can install the MWTM client either from the DVD distributed with the MWTM, or by using a web 
browser to download the MWTM client from an MWTM server. See the Installation Guide for the Cisco 
Mobile Wireless Transport Manager 6.0 for full details.

After a failed uninstall of the Windows client, I am prompted to uninstall again, but the procedure does not work. 
Why?

If for some reason the Windows MWTM client uninstall procedure fails before the client is completely 
uninstalled, the MWTM prompts you to uninstall the client again. However, this might not be possible 
using the standard Add/Remove Programs icon in the Windows Control Panel, or from the Windows 
Start menu.

If you cannot uninstall the MWTM client using the standard procedure, use this procedure:

Step 1 Delete the MWTM client installation directory and its contents. If you installed the MWTM client in the 
default directory, C:\Program Files, then the installation directory is C:\Program Files\Cisco 
Systems\MWTM Client. If you installed the MWTM client in a different directory, then the installation 
directory resides in that directory.

Step 2 Delete the MWTM Client entries from the Windows Start menu and desktop.

Why do I see strange character strings when I install the MWTM?

Some UNIX systems use the LANG variable to indicate the locale. The setting of the LANG 
environment variable can cause syntax errors in the MWTM setup scripts, which can result in messages 
that contain strange character strings such as ?y?d@O. To correct this problem, unset the LANG 
environment variable in the workstation from which you are installing the MWTM, using one of these 
commands:

• If you are running sh, enter the unset LANG command.

• If you are running csh, enter the unsetenv LANG command.

Then install the MWTM again.

Server Questions
This section addresses the following server questions:

• What workstation and network devices do I need to run the MWTM?, page C-3

• Why can’t my remote workstation access the MWTM on my local workstation?, page C-3

• I moved the server on which I had installed the MWTM and now I can’t start the MWTM client or 
server. Why?, page C-3

• Why did I receive a “cannot connect to server” message?, page C-4

• Will the MWTM server processes restart automatically after a system reboot?, page C-5

• Why doesn’t my MWTM server start after installing SSL?, page C-5
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What workstation and network devices do I need to run the MWTM?

The MWTM comprises two distinct pieces of functionality.

• The MWTM server application runs on Solaris/Linux only.

• The MWTM client application, including the user interface, runs on Solaris/Linux and 
Windows XP Professional. For Solaris/Linux, the MWTM client can run on the same system as the 
MWTM server, or on a different system.

Note The Linux client is unsupported.

For further hardware and software requirements, see the “Preparing to Install the MWTM” chapter of 
the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0.

Why can’t my remote workstation access the MWTM on my local workstation?

Keep in mind that performance is always better if you access the MWTM by installing the MWTM client 
on the remote workstation.

However, if you want to enable a remote Solaris/Linux workstation to access the MWTM on a local 
workstation, enter the xhost + remote_workstation UNIX command on your local workstation, where 
remote_workstation is the remote device you are enabling to access your local workstation.

To enable a remote Windows workstation to access the MWTM on a local workstation, you can use an 
X-Window system emulator such as eXceed or Reflection X, but be aware that there might be display 
problems. For example, the window borders might disappear, or the keyboard focus might be missing.

The X Performance Enhancer (AntiAliasing Off) check box in the Preferences window specifies 
whether antialiasing is turned on in the topology map. Antialiasing, which is turned on by default, 
improves the appearance of the icons and connections in the map.

You can improve the performance of the MWTM client on a remote workstation by turning off 
antialiasing in the topology map. For more information, see Turning Off Antialiasing, page 10-27.

I moved the server on which I had installed the MWTM and now I can’t start the MWTM client or server. Why?

If you change the IP address of the server on which you installed the MWTM, or if you move the server 
to a new network, you must reboot the server to prevent MWTM connection problems.

To reboot the server, use this procedure:

Step 1 Log in as the root user, as described in Becoming the Root User (Server Only), page 4-2.

Step 2 Enter:

cd /opt/CSCOsgm/bin
./mwtm reboot

If you change the server’s Solaris/Linux hostname, you must reset the default hostname on the MWTM 
server and client, using this procedure:

Step 3 Log in as the root user, as described in Becoming the Root User (Server Only), page 4-2.

Step 4 Enter:

cd /opt/CSCOsgm/bin
./mwtm evilstop

The MWTM stops all MWTM servers on the local host.
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Step 5 Enter:

./mwtm servername hostname

where hostname is the new default hostname. Ensure that the new name is valid and is defined in your 
/etc/hosts file.

The MWTM resets the default hostname for the MWTM server and client and automatically restarts the 
MWTM server.

Step 6 Any remote clients connecting to this new host should also change their default server name. From 
Windows, choose Start > Programs > Cisco MWTM Client > Modify Default MWTM Server Name.

Why did I receive a “cannot connect to server” message?

When you launch the MWTM client, the GTT Editor, Address Table Editor, or the Event Editor, or when 
you connect to a new server (whether manually or automatically as the result of a server failure), you 
might receive this message:

This client is not allowed to connect to the server or the server is listening on a port 
the client does not know about or cannot reach. Click the help button for a more detailed 
explanation.

If you receive this message, one of these situations has occurred:

• An MWTM administrator has prevented your MWTM client from connecting to the MWTM server, 
using the mwtm ipaccess command.

To resolve this problem, contact the MWTM administrator and ask to have your client’s IP address 
added to the ipaccess.conf file (see Limiting MWTM Client Access to the MWTM Server (Server 
Only), page 2-31).

• The MWTM server has more than one IP address, but the MWTM server’s default hostname is set 
to an IP address that your MWTM client cannot access.

To resolve this problem in Solaris/Linux, use the mwtm servername command to reset the MWTM 
server's default hostname to an IP address that your client can access and restart the server (see 
mwtm servername, page B-48).

To resolve this problem in Windows, choose Start > Programs > Cisco MWTM Client > Modify 
Default MWTM Server Name, then you can enter the mwtm servername command.

Note Using the mwtm servername command to reset the MWTM server's default hostname does not 
affect communication between the MWTM server and the nodes.

• A firewall is installed between the MWTM server and your MWTM client that only allows traffic to 
pass through to the MWTM server's port numbers 1774 (the MWTM web server port) and 44742 
(the MWTM Naming server port), but communication between the MWTM servers and clients 
requires additional ports.

To resolve this problem, set up the firewall correctly (see Firewall Communication, page H-5).



 

C-5
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix C      FAQs
  General FAQs

Will the MWTM server processes restart automatically after a system reboot?

Yes. When you install the MWTM server, the MWTM modifies your system startup scripts to ensure that 
the MWTM server processes start up again after a system reboot. To accomplish this, the MWTM adds 
these lines to your system startup scripts:

/etc/init.d/sgm
/etc/rc0.d/K99sgm
/etc/rc1.d/K99sgm
/etc/rc2.d/K99sgm
/etc/rc3.d/K99sgm
/etc/rc3.d/S99sgm

These lines ensure that the MWTM shutdown and startup scripts run in the correct order for each system 
initiation state.

Note that for Linux only, these lines are modified as well:

/etc/rc5.d/S99sgm
/etc/rc6.d/K99sgm

Why doesn’t my MWTM server start after installing SSL?

If you have not installed the SSL key and certificate, the MWTM server will not start. For exact details 
on this process, see Enabling SSL Support on the MWTM Server, page 2-20.

GUI Questions
This section addresses the following GUI questions:

• Some of my MWTM windows are showing up with small, unusable text entry fields. How can I 
correct this?, page C-5

• Sometimes my MWTM display seems to lock up. Why?, page C-5

Some of my MWTM windows are showing up with small, unusable text entry fields. How can I correct this?

Depending on your system, as well as other factors, the MWTM windows can sometimes display so 
small that text is illegible, and columns and text entry fields are very narrow and unusable. If this 
happens, resize the window and widen the individual columns until the information is again legible and 
the columns and text entry fields are usable.

To make a column wider or narrower, click the column divider in the heading and move the divider to 
the right or left while holding down the right mouse button.

Sometimes my MWTM display seems to lock up. Why?

In the MWTM, events might cause message popups to remain in the background of your display, 
preventing you from interacting with other windows. If you suspect that your display has locked up, 
perform these tasks:

• Ensure that you are running the MWTM on a supported operating system. For more information 
about supported operating systems, see “Preparing to Install the MWTM” in the Installation Guide 
for the Cisco Mobile Wireless Transport Manager 6.0.

• Minimize windows and look for an MWTM message popup in the background.
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Browser Questions
This section addresses the following browser questions:

• Sometimes when browsing the MWTM web interface, a popup appears with this message: 
Unresponsive Script. Why does this happen and how can I prevent it from reoccurring?, page C-6

• The MWTM web pages are displayed empty (without content). Why does this happen and how can 
I prevent it from reoccurring?, page C-6

Sometimes when browsing the MWTM web interface, a popup appears with this message: Unresponsive Script. 
Why does this happen and how can I prevent it from reoccurring?

This problem occurs when using the Firefox browser version 1.5. It is not an MWTM bug. You can 
prevent the popup from occurring with this workaround:

Step 1 In the address bar of a Firefox browser window, enter about:config

Step 2 In the filter bar, enter dom.max_script_run_time.

Step 3 You should now see a setting appear in the window below the filter bar. The setting's name should match 
what you entered previously (dom.max_script_run_time) and most likely shows a default value of 5.

Step 4 Double-click this setting. Firefox will prompt you for a new value. Enter 10. 

If changing this setting still causes the Unresponsive Script popup to appear, repeat these steps but 
increase the number that you enter in this step.

The MWTM web pages are displayed empty (without content). Why does this happen and how can I prevent it from 
reoccurring?

Your Internet Explorer browser settings in the MWTM client are disabling active scripting. To modify 
this, in Internet Explorer, change the browser settings as follows:

Step 1 Choose Tools > Internet Options.

Step 2 Select the Security tab.

Step 3 Click the Custom Level button.

Step 4 Search for Active Scripting in the Scripting section.

Step 5 Click the Enable radio button to enable Active Scripting.

Step 6 Search for Logon in the User Authentication section.

Step 7 Click the Automatic Logon with current username and password radio button.

Topology Questions
This section addresses the following topology questions:

• How does “zoom in on an area” work in a topology map?, page C-7

• Can I add my own icons to the topology map?, page C-7
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How does “zoom in on an area” work in a topology map?

With this feature, you can zoom in on a selected area of the topology map in the topology window. To 
do so, click the Zoom in on an area button, or choose Topology Tools > Zoom > Area from the MWTM 
main menu, then click in the topology map and drag a rectangle around the area you want to zoom in on. 
The MWTM expands the selected area to fill the topology map.

Can I add my own icons to the topology map?

No. To ensure that icons on the topology map can be resized cleanly, they are drawn as special 
vector-based images. Raster images, such as GIF files, do not resize cleanly.

Events and Alarms Questions
This section addresses the following events and alarms questions:

• If I select the Clear Event Icon menu option, does that delete the event from the MWTM database?, 
page C-7

• Can I add my own sounds to the Event Sound Filter?, page C-7

• Why are the age of my alarms always 0 minutes?, page C-8

• Why are objects in the Physical folder ignored?, page C-8

If I select the Clear Event Icon menu option, does that delete the event from the MWTM database?

No. When you select the Clear Event Icon menu option for an object, the MWTM does not delete the 
actual event from its database. The MWTM only deletes the event icon (an orange triangle) from its 
displays for the object, and only for the MWTM client on which you are currently working.

Can I add my own sounds to the Event Sound Filter?

Yes. You can add sound files to an MWTM client. The MWTM clients can play these sound file formats: 
AIFC, AIFF, AU, SND, and WAV.

Note WAV files encoded using MPEG Layer-3 are not supported.

The MWTM client sound files are stored in the MWTM client’s sounds directory:

• If you installed the MWTM client for Solaris/Linux in the default directory, /opt, then the sound file 
directory is /opt/CSCOsgmClient/sounds.

• If you installed the MWTM client for Windows in the default directory, /Program Files, then the 
sound file directory is C:\Program Files\Cisco Systems\MWTM Client\sounds.

• If you installed the MWTM in a different directory, then the sound file directory resides in that 
directory.

If for some reason the MWTM cannot play a specified sound file, the MWTM plays a default beep. For 
example, the MWTM cannot play a sound file if one of these conditions exists:

• The file has been moved or deleted from the sounds directory.

• The sounds directory has been deleted or cannot be found.

• Some other application is using all of the sound resources.

• No sound card is present.
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Why are the age of my alarms always 0 minutes?

If the server clock is ahead of the client clock, the value will be 0 until the client clock catches up to the 
server clock. To get accurate values, use a time service such as Network Time Protocol (NTP) or similar, 
which keeps server and client clocks in sync.

Why are objects in the Physical folder ignored?

Interfaces that are not configured for ITP, RAN-O or management connections could be set as 
administratively up on the node; however, since these interfaces are not connected and/or not configured, 
they appear to be operationally down, even though this status does not affect the behavior of the network 
(for example, unconnected E1 ports on cards in an ONS chassis). To make sure that these interfaces do 
not contribute to the overall status of the parent node, the Physical folder status is ignored.

Objects that appear in the Physical folder but also outside of the Physical folder are not ignored, and 
their status does contribute to the status of the parent node. 

If you want to monitor the status of objects that are ignored in the Physical folder:

Step 1 In the MWTM client navigation tree, expand the node that contains the Physical folder you want to 
unignore. Right-click and choose Physical > Unignore.

Step 2 Within the Status Contributors tab for the Physical folder, in the Ignored column, check the boxes for 
the objects you want to keep ignoring. Only the objects with unchecked boxes will be unignored.

Polling Questions
This section addresses the following polling questions:

• How often does the MWTM poll nodes?, page C-8

• How do I change the default status polling interval?, page C-8

How often does the MWTM poll nodes?

By default, the MWTM polls the nodes in the network every 15 minutes. However, you can initiate a poll 
for one or more nodes at any time by selecting the nodes in the Discovery tab in the Discovery dialog 
box and pressing Poll.

You can also change the default poll interval for one or more nodes in the SNMP Configuration dialog 
box. You must be logged in as the root user or as a superuser to access this dialog box.

Finally, the Node Details window polls the visible node and its adjacent node every 15 seconds, but you 
can change that poll interval, too.

How do I change the default status polling interval?

The MWTM polls the MWR node for status information (for example, interface up or down) every 15 
minutes. The size of this poll depends on the number and type of interfaces that are enabled on the MWR. 

To change the default polling interval of 15 minutes, open the SNMP Configuration dialog box by 
selecting Network > SNMP Configuration from the MWTM main window. You can use this dialog box 
to change the default polling interval to any number of minutes from 5 to 1440.

Note The status information in the GUI is only as good as the most recent poll.
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MIB Questions

What are the names of the MIBs used by the MWTM?

You can find the complete list of MIBs that the MWTM configures and queries in Appendix F, “MIB 
Reference.”

You can obtain the latest versions of these MIBs from one of these locations:

• The Zip file mibs.zip, located at the top of the MWTM DVD Image, contains these MIBs.

• You can download these MIBs from the Cisco website:

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

Miscellaneous Questions
This section addresses the following miscellaneous questions:

• Does the MWTM require any other NMS applications?, page C-9

• Can I run the MWTM on my Windows PC?, page C-9

• What is a superuser?, page C-10

• Does the MWTM Java RMI use TCP or UDP?, page C-10

• What does this message mean: MessageLoggerProxy:setMessageLogger(): Could not resolve., page 
C-10

• What does a status of Deleted, Uninhibited, or NoShutdown mean?, page C-10

• Why don’t the contents of the syslog tab match the log files of my syslog server?, page C-10

• When I start my MWTM client, I get a login window. However, I did not specify a user password 
during installation. How do I fix this?, page C-10

Does the MWTM require any other NMS applications?

The MWTM is functionally a standalone product and does not require any other products. However, you 
can integrate the MWTM with other products to provide added value.

For example, you can integrate the MWTM with CiscoWorks, which provides access to the full suite of 
CiscoWorks products, including the Device Center, the CiscoView Element Manager, Resource Manager 
Essentials (RME), the Internetwork Performance Monitor (IPM), and the Access Control List Manager.

You can also forward the MWTM events to other hosts, in the form of SNMP traps. This enables the 
MWTM to integrate with high-level event- and alarm-monitoring systems such as the Cisco Info Center 
(CIC) and Micromuse's Netcool suite of products. These systems can provide a single high-level view 
of all alarm monitoring in your network, making it easier to detect and resolve problems (see Forwarding 
Events as Traps to Other Hosts, page 9-40).

Can I run the MWTM on my Windows PC?

You can run the MWTM client on Windows XP Professional on your PC. However, the MWTM server 
must run on a Solaris/Linux system.

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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What is a superuser?

A superuser is an MWTM user who has been enabled to perform most of the MWTM functions that 
otherwise require the user to be logged in as the root user.

For a complete description of the functions that a superuser can and cannot perform, as well as 
instructions for enabling a superuser, see Specifying a Super User (Server Only), page 2-18.

Does the MWTM Java RMI use TCP or UDP?

The two-way RMI communication in the MWTM that occurs between Java-based GUI clients and 
Java-based server processes uses TCP sockets.

What does this message mean: MessageLoggerProxy:setMessageLogger(): Could not resolve.

One of these conditions has occurred:

• The host or port number of the Message Log server is configured incorrectly. Verify that the host or 
port number is valid.

• The MWTM cannot reach the Message Log server, probably because it is restarting. The MWTM 
recovers the connection when the Message Log server restarts.

What does a status of Deleted, Uninhibited, or NoShutdown mean?

A status of Deleted, Uninhibited, or NoShutdown indicates a possible problem with the MWTM. If you 
see one of these status settings, contact Cisco TAC or your Cisco Account Team.

Why don’t the contents of the syslog tab match the log files of my syslog server?

The MWTM client shows current syslog information available from a node, which reflects what content 
the node has stored in its internal memory. It is possible to configure your node to send its syslog 
messages to a host that stores these messages in files (usually under /var/adm). The MWTM does not 
access these persisted log messages, even if the host on which your MWTM server is running is logging 
syslog messages from your node. To access these persisted log messages, use CiscoWorks, or other 
software with syslog viewing capabilities. 

When I start my MWTM client, I get a login window. However, I did not specify a user password during 
installation. How do I fix this?

When you install the MWTM and if you select all the default settings, user security is enabled (default 
option) which causes the MWTM login window to appear when you start the MWTM client. However, 
if you did not provide a user password during the installation, you must disable user security before you 
can log into the MWTM client or add user passwords to the MWTM.
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To disable user security: 

Step 1 Log in as the root user on the MWTM server.

Step 2 Run the following command:

/opt/CSCOsgm/bin/mwtm useraccess disable

Output similar to the following appears:

[root@mwtm-server bin]# /opt/CSCOsgm/bin/mwtm useraccess disable

User Based Access Protection is Disabled. 
MWTM server must be restarted for changes to take effect.
Use the following command to restart the server:

 mwtm restart

Clear browser cache and restart browser after changing MWTM Security!!
[root@mwtm-server bin]# 

Step 3 Make sure you restart the MWTM server (using the mwtm restart command) to activate the new 
security settings.

To enable user security:

Step 1 Log in as the root user on the MWTM server.

Step 2 Run the following command:

/opt/CSCOsgm/bin/mwtm useraccess enable

Step 3 Run the following command:

/opt/CSCOsgm/bin/mwtm adduser <username>

Output similar to the following appears:

[root@mwtm-server bin]# /opt/CSCOsgm/bin/mwtm useraccess enable

User Based Access Protection is Enabled.   
Use the "mwtm adduser" command to add users.  
Log in with usernames and passwords for access to MWTM Features. 
MWTM server must be restarted for changes to take effect.
Use the following command to restart the server:

     mwtm restart

Clear browser cache and restart browser after changing MWTM Security!!

[root@mwtm-server bin]# /opt/CSCOsgm/bin/mwtm adduser newuser
Adding user newuser
New password:
Re-enter new password:
Adding password for user newuser

Should user be forced to change this password at the next login? [n] n

Access Level
===========================
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1 - Basic User
2 - Power User
3 - Network Operator
4 - Network Administrator
5 - System Administrator

Enter access level for user newuser: 5
User newuser added with level 5 access. 

User Based Access Protection is Enabled. 

Clear browser cache and restart browser after changing MWTM Security.

[root@mwtm-server bin]#

Step 4 Make sure you restart the MWTM server (using the mwtm restart command) to activate the new security 
settings.
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ITP Specific FAQs
This section addresses frequently asked questions related to ITP operations:

• Can ITPs send traps to the MWTM and to another process on the same node?, page C-13

• Why did the MWTM not discover all of my ITP nodes?, page C-13

• How can the Received Utilization for some of my links be 105%?, page C-14

• What does the asterisk (*) mean next to a SLC number?, page C-14

• When I try to deploy routes, GTT files, or address table files from the MWTM, why does TFTP fail 
or time out?, page C-14

• Why don’t my linkset and link totals match?, page C-14

• How do I enable accounting collection in the MWTM?, page C-14

• How do I generate custom ITP reports quarter hourly instead of hourly or daily?, page C-16

• Why do I have limited functionality on certain tabs?, page C-17

Can ITPs send traps to the MWTM and to another process on the same node?

Yes. You can configure your ITPs to send SNMP traps to more than one process on a single node. Each 
process receives traps on a different port number. However, to do so, you must configure a different 
community string for each process.

For example, your ITP configurations could include these lines:

snmp-server host 1.2.3.4 public udp-port 162
snmp-server host 1.2.3.4 otherCommunity udp-port 44750

where:

• The first line configures the HP OpenView trap receiver, with community string public and UDP 
port number 162.

• The second line configures the MWTM trap receiver, with community string otherCommunity and 
UDP port number 44750.

You would then configure the MWTM to receive traps on port number 44740. For information about how 
to configure the MWTM port number, see Enabling SNMP Traps, page 3-7.

Why did the MWTM not discover all of my ITP nodes?

After you discover the network, examine the Discovered Nodes table to verify that the MWTM 
discovered all of the nodes in the network. If you suspect that the MWTM did not discover all of the 
nodes, verify these conditions:

• Verify that the MWTM server can ping the nodes.

• Verify that the nodes are running ITP IOS images that are compatible with the MWTM server.

• Verify that the SNMP is enabled on the nodes.

• Verify that the MWTM is configured with the correct SNMP community name (see Launching the 
Discovery Dialog, page 4-6).

• Verify that the missing nodes are connected to the seed nodes by SCTP connections, not just serial 
connections.

• Verify that you selected Entire Network when you ran Discovery. If you suspect that you did not, 
run Discovery again with Entire Network selected.
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How can the Received Utilization for some of my links be 105%?

For serial and HSL links on Cisco 7507 and 7513 series routers, in the Received Utilization and Send 
Utilization real-time data charts for links and linksets, the visible utilization data can vary by up to 5% 
from the actual utilization—the MWTM might even display utilization data above 100%. This variance 
results from the synchronization of Layer 2 counters between the Versatile Interface Processor (VIP) 
CPU and the Route Switch Processor (RSP) CPU on 7500 series routers. This variance does not occur 
for links on Cisco 2600, 7200, or 7300 series routers.

What does the asterisk (*) mean next to a SLC number?

In the MWTM, each link is identified by its signaling link code ID (SLC). An asterisk indicates that a 
link is not configured, or that a poll could not get data for the link. 

The placement of the asterisk, to the left or right of the SLC, indicates whether the missing link is 
associated with the selected linkset or with its adjacent linkset. For example, SLC (*)3 means that no 
link is associated with the selected linkset for SLC 3, and SLC 3(*) means that no link is associated with 
the adjacent linkset for SLC 3.

When I try to deploy routes, GTT files, or address table files from the MWTM, why does TFTP fail or time out?

There are three primary causes for TFTP failure or timeout errors:

• You might not have enabled TFTP on your server, which will cause a timeout error (see Setting Up 
TFTP on Your Server (ITP Only), page 3-11).

• You might have specified your tftp root directory (by default, /tftpboot) within the tftp path, which 
is not necessary and will cause TFTP to fail. For details on specifying the correct path, see these 
sections: 

mwtm atbldir, page B-78

mwtm gttdir, page B-86

mwtm routedir, page B-102

• If the staging directory (created using the previous commands) does not have write permissions for 
the MWTM server processes, the TFTP will fail.

Why don’t my linkset and link totals match?

When you run the mwtm export command for a link or linkset, you might notice the output totals do 
not match the totals in the MWTM client. This discrepancy occurs because the mwtm export command 
counts each side of the linkset or link as a individual linkset or link, whereas the MWTM client 
(assuming it knows both sides) counts both sides as one linkset or link pair. Therefore, the mwtm export 
command might have more linksets and links than the MWTM client shows.

How do I enable accounting collection in the MWTM?

Enabling accounting collection in the MWTM is described next. First, you must enable accounting on 
each ITP node using IOS commands. Then you can enable accounting in the MWTM.

Note Enable accounting on each ITP node using IOS commands. Accounting can be enabled on the ITP 
globally or per linkset. For detailed information on IOS modes and commands, see the Cisco IOS 
software documentation.
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To enable accounting globally for all linksets on an ITP node:

Step 1 Go into IOS global configuration (configure terminal) mode.

Step 2 Enter these commands and arguments:

node name(config)#cs7 accounting global-gtt
node name(config)#cs7 accounting global-mtp3
node name(config)#cs7 accounting global-unrouteable

Note These IOS arguments are the recommended defaults for the MWTM.

To enable accounting per linkset on an ITP node:

Step 1 Go into IOS global configuration (configure terminal) mode.

Step 2 Enter these commands and arguments:

node name(config)#cs7 instance number linkset name
node name(config)#accounting
node name(config)#gtt-accounting
node name(config)#unrouteable-accounting

Note These arguments are the recommended defaults for the MWTM. The instance number argument 
is not required if you have only one instance.

The MWTM accounting reports are disabled by default. Enable them:

Step 1 Enter these commands:

node name#/opt/CSCOsgm/bin/sgm statreps acct
node name#/opt/CSCOsgm/bin/sgm statreps gtt

Data is collected daily, and is not affected by polling interval preferences in the Java or web clients.

Note These arguments are the recommended defaults for the MWTM. However, other arguments are 
available. For a full list of mwtm statreps commands, see Appendix B, “Command Reference.”

Step 2 Polling intervals for historical reports are controlled by the root user’s crontab file. To display the current 
values for crontab, and to verify that accounting reports are enabled, run this command:

node name#crontab -l

The list should include statreps acct and statreps gtt.
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How do I generate custom ITP reports quarter hourly instead of hourly or daily?

You can manually generate custom reports using the MWTM command line interface (CLI). These 
commands apply to generating custom reports:

• mwtm accstats quiet

• mwtm gttstats quiet

• mwtm linkstats quiet

• mwtm mlrstats quiet

• mwtm q752stats quiet

• mwtm xuastats quiet

The quiet option disables output to the console.

The output of these commands is placed in this directory:

/opt/CSCOsgm/reports/custom

Note For details on these commands, see Appendix B, “Command Reference.”

Use the UNIX cron facility to schedule the CLI commands to be run every quarter hour:

Step 1 Log in as the root user, as described in Becoming the Root User (Server Only), page 4-2.

Step 2 Enter this command to edit the crontab:

crontab -e 

Step 3 For example, if you wanted to have the link and XUA statistic reports run every quarter hour instead of 
hourly or daily:

a. Comment out these lines:

54  * * * *  /opt/CSCOsgm/bin/sgmCron.sh xuastats
56  * * * *  /opt/CSCOsgm/bin/sgmCron.sh linkstats

b. Add a line similar to these for each report command:

00,15,30,45 * * * *  /opt/CSCOsgm/bin/mwtm linkstats quiet
00,15,30,45 * * * *  /opt/CSCOsgm/bin/mwtm xuastats quiet

You can find these reports in this directory:

/opt/CSCOsgm/reports/custom

There will be 15 minute timestamps on each report file.

Step 4 To view these reports on the web, open the MWTM web interface (see Accessing the MWTM Web 
Interface, page 11-1) then choose File Archive > Reports > Custom.

Note You can keep both the standard hourly reports and the 15 minute reports by leaving both types in the 
crontab instead of commenting out the lines in the previous steps. This will generate a heavier load on 
the system for a few minutes at the top of the hour when both are running at the same time.
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Why do I have limited functionality on certain tabs?

You might notice limited functionality on the following ITP tabs:

• MSU Rates

• MLR Details

• Non-Stop Operation

These tabs are available on certain nodes, and also require specific IOS images:

RAN-O Specific FAQs
This section addresses frequently asked questions related to RAN-O operations:

• What is the difference between in-band and out-of-band management?, page C-17

• How does the MWTM server communicate to the RAN-O node at the remote cell site?, page C-18

• When viewing capacity planning information in the RAN Backhaul Utilization report, the peak 
timestamps are sometimes outside the selected range. For example, 2005-12-01 appears in the report 
window, but I see Nov 30, 2005 11:58:37 PM in the Peak Timestamp information. Why is the peak 
timestamp outside the selected range?, page C-19

• Does the MWTM support the use of Hot Standby Router Protocol (HSRP) for a pair of redundant 
nodes?, page C-20

• How do I sync up the time/date display on my RAN-O performance and error data with the time/date 
on the MWR?, page C-20

• Why are my MWR nodes yellow when I discover them?, page C-22

What is the difference between in-band and out-of-band management?

Nodes located at the cell site are usually accessible only over the same path that is used to transport voice 
traffic. Collecting management information over this path is called in-band management and has an 
impact on backhaul utilization. 

The MWTM can reduce the amount and frequency of collecting management information when 
information is collected in-band. The MWTM does not create reports for in-band accessed nodes. Also, 
the MWTM relies on the information in traps received from an in-band node instead of scheduling a poll 
to get the updated node status.

Tab Node Availability IOS Required Images

MSU Rates All • 12.2 (18) IXB or later

• 12.2 (25) SW7 or later

• 12.4 (11) SW or later 

MLR Details All • 12.2(18)IXA or later

• 12.2(21)SW1 or later

• 12.4(11)SW or later

Non-Stop Operation Cisco 7500 and Cisco 7600 
nodes only

• 12.2 (18) IXA or later

• 12.2(21)SW or later

• 12.2 (4)MB13a or later
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These cell-site node configuration statements provide the MWTM with information required to optimize 
data collection:

conf t
ipran-mib location cellSite
ipran-mib snmp-access inBand

Nodes located at the aggregation site are managed using different paths than those used by voice traffic. 
Collecting management information in this configuration is called out-of-band management and has no 
impact on backhaul utilization. 

Statistical reports are created for nodes that are managed out of band. Also, when traps are received, the 
node is polled to get the latest information.

These aggregation-site node configuration statements provide the MWTM with information required to 
optimize data collection:

conf t
ipran-mib location aggSite
ipran-mib snmp-access outOfBand

This example shows the range of options that are available for the ipran-mib command:

ems1941ka#conf t
Enter configuration commands, one per line.  End with CNTL/Z.
ems1941ka(config)#ipran-mib ?

backhaul-notify-interval  Interval for backhaul utilization
location                  Location of device
snmp-access               Specify type snmp connectivity
threshold-acceptable      Acceptable utilization threshold
threshold-overloaded      Overloaded utilization threshold
threshold-warning         Warning utilization threshold

ems1941ka(config)#ipran-mib location ?
aggSite    Located at BSC or RNC site
cellSite   Located at BTS or Node B site
undefined  Undefined location

ems1941ka(config)#ipran-mib snmp-access ?
inBand     In Band SNMP connectivity
outOfBand  Out of Band SNMP connectivity
undefined  Undefined connectivity

How does the MWTM server communicate to the RAN-O node at the remote cell site?

The MWTM server must communicate to the cell-site node using IP routing. If the cell-site node is 
reachable only through the backhaul interface, add a static route on the MWTM server to point to the 
cell-site node. Use the IP address of the local (aggregation site) RAN-O node as the next-hop address. 

These examples of static routing for Solaris and Linux platforms are based on the diagram in Figure C-1.

Figure C-1 Example of Static Routing
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To create a static route on a Solaris MWTM server, use this procedure:

Step 1 Log in as the root user, as described in Becoming the Root User (Server Only), page 4-2.

Step 2 Enter this command:

/usr/sbin/route add host 10.1.1.1 20.1.1.1

To create a static route on a Linux MWTM server, use this procedure:

Step 1 Log in as the root user, as described in Becoming the Root User (Server Only), page 4-2.

Step 2 Enter this command:

route add -host 10.1.1.1 gw 20.1.1.1

When viewing capacity planning information in the RAN Backhaul Utilization report, the peak timestamps are 
sometimes outside the selected range. For example, 2005-12-01 appears in the report window, but I see Nov 30, 
2005 11:58:37 PM in the Peak Timestamp information. Why is the peak timestamp outside the selected range?

Summaries do not end on fifteen-minute boundaries such as 12:00:00, 12:15:00, 12:30:00, because the 
node processes system time from its own start time, not from the current hour and minute. Therefore, 
when the timestamps are normalized to the MWTM server time, the end timestamp might appear as 
12:03:15, 12:18:15, or 12:33:15.

When you run a capacity planning report, the MWTM retrieves records for the fifteen-minute period that 
has an end timestamp within the start and stop range that you specify. Using the previous timestamps as 
examples, if a user runs a report for the 12:00-to-13:00 time range, the 12:03:15 record is retrieved. That 
record is a fifteen-minute summary of the period between 11:48:16 and 12:03:15. If the Peak Timestamp 
for this record occurred at 11:55:44, the user would observe this value in the capacity planning report.

A user might observe Peak Timestamps that occur up to fifteen minutes before the start timestamp 
specified in the capacity planning report query. This is the expected behavior.
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Does the MWTM support the use of Hot Standby Router Protocol (HSRP) for a pair of redundant nodes?

The MWTM supports HSRP for the Cisco Mobile Wireless Router (MWR) 1941-DC-A operating in an 
active-standby configuration. The MWTM supports these scenarios:

• An MWR fails at the cell site, and you install a new MWR to replace it. The MWTM applies the 
same IP address and configuration to the new MWR, but shows a different serial number. The 
MWTM detects that the new MWR is at the same cell site as the old MWR, and reuses the historical 
statistics for this node.

• You deploy two MWRs as a redundant pair by using the Y-cable configuration described in the Cisco 
MWR 1941-DC-A Mobile Wireless Edge Router Software Configuration Guide. When a failover 
occurs, the MWTM detects that the newly active node is at the same cell site as the standby node. 
The MWTM reuses the historical statistics for this node.

• The MWTM shows a failover alarm or a series of events associated with the failover between the 
active and standby nodes in a redundant pair of MWRs.

Note The MWTM GUI shows only the active MWR in an active-standby pair. 

Because the IOS configs are not synchronized between MWR nodes, make sure the IOS configs 
are identical (except HSRP settings) on both nodes.

How do I sync up the time/date display on my RAN-O performance and error data with the time/date on the MWR?

For the performance and error data to match the time/date on the MWRs, all equipment (Cisco and 
MWTM server) must be configured with the same Network Time Protocol (NTP) server. 

To configure NTP on the Cisco node:

Step 1 Log in to the node.

Step 2 Go into config mode.

Step 3 Enter:

ntp server <ip-address-of-ntp-server>

Step 4 Exit the config mode

Step 5 Save the configuration.

To configure NTP on a Solaris-based MWTM server:

Step 1 Log in as the root user.

Step 2 Edit the /etc/ntp.conf file by adding this line:

server <ip-address-of-ntp-server>

http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_chapter09186a00804d45e1.html
http://www.cisco.com/en/US/products/hw/routers/ps4062/products_configuration_guide_chapter09186a00804d45e1.html
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Step 3 Restart the NTP software using this command:

/etc/init.d/ntpd restart

Step 4 Run the date command and ensure the clock has been set properly. 

If the date is still incorrect, follow these instructions:

a. Stop the NTP software using the following command:

/etc/init.d/ntpd stop

b. Manually sync the date using the following command:

/usr/sbin/ntpdate <ip-address-of-ntp-server>

c. Start the NTP software using the following command:

/etc/init.d/ntp start

Note To enable the NTP software, the packages SUNWntpr and SUNWntpu are required. As the root 
user, run the command: pkginfo | grep SUNWntp. You can download missing packages from 
Sunfreeware.com.

To configure NTP on a Linux-based server:

Step 1 Log in as the root user

Step 2 Edit the ntp.conf file (usually located in /etc, /etc/inet, or /etc/ntp/ntpservers) by adding the following 
line:

server <ip-address-of-ntp-server>

Step 3 Restart the NTP software using this command:

/etc/init.d/ntpd restart

Step 4 Run the date command and ensure the clock has been set properly.

If the date is still incorrect, follow these instructions:

a. Stop the NTP software using the following command:

/etc/init.d/ntpd stop

b. Manually sync the date using the following command:

/usr/sbin/ntpdate <ip-address-of-ntp-server>

c. Start the NTP software using the following command:

/etc/init.d/ntp start

Note The NTP package is required to enable the NTP software. To determine if the NTP package has 
been installed, run the command rpm -qa | grep -i ntp as the root user. Missing packages can 
be downloaded from RPMFind.net.
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Why are my MWR nodes yellow when I discover them?

When the MWTM discovers or polls a node, a list of all interfaces and their corresponding status are 
reported back to the MWTM server. If the MWTM determines that one or more interfaces are 
operationally down, the MWR node is marked with a yellow status symbol unless the interface has an 
administrative status of Down (coming from the IOS shutdown directive). To determine the status of an 
interface, the MWTM uses the following logic matrix:

Note As shown in the above matrix, MWTM automatically ignores any interface with an 
administrative status of Down.

Interface Admin 
Status

Interface Operational 
Status

Reported Interface 
Status

MWTM Ignored 
Status

Up Up Up Not ignored

Up Down Down Not ignored

Down Down Down Ignored

Down Up Down Ignored
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This chapter provides this information for troubleshooting basic Cisco Mobile Wireless Transport 
Manager (MWTM) network problems:

• Clearing a Locked-Up MWTM Display, page D-1

• Investigating Data Problems, page D-1

• Understanding MWTM Client Start Error Messages, page D-2

• Checking MWTM Server Start Processes, page D-3

• Viewing the MWTM Troubleshooting Log, page D-3

• Viewing MWTM Data on the Web, page D-4

• Troubleshooting IOS Commands on the Web, page D-4

• Viewing Detailed Troubleshooting Instructions for Events, page D-5

• Diagnosing a Typical Network Problem, page D-5

Clearing a Locked-Up MWTM Display
In the MWTM, events might cause message popups to remain in the background of your display, 
preventing you from interacting with other windows. If you suspect that your display has locked up, 
perform these tasks:

• Ensure that you are running the MWTM on a supported operating system. For details on supported 
operating systems, see Chapter 1, “Preparing to Install the MWTM” in the Installation Guide for the 
Cisco Mobile Wireless Transport Manager 6.0.

• Minimize windows and look for an MWTM message popup in the background.

Investigating Data Problems
If you suspect that there are problems with the data that the MWTM is displaying, perform these tasks:

• Enter equivalent show commands on the router. Is the data the same as that visible by the MWTM?

• Send SNMP queries to the nodes. Do all queries complete?

The results of these tasks can help you distinguish between a router problem and an MWTM problem.
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Understanding MWTM Client Start Error Messages
If you encounter one of these errors upon starting the MWTM client, follow the subsequent procedures:

• DataModelMediatorService: Could not find service in RMI registry or the RMI Registry may be 
down.

• DemandPollerManagerService: Could not find service in RMI registry or the RMI registry may be 
down. Check the MWTM server and ensure that it is running.

Data Model Mediator Service Error
If you have received this message: “DataModelMediatorService: Could not find service in RMI registry 
or the RMI Registry may be down” either you have specified an incorrect port number when installing 
the MWTM, or the server or RMI registry is unavailable. 

To correct this problem:

Step 1 Verify that you specified a correct port number.

Step 2 Enter the mwtm status command on the server to determine the status of all MWTM servers on the local 
host.

Step 3 Enter the mwtm restart command to restart any servers that are not running.

Demand Poller Manager Service Error
If you have received this message: “DemandPollerManagerService: Could not find service in RMI 
registry or the RMI registry may be down. Check the MWTM server and ensure that it is running” one 
or more of the MWTM server processes may not have started. 

To diagnose and correct this problem:

Step 1 Enter the mwtm status command on the server to determine the status of all MWTM processes.

Check the output to see if the sgmDataServer and sgmTrapReceiver processes do not appear in the Ready 
state. They may appear:

PROCESS STATE    PID Last Message

sgmDataServer Starting 2586 Starting EventModelMediatorService
sgmMsgLogServer Ready    2551 Running
sgmTrapReceiver Initial 

Step 2 If the processes are not all in a Ready state, search log file /opt/CSCOsgm/logs/messageLog.txt for this 
error message:

A java.IO.EOFException was encountered against the persisted.server.data file.
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Step 3 Enter the mwtm cleandb command on the server, which will restore the persisted.server.data file to a 
valid state. The output should now show all processes running:

PROCESS STATE PID Last Message

sgmDataServer Ready 2586 Running
sgmMsgLogServer Ready 2551 Running
sgmTrapReceiver Ready 2600 Running

Step 4 Start the MWTM client, then re-discover the network (for details, see Discovering Your Network, page 
4-4.)

Checking MWTM Server Start Processes
When you run the mwtm start command, normal output appears:

PROCESS STATE PID Last Message

sgmDataServer Ready 2586 Running
sgmMsgLogServer Ready 2551 Running
sgmTrapReceiver Ready 2600 Running

If the sgmDataServer and sgmTrapReceiver process do not appear in the Ready state, see Demand Poller 
Manager Service Error, page D-2 for details on fixing this issue.

Viewing the MWTM Troubleshooting Log
The MWTM stores troubleshooting information in the /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file on 
the MWTM server. This log, which is updated each time the MWTM Server Troubleshooting page is 
accessed or the mwtm tac command is run, contains information that might be requested by Cisco 
customer support personnel.

To view the log from the command line:

Step 1 Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as 
described in Specifying a Super User (Server Only), page 2-18.

Step 2 Enter:

cd /opt/CSCOsgm/bin

./mwtm tac

This command might take a minute or more to complete. When it completes, the MWTM shows this 
message and prompt:

Output is in /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log
Would you like to view it? [y]

Step 3 Press Enter. The MWTM shows the contents of the /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file.
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Viewing MWTM Data on the Web
The MWTM provides an enormous amount of web-based troubleshooting information. From the 
MWTM web interface, you can access many web pages containing MWTM data, including server status, 
network status, installation logs, message logs, product documentation, and other important 
troubleshooting information about the MWTM. For full details, see Chapter 11, “Accessing Data from 
the Web Interface.”

Troubleshooting IOS Commands on the Web

Note If you have implemented MWTM User-Based Access, this option is available to users with 
authentication level Network Operator (level 3) and higher.

You can perform troubleshooting on a node or an object within the node’s hierarchy by:

1. Selecting an object in a view in the navigation tree

2. Clicking the Troubleshooting tab in the right pane

Note The Troubleshooting tab is not available for all objects in the navigation tree.

Tip To save the output of all executed commands to a log file, see mwtm tshootlog, page B-66. 

Before you can run commands and view output, credentials must be properly configured. You can 
configure credentials using the CLI command (see mwtm addcreds, page B-6) or through the MWTM 
client (see Configuring Login Credentials, page 3-19). If credentials are not configured, the message “No 
credentials available. Add credentials and reload the page” appears in the output pane.

The right pane for the Troubleshooting table shows these fields and toolbar buttons for the selected 
object:

Field or Toolbar Button Description

Object Name
(in heading)

Name as discovered by the MWTM.

Server Name
(in heading)

Name of the MWTM server associated with the node.

Update Interval
(in heading)

Time between automatic updates for the page.

Last Update
(in heading)

Date and time the information on the page was last updated by the MWTM.

Category Related commands are grouped together in categories. Some categories are 
provided by default and cannot be modified. Additional categories are 
user-defined. 

Command List of commands or tasks associated with the selected category. A selected 
command can be executed using the Execute Command button.
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Related Topics

• Configuring Login Credentials, page 3-19

• Viewing Troubleshooting, page 8-42

• mwtm addcreds, page B-6

• mwtm tshootlog, page B-66

Viewing Detailed Troubleshooting Instructions for Events
The MWTM provides extensive type-specific help and troubleshooting instructions for events. To see 
help and troubleshooting instructions for an event, right-click the event and select Help for Event.

You can also provide your own enterprise-specific instructions to operators in the event help. For more 
information, see Changing the Way the MWTM Processes Events, page 9-27.

Diagnosing a Typical Network Problem
This section contains this content:

• Diagnosing a Typical ITP Network Problem, page D-6

• Diagnosing a Typical RAN-O Network Problem, page D-8

When you use the MWTM to diagnose a problem in a network, follow these basic steps:

1. Monitor the network using the MWTM main window and the topology window. For example, an 
object in the topology map that changes color from green to yellow or red indicates a problem in the 
network.

2. Use MWTM windows, especially the Details window, to begin investigating the problem.

3. As you identify the source of the problem, examine the messages logged by the MWTM for more 
detailed information about the sequence of events that led to the problem.

4. Connect (by using Telnet or SSH) to the problematic node, if necessary.

Execute Command Executes the selected command only.

Execute Category Executes all commands in the selected category.

Cancel Execution Stops any execution process.

Clear Output Clears all output from the screen.

Output Pane Pane at bottom where command output appears.

Field or Toolbar Button Description
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Diagnosing a Typical ITP Network Problem
This real-life example provides detailed information about using the MWTM to diagnose a problem in 
an ITP network:

Step 1 A network operator (we’ll call him Joe) is using the MWTM to monitor an ITP network. Joe has 
customized his view, limiting it to only those nodes for which he is responsible.

(For more information about customizing views, see Chapter 7, “Managing Views.”)

Step 2 In the topology map, Joe notices a signaling point that has changed color from green to yellow. Yellow 
indicates a status of Warning, which means that one or more links or linksets associated with that 
signaling point is in Unknown or Warning status and is not flagged as Ignored.

(For more information about signaling point status, see Viewing Details, page 8-12.)

Step 3 Joe single-clicks the signaling point in the topology map.

The MWTM highlights the signaling point in the topology map, and in the topology ASP/SP/view table, 
in the left pane of the topology window. With the signaling point highlighted, Joe can easily see that the 
name of the signaling point is sgm-7500j.

The MWTM also shows all associated linksets in the topology ASPA/linkset table.

Joe double-clicks the signaling point’s name in the topology ASP/SP/view table.

The MWTM redraws the topology map, centered on sgm-7500j, making it easier for Joe to see the 
relevant portion of the map.

(For more information about the topology window and how to use it, see Chapter 10, “Viewing Network 
Topology.”)

Step 4 Joe notices that one of sgm-7500j’s diamonds is red, indicating that the associated linkset is either 
Unavailable or Unknown. Joe single-clicks the red diamond.

The MWTM highlights the linkset in the topology map and in the topology ASPA/linkset table. The table 
entry indicates that the linkset is Unavailable.

(For more information about linkset status, see Viewing Details, page 8-12.)

Step 5 Joe right-clicks the linkset in the topology map and selects View > Details in the right-click menu.

The MWTM opens the Details window, showing detailed information for the linkset.

In the Details window, detailed information for the selected linkset appears in the left column and for 
the adjacent linkset in the right column

Immediately, Joe sees that the left column is populated with MWTM data, but the right column is not. 
The problem is in the adjacent signaling point-to-primary signaling point linkset.

(For more information about linkset details, see Chapter 8, “Understanding Detailed Object Functions.”)

Step 6 Joe clicks onLinkset under Summary Lists to display the list of links associated with the linkset, 
identified by their signaling link code IDs (SLCs). In this case, only one link is listed, SLC 0, and it is 
red, meaning it has failed and no traffic is flowing on the link.

Joe selects SLC 0, and the MWTM shows detailed information for the link in the left column. Normally 
the MWTM also shows detailed information for links associated with the adjacent linkset in the right 
column, but in this case, that column is blank.

(For more information about linkset status, see Viewing Details, page 8-12.)
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Step 7 Joe decides to investigate the adjacent signaling point, so he double-clicks the adjacent signaling point 
in the topology map.

The resulting display shows that the adjacent signaling point, sgm-2600a, is Unmanaged.

(For more information about signaling point details, see Chapter 8, “Understanding Detailed Object 
Functions.”)

Step 8 Joe closes the Details window and returns to the topology window. He tries to find sgm-2600a in the 
topology map, but the map is too complex. So Joe lets the MWTM find the signaling point or application 
server process for him:

a. He selects Edit > Find in the MWTM main menu. The Find dialog box appears.

b. He enters sgm-2600a in the Search string field and makes sure the Name, check box is checked.

c. He clicks OK to launch the search. Almost immediately, the MWTM finds the signaling point or 
application server process and the Choose dialog box appears, listing all found objects.

d. Joe selects sgm-2600a, and the MWTM automatically highlights sgm-2600a in the topology 
ASP/SP/view table and in the topology map, and redraws the map centered on sgm-2600a.

(For more information about finding objects in the topology map, see Chapter 10, “Viewing Network 
Topology.”)

Step 9 Joe wants to see recent events for sgm-2600a, so he clicks the signaling point in the topology map and 
selects View > Events in the MWTM main menu. The Recent Events tab appears for the selected object, 
in this case showing recent events for sgm-2600a.

(For more information about viewing events, see Chapter 9, “Managing Events.”)

Step 10 Joe decides to see if the MWTM can manage the signaling point. He right-clicks sgm-2600a in the 
topology map and selects Manage in the right-click menu.

The MWTM changes the status of the signaling point from Unmanaged (red) to Warning (yellow), which 
means the signaling point is active, but one or more associated linksets or links has a status of Failed, 
Unavailable, Unknown, or Warning and is not flagged as Ignored.

(For more information, see Unmanaging and Managing Nodes or ITP Signaling Points, page 6-38.)

Step 11 Joe wants to see status change messages for sgm-2600a, so he right-clicks the signaling point again and 
selects Event History > Status Change Messages in the right-click menu. The MWTM shows recent 
status change messages for the signaling point in a web browser.

Joe sees that many of the links and linksets associated with sgm-2600a have a status of Unknown.

(For more information about displaying messages on the web, see Chapter 11, “Accessing Data from the 
Web Interface.”)

Step 12 At this point, Joe must determine why so many of the links and linksets are Unknown. He must verify 
that the MWTM server can ping the node (see Enabling the Telnet Server Proxy Service, page 3-11), and 
that the MWTM is configured with the correct SNMP community name for the node (see Launching the 
Discovery Dialog, page 4-6).

(For a list of some other actions Joe can take, see Verifying Discovery, page 4-21.)

Step 13 Finally, Joe can use another product, such as CiscoView, to further investigate the problem.

(For more information about integrating the MWTM with CiscoView and other products, see Integrating 
the MWTM with Other Products, page 5-39.)
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Diagnosing a Typical RAN-O Network Problem
This real-life example provides detailed information about using the MWTM to diagnose a problem in 
a RAN-O network:

Step 1 A network operator (we’ll call him Joe) is using the MWTM to monitor a RAN-O network. Joe has 
customized his view, limiting it to only those nodes for which he is responsible. 

(For more information about customizing views, see Chapter 7, “Managing Views.”)

Step 2 In the topology map, Joe notices a node that has changed color from green to yellow. Yellow indicates a 
status of Warning, which means that one or more interfaces associated with that node is in Unknown or 
Warning status and is not flagged as Ignored. 

(For more information about node status, see the “Viewing Details” section on page 8-12.)

Step 3 Joe single-clicks the node in the topology map. 

The MWTM highlights the node in the topology map and in the topology view table in the left pane of 
the topology window. With the node highlighted, Joe can easily see that the name of the node is 
MWR-1941a. 

The MWTM also shows all associated interfaces in the topology Connections table. 

Joe clicks the node's name and the zoom button in the topology view table. 

The MWTM redraws the topology map, centered on MWR-1941a, making it easier for Joe to see the 
relevant portion of the map. 

(For more information about the topology window and how to use it, see Chapter 10, “Viewing Network 
Topology.”)

Step 4 Joe notices that one of MWR-1941a’s diamonds is red, indicating that the associated interface is either 
Unavailable or Unknown. Joe single-clicks the red diamond. 

The MWTM highlights the connection in the topology map and in the topology Connections table. The 
table entry indicates that the connection is Unavailable. 

Step 5 Joe right-clicks the connection in the topology map and selects View > Configuration Details in the 
right-click menu. 

The MWTM opens the Details window (in the main MWTM window), showing detailed information for 
the connection. In the Details window, detailed information for the selected connection appears in the 
Configuration Data section. 

Immediately, Joe sees that the Operational Status is Down but notices that the Operational Status for E1 
1/0 is Up.

Step 6 Joe selects the Recent Events tab and notices that a Critical Alarm for E1 1/0 was recently added. 

Joe logs into the MWR-1941a node (right-click on node name and choose Node > Connect To) and runs 
the show controller E1 1/0 command. He learns that the node recently loss physical connectivity.

Step 7 Joe goes to the router and discovers that the cable is physically damaged. He replaces the cable and 
returns to the MWTM server.

Step 8 Joe views the MWTM main window and observes that the MWTM has already polled the node and 
changed the state color from yellow to green. 

Step 9 Joe looks at the MWTM topology window again and verifies the interface status has changed from 
yellow to green.
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This appendix defines the default status settings for all Cisco Mobile Wireless Transport Manager 
(MWTM) network objects.

This appendix contains:

• General Status Definitions, page E-1

• ITP Status Definitions, page E-2

• RAN-O Status Definitions, page E-7

General Status Definitions
The following status definitions apply to both ITP and RAN-O networks:

• Status Definitions for Nodes, page E-1

• Status Definitions for Views, page E-2

• Status Definitions for Folders, page E-2

Status Definitions for Nodes
Possible values for the current status of the node are:

• Active (green)—The node is currently fully functional.

• Discovering (cyan)—The node is being discovered, and Simple Network Management Protocol 
(SNMP) queries have been sent to the node.

• Polling (cyan)—The node is being polled.

• Unknown (red)—The node failed to respond to an SNMP request. The MWTM sets all associated 
signaling points, linksets, or links to Unknown.
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• Unmanaged (gray)—One of these situations exists:

– The node is known indirectly by the MWTM. In other words, the MWTM knows the node exists 
but there is no known SNMP stack on the node for the MWTM to query.

– An MWTM user has set the node to Unmanaged status, to prevent the MWTM from polling the 
node.

(ITP only) If the associated signaling points are referenced via linksets to other signaling points, 
the MWTM automatically sets all associated signaling points to Unmanaged, and deletes all 
associated linksets and links, as well as all linksets and links that reference the node as an 
adjacent node.

(ITP only) If the associated signaling points are not referenced to other signaling points, the 
MWTM automatically deletes the signaling points, all associated linksets and links, and all 
linksets and links that reference the node as an adjacent node.

• Waiting (gray)—The node is in the Discovery queue but is not currently being discovered.

• Warning (yellow)—The node is active, but one or more associated objects are in Failed, 
Unavailable, Unknown, or Warning status and are not Ignored.

Status Definitions for Views
Possible values for the current status of the view are:

• Active (green)—All objects in the selected view are currently Active and fully functional.

• Unmanaged (gray)—All objects in the selected view are currently Unmanaged.

• Warning (yellow)—One or more objects in the selected view is currently not Active.

Status Definitions for Folders
Possible values for folders (such as Physical and Mgmt Interfaces) are:

• Active (green)—All objects in the selected folder are currently Active and fully functional.

• Warning (yellow)—At least one object is not Active.

ITP Status Definitions
ITP status definitions include this information:

• Status Definitions for Application Servers, page E-3

• Status Definitions for Application Server Processes, page E-3

• Status Definitions for Application Server Process Associations, page E-3

• Status Definitions for ITP Interfaces, page E-4

• Status Definitions for Links, page E-5

• Status Definitions for Linksets, page E-6

• Status Definitions for Signaling Gateway Mated Pairs, page E-7

• Status Definitions for Signaling Points, page E-7
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Status Definitions for Application Servers
Possible values for the current status of the application server are:

• Active (green)—The application server is available and application traffic is active. At least one 
application server process serving this application server is Active.

• Down (red)—The application server is not available. All application server processes that serve this 
application server are Down. This is the initial status for application servers.

• Inactive (red)—The application server is available, but no application traffic is active (that is, at 
least one application server process is Inactive, and no application server process is Active).

• Pending (red)—The last remaining Active application server process serving this application server 
has become Inactive or Down. The next status for this application server will be Active, Inactive, or 
Down, depending on the recovery timer, and whether an application server process can become 
Active.

• Shutdown (blue)—An administrator has forced the application server to an unavailable state.

• Unknown (red)—The MWTM cannot determine the current status of the application server.

• Warning (yellow)—The application server is Active, but one of these conditions exists:

– At least one application server process association for this application server is not fully 
functional.

– A signaling gateway-mated pair has been defined for this signaling point, but no application 
server exists on the mate.

– The mate’s application server is not Active.

Status Definitions for Application Server Processes
Possible values for the current status of the application server process are:

• Unknown (red)—The MWTM cannot determine the current status of the application server process.

• Unmanaged (gray)—The MWTM cannot determine the status of the application server process 
because there is no known SNMP stack on the node that hosts this application server process for the 
MWTM to query.

Status Definitions for Application Server Process Associations
Possible values for the current status of the application server process association are:

• Active (green)—The remote peer at the application server process association is available and 
application traffic is active.

• Blocked (red)—The application server process association cannot receive normal data traffic, but it 
can send and receive control messages.

• Down (red)—The remote peer at the application server process association is not available, or the 
related SCTP association is down. This is the initial status for application server process 
associations.

• Inactive (red)—The remote peer at the application server process association is available, and the 
related SCTP association is up, but application traffic has stopped. The application server process 
association should not receive any data or SNMP messages for the application server.
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• Pending (red)—The last remaining Active application server process serving this application server 
process association has become Inactive or Down. The next status for this application server process 
association will be Active, Inactive, or Down, depending on the recovery timer, and whether an 
application server process can become Active.

• Shutdown (blue)—An administrator has forced the application server process association to an 
unavailable state.

• Unknown (red)—The MWTM cannot determine the current status of the application server process 
association.

• Warning (yellow)—The application server process association is Active, but some underlying 
facility is not fully functional.

Status Definitions for ITP Interfaces
This section provides definitions for these statuses:

• Admin Status, page E-8

• Operational Status, page E-8

• Status, page E-9

Admin Status

Possible values for the administrative status of the interface are:

• Unknown (red)—Unknown administrative status

• Up (green)—Administratively up

• Shutdown (blue)—Administratively down

• Testing (blue)—Administrator is testing the interface

Operational Status

Possible values for the operational status of the interface are:

• Unknown (red)—Unknown operational status.

• Up (green)—Interface is up.

• Down (red)—Interface is down.

• Testing (blue)—Interface is in test mode.

• Dormant (red)—Interface is dormant.

• Not Present (red)—An interface component is missing.

• Lower Layer Down (red)—An interface is down because of a lower-layer interface.
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Status

Possible values for the status of an interface are:

• Active (green)

• Down (red)

• Unknown (red)

• Warning (yellow)

Status Definitions for Links
Possible values for the current status of the link are:

• Active (green)—The link is currently fully functional.

• Blocked (red)—Traffic on this link is disabled by protocol.

• Failed (red)—An error is preventing traffic from flowing on this link, or the associated linkset has 
been set to Shutdown status.

A link can be Failed from an MTP3 perspective, but control messages might still be sent or received 
on the link, resulting in changing packet/second and bit/second rates. The rates might also be 
different at each end of the link, depending on the reason for the failure and the timing related to 
each endpoint.

• InhibitLoc (blue)—A local ITP administrator has set the link to prevent traffic from flowing.

• InhibitRem (blue)—A remote ITP administrator has set the link to prevent traffic from flowing.

• Shutdown (blue)—An ITP administrator has set the link to prevent traffic from flowing.

• Unknown (red)—Either the node associated with this link has failed to respond to an SNMP 
request, or the MWTM found that the link no longer exists.

When you physically delete a link, the Status field shows Unknown until you delete the link from 
the MWTM database.

• Warning (yellow)—The link is active and traffic is flowing, but one or more of these situations has 
occurred:

– The link is congested.

– The link has exceeded the defined Receive Utilization % or Send Utilization %.

– One or more of the local or remote IP addresses defined for SCTP is not active.
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Status Definitions for Linksets
Possible values for the current status of the linkset are:

• Active (green)—The linkset is currently fully functional.

• Shutdown (blue)—An ITP administrator has set the linkset to prevent traffic from flowing. When 
a linkset is set to Shutdown, all its associated links are set to Failed by Cisco IOS.

• Unavailable (red)—An error is preventing traffic from flowing on this linkset.

• Unknown (red)—Either the node associated with this linkset has failed to respond to an SNMP 
request, or the MWTM found that the linkset no longer exists.

• Warning (yellow)—The linkset is active, but one or more links in the linkset is congested or is in 
Failed, Unknown, or Warning status, and is not Ignored. At least one link is available and can carry 
traffic.
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Status Definitions for Signaling Gateway Mated Pairs
Possible values for the current status of the signaling gateway-mated pair are:

Active (green)—The signaling gateway-mated pair is available and application traffic is active.

Down (red)—The signaling gateway-mated pair is not available.

Inactive (red)—The signaling gateway-mated pair is available, but application traffic has stopped.

Shutdown (blue)—An administrator has forced the signaling gateway-mated pair to an unavailable 
state.

Unknown (red)—The MWTM cannot determine the current status of the signaling gateway-mated pair.

Warning (yellow)—The signaling gateway-mated pair is Active, but some underlying facility is not 
fully functional.

Status Definitions for Signaling Points
Possible values for the current status of the signaling point are:

Active (green)—The signaling point is currently fully functional.

Unknown (red)—The MWTM cannot poll the node associated with the signaling point.

Unmanaged (gray)—The MWTM cannot discover the signaling point. It is not an ITP node.

Warning (yellow)—The signaling point is active, but one or more associated links or linksets is in 
Failed, Unavailable, Unknown, or Warning status and is not flagged as Ignored.

RAN-O Status Definitions
RAN-O status definitions include this information:

• Status Definitions for RAN-O Interfaces, page E-7

• Status Definitions for Cards, page E-10

• Status Definitions for RAN-O Backhauls, page E-10

Status Definitions for RAN-O Interfaces
This section provides definitions for these statuses:

• Admin Status, page E-8

• Operational Status, page E-8

• Connect State for GSM Abis, page E-8

• Connect State for UMTS Iub, page E-8

• Alarm States, page E-9

• Redundancy State, page E-9

• Status, page E-9
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Admin Status

Possible values for the administrative status of the interface are:

Unknown (red)—Unknown administrative status

Up (green)—Administratively up

Shutdown (blue)—Administratively down

Testing (blue)—Administrator is testing the interface

Operational Status

Possible values for the operational status of the interface are:

Unknown (red)—Unknown operational status.

Up (green)—Interface is up.

Down (red)—Interface is down.

Testing (blue)—Interface is in test mode.

Dormant (red)—Interface is dormant.

Not Present (red)—An interface component is missing.

Lower Layer Down (red)—An interface is down because of a lower-layer interface.

Connect State for GSM Abis

Possible values for the connect state of a Global System for Mobile Communications (GSM) interface 
are:

Connected (green)—The node is monitoring local and remote alarm status.

Disconnected (red)—The system ignores the local alarm status. The local transmitter on the short-haul 
is disabled. Capability messages are transmitted to the remote describing the provisioning. The system 
stays disconnected until the remote capabilities are known and the peer state transitions to connected.

Send Connect (yellow)—One or more attempts have been made to connect to remote peer.

Receive Connect (yellow)—The local peer has received a connect request from the remote peer.

Connect Rejected (yellow)—Connection was rejected.

ACK Connect (yellow)—The initial connect request was sent and acknowledged by remote peer. The 
local peer is now waiting for a connect request from the remote peer.

Check Connect (yellow)—The local peer has reason to believe its remote peer has failed. Additional 
tests are being processed to verify peer's state.

Connect State for UMTS Iub

Possible values for the connect state of a Universal Mobile Telecommunications System (UMTS) 
interface are:

Initialized (yellow)—The connection is starting initialization.

Starting (red)—The shorthaul interface is administratively active, but the backhaul interface is down.

Closed (blue)—The backhaul interface is active, but the shorthaul is administratively closed.
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Stopped (red)—Unable to connect to peer in specified time interval. Additional attempts will be tried 
based on peer request or restart timers.

Closing (blue)—Connection closed by administration request.

Stopping (yellow)—Connection shut down by peer's Term-Request. Will transition to stopped state. 

Connect Sent (yellow)—Connection request sent to peer.

ACK Received (yellow)—Connection request sent and acknowledgement has been received from peer. 
Now waiting for peer's connection request.

ACK Sent (yellow)—Connection request received and acknowledgement has been sent to peer. 
Connection request sent and waiting for peer's acknowledgement.

Open (green)—Connection open and available for traffic.

Alarm States

The alarm states for a UMTS Iub interface include:

• Local Receive Alarm State

• Local Transmit Alarm State

• Remote Receive Alarm State

• Remote Transmit Alarm State

Possible values for these alarm states are:

Remote Alarm (blue)—Indicates a problem at the remote end. The alarm generated by the remote 
interface in the E1/T1 data stream is sent and no other action is required. 

No Alarm (green)—No alarm is present. 

Local Alarm (red)—Indicates local interface problem. The interface has not received synchronization 
from the GSM node. The node stops transmitting backhaul samples.

Received Alarm (yellow)—Indicates receive problem in the local node. The remote node stops 
transmitting backhaul data and indicates a blue alarm.

Alarm State Unavailable (red)—Indicates the alarm state is not available. This state only applies to the 
remote and occurs when the peer connection is inactive.

Redundancy State

Possible values for the redundancy state of GSM Abis or UMTS Iub interfaces are:

Active (green)—Active owner of interface.

Standby (green)—Active owner of interface.

Status

Possible values for the status of an interface are:

Active (green)—The interface is currently fully functional.

Down (red)—The interface is not available.

Unknown (red)—The MWTM cannot determine the current status of the interface.

Warning (yellow)—The interface is Active, but some underlying object is not fully functional.
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Status Definitions for Cards
Possible values for cards within Cisco Optical Networking System (ONS) nodes are:

Active (green)—The card is currently fully functional.

Not Present (red)—Preconfigured but not inserted in the ONS chassis

Failed (red)—Not functional

Warning (yellow)—Not in configured protection state

Unknown (red)—Failed SNMP

Status Definitions for RAN-O Backhauls
Possible values for RAN backhauls are:

Active (green)—The RAN backhaul is currently fully functional.

Unknown (red)—The MWTM cannot determine the current status of the RAN backhaul.

Warning (yellow)—At least one of the shorthaul interfaces or IP backhaul interfaces is not active

Failed (red)—None of the shorthaul or IP backhaul interfaces are active
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This appendix contains:

• General MIBs, page F-1

• ITP Specific MIBs, page F-3

• RAN-O Specific MIBs, page F-5

General MIBs
The Cisco Mobile Wireless Transport Manager (MWTM) queries these general Management 
Information Bases (MIBs), listed in alphabetical order:

MIB Description

CISCO-AAA-SERVER-MIB.my Provides configuration and statistics reflecting the state of 
authentication, authorization, and accounting (AAA) server 
operation within the node and AAA communications with external 
servers.

CISCO-BITS-CLOCK-MIB.my Provides information on Building Integrated Timing Supply (BITS) 
clocking sources and operation modes. The MWTM can generate 
notifications to indicate when clocking sources change roles or 
become unavailable. 

CISCO-CONFIG-MAN-MIB.my Provides configuration management, primarily by tracking changes 
and saving the running configuration. This MIB represents a model 
of configuration data that exists in various locations:

• running—In use by the running system

• terminal—Logical or attached hardware

• local—Saved locally in NVRAM or flash

• remote—Saved to a server on the network

CISCO-ENTITY-FRU-CONTROL
CAPABILITY.my

Provides additional capabilities for various platforms that are 
needed by the CISCO-ENTITY-FRU-CONTROL-MIB.

CISCO-ENTITY-FRU-CONTROL
-MIB.my

Monitors and configures the operational status of Field Replaceable 
Units (FRUs) of the system listed in the Entity-MIB (RFC 2037) 
entPhysicalTable. FRUs include assemblies such as power supplies, 
fans, processor modules, interface modules, and so forth.
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CISCO-ENVMON-MIB.my Provides environmental monitoring information on Cisco ITPs.

CISCO-EPM-NOTIFICATION-
MIB.my

Defines the trap structure that carries the identity and status 
information of the managed object. The MWTM can send internal 
events as traps defined in this MIB to third-party network 
management system (NMS) applications for further processing.

CISCO-FLASH-MIB.my Provides management of Cisco Flash Devices.

CISCO-HSRP-EXT-MIB.my Provides an extension to the CISCO-HSRP-MIB which defines 
Cisco's proprietary Hot Standby Routing Protocol (HSRP). The 
extensions cover assigning of secondary HSRP IP addresses and 
modifying an HSRP group's priority by tracking the operational 
status of interfaces. 

CISCO-HSRP-MIB.my Provides a means to monitor and configure the Cisco IOS 
proprietary Hot Standby Router Protocol (HSRP). Cisco HSRP 
protocol is defined in RFC2281. 

CISCO-PROCESS-MIB.my Shows memory and CPU utilization on Cisco nodes. CPU 
utilization gives a general idea of how busy the processor is. The 
numbers are a ratio of the current idle time divided by the longest 
idle time.

CISCO-RF-MIB.my Provides configuration control and status for the Redundancy 
Framework (RF) subsystem. RF provides a mechanism for logical 
redundancy of software functionality and is designed to support 
1-to-1 redundancy on processor cards. Redundancy is concerned 
with the duplication of data elements and software functions to 
provide an alternative in case of failure.

CISCO-SMI.my Defines the Structure of Management Information for the Cisco 
enterprise.

CISCO-SYSLOG-MIB.my Provides a means of gathering syslog messages generated by the 
Cisco IOS. The MWTM can send internal events as traps defined in 
this MIB to third-party NMS applications for further processing.

CISCO-TC.my Defines textual conventions used throughout Cisco enterprise 
MIBs.

ENTITY-MIB.my Module that represents multiple logical entities supported by a 
single SNMP agent. This MIB is based on RFC 2737. For more 
information on entity MIBs, see RFC 2037 section 3. 

IANAifType-MIB.my Defines the IANAifType Textual Convention, and thus the 
enumerated values of the ifType object defined in MIB-II's ifTable.

IF-MIB.my Describes generic objects for network interface sublayers. This 
MIB is an updated version of MIB-II's ifTable, and incorporates the 
extensions defined in RFC 1229.

IMA-MIB.my Module that manages ATM Forum Inverse Multiplexing for ATM 
(IMA) interfaces.

INET-ADDRESS-MIB.my Defines textual conventions for representing Internet addresses. An 
Internet address can be an IPv4 address, an IPv6 address, or a DNS 
domain name. This module also defines textual conventions for 
Internet port numbers, autonomous system numbers, and the length 
of an Internet address prefix.

MIB Description
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ITP Specific MIBs
MWTM queries these ITP specific MIBs, listed in alphabetical order:

PerfHist-TC-MIB.my Provides Textual Conventions to be used by systems supporting 15 
minute-based performance history counts.

RFC1213-MIB.my Provides basic management information on the ITP (RFC 1213).

RMON-MIB.my Remote network monitoring devices, often called monitors or 
probes, are instruments that exist for the purpose of managing a 
network. This MIB defines objects for managing remote network 
monitoring devices.

OLD-CISCO-INTERFACES-MIB.
my

Defines interfaces for the Cisco enterprise.

SNMP-FRAMEWORK-MIB.my Defines the SNMP Management Architecture.

SNMP-TARGET-MIB.my Defines the MIB objects that provide mechanisms to remotely 
configure the parameters used by an SNMP entity for the generation 
of SNMP messages.

SNMPv2-CONF.my Defines SNMPv2 conformance.

SNMPv2-MIB.my Defines SNMPv2 entities.

SNMPv2-SMI.my Defines the Structure of Management Information for SNMPv2.

SNMPv2-TC.my Defines textual conventions for SNMPv2.

MIB Description

MIB Description

CISCO-IETF-SCTP-EXT-MIB.my Extension to CISCO-IETF-SCTP-MIB.my that provides additional 
information to manage SCTP (RFC 2960).

CISCO-IETF-SCTP-MIB.my The MIB module for managing SCTP protocol (RFC 2960).

CISCO-ITP-ACL-MIB.my Manages access lists that control messages sent over SS7 networks 
using ITP.

CISCO-ITP-ACT-MIB.my Provides information specified in ITU Q752 Monitoring and 
Measurements for SS7 networks. This information is used to 
manage messages sent over SS7 networks using ITP. This MIB has 
been deprecated and replaced by the CISCO-ITP-GACT-MIB.

CISCO-ITP-GACT-MIB.my Provides information specified in ITU Q752 Monitoring and 
Measurements for SS7 networks. This information is used to 
manage messages sent over SS7 networks using ITP. This MIB 
replaces the CISCO-ITP-ACT-MIB and supports multiple instances 
of a signaling point within the same configuration.

CISCO-ITP-GRT-MIB.my Manages information required to route messages sent over SS7 
networks using ITP. This MIB replaces the CISCO-ITP-RT-MIB 
and supports multiple instances of a signaling point within the same 
configuration.
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CISCO-ITP-GSCCP-MIB.my Provides information specified in ITU Q752 Monitoring and 
Measurements for SS7 networks. This information is used to 
manage Signaling Connection Control Part (SCCP) messages sent 
over SS7 networks using ITP. This MIB replaces the 
CISCO-ITP-SCCP-MIB and supports multiple instances of a 
signaling point within the same configuration.

CISCO-ITP-GSP-MIB.my Manages signaling points and associated messages sent over SS7 
networks using ITP. This MIB replaces the CISCO-ITP-SP-MIB 
and supports multiple instances of a signaling point within the same 
configuration.

CISCO-ITP-GSP2-MIB.my Provides information specified in ITU Q752 Monitoring and 
Measurements for SS7 networks. This information is used to 
manage messages sent over SS7 networks using ITP. This MIB 
replaces the CISCO-ITP-SP2-MIB and supports multiple instances 
of a signaling point within the same configuration.

CISCO-ITP-MLR-MIB.my Provides information about Multi-Layer Routing (MLR). This 
information is used to control and measure SS7 message signaling 
units (MSUs) in an SS7 network.

CISCO-ITP-MONITOR-MIB.my Provides information about monitoring SS7 links. This information 
is used to manage the state of software used to collect all packets 
transported and received over an SS7 link.

CISCO-ITP-MSU-RATES-MIB.
my

Provides information used to manage the number of MTP3 MSUs 
transmitted and received per processor. Many of the higher level 
protocols require several MSUs per transaction. Traffic capacity 
planning is based on MSUs, not transactions. This MIB provides 
information to determine current traffic.

CISCO-ITP-RT-MIB.my Manages the route tables used to control messages sent over SS7 
networks using ITP. This MIB has been deprecated and replaced by 
the CISCO-ITP-GRT-MIB.

CISCO-ITP-SCCP-MIB.my Manages SCCP messages sent over SS7 networks using ITP, and 
provides information specified in ITU Q752 Monitoring and 
Measurements for SS7 networks. This MIB has been deprecated and 
replaced by the CISCO-ITP-GSCCP-MIB.

CISCO-ITP-SP-MIB.my Manages signaling points and associated linksets and links in SS7 
networks using ITP.

CISCO-ITP-SP2-MIB.my Provides Quality of Service (QoS) information related to the 
configuration of an SS7 network. Also provides MTP3 event history 
information. This MIB has been deprecated and replaced by the 
CISCO-ITP-GSP2-MIB.

CISCO-ITP-TC-MIB.my Defines textual conventions used to manage nodes related to the 
SS7 network. The ITU documents that describe this technology are 
the ITU Q series, including:

• ITU Q.700: Introduction to CCITT SS7

• ITU Q.701: Functional description of the message transfer part 
(MTP) of SS7.

MIB Description
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RAN-O Specific MIBs
MWTM queries these RAN-O specific MIBs, listed in alphabetical order:

You can obtain the latest versions of these MIBs from one of these locations:

• The Zip file mibs.zip, located at the top of the MWTM DVD Image, contains these MIBs.

• You can download these MIBs from the Cisco website:

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

CISCO-ITP-XUA-MIB.my Manages MTP3 User Adaptation (M3UA) and SCCP User 
Adaptation (SUA) for ITP.

OLD-CISCO-SYS-MIB.my Provides a means of gathering basic information for an ITP node.

MIB Description

MIB Description

CERENT-454-MIB.mib Defines the alarms and events for the Cisco ONS 15454. The 
MWTM processes each ONS event by creating an MWTM event 
with a severity that maps to the severity of the ONS event.

CERENT-ENVMON-MIB.mib Provides environmental status information.

CERENT-FC-MIB.mib Defines the managed objects for performance monitoring of 
supported Fibre Channel interfaces. 

CERENT-GLOBAL-REGISTRY.
mib

Provides the global registrations for all other CERENT MIB 
modules.

CERENT-MSDWDM-MIB.mib Defines the managed objects for physical layer related interface 
configurations and objects for the protocol specific error counters 
for dense wavelength division multiplexing (DWDM) optical 
switches.

CERENT-OPTICAL-MONITOR-
MIB.mib

Defines objects to monitor optical characteristics and set 
corresponding thresholds on the optical interfaces in a network 
element.

CERENT-TC.mib Provides the global Textual Conventions for all other CERENT MIB 
modules.

CISCO-IP-RAN-BACKHAUL-
MIB.my

Provides information on the optimization of IP-RAN traffic 
between the cell site and the aggregation node site. It handles both 
GSM Abis and UMTS Iub traffic. 

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml
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Trap Reference

This appendix contains:

• General Traps, page G-1

• ITP Specific Traps, page G-8

• RAN-O Specific Traps, page G-11

General Traps
The Cisco Mobile Wireless Transport Manager (MWTM) supports these general traps/notifications, 
which apply to:

• IP Transfer Point (ITP) networks

• Radio Access Network Optimization (RAN-O) networks

Note Some traps are platform/IOS specific. 

Trap Name Description

casServerStateChange An AAA server state change notification is generated 
whenever an AAA server connection state changes value. An 
AAA server state can be either up or dead.

ccmCLIRunningConfigChanged This notification indicates that the running configuration of 
the managed system has changed from the CLI. If the 
managed system supports a separate configuration mode 
(where the configuration commands are entered under a 
configuration session which affects the running configuration 
of the system), then this notification is sent when the 
configuration mode is exited. During this configuration 
session there can be one or more running configuration 
changes.

cefcFRUInserted The cecfFRUInserted notification indicates that a FRU was 
inserted. The varbind for this notification indicates the 
entPhysicalIndex of the inserted FRU, and the 
entPhysicalIndex of the FRU’s container.
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cefcFRURemoved The cefcFRURemoved notification indicates that a FRU was 
removed. The varbind for this notification indicates the 
entPhysicalIndex of the removed FRU, and the 
entPhysicalIndex of the FRU's container.

cefcModuleStatusChange This notification is generated when the value of 
cefcModuleOperStatus changes.It can be utilized by an NMS 
to update the status of the module it is managing.

cefcPowerStatusChange The cefcFRUPowerStatusChange notification indicates that 
the power status of a FRU has changed. The varbind for this 
notification indicates the entPhysicalIndex of the FRU, and 
the new operational-status of the FRU.

cHsrpStateChange A cHsrpStateChange notification is sent when a 
cHsrpGrpStandbyState transitions to either active or standby 
state, or leaves active or standby state. There will be only one 
notification issued when the state change is from standby to 
active and vice versa.

ciscoBitsClockFreerun This trap is for Building Integrated Timing Supply (BITS) 
clocking sources. It is used to generate notifications to 
indicate when clocking source is unavailable. The internal 
clock will operate in freerun mode using appropriate local 
oscillator. Therefore, it does not provide synchronous 
clocking. This is the least stable of all operating modes.

ciscoBitsClockHoldover This trap is for Building Integrated Timing Supply (BITS) 
clocking sources. It is used to generate notifications to 
indicate when clocking source is unavailable and the internal 
clock will operate in holdover mode. The network clock 
module has stored information about the incoming clock 
signal, it can faithfully reproduce the lost signal while in 
holdover mode until a switchover to another clock source 
occurs.

ciscoBitsClockSource This trap is for Building Integrated Timing Supply (BITS) 
clocking sources. It is used to generate notifications to 
indicate when clocking sources change. 

ciscoConfigManEvent Notification of a configuration management event as 
recorded in ccmHistoryEventTable.

ciscoEnvMonFanNotification A ciscoEnvMonFanNotification trap is generated if any one 
of the fans in the fan array (where extant) fails. Since such a 
notification is usually generated before the shutdown state is 
reached, it can convey more data and has a better chance of 
being sent than does the ciscoEnvMonShutdownNotification.

ciscoEnvMonRedundantSupply
Notification

A ciscoEnvMonRedundantSupplyNotification trap is 
generated if the redundant power supply (where extant) fails. 
Since such a notification is usually generated before the 
shutdown state is reached, it can convey more data and has a 
better chance of being sent than does the 
ciscoEnvMonShutdownNotification.

Trap Name Description
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ciscoEnvMonShutdownNotification A ciscoEnvMonShutdownNotification trap is generated if the 
environmental monitor detects a testpoint reaching a critical 
state and is about to initiate a shutdown. This notification 
contains no objects so that it can be encoded and sent in the 
shortest amount of time possible. Even so, management 
applications should not rely on receiving such a notification 
as it might not be sent before the shutdown completes.

ciscoEnvMonTemperatureNotification A ciscoEnvMonTemperatureNotification trap is generated if 
the temperature measured at a given testpoint is outside the 
normal range for the testpoint (that is, is at the warning, 
critical, or shutdown stage). Since such a Notification is 
usually generated before the shutdown state is reached, it can 
convey more data and has a better chance of being sent than 
does the ciscoEnvMonShutdownNotification.

ciscoEnvMonVoltageNotification A ciscoEnvMonVoltageNotification trap is generated if the 
voltage measured at a given testpoint is outside the normal 
range for the testpoint (that is, is at the warning, critical, or 
shutdown stage). Since such a notification is usually 
generated before the shutdown state is reached, it can convey 
more data and has a better chance of being sent than does the 
ciscoEnvMonShutdownNotification.

ciscoFlashCopyCompletionTrap A ciscoFlashCopyCompletionTrap is sent at the completion 
of a flash copy operation if such a trap was requested when 
the operation was initiated.

ciscoFlashDeviceChangeTrap A ciscoFlashDeviceChangeTrap is sent whenever a 
removable Flash device is inserted or removed.

ciscoFlashDeviceInsertedNotif A ciscoFlashDeviceInsertedNotif notification is sent 
whenever a removable Flash device is inserted.

ciscoFlashDeviceInsertedNotifRev1 A ciscoFlashDeviceInsertedNotif notification is sent 
whenever a removable Flash device is inserted 
ciscoFlashDeviceInsertedNotifRev1 deprecates 
ciscoFlashDeviceInsertedNotif since it uses 
ciscoFlashDeviceName as a varbind which is deprecated.

ciscoFlashDeviceRemovedNotif A ciscoFlashDeviceRemovedNotif notification is sent 
whenever a removable Flash device is removed.

ciscoFlashDeviceRemovedNotifRev1 A ciscoFlashDeviceRemovedNotif notification is sent 
whenever a removable Flash device is removed. 
ciscoFlashDeviceRemovedNotifRev1 deprecates 
ciscoFlashDeviceRemovedNotif since it uses 
ciscoFlashDeviceName as a varbind, which is deprecated.

ciscoFlashMiscOpCompletionTrap A ciscoFlashMiscOpCompletionTrap is sent at the 
completion of a miscellaneous flash operation (enumerated 
in ciscoFlashMiscOpCommand) if such a trap was requested 
when the operation was initiated.

ciscoFlashPartitioningCompletionTrap A ciscoFlashPartitioningCompletionTrap is sent at the 
completion of a partitioning operation if such a trap was 
requested when the operation was initiated.

Trap Name Description
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ciscoProducts The ciscoProducts and snmpTraps traps provide information 
when a cold or warm start is performed on a node or the state 
of a node interface changes:

• AUTHENTICATION_FAILURE—An 
authenticationFailure trap signifies that the IP address is 
accessing this node using the wrong community string.

• COLD_START—A coldStart trap signifies that the 
SNMPv2 entity, acting in an agent role, is reinitializing 
itself such that its configuration might be altered. 

• WARM_START—A warmStart trap signifies that the 
SNMPv2 entity, acting in an agent role, is reinitializing 
itself such that its configuration is unaltered. 

• LINK_DOWN—A linkDown trap signifies a failure in 
one of the communication links represented in the node's 
configuration has occurred. 

• LINK_UP—A linkUp trap signifies that one of the 
communication links represented in a node's 
configuration has come up. 

ciscoRFProgressionNotif A ciscoRFProgressionNotif trap is sent by the active 
redundant unit whenever its RF state changes or the RF state 
of the peer unit changes.

ciscoRFSwactNotif A ciscoRFSwactNotif trap is sent by the newly active 
redundant unit whenever a switch of activity (SWACT) 
occurs. In the case where a SWACT event might be 
indistinguishable from a reset event, a network management 
station should use this notification to differentiate the 
activity.

clogMessageGenerated When a syslog message is generated by the node a 
clogMessageGenerated notification is sent. The sending of 
these notifications can be enabled/disabled via the 
clogNotificationsEnabled object.

cpmCPUFallingThreshold A cpmCPUFallingThreshold trap is generated when CPU 
utilization is below the falling threshold.

cpmCPURisingThreshold A cpmCPURisingThreshold trap is generated when CPU 
utilization is above the rising threshold.

Trap Name Description
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entConfigChange An entConfigChange notification is generated when the value 
of entLastChangeTime changes. It can be utilized by an NMS 
to trigger logical/physical entity table maintenance polls.

An agent should not generate more than one 
entConfigChange notification-event in a given time interval 
(five seconds is the suggested default). A notification-event is 
the transmission of a single trap or inform PDU to a list of 
notification destinations.

If additional configuration changes occur within the 
throttling period, then notification-events for these changes 
should be suppressed by the agent until the current throttling 
period expires. At the end of a throttling period, one 
notification-event should be generated if any configuration 
changes occurred since the start of the throttling period. In 
such a case, another throttling period is started right away.

An NMS should periodically check the value of 
entLastChangeTime to detect any missed entConfigChange 
notification-events (for example, because of throttling or 
transmission loss).

fallingAlarm The SNMP trap that is generated when an alarm entry crosses 
its falling threshold and generates an event that is configured 
for sending SNMP traps.

risingAlarm The SNMP trap that is generated when an alarm entry crosses 
its rising threshold and generates an event that is configured 
for sending SNMP traps.

rttMonConnectionChangeNotification This notification is only valid when the RttMonRttType is 
echo or pathEcho. An rttMonConnectionChangeNotification 
indicates that a connection to a target (not to a hop along the 
path to a target) has either failed on establishment or been lost 
and when reestablished. This causes 
rttMonCtrlOperConnectionLostOccurred to change value. If 
history is not being collected, the instance values for the 
rttMonHistoryCollectionAddress object will not be valid. 
When RttMonRttType is not echo or pathEcho, the 
rttMonHistoryCollectionAddress object will be null.

rttMonLpdDiscoveryNotification A rttMonLpdDiscoveryNotification indicates that the LSP 
Path Discovery to the target PE has failed, and it also 
indicates the clearing of such condition. This causes 
rttMonLpdGrpStatsLPDFailOccurred to change value. When 
the rttMonLpdGrpStatsLPDFailOccurred is false, the 
instance value for rttMonLpdGrpStatsLPDFailCause is not 
valid.

rttMonLpdGrpStatusNotification A rttMonLpdGrpStatusNotification indicates that the LPD 
Group status rttMonLpdGrpStatsGroupStatus has changed, 
indicating some connectivity change to the target PE. This 
causes rttMonLpdGrpStatsGroupStatus to change value.

Trap Name Description
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rttMonNotification A rttMonNotification indicates the occurrence of a threshold 
violation, and it indicates the previous violation has subsided 
for a subsequent operation. When the RttMonRttType is 
pathEcho, this notification will only be sent when the 
threshold violation occurs during an operation to the target 
and not to a hop along the path to the target. This also applies 
to the subsiding of a threshold condition. If history is not 
being collected, the instance values for the 
rttMonHistoryCollectionAddress object will not be valid. 
When RttMonRttType is not echo or pathEcho, the 
rttMonHistoryCollectionAddress object will be null. 
rttMonReactVar defines the type of reaction that is 
configured for the probe (for example, jitterAvg). Trap 
definitions for the probes are in the rttMonReactTable, and 
each probe can have more than one trap definition for various 
types (for example, jitterAvg). So the object rttMonReactVar 
indicates the type (for example, packetLossSD) for which 
threshold violation traps have been generated. The object 
rttMonEchoAdminLSPSelector will be valid only for the 
probes based on mplsLspPingAppl RttMonProtocol. For all 
other probes it will be null.

rttMonThresholdNotification A rttMonThresholdNotification indicates the occurrence of a 
threshold violation for a RTT operation, and it indicates the 
previous violation has subsided for a subsequent RTT 
operation. This causes 
rttMonCtrlOperOverThresholdOccurred to change value. 
When the RttMonRttType is pathEcho, this notification will 
only be sent when the threshold violation occurs during an 
operation to the target and not to a hop along the path to the 
target. This also applies to the subsiding of a threshold 
condition. If history is not being collected, the instance 
values for the rttMonHistoryCollectionAddress object will 
not be valid. When RttMonRttType is not echo or pathEcho 
the rttMonHistoryCollectionAddress object will be null.

rttMonTimeoutNotification A rttMonTimeoutNotification indicates the occurrence of a 
timeout for a RTT operation, and it indicates the clearing of 
such a condition by a subsequent RTT operation. This causes 
rttMonCtrlOperTimeoutOccurred to change value. When the 
RttMonRttType is pathEcho, this notification will only be 
sent when the timeout occurs during an operation to the target 
and not to a hop along the path to the target. This also applies 
to the clearing of the timeout. If history is not being collected, 
the instance values for the rttMonHistoryCollectionAddress 
object will not be valid. When RttMonRttType is not echo or 
pathEcho, the rttMonHistoryCollectionAddress object will 
be null.

Trap Name Description
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rttMonVerifyErrorNotification A rttMonVerifyErrorNotification indicates the occurrence of 
a data corruption in an RTT operation.

snmpTraps The ciscoProducts and snmpTraps traps provide information 
when a cold or warm start is performed on a node or the state 
of a node interface changes:

• AUTHENTICATION_FAILURE—An 
authenticationFailure trap signifies that the IP address is 
accessing this node using the wrong community string.

• COLD_START—A coldStart trap signifies that the 
SNMPv2 entity, acting in an agent role, is reinitializing 
itself such that its configuration might be altered. 

• WARM_START—A warmStart trap signifies that the 
SNMPv2 entity, acting in an agent role, is reinitializing 
itself such that its configuration is unaltered. 

• LINK_DOWN—A linkDown trap signifies a failure in 
one of the communication links represented in the node's 
configuration has occurred. 

• LINK_UP—A linkUp trap signifies that one of the 
communication links represented in a node's 
configuration has come up. 

Trap Name Description
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ITP Specific Traps
The MWTM supports these ITP specific traps, listed in alphabetical order:

Trap Name Description

ciscoGrtDestStateChange A ciscoGrtDestStateChange trap is generated whenever one 
or more destination changes states. This notification contains 
a list of destination state changes in the 
cgrtDestNotifChanges object. State changes are accumulated 
until the cgrtDestNotifChanges is full or the maximum delay 
time is reached. The delay time is specified by the 
cgrtDestNotifDelayTime object.

It might be necessary to suppress the sending of notification 
when a large number destinations change state, due to the 
failure of some common resource. The number of 
notifications can be controlled by specifying values for 
cgrtDestNotifWindowTime and 
cgrtDestNotifMaxPerWindow objects. When the number of 
destination state changes exceed the specified value the last 
notification will indicate that notifications are suppressed for 
the remainder of the window.

ciscoGrtMgmtStateChange A ciscoGrtMgmtStateChange trap is generated whenever one 
or more management routes change state. This notification 
contains a list of management route state changes in the 
cgrtMgmtNotifChanges object. State changes are 
accumulated until the cgrtMgmtNotifChanges is full or the 
maximum delay time is reached. The delay time is specified 
by the cgrtMgmtNotifDelayTime object.

It might be necessary to suppress the sending of notification 
when a large number of routes change state, due to the failure 
of some common resource. The number of notifications can 
be controlled by specifying values for 
cgrtMgmtNotifWindowTime and 
cgrtMgmtNotifMaxPerWindow objects. When the number of 
route state changes exceed the specified value the last 
notification will indicate that notifications are suppressed for 
the remainder of the window.

ciscoGrtRouteTableLoad A ciscoGrtRouteTableLoad trap is generated whenever a load 
operation is started or completed. Route table configurations 
can be loaded by CLI requests. In addition, route tables can 
loaded using configuration statements. This allows route 
tables to be reloaded whenever a node restarts.
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ciscoGsccpGttErrors This notification is generated whenever any global title error 
is encountered in last interval specified by the 
cgsccpGttErrorPeriod and the cgsccpInstErrorIndicator will 
be set to true. The notification will also be generated when 
errors have abated. The notification is generated after the 
number of recovery intervals as specified by the 
cgsccpGttErrorRecoveryCount object has passed without any 
global title errors.

ciscoGsccpGttLoadTable A ciscoGsccpGttLoadTable trap is generated whenever a load 
operation is started or completes.

ciscoGsccpGttMapStateChange A ciscoGsccpGttMapStateChange is generated when a mated 
application subsystem changes to a new state. The value of 
cgsccpGttMapSsStatus indicates the new state for the 
subsystem.

ciscoGspCongestionChange A ciscoGspCongestionChange trap is generated when a link 
changes to a new congestion level as specified by the 
cgspLinkCongestionState object.

ciscoGspIsolation This notification indicates the instance specified by 
cgspInstDisplayName and cgspInstDescription has become 
isolated. All linkset used to connect MTP3 node (instance) 
are unavailable. Isolation is ended when any linkset 
supported by this instance reaches the active state.

ciscoGspLinkRcvdUtilChange A ciscoGspLinkRcvdUtilChange trap is generated when the 
cgspLinkUtilStateRcvd changes states.

ciscoGspLinkSentUtilChange A ciscoGspLinkSentUtilChange trap is generated when the 
cgspLinkUtilStateSent changes states.

ciscoGspLinksetStateChange A ciscoGspLinksetStateChange trap is generated when a 
linkset changes to a new state. The value of 
cItpSpLinksetState indicates the new state.

ciscoGspLinkStateChange A ciscoGspLinkStateChange trap is generated when a link 
changes to a new state. The value of cItpSpLinkState 
indicates the new state.

ciscoItpMsuRateState This notification is generated once for the interval specified 
by the cimrMsuRateNotifyInterval object when the 
cimrMsuTrafficRateState object has the following state 
transitions:

• acceptable to warning

• acceptable to overloaded

• warning to overloaded

At the end of the interval specified by the 
cimrMsuRateNotifyInterval object another notification will 
be generated if the current state is different from state sent in 
last notification even if the state transition is not one of the 
previously mentioned transitions. When the 
cimrMsuRateNotifyInterval is set to zero all state changes 
will generate notifications.

Trap Name Description
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ciscoItpXuaAsStateChange A ciscoItpXuaAsStateChange trap is generated when an AS 
changes to a new state. The value of cItpXuaAsState 
indicates the new state for the AS.

ciscoItpXuaAspCongChange A ciscoItpXuaAspCongChange trap is generated when an 
ASP changes to a congestion level as specified by the 
cItpXuaAspCongLevel object.

ciscoItpXuaAspStateChange A ciscoItpXuaAspStateChange trap is generated when an 
ASP changes to a new state. The value of cItpXuaAspAsState 
indicates the new state for the ASP that is serving the AS 
specified by cItpXuaAsDisplayName.

ciscoItpXuaSgmCongChange A ciscoItpXuaSgmCongChange trap is generated when an 
SGMP changes to a congestion level as specified by the 
cItpXuaSgmCongLevel object.

ciscoItpXuaSgmStateChange A ciscoItpXuaSgmStateChange trap is generated when an SG 
Mate changes to a new state. The value of cItpXuaSgmState 
indicates the new state for the SG Mate.

ciscoMlrTableLoad A ciscoMlrTableLoad trap is generated when a load operation 
is started or completed. Route table configurations can be 
loaded by CLI requests. In addition, route tables can loaded 
using configuration statements, which allows route tables to 
be reloaded whenever a node restarts.

cItpRouteStateChange A cItpRouteStateChange trap is generated whenever one or 
more route destination status changes states and includes the 
count of all route state changes. This notification contains a 
list of route state changes in the cItpRtNotifInfoStateChanges 
object. State changes are accumulated until the 
cItpRtNotifInfoStateChanges is full or the maximum delay 
time is reached. The delay time is specified by the 
cItpRtChangeNotifDelayTime object.

It might be necessary to suppress the sending of notification 
when a large number route change state, due the failure of 
some common resource. The number of notifications can be 
controlled by specifying values for 
cItpRtChangeNotifWindowTime and 
cItpRtChangeNotifMaxPerWindow objects. When the 
number of route state changes exceed the specified value the 
last notification will indicate that notifications are suppressed 
for the remainder of the window.

cItpSccpGttMapStateChange A cItpSccpGttMapStateChange trap is generated when a 
mated application subsystem changes to a new state. The 
value of cItpSccpGttMapSsStatus indicates the new state for 
the subsystem.

cItpSpCongestionChange A cItpSpCongestionChange trap is generated when a link 
changes to a new congestion level as specified by the 
cItpLinkCongestionState object.

cItpSpLinkRcvdUtilChange A cItpSpLinkRcvdUtilChange trap is generated when the 
cItpSpLinkUtilStateRcvd changes states.

Trap Name Description
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RAN-O Specific Traps
The MWTM supports these RAN-O specific traps, listed in alphabetical order:

cItpSpLinkSentUtilChange A cItpSpLinkSentUtilChange trap is generated when the 
cItpSpLinkUtilStateSent changes states.

cItpSpLinksetStateChange A cItpSpLinksetStateChange trap is generated when a linkset 
changes to a new state. The value of cItpSpLinksetState 
indicates the new state.

cItpSpLinkStateChange A cItpSpLinkStateChange trap is generated when a link 
changes to a new state. The value of cItpSpLinkState 
indicates the new state.

cSctpExtDestAddressStateChange A cSctpExtDestAddressStateChange trap is generated when 
the state transition of cSctpAssocRemAddressStatus has 
occurred.

Trap Name Description

Trap Name Description

cerent454Events The CERENT-454-MIB defines the events and alarms that 
are raised by the ONS 15454. The MWTM processes each 
ONS event by creating an MWTM event with a severity that 
maps to the severity of the ONS event. 

ciscoIpRanBackHaulGsmAlarm A ciscoIpRanBackHaulGsmAlarm trap is generated when the 
values of these objects change: connect state, local alarm 
state, remote alarm state, and redundancy state.

ciscoIpRanBackHaulUmtsAlarm A ciscoIpRanBackHaulUmtsAlarm trap is generated when 
the values of these objects change: connect state, received 
local state, received remote state, transmit local state, 
transmit remote state, and redundancy state.

ciscoIpRanBackHaulRcvdUtil A ciscoIpRanBackHaulRcvdUtil trap is generated when a 
received utilization state changes to a new state.

ciscoIpRanBackHaulSentUtil A ciscoIpRanBackHaulSentUtil trap is generated when a sent 
utilization state changes to a new state.
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A P P E N D I X H
Configuring MWTM to Run with Various 
Networking Options

In addition to running on standard IP-connected networks, the Cisco Mobile Wireless Transport 
Manager (MWTM) has the flexibility to adapt to a variety of different networking environments, 
including Virtual Private Network (VPN), Network Address Translation (NAT), firewall, 
port-forwarding, and Secure Sockets Layer (SSL). The MWTM software can run in each of these 
environments individually, or in any combination of networking environments.

This appendix describes communication between the MWTM client and the MWTM server. Figure H-1) 
includes the following:

• Two-way Remote Method Invocation (RMI) communication between a Java-based GUI client and 
Java-based server processes. The client can send requests to and receive responses from the server, 
and the server can send unsolicited notifications to the client. For example, if the server detects that 
an ITP’s state has changed, it sends a notification to all MWTM clients to update their topology 
windows.

• One-way HTTP communication between a web browser and an MWTM-embedded web server, 
using the request/response model.

Figure H-1 MWTM Communication

Note This appendix does not address communication between the MWTM server and the ITP, which uses the 
SNMP protocol for network management.
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This appendix contains:

• How Does RMI Work?, page H-2

• VPN Communication, page H-3

• NAT Communication, page H-4

• Firewall Communication, page H-5

• Port-Forwarding Communication, page H-11

• Configuring MWTM to Work With a Dual-Interface Machine Connected to Separate Networks, 
page H-13

• Additional Network Configurations, page H-16

• Configuring MWTM with IOS Server Load Balancing, page H-17

How Does RMI Work?
RMI is a Java-based technology that allows a Java application to communicate with another Java 
application (usually residing on different hosts) using remote method invocation. RMI marshals and 
unmarshals method parameters and return values using Java object serialization. It uses TCP connections 
as the default communication mechanism.

Understanding how RMI works can assist your understanding of the different scenarios presented in this 
appendix. 

Three types of RMI components exist between the MWTM client and server communication:

• RMI name server—Runs on the MWTM server

• MWTM RMI services—Runs on the MWTM server

• MWTM client process—Runs on the MWTM client

Figure H-2 RMI Components

When the MWTM server starts, the MWTM RMI services register with the RMI name server. These 
registered RMI services have one single published IP address. 
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When the MWTM client starts, it first establishes a TCP connection to the RMI name server and 
performs a service lookup. The RMI name server returns the published IP address for the MWTM RMI 
services. The MWTM client then establishes another TCP connection to the published IP address of the 
MWTM RMI services for client and server communication.

This appendix describes how to configure the MWTM software to adjust the communication process 
outlined previously, in order to make the MWTM work with NAT, Port-Forwarding, and/or a 
Dual-Interface MWTM server.

VPN Communication

Note VPN configuration is transparent to the user; no manual configuration is needed.

MWTM client/server communication can run transparently through a VPN tunnel, which is a secure IP 
layer, without any user intervention. You can use VPN to connect to a corporate network, then start the 
MWTM client to connect through the VPN tunnel to an MWTM server in the corporate network.

When the client host establishes a VPN tunnel, the operating system (or system library) sees this as 
another virtual IP interface. The VPN tunnel does not affect HTTP communication between the web 
browser and server, it only affects RMI communication between the MWTM client and server processes.

For HTTP communication, the virtual IP address is transparent to the upper layer. The operating system 
automatically chooses the correct IP address to send out the request packet. For RMI communication, 
the MWTM client must register with the MWTM server using the correct IP address, so that the server 
can invoke RMI callbacks and send unsolicited notifications to the client. 

The MWTM software solves this problem by automatically detecting the local IP interface so that the 
MWTM server can send unsolicited notification to the correct IP address.

Figure H-3 shows a sample VPN network with these characteristics:

• The MWTM client with IP address 192.168.0.1 is connected to the MWTM server network through 
a VPN tunnel.

• The MWTM client host has obtained VPN IP address 10.1.1.2, which is a virtual IP interface.

Figure H-3 VPN Communication

When connecting to the MWTM server, the MWTM client automatically recognizes its VPN IP address, 
10.1.1.2, and uses that address to register with the MWTM server to receive RMI callbacks. 
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NAT Communication
MWTM client/server communication can run through one or more static NAT-connected networks. 

Note The MWTM software does not support dynamic NAT or dynamic NAT pool overloading.

In a static NAT network, the MWTM client and server reside on different sides of the NAT network, with 
no routes between the client network and the server network. The NAT device statically maps the client 
IP address to a NAT address in the server network, and the server IP address to a NAT address in the 
client network.

The NAT device translates packets between the MWTM client and server by replacing IP address headers 
when packets pass through. From the client's point of view, the server appears to be at a NAT IP address 
in the client network, and vice versa. For most protocols, this technique is sufficient to enable the client 
and server to communicate.

However, for the RMI protocol, this is not sufficient. The RMI protocol requires the client and server to 
keep remote object references by remote stubs. These remote stubs contain the remote objects' IP 
addresses, and are passed between the client and server using Java serialization. The NAT device only 
converts the IP addresses in the IP packet header, but the remote stub object is within the packet content. 
Therefore, the NAT device cannot recognize the IP address inside the packet, and fails to route it 
correctly.

The MWTM software solves this problem by creating a specialized NAT-aware socket factory. The user 
must perform some manual configuration to enable the MWTM to “know” the network NAT 
configuration.

Figure H-4 shows a sample static NAT network with these characteristics:

• A static NAT device connects Network A (192.168.*.*) to Network B (10.*.*.*), with no routes 
between Network A and Network B.

• The NAT device maps the MWTM client IP address 192.168.0.1 in Network A to 10.1.1.2 in 
Network B.

• The NAT device maps the MWTM server IP address 10.0.0.1 in Network B to 192.168.1.2 in 
Network A.

Figure H-4 Static NAT Communication

To configure the MWTM software in this static NAT network, you must change the MWTM client's 
RMIOverNAT.properties file.

• In Solaris/Linux, if you installed the MWTM software in the default directory, /opt, then the location 
of the file is /opt/CSCOsgmClient/properties/RMIOverNAT.properties.

• In Windows, if you installed the MWTM software in the default directory, C:\Program Files, then 
the location of the file is C:\Program Files\SGMClient\properties\RMIOverNAT.properties.

• If you installed the MWTM software in a different directory, then the file resides in that directory.
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For the example shown in Figure H-4, you must add this line to the file:

10.0.0.1 = 192.168.1.2

This line maps the MWTM server's real IP address, 10.0.0.1 in Network B, to its NAT address, 
192.168.1.2, in Network A, which is the server's IP address as seen by the client.

Note The MWTM server automatically detects the MWTM client's NAT address. No manual configuration on 
the part of the user is needed at the server side.

When the MWTM server starts, it starts MWTM services that register with the RMI server and publish 
themselves with the IP address specified in the SERVER_NAME property of System.properties file on 
the MWTM server. In the given example, the published IP address is 10.0.0.1.

The MWTM client starts and connects to 192.168.1.2 (specified as the MWTM client's default server 
address). The NAT device translates the MWTM client's request to the RMI server at 10.0.0.1.

The MWTM client then asks where the MWTM services are located. The RMI server replies that these 
MWTM services reside at 10.0.0.1. Without the RMIOverNAT.properties file on the MWTM client, the 
client will try to connect to 10.0.0.1, which would fail.

If we have configured the RMIOverNAT.properties file on the MWTM client as in the example, the 
MWTM client will still connect to 192.168.1.2 for name lookup, and the name server will return that 
MWTM services are running on 10.0.0.1. The MWTM client then looks in the RMIOverNAT.properties 
file, and discovers that the translated address for 10.0.0.1 is 192.168.1.2. With this configuration, the 
MWTM client will try to connect to 192.168.1.2 for RMI services (instead of 10.0.0.1). As the result, 
the connection will be established successfully.

Firewall Communication
To enable MWTM client/server communication through a firewall, you need to set up the firewall so that 
it allows MWTM communication packets to pass through freely.

This section contains:

• Configuring Port Numbers and Parameters, page H-6

• Configuring Firewalls Step by Step, page H-8

• Sample Firewall Configuration, page H-10



 

H-6
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix H      Configuring MWTM to Run with Various Networking Options
  Firewall Communication

Configuring Port Numbers and Parameters

Note The MWTM client and server communicate using TCP sockets. All port numbers in this section are TCP 
ports.

The port number used by the MWTM software is configured in the System.properties file:

• If you installed the MWTM software in the default directory, /opt, then the location of the file is 
/opt/CSCOsgm/properties/System.properties.

• In Windows, if you installed the MWTM software in the default directory, C:\Program Files, then 
the location of the file is C:\Program Files\SGMClient\properties\System.properties.

• If you installed the MWTM software in a different directory, then the file resides in that directory.

Set these parameters on the server side of the file:

RMIREGISTRY_PORT = 44742

DATASERVER_PORT = 0

LOGINSERVER_PORT = 0

WEB_PORT = 1744

where:

• RMIREGISTRY_PORT is the port on which the RMI naming server listens. You must specify a port 
number; 0 is not allowed.

• DATASERVER_PORT is the port on which the Data Service listens. If you specify 0, the MWTM 
software uses a random available port, 1024 and above. The MWTM maintains the chosen port until 
the next server restart.

• LOGINSERVER_PORT is the port on which the Log in Service listens. If you specify 0, the MWTM 
software uses a random available port, 1024 and above. The MWTM maintains the chosen port until 
the next server restart.

• WEB_PORT is the port on which the MWTM web server listens. You must specify a port number; 
0 is not allowed. To change the WEB_PORT number, use the mwtm webport command (see mwtm 
webport, page B-71).

Note If any of these port numbers change, you must restart the MWTM server before the changes take effect.
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Set these parameters in the MWTM client’s System.properties file:

RMIREGISTRY_PORT = 44742

CLIENT_PORT = 0

where:

• RMIREGISTRY_PORT is the port on which the server-side RMI naming server listens. This port 
number must match the one specified for the RMIREGISTRY_PORT on the server side.

• CLIENT_PORT is the port on which the MWTM client listens for RMI callbacks (unsolicited 
notifications):

– If you specify CLIENT_PORT = 0, the MWTM software uses any available port, 1024 and 
above.

– If you specify CLIENT_PORT with a single value other than 0, such as CLIENT_PORT = 
33459, the MWTM software uses that port, and you can run only one MWTM client process at 
a time.

– If you specify CLIENT_PORT with a range of values other than 0, such as CLIENT_PORT = 
33459-33479, the MWTM software can use any of the ports in the range, including the 
beginning and ending ports, and you can run more than one MWTM client process at a time.

Note If any of these port numbers change, you must restart the MWTM client before the changes take 
effect.

The MWTM client’s System.properties file resides in the properties directory:

• In Solaris/Linux, if you installed the MWTM software in the default directory, /opt, then the location 
of the file is /opt/CSCOsgmClient/properties/System.properties.

• In Windows, if you installed the MWTM software in the default directory, C:\Program Files, then 
the location of the file is C:\Program Files\SGMClient\properties\System.properties.

• If you installed the MWTM software in a different directory, then the file resides in that directory.
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Configuring Firewalls Step by Step

Step 1 Identify the TCP port numbers to use between the MWTM server and client applications.

The MWTM software uses four TCP port numbers on the server side and two TCP port numbers on the 
client side to communicate between the MWTM server and client(s). These ports include the RMI 
Registry Port, the Data Server Port, the Login Server Port, the Client Port, and the HTTP Web Server 
port. You configure these port numbers in a plain-text file named System.properties located on the 
MWTM server and client. When configuring the MWTM software in a firewall deployment, you should 
use these port numbers:

• RMI Registry Port—44742

• Data Server Port—44751

• Login Server Port—44752

• Client Port—56173

• HTTP Web Server Port—1774

Step 2 Modify the System.properties file on the MWTM server. The System.properties file resides on the 
MWTM server under the /opt/CSCOsgm/properties directory.

Note If the you installed the MWTM software in a location other than the default (/opt/CSCOsgm), 
substitute the correct directory name to locate the properties directory.

Caution Before editing, always make a backup of the file. This ensures a valid file exists in case an 
error is made during the editing process.

Using a text editor, edit this file and specify the appropriate port number where indicated subsequently:

Step 3 Modify the System.properties file on the MWTM client. The System.properties file resides on the 
MWTM client machine under:

• /opt/CSCOsgm/properties directory for Solaris clients

• C:\Program Files\MWTMClient\properties for Windows clients

Note If the you installed the MWTM software in a location other than the default 
(/opt/CSCOsgmClient), substitute the correct directory name to locate the properties directory.

Port Name Keyword Value

RMI Registry Port RMIREGISTRY_PORT 44742

Data Server Port DATASERVER_PORT 44751

Login Server Port LOGINSERVER_PORT 44752

HTTP Web Server Port WEB_PORT 1774
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Caution Before editing, always make a backup of the file. This ensures a valid file exists in case an 
error is made during the editing process.

Using a text editor, edit this file and specify the appropriate port number where indicated subsequently:

Step 4 Modify the node configuration files with the selected port numbers. 

On Cisco nodes, you can use extended access lists to allow the selected TCP port numbers to pass 
between the appropriate interface(s). Assuming a single node separates the MWTM client and server, 
you can use the following extended access list:

Note The established entries are necessary, as they allow data to flow between the server and client that 
initiated the session. Without this keyword, clients will not have access to the MWTM server.

# MWTM Client Interface
interface FastEthernet 1/1

ip address 192.168.1.100 255.255.255.0
ip access-group client-to-server in

# MWTM Server Interface
interface FastEthernet 2/1

ip address 192.168.2.100 255.255.255.0
ip access-group server-to-client in

# Access list from client to server
ip access-list extended client-to-server

10 permit tcp any any established
20 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44742
30 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44751
40 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44752
50 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 1774

# Access list from server to client
ip access list extended server-to-client

10 permit tcp any any established
20 permit tcp host 192.168.2.2 192.168.1.0 0.0.0.255 eq 56173

Step 5 Restart the MWTM server to use the newly selected TCP port numbers.

As the root user, on the MWTM server, type:

#/opt/CSCOsgm/bin 
#./mwtm restart

The server processes restart using the newly selected port numbers.

Port Name Keyword Value

RMI Registry Port RMIREGISTRY_PORT 44742

Client Port CLIENT_PORT 56173
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Sample Firewall Configuration
This sample shows how to configure your firewall from the server side, client side, and Cisco node side.

Figure H-5 shows a sample firewall network with these parameters set in the System.properties file:

• On the MWTM server side:

RMIREGISTRY_PORT = 44742

DATASERVER_PORT = 44751

LOGINSERVER_PORT = 44752

WEB_PORT = 1774

• On the MWTM client side:

RMIREGISTRY_PORT = 44742

CLIENT_PORT = 56173

Figure H-5 Firewall Communication

MWTM Client Firewall
device MWTM Server

192.168.1.1 192.168.2.2

Allow TCP connection from 192.168.1.1 to 192.168.2.2,
ports 44742, 44751, 44752, 44753, 44754, and 1774

Network A
192.168.1.*

Network B
192.168.2.*
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Allow TCP connection from 192.168.2.2 to 192.168.1.1,
port 56173
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This example illustrates a typical firewall configuration for Cisco nodes using access lists. This 
examples has two extended access lists:

• ip access-list extended client-to-server—This access list is applied on the input interface from the 
client to the server (FE 1/1).

• ip access-list extended server-to-client—This access list is applied on the input interface from the 
server to the client (FE 2/1).

!
ip access-list extended client-to-server
    10 permit tcp any any established 
    20 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44742
    30 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44751
    40 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 44752
    50 permit tcp 192.168.1.0 0.0.0.255 host 192.168.2.2 eq 1774
!   60 … 
!
ip access list extended server-to-client
    10 permit tcp any any established
    20 permit tcp host 192.168.2.2 192.168.1.0 0.0.0.255 eq 56173
!   30 …
!
interface FastEthernet 1/1
    ip address 192.168.1.100 255.255.255.0
    ip access-group client-to-server in
!   …
!
interface FastEthernet 2/1
    ip address 192.168.2.100 255.255.255.0
    ip access-group server-to-client in
!   …
!

Note Both of these access lists allow established TCP connections (10 permit tcp any any established, 
see previous). When the MWTM client or server establishes a TCP connection to the other end, 
it uses a fixed destination port. However, the source port from the initiating party is random. The 
established keyword allows a returning TCP packet to go back to the random initiating source 
port.

Port-Forwarding Communication
To enable the MWTM software to operate in a TCP port-forwarding environment, perform these 
configuration tasks:

Step 1 Configure the server hostname and port number mapping in the MWTM client’s 
RMIOverNAT.properties file, as described in NAT Communication, page H-4.

Step 2 Configure the port numbers used by the MWTM client and server in the System.properties file, as 
described in Firewall Communication, page H-5.

Step 3 Configure the port-forwarding tunnel to forward each side’s TCP connection to the other side.



 

H-12
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix H      Configuring MWTM to Run with Various Networking Options
  Port-Forwarding Communication

Figure H-6 shows a sample network that uses Secure Shell (SSH) port-forwarding. Other 
port-forwarding configurations might use a single host with dual interfaces at the client’s and server's 
networks. While other port-forwarding configurations might differ from this example, the general rules 
to configure the MWTM software to operate in a port-forwarding environment are the same.

Figure H-6 Port-Forwarding Communication

The port-forwarding network shown in Figure H-6 has these parameters set:

• In the System.properties file, on the MWTM server side:

RMIREGISTRY_PORT = 44742

DATASERVER_PORT = 44751

LOGINSERVER_PORT = 44752

WEB_PORT = 1774

• In the System.properties file, on the MWTM client side:

RMIREGISTRY_PORT = 44742

CLIENT_PORT = 56173

• In the MWTM client's RMIOverNAT.properties file:

10.0.0.1/44742 = 127.0.0.1/25742

10.0.0.1/44751 = 127.0.0.1/25751

10.0.0.1/44752 = 127.0.0.1/25752

10.0.0.1/1774 = 127.0.0.1/8080

• In the port-forwarding network:

Local port 25751 => remote host 127.0.0.1, port 44742

Local port 25751 => remote host 127.0.0.1, port 44751

Local port 25752 => remote host 127.0.0.1, port 44752

Local port 8080 => remote host 127.0.0.1, port 1774

Remote port 56173 => local host 127.0.0.1, port 56173

MWTM Client

SSH tunnel

MWTM Server

192.168.0.1 10.0.0.1

Network A
192.168.*.*

Network B
10.*.*.*
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Note For port-forwarding setup, the backward-forwarding port numbers must match each other. 
In the previous example, both are 56173. The forward-forwarding port numbers do not need 
to match each other.

If you want to run more than one MWTM client process at the same time on the same node, 
you must specify CLIENT_PORT with a range of values other than 0, such as 
CLIENT_PORT = 33459-33479, in the MWTM client’s RMIOverNAT.properties file. See 
Firewall Communication, page H-5 for more information about specifying the 
CLIENT_PORT parameter. You must also set up the backward-forwarding port numbers to 
use a range of values.

When the MWTM server starts, underlying network services register with the RMI server and publish 
themselves with the IP address specified in the SERVER_NAME property of the System.properties file 
on the MWTM server. In the given example, the published IP address is 10.0.0.1.

The MWTM client starts and connects to the localhost/127.0.0.1 (specified as the MWTM client's 
default server address). The SSH port-forwarding tunnel forwards the MWTM client's request to the 
RMI server at the MWTM server's localhost/127.0.0.1.

The MWTM client then asks where the MWTM services are located, and the RMI server replies that 
these MWTM services reside at 10.0.0.1. Without the RMIOverNAT.properties file on the MWTM client, 
the client would try to connect to 10.0.0.1, which would fail because of a network routing problem.

If we have configured the RMIOverNAT.properties file on the MWTM client as in the example, the 
MWTM client will still connect to the localhost/127.0.0.1 for name lookup, and the name server would 
return that MWTM services are running on 10.0.0.1. The MWTM client then looks in the 
RMIOverNAT.properties file, and discovers that the translated address for 10.0.0.1 is 127.0.0.1. With this 
configuration, the MWTM client will try to connect to 127.0.01 for RMI services (instead of 10.0.0.1). 
As a result, the connection will establish successfully.

Configuring MWTM to Work With a Dual-Interface Machine 
Connected to Separate Networks

The MWTM client and server communication is based on Java RMI protocol. A limitation of RMI is its 
inability to publish itself with more than one specific IP address. This means that the RMI service can 
only register to one single interface on a dual interface machine. You can deploy the MWTM server on 
a dual interface machine in various scenarios:

• In some scenarios, all MWTM clients run on one side of the MWTM server interface, with no 
MWTM clients on the other side of the interface (for example, the other MWTM server interface is 
exclusively used for network management/SNMP traffic). In this scenario, ensure that the MWTM 
server published address is the interface connected to the MWTM clients. To change the published 
address of the MWTM server, see mwtm servername, page B-48.

• In some other scenarios, the two MWTM server interfaces are connected to the same network, or the 
two interfaces are connected to two different networks, but these networks are routed between each 
other. Typically, the intention is to use two physical interfaces to provide redundancy on the MWTM 
server. When providing physical interface redundancy, you should use Cisco Server Load Balancing 
technology. For details on configuring the MWTM software with this scenario, see Configuring 
MWTM with IOS Server Load Balancing, page H-17.
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This section describes a third scenario: how to configure the MWTM software to work with a 
dual-interface machine that is connected to two separate networks. Both networks have MWTM clients 
that need to connect to the MWTM server. The following is a diagram of a sample network where a single 
MWTM server is connected to two separate networks. Two MWTM clients, A and B, are on these two 
separate networks and need to communicate with the MWTM server.

Figure H-7 Sample Network

In this network configuration, the two networks (192.168.1.0/24 and 10.0.0.0/24) are not routed between 
each other. If the two networks were routed between each other (for example, if MWTM client B at 
10.0.0.2 could reach the MWTM server at 192.168.1.1), you would configure the MWTM server with 
the 192.168.1.1 address, which would enable the MWTM client A and MWTM client B to connect to 
the MWTM server.

Following is the example on how to configure the MWTM software to work with MWTM clients on both 
networks.

MWTM Server Configuration
The MWTM server can publish only one single IP address on the MWTM server machine. To configure 
this published address, use the mwtm servername command (see mwtm servername, page B-48).

For example, a system administrator configures the MWTM server to use the 192.168.1.1 address, by 
running the command mwtm servername 192.168.1.1 on the MWTM server machine. The MWTM 
server will restart for the change to take effect. The command changes the System.properties file on the 
MWTM server to contain following line:

SERVER_NAME = 192.168.1.1

MWTM Client A Configuration
No special configurations are required on MWTM client A. Since this client is on the same network as 
the MWTM server binding interface, MWTM client A can communicate freely with the MWTM server.

You do need to ensure that during installation, MWTM client A has setup the MWTM server IP address 
as 192.168.1.1.

If the initial installation has incorrect information, you can change the MWTM server IP address to 
192.168.1.1 using the mwtm servername command, or you can use the Change Default MWTM Server 
option on the MWTM client menu. For detailed information, see mwtm servername, page B-48 or 
Changing the Default MWTM Server Name, page 4-43.
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MWTM Client B Configuration
When the MWTM server starts up on a dual-interface machine, it starts the RMI server and binds it to 
all the interfaces.

The MWTM server then starts all MWTM services and binds them to all the interfaces. These MWTM 
services then register with the RMI server and publish themselves with the IP address specified in the 
SERVER_NAME property of the System.properties file on the MWTM server. In the given example, the 
published IP address is 192.168.1.1.

MWTM client B starts up, connecting to 10.0.0.1 (specified as the MWTM client B default server 
address). MWTM client B connects to the RMI server at 10.0.0.1.

MWTM client B then asks where the MWTM services are located. The RMI server replies that these 
MWTM services reside at 192.168.1.1. Without the RMIOverNAT.properties file on the MWTM client 
B, the client would try to connect to 192.168.1.1, which would fail.

If we have configured the RMIOverNAT.properties file on MWTM client B as in the example, MWTM 
client B will still connect to 10.0.0.1 for name lookup, and the name server will return that MWTM 
services are running on 192.168.1.1. The MWTM client then looks in the RMIOverNAT.properties file, 
and discovers that the translated address for 192.168.1.1 is 10.0.0.1. With this configuration, MWTM 
client B will try to connect to 10.0.0.1 (instead of 192.168.1.1) for RMI services. As the result, the 
connection will establish successfully.

Configuring MWTM client B involves two things:

• First, ensure that MWTM client B has setup the MWTM server IP address as 10.0.0.1 during 
installation.

If the initial installation has incorrect information, you can also change the MWTM server IP 
address to 10.0.0.1 using the mwtm servername 10.0.0.1 command, or using the Change Default 
MWTM Server option on the MWTM client menu.

• Next, you must edit the RMIOverNAT.properties file on the MWTM client machine. On a Windows 
client, the default location of this file is C:/ProgramFiles/SGMClient/properties/
RMIOverNAT.properties. On a Solaris client, the default location of this file is 
/opt/CSCOmwcClient/properties/RMIOverNAT.properties.

Add this line in the RMIOverNAT.properties file:

192.168.1.1 = 10.0.0.1

After you have completed these steps, MWTM client B will be able to connect to the MWTM server even 
if the MWTM server published address 192.168.1.1 is unreachable from MWTM client B. MWTM client 
B will convert 192.168.1.1 to a reachable IP address 10.0.0.1 for client to server TCP connection.
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Additional Network Configurations
Numerous other network configurations are not directly addressed here. The MWTM client and server 
can work with most of these networks, as long as the MWTM client and server can establish an SSH 
connection. 

A few examples of alternative network configurations are:

• Dynamic NAT, where the MWTM client and server are on two different sides of the dynamic NAT 
network.

• A situation where the MWTM client is in a trusted network and the MWTM server is in a public 
network, but the firewall does not allow a direct TCP connection made from the MWTM server to 
the MWTM client.

• A situation where the MWTM server is in a trusted network and the MWTM client is in a public 
network, but the firewall does not allow a direct TCP connection made from MWTM client to 
MWTM server.

To allow the MWTM client and server communication in these network environments, you can establish 
a SSH connection between the MWTM client and the MWTM server using SSH port-forwarding (for 
details, see Port-Forwarding Communication, page H-11). 

SSL Communication
If SSL is implemented and enabled in your MWTM system, the MWTM software uses secure socket 
communication for both RMI and HTTP communication between the MWTM client and server.

The MWTM software supports standard-based SSL encryption algorithms, including RSA, DSA public 
key algorithms, and 40-bit or 128-bit encryption. The MWTM software can generate an X.509 certificate 
and a certificate signing request (CSR), which is interoperable with most certificate authorities (CAs).

Both the MWTM web server and the MWTM server processes share the same SSL key/certificate pair. 
In addition, the MWTM client and the web browser can examine the server's certificate.

For more information, including descriptions of the MWTM commands and procedures used to 
implement, enable, manage, and monitor SSL support, see Implementing SSL Support in the MWTM, 
page 2-20.

Figure H-8 shows a sample MWTM-over-SSL network with these characteristics:

• A user-generated SSL key pair on the MWTM server.

• The server's certificate is trusted on the MWTM client.

• Communication between the client and server is RMI-over-SSL and HTTPS. Both protocols are 
encrypted and secure.
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Figure H-8 SSL Communication

Configuring MWTM with IOS Server Load Balancing
If a network failure causes the MWTM software to fail, you can no longer monitor your network. You 
can solve this potential problem by configuring a backup MWTM server, as detailed in Configuring a 
Backup MWTM Server, page 3-9. However, this solution requires a connection to the backup MWTM 
server, which might not mirror exactly the primary MWTM server.

A better solution is to use IOS Server Load Balancing (IOS SLB), which provides transparent failover 
of the MWTM client connection.

Use this procedure to configure the MWTM software with IOS SLB:

Step 1 Ensure that you have this required hardware and software:

• Solaris/Linux server with at least two network interface cards (NICs)

• Cisco 7204VXR or 7206VXR series node

• IOS SLB release 12.1(11b)E or later

• MWTM release 6.0 or later

Step 2 Configure the Solaris/Linux server with at least two active NICs.

Step 3 Configure a routing protocol on the Solaris/Linux server, such that if one network interface fails, the 
other interfaces can still contact the monitored networks and the MWTM client:

• Run in.routed on the Solaris/Linux server, with two RIP-based nodes on two separate networks 
providing routing tables for the server. See the in.routed man page for more information on this 
configuration.

• Use the GateD routing software developed by NextHop Technologies. Refer to this URL for more 
information:

http://www.gated.org

Step 4 Configure the Cisco 7204VXR or 7206VXR series router, with the Solaris/Linux server network 
interfaces configured as real servers in the server farm. Refer to the IOS SLB feature module for more 
information on configuring the IOS SLB node.
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Step 5 Configure a virtual interface, lo0:1 with the Internet address that matches the virtual IP address 
configured on the IOS SLB node:

ifconfig lo0:1 addif ip-address

Step 6 Install the MWTM software.

Step 7 Edit the /opt/CSCOsgm/properties/System.properties file, and replace the SERVER NAME variable with 
the DNS entry that matches the virtual IP address configured on the IOS SLB node. Save your changes 
and restart the MWTM server.

Step 8 Configure your MWTM clients to match the same DNS entry.

Step 9 Your configuration is complete.

Remember that:

• Failover of the MWTM client is transparent to the user. No additional changes are needed at that end.

• A failure of either interface, or of the surrounding networks, might cause the MWTM client to hang 
for a short period, depending on the convergence of the routing protocol used by the MWTM server. 
For example, with RIP, the MWTM client might hang for up to two minutes while RIP converges 
after a network failure. Faster protocols might result in shorter MWTM client hang times.
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This appendix contains this content:

• ITP Specific Archived Reports File Formats, page I-1

• RAN-O Specific Archived Reports File Formats, page I-18

ITP Specific Archived Reports File Formats
This section lists the formats for these Cisco IP Transfer Point (ITP) specific archived reports files:

• Application Server Process Statistics Daily and Peaks Daily Format, page I-2

• Application Server Process Statistics Hourly Format, page I-3

• Application Server Process Statistics MTP3 Daily and MTP3 Peaks Daily Format, page I-4

• Application Server Statistics Daily and Peaks Daily Format, page I-4

• Application Server Statistics Hourly Format, page I-5

• GTT Accounting Statistics Daily Format, page I-5

• Link Statistics Daily and Peaks Daily Format, page I-6

• Link Statistics Hourly Format, page I-7

• Link Statistics Multi Day Format, page I-8

• Linkset Statistics Daily and Peaks Daily Format, page I-8

• Linkset Statistics Hourly Format, page I-9

• MLR Aborts and Continues Daily Format, page I-10

• MLR Processed Statistics Daily Format, page I-10

• MLR Result Invokes Statistics Daily Format, page I-11

• MLR Rule Matches Statistics Daily Format, page I-11

• MLR SubTriggers Daily Format, page I-12

• MLR Triggers Daily Format, page I-12

• MSU Rates Load and Peaks Reports Format, page I-13

• MTP3 Accounting Statistics Daily Format, page I-14

• MTP3 Events Hourly Format, page I-15

• Point Code Inventory Format, page I-15
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• Q.752 Link Statistics Hourly Format, page I-15

• Custom Network Reports File Formats, page I-17

• Rolling Network Reports File Formats, page I-18

Application Server Process Statistics Daily and Peaks Daily Format
Archived reports for the Cisco Mobile Wireless Transport Manager (MWTM) daily and peaks daily 
application server process statistics reports use this format:

# =================================================================================
# Format of ASP Statistics Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date Calendar date in Excel import format
# 3 Sort Date Calendar date good for sorting
# 4 Node 
# 5 ASP Name               Val cItpXuaAspName
# 6 Node Disp Name       Display name of node from MWTM server
# 7 Hours Hours in day with data
# 8 Day Str Day string
# 9 Tot Pkts From Asp     In kilos
# 10 Tot Pkts To Asp       In kilos
# 11 Tot Pkts From Mtp3    In kilos
# 12 Tot Pkts To Mtp3      In kilos
# 13 Tot Errors Sent In kilos
# 14 Tot Errors Rcvd In kilos
# 15 Hourly Avg Pkts From Asp    Average hourly value
# 16 Hourly Avg Pkts To Asp      Average hourly value
# 17 Hourly Avg Pkts From Mtp3   Average hourly value
# 18 Hourly Avg Pkts To Mtp3     Average hourly value
# 19 Hourly Avg Errors Sent  Average hourly value
# 20 Hourly Avg Errors Rcvd  Average hourly value
# 21 Peak Pkts From Asp
# 22 Peak Pkts From Asp Hour
# 23 Peak Pkts To Asp
# 24 Peak Pkts To Asp Hour
# 25 Peak Pkts From Mtp3
# 26 Peak Pkts From Mtp3 Hour
# 27 Peak Pkts To Mtp3
# 28 Peak Pkts To Mtp3 Hour
# 29 Peak Errors Sent
# 30 Peak Errors Sent Hour
# 31 Peak Errors Rcvd
# 32 Peak Errors Rcvd Hour
# 33 Node SGM Id
# 34 SP Name
# 35 SP SGM Id
# 36 AS Parent
# 37 Ver
# =================================================================================
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Application Server Process Statistics Hourly Format
Archived reports for the MWTM hourly application server process statistics reports use this format:

# =================================================================================
# Format of ASP Statistics Hourly Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date Calendar date in Excel import format
# 3 Sort Date Calendar date good for sorting
# 4 Node 
# 5 ASP Name               Val cItpXuaAspName
# 6 Period Length of this period in seconds
# 7 Day Str Day string
# 8 Pkts From Asp Number of packets from ASP this period
# 9 Pkts To Asp Number of packets to ASP this period
# 10 Pkts From Mtp3 Number of packets from MTP3 this period
# 11 Pkts To Mtp3 Number of packets to MTP3 this period
# 12 Errors Sent Number of errors sent this period
# 13 Errors Rcvd Number of errors received this period
# 14 Node Disp Name       Display name of node from MWTM server
# 15 Node SGM Id
# 16 SP Name
# 17 SP SGM Id
# 18 AS Parent Parent AS name
# 19 Ver File version
#  20 UPACKs Sent 
#  21 UPs Rcvd 
#  22 DNACKs Sent 
#  23 DNs Rcvd
#  24 ACACKs Sent
#  25 ACs Rcvd
#  26 IAACKs Sent
#  27 IAs Rcvd
#  28 Notifys Sent
#  29 DUNAs Sent
#  30 DUNAs Rcvd 
#  31 DAVAs Sent
#  32 DAVAs Rcvd
#  33 DUPUs Sent 
#  34 DUPUs Rcvd
#  35 DAUDs Sent 
#  36 DAUDs Rcvd 
# =================================================================================



 

I-4
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix I      Archived Reports File Formats
  ITP Specific Archived Reports File Formats

Application Server Process Statistics MTP3 Daily and MTP3 Peaks Daily 
Format

Archived reports for the MWTM Message Transfer Part level 3 (MTP3) daily and MTP3 peaks daily 
application server statistics reports use this format:

# =================================================================================
# Format of AS Statistics MTP3 Daily Archived Reports:
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date Calendar date in Excel import format
# 3 Sort Date Calendar date good for sorting
# 4 Node
# 5 ASP Name               Val cItpXuaAspName
# 6 Node Disp Name      Display name of node from MWTM server
# 7 Hours Hours in day with data
# 8 Day Str Day string
# 9 Tot Pkts From Mtp3         In kilos
# 10 Tot Pkts To Mtp3         In kilos
# 11 Tot Errors Sent In kilos
# 12 Tot Errors Rcvd In kilos
# 13 Hourly Avg Pkts From Mtp3 Average hourly value
# 14 Hourly Avg Pkts To Mtp3 Average hourly value
# 15 Hourly Avg Errors Sent Average hourly value
# 16 Hourly Avg Errors Rcvd Average hourly value
# 17 Peak Pkts From Mtp3
# 18 Peak Pkts From Mtp3 Hour
# 19 Peak Pkts To Mtp3 
# 20 Peak Pkts To Mtp3 Hour
# 21 Peak Errors Sent
# 22 Peak Errors Sent Hour
# 23 Peak Errors Rcvd
# 24 Peak Errors Rcvd Hour
# 25 Node SGM Id
# 26 SP Name
# 27 SP SGM Id
# 28 AS Parent
# 29 Ver
# =================================================================================

Application Server Statistics Daily and Peaks Daily Format
Archived reports for the MWTM application server daily and peaks daily statistics reports use this 
format:

# =================================================================================
# Format of AS Statistics Daily Archived Reports:
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date 
# 3 Sort Date 
# 4 Node 
# 5 AS Name               Val cItpXuaAsName
# 6 Node Display Name      Display name of node from MWTM server
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# 7 Hours in Day with Data Hours in day with data
# 8 Day Str Day string
# 9 TotPktsFromMtp3         In kilos
# 10 TotPktsToASPsOfAs       In kilos
# 11 HourlyAvgPktsFromMtp3   Average hourly value
# 12 HourlyAvgPktsToASPsOfAs Average hourly value
# 13 PeakPktsFromMtp3
# 14 PeakPktsFromMtp3Hour
# 15 PeakPktsToASPsOfAs
# 16 PeakPktsToASPsOfAsHour
# 17 Node SGM Id
# 18 SP Name
# 19 SP SGM Id
# 20 Ver
# =================================================================================

Application Server Statistics Hourly Format
Archived reports for the MWTM hourly application server statistics reports use this format:

# =================================================================================
# Format of AS Statistics Hourly Archived Reports:
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 AS Name                 Val cItpXuaAsName
# 6 Period
# 7 Day Str
# 8 PktsFromMtp3 this period
# 9 PktsToASPsOfAs this period
# 10 Node Display Name       Display name of node from MWTM server
# 11 Node SGM Id
# 12 SP Name
# 13 SP SGM Id
# 14 Ver
# =================================================================================

GTT Accounting Statistics Daily Format
Archived reports for the MWTM daily Global Title Translation (GTT) accounting statistics reports use 
this format:

# =================================================================================
# Format of GTT Accounting Statistics Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset Name of linkset
# 6 Sel Name        Name of Global Title Selector
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# 7 GTA                  Name of Global Title Address
# 8 PC Translated point code
# 9 Diff Packets              Number of translated packets
# 10 Diff Octets               Number of translated octets
# 11 Node Disp Name     Display name of node from MWTM server
# 12 Linkset Disp Name Display name of linkset from ITP device
# 13 Period Length of this period in seconds
# 14 Day Str           Textual value for day (Sun, Mon, etc.)
# 15 Node SGM Id           Internal ID of node in MWTM server
# 16 Ver              File version
# 17 SP Name
# 18 SP SGM Id
# 19 To Instance          Instance in which the translated PC resides
# =================================================================================

Link Statistics Daily and Peaks Daily Format
Archived reports for the MWTM link daily and peaks daily statistics summary reports use this format:

# =================================================================================
# Format of Link Statistics Daily Export File:
#   Any value = 999.1 means link capacity not set
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset                Val cItpSpLinksetName
# 6 SLC                         Val cItpSpLinkSlc
# 7 Node Disp Name            Display name of node from MWTM server
# 8 Link Disp Name            Val cItpSpLinkDisplayName
# 9 Type 
# 10 Type Str
# 11 ifIndex
# 12 Send Cap Plan send capacity of link in bits/sec.
# 13 Recv Cap Plan receive capacity of link in bits/sec.
# 14 if Speed MIB-II ifSpeed of link. Serial/HSL only, in bits/sec.
# 15 Hours 
# 16 Day Str
# 17 Daily Avg Snd U
# 18 Daily Avg Rcv U
# 19 Peak Snd U
# 20 Peak Snd Hour
# 21 Peak Recv U
# 22 Peak Recv Hour
# 23 Tot Send MSUs - In Kilos
# 24 Tot Recv MSUs - In Kilos
# 25 Drops
# 26 Daily Avg In Srv
# 27 Low In Srv
# 28 Low Hour
# 29 LT Avg In Srv
# 30 LT Avg Snd U
# 31 LT Avg Rcv U
# 32 Node SGM Id
# 33 Ver
# 34 SP Name
# 35 SP SGM Id
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# 36 Avg Cong
# 37 Peak Congest
# 38 Peak Cong Hour
# =================================================================================

Link Statistics Hourly Format
Archived reports for the MWTM hourly link statistics reports use this format:

# =================================================================================
# Format of Link Statistics Hourly Archived Reports:
#   Possible values of Link Type are:
# other(1),serial(2),sctpIp(3),hsl(4)
#   Any value = 999.1 means link capacity not set
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset                 Val cItpSpLinksetName
# 6 SLC Val cItpSpLinkSlc
# 7 Node Disp Name Display name of node from MWTM server
# 8 Link Disp Name Val cItpSpLinkDisplayName 
# 9 Type (integer)        Val cItpSpLinkType
# 10 Type Str (text)
# 11 ifIndex MIB-II ifIndex of link. Serial/HSL only.
# 12 SendCap  Plan send capacity of link in bits/sec.  
# 13 RecvCap Plan receive capacity of link in bits/sec.
# 14 ifSpeed MIB-II ifSpeed of link. Serial/HSL only. 

In bits/sec.
# 15 Period
# 16 Day Str
# 17 Send Erl  Send utilization this time period. In Erlangs, 

not percent.
# 18 LT Send Erl Long-Term Average send utilization. In Erlangs, 

not percent.
# 19 Recv Erl  Recv utilization this time period. In Erlangs, 

not percent.
# 20 LT Recv Erl Long-Term Average receive utilization. In Erlangs, 

not percent.
# 21 Sent MSU Number of MTP3 MSUs sent this period
# 22 Recv MSU Number of MTP3 MSUs received this period
# 23 Drops Number of drops this period
# 24 In Ser Percentage of time in service this period
# 25 Avg In Serv Average percentage of time in service since reboot 

or last counter wrap
# 26 Out Ser Percentage of time out of service this period
# 27 Avg Out Ser Average percentage of time out of service since 

reboot or last counter wrap
# 28 Sent MTP3 Bytes  Number of MTP3 bytes sent this period
# 29 Recv MTP3 Bytes Number of MTP3 bytes received this period
# 30 Node SGM Id
# 31 Ver
# 32 SP Name
# 33 SP SGM Id
# 34 Percent Con  Percentage of time in congestion this period
# =================================================================================
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Link Statistics Multi Day Format
Archived reports for the MWTM multi day link statistics reports use this format:

# =================================================================================
# Format of Link Statistics Multi Day Archived Reports:
#   Any value = 999.1 means link capacity not set
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                        Description
# ---------------------------------------------------------------------------------
# 1 ID
# 2 Node
# 3 Linkset
# 4 SLC Val cItpSpLinkSlc
# 5 Node Disp Name Display name of node from MWTM server
# 6 Link Disp Name            Val cItpSpLinkDisplayName
# 7 Type (integer)         Val cItpSpLinkType
# 8 Type Str (text) Serial/HSL only.
# 9 ifIndex
# 10 Send Cap Plan send capacity of link in bits/sec.
# 11 Recv Cap Plan receive capacity of link in bits/sec.
# 12 ifSpeed Serial/HSL only. In bits/sec.
# 13 Hours Hours in day with data
# 14 Node SGM Id Internal ID of node in SGM server
# 15 Ver File version
# 16 SP Name Signaling point name
# 17 SPSGM Id
# 18 AvgSendUtil-YYYY-MM-DD For a 3 day report
# 19 AvgReceiveUtil-YYYY-MM-DD  For a 3 day report
# 20 AvgSendUtil-YYYY-MM-DD For a 3 day report
# 21 AvgReceiveUtil-YYYY-MM-DD For a 3 day report
# 22 AvgSendUtil-YYYY-MM-DD For a 3 day report
# 23 AvgReceiveUtil-YYYY-MM-DD For a 3 day report
# 24 AvgSendUtil-YYYY-MM-DD For a 5 day report
# 25 AvgReceiveUtil-YYYY-MM-DD For a 5 day report
# 26 AvgSendUtil-YYYY-MM-DD For a 5 day report
# 27 AvgReceiveUtil-YYYY-MM-DD For a 5 day report
# =================================================================================

Linkset Statistics Daily and Peaks Daily Format
Archived reports for the MWTM daily and peaks daily linkset statistics summary reports use this format:

# =================================================================================
# Format of Linkset Statistics Daily Archived Reports:
# =================================================================================

# Field Variable Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset                Val cItpSpLinksetName
# 6 Node Disp Name            Display name of node from MWTM server
# 7 Linkset Disp Name
# 8 Hours
# 9 Day Str
# 10 Daily Avg In Srv
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# 11 Low In Srv
# 12 Low Hour
# 13 LT Avg In Srv
# 14 Node SGM Id
# 15 Ver
# 16 SP Name
# 17 SP SGM Id
# 18 Daily Avg Snd U
# 19 Daily Avg Rcv U
# 20 Peak Snd U
# 21 Peak Snd Hour
# 22 Peak Recv U
# 23 Peak Recv Hour
# 24 LT Avg Snd U
# 25 LT Avg Rcv U
# =================================================================================

Linkset Statistics Hourly Format
Archived reports for the MWTM hourly linkset statistics reports use this format:

# =================================================================================
# Format of Linkset Statistics Hourly Archived Reports:
# =================================================================================

# Field Variable Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset                Val cItpSpLinksetName
# 6 Node Disp Name            Display name of node from MWTM server
# 7 Linkset Disp Name         Val cItpSpLinksetDisplayName 
# 8 Period
# 9 Day Str
# 10 In Ser Percentage of time in service this period 
# 11 Avg In Serv Average percentage of time in service 

since reboot
# 12 Out Ser Percentage of time out of service this period
# 13 Avg Out Serv Average percentage of time out of service 

since reboot
# 14 Node SGM Id
# 15 Ver
# 16 SP Name
# 17 SP SGM Id
# 18 Send Erl Send utilization this time period. In Erlangs, 

not percent.
# 19 Recv Erl Recv utilization this time period. In Erlangs, 

not percent.
# 20 LT Send Erl Long-Term average send utilization. In Erlangs, 

not percent.
# 21 LT Recv Erl Long-Term average recv utilization. In Erlangs, 

not percent.
# =================================================================================
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MLR Aborts and Continues Daily Format
Archived reports for the MWTM multilayer routing (MLR) daily aborts and continues statistics reports 
use this format:

# =================================================================================
# Format of MLR Aborts/Continues Stats Daily Archived Reports:
#   Signaling Point Level Statistics
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Diff Unsup Type MSUs returned to SCCP due to unsupported msg type
# 6 Diff Unsup Seg  MSUs returned to SCCP due to unsupported segment
# 7 Diff Unsup Msg  MSUs returned to SCCP due to unsupported message
# 8 Diff Parse Error MSUs returned to SCCP due to parse error
# 9 Diff No Result MSUs returned to SCCP with no result
# 10 Diff Result Cont MSUs returned to SCCP with continue result
# 11 Diff No Svr Cont MSUs returned to SCCP due to no available server
# 12 Diff Result GTT MSUs returned to SCCP with GTT result
# 13 Diff No Resources MSUs not processed due to resource shortage
# 14 Diff Result Block  MSUs not processed due to block result
# 15 Diff GTIM is  MSUs not processed due to mismatched GTI
# 16 Diff No Addv Conv  MSUs not processed due to GTA address conversion
# 17 Diff No Dest  MSUs not processed due to destination PC unavail
# 18 Diff Failed Trigger MSUs returned to SCCP due to no trigger match
# 19 Diff Routed  Number of times a packet was routed by MLR
# 20 Diff Continue MSUs passed back to SCCP processing
# 21 Diff Abort MSUs not processed due to invalid data or a 

blocked MSU
# 22 Diff No Svr Discard  MSUs not processed due to no available server 
# 23 Node Disp Name        Display name of node from MWTM server
# 24 Period                  Length of this period in seconds
# 25 Day Str              Textual value for day (Sun, Mon, etc.)
# 26 Node SGM Id             Internal ID of node in MWTM server
# 27 Ver                 File version
# 28 SP Name    Display name of signaling point
# 29 SP SGM Id  Internal ID of signaling point in MWTM server
# =================================================================================

MLR Processed Statistics Daily Format
Archived reports for the MWTM MLR daily processed statistics reports use this format:

# =================================================================================
# Format of MLR Processed Statistics Daily Archived Reports:
#   Signaling Point Level Statistics
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
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# 5 Diff Routed  Number of times a packet was routed by MLR
# 6 Diff Continue  MSUs passed back to SCCP processing
# 7 Diff Abort MSUs not processed due to invalid data or a blocked MSU
# 8 Diff SMS MO  Number of MSUs of type GSM-MAP SMS-MO
# 9 Diff SMS MT  Number of MSUs of type GSM-MAP SMS-MT
# 10 Diff SRI SM  Number of MSUs of type GSM-MAP SRI-SM
# 11 Diff Alert Number of MSUs of type GSM-MAP AlertSc
# 12 Diff SMD PP  Number of MSUs of type ANSI-41 SMD-PP
# 13 Diff SMS REQ Number of MSUs of type ANSI-41 SMSRequest
# 14 Diff SMS Notify  Number of MSUs of type ANSI-41 SMSNotify
# 15 Node Disp Name      Display name of node from MWTM server
# 16 Period                Length of this period in seconds
# 17 Day Str            Textual value for day (Sun, Mon, etc.)
# 18 Node SGM Id            Internal ID of node in MWTM server
# 19 Ver               File version
# 20 SP Name Display name of signaling point
# 21 SP SGM Id Internal ID of signaling point in MWTM server
# =================================================================================

MLR Result Invokes Statistics Daily Format
Archived reports for the MWTM MLR daily result invokes statistics reports use this format:

# =================================================================================
# Format of MLR Result Invokes Statistics Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Result set Name           
# 6 Result Num  Number of results within the result set
# 7 Diff Invoke 
# 8 Node Disp Name         Display name of node from MWTM server
# 9 Period                   Length of this period in seconds
# 10 Day Str              Textual value for day (Sun, Mon, etc.)
# 11 Node SGM Id               Internal ID of node in MWTM server
# 12 Ver                 File version
# 13 SP Name     Display name of signaling point
# 14 SP SGM Id    Internal ID of signaling point in MWTM server
# =================================================================================

MLR Rule Matches Statistics Daily Format
Archived reports for the MWTM MLR daily rule matches statistics reports use this format:

# =================================================================================
# Format of MLR Rule Matches Statistics Daily Archived Reports:
#   Any value = 999.2 means a math error occurred 
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
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# 4 Node
# 5 Ruleset Name             
# 6 Rule Num Number of rules within the ruleset
# 7 Diff Match  
# 8 Node Disp Name         Display name of node from MWTM server
# 9 Period                   Length of this period in seconds
# 10 Day Str               Textual value for day (Sun, Mon, etc.)
# 11 Node SGM Id               Internal ID of node in MWTM server
# 12 Ver                  File version 
# 13 SP Name     Display name of signaling point
# 14 SP SGM Id    Internal ID of signaling point in MWTM server
# =================================================================================

MLR SubTriggers Daily Format
Archived reports for the MWTM MLR daily subtrigger statistics reports use this format:

# ==============================================================================
# Format of MLR SubTrigger Stats Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# ==============================================================================

# Field Variable Description
# ------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Table Name          Name for this collection of MLR configs
# 6 Trigger Num Index number for parent trigger statement
# 7 Sub Trigger Num Index number for each subtrigger statement
# 8 Action              Action taken by the subtrigger
# 9 Params Str Parameters that control the trigger
# 10 Diff Match  
# 11 Node Disp Name    Display name of node from MWTM server
# 12 Period              Length of this period in seconds
# 13 Day Str          Textual value for day (Sun, Mon, etc.)
# 14 Node SGM Id          Internal ID of node in MWTM server
# 15 Ver             File version
# 16 SP Name     Display name of signaling point
# 17 SP SGM Id    Internal ID of signaling point in MWTM server
# ================================================================================

MLR Triggers Daily Format
Archived reports for the MWTM MLR daily trigger statistics reports use this format:

# =================================================================================
# Format of MLR Trigger Stats Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Table Name          Name for this collection of MLR configs
# 6 Trigger Num Index number for each trigger statement



 

I-13
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix I      Archived Reports File Formats
  ITP Specific Archived Reports File Formats

# 7 Action              Action taken by the trigger
# 8 Params Str Parameters that control the trigger
# 9 Active              Determines whether trigger is active
# 10 Diff Prel Match Preliminary count of trigger matches
# 11 Diff Match 
# 12 Node Disp Name    Display name of node from MWTM server
# 13 Period              Length of this period in seconds
# 14 Day Str          Textual value for day (Sun, Mon, etc.)
# 15 Node SGM Id          Internal ID of node in MWTM server
# 16 Ver             File version
# 17 SP Name     Display name of signaling point
# 18 SP SGM Id    Internal ID of signaling point in MWTM server
# =================================================================================

MSU Rates Load and Peaks Reports Format
Archived reports for the MWTM message signal units (MSU) load and peaks daily, hourly, and 15 
minute reports use this format:

# =================================================================================
# Format of MSU Load and Peaks Archived Reports:
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 id
# 2 time Stamp Database time stamp value
# 3 node Id Internal MWTM node ID
# 4 node Name 
# 5 node Display Name
# 6 processor Slot Number Contains the processor for which this record 

contains data
# 7 processor Bay Number Contains the processor for which this record

contains data
# 8 acceptable Threshhold Level of traffic below which traffic is 

acceptable
# 9 warning Threshold Level of traffic is above acceptable level 

but below a level that impacts MSU routing
# 10 overloaded Threshold Level of traffic indicating a rate that may 

impact MSU routing
# 11 reset Timestamp  
# 12 send Duration Warning Number of seconds rate state is warning
# 13 send Duration Overloaded Number of seconds rate state is overloaded
# 14 send Max Rate Maximum value of send rate since time 

specified
# 15 send Max Timestamp Time and date when send max rate was last 

sent
# 16 send Dur 00 to 09 Percent Total number of seconds when the MSU rate for 

this processor was x-x percent of the current 
overloaded threshold value.

# 17 send Dur 10 to 19
# 18 send Dur 20 to 29 Percent 
# 19 send Dur 30 to 39 Percent 
# 20 send Dur 40 to 49 Percent 
# 21 send Dur 50 to 59 Percent 
# 22 send Dur 60 to 69 Percent 
# 23 send Dur 70 to 79 Percent 
# 24 send Dur 80 to 89 Percent 
# 25 send Dur 90 or Above
# 26 receive Duration Warning Number of seconds the rate state is warning
# 27 receive Duration Overloaded Number of seconds the rate state is 

overloaded
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# 28 receive Max Rate Maximum value of receive rate since time 
specified

# 29 receive Max Timestamp Time and date when receive max rate was 
last set

# 30 receive Dur 00 to 09 Percent Total number of seconds when the MSU rate 
for this processor was x-x percent of the 
current overloaded threshold value.

# 31 receive Dur 10 to 19
# 32 receive Dur 20 to 29 Percent 
# 33 receive Dur 30 to 39 Percent 
# 34 receive Dur 40 to 49 Percent 
# 35 receive Dur 50 to 59 Percent 
# 36 receive Dur 60 to 69 Percent 
# 37 receive Dur 70 to 79 Percent 
# 38 receive Dur 80 to 89 Percent 
# 39 receive Dur 90 or Above

# =================================================================================

MTP3 Accounting Statistics Daily Format
Archived reports for the MWTM daily MTP3 accounting statistics reports use this format:

# =================================================================================
# Format of MTP3 Accounting Statistics Daily Archived Reports:
#   Any value = 999.2 means a math error occurred
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 Linkset                Name of Linkset
# 6 ACL Test                    Passed, failed, or unroutable
# 7 DPC                         Destination point code
# 8 OPC                         Originating point code
# 9 SI                          Service indicator
# 10 Diff Rcvd MSUs               Number of MSUs sent this period
# 11 Diff Sent MSUs                   Number of MSUs received this period
# 12 Diff Rcvd Bytes             Number of bytes sent this period
# 13 Diff Sent Bytes                 Number of bytes received this period
# 14 Node Disp Name            Display name of node from MWTM server
# 15 Linkset Disp Name         Display name of linkset from ITP
# 16 Diff Up Time
# 17 Day Str                  Textual value for day (Sun, Mon, etc.)
# 18 Node SGM Id                  Internal ID of node in MWTM server
# 19 Ver                     File version
# 20 SP Name        Name of signaling point from ITP
# 21 SP SGM Id      Internal ID of signaling point in MWTM server
# =================================================================================
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MTP3 Events Hourly Format
Archived reports for the MWTM hourly MTP3 event reports use this format:

# ================================================================
# Format of MTP3 Events Hourly Archived Reports:
# ================================================================
  
# Field Variable                         Description
# ----------------------------------------------------------------
#  1 ID
#  2  Date Calendar date in Excel import format
#  3  Sort Date Calendar date good for sorting
#  4  Node 
#  5 Index
#  6  Event Msg 
#  7  Node Disp Name             Display name of node from SGM server
#  8  Node SGM Id  Internal ID of node in SGM server
#  9  Day Str Day string
#  10 Ver File version
# =============================================================================

Point Code Inventory Format
Archived reports for the MWTM point code inventory reports are comma-separated value (CSV) text 
files. Each line of the file has this format:

# =================================================================================
# Format of Point Code Inventory Archived Reports:
# =================================================================================

# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Sig Point
# 2 Point Code
# 3 Node Name
# 4 Node Display Name
# 5 PC Type
# 6 SGM Id
# =================================================================================

Q.752 Link Statistics Hourly Format

Note Q.752 link statistics archived reports are not available through the MWTM web interface. You can access 
these reports in the /opt/CSCOsgm/reports/exporthourly directory on your server.

Archived reports for the MWTM hourly Q.752 link statistics reports use this format:

# =================================================================================
# Format of Q752 Link Statistics Hourly Archived Reports:
# Possible values of Link Type are:
#        other(1),serial(2),sctpIp(3),hsl(4),virtual(5)
#   Any value = 999.2 means a math error occurred

# =================================================================================
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# Field Variable                         Description
# ---------------------------------------------------------------------------------
# 1 Id
# 2 Date
# 3 Sort Date
# 4 Node
# 5 cgspLinksetName 
# 6 cgspLinkSlc
# 7 cgspLinkType (integer)
# 8  cgspLinkType (text)
# 9 cgspLinkifIndex
# 10 cgspLinkQ752T1E1  Number in this period
# 11 cgspLinkQ752T1E2  
# 12 cgspLinkQ752T1E3  
# 13 cgspLinkQ752T1E4*  
# 14 cgspLinkQ752T1E5  
# 15 cgspLinkQ752T1E6*  
# 16 cgspLinkQ752T1E7  
# 17 cgspLinkQ752T1E8  
# 18 cgspLinkQ752T1E9  
# 19 cgspLinkQ752T1E10  
# 20 cgspLinkQ752T1E11  
# 21 cgspLinkQ752T2E1  
# 22 cgspLinkQ752T2E2*  
# 23 cgspLinkQ752T2E3*  
# 24 cgspLinkQ752T2E4*  
# 25 cgspLinkQ752T2E5  
# 26 cgspLinkQ752T2E6  
# 27 cgspLinkQ752T2E7  
# 28 cgspLinkQ752T2E8*  
# 29 cgspLinkQ752T2E9  
# 30 cgspLinkQ752T2E10  
# 31 cgspLinkQ752T2E11*  
# 32 cgspLinkQ752T2E12*  
# 33 cgspLinkQ752T2E13*  
# 34 cgspLinkQ752T2E14*  
# 35 cgspLinkQ752T2E15  
# 36 cgspLinkQ752T2E16  
# 37 cgspLinkQ752T2E17*  
# 38 cgspLinkQ752T2E18  
# 39 cgspLinkQ752T2E19*  
# 40 cgspLinkQ752T3E1  
# 41 cgspLinkQ752T3E2Bytes  
# 42 cgspLinkQ752T3E3  
# 43 cgspLinkQ752T3E4
# 44 cgspLinkQ752T3E5  
# 45 cgspLinkQ752T3E6  
# 46 cgspLinkQ752T3E7
# 47 cgspLinkQ752T3E8*  
# 48 cgspLinkQ752T3E9*  
# 49 cgspLinkQ752T3E10L  Number in this period - Sum of L1-L3
# 50 cgspLinkQ752T3E11L  Number in this period - Sum of L1-L3
# 51 Period
# 52 Ver
# 53 Day Str
# 54 Node Disp Name
# 55 Node SGM Id
# 56 SP Name (PointCode:cgspInstNetwork)
# 57 SP SGM Id
# =================================================================================

Note Fields marked with an asterisk (*) are unsupported.
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Custom Network Reports File Formats
Archived reports for custom network statistics reports use the same format as the corresponding 
accounting, link, and linkset statistics reports:

• The archived reports for a custom GTT accounting statistics report uses the same format as the daily 
GTT accounting statistics report, as shown in GTT Accounting Statistics Daily Format, page I-5.

• The archived reports for a custom MLR aborts and continues statistics report uses the same format 
as the daily MLR aborts and continues statistics report, as shown in MLR Aborts and Continues 
Daily Format, page I-10.

• The archived reports for a custom MLR processed statistics report uses the same format as the daily 
MLR processed statistics report, as shown in MLR Processed Statistics Daily Format, page I-10.

• The archived reports for a custom MLR subtriggers statistics report uses the same format as the daily 
MLR subtriggers statistics report, as shown in MLR SubTriggers Daily Format, page I-12.

• The archived reports for a custom MLR triggers statistics report uses the same format as the daily 
MLR triggers statistics report, as shown in MLR Triggers Daily Format, page I-12.

• The archived reports for a custom MTP3 accounting statistics report uses the same format as the 
daily MTP3 accounting statistics report, as shown in MTP3 Accounting Statistics Daily Format, 
page I-14.

• The archived reports for a custom MTP3 events report uses the same format as the hourly MTP3 
events report, as shown in MTP3 Events Hourly Format, page I-15.

• The archived reports for a custom application server accounting statistics summary report uses the 
same format as the hourly application server accounting statistics report, as shown in Application 
Server Statistics Hourly Format, page I-5.

• The archived reports for a custom application server process accounting statistics summary report 
uses the same format as the hourly application server process accounting statistics report, as shown 
in Application Server Process Statistics Hourly Format, page I-3.

• The archived reports for a custom link statistics summary report uses the same format as the hourly 
link statistics report, as shown in Link Statistics Hourly Format, page I-7.

• The archived reports for a custom linkset statistics summary report uses the same format as the 
hourly linkset statistics report, as shown in Linkset Statistics Hourly Format, page I-9.
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Rolling Network Reports File Formats
Archived reports for 7-day and 30-day rolling network statistics reports use the same format as the 
corresponding link, linkset, application server, and application server process statistics reports:

RAN-O Specific Archived Reports File Formats
This section lists the formats for these RAN-O specific archived reports files:

• Capacity Summary Backhaul Reports, page I-18

• Capacity Summary Shorthaul Reports, page I-19

• Minimum Capacity Backhaul Reports, page I-20

• Average Capacity Backhaul Reports, page I-20

• Maximum Capacity Backhaul Reports, page I-21

Capacity Summary Backhaul Reports
Archived reports for the MWTM backhaul daily, hourly, and 15 minutes capacity summary data use this 
format:

# ====================================================================
# Format of Backhaul Capacity Summary Archived Reports
#
#
 
# Field Variables Description
# 
------------------------------------------------------------------------------------------
# 1  Title Report title
# 2  Object Object path
# 3  Report Version

Report Type Format

7-day:

• Link statistics summary

• Linkset statistics summary

• Application server summary

• Application server process 
summary

• Link Statistics Hourly Format, page I-7

• Linkset Statistics Hourly Format, page I-9

• Application Server Statistics Hourly Format, page I-5

• Application Server Process Statistics Hourly Format, 
page I-3

30-day:

• Link statistics summary

• Linkset statistics summary

• Application server summary

• Application server process 
summary

• Link Statistics Daily and Peaks Daily Format, page I-6

• Linkset Statistics Daily and Peaks Daily Format, page I-8

• Application Server Statistics Daily and Peaks Daily 
Format, page I-4

• Application Server Process Statistics Daily and Peaks 
Daily Format, page I-2
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# 4  Start Date
# 5  End Date 
# 6  Type  
# 7  Errors Timestamp 
# 8  Total Errors 
# 9  Send Minimum Timestamp 
# 10 Send Total Minimum 
# 11 Send Average Timestamp 
# 12 Send Total Average 
# 13 Send Maximum Timestamp 
# 14 Send Total Maximum 
# 15 Receive Minimum Timestamp
# 16 Receive Total Minimum
# 17 Receive Average Timestamp
# 18 Receive Total Average
# 19 Receive Maximum Timestamp
# 20 Receive Total Maximum

Capacity Summary Shorthaul Reports
Archived reports for the MWTM shorthaul daily, hourly, and 15 minutes capacity summary data use this 
format:

# ====================================================================
# Format of Shorthaul Capacity Summary Archived Reports
#
#
 
# Field Variables Description
# 
------------------------------------------------------------------------------------------
# 1  Title Report title
# 2  Object Object path
# 3  Report Version
# 4  Start Date
# 5  End Date 
# 6 Send Minimum Timestamp 
# 7 Send Minimum
# 8  Send Average
# 9  Send Maximum Timestamp
# 10 Send Maximum
# 11 Receive Minimum Timestamp
# 12 Receive Minimum
# 13 Receive Average Timestamp
# 14 Receive Average
# 15 Receive Maximum Timestamp
# 16 Receive Maximum
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Minimum Capacity Backhaul Reports
Archived reports for the MWTM daily, hourly, and 15 minutes minimum capacity data use this format:

# ====================================================================
# Format of Backhaul Minimum Capacity Archived Reports
#
#
 
# Field Variables Description
# 
------------------------------------------------------------------------------------------
# 1  Title Report title
# 2  Object Object path
# 3  Report Version
# 4  Start Date
# 5  End Date
# 6 Name
# 7 Type  
# 8 Send Minimum Timestamp 
# 9 Send Minimum
# 10 Receive Minimum Timestamp
# 11 Receive Minimum 

Average Capacity Backhaul Reports
Archived reports for the MWTM daily, hourly, and 15 minutes average capacity data use this format:

# ====================================================================
# Format of Backhaul Average Capacity Archived Reports
#
#
 
# Field Variables Description
# 
------------------------------------------------------------------------------------------
# 1  Title Report title
# 2  Object Object path
# 3  Report Version
# 4  Start Date
# 5  End Date
# 6 Name
# 7 Type  
# 8 Timestamp 
# 9 Send Average
# 10 Receive Average
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Maximum Capacity Backhaul Reports
Archived reports for the MWTM daily, hourly, and 15 minutes maximum capacity data use this format:

# ====================================================================
# Format of Backhaul Maximum Capacity Archived Reports
#
#
 
# Field Variables Description
# 
------------------------------------------------------------------------------------------
# 1  Title Report title
# 2  Object Object path
# 3  Report Version
# 4  Start Date
# 5  End Date
# 6 Name
# 7 Type  
# 8 Send Maximum Timestamp 
# 9 Send Maximum
# 10 Receive Maximum Timestamp
# 10 Receive Maximum
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The Cisco Mobile Wireless Transport Manager (MWTM) uses the following default ports to provide 
services:

Port Name or Number Port Type Description

1774 tcp Apache web server

1775 tcp TOMCAT Java Server Pages (JSP) server

44742 tcp Java Remote Method Invocation (RMI) naming service

dynamic port 1 tcp Java RMI service for Login Service. A network or system 
administrator can specify a fixed port using the 
LOGINSERVER_PORT parameter in the System.properties 
file.

Note If you installed the MWTM in the default directory, 
/opt, then the location of the System.properties file is 
/opt/CSCOsgm/properties/System.properties. If you 
installed the MWTM in a different directory, then the 
System.properties file resides in that directory.

dynamic port 2 tcp Java RMI service for the MWTM Data Server. A network or 
system administrator can specify a fixed port using the 
DATASERVER_PORT parameter in the System.properties 
file.

Note If you installed the MWTM in the default directory, 
/opt, then the location of the System.properties file is 
/opt/CSCOsgm/properties/System.properties. If you 
installed the MWTM in a different directory, then the 
System.properties file resides in that directory.
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162 udp Simple Network Management Protocol (SNMP) trap listener

dynamic ports 1-25 udp SNMP request senders. These ports are used by the SNMP 
stack for sending SNMP requests. A maximum of 25 can be 
opened in the MWTM. You can customize the number of 
ports by changing the SNMP_SOCKET_NUMBER 
parameter in the Server.properties file.

Note If you installed the MWTM in the default directory, 
/opt, then the location of the Server.properties file is 
/opt/CSCOsgm/properties/Server.properties. If you 
installed the MWTM in a different directory, then the 
Server.properties file resides in that directory.

Port Name or Number Port Type Description
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Open Source License Notices for the Cisco Mobile 
Wireless Transport Manager

Notices
The following notices pertain to these software licenses:

• OpenSSL/Open SSL Project, page K-1

• Apache 2.0 Licensed Software, page K-4

• Apache 1.1 Licensed Software, page K-7

• GPL V2 Software, page K-8

• Lesser General Public License 2.1 Software, page K-13

• .useful Java Library, page K-20

• Clearthought Tablelayout, page K-21

• JSCH, page K-22

• JAXP, page K-22

• JAX-WS, page K-25

• mod_ssl, page K-30

• Netbeans IDE 4.1, CVS Client Library, page K-31

• TCL, page K-37

• Zip, page K-38

• Expect, page K-38

OpenSSL/Open SSL Project
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

http://www.openssl.org/
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License Issues

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the 
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses 
are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact 
openssl-core@openssl.org.

OpenSSL License:

Copyright © 1998-2007 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgment: “This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit (http://www.openssl.org/)”.

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in 
their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/)”.

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS”' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License:

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

http://www.openssl.org/
http://www.openssl.org/
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This library is free for commercial and non-commercial use as long as the following conditions are 
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is 
covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. 
If this package is used in a product, Eric Young should be given attribution as the author of the parts of 
the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”.

The word ‘cryptographic’ can be left out if the routines from the library being used are not 
cryptography-related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: “This product includes software written 
by Tim Hudson (tjh@cryptsoft.com)”.

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publicly available version or derivative of this code cannot be 
changed. i.e. this code cannot simply be copied and put under another distribution license [including the 
GNU Public License].
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Apache 2.0 Licensed Software
This product includes software developed by the Apache Software Foundation.  
(http://www.apache.org/).

The following software is included which is licensed under the Apache 2.0 license.

• Apache Derby. The license is attached below.

• Apache HTTP Server. Modifications are Copyright 2006 Cisco Systems Inc. Modified source code 
is distributed on the MWTM DVD in /sgm-pdsources/src/apache-http-mods.tar.gz..

• Apache Jakarta Velocity. The license is attached below.

• Apache Log4j.  The license is attached below.

• Apache Struts.  The license is attached below.

• Apache Tomcat.  The license is attached below.

• JBoss Rules.  The license is attached below.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is 
granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are 
controlled by, or are under common control with that entity. For the purposes of this definition, 
"control" means (i) the power, direct or indirect, to cause the direction or management of such entity, 
whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding 
shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a 
Source form, including but not limited to compiled object code, generated documentation, and 
conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under 
the License, as indicated by a copyright notice that is included in or attached to the work (an example 
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or 
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other 
modifications represent, as a whole, an original work of authorship. For the purposes of this License, 
Derivative Works shall not include works that remain separable from, or merely link (or bind by 
name) to the interfaces of, the Work and Derivative Works thereof.
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"Contribution" shall mean any work of authorship, including the original version of the Work and 
any modifications or additions to that Work or Derivative Works thereof, that is intentionally 
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal 
Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, 
"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or 
its representatives, including but not limited to communication on electronic mailing lists, source 
code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor 
for the purpose of discussing and improving the Work, but excluding communication that is 
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a 
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a 
Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a 
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to 
reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and 
distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. 

Subject to the terms and conditions of this License, each Contributor hereby grants to You a 
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this 
section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the 
Work, where such license applies only to those patent claims licensable by such Contributor that are 
necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with 
the Work to which such Contribution(s) was submitted. If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation 
is filed.

4. Redistribution. 

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, 
with or without modifications, and in Source or Object form, provided that You meet the following 
conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and 

2. You must cause any modified files to carry prominent notices stating that You changed the files; 
and 

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, 
patent, trademark, and attribution notices from the Source form of the Work, excluding those 
notices that do not pertain to any part of the Derivative Works; and 
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4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works 
that You distribute must include a readable copy of the attribution notices contained within such 
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, 
in at least one of the following places: within a NOTICE text file distributed as part of the 
Derivative Works; within the Source form or documentation, if provided along with the 
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such 
third-party notices normally appear. The contents of the NOTICE file are for informational 
purposes only and do not modify the License. You may add Your own attribution notices within 
Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from 
the Work, provided that such additional attribution notices cannot be construed as modifying 
the License.

You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, 
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of 
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. 

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the 
Work by You to the Licensor shall be under the terms and conditions of this License, without any 
additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify 
the terms of any separate license agreement you may have executed with Licensor regarding such 
Contributions.

6. Trademarks. 

This License does not grant permission to use the trade names, trademarks, service marks, or 
product names of the Licensor, except as required for reasonable and customary use in describing 
the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. 

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR 
CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any 
warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 
FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness 
of using or redistributing the Work and assume any risks associated with Your exercise of 
permissions under this License.

8. Limitation of Liability. 

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, 
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in 
writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, 
incidental, or consequential damages of any character arising as a result of this License or out of the 
use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even 
if such Contributor has been advised of the possibility of such damages.



 

K-7
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix K      Open Source License Notices for the Cisco Mobile Wireless Transport Manager
  Notices

9. Accepting Warranty or Additional Liability. 

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a 
fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights 
consistent with this License. However, in accepting such obligations, You may act only on Your 
own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You 
agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or 
claims asserted against, such Contributor by reason of your accepting any such warranty or 
additional liability.

END OF TERMS AND CONDITIONS

Apache 1.1 Licensed Software 
This software includes software developed by the Apache Software Foundation 
(http://www.apache.org/).

Apache Jakarta Commons Net.  Copyright (c) 2000 The Apache Software Foundation.  All rights 
reserved  The license is attached below.

The Apache Software License, Version 1.1

Copyright (c) 2000 The Apache Software Foundation.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment:

"This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party 
acknowledgments normally appear.

4. The names "Apache" and "Apache Software Foundation" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache 
Software Foundation.  For more information on the Apache Software Foundation, please see 
<http://www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National Center 
for Supercomputing Applications, University of Illinois, Urbana-Champaign.

GPL V2 Software
• coreutils.  The license is attached.  The source code is distributed on the MWTM DVD as 

/sgm-pdsources/src/coreutils-5.2.1.tar.gz.

• CVS.  The license is attached. The source code is distributed on the MWTM DVD as 
/sgm-pdsources/src/cvs-1.12.12.tar.gz.

• gawk.  The license is attached. The source code is distributed on the MWTM DVD as 
/sgm-pdsources/src gawk-3.1.1.tar.gz

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 
02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 
is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it.  By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and change 
free software--to make sure the software is free for all its users.  This General Public License applies to 
most of the Free Software Foundation's software and to any other program whose authors commit to 
using it.  (Some other Free Software Foundation software is covered by the GNU Lesser General Public 
License instead.)  You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses 
are designed to make sure that you have the freedom to distribute copies of free software (and charge for 
this service if you wish), that you receive source code or can get it if you want it, that you can change 
the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask 
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute 
copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the 
recipients all the rights that you have.  You must make sure that they, too, receive or can get the source 
code.  And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which 
gives you legal permission to copy, distribute and/or modify the software.



 

K-9
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix K      Open Source License Notices for the Cisco Mobile Wireless Transport Manager
  Notices

Also, for each author's protection and ours, we want to make certain that everyone understands that there 
is no warranty for this free software.  If the software is modified by someone else and passed on, we want 
its recipients to know that what they have is not the original, so that any problems introduced by others 
will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that 
redistributors of a free program will individually obtain patent licenses, in effect making the program 
proprietary.  To prevent this, we have made it clear that any patent must be licensed for everyone's free 
use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright 
holder saying it may be distributed under the terms of this General Public License.  The "Program", 
below, refers to any such program or work, and a "work based on the Program" means either the 
Program or any derivative work under copyright law: that is to say, a work containing the Program 
or a portion of it, either verbatim or with modifications and/or translated into another language.  
(Hereinafter, translation is included without limitation in the term "modification".)  Each licensee is 
addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope.  The act of running the Program is not restricted, and the output from the Program 
is covered only if its contents constitute a work based on the Program (independent of having been 
made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 
medium, provided that you conspicuously and appropriately publish on each copy an appropriate 
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and 
to the absence of any warranty; and give any other recipients of the Program a copy of this License 
along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based 
on the Program, and copy and distribute such modifications or work under the terms of Section 1 
above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files 
and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is 
derived from the Program or any part thereof, to be licensed as a whole at no charge to all third 
parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, 
when started running for such interactive use in the most ordinary way, to print or display an 
announcement including an appropriate copyright notice and a notice that there is no warranty 
(or else, saying that you provide a warranty) and that users may redistribute the program under 
these conditions, and telling the user how to view a copy of this License.  (Exception: if the 
Program itself is interactive but does not normally print such an announcement, your work 
based on the Program is not required to print an announcement.)
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These requirements apply to the modified work as a whole.  If identifiable sections of that work are 
not derived from the Program, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them 
as separate works.  But when you distribute the same sections as part of a whole which is a work 
based on the Program, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every part regardless 
of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely 
by you; rather, the intent is to exercise the right to control the distribution of derivative or collective 
works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with 
a work based on the Program) on a volume of a storage or distribution medium does not bring the 
other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 
executable form under the terms of Sections 1 and 2 above provided that you also do one of the 
following:

a. Accompany it with the complete corresponding machine-readable source code, which must be 
distributed under the terms of Sections 1 and 2 above on a medium customarily used for 
software interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for a 
charge no more than your cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding 
source code.  (This alternative is allowed only for noncommercial distribution and only if you 
received the program in object code or executable form with such an offer, in accord with 
Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it.  
For an executable work, complete source code means all the source code for all modules it contains, 
plus any associated interface definition files, plus the scripts used to control compilation and 
installation of the executable.  However, as a special exception, the source code distributed need not 
include anything that is normally distributed (in either source or binary form) with the major 
components (compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not compelled to copy the source along 
with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under 
this License.  Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, 
and will automatically terminate your rights under this License. However, parties who have received 
copies, or rights, from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.  However, nothing else 
grants you permission to modify or distribute the Program or its derivative works.  These actions are 
prohibited by law if you do not accept this License.  Therefore, by modifying or distributing the 
Program (or any work based on the Program), you indicate your acceptance of this License to do so, 
and all its terms and conditions for copying, distributing or modifying the Program or works based 
on it.
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6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the Program 
subject to these terms and conditions.  You may not impose any further restrictions on the recipients' 
exercise of the rights granted herein. You are not responsible for enforcing compliance by third 
parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions 
of this License.  If you cannot distribute so as to satisfy simultaneously your obligations under this 
License and any other pertinent obligations, then as a consequence you may not distribute the 
Program at all.  For example, if a patent license would not permit royalty-free redistribution of the 
Program by all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply and the section as a whole is intended to apply in other 
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting the 
integrity of the free software distribution system, which is implemented by public license practices.  
Many people have made generous contributions to the wide range of software distributed through 
that system in reliance on consistent application of that system; it is up to the author/donor to decide 
if he or she is willing to distribute software through any other system and a licensee cannot impose 
that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest 
of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Program under this License may 
add an explicit geographical distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded.  In such case, this License incorporates the 
limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time.  Such new versions will be similar in spirit to the present version, but 
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Program specifies a version number 
of this License which applies to it and "any later version", you have the option of following the terms 
and conditions either of that version or of any later version published by the Free Software 
Foundation.  If the Program does not specify a version number of this License, you may choose any 
version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission.  For software which is copyrighted 
by the Free Software Foundation, write to the Free Software Foundation; we sometimes make 
exceptions for this.  Our decision will be guided by the two goals of preserving the free status of all 
derivatives of our free software and of promoting the sharing and reuse of software generally.
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NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT 
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER 
PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS 
WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED 
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER 
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best 
way to achieve this is to make it free software which everyone can redistribute and change under these 
terms.

To do so, attach the following notices to the program.  It is safest to attach them to the start of each source 
file to most effectively convey the exclusion of warranty; and each file should have at least the 
"copyright" line and a pointer to where the full notice is found.

<one line to give the program's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU 
General Public License as published by the Free Software Foundation; either version 2 of the License, 
or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  
See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, 
write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 
USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'.

This is free software, and you are welcome to redistribute it

under certain conditions; type `show c' for details.
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The hypothetical commands `show w' and `show c' should show the appropriate parts of the General 
Public License.  Of course, the commands you use may be called something other than `show w' and 
`show c'; they could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a 
"copyright disclaimer" for the program, if necessary.  Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program

`Gnomovision' (which makes passes at compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

  Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs.  If 
your program is a subroutine library, you may consider it more useful to permit linking proprietary 
applications with the library.  If this is what you want to do, use the GNU Lesser General Public License 
instead of this License.

Lesser General Public License  2.1 Software
JBoss Application Server.  The license is attached below, LGPL 2.1. The source code is distributed on 
the MWTM DVD as /sgm-pdsources/src/ jboss-4.0.4.GA-src.tar.gz.

JFreeChart.  (C)opyright 2000-2006, by Object Refinery Limited and Contributors.  The license file is 
attached below, LGPL 2.1. The source code is distributed on the MWTM DVD as 
/sgm-pdsources/src/jfreechart-1.0.3.tar.gz.  JfreeChart is provided without Warranty.

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 
is not allowed.

[This is the first released version of the Lesser GPL.  It also counts as the successor of the GNU Library 
Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it.  By 
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change

free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software 
packages--typically libraries--of the Free Software Foundation and other authors who decide to use it.  
You can use it too, but we suggest you first think carefully about whether this license or the ordinary 
General Public License is the better strategy to use in any particular case, based on the explanations 
below.
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When we speak of free software, we are referring to freedom of use, not price.  Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free software (and 
charge for this service if you wish); that you receive source code or can get it if you want it; that you can 
change the software and use pieces of it in new free programs; and that you are informed that you can 
do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or 
to ask you to surrender these rights.  These restrictions translate to certain responsibilities for you if you 
distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the 
recipients all the rights that we gave you.  You must make sure that they, too, receive or can get the source 
code.  If you link other code with the library, you must provide complete object files to the recipients, 
so that they can relink them with the library after making changes to the library and recompiling it.  And 
you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this 
license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library.  
Also, if the library is modified by someone else and passed on, the recipients should know that what they 
have is not the original version, so that the original author's reputation will not be affected by problems 
that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program.  We wish to make 
sure that a company cannot effectively restrict the users of a free program by obtaining a restrictive 
license from a patent holder.  Therefore, we insist that any patent license obtained for a version of the 
library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License.  
This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite 
different from the ordinary General Public License.  We use this license for certain libraries in order to 
permit linking those ibraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of 
the two is legally speaking a combined work, a derivative of the original library.  The ordinary General 
Public License therefore permits such linking only if the entire combination fits its criteria of freedom.  
The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user's 
freedom than the ordinary General Public License.  It also provides other free software developers Less 
of an advantage over competing non-free programs.  These disadvantages are the reason we use the 
ordinary General Public License for many libraries.  However, the Lesser license provides advantages in 
certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a 
certain library, so that it becomes a de-facto standard.  To achieve this, non-free programs must be 
allowed to use the library.  A more frequent case is that a free library does the same job as widely used 
non-free libraries.  In this case, there is little to gain by limiting the free library to free software only, so 
we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of 
people to use a large body of free software.  For example, permission to use the GNU C Library in 
non-free programs enables many more people to use the whole GNU operating system, as well as its 
variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that 
the user of a program that is linked with the Library has the freedom and the wherewithal to run that 
program using a modified version of the Library.
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The precise terms and conditions for copying, distribution and modification follow.  Pay close attention 
to the difference between a "work based on the library" and a "work that uses the library".  The former 
contains code derived from the library, whereas the latter must be combined with the library in order to 
run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice 
placed by the copyright holder or other authorized party saying it may be distributed under the terms 
of this Lesser General Public License (also called "this License"). Each licensee is addressed as 
"you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently 
linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under 
these terms.  A "work based on the Library" means either the Library or any derivative work under 
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with 
modifications and/or translated straightforwardly into another language.  (Hereinafter, translation is 
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it.  For 
a library, complete source code means all the source code for all modules it contains, plus any 
associated interface definition files, plus the scripts used to control compilation and installation of 
the library.

Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope.  The act of running a program using the Library is not restricted, and output from 
such a program is covered only if its contents constitute a work based on the Library (independent 
of the use of the Library in a tool for writing it).  Whether that is true depends on what the Library 
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive 
it, in any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this 
License and to the absence of any warranty; and distribute a copy of this License along with the 
Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based 
on the Library, and copy and distribute such modifications or work under the terms of Section 1 
above, provided that you also meet all of these conditions:

a. The modified work must itself be a software library.

b. You must cause the files modified to carry prominent notices stating that you changed the files 
and the date of any change.

c. You must cause the whole of the work to be licensed at no charge to all third parties under the 
terms of this License.
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d. If a facility in the modified Library refers to a function or a table of data to be supplied by an 
application program that uses the facility, other than as an argument passed when the facility is 
invoked, then you must make a good faith effort to ensure that, in the event an application does 
not supply such function or table, the facility still operates, and performs whatever part of its 
purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely 
well-defined independent of the application.  Therefore, Subsection 2d requires that any 
application-supplied function or table used by this function must be optional: if the application does 
not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole.  If identifiable sections of that work are 
not derived from the Library, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them 
as separate works.  But when you distribute the same sections as part of a whole which is a work 
based on the Library, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every part regardless 
of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely 
by you; rather, the intent is to exercise the right to control the distribution of derivative or collective 
works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a 
work based on the Library) on a volume of a storage or distribution medium does not bring the other 
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License 
to a given copy of the Library.  To do this, you must alter all the notices that refer to this License, 
so that they refer to the ordinary GNU General Public License, version 2, instead of to this License.  
(If a newer version than version 2 of the ordinary GNU General Public License has appeared, then 
you can specify that version instead if you wish.)  Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU 
General Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is 
not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object 
code or executable form under the terms of Sections 1 and 2 above provided that you accompany it 
with the complete corresponding machine-readable source code, which must be distributed under 
the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then 
offering equivalent access to copy the source code from the same place satisfies the requirement to 
distribute the source code, even though third parties are not compelled to copy the source along with 
the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the 
Library by being compiled or linked with it, is called a "work that uses the Library".  Such a work, 
in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this 
License.

However, linking a "work that uses the Library" with the Library creates an executable that is a 
derivative of the Library (because it contains portions of the Library), rather than a "work that uses 
the library".  The executable is therefore covered by this License. Section 6 states terms for 
distribution of such executables.
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When a "work that uses the Library" uses material from a header file that is part of the Library, the 
object code for the work may be a derivative work of the Library even though the source code is not. 
Whether this is true is especially significant if the work can be linked without the Library, or if the 
work is itself a library.  The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small 
macros and small inline functions (ten lines or less in length), then the use of the object file is 
unrestricted, regardless of whether it is legally a derivative work.  (Executables containing this 
object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work 
under the terms of Section 6. Any executables containing that work also fall under Section 6, 
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" 
with the Library to produce a work containing portions of the Library, and distribute that work under 
terms of your choice, provided that the terms permit modification of the work for the customer's own 
use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the 
Library and its use are covered by this License.  You must supply a copy of this License.  If the work 
during execution displays copyright notices, you must include the copyright notice for the Library 
among them, as well as a reference directing the user to the copy of this License.  Also, you must 
do one of these things:

a. Accompany the work with the complete corresponding machine-readable source code for the 
Library including whatever changes were used in the work (which must be distributed under 
Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the 
complete machine-readable "work that uses the Library", as object code and/or source code, so 
that the user can modify the Library and then relink to produce a modified executable containing 
the modified Library.  (It is understood that the user who changes the contents of definitions 
files in the Library will not necessarily be able to recompile the application to use the modified 
definitions.)

b. Use a suitable shared library mechanism for linking with the Library.  A suitable mechanism is 
one that (1) uses at run time a copy of the library already present on the user's computer system, 
rather than copying library functions into the executable, and (2) will operate properly with a 
modified version of the library, if the user installs one, as long as the modified version is 
interface-compatible with the version that the work was made with.

c. Accompany the work with a written offer, valid for at least three years, to give the same user 
the materials specified in Subsection 6a, above, for a charge no more than the cost of performing 
this distribution.

d. If distribution of the work is made by offering access to copy from a designated place, offer 
equivalent access to copy the above specified materials from the same place.

e. Verify that the user has already received a copy of these materials or that you have already sent 
this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and 
utility programs needed for reproducing the executable from it.  However, as a special exception, the 
materials to be distributed need not include anything that is normally distributed (in either source or 
binary form) with the major components (compiler, kernel, and so on) of the operating system on 
which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries 
that do not normally accompany the operating system.  Such a contradiction means you cannot use 
both them and the Library together in an executable that you distribute.
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7. You may place library facilities that are a work based on the Library side-by-side in a single library 
together with other library facilities not covered by this License, and distribute such a combined 
library, provided that the separate distribution of the work based on the Library and of the other 
library facilities is otherwise permitted, and provided that you do these two things:

a. Accompany the combined library with a copy of the same work based on the Library, 
uncombined with any other library facilities.  This must be distributed under the terms of the 
Sections above.

b. Give prominent notice with the combined library of the fact that part of it is a work based on 
the Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly 
provided under this License.  Any attempt otherwise to copy, modify, sublicense, link with, or 
distribute the Library is void, and will automatically terminate your rights under this License.  
However, parties who have received copies, or rights, from you under this License will not have their 
licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it.  However, nothing else 
grants you permission to modify or distribute the Library or its derivative works.  These actions are 
prohibited by law if you do not accept this License.  Therefore, by modifying or distributing the 
Library (or any work based on the Library), you indicate your acceptance of this License to do so, 
and all its terms and conditions for copying, distributing or modifying the Library or works based 
on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient 
automatically receives a license from the original licensor to copy, distribute, link with or modify 
the Library subject to these terms and conditions.  You may not impose any further restrictions on 
the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions 
of this License.  If you cannot distribute so as to satisfy simultaneously your obligations under this 
License and any other pertinent obligations, then as a consequence you may not distribute the 
Library at all.  For example, if a patent license would not permit royalty-free redistribution of the 
Library by all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply, and the section as a whole is intended to apply in other 
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting the 
integrity of the free software distribution system which is implemented by public license practices.  
Many people have made generous contributions to the wide range of software distributed through 
that system in reliance on consistent application of that system; it is up to the author/donor to decide 
if he or she is willing to distribute software through any other system and a licensee cannot impose 
that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest 
of this License.
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12. If the distribution and/or use of the Library is restricted in ertain countries either by patents or by 
copyrighted interfaces, the original copyright holder who places the Library under this License may 
add an explicit geographical distribution limitation excluding those countries, so that distribution is 
permitted only in or among countries not thus excluded.  In such case, this License incorporates the 
limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Library specifies a version number of 
this License which applies to it and "any later version", you have the option of following the terms 
and conditions either of that version or of any later version published by the Free Software 
Foundation.  If the Library does not specify a license version number, you may choose any version 
ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions 
are incompatible with these, write to the author to ask for permission.  For software which is 
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes 
make exceptions for this.  Our decision will be guided by the two goals of preserving the free status 
of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR 
THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH 
YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED 
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR 
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we 
recommend making it free software that everyone can redistribute and change.  You can do so by 
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General 
Public License).

To apply these terms, attach the following notices to the library.  It is safest to attach them to the start of 
each source file to most effectively convey the exclusion of warranty; and each file should have at least 
the "copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.>

Copyright (C) <year>  <name of author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser 
General Public License as published by the Free Software Foundation; either version 2.1 of the License, 
or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  
See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if 
not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  
02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a 
"copyright disclaimer" for the library, if necessary.  Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the

library `Frob' (a library for tweaking knobs) written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

  Ty Coon, President of Vice

That's all there is to it!

.useful Java Library
This product includes software developed by the .useful community.

.useful Java library - License.useful Java library

.useful is Open Source under the Apache license which means you can use it with your commercial or 
non-commercial applications. The only requirement is to place a note that your software includes .useful. 
The Software License (based on Apache Software License, Version 1.1) Redistribution and use in source 
and binary forms, with or without modification, are permitted provided that the following conditions are 
met: Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other materials provided with 
the distribution. The end-user documentation included with the redistribution, if any, must include the 
following acknowledgment: "This product includes software developed by .useful community."  
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party 
acknowledgments normally appear. The names "dot-useful" and "Denis Krukovsky" must not be used to 
endorse or promote products derived from this software without prior written permission. For written 
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permission, please contact dkrukovsky at yahoo.com. Products derived from this software may not be 
called "useful", nor may "useful" appear in their name, without prior written permission of Denis 
Krukovsky.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
DOTUSEFUL COMMUNITY OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

Clearthought Tablelayout
The license is attached below.

The Clearthought Software License, Version 1.0

Copyright (c) 2001 Daniel Barbalace.  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. The original software may not be altered.  However, the classes provided may be subclasses as long 
as the subclasses are not packaged in the info.clearthought package or any subpackage of 
info.clearthought.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 
AUTHOR, AFFILATED BUSINESSES, OR ANYONE ELSE BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
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JSCH
License is attached below.

JSCH is Copyright (c) 2002,2003,2004,2005,2006 Atsuhiko Yamanaka, JCraft,Inc. 

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The names of the authors may not be used to endorse or promote products derived from this software 
without specific prior written permission.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
JCRAFT, INC. OR ANY CONTRIBUTORS TO THIS SOFTWARE BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

JAXP
The license is attached below. 

Sun Microsystems, Inc. 

Binary Code License Agreement

READ THE TERMS OF THIS AGREEMENT AND ANY PROVIDED SUPPLEMENTAL LICENSE 
TERMS (COLLECTIVELY "AGREEMENT") CAREFULLY BEFORE OPENING THE SOFTWARE 
MEDIA PACKAGE.  

BY OPENING THE SOFTWARE MEDIA PACKAGE, YOU AGREE TO THE TERMS OF THIS 
AGREEMENT. 

 IF YOU ARE ACCESSING THE SOFTWARE ELECTRONICALLY, INDICATE YOUR 
ACCEPTANCE OF THESE TERMS BY SELECTING THE "ACCEPT" BUTTON AT THE END OF 
THIS AGREEMENT.  IF YOU DO NOT AGREE TO ALL THESE TERMS, PROMPTLY RETURN 
THE UNUSED SOFTWARE TO YOUR PLACE OF PURCHASE FOR A REFUND OR, IF THE 
SOFTWARE IS ACCESSED ELECTRONICALLY, SELECT THE "DECLINE" BUTTON AT THE 
END OF THIS AGREEMENT. 

1. LICENSE TO USE.  Sun grants you a non-exclusive and non-transferable license for the internal 
use only of the accompanying software and documentation and any error corrections provided by 
Sun (collectively "Software"), by the number of users and the class of computer hardware for which 
the corresponding fee has been paid. 
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2. RESTRICTIONS.  Software is confidential and copyrighted. Title to Software and all associated 
intellectual property rights is retained by Sun and/or its licensors.  Except as specifically authorized 
in any Supplemental License Terms, you may not make copies of Software, other than a single copy 
of Software for archival purposes.  Unless enforcement is prohibited by applicable law, you may not 
modify, decompile, or reverse engineer Software.  You acknowledge that Software is not designed, 
licensed or intended for use in the design, construction, operation or maintenance of any nuclear 
facility.  Sun disclaims any express or implied warranty of fitness for such uses.  No right, title or 
interest in or to any trademark, service mark, logo or trade name of Sun or its licensors is granted 
under this Agreement. 

3. LIMITED WARRANTY.  Sun warrants to you that for a period of ninety (90) days from the date of 
purchase, as evidenced by a copy of the receipt, the media on which Software is furnished (if any) 
will be free of defects in materials and workmanship under normal use.  Except for the foregoing, 
Software is provided "AS IS".  Your exclusive remedy and Sun's entire liability under this limited 
warranty will be at Sun's option to replace Software media or refund the fee paid for Software. 

4. DISCLAIMER OF WARRANTY.  UNLESS SPECIFIED IN THIS AGREEMENT, ALL EXPRESS 
OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
OR NON-INFRINGEMENT ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT THESE 
DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. 

5. LIMITATION OF LIABILITY.  TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT 
WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, 
OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, 
HOWEVER CAUSED REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF OR 
RELATED TO THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SUN HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  In no event will Sun's liability to you, 
whether in contract, tort (including negligence), or otherwise, exceed the amount paid by you for 
Software under this Agreement.  The foregoing limitations will apply even if the above stated 
warranty fails of its essential purpose. 

6. Termination.  This Agreement is effective until terminated.  You may terminate this Agreement at 
any time by destroying all copies of Software.  This Agreement will terminate immediately without 
notice from Sun if you fail to comply with any provision of this Agreement.  Upon Termination, you 
must destroy all copies of Software. 

7. Export Regulations. All Software and technical data delivered under this Agreement are subject to 
US export control laws and may be subject to export or import regulations in other countries.  You 
agree to comply strictly with all such laws and regulations and acknowledge that you have the 
responsibility to obtain such licenses to export, re-export, or import as may be required after delivery 
to you. 

8. U.S. Government Restricted Rights.  If Software is being acquired by or on behalf of the U.S. 
Government or by a U.S. Government prime contractor or subcontractor (at any tier), then the 
Government's rights in Software and accompanying documentation will be only as set forth in this 
Agreement; this is in accordance with 48 CFR 227.7201 through 227.7202-4 (for Department of 
Defense (DOD) acquisitions) and with 48 CFR 2.101 and 12.212 (for non-DOD acquisitions). 

9. Governing Law.  Any action related to this Agreement will be governed by California law and 
controlling U.S. federal law.  No choice of law rules of any jurisdiction will apply. 
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10. Severability. If any provision of this Agreement is held to be unenforceable, this Agreement will 
remain in effect with the provision omitted, unless omission would frustrate the intent of the parties, 
in which case this Agreement will immediately terminate. 

11. Integration.  This Agreement is the entire agreement between you and Sun relating to its subject 
matter.  It supersedes all prior or contemporaneous oral or written communications, proposals, 
representations and warranties and prevails over any conflicting or additional terms of any quote, 
order, acknowledgment, or other communication between the parties relating to its subject matter 
during the term of this Agreement.  No modification of this Agreement will be binding, unless in 
writing and signed by an authorized representative of each party. 

JAVA(TM) INTERFACE CLASSES 

JAVA API FOR XML PROCESSING (JAXP), VERSION 1.1 

SUPPLEMENTAL LICENSE TERMS

These supplemental license terms ("Supplemental Terms") add to or modify the terms of the Binary Code 
License Agreement (collectively, the "Agreement"). Capitalized terms not defined in these Supplemental 
Terms shall have the same meanings ascribed to them in the Agreement. These Supplemental Terms shall 
supersede any inconsistent or conflicting terms in the Agreement, or in any license contained within the 
Software. 

1. Software Internal Use and Development License Grant. Subject to the terms and conditions of this 
Agreement, including, but not limited to Section 3 (Java(TM) Technology Restrictions) of these 
Supplemental Terms, Sun grants you a non-exclusive, non-transferable, limited license to reproduce 
internally and use internally the binary form of the Software, complete and unmodified, for the sole 
purpose of designing, developing and testing your Java applets and applications ("Programs"). 

2. License to Distribute Software.  In addition to the license granted in Section 1 (Software Internal 
Use and Development License Grant) of these Supplemental Terms, subject to the terms and 
conditions of this Agreement, including but not limited to Section 3 (Java Technology Restrictions), 
Sun grants you a non-exclusive, non-transferable, limited license to reproduce and distribute the 
Software in binary form, provided that you (i) distribute the Software complete and unmodified and 
only bundled as part of your Programs, (ii) do not distribute additional software intended to replace 
any component(s) of the Software, (iii) do not remove or alter any proprietary legends or notices 
contained in the Software, (iv) only distribute the Software subject to a license agreement that 
protects Sun's interests consistent with the terms contained in this Agreement, and (v) agree to 
defend and indemnify Sun and its licensors from and against any damages, costs, liabilities, 
settlement amounts and/or expenses (including attorneys' fees) incurred in connection with any 
claim, lawsuit or action by any third party that arises or results from the use or distribution of any 
and all Programs and/or Software. 

3. Java Technology Restrictions. You may not modify the Java Platform Interface ("JPI", identified as 
classes contained within the "java" package or any subpackages of the "java" package), by creating 
additional classes within the JPI or otherwise causing the addition to or modification of the classes 
in the JPI.  In the event that you create an additional class and associated API(s) which (i) extends 
the functionality of the Java platform, and (ii) is exposed to third party software developers for the 
purpose of developing additional software which invokes such additional API, you must promptly 
publish broadly an accurate specification for such API for free use by all developers. You may not 
create, or authorize your licensees to create additional classes, interfaces, or subpackages that are in 
any way identified as "java", "javax", "sun" or similar convention as specified by Sun in any naming 
convention designation.
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4. Trademarks and Logos. You acknowledge and agree as between you and Sun that Sun owns the 
SUN, SOLARIS, JAVA, JINI, FORTE, STAROFFICE, STARPORTAL and iPLANET trademarks 
and all SUN, SOLARIS, JAVA, JINI, FORTE, STAROFFICE, STARPORTAL and iPLANET-related 
trademarks, service marks, logos and other brand designations ("Sun Marks"), and you agree to 
comply with the Sun Trademark and Logo Usage Requirements currently located at 
http://www.sun.com/policies/trademarks. Any use you make of the Sun Marks inures to Sun's 
benefit. 

5. Source Code. Software may contain source code that is provided for reference purposes pursuant to 
the terms of this Agreement. Source code may not be redistributed unless expressly provided for in 
this Agreement. Portions of this download are governed by the Apache Source Code License and are 
identified in the Readme file. A copy of the Apache License is supplied with the Apache Source 
Code.

6. Termination for Infringement.  Either party may terminate this Agreement immediately should any 
Software become, or in either party's opinion be likely to become, the subject of a claim of 
infringement of any intellectual property right. 

For inquiries please contact: Sun Microsystems, Inc.  901 San Antonio Road, Palo Alto, California 
94303 

(Form last modified 11-03-2000.)

JAX-WS
The license is attached below under CDDL 1.0 .

Licenses for other utilities included in JAX-WS are described in in above Apache 2.0 license.

The source code is distributed on the MWTM DVD as /sgm-pdsources/src/ jaxws-2_0-src.jar.

COMMON DEVELOPMENT AND DISTRIBUTION LICENSE (CDDL) Version 1.0

1. Definitions.

1.1. "Contributor" means each individual or entity that creates or contributes to the creation of 
Modifications.

1.2. "Contributor Version" means the combination of the Original Software, prior Modifications 
used by a Contributor (if any), and the Modifications made by that particular Contributor.

1.3. "Covered Software" means (a) the Original Software, or (b) Modifications, or (c) the 
combination of files containing Original Software with files containing Modifications, in each case 
including portions thereof.

1.4. "Executable" means the Covered Software in any form other than Source Code. 

1.5. "Initial Developer" means the individual or entity that first makes Original Software available 
under this License. 

1.6. "Larger Work" means a work which combines Covered Software or portions thereof with code 
not governed by the terms of this License.

1.7. "License" means this document.

1.8. "Licensable" means having the right to grant, to the maximum extent possible, whether at the 
time of the initial grant or subsequently acquired, any and all of the rights conveyed herein.
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1.9. "Modifications" means the Source Code and Executable form of any of the following: 

A. Any file that results from an addition to, deletion from or modification of the contents of a 
file containing Original Software or previous Modifications; 

B. Any new file that contains any part of the Original Software or previous Modification; or 

C. Any new file that is contributed or otherwise made available under the terms of this License.

1.10. "Original Software" means the Source Code and Executable form of computer software code 
that is originally released under this License. 

1.11. "Patent Claims" means any patent claim(s), now owned or hereafter acquired, including 
without limitation, method, process, and apparatus claims, in any patent Licensable by grantor. 

1.12. "Source Code" means (a) the common form of computer software code in which modifications 
are made and (b) associated documentation included in or with such code.

1.13. "You" (or "Your") means an individual or a legal entity exercising rights under, and complying 
with all of the terms of, this License. For legal entities, "You" includes any entity which controls, is 
controlled by, or is under common control with You. For purposes of this definition, "control" means 
(a) the power, direct or indirect, to cause the direction or management of such entity, whether by 
contract or otherwise, or (b) ownership of more than fifty percent (50%) of the outstanding shares 
or beneficial ownership of such entity.

2. License Grants. 

2.1. The Initial Developer Grant. Conditioned upon Your compliance with Section 3.1 below and 
subject to third party intellectual property claims, the Initial Developer hereby grants You a 
world-wide, royalty-free, non-exclusive license: 

a) under intellectual property rights (other than patent or trademark) Licensable by Initial 
Developer, to use, reproduce, modify, display, perform, sublicense and distribute the Original 
Software (or portions thereof), with or without Modifications, and/or as part of a Larger Work; 
and 

b) under Patent Claims infringed by the making, using or selling of Original Software, to make, 
have made, use, practice, sell, and offer for sale, and/or otherwise dispose of the Original 
Software (or portions thereof). 

c) The licenses granted in Sections 2.1(a) and (b) are effective on the date Initial Developer first 
distributes or otherwise makes the Original Software available to a third party under the terms 
of this License. 

d) Notwithstanding Section 2.1(b) above, no patent license is granted: (1) for code that You 
delete from the Original Software, or (2) for infringements caused by: (i) the modification of 
the Original Software, or (ii) the combination of the Original Software with other software or 
devices. 

2.2. Contributor Grant. Conditioned upon Your compliance with Section 3.1 below and subject to 
third party intellectual property claims, each Contributor hereby grants You a world-wide, 
royalty-free, non-exclusive license:

a) under intellectual property rights (other than patent or trademark) Licensable by Contributor 
to use, reproduce, modify, display, perform, sublicense and distribute the Modifications created 
by such Contributor (or portions thereof), either on an unmodified basis, with other 
Modifications, as Covered Software and/or as part of a Larger Work; and
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b) under Patent Claims infringed by the making, using, or selling of Modifications made by that 
Contributor either alone and/or in combination with its Contributor Version (or portions of such 
combination), to make, use, sell, offer for sale, have made, and/or otherwise dispose of: (1) 
Modifications made by that Contributor (or portions thereof); and (2) the combination of 
Modifications made by that Contributor with its Contributor Version (or portions of such 
combination). 

c) The licenses granted in Sections 2.2(a) and 2.2(b) are effective on the date Contributor first 
distributes or otherwise makes the Modifications available to a third party. 

d) Notwithstanding Section 2.2(b) above, no patent license is granted: (1) for any code that 
Contributor has deleted from the Contributor Version; (2) for infringements caused by: (i) third 
party modifications of Contributor Version, or (ii) the combination of Modifications made by 
that Contributor with other software (except as part of the Contributor Version) or other devices; 
or (3) under Patent Claims infringed by Covered Software in the absence of Modifications made 
by that Contributor. 

3. Distribution Obligations.

3.1. Availability of Source Code. Any Covered Software that You distribute or otherwise make 
available in Executable form must also be made available in Source Code form and that Source Code 
form must be distributed only under the terms of this License. You must include a copy of this 
License with every copy of the Source Code form of the Covered Software You distribute or 
otherwise make available. You must inform recipients of any such Covered Software in Executable 
form as to how they can obtain such Covered Software in Source Code form in a reasonable manner 
on or through a medium customarily used for software exchange.

3.2. Modifications. The Modifications that You create or to which You contribute are governed by 
the terms of this License. You represent that You believe Your Modifications are Your original 
creation(s) and/or You have sufficient rights to grant the rights conveyed by this License.

3.3. Required Notices. You must include a notice in each of Your Modifications that identifies You 
as the Contributor of the Modification. You may not remove or alter any copyright, patent or 
trademark notices contained within the Covered Software, or any notices of licensing or any 
descriptive text giving attribution to any Contributor or the Initial Developer.

3.4. Application of Additional Terms. You may not offer or impose any terms on any Covered 
Software in Source Code form that alters or restricts the applicable version of this License or the 
recipients' rights hereunder. You may choose to offer, and to charge a fee for, warranty, support, 
indemnity or liability obligations to one or more recipients of Covered Software. However, you may 
do so only on Your own behalf, and not on behalf of the Initial Developer or any Contributor. You 
must make it absolutely clear that any such warranty, support, indemnity or liability obligation is 
offered by You alone, and You hereby agree to indemnify the Initial Developer and every Contributor 
for any liability incurred by the Initial Developer or such Contributor as a result of warranty, support, 
indemnity or liability terms You offer.

3.5. Distribution of Executable Versions. You may distribute the Executable form of the Covered 
Software under the terms of this License or under the terms of a license of Your choice, which may 
contain terms different from this License, provided that You are in compliance with the terms of this 
License and that the license for the Executable form does not attempt to limit or alter the recipient's 
rights in the Source Code form from the rights set forth in this License. If You distribute the Covered 
Software in Executable form under a different license, You must make it absolutely clear that any 
terms which differ from this License are offered by You alone, not by the Initial Developer or 
Contributor. You hereby agree to indemnify the Initial Developer and every Contributor for any 
liability incurred by the Initial Developer or such Contributor as a result of any such terms You offer.
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3.6. Larger Works. You may create a Larger Work by combining Covered Software with other code 
not governed by the terms of this License and distribute the Larger Work as a single product. In such 
a case, You must make sure the requirements of this License are fulfilled for the Covered Software. 

4. Versions of the License. 

4.1. New Versions. Sun Microsystems, Inc. is the initial license steward and may publish revised 
and/or new versions of this License from time to time. Each version will be given a distinguishing 
version number. Except as provided in Section 4.3, no one other than the license steward has the 
right to modify this License. 

4.2. Effect of New Versions. You may always continue to use, distribute or otherwise make the 
Covered Software available under the terms of the version of the License under which You originally 
received the Covered Software. If the Initial Developer includes a notice in the Original Software 
prohibiting it from being distributed or otherwise made available under any subsequent version of 
the License, You must distribute and make the Covered Software available under the terms of the 
version of the License under which You originally received the Covered Software. Otherwise, You 
may also choose to use, distribute or otherwise make the Covered Software available under the terms 
of any subsequent version of the License published by the license steward. 

4.3. Modified Versions. When You are an Initial Developer and You want to create a new license for 
Your Original Software, You may create and use a modified version of this License if You: (a) 
rename the license and remove any references to the name of the license steward (except to note that 
the license differs from this License); and (b) otherwise make it clear that the license contains terms 
which differ from this License.

5. DISCLAIMER OF WARRANTY.

COVERED SOFTWARE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, WARRANTIES THAT THE COVERED SOFTWARE IS FREE OF 
DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE COVERED 
SOFTWARE IS WITH YOU. SHOULD ANY COVERED SOFTWARE PROVE DEFECTIVE IN 
ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) 
ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS 
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. 
NO USE OF ANY COVERED SOFTWARE IS AUTHORIZED HEREUNDER EXCEPT UNDER 
THIS DISCLAIMER. 

6. TERMINATION. 

6.1. This License and the rights granted hereunder will terminate automatically if You fail to comply 
with terms herein and fail to cure such breach within 30 days of becoming aware of the breach. 
Provisions which, by their nature, must remain in effect beyond the termination of this License shall 
survive.

6.2. If You assert a patent infringement claim (excluding declaratory judgment actions) against 
Initial Developer or a Contributor (the Initial Developer or Contributor against whom You assert 
such claim is referred to as "Participant") alleging that t e Participant Software (meaning the 
Contributor Version where the Participant is a Contributor or the Original Software where the 
Participant is the Initial Developer) directly or indirectly infringes any patent, then any and all rights 
granted directly or indirectly to You by such Participant, the Initial Developer (if the Initial 
Developer is not the Participant) and all Contributors under Sections 2.1 and/or 2.2 of this License 
shall, upon 60 days notice from Participant terminate prospectively and automatically at the 
expiration of such 60 day notice period, unless if within such 60 day period You withdraw Your 
claim with respect to the Participant Software against such Participant either unilaterally or pursuant 
to a written agreement with Participant.
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6.3. In the event of termination under Sections 6.1 or 6.2 above, all end user licenses that have been 
validly granted by You or any distributor hereunder prior to termination (excluding licenses granted 
to You by any distributor) shall survive termination.

7. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT 
(INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL YOU, THE INITIAL 
DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED 
SOFTWARE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON 
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY 
CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOST PROFITS, LOSS 
OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY 
AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF SUCH PARTY SHALL 
HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF 
LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY 
RESULTING FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW 
PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS 
EXCLUSION AND LIMITATION MAY NOT APPLY TO YOU.

8. U.S. GOVERNMENT END USERS. The Covered Software is a "commercial item," as that term is 
defined in 48 C.F.R. 2.101 (Oct. 1995), consisting of "commercial computer software" (as that term 
is defined at 48 C.F.R. ¤ 252.227-7014(a)(1)) and "commercial computer software documentation" 
as such terms are used in 48 C.F.R. 12.212 (Sept.1995). Consistent with 48 C.F.R. 12.212 and 48 
C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire 
Covered Software with only those rights set forth herein. This U.S. Government Rights clause is in 
lieu of, and supersedes, any other FAR, DFAR, or other clause or provision that addresses 
Government rights in computer software under this License.

9. MISCELLANEOUS.

This License represents the complete agreement concerning subject matter hereof. If any provision 
of this License is held to be unenforceable, such provision shall be reformed only to the extent 
necessary to make it enforceable. This License shall be governed by the law of the jurisdiction 
specified in a notice contained within the Original Software (except to the extent applicable law, if 
any, provides otherwise), excluding such jurisdiction's conflict-of-law provisions. Any litigation 
relating to this License shall be subject to the jurisdiction of the courts located in the jurisdiction 
and venue specified in a notice contained within the Original Software, with the losing party 
responsible for costs, including, without limitation, court costs and reasonable attorneys' fees and 
expenses. The application of the United Nations Convention on Contracts for the International Sale 
of Goods is expressly excluded. Any law or regulation which provides that the language of a contract 
shall be construed against the drafter shall not apply to this License. You agree that You alone are 
responsible for compliance with the United States export administration regulations (and the export 
control laws and regulation of any other countries) when You use, distribute or otherwise make 
available any Covered Software.

10. RESPONSIBILITY FOR CLAIMS.

As between Initial Developer and the Contributors, each party is responsible for claims and damages 
arising, directly or indirectly, out of its utilization of rights under this License and You agree to work 
with Initial Developer and Contributors to distribute such responsibility on an equitable basis. 
Nothing herein is intended or shall be deemed to constitute any admission of liability.
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mod_ssl
Copyright (c) 1998-2004 Ralf S. Engelschall. All rights reserved.  This product includes software 
developed by Ralf S. Engelschall <rse@engelschall.com> for use in the mod_ssl project 
(http://www.modssl.org/).  The license is attached below.

_ __ ___   ___   __| |    ___ ___| |  mod_ssl

  | '_ ` _ \ / _ \ / _` |   / __/ __| |  Apache Interface to OpenSSL

  | | | | | | (_) | (_| |   \__ \__ \ |  www.modssl.org

  |_| |_| |_|\___/ \__,_|___|___/___/_|  ftp.modssl.org

                       |_____|         

“Ian Fleming was a UNIX fan!

How do I know?  Well, James Bond

had the (license to kill) number 007,

i.e. he could execute anyone.'”

-- Unknown 

  LICENSE

The mod_ssl package falls under the Open-Source Software label because it's distributed under a 
BSD-style license. The detailed license information follows.

Copyright (c) 1998-2004 Ralf S. Engelschall. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgment:

"This product includes software developed by Ralf S. Engelschall <rse@engelschall.com> for use 
in the mod_ssl project (http://www.modssl.org/)."

4. The names "mod_ssl" must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact rse@engelschall.com.

5. Products derived from this software may not be called "mod_ssl" nor may "mod_ssl" appear in their 
names without prior written permission of Ralf S. Engelschall.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by Ralf S. Engelschall <rse@engelschall.com> for use 
in the mod_ssl project (http://www.modssl.org/)." 

THIS SOFTWARE IS PROVIDED BY RALF S. ENGELSCHALL ``AS IS'' AND ANY EXPRESSED 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL RALF S. ENGELSCHALL OR HIS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
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CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Netbeans IDE 4.1, CVS Client Library
The license is attached below.

SUN PUBLIC LICENSE Version 1.0

1. Definitions.

1.0.1. "Commercial Use" means distribution or otherwise making the Covered Code available to a 
third party.

1.1. "Contributor" means each entity that creates or contributes to the creation of Modifications.

1.2. "Contributor Version" means the combination of the Original Code, prior Modifications used 
by a Contributor, and the Modifications made by that particular Contributor.

1.3. "Covered Code" means the Original Code or Modifications or the combination of the Original 
Code and Modifications, in each case including portions thereof and corresponding documentation 
released with the source code.

1.4. "Electronic Distribution Mechanism" means a mechanism generally accepted in the software 
development community for the electronic transfer of data.

1.5. "Executable" means Covered Code in any form other than Source Code.

1.6. "Initial Developer" means the individual or entity identified as the Initial Developer in the 
Source Code notice required by Exhibit A.

1.7. "Larger Work" means a work which combines Covered Code or portions thereof with code not 
governed by the terms of this License.

1.8. "License" means this document.

1.8.1. "Licensable" means having the right to grant, to the maximum extent possible, whether at the 
time of the initial grant or subsequently acquired, any and all of the rights conveyed herein.

1.9. "Modifications" means any addition to or deletion from the substance or structure of either the 
Original Code or any previous Modifications. When Covered Code is released as a series of files, a 
Modification is:

A. Any addition to or deletion from the contents of a file containing Original Code or previous 
Modifications.

B. Any new file that contains any part of the Original Code or previous Modifications.

1.10. "Original Code" means Source Code of computer software code which is described in the 
Source Code notice required by Exhibit A as Original Code, and which, at the time of its release 
under this License is not already Covered Code governed by this License.

1.10.1. "Patent Claims" means any patent claim(s), now owned or hereafter acquired, including 
without limitation, method, process, and apparatus claims, in any patent Licensable by grantor.

1.11. "Source Code" means the preferred form of the Covered Code for making modifications to it, 
including all modules it contains, plus any associated documentation, interface definition files, 
scripts used to control compilation and installation of an Executable, or source code differential 
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comparisons against either the Original Code or another well known, available Covered Code of the 
Contributor's choice. The Source Code can be in a compressed or archival form, provided the 
appropriate decompression or de-archiving software is widely available for no charge.

1.12. "You" (or "Your") means an individual or a legal entity exercising rights under, and complying 
with all of the terms of, this License or a future version of this License issued under Section 6.1. For 
legal entities, "You" includes any entity which controls, is controlled by, or is under common control 
with You. For purposes of this definition, "control" means (a) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (b) ownership of 
more than fifty percent (50%) of the outstanding shares or beneficial ownership of such entity.

2. Source Code License.

2.1 The Initial Developer Grant. The Initial Developer hereby grants You a world-wide, royalty-free, 
non-exclusive license, subject to third party intellectual property claims:

a) under intellectual property rights (other than patent or trademark) Licensable by Initial 
Developer to use, reproduce, modify, display, perform, sublicense and distribute the Original 
Code (or portions thereof) with or without Modifications, and/or as part of a Larger Work; and

b) under Patent Claims infringed by the making, using or selling of Original Code, to make, 
have made, use, practice, sell, and offer for sale, and/or otherwise dispose of the Original Code 
(or portions thereof).

c) the licenses granted in this Section 2.1(a) and (b) are effective on the date Initial Developer 
first distributes Original Code under the terms of this License.

d) Notwithstanding Section 2.1(b) above, no patent license is granted: 1) for code that You 
delete from the Original Code; 2) separate from the Original Code; or 3) for infringements 
caused by: i) the modification of the Original Code or ii) the combination of the Original Code 
with other software or devices.

2.2. Contributor Grant. Subject to third party intellectual property claims, each Contributor hereby 
grants You a world-wide, royalty-free, non-exclusive license 

a) under intellectual property rights (other than patent or trademark) Licensable by Contributor, 
to use, reproduce,  modify, display, perform, sublicense and distribute the Modifications created 
by such Contributor (or portions thereof) either on an unmodified basis, with other 
Modifications, as Covered Code and/or as part of a Larger Work; and

b) under Patent Claims infringed by the making, using, or selling of Modifications made by that 
Contributor either alone and/or in combination with its Contributor Version (or portions of such 
combination), to make, use, sell, offer for sale, have made, and/or otherwise dispose of: 1) 
Modifications made by that Contributor (or portions thereof); and 2) the combination of 
Modifications made by that Contributor with its Contributor Version (or portions of such 
combination).

c) the licenses granted in Sections 2.2(a) and 2.2(b) are effective on the date Contributor first 
makes Commercial Use of the Covered Code.

d)  notwithstanding Section 2.2(b) above, no patent license is granted: 1) for any code that 
Contributor has deleted from the Contributor Version; 2)  separate from the Contributor Version; 
3) for infringements caused by: i) third party modifications of Contributor Version or ii) the 
combination of Modifications made by that Contributor with other software (except as part of 
the Contributor Version) or other devices; or 4) under Patent Claims infringed by Covered Code 
in the absence of Modifications made by that Contributor.
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3. Distribution Obligations.

3.1. Application of License. The Modifications which You create or to which You contribute are 
governed by the terms of this License, including without limitation Section 2.2. The Source Code 
version of Covered Code may be distributed only under the terms of this License or a future version 
of this License released under Section 6.1, and You must include a copy of this License with every 
copy of the Source Code You distribute. You may not offer or impose any terms on any Source Code 
version that alters or restricts the applicable version of this License or the recipients' rights 
hereunder. However, You may include an additional document offering the additional rights 
described in Section 3.5.

3.2. Availability of Source Code. Any Modification which You create or to which You contribute 
must be made available in Source Code form under the terms of this License either on the same 
media as an Executable version or via an accepted Electronic Distribution Mechanism to anyone to 
whom you made an Executable version available; and if made available via Electronic Distribution 
Mechanism, must remain available for at least twelve (12) months after the date it initially became 
available, or at least six (6) months after a subsequent version of that particular Modification has 
been made available to such recipients. You are responsible for ensuring that the Source Code 
version remains available even if the Electronic Distribution Mechanism is maintained by a third 
party.

3.3. Description of Modifications. You must cause all Covered Code to which You contribute to 
contain a file documenting the changes You made to create that Covered Code and the date of any 
change. You must include a prominent statement that the Modification is derived, directly or 
indirectly, from Original Code provided by the Initial Developer and including the name of the 
Initial Developer in (a) the Source Code, and (b) in any notice in an Executable version or related 
documentation in which You describe the origin or ownership of the Covered Code.

3.4. Intellectual Property Matters.

a) Third Party Claims. If Contributor has knowledge that a license under a third party's 
intellectual property rights is required to exercise the rights granted by such Contributor under 
Sections 2.1 or 2.2, Contributor must include a text file with the Source Code distribution titled 
"LEGAL'' which describes the claim and the party making the claim in sufficient detail that a 
recipient will know whom to contact. If Contributor obtains such knowledge after the 
Modification is made available as described in Section 3.2, Contributor shall promptly modify 
the LEGAL file in all copies Contributor makes available thereafter and shall take other steps 
(such as notifying appropriate mailing lists or newsgroups) reasonably calculated to inform 
those who received the Covered Code that new knowledge has been obtained.

b) Contributor APIs. If Contributor's Modifications include an application programming 
interface ("API") and Contributor has knowledge of patent licenses which are reasonably 
necessary to implement that API, Contributor must also include this information in the LEGAL 
file.

c) Representations. Contributor represents that, except as disclosed pursuant to Section 3.4(a) 
above, Contributor believes that Contributor's Modifications are Contributor's original 
creation(s) and/or Contributor has sufficient rights to grant the rights conveyed by this License.

3.5. Required Notices. You must duplicate the notice in Exhibit A in each file of the Source Code. 
If it is not possible to put such notice in a particular Source Code file due to its structure, then You 
must include such notice in a location (such as a relevant directory) where a user would be likely to 
look for such a notice.  If You created one or more Modification(s) You may add your name as a 
Contributor to the notice described in Exhibit A. You must also duplicate this License in any 
documentation for the Source Code where You describe recipients' rights or ownership rights 
relating to Covered Code. You may choose to offer, and to charge a fee for, warranty, support, 
indemnity or liability obligations to one or more recipients of Covered Code. However, You may do 
so only on Your own behalf, and not on behalf of the Initial Developer or any Contributor. You must 



 

K-34
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Appendix K      Open Source License Notices for the Cisco Mobile Wireless Transport Manager
  Notices

make it absolutely clear than any such warranty, support, indemnity or liability obligation is offered 
by You alone, and You hereby agree to indemnify the Initial Developer and every Contributor for 
any liability incurred by the Initial Developer or such Contributor as a result of warranty, support, 
indemnity or liability terms You offer.

3.6. Distribution of Executable Versions. You may distribute Covered Code in Executable form only 
if the requirements of Section 3.1-3.5 have been met for that Covered Code, and if You include a 
notice stating that the Source Code version of the Covered Code is available under the terms of this 
License, including a description of how and where You have fulfilled the obligations of Section 3.2. 
The notice must be conspicuously included in any notice in an Executable version, related 
documentation or collateral in which You describe recipients' rights relating to the Covered Code. 
You may distribute the Executable version of Covered Code or ownership rights under a license of 
Your choice, which may contain terms different from this License, provided that You are in 
compliance with the terms of this License and that the license for the Executable version does not 
attempt to limit or alter the recipient's rights in the Source Code version from the rights set forth in 
this License. If You distribute the Executable version under a different license You must make it 
absolutely clear that any terms which differ from this License are offered by You alone, not by the 
Initial Developer or any Contributor. You hereby agree to indemnify the Initial Developer and every 
Contributor for any liability incurred by the Initial Developer or such Contributor as a result of any 
such terms You offer.

3.7. Larger Works. You may create a Larger Work by combining Covered Code with other code not 
governed by the terms of this License and distribute the Larger Work as a single product. In such a 
case, You must make sure the requirements of this License are fulfilled for the Covered Code.

4. Inability to Comply Due to Statute or Regulation. If it is impossible for You to comply with any of 
the terms of this License with respect to some or all of the Covered Code due to statute, judicial 
order, or regulation then You must: (a) comply with the terms of this License to the maximum extent 
possible; and (b) describe the limitations and the code they affect. Such description must be included 
in the LEGAL file described in Section 3.4 and must be included with all distributions of the Source 
Code. Except to the extent prohibited by statute or regulation, such description must be sufficiently 
detailed for a recipient of ordinary skill to be able to understand it.

5. Application of this License. This License applies to code to which the Initial Developer has attached 
the notice in Exhibit A and to related Covered Code. 

6. Versions of the License.

6.1. New Versions. Sun Microsystems, Inc. ("Sun") may publish revised and/or new versions of the 
License from time to time. Each version will be given a distinguishing version number.

6.2. Effect of New Versions. Once Covered Code has been published under a particular version of 
the License, You may always continue to use it under the terms of that version. You may also choose 
to use such Covered Code under the terms of any subsequent version of the License published by 
Sun. No one other than Sun has the right to modify the terms applicable to Covered Code created 
under this License.

6.3. Derivative Works. If You create or use a modified version of this License (which you may only 
do in order to apply it to code which is not already Covered Code governed by this License), You 
must: (a) rename Your license so that the phrases "Sun," "Sun Public License," or "SPL" or any 
confusingly similar phrase do not appear in your license (except to note that your license differs 
from this License) and (b) otherwise make it clear that Your version of the license contains terms 
which differ from the Sun Public License. (Filling in the name of the Initial Developer, Original 
Code or Contributor in the notice described in Exhibit A shall not of themselves be deemed to be 
modifications of this License.)
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7. DISCLAIMER OF WARRANTY. COVERED CODE IS PROVIDED UNDER THIS LICENSE ON 
AN "AS IS'' BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED 
CODE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR 
NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF 
THE COVERED CODE IS WITH YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE 
IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) 
ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS 
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. 
NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS 
DISCLAIMER.

8. TERMINATION.

8.1. This License and the rights granted hereunder will terminate automatically if You fail to comply 
with terms herein and fail to cure such breach within 30 days of becoming aware of the breach. All 
sublicenses to the Covered Code which are properly granted shall survive any termination of this 
License. Provisions which, by their nature, must remain in effect beyond the termination of this 
License shall survive.

8.2. If You initiate litigation by asserting a patent infringement claim (excluding declaratory 
judgment actions) against Initial Developer or a Contributor (the Initial Developer or Contributor 
against whom You file such action is referred to as "Participant")  alleging that:

a) such Participant's Contributor Version directly or indirectly infringes any patent, then any and 
all rights granted by such Participant to You under Sections 2.1 and/or 2.2 of this License shall, 
upon 60 days notice from Participant terminate prospectively, unless if within 60 days after 
receipt of notice You either: (i) agree in writing to pay Participant a mutually agreeable 
reasonable royalty for Your past and future use of Modifications made by such Participant, or 
(ii) withdraw Your litigation claim with respect to the Contributor Version against such 
Participant.  If within 60 days of notice, a reasonable royalty and payment arrangement are not 
mutually agreed upon in writing by the parties or the litigation claim is not withdrawn, the rights 
granted by Participant to You under Sections 2.1 and/or 2.2 automatically terminate at the 
expiration of the 60 day notice period specified above.

b) any software, hardware, or device, other than such Participant's Contributor Version, directly 
or indirectly infringes any patent, then any rights granted to You by such Participant under 
Sections 2.1(b) and 2.2(b) are revoked effective as of the date You first made, used, sold, 
distributed, or had made, Modifications made by that Participant.

8.3. If You assert a patent infringement claim against Participant alleging that such Participant's 
Contributor Version directly or indirectly infringes any patent where such claim is resolved 
(such as by license or settlement) prior to the initiation of patent infringement litigation, then 
the reasonable value of the licenses granted by such Participant under Sections 2.1 or 2.2 shall 
be taken into account in determining the amount or value of any payment or license.

8.4. In the event of termination under Sections 8.1 or 8.2 above,  all end user license agreements 
(excluding distributors and resellers) which have been validly granted by You or any distributor 
hereunder prior to termination shall survive termination.

9. LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL 
THEORY, WHETHER TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, 
SHALL YOU, THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY 
DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE 
LIABLE TO ANY PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER 
FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR 
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LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF 
SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY 
FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH PARTY'S NEGLIGENCE TO 
THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THIS EXCLUSION AND LIMITATION MAY NOT APPLY 
TO YOU.

10. U.S. GOVERNMENT END USERS. The Covered Code is a "commercial item," as that term is 
defined in 48 C.F.R. 2.101 (Oct. 1995), consisting of "commercial computer software" and 
"commercial computer software documentation," as such terms are used in 48 C.F.R. 12.212 (Sept. 
1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), 
all U.S. Government End Users acquire Covered Code with only those rights set forth herein.

11. MISCELLANEOUS. This License represents the complete agreement concerning subject matter 
hereof. If any provision of this License is held to be unenforceable, such provision shall be reformed 
only to the extent necessary to make it enforceable. This License shall be governed by California 
law provisions (except to the extent applicable law, if any, provides otherwise), excluding its 
conflict-of-law provisions. With respect to disputes in which at least one party is a citizen of, or an 
entity chartered or registered to do business in the United States of America, any litigation relating 
to this License shall be subject to the jurisdiction of the Federal Courts of the Northern District of 
California, with venue lying in Santa Clara County, California, with the losing party responsible for 
costs, including without limitation, court costs and reasonable attorneys' fees and expenses. The 
application of the United Nations Convention on Contracts for the International Sale of Goods is 
expressly excluded. Any law or regulation which provides that the language of a contract shall be 
construed against the drafter shall not apply to this License.

12. RESPONSIBILITY FOR CLAIMS. As between Initial Developer and the Contributors, each party 
is responsible for claims and damages arising, directly or indirectly, out of its utilization of rights 
under this License and You agree to work with Initial Developer and Contributors to distribute such 
responsibility on an equitable basis. Nothing herein is intended or shall be deemed to constitute any 
admission of liability.

13. MULTIPLE-LICENSED CODE. Initial Developer may designate portions of the Covered Code as 
"Multiple-Licensed". "Multiple-Licensed" means that the Initial Developer permits you to utilize 
portions of the Covered Code under Your choice of the alternative licenses, if any, specified by the 
Initial Developer in the file described in Exhibit A.

Exhibit A -Sun Public License Notice.

The contents of this file are subject to the Sun Public LicenseVersion 1.0 (the "License"); you 
may not use this file except compliance with the License. A copy of the License is available 
http://www.sun.com/

The Original Code is _________________. The Initial Developer of the Original Code is 
___________. Portions created by ______ are Copyright (C)_________. All Rights Reserved.

Contributor(s): ______________________________________.

Alternatively, the contents of this file may be used under the terms of the _____ license (the  
"[___] License"), in which case the provisions of [______] License are applicable  instead of 
those above. If you wish to allow use of your version of this file only under the terms of the 
[____] License and not to allow others to use your version of this file under the SPL, indicate 
your decision by deleting the provisions above and replace  them with the notice and other 
provisions required by the [___] License. If you do not delete the provisions above, a recipient 
may use your version of this file under either the SPL or the [___] License."
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[NOTE: The text of this Exhibit A may differ slightly from the text of the notices in the Source 
Code files of the Original Code. You should use the text of this Exhibit A rather than the text 
found in the Original Code Source Code for Your Modifications.]

TCL
The license is described attached below.

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., 
Scriptics Corporation, ActiveState Corporation and other parties.  The following terms apply to all files 
associated with the software unless explicitly disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its 
documentation for any purpose, provided that existing copyright notices are retained in all copies and 
that this notice is included verbatim in any distributions. No written agreement, license, or royalty fee is 
required for any of the authorized uses. Modifications to this software may be copyrighted by their 
authors and need not follow the licensing terms described here, provided that the new terms are clearly 
indicated on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT 
OF THE USE OF THIS SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES THEREOF, 
EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT.  THIS SOFTWARE IS 
PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND DISTRIBUTORS HAVE NO 
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR 
MODIFICATIONS.

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. government, the 
Government shall have only "Restricted Rights" in the software and related documentation as defined in 
the Federal Acquisition Regulations (FARs) in Clause 52.227.19 (c) (2).  If you are acquiring the 
software on behalf of the Department of Defense, the software shall be classified as "Commercial 
Computer Software" and the Government shall have only "Restricted Rights" as defined in Clause 
252.227-7013 (c) (1) of DFARs.  Notwithstanding the foregoing, the authors grant the U.S. Government 
and others acting in its behalf permission to use and distribute the software in accordance with the terms 
specified in this license. 
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Zip
Copyright (c) 1990-2003 Info-ZIP.  All rights reserved.  The license is attached below.  Distributed in 
binary form as 'sgmzip' in the MWTM 'bin' directory.  The original zip binary has not been altered other 
than through the change of the executable file name.

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., 
Scriptics Corporation, ActiveState Corporation and other parties.  The following terms apply to all files 
associated with the software unless explicitly disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its 
documentation for any purpose, provided that existing copyright notices are retained in all copies and 
that this notice is included verbatim in any distributions. No written agreement, license, or royalty fee is 
required for any of the authorized uses. Modifications to this software may be copyrighted by their 
authors and need not follow the licensing terms described here, provided that the new terms are clearly 
indicated on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT 
OF THE USE OF THIS SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES THEREOF, 
EVEN IF THE AUTHORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT.  THIS SOFTWARE IS 
PROVIDED ON AN "AS IS" BASIS, AND THE AUTHORS AND DISTRIBUTORS HAVE NO 
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR 
MODIFICATIONS.

GOVERNMENT USE: If you are acquiring this software on behalf of the U.S. government, the 
Government shall have only "Restricted Rights" in the software and related documentation as defined in 
the Federal Acquisition Regulations (FARs) in Clause 52.227.19 (c) (2).  If you are acquiring the 
software on behalf of the Department of Defense, the software shall be classified as "Commercial 
Computer Software" and the Government shall have only "Restricted Rights" as defined in Clause 
252.227-7013 (c) (1) of DFARs.  Notwithstanding the foregoing, the authors grant the U.S. Government 
and others acting in its behalf permission to use and distribute the software in accordance with the terms 
specified in this license. 

Expect
Written by Don Libes don.libes@nist.gov.  No license required pursuant to 17 USC 105.
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This glossary contains Cisco Mobile Wireless Transport Manager (MWTM) specific terms. For an online listing of other 
internetworking terms and acronyms, refer to this URL:

• http://www.cisco.com/univercd/cc/td/doc/cisintwk/ita/index.htm

A

access list A list kept by routers to control access to or from the router for a number of services (for example, to 
prevent packets with a certain IP address from leaving a particular interface on the router).

accounting Collection of SS7 accounting statistics.

active alarm Network object with this status:

• An application server process, application server process association, link, or signaling 
gateway-mated pair that is Warning (yellow) or worse and is not Ignored.

• A node, application server, linkset, node, or signaling point that is Pending (red) or worse and is 
not Ignored.

adjacent node In the MWTM, for a given pair of connected nodes, the node that the MWTM discovered second. See 
primary node.

adjacent point code Point code of the adjacent ITP signaling point for the linkset. Contrast with local point code.

aggregation site A Base Station Controller (BSC) or Radio Network Controller (RNC) site where traffic is collected for 
multiple cell sites. See cell site.

alias point code See capability point code.

ANSI American National Standards Institute.

API Application Programming Interface. A source code interface that a computer system or program library 
provides to support requests for services by a computer program.

application server Logical entity serving a specific routing key. The application server implements a set of one or more 
unique application server processes, of which one or more is normally actively processing traffic. See 
application server process, application server process association, routing key, signaling 
gateway-mated pair.

application server 

process

IP-based instance of an application server, such as Call Agents, HLRs, SMSCs, and so on. An 
application server process can implement more than one application server. See application server, 
application server process association, routing key, signaling gateway-mated pair.

application server 

process association

ITP’s virtual view of an application server process. The application server process association is 
defined on, and resides on, the ITP. See application server, application server process, routing key, 
signaling gateway-mated pair.

http://www.cisco.com/en/US/learning/index.html
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arrowhead In topology maps, indicator for an application server process association connection. See topology 
map.

auto save Setting that enables the MWTM to save changes automatically when you exit the MWTM.

auto start Setting that enables the MWTM to start a process automatically when the Process Manager is started. 
See Data Server, Message Log Server, Process Manager, Trap Receiver.

B

base station 

controller

See BSC.

base transceiver 

station

See BTS.

browser GUI-based hypertext client application, such as Internet Explorer or Mozilla, used to access hypertext 
documents and other services located on innumerable remote servers throughout the World Wide Web 
(WWW) and Internet.

BSC Base Station Controller. Equipment that manages radio resources in a GSM network.

BTS Base Transceiver Station. The equipment in a GSM network that is used to transmit radio frequencies 
over the air waves.

C

capability point 

code

Point code shared by more than one signaling point, each of which is also assigned a “real” point code. 
Also called alias point code.

cell site A Base Transceiver Station (BTS) or Node B site, usually located at the remote site with limited 
connectivity. See aggregation site.

circle In topology maps, indicator for a link that is part of a virtual linkset, associated with the closest node. 
See topology.

circle layout Topology map layout in which objects are arranged in a circle, connected by links. Contrast with spring 
layout. See topology map.

Cisco IOS software Cisco Internetwork Operating System software. Cisco system software that provides common 
functionality, scalability, and security for many Cisco products. The Cisco IOS software allows 
centralized, integrated, and automated installation and management of internetworks, while ensuring 
support for a wide variety of protocols, media, services, and platforms.

CLI Command line interface. An interface that allows the user to interact with the Cisco IOS software 
operating system by entering commands and optional arguments.

client Node or software program that requests services from a server. The MWTM user interface is an 
example of a client. See also server.

client view User-customized subset of the DEFAULT view. See also DEFAULT view, view, subview.
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CLLI code COMMON LANGUAGE Location Identification Code for a node. A CLLI code is a standardized 
11-character identifier that uniquely identifies the geographic location of the node.

command line 

interface

See CLI.

community name See community string.

community string Text string that acts as a password and is used to authenticate messages sent between a management 
station and a node containing an SNMP agent. The community string is sent in every packet between 
the manager and the agent. Also called community name, read community.

congestion Condition in which a link has too many packets waiting to be sent. This condition could be caused by 
the failure of an element in the network. Possible levels are None, Low, High, and Very High, which 
correspond roughly to equivalent ANSI, China standard, ITU, NTT, and TTC congestion levels.

console log Log containing unexpected error and warning messages from the MWTM server, such as those that 
might occur if the MWTM server cannot start.

cost Measure of the suitability of a route to a destination, relative to other routes. Costs range from 1 (lowest 
cost and highest priority) through 9 (highest cost and lowest priority).

credentials Login credentials that are stored in an encrypted file on the server, eliminating the need for users to 
login before running commands. The MWTM enables a system administrator to configure the login 
credentials using the Node SNMP and Credentials Editor dialog box. 

cross-instance GTT 

file

Global Title Translation file that supports the Multiple Instance and Instance Translation ITP features. 
Cross-instance GTT files contain application groups that reference point codes in other GTT files. See 
Instance Translation, Multiple Instance.

CSV Comma-separated values. A widely-used file format for storing tabular data. 

current view View that is currently in use on an MWTM client. The view can be the DEFAULT view or a customized 
view. Also called current view. See client view, DEFAULT view.

D

Data Server Multi-threaded process that handles most of the work done by the MWTM, including discovery, 
polling, and scheduling. See also Message Log Server, Process Manager, Trap Receiver.

DEFAULT view View into which the MWTM places all discovered objects when discovering the network. The 
DEFAULT view is stored on the MWTM server and shared by all MWTM clients, but it cannot be 
modified by the clients. See current view, view.

demand polling User-initiated poll of selected nodes. Contrast with status polling.

destination linkset In ITP route tables, linkset associated with the destination point code. Also called the output linkset. 
See linkset, destination point code, route table.

destination point 

code

In ITP route tables, point code of the adjacent signaling point, the destination for packets on the 
selected signaling point. See destination linkset, point code, route table.

device See node.
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device type In MWTM, the type of a discovered device, either a Cisco device or a BTS, BSC, or legacy SS7 device. 
Also called system object ID. See legacy device.

diamond In topology maps, indicator for a connection that is part of a configured interface, associated with the 
closest node. See topology.

discovered Object that has been discovered by the MWTM. Also called known. Contrast with unknown.

Discovery Process by which the MWTM discovers objects in your network. See also nonrecursive Discovery, 
recursive Discovery.

display name User-specified name for a node. Contrast with DNS name. See also node name.

domain name The style of identifier—a sequence of case-insensitive ASCII labels separated by dots 
(“bbn.com.”)—defined for subtrees in the Internet Domain Name System [R1034] and used in other 
Internet identifiers, such as host names, mailbox names, and URLs.

Domain Name 

System

 See DNS.

double triangle In topology maps, indicator for a connection that has multiple interfaces, such as two linksets between 
the same two signaling points. See topology map.

DNS Domain Name System. System used on the Internet for translating names of network nodes into 
addresses.

DNS name Initial name of a node, as discovered by the MWTM. Contrast with display name. See also node name.

DPC See destination point code.

E

Erlang (E) The international (dimensionless) unit of the average traffic intensity (occupancy) of a facility during 
a period of time, normally, a busy hour. The number of Erlangs is the ratio of the time during which a 
facility is occupied (continuously or cumulatively) to the time this facility is available for occupancy. 
Another definition is the ratio of the average call arrival rate into the system, to the average call 
duration. One Erlang is equivalent to 36 ccs (completed call seconds), which is another traffic intensity 
unit.

events The MWTM can detect events that are triggered by SNMP traps or notifications, status changes (status 
alarms), and user actions. See trap, active alarm. 

event forwarding See trap forwarding.

exclude Removing a network object from a view, while retaining the object in the MWTM database.
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F

Field Replaceable 

Units

See FRU.

FRU Assemblies such as power supplies, fans, processor modules, interface modules, and so forth.

G

GSM ITU standard for defining the Global System for Mobile communications, a digital cellular telephone 
standard.

Global System for 

Mobile 

communications

See GSM.

graphical element Graphical representation of an object or view in the topology map. See topology map.

graphical user 

interface

See GUI.

GTT Global Title Translation. The process by which the SCCP translates a global title into the point code 
and subsystem number of the destination service switching point where the higher-layer protocol 
processing occurs.

GUI Graphical user interface. User environment that uses pictorial as well as textual representations of the 
input and output of applications and the hierarchical or other data structure in which information is 
stored. Conventions such as buttons, icons, and windows are typical, and many actions are performed 
using a pointing device (such as a mouse). Microsoft Windows and the Apple Macintosh are prominent 
examples of platforms utilizing a GUI.

H

host Computer system on a network. Similar to the term node except that host usually implies a computer 
system, whereas node generally applies to any network system, including access servers and ITP or 
RAN-O devices. See also node.

host address See host number.

host number Part of an IP address that designates which node on the subnetwork is being addressed. Also called a 
host address.

HSL High-speed link. An HSL link is one that uses use the SS7-over-ATM (Asynchronous Transfer Mode) 
high-speed protocol.

HTML Hypertext Markup Language. Simple hypertext document formatting language that uses tags to indicate 
how a given part of a document should be interpreted by a viewing application, such as a web browser. 
See also hypertext and browser.
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hypertext Electronically-stored text that allows direct access to other texts by way of encoded links. Hypertext 
documents can be created using HTML, and often integrate images, sound, and other media that are 
commonly viewed using a browser. See also HTML and browser.

Hypertext Markup 

Language

See HTML.

I

ignore Exclude an object when aggregating and displaying MWTM status information. See also unignore.

IMSI International Mobile Subscriber Identity. A unique 15-digit code that identifies an individual user on a 
GSM network.

installation log Log containing messages and other information recorded during installation.

Instance Translation ITP feature in support of the Multiple Instance feature that enables the conversion of packets between 
instances of any variant. Each instance is a separate domain with a defined variant, network indicator, 
ITP point code, optional capability point code, and optional secondary point code. Each instance also 
has its own routing table and GTT file. See cross-instance GTT file, Multiple Instance.

interface Connection between two systems or devices. In the MWTM, an interface is a connection on an ITP or 
RAN-O node.

internal ID Unique identifier assigned by the MWTM, for its own internal use, to every event, link, linkset, and 
node.

Internet Protocol See IP.

IP Internet Protocol. Network layer protocol in the TCP/IP stack offering a connectionless internetwork 
service. IP provides features for addressing, type-of-service specification, fragmentation and 
reassembly, and security. Documented in RFC 791.

IP address 32-bit address assigned to hosts using TCP/IP. An IP address belongs to one of five classes (A, B, C, 
D, or E) and is written as 4 octets separated by periods (dotted decimal format). Each address consists 
of a network number, an optional subnetwork number, and a host number. The network and subnetwork 
numbers together are used for routing, while the host number is used to address an individual host 
within the network or subnetwork. A subnet mask is used to extract network and subnetwork 
information from the IP address. CIDR provides a new way of representing IP addresses and subnet 
masks. See also IP.

IP backhaul A trunk that transports optimized voice and data traffic between a remote cell-site, RAN-O node and 
an aggregation RAN-O node at a central site.

ITP Part of Cisco’s hardware and software SS7-over-IP (SS7oIP) solution. ITP provides a reliable, 
cost-effective medium for migrating Signaling System 7 (SS7), the telecommunications network 
signaling technology, to the mobile wireless industry IP environment. ITP off-loads SS7 Short 
Messaging Service (SMS) traffic onto the IP network, replacing the mobile service provider’s signaling 
network with a redundant IP cloud.

ITU International Telecommunication Union.
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K

known See discovered.

L

LAN Local Area Network.

legacy device In the MWTM, an SS7 device that is not a Cisco ITP or a Cisco RAN-O node. Legacy devices include 
MSCs, SCPs, SSPs, STPs, BSCs, and BTSs. See MSC, SCP, SS7, SSP, STP, BTS, BSC.

link In ITP, the connection between nodes. See ITP, linkset, node.

link type In the MWTM, the type of a discovered ITP link, either SCTP IP or serial. See HSL, SCTP, serial, 
virtual link.

linkset In ITP, a grouped set of links. In the MWTM, a representation of two linksets associated with two 
nodes, one for each side of a logical connection. See ITP, link, node.

linkset pair In the MWTM, a single linkset with input from the perspective of both of its endpoints. See also linkset.

linkset type In the MWTM, the type of a discovered linkset, either SCTP IP, serial, HSL, mixed, or other. Other 
means no links have been defined for the linkset. See HSL, mixed linkset, SCTP, serial, virtual linkset.

local authentication Type of MWTM security authentication that allows the creation of user accounts and passwords local 
to the MWTM system. When using this method, user names, passwords, and access levels are managed 
using MWTM commands. Contrast with Solaris authentication.

For more information on Solaris authentication, see the “Implementing Secure User Access (Server 
Only)” section on page 2.

local IP address IP address used by the MWTM client to connect to the MWTM server.

local point code Point code of the primary signaling point for a linkset. Contrast with adjacent point code.

local VPN IP address IP address used by the MWTM client to connect to the MWTM server via VPN. See local IP address, 
VPN.

M

M3UA MTP3 User Adaptation layer. A protocol for supporting the transport of any SS7 MTP3 user signaling 
over the IP network. M3UA provides a seamless operation of the MTP3 user peers in the SS7 and IP 
domains. See MTP3.

managed object Node, application server, application server process, application server process association, link, 
linkset, node, signaling gateway-mated pair, or signaling point that is being managed by the MWTM.

Management 

Information Base

See MIB.
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MAP Mobile Application Part. An SS7 protocol that allows for the implementation of mobile network 
signaling infrastructure. See SS7.

mask Bit combination used in the MWTM to indicate the significant bits of the point code.

For ANSI and China standard networks using the default 24-bit point code format, the default mask is 
255.255.255.

For ITU networks using the default 14-bit point code format, the default mask is 7.255.7.

For NTT and TTC networks using the default 16-bit point code format, the default mask is 31.15.127.

Message Log Server Multi-threaded process that logs messages from the Data Server, Process Manager, and MWTM client. 
See also Data Server, Process Manager, Trap Receiver.

MIB Management Information Base. Database of network management information that is used and 
maintained by a network management protocol such as SNMP. The value of a MIB object can be 
changed or retrieved using SNMP commands, usually through a GUI network management system. 
MIB objects are organized in a tree structure that includes public (standard) and private (proprietary) 
branches.

mixed linkset Linkset in which the links are of two or more types. (This configuration is not recommended.)

MLR Multi-Layer SMS Routing. Scheme that enables intelligent routing of Short Message Service (SMS) 
mobile originated (MO) messages based on the application or service from which they originated or to 
which they are destined. The MLR feature can make SMS message routing decisions based on 
information found in the TCAP, MAP, and MAP-user layers; MAP operation codes 
MAP-MT-FORWARD-SM and SEND-ROUTING-INFO-FOR-SM; and ANSI TCAP and IS-41 MAP 
operations.

mobile switching 

center

See MSC.

MSC Mobile switching center. Provides telephony switching services and controls calls between telephone 
and data systems.

MSU Message Signal Unit. MSUs provide MTP protocol fields and are the workhorses of the SS7 network. 
All signaling associated with call setup and teardown, database query and response, and SS7 
management requires the use of MSUs. See MTP3.

MTP3 Message Transfer Part, level 3. An SS7 protocol that routes SS7 signaling messages to public network 
nodes by means of destination point codes, which allow messages to be addressed to specific signaling 
points. See SS7.

Multi-Layer SMS 

Routing

See MLR.

Multiple Instance ITP feature that makes it possible to connect an ITP to different networks at one time, each with specific 
variant and network indicator values. The ITP treats each combination of variant and network indicator 
as a separate “instance” or signaling point with its own local point code and routing table on the ITP. 
Each instance is part of the SS7 network and shares the same variant and network indicator. In order 
for instances in the same network to be properly managed they must be assigned the same network 
name. See cross-instance GTT file, Instance Translation.
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N

name server Server connected to a network that resolves network names into network addresses.

NAT Network Address Translation. Internet standard that enables a LAN to use one set of IP addresses for 
internal traffic and a second set of addresses for external traffic. 

Network Address 

Translation

See NAT.

network indicator See NI.

network 

management 

system

See NMS.

network view See view.

Network Time 

Protocol

See NTP.

new node Node that the MWTM has newly discovered, and that has not yet been added to the current view.

NI Network indicator. Information within the service information octet of the MSU that permits 
discrimination between national and international messages. See MSU.

NMS Network management system. System responsible for managing at least part of a network. An NMS is 
generally a reasonably powerful and well-equipped computer such as an engineering workstation. 
NMSes communicate with agents to help keep track of network statistics and resources.

node Endpoint of a network connection or a junction common to two or more lines in a network. Nodes can 
be processors, controllers, or workstations. Nodes, which vary in routing and other functional 
capabilities, can be interconnected by links, and serve as control points in the network.

In ITP, a node is a Cisco ITP or a legacy SS7 device (SSP, SCP, or STP). 

In RAN-O networks, a node is a Cisco Mobile Wireless Router (MWR), Optical Networking System 
(ONS), RAN service module, or a legacy RAN device (BTS or BSC).

See legacy device.

Node B  Physical unit for radio transmission/reception with cells in the UTRAN.

node name Name of a node. This is either the DNS name of the node, or a user-specified name. See display name, 
DNS name.

nonrecursive 

Discovery

Discovery of seed nodes only. The MWTM discovers all seed nodes and attempts to manage them, then 
marks all nodes that are adjacent to those seed nodes as Unmanaged. Contrast with recursive 
Discovery.

Non-Stop Operation See NSO.

note User-defined descriptive string attached to an object.
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NSO Non-Stop Operation. Implementation of redundant data elements and software functionality, enabling 
networks to approach 99.999% availability. See also RF.

NTP Network Time Protocol. Timing protocol that maintains a common time among Internet hosts in a 
network.

O

object Node, application server, application server process, application server process association, link, 
linkset, node, signaling gateway-mated pair, or signaling point that has been discovered by the MWTM.

output linkset See destination linkset.

P

ping Packet internet groper. ICMP echo message and its reply. Often used in IP networks to test the 
reachability of a network device.

point code A unique address code that identifies a service provider within a signaling network. Also called 
primary point code. See capability point code, destination point code, local point code, secondary point 
code.

polling Access method in which a primary network device inquires, in an orderly fashion, whether secondaries 
have data to transmit. The inquiry occurs in the form of a message to each secondary that gives the 
secondary the right to transmit.

poll interval Time between polls.

poll response Time taken by a node to respond to MWTM poll requests.

port In IP terminology, an upper-layer process that receives information from lower layers. Ports are 
numbered, and each numbered port is associated with a specific process. For example, SMTP is 
associated with port 25. A port number is also called a well-known address.

preferences Settings that enable a user to change the way the MWTM presents information.

primary node In the MWTM, for a given pair of connected signaling points or nodes, the signaling point or node that 
the MWTM discovered first. See adjacent node.

primary point code See point code.

primary SNMP 

address

IP address used by SNMP to poll the node. (There might be other IP addresses on the node that are not 
the primary SNMP address.) Contrast with secondary IP address.

process Internal component of the MWTM. See Data Server, Message Log Server, Process Manager, Trap 
Receiver.

Process Manager Multi-threaded process that handles the management of registered MWTM processes. See also Data 
Server, Message Log Server, Trap Receiver.
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Q

QoS Quality of service. Measure of performance for a transmission system that reflects its transmission 
quality and service availability.

Quality of Service See QoS.

R

Radio Network 

Controller

See RNC.

RAN Radio Access Network.

RAN backhaul The end-to-end RAN connections between the BTS or Node B at the cell site and the BSC or RNC. See 
also virtual RAN backhaul, IP backhaul.

RAN shorthaul An interface that transports GSM or UMTS voice and data traffic between the BTS or Node-B and the 
RAN-O node at the cell site. At the aggregation site, RAN shorthauls exist between the RAN-O node 
and the BSC or RNC.

RAN-O RAN optimization. Standard-based, end-to-end, IP connectivity for GSM and UMTS RAN transport. 
The Cisco solution puts RAN voice and data frames into IP packets at the cell-site, and transports them 
seamlessly over an optimized backhaul network. At the central site, the RAN frames are extracted from 
IP packets, and the GSM or UMTS data streams are rebuilt.

read community See community string.

recursive Discovery Discovery of the entire network. The MWTM discovers all seed nodes and attempts to manage them; 
then attempts to discover and manage all ITP nodes that are adjacent to those seed nodes (unless the 
nodes are connected by serial links only); then attempts to discover and manage all ITP nodes that are 
adjacent to those nodes; and so on, until the MWTM has discovered the entire network.

Contrast with nonrecursive Discovery.

Redundancy 

Framework

See RF.

RF Redundancy Framework. Mechanism for logical redundancy of software functionality, designed to 
support 1:1 redundancy on processor cards. See also NSO.

RNC Radio Network Controller. Network element that controls one or more Node B transceiver stations in 
the UTRAN.

route Path through an internetwork.

route set Set of routes with the same destination point code.
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route table Table used in ITP to locate a destination linkset for a packet whose destination point code does not 
match the ITP's local point code.

routing key Set of SS7 parameters that uniquely define the range of signaling traffic to be handled by a particular 
application server or application server route table. Thus, the routing key identifies an application 
server or an application server route table. See application server, application server process, 
application server process association, signaling gateway-mated pair

S

SCCP Signaling Connection Control Part. A routing protocol in SS7 protocol suite in layer 4 that provides 
end-to-end routing for TCAP messages. SCCP also provides the means by which an STP can perform 
global title translation, a procedure by which the destination signaling point and subsystem number is 
determined from digits present in the signaling message. See also TCAP.

SCP Service control point. An element of an SS7-based Intelligent Network that performs various service 
functions, such as number translation, call setup and teardown, and so on.

SCTP Stream Control Transmission Protocol. An end-to-end, connection-oriented protocol that transports 
data in independent sequenced streams.

secondary IP 

address

Alternate or backup IP address used by a node. Contrast with primary SNMP address.

secondary point 

code

Alternate or backup point code used by a signaling point. See point code.

seed file List of seed nodes. See seed node.

seed node Node used by the MWTM to discover the other objects in your network.

serial Method of data transmission in which the bits of a data character are transmitted sequentially over a 
single channel.

server Node or software program that provides services to clients. See client.

service control point See SCP.

service switching 

point

See SSP.

SGMP See signaling gateway-mated pair.

signaling 

gateway-mated pair

Pair of signaling gateways that exchange necessary state information using the Signaling 
Gateway-Mated Protocol (SGMP). See application server, application server process, application 
server process association, routing key, signaling gateway-mated pair.

Signaling 

Gateway-Mated 

Protocol

Protocol that enables two Cisco ITP M3UA/SUA signaling gateways to act as a mated pair and 
exchange necessary state information. See signaling gateway-mated pair.

signaling point  See SP.
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signal transfer point See STP.

Signaling System 7 See SS7.

Simple Network 

Management 

Protocol

See SNMP.

SMPP Short Message Peer-to-Peer Protocol. A messaging protocol meant to simplify integration of data 
applications with wireless mobile networks such as GSM.

SNMP Simple Network Management Protocol. Network management protocol used almost exclusively in 
TCP/IP networks. SNMP provides a means to monitor and control network devices, and to manage 
configurations, statistics collection, performance, and security.

SOAP Simple Object Access Protocol. A protocol for exchanging XML-based messages over computer 
networks. See XML.

Solaris 

authentication

Type of MWTM security authentication that uses standard Solaris-based user accounts and passwords, 
as specified in the /etc/nsswitch.conf file. You can provide authentication with the local /etc/passwd file 
or from a distributed Network Information Services (NIS) system. Contrast with local authentication.

For more information on Solaris authentication, see the “Implementing Secure User Access (Server 
Only)” section on page 2.

SP Signaling point. An SCP, SSP, or STP, or an ITP instance. See SCP, SSP, or STP.

spring layout Topology map layout in which objects are arranged in a spring layout. Objects with the most links are 
drawn closer to the center of the map, while objects with fewer links are drawn farther away. Contrast 
with circle layout. See topology map.

SS7 Signaling System 7. Standard CCS system used with BISDN and ISDN. Developed by Bellcore.

SSL Secure Sockets Layer. A protocol for transmitting private documents via the Internet.

SSP Service switching point. Element of an SS7-based Intelligent Network that performs call origination, 
termination, or tandem switching.

status Current condition, such as Active or Unknown, of a network object.

status polling Regularly scheduled polling of nodes performed by the MWTM. Contrast with demand polling.

STP Signal transfer point. Element of an SS7-based Intelligent Network that performs routing of the SS7 
signaling.

SUA SCCP User Adaptation. A client/server protocol that provides a gateway to the legacy SS7 network for 
IP-based applications that interface at the SCCP layer. See also SCCP.

Stream Control 

Transmission 

Protocol

See SCTP.

subview A view within a customized view. You can create subviews on an MWTM client, with each subview 
devoted to a different part of the network. You can then load a subview to manage a different part of 
the network, or switch to the DEFAULT view to see the entire network. See also DEFAULT view.
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superuser User specified in the MWTM to be able to perform most functions that otherwise require the user to be 
logged in as the root user.

For more information, see the “Specifying a Super User (Server Only)” section on page 18.

system object ID See device type.

T

TCP Transmission Control Protocol. Connection-oriented transport layer protocol that provides reliable 
full-duplex data transmission. TCP is part of the TCP/IP protocol stack. See also TCP/IP.

TCAP Transaction Capabilities Application Part. An SS7 protocol that enables the deployment of advanced 
intelligent network services by supporting non-circuit related information exchange between signaling 
points using the SCCP connectionless service. See also SCCP.

TCP/IP Transmission Control Protocol/Internet Protocol. Common name for the suite of protocols developed 
by the U.S. DoD in the 1970s to support the construction of worldwide internetworks. TCP and IP are 
the two best-known protocols in the suite. See also IP and TCP.

TFTP Trivial File Transfer Protocol. A protocol that is used to transfer small files between hosts of a network. 
See also host.

thread name Task name.

timeout Event that occurs when one network device expects to hear from another network device within a 
specified period of time, but does not. The resulting timeout usually results in a retransmission of 
information or the dissolving of the session between the two devices.

tooltip Popups that display information about objects and table entries.

topology See topology map.

topology map Graphical representation by the MWTM of the network. Also called topology.

Transmission 

Control Protocol

See TCP.

Transmission 

Control 

Protocol/Internet 

Protocol

See TCP/IP.

trap Unsolicited message sent by an SNMP agent to an NMS, console, or terminal to indicate the occurrence 
of a significant event, such as a specifically defined condition or a threshold that has been reached.

trap forwarding Forwarding MWTM events to other hosts, in the form of SNMP traps. This enables the MWTM to 
integrate with high-level event- and alarm-monitoring systems such as the Cisco Info Center (CIC) and 
Micromuse's Netcool suite of products. These systems can provide a single high-level view of all alarm 
monitoring in your network, making it easier to detect and resolve problems.
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Trap Receiver Multi-threaded process that receives SNMP traps for the MWTM. See also Data Server, Message Log 
Server, Process Manager.

Trivial File Transfer 

Protocol

See TFTP.

U

UDP User Datagram Protocol. Connectionless transport layer protocol in the TCP/IP protocol stack. UDP 
is a simple protocol that exchanges datagrams without acknowledgments or guaranteed delivery, 
requiring that error processing and retransmission be handled by other protocols. UDP is defined in 
RFC 768.

UMTS Universal Mobile Telecommunications System. Third generation wireless standard for supporting data 
transfer rates of 144 kbs (vehicular), 384 kbs (pedestrian), or up to 2 Mbs in buildings.

UMTS Terrestrial 

RAN

See UTRAN.

unignore Stop ignoring the selected object at the next polling cycle. See also ignore.

unknown Device type for which the MWTM is unable to determine the device type. If a node, the node failed to 
respond to an SNMP request. If a linkset or link, either the associated node failed to respond to an 
SNMP request, or the MWTM found that the linkset or link no longer exists. Contrast with discovered.

Universal Mobile 

Telecommunications 

System

See UMTS.

unmanaged Node status in which the node is known indirectly by the MWTM (the MWTM knows the device exists 
but no known SNMP stack exists on the device for the MWTM to query), or a user has set the node to 
this status to prevent the MWTM from polling the node.

User-Based Access MWTM security scheme that provides multi-level password-protected access to MWTM features. 
Each user can have a unique user name and password. Each user can also be assigned to one of five 
levels of access, which control the list of MWTM features accessible by that user.

For more information, see the “Configuring User Access” section in Chapter 2, “Configuring 
Security.”

User Datagram 

Protocol

See UDP.

utilization Amount of an object’s send or receive capacity that is being used, expressed as a percentage or in 
Erlangs.

UTRAN  UMTS Terrestrial RAN. Radio access network for UMTS networks.
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V

variant A method of identifying SS7 point codes. Example point code variants are:

ITU: 3-8-3 format is common, made up of 14 bits

ANSI: 8-8-8 format is common, made up of 24 bits

view View that is currently in use on an MWTM client. The current view can be the DEFAULT view or a 
customized view. A customized view can have one or more subviews. See client view, current view, 
DEFAULT view.

virtual RAN 

backhaul

A grouping of RAN backhauls. A virtual RAN backhaul is useful if you have configured several RAN 
backhauls for the same interface. To view the utilization for that interface, create a virtual RAN 
backhaul that contains all the real backhauls that you have configured for the interface. See RAN 
backhaul.

virtual link Link that connects signaling point instances running on the same device. The MWTM does not poll 
virtual links, nor does it display real-time data or accounting statistics for virtual links. 

virtual linkset Linkset in which the links are virtual links, which connect signaling point instances running on the 
same device. The MWTM does not poll virtual linksets, nor does it display real-time data or accounting 
statistics for virtual linksets.

Note Prior to IOS release 12.2(23)SW1, virtual linksets on multi-instance routers were created 
manually by the user. Within and after that release, virtual linksets are created automatically.

Virtual Private 

Network

See VPN.

VPN Virtual Private Network. Enables IP traffic to travel securely over a public TCP/IP network by 
encrypting all traffic from one network to another. A VPN uses “tunneling” to encrypt all information 
at the IP level.

W

World Wide Web See WWW.

WWW World Wide Web. Large network of Internet servers providing hypertext and other services to terminals 
running client applications such as a browser. See also browser.

X

XML Extended Markup Language. A general-purpose markup language for to facilitating the sharing of data 
across different information systems connected through the Internet. See SOAP.
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colors 10

date 10

time 10

severities and colors 35

SNMP servers and traps 32

sound filters

creating new 43
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